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Welcome to FrameMaker® document publishing software from Frame
Technology® Corporation. FrameMaker is integrated publishing
software that gives you everything you need to create a wide range of
publication-quality documents—books, technical manuals, letters,
memos, reports, newsletters, and presentations.

Using this manual (first-time users)
This may be the manual you turn to most often as you work with
FrameMaker. It contains step-by-step instructions for most tasks you
perform.
The eight parts of this manual deal with general areas of interest such
as text, graphics, and page design. The table of contents that precedes
this preface lists the eight parts, the chapters in them, and the major
sections of each chapter. A table of contents at the beginning of each
chapter lists the contents of that chapter in detail.
The appendixes provide additional information to help you work with
FrameMaker as well as companion products. The glossary defines
FrameMaker and industry-wide printing terminology.

Using FrameMaker
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Using this manual (upgrade users)
This manual is an improved version of your familiar FrameMaker
manual. It has new and revised step-by-step instructions that
incorporate the new FrameMaker features. The following table lists
some of these features and the parts of the manual where they’re
mentioned. If you want detailed information about the new
FrameMaker features, consult the online manual What’s New in
FrameMaker.
For new information about
See
..........................................................................

QuickAccess bar

“Using commands and dialog boxes” in
Chapter 2

Text imported by
reference

“Importing text” in Chapter 3

Paragraph straddles

“Formatting special headings” in Chapter 4

Table straddles

“Inserting and manipulating tables” in
Chapter 6

Footnote straddles

“Creating a footnote” in Chapter 11

Small Tools palette

“Setting up the drawing environment” in
Chapter 13

Text runarounds

“Using text with graphics” in Chapter 13

Joined Bézier curves

“Arranging objects” in Chapter 14

Anchored frame positions

“Creating an anchored frame” in Chapter 15

Anchored frame straddles

“Creating an anchored frame” in Chapter 15

Text frames

Chapter 18, Chapter 19, and Chapter 20

Hypertext enhancements

Chapter 27

Command conventions
This manual identifies commands on submenus by referring to both the
submenu and the command name. For example, the New Master Page
command on the Page Layout submenu is referred to as
Page Layout>New Master Page.

xii
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Keyboard conventions
This manual refers to a key called Meta. The following table shows how
the Meta key is labeled on keyboards from several manufacturers.
Keyboard
Meta key is labeled
..........................................................................

Sun

With a diamond; Left and Right on older keyboards

Hewlett-Packard

Extend Char

IBM

Alt

DEC

Compose Character

Silicon Graphics

Alt

This manual uses concise conventions for the key combinations you use
for keyboard shortcuts. The following table explains the conventions.
Shortcut
Explanation
..........................................................................

Control-e

Hold down Control and press the letter e.

Shift-Control-hyphen

Hold down Shift and Control, and press the
hyphen key.

Esc v B

Press and release the Esc key, then press the letter
v, and hold down Shift while you press the letter B.

When this manual uses Esc as the default command prefix, you can use
Control-r as the command prefix instead. Your system administrator
can tell you whether your platform is configured for a different
command prefix.
This manual also uses the following conventions for mouse actions.
Instruction
Action
..........................................................................

Click

Click the left mouse button.

Middle-click

Click the middle button of a three-button mouse, or
simultaneously click both buttons of a two-button
mouse.

Right-click

Click the right mouse button.

Double-click

Click the left mouse button twice rapidly without
moving the mouse.

Shift-click

Hold down Shift and click the left mouse button.

Using FrameMaker
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Using FrameMaker documentation
Whether you’re a publishing novice or a production expert,
FrameMaker documentation provides a clear and easy path to
productivity: a tutorial to get you started, booklets describing
installation and shortcuts, online Help, and more. Some of the
documents are provided in printed form; most are available online and
are accessible through online Help.

What to look for in print
The following information is available in print.
Introducing FrameMaker describes features and
functions of FrameMaker. It includes samples of the kinds of documents
you can create.
Product overview

Installing Frame Products explains how to
install FrameMaker and set up licensing at your site. Installation Notes
includes last-minute changes in installation procedures.
Installation instructions

Using FrameMaker has step-by-step instructions for a
comprehensive range of FrameMaker tasks. It is organized logically by
task groupings.

User’s manual

Abbreviated task instructions and shortcuts The Quick Reference for
FrameMaker contains abbreviated instructions for many tasks, and it
lists all of the keyboard shortcuts. The Pocket Guide for FrameMaker
lists keyboard shortcuts you can use when typing and editing text.

What to look for online
The following information is available online. You can reach most online
information from online Help. You can reach online manuals from the
Online Manuals pop-up menu in the Help main menu.
New and changed features If you are already familiar with earlier
versions of FrameMaker, you may want to read the online manual
What’s New in FrameMaker. This manual describes the new and
changed features in this release of FrameMaker and directs you to
further information.

xiv
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FrameMaker Overview is a brief online introduction to key
FrameMaker concepts. If you are new to FrameMaker, it is your best
online starting point.
Overview

Online tutorial If you are new to FrameMaker, the online tutorial,
Learning FrameMaker, will teach you the basics as you work with
real FrameMaker documents. Do the tutorial after you read
FrameMaker Overview. To start the tutorial, choose Tutorial from
the Help main menu.

The online manual Release Notes provides
late-breaking information on FrameMaker that could not be included in
the printed manuals.
Last-minute information

FrameMaker online Help includes both indexed and
context-sensitive help with commands, dialog boxes, and keyboard
shortcuts.
Online reference

The online manual Managing Frame
Products gives information on adding fonts to FrameMaker, the files
contained in this release, and FrameMaker scripts and environment
variables.

Application management

The online manual Changing Setup Files explains how to
customize FrameMaker and its environment.

Custom use

Predesigned templates are available for a variety of uses—
for example, common business correspondence, newsletters, reports,
outlines, and books. To see a list of templates, choose New from the File
menu and then click Explore Standard Templates.
Templates

Sample documents, available through online Help, show the
types of documents you can create with FrameMaker.
Samples

FrameMaker provides a collection of line art that you can copy
and paste into your own documents.

Clip art

Filters The online manual Using Frame Filters provides information on
converting a wide range of documents between FrameMaker and other
applications.

Using FrameMaker
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The online manual Using Frame Products on
Multiple Platforms describes how the UNIX, Windows, and Macintosh
versions of FrameMaker differ.

Multiple-platform use

The online manual MIF Reference
explains the MIF text format, which allows FrameMaker to share
information with another application while preserving graphics, text,
and formatting information.

Maker Interchange Format (MIF)

The online manual MML Reference
describes a markup language that you can use with any standard text
editor to create simple FrameMaker documents.

Maker Markup Language (MML)

xvi
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1

FrameMaker is a complete publishing system. It’s a word processor,
page designer, graphics editor, and book builder rolled into one package.
You can use this versatile application to write simple one-page memos
or to produce complex multichapter documents with imported graphics.

Full word processing power
FrameMaker provides the text editing, spell-checking, and search
capabilities you expect from a full word processor. You can format text
as you type or apply predefined formats later, using advanced text
management features such as paragraph and table format catalogs.
FrameMaker can automatically manage cross-references and footnotes
to further streamline and simplify your work.

Flexible page design
Page design in FrameMaker is fast and flexible. You create master
(background) pages that contain the design elements you want to
appear on all body (foreground) pages. You specify the number and
position of text columns and the appearance of background text and
graphics. Text, tables, and graphics flow from column to column
automatically, and can even straddle columns.

A master page provides the
background...

Running head

Abcd Efgh Ij
BrewBlend Coffee

...and your text and
graphics occupy the
foreground.

Abcd Efgh Ij

Page #

Page 3

Using FrameMaker 1-1

1

OVERVIEW

Portrait and landscape pages can be mixed and can contain any
combination of columns.

Graphics tools, with color
With the FrameMaker drawing tools, you can draw and edit objects to
add visual interest (and perhaps some color) to a document. You can
capture an image on your screen and then import the image into a
document. Graphics can be anchored to text so that they move with the
surrounding text as you edit.

BrewBlend Coffee

A graphic anchored
to text...
...moves as text is edited.

Or they can be placed at a fixed location on the page, with text running
around the graphics automatically.

A gateway for other products and platforms
FrameMaker supplies tools for importing graphics and text from other
application programs to FrameMaker documents. FrameMaker can
maintain a link between the document and the source of the imported
information so the document is updated automatically when the source
changes. And when you import text, you can retain the formatting from
the source document or use the formats stored in the current one.
FrameMaker is available for several operating systems, including
Microsoft Windows, the Apple Macintosh® operating system, and
UNIX. The FrameMaker document format is the same on every
platform. So you can create documents on one platform, edit them on a
second, and distribute them on a third.

1-2
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Book building and revision management
FrameMaker provides a book building feature that lets you manage
multiple files as a single document. You can generate a table of contents
or an index for the entire book or for a selected chapter automatically.
Lists of captioned illustrations are just as easy to assemble.
As you revise and refine a book, you can track the changes by using
change bars or by comparing a revision with the original.

Professional color control
Color separations can be expensive if you leave them to outside
vendors. With FrameMaker, you can prepare color separations for spot
color and for four-color process printing yourself. You can review and
correct color work long before your document goes to press, saving time
and money in the process.

Attractive tables for organizing information
When you want to present information in a tabular format,
FrameMaker simplifies the job. You can create attractive tables with
any combination of ruling lines and shading. You can make cells
straddle columns or rows. For a professional look, you can rotate
headings to create table categories that stand out.

From

Cost

BrewBlend Coffee

Body

Kona

Body

Java

Cost

Mocha

Java

Kona

From

You can apply professionallooking ruling lines and
shading…

…and make cells straddle
rows.

Landscape
Portrait

Using FrameMaker
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Conditional text for multiple versions of a document
If you need to create several versions of the same document, the
FrameMaker conditional text feature lets you hide or display different
versions in the same document.

Only one version of the
document is visible.

Blend Coffee

Blend CoffeeTea

Brew Coffee

Brew CoffeeTea

Serve Coffee

Serve CoffeeTea

Now you can see both
versions together.

Templates for standardized documents
If you’re creating a document that must have a consistent, polished look
throughout, using a template speeds up the job. When you create a
document from a template, you use the template’s page layouts,
predefined formats, and other properties. FrameMaker provides a
variety of templates for letters, memos, reports, newsletters, outlines,
books, and viewgraphs.

Information links can be built in
You can use FrameMaker hypertext commands to set up links between
related locations. When readers view a linked document online, they
can click an active location to jump to the related information at the
linked location.
2
10
The reader clicks a word,
phrase, or graphic to display
more information.

1-4
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Locations in the same document or in different documents can be
linked. When you generate tables of contents and indexes, you can
include links to the items they list so that users can jump right to them.
If your readers don’t have FrameMaker for reading online hypertext
documents, you can distribute FrameReader® or FrameViewer® with
your hypertext system. With FrameReader or FrameViewer, readers
can open and navigate documents and also use a few appropriate
FrameMaker commands, such as Print, Copy, or Find.

Step-by-step instructions
This brief introduction has given you a broad overview of FrameMaker
publishing features. The rest of this manual supplies the details. Part I
concludes with Chapter 2, “Basic Procedures,” which explains
essentials such as creating new documents and managing windows.
Parts II through VIII contain step-by-step instructions for the many
jobs you’ll do as you use FrameMaker to prepare your work for
publication.
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STARTING FRAMEMAKER 2-4

SAVING A DOCUMENT 2-30

To start FrameMaker 2-4
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To get a license 2-5
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To zoom in and out 2-25
To customize the zoom settings 2-25
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To display a specific page 2-28
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To set how pages scroll 2-29
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FrameMaker lets you create and publish great-looking documents
through its easy-to-use commands and tools. Once you master the
basics of using FrameMaker, you’ll want to learn more about the
program and add more skills to your repertoire.

A quick look at the FrameMaker document window
FrameMaker displays a document in a document window. Within this
window, you can write new text, view pages in different ways, and finetune every detail of a publishing project.

The formatting bar makes it
easy to format paragraphs.
Buttons give you access to
formatting, drawing, and
math tools.

You view your document
here.

The status bar displays
information on paragraphs
and pages.

2-2
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Window settings can suit your preferences
FrameMaker gives you several ways to change your view of a
document. You can zoom to view your document at any percentage up to
1600, and you can display one, two, or more pages at a time. You can
also use a variety of nonprinting borders, text symbols, rulers, and grid
lines as aids for precise text placement and editing. When you need a
different unit of measurement for the rulers or a different grid size, you
can easily customize these features.

Grid lines help you place
objects.

Saving documents lets you be creative and secure
If you’ve worked with a computer, you already know the importance of
saving your work—and saving it often. A saved document spares you
the grief of losing a day’s work when the power fails unexpectedly.
FrameMaker can automatically save your document and create backup
copies for you. These saved documents can also help if you want to
make sweeping revisions to a document but don’t want to discard the
original until you’re sure you want to keep your changes.

In this chapter
This chapter shows you how to create and open documents and how to
work with commands, dialog boxes, and windows. It also covers setting
up the document window, saving files, making backup copies, printing
black-and-white copies, and what to do when you finish with a
document or with FrameMaker.

Using FrameMaker
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STARTING FRAMEMAKER
Before you can use FrameMaker you must have a UNIX window open on your
screen. Your system administrator should have installed a licensed copy of
FrameMaker on your system according to the instructions in Installing Frame
Products.
You start FrameMaker in a UNIX window. FrameMaker then displays its main
window. From this window, you can create a new document or open an existing
one, if you have a license. If you don’t have a license, you can get one by using
commands and dialog boxes. (If you don’t know how to choose a command or use
a dialog box, see “Using commands and dialog boxes” on page 2-16. Also, the
instructions in this manual assume that you are familiar with your window
manager’s methods for scrolling in windows and closing them.)

To start FrameMaker
If you don’t see the FrameMaker icon or the main FrameMaker window, start
FrameMaker.

Icon
Main FrameMaker window
■

Type one of the following commands in a UNIX window and press Return.
FrameMaker edition desired
Command
..........................................................................

United States

maker

International Edition

imaker -l language
Type imaker -l (lowercase L) and the name
of the language you want to use—for example,
ukenglish, francais, deutsch,
italiano, or svenska.

FrameMaker displays the main FrameMaker window. (If you don’t see the main
FrameMaker window, contact your system administrator.) You can now create
or open a document. If you want to work on more than one document at a time,
open another document. Don’t start another copy of FrameMaker.
For instructions on how to open a specific document when you start
FrameMaker, see the online manual Changing Setup Files.
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To get a license
You can use FrameMaker if you have either a shared or a personal license. You
can get a shared license from your network on a first-come, first-served basis;
however, your system administrator can reserve a shared license for your
exclusive use. A personal license can be used only by a specific user. If you can
successfully open an existing document or create a new one, you have a license
and you do not have to follow these instructions. Use this procedure when you
see an alert that tells you that you do not have a license.
Occasionally, you may find that no shared licenses are available. In that case,
you can use FrameMaker only in demonstration mode until someone else gives
up a license.
In addition, your system administrator can specify how long FrameMaker can
remain idle before a user loses a license. As a result, if you start FrameMaker
and then leave it idle for some time, you can lose your license. If you’re using a
shared license and don’t intend to use FrameMaker for a while, but don’t want
to quit the application, consider giving up your license so that it becomes
available to another user. For information on giving up a license, see “If you’ve
lost your license or want to give it up” on page 2-6.
For a detailed description of Frame® licensing policy and instructions for
setting up and customizing licenses, see Installing Frame Products.
1

Click Info in the main FrameMaker window.

2

Click License.

3

Click Get License.

FrameMaker gives you a license if one is available.

Using FrameMaker
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If you can’t get a license on your current host, you can type the name of another
server host in the License Server Host text box and click Get License again.

Displays the users who
currently have shared
licenses from the host
named in the License Server
Host text box

Tells you whether you have
a license

The asterisk indicates a
reserved license.

IF YOU’VE LOST YOUR LICENSE OR WANT TO GIVE IT UP

If your system sits idle for too long, FrameMaker may give up your license. If
this happens, you can’t edit a document, but you can still manipulate
FrameMaker windows, save any unsaved work in a document or book file, exit
FrameMaker, or get another license and continue your work. If you have any
unsaved documents open, click Save Work before you try to get another license.
If you want to make your license immediately available to others, click Give Up
License. You can also specify the length of time FrameMaker can remain idle
before you lose your shared license. You must specify a whole number of at least
1 hour. Your system administrator sets an upper limit on the amount of time
you can leave FrameMaker idle without losing your shared license.
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CREATING AND OPENING DOCUMENTS
After you’ve started FrameMaker, you begin to work with a FrameMaker
document, either by creating a new one or by opening an existing one. When
you create a new document, you can use a template that already defines much
of what a document looks like, or you can start with the FrameMaker
equivalent of a blank piece of paper. Either method lets you create a document
that looks exactly like the document you want.
A template is a FrameMaker document that can contain all the information
necessary for laying out a new document. It includes paragraph, character, and
table formats as well as page layout information (such as margins, page
numbering, and spacing for headers and footers). Some templates also contain
formats for running headers and footers. Templates let you create professionallooking documents and help standardize documents created by different
authors.
When you use blank paper to create a new document, you start with a
document that includes a few basic paragraph and character formats. If none of
the FrameMaker templates looks like what you want, use a blank paper
document and create your own formats.
After you create or open a document, you can make changes to the document
window through which you view the document, you can add to the document,
and you can change the document’s layout.
For you to create or open documents, you must know how to use commands and
dialog boxes. If you don’t know how to choose a command or use a dialog box,
see “Using commands and dialog boxes” on page 2-16.

To create a document from a template
When you create a document based on a template, all the formatting
instructions are copied from the template to the new document. For general
information on templates, see “FrameMaker templates” on page 2-8. For
detailed information on templates, see Chapter 21, “Document Templates.”
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FrameMaker provides templates for letters, memos, reports, newsletters,
outlines, books, and viewgraphs.
1

Click New in the main FrameMaker window.

You can also choose New from the File menu of an open FrameMaker document
to create a new document.
FrameMaker opens a dialog box and displays the contents of the Templates
directory or, if it cannot find this directory, the contents of your home directory.
(If the current directory isn’t Templates, in the Use Template dialog box type
$FMHOME/fminit/usenglish/Maker/Templates and click Create.)
If you are using an international version of FrameMaker, substitute your
language name for usenglish. If you don’t have a FrameMaker license, you’ll
see an alert. See “To get a license” on page 2-5.

FRAMEMAKER TEMPLATES
Templates are the foundation of the FrameMaker
approach to document publishing. They affect the
appearance of every aspect of a document and help
to keep that appearance consistent from one page
to the next and from one chapter to another.

• Cross-reference formats that determine the text
and appearance of cross-references.

A template can contain:

• Conditional text formats and settings that
manage the different versions of a single document
in the same file.

• Paragraph, character, and table formats that
you can apply anywhere in the document. These
formats are stored in catalogs that are always
available as you work.
• Page layouts that determine the number of
columns on a page and their positions. The page
layouts also contain the text and graphics that
appear in the background on body pages.
• Reference pages that hold graphics and
formatting information accessible from anywhere
in the document.
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• Variable definitions that let you use a
placeholder for text that FrameMaker can update
as the definitions change.

• Colors specific to a document. FrameMaker
provides a basic set of colors, but a template can
include custom colors.
• Math definitions that include equation size, font
settings, and custom math element definitions.
For information on creating templates, see
Chapter 21, “Document Templates.”
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Select a directory and click Create.

Type the name of the
directory you want to open,
or select a directory name
in the scroll list.

FrameMaker displays a list of templates in the selected directory.
3

Select a template and click Create.

FrameMaker opens a new document, copying the formats from the template.
Initially, the name of the document is NoName, but you can use the Save As
command on the File menu to rename it. For information on using this
command, see “To change a document’s name, location, or file format” on
page 2-31.
4

Enter text in the document.

If there is sample text in the document when you create it, you can either
remove it and then start to type, or you can select the sample text and type over
it. Whether you delete the sample text or just type over it, the document still
contains all the paragraph and character formats of the template. For
information on deleting some text or typing over text, see Chapter 3, “Editing
Text.”
If you can’t select sample text or a graphic from the newly created document,
the text or graphic is located on one of the document’s master pages. For
information on making changes to a master page, see Chapter 19, “Custom
Page Design.”
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EXPLORING STANDARD TEMPLATES

If you’re not sure which standard template to select in the scroll list in the New
dialog box, click Explore Standard Templates. In the Standard Templates
dialog box, select a template in the scroll list to see some descriptive
information about the template and a thumbnail image (or preview) of it.

To create a document from blank paper
If none of the FrameMaker templates has the format you want, you can use a
blank paper document to design your own format. FrameMaker provides three
kinds of blank paper documents—portrait, landscape, and custom.
Portrait and landscape blank paper documents display a page with one text
frame. When you create a custom document, you can specify exactly the page
size, margins, and number of columns you want. For information on creating a
custom document, see “To create a custom document,” next.

Landscape orientation
Portrait orientation

1

Click New in the main FrameMaker window.

You can also choose New from the File menu of an open FrameMaker document
to create a new document.
If you don’t have a FrameMaker license, you’ll see an alert. See “To get a
license” on page 2-5.
2

Click Portrait or Landscape to create a new document, or click Custom to design your
own page format.

If you click Portrait or Landscape, FrameMaker opens a new, untitled document
with either vertical or horizontal orientation. You can use the Save As
command on the File menu to rename the document. If you click Custom, see
“To create a custom document,” next.
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To create a custom document
Once you have clicked Custom in the New dialog box to create a custom
document, you can define any of the items that make up the general page layout
of the document. You can change the document’s page size, the number of
columns on a page and their spacing, the width of the margins, whether the
document is single- or double-sided, and the default units of measurement.
Make your selections and then click Create.
■

Choose a page size from the pop-up menu to set the general page layout options for
a variety of preset page sizes.

If you choose a page size from the pop-up menu, FrameMaker changes some of
the other options in the dialog box. You may change any of the options.
■

Type a width and height for your pages.

■

Type the number of columns and a gap value.

The gap is the space between columns.
■

Type values for the margins.

These margins are measured from the edge of the page.
■

Click a pagination setting.

If you select Double-Sided, choose Right 1st Page or Left 1st Page from the
pop-up menu to determine on which side a document starts. The text boxes for
the left and right column margins change so you can enter values for inside and
outside column margins to create a different margin on the inside of the
document to allow for binding.
Top

Left

Top

Inside

Top

Right
Outside

Bottom

■

Outside

Bottom

Bottom

Choose the units for the document.

These display units are the units of measurement FrameMaker uses when it
measures distances in your document. These display units appear in dialog
boxes and in the document window’s status bar.
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To open an existing document
You can open an existing FrameMaker document or a document created in a
compatible application. If you open any file other than a FrameMaker file,
FrameMaker tries to convert it to a FrameMaker document. If the file is from
another application, a filter for that application must be installed so that
FrameMaker can recognize and open the file. For information on file types
FrameMaker can open and for a list of filters provided with FrameMaker, see
“File types you can open” on page 2-12. If you are opening a text file, see “To
open a text file as a document” on page 2-16.
1

Click Open in the main FrameMaker window.

You can also choose Open from the File menu of an open FrameMaker
document.
If you don’t have a FrameMaker license, you’ll see an alert. See “To get a
license” on page 2-5.

FILE TYPES YOU CAN OPEN
FrameMaker can open the following types of files.
Maker Interchange Format (MIF) or Maker Markup
Language (MML) files MIF is an ASCII format that

lets you exchange information between
FrameMaker and other applications. MML is a
markup language you can use with any standard
text editor to create simple FrameMaker
documents. When you open a MIF or an MML file,
FrameMaker normally converts it to a
FrameMaker document. To open the file without
converting it so you can edit the MIF or MML
statements, hold down Shift and click Open in the
Open dialog box. FrameMaker opens the file
without interpreting its commands.
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Text files These files do not have graphics or
paragraph and character formatting information.
For information on how to open a text file
document, see “To open a text file as a document”
on page 2-16.
Files created in other applications FrameMaker
provides you with the filters to open files created in
Microsoft Word, WordPerfect, Interleaf, and troff.
Much of the file’s formatting is retained when you
open the file. Consult your system administrator
about other types of files you can open at your site.
For more information on FrameMaker filters, see
the online manual Using Frame Filters.
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Select the name of the document you want to open.

Contents of the current
directory

Pathname of the current
directory

To open the document in one step, double-click the document name in the
scroll list.
If the file you want to open isn’t in the scroll list, change to another directory by
double-clicking a directory name in the scroll list or by typing a different
directory name in the text box above the scroll list and clicking Open.
3

Click Open.

Typically, the document opens immediately. Occasionally, FrameMaker displays
an alert or dialog box before opening the document. The following describes
these special cases.
• If FrameMaker can locate all the fonts and imported graphics in the
document, it opens the document. If you are opening a text file, FrameMaker
first may ask you to confirm that the file is text by presenting the Unknown
File Type dialog box with Text preselected. Click Convert to continue. You
see the Reading Text File dialog box. For more information, see “To open a
text file as a document” on page 2-16. If you try to open a document already
in use, you will see a dialog box that tells you that your changes to the file
may conflict with the work of others. For more information, see “Documents
in use” on page 2-14.
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• If the document uses fonts that are not available on your computer, or if the
document uses different font metrics, FrameMaker displays an alert. If you
continue, FrameMaker substitutes new fonts for those missing and
reformats your file. Your line breaks, page breaks, and text lines may look
different. If you don’t want your file reformatted with new fonts, click
Cancel. If you open a document with substitute fonts, the document doesn’t
change permanently until you save it. For information on adding fonts to
FrameMaker, see the online manual Managing Frame Products.
• If you try to open a document that was open when a system crashed,
FrameMaker may ask whether you want to open an automatically saved
version of the file. For more information on opening this file, see “If your
system crashes” on page 2-36.
• If you try to open a file containing imported art that FrameMaker can’t
locate, FrameMaker displays the Missing File dialog box, in which you can
tell FrameMaker where the graphic is located or instruct FrameMaker to
skip the missing graphic. For information on locating missing art, see “To
locate a graphic FrameMaker can’t find” on page 16-14.

DOCUMENTS IN USE
To keep track of open documents, FrameMaker
creates a lock file named filename.lck (where
filename is the name of the open document). A
lock file is located in the same directory as the
original document. If you try to open a document
that’s already open, and if you have permission to
write to that document, FrameMaker displays a
Document in Use dialog box that shows the name
of the document, who opened it last, the host on
which it is open, and when it was opened. You also
see this dialog box when your system crashes and
when you open the document you were last using.
If you do not want to open the lock file, click
Cancel.
If you want to open the lock file, you have three
choices. If you want only to look at the file, and if
you don’t want to change it at all, click Open for
Viewing Only and click Continue.
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If you want to open a copy of the file that you can
edit, click Open Copy for Editing and click
Continue. There will be two versions of this
document—the one you use and the original
document.
If you want to edit the file and know that no one
else is using it, click Reset File Lock and Open, and
then click Continue to open the file. Use this option
when your system crashes and you are opening the
document you were last using.
FrameMaker removes the lock file when you close
the document.
For information on how to
ensure file locking across platforms (Windows,
Macintosh, and UNIX), see the online manual
Using Frame Products on Multiple Platforms.

Cross-platform use
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• If you open a file containing a text inset whose source FrameMaker can’t
locate, FrameMaker displays an alert. For information on text insets, see “To
locate the source for an unresolved text inset” on page 3-23.
• If you open a file containing unresolved cross-references in a file set for
automatic updating, FrameMaker displays an alert. For information on
resolving cross-references, see “To resolve a cross-reference after automatic
updating” on page 10-18.
• If you open a non-FrameMaker file, FrameMaker may display the Unknown
File Type dialog box and selects its best guess as to the file type. You can
select any type in the list. Click Convert to continue.
LIMITING THE CONTENTS OF THE SCROLL LIST

By typing wildcards in the Open File Named text box, you can limit the files
listed in the scroll list. For example, if you type *.new, you see any
subdirectory or document that has the extension .new. To redisplay the entire
directory, type * in the text box. For information on other wildcards, see
“Wildcards” on page 8-8.
OPENING RECENTLY OPENED DOCUMENTS

At the bottom of the File menu, FrameMaker lists the five documents you have
most recently opened or saved with the Save As command. To open a document
listed, simply choose it from the File menu. The filenames appear in
chronological order, with the most recently opened document at the top of the
list. When FrameMaker adds a filename to the list of five files, it removes the
name at the bottom.
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To open a text file as a document
When you open a text-only file in FrameMaker, FrameMaker queries you about
how to treat the text in the document.
1

Follow the usual steps for opening a FrameMaker document.

For details, see “To open an existing document” on page 2-12. When you open a
text file, FrameMaker first may ask you to confirm that the file is text by
presenting the Unknown File Type dialog box with Text preselected. Click
Convert to continue. The Reading Text File dialog box then prompts you for
information on how to import the text.
2

Specify how to treat the imported text and click Read.
Selection
Text example
Comment
...........................................................................

Merge Lines
into Paragraphs

Paragraph-oriented
text file such as a
file containing
document text

Merges adjacent nonblank lines
into paragraphs and breaks the
text into paragraphs at a blank
line.

Treat Each Line
As a Paragraph

Line-oriented text
file such as
computer code

Breaks the text into paragraphs
at the end of each line. This
option maintains a file’s original
line breaks and blank lines.

USING COMMANDS AND DIALOG BOXES
Once you start FrameMaker, you use commands, dialog boxes, and windows for
almost every task. You choose commands in FrameMaker just as you do in
other applications—by using a menu in the FrameMaker menu bar or by using
keyboard shortcuts. You can undo most commands with the Undo command on
the Edit menu. If you need help on a command, dialog box, or window, you can
choose a Help command, click a Help button, or start context-sensitive Help.
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FrameMaker uses dialog boxes and windows to accept input from you. The
document window is only one of the windows you see in FrameMaker; the
others look like dialog boxes. Dialog boxes must be dismissed before you can
continue working in your document. Windows, such as the Spelling Checker
and Find/Change windows, can remain displayed while you work. Some text
boxes in dialog boxes and windows display a preset measurement—the display
units (inches or centimeters, for example). You can change these settings for
each document.

To choose a command from a menu
You can choose commands from the menus in the menu bar, and you can
choose some frequently used commands such as Cut, Copy, and Paste from the
Maker menu.
FrameMaker provides keyboard shortcuts for each menu command. As you
become familiar with the application, you may want to use the keyboard
shortcuts to choose commands because keyboard shortcuts are faster to use.
Keyboard shortcuts appear on the menu to the right of the command. For a
complete list of shortcuts, see the Quick Reference.

Keyboard shortcuts (! represents
the Esc key)

■

To choose a command from the menu bar, click the menu name and then click the
command on the menu.

Or point on the menu name, hold down the mouse button, move the pointer to
highlight your choice, and release the mouse button.
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■

To choose a command from the Maker menu, point anywhere inside the document
window, hold down the right mouse button, move the pointer to highlight your choice,
and release the mouse button.

Or click the right mouse button in the document window and then click the
command on the menu.

The Maker menu appears
when you press the right
mouse button.
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To choose a command by using a keyboard shortcut, point in the document window
and type the shortcut.

Because keyboard shortcuts are case-sensitive, be sure to type lowercase and
uppercase letters just as they appear on the menus. The ! key represents the
Esc key prefix. (This means you should press Esc before typing any other keys
in the shortcut. You can also use Control-r for the Esc key. Your system
administrator can change your setup so that the ! key represents a different key
or key combination. For more information, see the online manual Changing
Setup Files.) If a shortcut doesn’t seem to work at first, make sure that the Caps
Lock key is off and try it again. FrameMaker provides keyboard shortcuts for
nearly every command. For a complete list, see the Quick Reference.
UNDOING A COMMAND

You can cancel the effects of most commands by choosing Undo from the Edit
menu. If you choose a command that cannot be undone, FrameMaker asks
whether you want to continue. FrameMaker remembers only the last command
you used. Therefore, to cancel a command, choose Undo immediately.
IF YOUR MENUS LOOK DIFFERENT

Menus in your version of FrameMaker may look different from the menus
shown and described in the FrameMaker documentation. The documentation
describes the complete menus. However, your version of FrameMaker may
display a subset of the FrameMaker menus—quick menus—or may display a
site-specific menu configuration that has been customized for you. You can
display either complete menus or quick menus. You might want to use quick
menus when you aren’t using all the FrameMaker features. To display quick
menus, choose Menus>Quick from the View menu. To display complete menus,
choose Menus>Complete from the View menu.
You can also customize the menus shown in your version of FrameMaker. For
information on how to customize menus, see the online manual Changing Setup
Files. Contact your system administrator for information if your menus have
been customized.
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To use a dialog box
FrameMaker uses dialog boxes that contain scroll lists, pop-up menus, radio
buttons, command buttons, checkboxes, and text boxes. You work with scroll
lists, radio buttons, and checkboxes just as you do in other applications.
FrameMaker doesn’t accept any input in a document window while you have a
dialog box open.

Radio button

Text box
Checkbox

Pop-up menu

Command buttons
Selected command button

■

To choose from a pop-up menu, click the menu to reveal its contents and then click
the item you want.

You can also point on the menu, hold down the mouse button, move the pointer
to highlight your choice, and release the mouse button to make a selection from
a pop-up menu.
Pop-up menus in dialog boxes have a small bar on them to distinguish them
from text boxes. A pop-up menu gives several options, with the current option
showing. If you change your mind about using the pop-up menu, click outside
the menu or point outside it and release the mouse button.
■

To type a value in a text box, click in the text box and type.

Don’t press Return when you finish typing text unless you’re finished with the
dialog box. Pressing Return tells FrameMaker to execute the selected command
button.
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■

To apply changes and close a dialog box, click the preselected command button or
press Return.

The preselected command button displays a selection box around it when the
dialog box opens and has a name such as Set, Create, or Insert.
■

To cancel the changes and close the dialog box, click Cancel.

If you click Cancel when a pop-up menu is open, the command closes the menu.
Click Cancel again to close the dialog box.
■

To display help information on the dialog box, click Help.

The pointer changes to a question mark. Move the question mark over an item
and click to get help on that item.
To cancel the help request, press Control-c.
■

To select an option by using the keyboard only, press Tab until the item you want is
highlighted and then press the space bar.

Pressing the space bar when a pop-up menu is highlighted opens the pop-up
menu. Press the up and down arrow keys to highlight items in the pop-up
menu. Press the space bar again to select the highlighted item and to close the
pop-up menu.
FRAMEMAKER WINDOWS AND DIALOG BOXES

FrameMaker displays a window instead of a dialog box when you choose some
commands—for example, Find/Change and Spelling Checker. These windows
look much the same as dialog boxes—with any combination of pop-up menus,
text boxes, command buttons, radio buttons, checkboxes, and scroll lists—but
windows can stay open while you work. Before you work in a window, you must
make it active by moving your pointer over it (or, if you are set up in click totype mode, you must click in a window to make it active). When you want to
close a window, make it active and press Control-c (hold down the Control key
and press c). If you want to close the Help window, press Control-x, Control-c
(hold down the Control key and press x, and then hold down the Control key
and press c).

To use the QuickAccess bar
The FrameMaker QuickAccess bar gives you easy access to frequently used
commands.
■

To display the QuickAccess bar, choose QuickAccess Bar from the View menu.

■

To change the orientation of the QuickAccess bar, click

on the bar.

Using FrameMaker

2-21

BASIC PROCEDURES

2

Using commands and dialog boxes

■

To choose a command from the QuickAccess bar, click its command button.

For a list of commands and for information on using the QuickAccess bar, see
the Quick Reference or click
on the QuickAccess bar.
■

To close the QuickAccess bar, choose QuickAccess Bar from the View menu.

To chang e the preset display units
Some text boxes in dialog boxes and windows require a unit of measurement,
such as points or inches, for the value you type. The default units of
measurement—the display units—appear after the values in the text boxes. If
you type a value without a unit of measurement, FrameMaker uses the preset
display units.
1

Choose Options from the View menu.

2

In the View Options dialog box, choose a unit from the Display Units pop-up menu
and click Set.
USING DIFFERENT DISPLAY UNITS IN A TEXT BOX

If you want to use different display units for a particular entry, type the units;
FrameMaker will convert the entry to the correct number of preset display
units when you click the command button. Use this feature when you don’t
know the formula for converting one display unit to another. For example, if
your document’s display units are picas, and if you want to set a paragraph
indent of 1 inch, type 1" in the First Indent text box. When you click Apply,
FrameMaker converts the measurement to the number of picas that
corresponds to 1 inch.
To specify
Type this after the number
..........................................................................
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Centimeters

cm

Millimeters

mm

Inches

" or in

Picas

pc, pi, or pica

Points

pt or point

Didots

dd

Ciceros

cc or cicero
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To get online Help
The FrameMaker Help system is a guide to the parts of FrameMaker you work
with—windows and dialog boxes, controls and commands, and so on. It
complements this manual, which describes the work you can do with
FrameMaker and explains how to do it.
FrameMaker Help is also your access point to syntax descriptions, samples, clip
art, and FrameMaker’s online manuals.
You can get online Help by choosing a command from a document window’s
Help menu, by clicking Help on the main FrameMaker window, by turning on
context-sensitive Help, and by clicking a Help button in a dialog box. Open
online Help to see instructions on using it to get the information you need.
■

To see the Help main menu, choose Contents from the Help menu.

The FrameMaker Help main menu contains a list of topics for which help is
available. Click About Help to get information on how to use the Help system.
■

To activate context-sensitive Help, press the Help key on your keyboard or click Help
in a dialog box.

This changes the pointer to a question mark. Move the question mark over any
item in a document window or other window, dialog box, or menu, and click to
get help on that item. If you change your mind, you can cancel context-sensitive
Help when the pointer is a question mark by pressing Control-c.
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USING THE DOCUMENT WINDOW
Once you create or open a FrameMaker document, you work in a document
window through which you view the contents of the document. For each
document, you can change the way the document window looks according to
your preferences and needs.
Formatting
bar toggle

Paragraph Catalog button

Formatting
bar

Character Catalog button
Tools Palette button
Equations Palette button

Rulers

Page buttons
Status bar
Page status area

Zoom controls

FrameMaker provides several ways to customize the document window. You can
magnify your view of the document by using the Zoom buttons or the Zoom
pop-up menu. Or you can turn on the grid, rulers, and borders to help you line
up objects.
All of the items in the document window are discussed in the tasks that make
use of them. You’ll find information about the rulers, zoom controls, and page
buttons in this chapter.
If you want information on the status bar, which shows you the names of
paragraph, character, condition, and variable formats; the size and position of
graphic objects; and flow names (depending on the insertion point’s location or
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what is selected), see Chapter 5, “Format Catalogs,” Chapter 26, “Conditional
Documents,” Chapter 12, “Variables,” Chapter 14, “Editing Illustrations,” and
Chapter 20, “Flow Design.”
If you want information on the Paragraph Catalog, Character Catalog, Tools
palette, and Equations palette buttons, which display a small window of
formats or tools, see Chapter 5, “Format Catalogs,” Chapter 13, “Illustrating a
Document,” and Chapter 28, “Creating Equations.”

To zoom in and out
You can zoom in to focus on details or zoom out to display more than one page.
The Zoom pop-up menu shows the current zoom setting.
Zoom pop-up menu

Zoom Out button

Zoom In button
■

To make text and objects appear smaller and to fit more in the window, click the
Zoom Out button.

■

To magnify text and objects, click the Zoom In button.

FrameMaker zooms in on the area of the page containing the insertion point or
a selected object. If there’s no insertion point, and if nothing is selected on the
page, FrameMaker zooms in on the center of the page.
■

To display text and objects at a particular percentage, choose a percentage from the
Zoom pop-up menu.

■

To display the entire page in the current window, choose Fit Page in Window from the
Zoom pop-up menu.

■

To resize the window so that it is the same size as the page, choose Fit Window to Page
from the Zoom pop-up menu.

To customize the zoom settings
FrameMaker provides default zoom settings. You can change these settings to
fit your needs. For example, if documents displayed at 126 percent work best on
your monitor, you can create a setting for 126 percent. This procedure explains
how to change the zoom settings for a document. If you want to customize the
zoom settings FrameMaker uses when you start it, see the online manual
Changing Setup Files.
1

Choose Set from the Zoom pop-up menu.
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2

In the Zoom Menu Options dialog box, select the percentage you want to change,
and type the new percentage.

FrameMaker sorts the values from lowest to highest, so you can type values in
any text box.
To return to the default percentages, click Get Defaults.
3

Click Set.

To use document window guides
FrameMaker provides four different types of window guides—borders, text
symbols, rulers, and grid lines—to help you work with a document.
Rulers

Grid lines
Text symbols
Borders

You can turn guides on when you need them and off when you want to see how
your document will look when it’s printed. Even if displayed, these guides do
not appear in the printed document.
■

To display the borders, choose Borders from the View menu.

Borders are dotted lines that define the edges of text frames, graphic frames,
and imported objects.
■

To display the text symbols, choose Text Symbols from the View menu.

FrameMaker uses text symbols to show tabs, ends of paragraphs and text flows,
markers, and other items. You can display or hide text symbols by choosing Text
Symbols from the View menu. For a list of all the text symbols, see “Text
symbols,” next.
Text symbols are visual cues that give you information about content, position,
and format of objects in a document. You can move, copy, delete, and search for
these symbols. Working with Text Symbols on can help you make precise
editing changes—for example, selecting text at the end of a paragraph without
selecting the end-of-paragraph symbol.
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To display the rulers, choose Rulers from the View menu.

The rulers help you accurately place text and objects. The top ruler can be
expanded to a formatting bar that displays pop-up menus for formatting text.
■

To display the grid lines, choose Grid Lines from the View menu.

The grid lines provide visual cues to help you accurately place text and objects.
■

To hide a document window guide, choose the command that displayed it from the
View menu.

If a command is turned on, choosing it again from the View menu turns the
command off.
TEXT SYMBOLS

Here are the symbols you may see in a document window when you turn on
Text Symbols.
Symbol
Meaning
..........................................................................

¶

End of paragraph

§

End of flow
Tab
Anchored frame or table anchor
Marker
Forced line return
Manual equation alignment point
Nonbreaking space
Discretionary hyphenation
Suppressed hyphenation

In addition, you can show or hide Macintosh publisher boundaries, [ ], by
pressing Esc v l (lowercase L).

To chang e grid and ruler intervals
You can change the spacing of the intervals on the rulers or on the grid. When
you change the intervals, you change only the distance between the lines
displayed on the rulers and the lines on the grid. Objects on the page do not
change position.
1

Choose Options from the View menu.
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Choose a new setting from the Rulers pop-up menu or from the Grid Lines
pop-up menu.

Grid Lines pop-up menu

Rulers pop-up menu

3

Click Set.

MOVING THROUGH A DOCUMENT
As you’re working in a document, you’ll need to display different pages.
FrameMaker provides several ways for you to move through a document—by
displaying the next or previous page, by going to a specific page or line or to the
page containing the insertion point, or by scrolling one line or one screen of text
at a time. If moving around your document is slow, you can turn off the graphics
display or display small text as a gray bar.
You can control the direction in which FrameMaker scrolls pages on your
monitor. You can scroll up and down or left and right.

To display a specific page
FrameMaker provides several ways for you to display specific pages in the
document window.
Page status area

Previous Page button
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■

To display the next page, click the Next Page button.

■

To display the previous page, click the Previous Page button.

Next Page button

■

To display the first page, Shift-click the Previous Page button.

■

To display the last page, Shift-click the Next Page button.

■

To display a specific page, click in the page status area.
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Specify which page you want and click Go.
Select
To go to
And
..........................................................................

Page Number

A numbered page

Page Containing
the Insertion Point

The page where you
last clicked

Line Number

A particular line in
the current flow

Type the page number in
the text box

Type the line number in
the text box

You can also display the Go to Page dialog box by choosing the Go to Page
command from the View menu.

To display pages faster
If you want FrameMaker to display pages faster, and if you don’t need to see the
graphics, you can turn off the graphics display.
Another way to save time when displaying pages is by greeking text—
displaying any text that’s smaller than a specified size as a gray bar.
■

To turn off the graphics display, choose Options from the View menu, turn off Graphics,
and click Set.

FrameMaker hides all drawings that have been created with FrameMaker
drawing tools and all imported graphics.
■

To display small text as a gray bar, choose Preferences from the File menu, type a
point size in the text box after Greek Screen Text Smaller Than, and click Set.

Whenever you have text in your document that is smaller than the point size
you type here, FrameMaker displays that text as a gray bar.

To set how pages scroll
You can control the way FrameMaker scrolls a document. Select a scrolling
method based on how you prefer to work. For example, you might want to scroll
through facing pages when you’re laying out a newsletter.
1

Choose Options from the View menu.
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In the View Options dialog box, choose one of the four options from the Page Scrolling
pop-up menu and click Set.
Select
To display pages
..........................................................................

Vertical

From top to bottom (for example, page 2 below page 1)

Horizontal

From left to right (for example, page 2 to the right of
page 1)

Facing Pages

Side by side

Variable

As many pages as will fit in the window from left to right

SAVING A DOCUMENT
As you work, save early and often; don’t wait until you finish working. As an
added precaution, FrameMaker can back up your file when you save it and
periodically while you work. Sometimes, when you’re working on a document,
you may want to throw away the changes you’ve made and start again.
FrameMaker provides a command so you can easily revert to the last-saved
version of a document.
You can also save a document in a different format, with different access
permissions, or with a different name or pathname.
When you close a document or exit FrameMaker, you can save the document at
that time. The instructions that follow are for saving while you work on a
document. For information on saving a document when exiting, see “To close a
document” on page 2-42.

To save a document
Save your document frequently.
■

To save changes made to the current document, choose Save from the File menu.

If this is the first time you’ve saved the file, FrameMaker displays the Save
Document dialog box. Type a new name for the file and click Save. For more
information on saving a document for the first time, see “To change a
document’s name, location, or file format” on page 2-31.
■
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To revert to the last-saved version
If you make changes to a document and then decide you don’t want to keep the
changes, you can return to the last-saved version of the document. If the
document was saved automatically since the last time you saved it, you are
returned to the version you saved, not the one FrameMaker saved for you. For
information on automatic saving, see “To back up and save automatically” on
page 2-35.
1

Choose Revert to Saved from the File menu.

2

In the dialog box, click OK to confirm the choice.

FrameMaker opens the version of the document you last saved when you used
the Save or Save As command. FrameMaker does not open its own
automatically saved version.

To chang e a document’s name, location, or file format
When you save a document, you can change its name, its location, or its file
format. When you change a document’s name or location, you create a copy of
the document. For information on the different types of file formats available,
see “File formats you can save” on page 2-31.
1

Choose Save As from the File menu.

FILE FORMATS YOU CAN SAVE
You can save a file in several formats.
Produces a regular FrameMaker
document. This format is the most compact and
requires the least amount of time to save and open.

Normal

Produces a document that users can
open but can’t edit. If you accidentally save a file in
View Only format, you can unlock it by moving the
pointer inside the document window and pressing
Esc F l (lowercase L) k. Then you can save the
document in Normal format.

View Only

Creates an ASCII text file that
contains FrameMaker statements that describe all
text and graphics. When you save a document in
Maker Interchange Format (MIF), add a .mif

Interchange - MIF

extension to the end of the filename to avoid
overwriting your FrameMaker document the next
time you save it. For more information on MIF, see
the online manual MIF Reference.
Creates a text file without graphics or
formatting information. To avoid overwriting the
formatted document, it’s a good idea to save the
text file under a name different from that of the
current document and to add a .txt extension to
the end of the filename. When you save a document
as text, FrameMaker queries you about how you
want to treat the text and any tables in your
document. For information on saving a document
as text, see “To save a document in Text Only
format” on page 2-33.

Text Only

Using FrameMaker

2-31

BASIC PROCEDURES

2

Saving a document

2

Change the name of the document, open a different directory to hold the document,
or do both.

Format pop-up menu

Directory that will contain
the document

To save the document in a different directory, navigate through the directories
until the correct one is displayed. If the directory in which you want to save the
document is not displayed, you can type a new path for the file in the Save in
File text box.
3

Choose a file format from the Format pop-up menu.

For information on the different types of formats, see “File formats you can
save” on page 2-31.
4

In the Permissions area, select the type of access you want to provide to other users.

Turning on Read allows others to look at, copy, or print your document. If you
want others to be able to edit the document and save the changes, turn on
Write.
5

Click Save.

FrameMaker saves the document. If you have chosen Text Only format, you see
the Save As Text dialog box. For more information, see “To save a document in
Text Only format” on page 2-33.
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If you change the name of the document or open another directory to hold it,
you’ll have two copies of the document. However, the original document will not
reflect the changes you saved. If you want to save the changes made to the
document and then create a copy of the document, first save the document by
using the Save command. Then create another copy of the document by using
the Save As command. You can also use your window manager to save a copy of
a file by copying it into another directory.

To save a document in Text Only format
Saving a document in the Text Only format creates an ISO Latin-1 text file.
When you save a document as text, FrameMaker asks how you want to treat
the text and any tables in your document. Only the text in text frames and
tables is saved; text lines, footnotes, graphics, and formatting information will
not be saved. (A text line is a single line of text that FrameMaker treats
independently from other text. Text lines are often used for callouts in
illustrations.) When you save a FrameMaker document containing table cells as
a text-only file, you can have FrameMaker write the cells across rows or down
columns. Reformat line lengths and hyphenation to the way you want them
before saving the file. For information on reformatting line lengths, see “To
control hyphenation” on page 4-23 and “To control line breaks” on page 4-25.
1

Follow the usual steps for changing a document’s file format.

For details, see “To change a document’s name, location, or file format” on
page 2-31. With a text-only document, a dialog box appears before the
document is actually saved.
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Choose how you want to save the text.

Select where you want to
place Returns.
Choose how to write table
cells from the pop-up menu.

Selection
Text example
Comment
..........................................................................

3
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At the End of
Each Line

Line-oriented file such as
computer code

Breaks the text into
paragraphs at the end of
each line. This option
maintains a file’s original
line breaks and blank lines.

Only between
Paragraphs

Paragraph-oriented file
such as a file containing
document text

Merges adjacent nonblank
lines into paragraphs and
breaks the text into
paragraphs at a blank line.

As Paragraphs
Row by Row

Table with text that you
read across rows (for
example, a parts list)

Creates a paragraph for
each item in the first row,
then creates a paragraph
for each item in the next
row, and so on.

As Paragraphs
Column by
Column

Table with text that you
read down columns (for
example, a calendar that
shows what is scheduled
for the next four
Thursdays)

Creates a paragraph for
each item in the first
column, then creates a
paragraph for each item in
the next column, and so on.

Skip

Any table

Ignores the table and
doesn’t save any text in it.

Click Save.
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CONVERTING SPACES IN TEXT FILES

When FrameMaker converts a document to text, it handles some space
characters in special ways. Numeric spaces appear as a space character.
Nonbreaking spaces appear as \x11, thin spaces as \x12, en spaces as \x13,
and em spaces as \x14. If you want all space characters to be saved as regular
space characters in the text file, change the Maker.textCharacterEncoding
resource to ASCII. See the online manual Changing Setup Files for more
information.
If you are sharing text files with special spaces across platforms, refer to the
online manual Using Frame Products on Multiple Platforms for information.

To back up and save automatically
Using FrameMaker preference settings, you can choose two ways to back up
your work—Automatic Backup on Save and Automatic Save. In each case,
FrameMaker writes the backup file to the directory in which the document is
saved. For information on how FrameMaker creates these files, see
“Automatically created files” on page 2-35.

AUTOMATICALLY CREATED FILES
FrameMaker automatically creates backup and
autosave files that save your document in case you
want to go back to an earlier version. It also
creates recover files if your system crashes.
.backup files When you have turned on Automatic
Backup on Save in the Preferences dialog box,
.backup files are automatically created when you
choose Save. This creates a copy of the file before
your latest changes are saved. The backup copy is
named filename.backup (where filename is
the name of your document and .backup is a
filename extension provided by FrameMaker). If
filename.backup already exists, the new
backup file overwrites it.
.auto files When you have turned on Automatic
Save in the Preferences dialog box, .auto files
are automatically created at regular intervals. You
don’t have to choose Save. Automatic Save saves

the current document at regular intervals to an
autosave file named filename.auto (where
filename is the name of your document and
.auto is a filename extension provided by
FrameMaker). When you save manually (using
Save or Save As) or revert to the last-saved version
with the Revert to Saved command, FrameMaker
deletes the autosave file.
.recover files If your system begins to crash,
FrameMaker tries to create a recovery file with
your most recent changes before the system
finishes crashing. This file is named
filename.recover (where filename is the
name of your document and .recover is a
filename extension provided by FrameMaker).
Even though FrameMaker tries to create this file,
you should still regularly save your work, and not
rely on a .recover file.
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Automatic Backup on Save creates a backup copy of the current document when
you choose the Save command.
Automatic Save saves the current document at regular intervals to an autosave
file. Automatic Save can protect you from losing work in the event of an
equipment or software failure.
FrameMaker doesn’t automatically save a copy of a document unless you made
a change to it since the last time it was saved.
1

Choose Preferences from the File menu.

2

Select an automatic save option.

3

Click Set.

To create a backup file
every time you save, click
here.
To turn on autosave, click
here and type the number
of minutes you want
between saves.

IF YOUR SYSTEM CRASHES

Open the document on which you were working. If a recover file exists,
FrameMaker asks whether you want to open it. Open the file and check to see if
your latest changes are there. If so, save this file with the same name as the
document you were originally working on and then delete the recover file.
If FrameMaker didn’t create a recover file, it looks for an autosave file. Save the
autosave file with the same name as the file you were originally working on.
This file has all the changes you made up until the time of the last autosave.
The amount of changes lost depends on the time you set between saves and
when your system crashed.
For information on how FrameMaker names recover and autosave files, see
“Automatically created files” on page 2-35.
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PRINTING A DOCUMENT
FrameMaker is preset to print one copy of the entire document on a preselected
printer. You can customize printing the document in several ways—for example,
by printing a document double-sided or by printing a scaled image of your
document.
FrameMaker remembers all the settings you specify, except for the starting and
ending page range. The next time you print the document, FrameMaker
displays the changed settings in the Print dialog box.
If several people are using the same printer, you may want to check the printer
queue before sending a document to print. If the queue is long, you may want to
send the document to another printer. For information on how to use the printer
queue, see “To manage the printer queue” on page 2-41.
Printing speed depends on the complexity of the pages. A page containing a
complex graphic takes longer to print than one containing only text in a single
font. Many printers cannot print along the outer margins of a page. If you place
text or a graphic too close to the page edge, it may not appear in the printed
document. Also, if you turned off Graphics in the View Options dialog box,
graphics will not appear in the printed document.
For information on printing a book made up of several documents, see “To print
files” on page 24-24. For information on printing color documents, see “Printing
colors” on page 17-13.

To print a document
Before you print a document, it is a good idea to check the spelling and to
update the cross-references if the document contains any. For information on
spell-checking a document, see Chapter 9, “Spelling and Word Choice.” For
information on updating cross references, see “To update cross-references
manually” on page 10-19.
1

Choose Print from the File menu.
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Specify the page range you want to print.

Specify the pages to print.

Type the number of copies
to print.
Type the name of the
printer.

Click All to print the entire document or type page numbers to print part of the
document.
The Start Page text box always displays the current page number, but you can
change it. To print one page, type the same page number in both the Start Page
and End Page text boxes. Type a starting page number and an ending page
number to print a few of the document’s pages.
3

Make sure the printer listed is the one you want.

If you need to change the name of the printer, see your system administrator for
the names of the printers you can use.
4

If you need to change the number of copies, type the number in the Copies text box.

5

Make sure the numbers in the Printer Paper Size area match the size of paper in the
printer.

If your document’s pages are larger than the size of the paper, you’ll see an
alert. If you decide to print the document, the printer crops the document so it
fits on the page.
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Make sure all the other settings are correct.

For information on the other settings in the Print dialog box, see “To customize
printing,” next.
7

Click Print.
CHANGING THE PRINTING SETTINGS FOR A DOCUMENT

If you want to change the printing settings for a document, but don’t want to
print it yet, change the settings in the Print dialog box and click Save Settings
Only. For example, if you’ve just printed multiple copies of a document and
want to make sure that the next time you print the document you print only one
copy, change the number of copies in the Copies text box to 1 and click Save
Settings Only. Nothing will print now; but, the next time you click Print,
FrameMaker will print only one copy.

To customize printing
If you want to customize the way your document is printed, you have a number
of options to choose from—for example, printing double-sided pages, adding
registration marks for a commercial print shop, and printing reduced images of
several pages on one piece of paper.
When you change a setting in the Print dialog box, FrameMaker keeps track of
the changes, except for the starting and ending page range. The next time you
print a document, FrameMaker displays the changed settings as the defaults.
■

To have FrameMaker print one complete copy before printing the next copy, turn on
Collate when you’re printing multiple copies.

Printing might be slower when Collate is turned on. If you don’t care how
printed pages are sorted, you can turn Collate off to print faster.
■

To print a double-sided document if you’re not using a duplex printer, print the oddnumbered pages, turn the paper over in the printer, and print the even-numbered
pages.

Turn on Odd-Numbered Pages and turn off Even-Numbered Pages for the first
pass. Reverse the settings for the second. Depending on how your printer
produces pages, you may need to turn on Last Sheet First before you click Print,
because turning the paper over in the printer may reverse the page numbering.
■

To print a document starting with the last page, turn on Last Sheet First.

Use this option if your printer produces pages face up.
■

To print a document more quickly, turn on Low-Resolution Images.

FrameMaker prints imported images more quickly by lowering the resolution
quality. For final printing, turn this option off so you get the highest-resolution
graphics possible.
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■

To print a document for reproduction by a commercial print shop, turn on Registration
Marks.

FrameMaker prints crop marks and registration marks.
■

To print a reduced or enlarged page image, type a percentage in the Scale text box.

FrameMaker centers the scaled image on the page.
■

To print thumbnails (small images of several pages on one page), type values in the
Thumbnails text boxes.

In the Rows text box, type the number of thumbnails you want to print down
the page. In the Cols text box, type the number of thumbnails you want to print
across the page.
■

To ensure that colored items in the document print either 100% black or 100% white,
edit the beginning of the ps_prolog file.

For more information on PostScript printing controls, see the online manual
Changing Setup Files.
■

To print the document on paper that is not in your printer’s paper cassette, turn on
Manual Feed.

You must feed the paper into the printer while the document prints.
■

To print the document on a special paper size, type the paper dimensions in the Width
and Height text boxes.

These dimensions describe the physical size of the paper in the printer’s paper
cassette, not the orientation of the document.
■

To create a print file rather than print the document, turn on Print Only to File and type
the filename in the text box.

A print file is a description of the document in a language specific to your
printer. You might want to type an extension for your file that describes it—for
example, .ps for a PostScript file. You can edit a print file, convert it for use
with other printers, or send it to a service bureau for typesetting. You can also
print the print file by using the UNIX lpr command (the lp command in
System V).
If you are generating a PostScript file to be used for creating an Adobe Acrobat
(.pdf) file, click Acrobat Setup. For more information, see “Converting
FrameMaker files to Adobe Acrobat files” on page 27-36.
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To manage the printer queue
To print, FrameMaker uses the UNIX command that’s appropriate for your
system, usually either lpr or lp. Print jobs go into the UNIX printer queue.
You use UNIX commands to manage the printing of your documents. Type all
UNIX commands at a UNIX shell prompt.
Printer-queue commands appear in the two most popular forms of UNIX,
Berkeley Software Distribution (BSD) and System V. BSD is the UNIX used in
SunOS 4 computers, and System V is used in Solaris (SunOS 5) and HewlettPackard computers. If you’re not sure what version of UNIX your computer
uses, ask your system administrator or consult your UNIX documentation.
■

■

To list jobs in the printer queue for the default printer, do one of the following.
BSD

lpq

System V

lpstat

To list jobs in the printer queue for a printer other than the default printer, do one of the
following.
BSD

lpq -Pprinter-name

System V

lpstat -o printer-name

Replace printer-name with the name of the printer.
■

To remove a job from the default printer queue, do one of the following.
BSD

lprm job-number
Use the lpq command to obtain the job-number.

System V

cancel job-number
Use the lpstat command to obtain the job-number.

■

To remove all your print jobs from the default printer queue, do one of the following.
BSD

lprm -

System V

cancel -u login-ID
Replace login-ID with your login name.
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■

To remove all your print jobs from a printer queue on a named printer, do one of the
following.
BSD

lprm -Pprinter-name -

System V

cancel -u login-ID printer-name

Replace printer-name with the name of the printer. With System V, replace
login-ID with your login name.

CLOSING A DOCUMENT AND EXITING
FRAMEMAKER
When you’ve finished using a document, you can close it to remove the
document from your system’s memory. When you’re finished using
FrameMaker, you can exit it to end the current session. If you’re using a shared
license, as soon as you’ve finished your work you can either exit FrameMaker or
manually give up your license. Exiting FrameMaker automatically gives up
your license. For information on giving up a license, see “If you’ve lost your
license or want to give it up” on page 2-6. When you exit, FrameMaker asks
whether you want to save any changes that haven’t been saved.
Be sure to exit FrameMaker before exiting your window system or logging out.

To close a document
Close a document when you’re finished using it.
■

To close the current document, choose Close from the File menu.

If changes made to the document haven’t been saved, FrameMaker asks
whether you want to save the changes or cancel closing the document.
■

To close all open documents, hold down Shift and choose Close All Open Files from
the File menu.

To exit FrameMaker
Exit FrameMaker when you’ve finished all your document tasks.
■

To exit FrameMaker, click Exit in the main FrameMaker window.

If any modified documents are open and haven’t been saved, FrameMaker asks
whether you want to save the documents. After you indicate whether you want
to save each open document, FrameMaker asks whether it’s OK to exit. Click
OK to exit FrameMaker.
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FrameMaker provides the tools you need to put your words into print as
quickly and easily as possible.

You enter text by typing
You simply click and type in a document window to enter text. The text
flows to another line or column as you type—you need to press Return
only when you’re ready to start a new paragraph.When you reach the
end of a page, FrameMaker automatically creates a new page so that
text can flow freely from one page to the next.
When you click in a document, an insertion point appears where
FrameMaker will put text.
Coffee is consumed, either hot or cold, by
nearly one-third of the earth’s inhabitants. This
popular beverage is brewed from the roasted
and ground seeds of the tropical evergreen

Text you type appears at
the insertion point.

Along with the standard set of characters you see on your keyboard, you
can also type bullets, mathematical symbols, spaces of various widths,
international characters, and other special characters.

Smart Quotes and Smart Spaces help you type
Smart Quotes and Smart Spaces make entering text a little easier.
When Smart Quotes is on, every time you type a quotation mark or an
apostrophe, FrameMaker inserts a left or right one, depending on its
relationship to the text next to it. When Smart Spaces is on, you can’t
type more than one space at a time no matter how many times you
press the space bar, so you’ll always have one space between words and
between sentences.
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You can also import text
If the text you need is in another file, you can import the text to add it
to your document. You can use text from other FrameMaker documents,
from text files, and even from files created in other applications.
You can import text by copying it or by creating a reference to it. Text
imported by copying becomes part of the document. Text imported by
reference remains linked to the source document so that FrameMaker
can update it whenever the source changes.
You import text from documents created in other applications by using
filters—programs that convert text from one file format to another.
FrameMaker provides filters for several commonly used page layout
and word processing applications.

Quick, easy text editing
For text editing, FrameMaker is as flexible and straightforward as a
word processor. You can add or delete text, replace it with other text,
copy or move it to another location, and otherwise change text in any
way you want.
Brewing Coffee
Brewing Coffee

In this chapter
This chapter shows you how to type, edit, and import text in a
FrameMaker document. It also shows you how to manage the files from
which you import text.
For information on formatting text, either as you go along or after
entering the text, see Chapter 4, “Formatting Text,” and Chapter 5,
“Format Catalogs.”
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You enter text by typing in the document window. Any text you type appears at
the insertion point, which you can move in a variety of ways, including by
pressing the Tab key. You can type a variety of spaces and dashes, known as
special characters.
FrameMaker provides many features to make typing easier and more
automatic. Smart Quotes inserts the appropriate left or right quotation mark
when you type a straight quotation mark. Smart Spaces prevents you from
typing more than one space in a row.

To place the insertion point
The insertion point marks where you want to enter new text. You can put the
insertion point in any text in the document window and next to special text
items. For information on special text items, see “Special text items” on
page 3-8.
The location of the insertion point also determines which paragraph is the
current one. You need to know which is the current paragraph before you choose
a paragraph formatting command that applies to an entire paragraph. For
information on paragraph formatting commands, see Chapter 4, “Formatting
Text,” and Chapter 5, “Format Catalogs.”
1

Put the I-beam where you want to place the insertion point.

2

Click.

The insertion point appears where you click.
Insertion point

Click to move the insertion
point to this I-beam.

Coffee is consumed, either hot or cold,
by nearly one-third of the earth’s
inhabitants. This popular beverage is
brewed from the roasted and ground
seeds of the tropical evergreen coffee

Coffee is consumed, either hot or cold,
by nearly one-third of the earth’s
inhabitants. This popular beverage is
brewed from the roasted and ground
seeds of the tropical evergreen coffee

If you can’t place the insertion point in or next to text, the text is probably
background text. If so, display the master page that contains the text and then
put the insertion point in the text on that page. For information on master
pages, see “To display master or body pages” on page 18-10.
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MOVING THE INSERTION POINT WITH THE KEYBOARD

You can move an insertion point once it appears in the document window. Press
the arrow keys to move the insertion point. The up and down arrow keys have
no effect in a text line. (A text line is a single line of text that FrameMaker
treats independently of other text. Text lines are often used for callouts in
illustrations.)
Other keyboard commands are available for moving the insertion point—for
example, to the end of a line or the beginning of a paragraph. For information
on these commands, see Chapter 3, “Character Sets,” in the Quick Reference.

To use tabs
Tabs let you place text at specific horizontal locations in a line.
■

To move the insertion point and any text following it to the corresponding tab stop,
press Tab.

If Text Symbols on the View menu is on, a tab symbol ( ) appears on the screen
but does not appear in the printed document. If the current paragraph doesn’t
have any tab stops set, pressing Tab does not move the insertion point and text.
Tab stops
Tab symbol without a
corresponding tab stop

Reformatted text after
tab stop is added

A tab symbol is embedded in the text each time you press Tab even if the
current paragraph does not have tab stops. FrameMaker counts the number
of tabs in a line and moves the text one tab stop for each time you press Tab.
You may have several overlapping tab symbols in a line if you press Tab
more times than you have tab stops. If you later add tab stops to the paragraph,
FrameMaker tabs the text at the tab symbols.
For information on the types of tab stops you can add to a paragraph, see “To
define a tab stop” on page 4-15.
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ABSOLUTE TAB STOPS

FrameMaker tab stops are absolute rather than relative. Relative tab stops
mean that each time you press Tab, the insertion point moves to the next tab
stop. FrameMaker tab stops are absolute in that the nth tab on a line moves the
insertion point to the nth stop.

To type text
When entering text, all you need to do is type. FrameMaker automatically
wraps the text from one line to the next and adds a new page for you when you
reach the bottom of the current one.
1

Place the insertion point where you want to type the text.

2

Begin typing, pressing Return only when you want to begin a new paragraph.

The text appears as you type.
You can type all of the characters you see on the keyboard—and many more. For
information on bullets, symbols, fixed-width spaces, and other characters, see
“To type characters not on the keyboard,” next.
FORCING A LINE BREAK OR PAGE BREAK

Although FrameMaker wraps text automatically from line to line and from
page to page, you may want to force a line or page break at a specific location.
For more information, see “To control line breaks” on page 4-25 and “To start a
paragraph at the top of a column or page” on page 4-27.

To type characters not on the keyboard
FrameMaker lets you use combinations of keys to type fixed-width spaces,
dashes, symbols, and accented characters such as ç, ñ, and ö. You can also type
characters in the Symbol font, such as , ∴, and ∞. If the Zapf Dingbats font is
installed on your system, you can type any of the special symbols in that font—
for example, ❏, ▲, and ✓.
This section lists a few of the special characters you can type. For a list of
characters in the Symbol and Zapf Dingbats fonts, and a list of accented
characters in the standard character set, see Chapter 3, “Character Sets,” in the
Quick Reference. The chapter also shows the key sequence you use to type each
character. For information on changing the font of characters, see “To choose a
font family, style, and size” on page 4-8.
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To type fixed-width spaces, use one of the following key sequences.
To type
Press
..........................................................................

Em space

Esc space m

En space

Esc space n

Numeric space

Esc space one

Thin space

Esc space t

When you type a fixed-width space between two words, FrameMaker keeps the
words together on a line. For definitions of fixed-width spaces and tips on their
use, see “Using fixed-width spaces” on page 3-7.
■

To type a bullet, press Meta-period.

■

To type a dash, use one of the following key sequences.
To type
Press
..........................................................................

Em dash (—)

Control-q Q

En dash (–)

Control-q P

USING FIXED-WIDTH SPACES
When you press the space bar, FrameMaker
inserts a proportional space—that is, a space the
width of which varies depending on the characters
on either side. But there may be times when you’d
prefer a fixed-width space—for example, when you
want more space between two words or want to
line up numbers without using tabs or tables.
FrameMaker has four fixed-width spaces you
can use.
Em space The same width as the point size of the
font you use. For example, if you use a 10-point
font, an em space is 10 points wide.

En space

Half the width of an em space.

Numeric space The same width as the font’s zero
(0) character. All digits are typically the same
width. This space is useful for aligning numbers in
a column without using tabs.
Thin space One-twelfth the width of an em space.

A thin space is often used when a very small space
is needed to separate two characters—for example,
between a number and the unit of measure that
follows it.
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SPECIAL CHARACTERS IN DIALOG BOXES

Some special characters, including bullets and en and em dashes, appear in
dialog boxes as backslash (\) equivalents. For a list of these equivalents, see
Chapter 3, “Character Sets,” in the Quick Reference.
SPECIAL TEXT ITEMS

FrameMaker gives you a way to insert special text items such as crossreferences, footnotes, variables, and markers. Inserting a variable
automatically places the date, time, page count, filename, or text that you
define into a document. FrameMaker updates variables when they change.
Markers let you categorize text so all markers in the same category can be used
to generate a list such as a table of contents, an index, or a list of comments.
Markers can also be used to insert hypertext commands.
To insert any of these special text items, choose the appropriate command from
the Special menu and fill in the dialog box that FrameMaker displays. (The
Footnote command immediately lets you type a footnote. You don’t have to fill in
a dialog box.)
For more information on
See
..........................................................................

Cross-references

Chapter 10, “Cross-References.”

Footnotes

Chapter 11, “Footnotes.”

Variables

Chapter 12, “Variables.”

Markers for tables of
contents and indexes

Chapter 22, “Generated Lists,” and Chapter 23,
“Indexes.”

Markers for hypertext

Chapter 27, “Hypertext and View-Only
Documents.”

To use Smart Quotes or Smart Spaces
When Smart Quotes is on, FrameMaker uses curved left and right quotation
marks whenever you press the ', `, or " key. If you prefer to use straight
quotation marks, turn off Smart Quotes. FrameMaker uses a curved apostrophe
whether or not Smart Quotes is on. For information on customizing quotation
marks for languages other than US English, see the online manual Changing
Setup Files.
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When Smart Spaces is on, FrameMaker prevents you from typing more than
one space in a row. If you want consistent spacing between words and
sentences, turn on Smart Spaces. If you want to be able to type more than one
space in a row, turn off Smart Spaces. However, you can type multiple fixedwidth spaces whether or not Smart Spaces is on. (For information on typing
fixed-width spaces, see “Using fixed-width spaces” on page 3-7.)
1

Choose Document>Text Options from the Format menu.

2

In the Text Options dialog box, turn Smart Spaces or Smart Quotes on or off and
click Set.
OVERRIDING SMART QUOTES

You may want to use curved quotation marks most of the time and straight
quotes only occasionally—for example, in computer code or as the symbol for
inch ("). Or you may want to use straight marks most of the time and curved
marks only occasionally.
To type
With Smart Quotes on, press
With Smart Quotes off, press
..........................................................................

'

Control-'

Control-'

"

Control-"

"

`

Control-`

Control-`

´

Control-q +

Control-q +

‘ and ’

' and '

` and '

“ and ”

" and "

Meta-` and Meta-'

QUOTATION MARKS IN EXISTING DOCUMENTS AND DIALOG BOXES

When you turn on Smart Quotes, FrameMaker doesn’t change any quotation
marks that are already in the document. To correct straight quotation marks
and apostrophes, use the Spelling Checker. See “To check for typing errors” on
page 9-6.
Smart Quotes doesn’t apply to text in dialog boxes. For information on typing
quotation marks and apostrophes in dialog boxes, see Chapter 3, “Character
Sets,” in the Quick Reference.
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You can edit text once you select it—by moving it, copying it, deleting it, or
replacing it. When editing text, you’ll probably find it helpful to turn on
Text Symbols on the View menu to help you avoid accidentally deleting
paragraph symbols and markers.

To select text to edit
You must select text before you can edit it. When selected, text is highlighted.
You also select text before you change its format, such as its font size or style.
For information on text formatting commands, see Chapter 4, “Formatting
Text.”
■

To select a range of text, drag through the text.

Or click at the beginning of the text and Shift-click at the end.
■

To select a word, double-click it.

Double-clicking a word and then dragging extends the selection a word
at a time.
■

To select a paragraph, triple-click it.

Triple-clicking a paragraph and then dragging extends the selection a
paragraph at a time.
■

To select all the text in a flow, click in the flow and choose Select All in Flow from the
Edit menu.
CHANGING A SELECTION

To shorten or extend an existing selection, Shift-click at the new beginning or
end of the selection. To deselect text, click anywhere in the document window.

To move or copy text
You can move or copy text to a different location in the same document or in
another document. To do this, you put the text on the Clipboard and then paste
it where you want it.
1

Select the text you want to move or copy.

If you want to move or copy an entire paragraph, make sure you select the
paragraph symbol (¶) at the end of the paragraph.
2

From the Edit menu, choose Cut to move the text or choose Copy to copy it.

The text is placed on the Clipboard. It remains there until you cut or copy
something else. To see the contents of the Clipboard, you must paste them
somewhere.
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Click where you want to insert the text and choose Paste from the Edit menu.

If the pasted text contains paragraph symbols, the paragraph format associated
with each paragraph is also pasted. Otherwise, the pasted text takes the
paragraph format of the paragraph in which it’s pasted. Pasted text always
retains its original paragraph format’s default font and remains on the
Clipboard until you cut or copy something else. For information on how to
change the font of selected text, see Chapter 4, “Formatting Text.”
QUICK-COPYING TEXT

You can quick-copy text to another location without using the Clipboard. The
original text and the new location for the copy must be visible, but they can be
in different documents.
To quick-copy text, put the insertion point where you want to insert the text.
Hold down Control and, with the middle mouse button, select the text you want
to copy. FrameMaker pastes the selected text at the insertion point.

To delete text
Delete text when you want to remove it permanently from the document. If you
want to move the text to another location, use Cut and Paste on the Edit menu
rather than press Delete.
1

Select the text.

2

Press Delete.

You can also choose Clear from the Edit menu to delete selected text.
If the text you delete contains the end of a paragraph and the paragraph
symbol (¶), the text preceding and following the deleted text is merged into one
paragraph.
If you didn’t mean to combine the two paragraphs, immediately choose Undo
from the Edit menu. Then select the text you want to delete, but not the
paragraph symbol, and press Delete again.
REMOVING EMPTY PAGES AT THE END OF A DOCUMENT

You can tell FrameMaker to delete the empty pages at the end of a
document each time you save or print the document. To do this, choose
Document>Numbering from the Format menu. In the Numbering dialog box,
choose Delete Empty Pages from the Before Saving & Printing pop-up menu,
and click Set. If you change a body page layout but not its corresponding master
page layout, or if a custom master page is applied, these options will not remove
the blank page. (To remove such a page, you have to display it and choose
Delete Page from the Special menu.)
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If you choose Make Page Count Even or Make Page Count Odd, FrameMaker
leaves one blank page at the end of the document as necessary. These options
are helpful when you want every chapter in a book to start on the same side of
a page.
DELETING A PAGE OF TEXT

To delete a page of text, select the text and press Delete. If the page isn’t part of
the main text flow (if it’s a disconnected page), display the page and choose
Delete Pages from the Special menu. If the page contains the beginning of a
table that continues on another page, the entire table is deleted. For
information on connecting and disconnecting flows and pages, see “Controlling
the flow of text” on page 20-7.

To replace text
You can replace text—from a single character to an entire flow—at any time.
1

Select the text you want to replace.

2

Type the new text.

If the text you want to use is on the Clipboard, you can choose Paste to replace
selected text. FrameMaker deletes the existing text, and the new text appears
in its place. If the text you replace contains the end of a paragraph and the
paragraph symbol (¶), the beginning of the paragraph is merged with the next
paragraph in the document.
If you didn’t mean to replace the paragraph symbol, immediately choose Undo
from the Edit menu. Then select the text you want to replace, but not the
paragraph symbol, and type the replacement text again.

IMPORTING TEXT
You can import text into a FrameMaker document from another part of the
document, from another FrameMaker document, or from a file created in an
application, such as Microsoft Word, for which FrameMaker provides a filter. In
this case, FrameMaker filters the document as it is imported.
When you import text from a document, you import all the text and special text
items contained in a single flow of text. A text flow may be the whole document
or part of it, and the part can appear on non-consecutive pages, such as a
newsletter article that begins on one page and continues several pages later.
You can also import text into a FrameMaker document from a text file. In this
case, you import all the text in the file.
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You import text by copying or by reference. Importing by copying inserts a copy
of the text, which you can edit, into the document. Importing by reference
creates a text inset, linked to the text in the source document. When the source
text changes, FrameMaker can automatically update the text inset, or you can
update it manually.
When you import a text flow, you also decide how it’s formatted—whether it
retains the formatting it had in the source document or adopts the formatting of
the document into which it’s imported. When you import a text file, it adopts
the formatting used at the insertion point.
For more information on text flows, see “To import a text flow,” next. For
information on the special text items that can be imported in addition to the
text in a flow, see “What gets imported” on page 3-16. For information on
copying selections of text from other FrameMaker documents, see “To move or
copy text” on page 3-10. For information on the file formats that FrameMaker
can open, see “File types you can open” on page 2-12. For information on
FrameMaker filters, see the online manual Using Frame Filters.

To import a text flow
You import text into a FrameMaker document from another part of the
document or from another FrameMaker document. The text you import is a
single flow of text. With most documents, there is one main flow that contains
all the body text, but some documents contain several text flows. For example, a
newsletter might contain a separate flow for each article, with some articles
beginning on one page and continuing several pages later.
You can also import a text flow from a file created in another application, such
as Microsoft Word, for which there is a FrameMaker filter. In this case, the
filter converts the content of the file into a single text flow as it is imported.
When you import from a file created in another application, FrameMaker helps
you select the filter that converts the content from that file into the flow you
import.
When you import a flow, you also specify how to format the imported text and
whether to import by copying or by reference. A flow imported by copying
becomes part of the text flow into which you insert it. A flow imported by
reference becomes a text inset, linked to the text in the source document.
For more information on text flows, see Chapter 20, “Flow Design.” For
information on file formats that FrameMaker can open, see “File types you can
open” on page 2-12. For information on FrameMaker filters and for details on
how FrameMaker filters the contents of files created in other applications into
FrameMaker flows, see the online manual Using Frame Filters. For information
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on importing text from a text file rather than from a text flow, see “To import a
text file” on page 3-17.
1

Place the insertion point where you want to insert the text.

2

Choose Import>File from the File menu.

3

Specify the file that contains the flow you want to import and the import method.

Choose the file to import.

Choose how to import the
file.

For information on the Import by Reference and Copy into Document settings,
see “Import by copying or by reference” on page 3-15.
Type the name of the file you want to import in the File text box or select the
name of the file in the scroll list.
4

Click Import.

5

If you’re importing a file in a format FrameMaker doesn’t recognize, select a filter in
the Unknown File Type dialog box and click Convert.

The dialog box that appears depends on the import method you chose in the
Import File dialog box. The Import Text Flow by Reference dialog box contains
settings for specifying how to update the imported flow.
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Choose a body page flow or a reference page flow.

Reference pages can contain
boilerplate text and graphics, also in
multiple flows.

Body pages can contain
multiple flows.

Text appears on body pages. Reference pages can contain flows with boilerplate
text or graphics for use on body pages. For information on viewing flows on
reference pages, see “Working with reference pages” on page 19-22.
7

Specify how to format the text.

Overrides, such as tab
settings, may not suit the
new document.

Click to use the formatting
at the insertion point.

For more information, see “Formatting an imported text flow” on page 3-16.
8

If you selected Import by Reference in the Import File dialog box, specify how to
update the text inset.

Choose to update whenever
you open the document
containing the inset.

9

Choose to update only
when you specify.

Click Import.

The text appears in the document. If you imported the text by reference, it
appears in a text inset.
IMPORT BY COPYING OR BY REFERENCE

Importing a text flow or text file by copying inserts the text into the document
without maintaining a reference to the source file. This makes it easy to copy
the document from one location to another. However, if you make changes to the
source file, you must reimport the text to update the document with the latest
version.
Importing by reference lets you use the same text in several places and update
it in all of them at once. When you import a flow or text file by reference,
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FrameMaker stores the pathname of the source document along with the text
inset in the document. Each time you open the document, or whenever you
specify, FrameMaker locates the source file on the disk and updates the
document with the latest version.
WHAT GETS IMPORTED

When you import a flow, you import the text in the flow and any crossreferences, footnotes, variables, and markers contained in the flow. For
information on these special text items, see “Special text items” on page 3-8.

FORMATTING AN IMPORTED TEXT FLOW
You can format an imported text flow by using
matching-tag formats in the current document. You
can reformat as plain text—that is, use the format
of the text at the insertion point. Or you can retain
the formatting it had in the source document.

Reformat Using Current Document’s Formats Applies
the current document’s formats to the imported
text, whenever their tags match. If the tags don’t
match, the formatting of imported text is
unaffected.

If you want imported text to use the current
document’s formats (or if you later want to be able
to modify the imported text’s formats when you
modify the current document’s formats), make sure
the imported text’s paragraph and character tags
match those in the current document. Similarly, if
you want tables, cross-references, and variables to
be formatted and updated from the current
document, make sure that the imported text’s table
tags, variable definitions, and cross-reference
formats match those of the current document.

When you import, removing manual page breaks
and other format overrides (such as tab settings)
that exist in the source document ensures that
formats in the imported text match the appearance
of the formats with the same tags in the current
document.

For details on using consistent paragraph and
character formats, see “Tips on creating formats”
on page 5-12. For information on paragraph and
character formats and catalogs, see Chapter 4,
“Formatting Text,” and Chapter 5, “Format
Catalogs.” For information on table formats, see
Chapter 7, “Table Formats.” For information on
variable definitions, see Chapter 12, “Variables.”
And for information on cross-reference formats, see
Chapter 10, “Cross-References.”
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Reformat as Plain Text Removes the formatting the
text had in the source document and applies the
character and paragraph formatting used at the
insertion point. However, formatting of text in
tables or anchored frames retains the formatting it
had in the source document.

Keeps the formatting
the text used in the source document. Formats in
the imported text aren’t added to the current
document’s format catalogs. If you later modify the
current document’s formats (paragraph, character,
table, or cross-reference formats, or variable
definitions), the imported text formats won’t be
affected—even if the tags in the current document
and imported text match.

Retain Source’s Formatting

Importing text

.....

EDITING TEXT

If the flow contains tables or anchored graphic frames, they are also imported,
including the contents of the frames. Conditional text in the flow is also
imported.
Condition tags applied to text in the source document are imported, so you can
show and hide the imported conditional text in the usual way. For details, see
“Viewing imported conditional text” on page 26-17.
IMPORTING A MIF FILE

Maker Interchange Format (MIF) is an ASCII format that lets you exchange
information between FrameMaker and other applications. To import the text in
the main flow of a MIF file that has been saved on disk, use import by reference.
FrameMaker imports the file without interpreting its commands. Using import
by copying to import a MIF file that has been saved on disk imports the text
and also interprets the commands in the MIF file—for example, commands
that alter master pages in the document or change the appearance of the
document window or the menu bar. The text imported by copying appears on
a disconnected page. For information on connecting and disconnecting pages
and flows, see “Controlling the flow of text” on page 20-7. For more information
on MIF, see the online manual MIF Reference.

To import a text file
You specify whether to import a text file by copying or by reference, and how to
treat lines in the text file. The imported text adopts the formatting of the text at
the insertion point.
For information on importing text from a FrameMaker document, see “To
import a text flow” on page 3-13.
1

Place the insertion point where you want to insert the text.

2

Choose Import>File from the File menu.

3

In the Import File dialog box, specify the text file you want to import and the import
method.

Type the name of the text file you want to import in the File text box or select
the name of the text file in the scroll list.
For information on the Import by Reference and Copy into Document settings,
see “Import by copying or by reference” on page 3-15.
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Importing text

4

Click Import.

The dialog box that appears depends on the import method you chose. The
Import Text File by Reference dialog box (shown here) contains settings for
specifying how to update the imported text file.

5

Specify how to treat the imported text.
Selection
Text example
Comment
..........................................................................

6

Choose to update
whenever you open the
document that contains
the inset.
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Merge Lines into
Paragraphs

Paragraph-oriented
text file such as a file
that contains
document text

Merges adjacent nonblank
lines into paragraphs and
breaks the text into paragraphs
at a blank line.

Treat Each Line
as a Paragraph

Line-oriented text
file such as
computer code

Breaks the text into
paragraphs at the end of each
line.

Convert to Table

Text file containing
delimited text into a
new table at the
insertion point

The Convert to Table dialog box
appears so you can specify the
table format and other settings.
See “To convert existing text to
a table” on page 6-25.

If you’re importing the text file by reference, select an update method.

Choose to update only
when you specify.

7
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Managing text insets

Click Import.

The text appears in the document. If you imported the text by reference, it
appears in a text inset.

To replace imported text
You may need to replace imported text if its source has changed and if you
imported it by copying. Or you may simply need to replace one text inset with
another. In either case, FrameMaker places the new text in the same location as
the old text.
1

Select the imported text or click in the text inset.

2

Import the new text.

MANAGING TEXT INSETS
When you update a document that contains text imported by reference,
FrameMaker looks for the source file and then updates the text inset in the
document. In looking for the source file, FrameMaker uses the pathname that
was specified when the file was imported. For information on the pathname, see
“How FrameMaker locates imported files” on page 3-20.
FrameMaker may not be able to find the source file of a text inset for several
reasons.
• The document was moved to a new location, but the source files weren’t.
• The source file was removed or moved to a new location.
• The source file was renamed.
• The directory that contains the source file was renamed.
If FrameMaker can’t find the source file it’s looking for and can’t update the
inset, it displays an alert. You can reimport the source file from its new location
using the Import>File command on the File menu.
At other times, a document may contain an inset from a file with a name you
can’t remember. If so, you can look up its filename.
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To organize files for importing text
You’ll find it easier to maintain your source files and the FrameMaker
documents that contain text imported from them when you follow a few simple
guidelines for organizing the files.
■

Keep all source files for a document in one directory.

It’s easier to move or copy files in a single directory than to move or copy files
scattered in several directories.
■

Put source files in the same directory as the document or in a directory below the
document directory, and import them by reference.

If you move the document directory (and its subdirectories) to another location,
FrameMaker can still find the source files when you update text insets in the
document. For source files used with several documents, see the next guideline.
■

Put source files that may be used in several documents in a central directory, and
import them by reference.

If a source file is changed, all documents that contain the source file’s text can
be updated.
■

Use a filename extension to indicate the source file type.

For example, you could use the extension .txt for text files. You may even
want to create separate subdirectories for different types of source files.
■

Give source files descriptive names.

Documents are much easier to maintain when source files have filenames such
as midwest.rpt rather than import1.doc.

HOW FRAMEMAKER LOCATES IMPORTED FILES
The pathname that FrameMaker stores for a file
imported by reference is usually relative. That is,
it shows the location relative to the directory of the
document that contains the imported text. For
example, files/East is a relative pathname
indicating that East is in the files
subdirectory of the document’s directory. However,
if FrameMaker has to traverse the root of the file
system when building the pathname, it uses an
absolute pathname that begins at the root (/).
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For example, /usr/sales/files/East is an
absolute pathname.
Because FrameMaker stores relative pathnames
whenever possible, it continues to find the file even
when you move the document and source files to a
different directory—as long as you keep the files in
the same relative locations. And if you save the
document in a different directory, FrameMaker
adjusts the pathnames of the imported files
accordingly.
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■

Consider the file-naming conventions of each computer platform on which you use
your FrameMaker documents.

For example, the Macintosh doesn’t allow colons in filenames, Windows 3.1
allows filenames of up to eight characters with a three-character extension, and
spaces can cause problems on UNIX platforms. For more information, see the
online manual Using Frame Products on Multiple Platforms.

To view the properties of a text inset
You can view the filename and file type of the source document, the date it was
last modified, the date the text inset was last updated, and the inset’s update
setting.
1

Click the text inset to select it.

2

Choose Text Inset Properties from the Edit menu.

You can also double-click the inset. When you double-click, you don’t have to
select it first.
DISPLAYING THE SOURCE OF A TEXT INSET

You can open the source of a text inset from the document by clicking Open
Source in the Text Inset Properties dialog box.
MACINTOSH SUBSCRIBERS ON NON-MACINTOSH PLATFORMS

Text imported on the Macintosh with Publish and Subscribe creates a
Macintosh subscriber—a text inset that has a Macintosh edition file as its
source. On platforms other than the Macintosh, status information and some
options in the Text Inset Properties dialog box are unavailable—for example,
opening the source, changing update or format settings, and updating. For more
information, see the online manual Using Frame Products on Multiple
Platforms.
CREATING A LIST OF TEXT INSETS

You can create a list of all the text insets in a document. For information, see
“To generate a list” on page 22-7.
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To chang e the updating of a text inset
When you create a text inset by importing a text flow or a text file by reference,
you specify either automatic or manual updating. If you specify manual,
you can update the text inset manually, either on its own or together with
all the insets in the document. If you specify automatic, the inset updates
automatically when you open the document. You can later suppress automatic
updating of all updates, and you can change how any single inset updates.
1

Click the text inset to select it.

2

Choose Text Inset Properties from the Edit menu.

3

In the Text Inset Properties dialog box, click Settings.

4

In the dialog box that appears, specify a new update setting and click Set.

To suppress automatic updating of all text insets
Text insets set for automatic updating are updated when you open the
document. You can improve the opening time of a document by suppressing
automatic updating. Later you can update the insets manually, either singly or
all at once.
1

Choose Update References from the Edit menu.

2

In the Update References dialog box, choose Suppress Automatic Updating from the
Commands pop-up menu.

3

In the Suppress Automatic Reference Updating dialog box, turn on Suppress
Automatic Updating of All Text Insets and click Set.

4

In the Update References dialog box, click Done.
MANUALLY UPDATING A SINGLE TEXT INSET

You can update a single text inset manually by selecting it and choosing Text
Inset Properties from the Edit menu. In the Text Inset Properties dialog box,
click Update Now.
MANUALLY UPDATING MULTIPLE TEXT INSETS SIMULTANEOUSLY

You can simultaneously update all the insets in a document that are marked for
either automatic or manual updating. To do so, choose Update References from
the Edit menu, select which text insets you want to update in the Update
References dialog box, and click Update. FrameMaker updates the text insets
you specify if their source has changed on disk since the last update.
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CONVERTING A TEXT INSET TO EDITABLE TEXT

You can convert a single text inset or all the text insets in a document. First,
click the text inset to select it. Then choose Text Inset Properties from the Edit
menu. In the dialog box, click Convert to Text. The Convert Text Insets to Text
dialog box appears. Click Selected Text Inset or All Text Insets and click
Convert. When you convert a text inset to text, FrameMaker no longer
updates it.
CANCELING THE UPDATING

You can interrupt the updating of text insets in a document by pressing
Control-c.

To locate the source for an unresolved text inset
If FrameMaker can’t locate the source file for a text inset during updating (or if
the format of the source file has changed since the last update), FrameMaker
displays the Unresolved Text Inset alert box. You can locate the unresolved text
inset and search for its source file. You use the Find/Change window to locate
the unresolved inset. Alternatively, you can generate a list of unresolved insets.
1

Click Continue to dismiss the alert box.

2

Choose Find/Change from the Edit menu.

3

In the Find/Change window, choose Unresolved Text Inset from the Find pop-up menu
and click Find.

FrameMaker finds the first unresolved text inset and selects it.
4

Choose Text Inset Properties from the Edit menu.

In the Text Inset Properties dialog box, note the pathname and file type of the
source of the inset. For details, see “To view the properties of a text inset” on
page 3-21.
5

Click Cancel to dismiss the Text Inset Properties dialog box and then reimport the text.

Follow the steps in “To import a text flow” on page 3-13 or in “To import a text
file” on page 3-17 to reimport the text. Use the information in the Text Inset
Properties dialog box to help you locate the source of the inset.
You can search for other unresolved insets and their sources by repeating
steps 3 through 5.
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MACINTOSH SUBSCRIBERS ON NON-MACINTOSH PLATFORMS

If a file contains subscribers and you try to update text insets in the file (or if
you try to open the file when text insets are set to update automatically) on
platforms other than the Macintosh, FrameMaker cannot update the subscriber
and notifies you that the document contains unresolved text insets. To update
or modify a text inset created by subscribing to text, update the file on the
Macintosh or, if possible, reimport the source text using the Import>File
command on the File menu. For more information, see the online manual Using
Frame Products on Multiple Platforms.
GENERATING A LIST OF UNRESOLVED TEXT INSETS

You can generate a list of unresolved text insets by page number, with the
imported text and graphics in each inset indicated. For details on generating a
list, see “To generate a list” on page 22-7.
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USING THE FORMATTING BAR
AND THE DESIGNER WINDOWS 4-6
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CONTROLLING PAGE BREAKS 4-26

To display the formatting bar 4-6

To start a paragraph at the top of a column or
page 4-27

To display a designer window 4-6

To start a paragraph wherever there’s room 4-27
To keep paragraphs together 4-28

SPECIFYING FONT PROPERTIES 4-7

To control widow and orphan lines 4-28

To choose a font family, style, and size 4-8
To choose a color 4-9

FORMATTING SPECIAL HEADINGS 4-29

To use pair kerning 4-10

To set up side-head and body-text areas 4-30

To change the spread between characters 4-10

To create a side head 4-32

To use special capitalization 4-11

To create a straddle head 4-34

To specify the size and placement of superscript and
subscript text 4-12

To create a run-in head 4-34
FORMATTING LISTS 4-36

FORMATTING PASSAGES OF TEXT 4-13

To create a numbered list 4-36

To indent a paragraph 4-13

To create a bulleted list 4-38

To align a paragraph 4-14

To use a different bullet symbol 4-39

To define a tab stop 4-15
To specify an exact position for a tab stop 4-16
To set a tab leader 4-17
To put graphic lines above and below a
paragraph 4-17
To choose the spacing between lines 4-18
To specify custom line spacing 4-19
To set the spacing above and below a
paragraph 4-20
To adjust the space between words 4-21
To control hyphenation 4-23
To control line breaks 4-25
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Formatting in FrameMaker involves specifying the properties of text.
Properties include the font family, size, and style, plus indents, tab
stops, line spacing, and other such items.

Paragraphs are the basic formatting building block
In a FrameMaker document, the format properties you change
generally apply to entire paragraphs. (A paragraph can be normal body
text, a heading, an item in a list, and so on.) You can also change
properties of individual characters or words within a paragraph. For
example, you may want to use italics when you introduce new terms.

Inspection List
Each paragraph has
properties that determine
its appearance and position
on the page.

Follow these steps, checking each item,
to complete final inspection of Espresso
units.
■

Visually inspect threading of cap.

You can also change the
properties of a single
character, a word, or a
phrase within a paragraph.

When you change properties of selected text within a paragraph, those
properties are retained if you later change the properties of the entire
paragraph. That way, you don’t lose any special formatting.

You can use the formatting bar or a designer window
The formatting bar and the Format menu contain most of the commonly
used formatting commands. For more precise control, and for access to
commands that aren’t available on the formatting bar, you can use the
FrameMaker designer windows as you format text. If you use the
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formatting bar to change a property, the new setting also appears in the
designer window.

You can use the Paragraph
Designer or the formatting
bar to change paragraph
properties, such as
alignment.

Inspection List
Follow these steps, checking each item,
to complete final inspection of Espresso
units.
■

Visually inspect threading of cap.

■

With gauge, measure angle of threads.

You can use the Character
Designer to change
character properties.

With the Paragraph Designer window, you can change some or all
properties of a paragraph at once from one location. For example, you
can specify a paragraph’s font properties, indents, alignment, space
above and below, line spacing, and tab stops.
With the Character Designer window, you can change several font
properties of selected text without affecting the entire paragraph. For
example, you can select a word or phrase and use the Character
Designer to change its font size and style.

Font properties determine the appearance of text
Every paragraph has a default font that determines the appearance of
text in the paragraph. The default font is made up of properties that
you can change—for example, the font family, size, style, and color. To
fine-tune the appearance of text, you can adjust the spacing between
characters, apply special capitalization, and set the size and placement
of superscript and subscript text.
You can change the font properties of entire paragraphs or of selected
text within a paragraph.
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You can change the properties of entire passages
While font properties determine the appearance of the text characters,
the general look of your text is provided by properties that apply to
larger passages—paragraphs or groups of paragraphs. You can change
the formatting properties of a single paragraph or several adjacent
paragraphs at once. You can set up where paragraphs fall on the page,
how they’re indented and aligned, and how much space appears above
and below them. You can define tab stops with leader lines, add graphic
lines above and below paragraphs, and set the spacing between words
and lines. Special features also let you control the way words are
hyphenated and how lines and pages break.

Special headings require special formatting
With FrameMaker, you can set up headings or other paragraphs that
straddle columns in a multicolumn layout. You can also set up side
heads—headings that appear at the side of body text, aligned with the
text. And you can design run-in heads whose text can be included in
tables of contents, cross-references, and page headers and footers.

Clean lists, easy reading—and no misnumbering
You can set up special formats that automatically number items in lists.
When you delete an item from a numbered list, or add one to it,
FrameMaker automatically renumbers the other items.

When you delete an item…

Carafe Assembly

Carafe Assembly

These installation instructions cover
how to assemble the glass carafe.

These installation instructions cover
how to assemble the glass carafe.

1 Screw the knob onto the carafe lid.

1 Screw the knob onto the carafe lid.

2 Slide metal belt around outside of carafe.

2 Attach metal handle ring to housing
assembly by screwing it clockwise.

3 Attach metal handle ring to housing
assembly by screwing it clockwise.

3 Screw black plastic handle into the

…the rest of the list is
automatically renumbered.

For unnumbered lists, you can specify that a bullet symbol appear
before each item. You type the text, and FrameMaker inserts the
symbol.
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Formats can be reused
Every paragraph in a document has a format—a collection of
properties—that you can manipulate as a whole. Chapter 5, “Format
Catalogs,” describes working with paragraph formats. You can apply a
paragraph format to other paragraphs in the same document or in a
different document. You save time by not having to format each
paragraph separately, and you can quickly maintain and update
formats throughout a document. You store formats that you want to
reuse in a catalog. Once a document’s catalog is set up, you simply
choose formats from the catalog and apply them to paragraphs in the
document.
You can also format a word or phrase that you want to stand out from
the rest of the paragraph. You can store these types of formats in a
catalog and reuse them wherever necessary.

In this chapter
This chapter tells you how to change text properties such as the font
family and style, character spacing, and paragraph settings. The
chapter also shows you how to set up page breaks, create numbered and
bulleted lists, and create straddle, side, and run-in heads. When you
can use either the formatting bar or a designer window to change a
property, the chapter provides the more convenient formatting bar
method. It includes the designer window method only if it allows you
more precise control.
Chapter 5, “Format Catalogs,” shows you how to reuse formats stored in
catalogs. Familiarizing yourself with the concepts in Chapter 5 will give
you a broader view of how FrameMaker handles paragraph and text
formatting.
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USING THE FORMATTING BAR
AND THE DESIGNER WINDOWS
You can perform many text formatting tasks by using the formatting bar and
the commands on the Format menu. This is generally the simplest way to
format text. Any changes you make take effect immediately, changing the
appearance of the text to reflect the new settings.
You can also use the Paragraph Designer window and the Character Designer
window to format text. The designer windows give you more precise control and
let you perform multiple formatting tasks at once. With the Paragraph
Designer, you can change the properties of an entire paragraph. With the
Character Designer, you can change the font properties of selected text within a
paragraph without affecting the rest of the paragraph. When you use a designer
window to change properties, the new settings do not take effect in the text
until you explicitly apply them.
When you use the formatting bar to change properties, the new settings are
reflected in the designer windows.

To display the formatting bar
The formatting bar contains formatting pop-up menus and tab wells that you
can use to quickly set paragraph properties.
Spacing pop-up menu

Tab wells

Alignment pop-up menu
Paragraph Format
pop-up menu

Formatting bar toggle

In order to display the formatting bar and the rulers, rulers must be visible.
1

Choose Rulers from the View menu if the rulers are not already visible.

2

Click the formatting bar toggle.

Clicking the toggle displays or hides the formatting bar.

To display a designer window
The Paragraph Designer divides formatting properties into six groups: basic,
default font, pagination, numbering, advanced, and table cell. The Character
Designer has only one group, which is the same as the Paragraph Designer’s
default font group.
■
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To display the Paragraph Designer, choose Paragraphs>Designer from the
Format menu.
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To display a different group of formatting properties in the Paragraph Designer, choose
the group from the Properties pop-up menu.

Properties pop-up menu

When you use a designer window to change properties, the new settings do not
take effect in the text until you explicitly apply them. Before changing to a
different property group, you should apply the current changes. To apply
changes to the paragraph, click Apply To Selection.
For a brief description of how to use the designer windows, see “The Paragraph
Designer” on page 5-8.
■

To display the Character Designer, choose Characters>Designer from the
Format menu.
RESETTING THE PROPERTIES

If you change properties in a designer window but then decide you don’t want to
apply them, you can reset the properties to match the current text.
To display the properties of the current text, choose Reset Window from
Selection from the Commands pop-up menu in the designer window.

SPECIFYING FONT PROPERTIES
You can click in a paragraph (or select multiple paragraphs) and change the
default font properties of the entire paragraph. You can also select specific text
within a paragraph and change the text’s font properties. If you change the font
properties of selected text, those properties are retained when you later update
the properties of the entire paragraph.
You can also change the font properties of text created with the Text Line tool.
You can change the font properties of an entire text inset (text imported by
reference), but only when the inset doesn’t use formats from the source
document. For details, see “Formatting an imported text flow” on page 3-16.
The basic font properties are the font family, style, and size. The family is the
actual typeface such as Times and Helvetica. Font styles include the usual bold
and italic styles as well as some less commonly used styles such as numeric
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underlining, overlining, strikethrough, capitalization, superscripting, and
subscripting. You can also choose a color for text.
You can improve the appearance of spacing on a line by using pair kerning and
spread to adjust the space between characters. The ability to adjust character
spacing is particularly useful for formatting large type such as titles or
headings. Pair kerning removes space between some characters, making text
easier to read. The spread is the amount of space added to (or subtracted from)
the normal space between all characters.

To choose a font family, style, and size
When you choose a font, you specify the font family, style, and point size. The
available font families and styles depend on which fonts are installed.
1

Select the text whose font you want to change or click where you want to begin
typing.

If you want to change the default font properties of a paragraph, select the
entire paragraph.
2

Choose a font family from the Format>Font submenu.

3

Choose a style from the Format>Style submenu.

4

Choose a size from the Format>Size submenu.

If you want a size not listed on the menu, choose Other and specify the size you
want. You can type any point size from 2 to 400; the size can include a decimal
fraction such as 10.5.
EFFECT ON LINE AND PARAGRAPH SPACING

When you change the size of a paragraph’s default font, FrameMaker
automatically changes the line spacing and then adjusts the space above and
below the paragraph to maintain the proportionality. For example, if you
increase the font size of a 12-point heading with 14 points of line spacing and 21
points of space above to 14 points, FrameMaker changes the line spacing to 17
points and the space above to 25.5 points.
USING A DESIGNER WINDOW

You can use a designer window to choose a font family, style, and size. To
change the default font properties of an entire paragraph, click in the
paragraph, choose Default Font from the Properties pop-up menu in the
Paragraph Designer, and change the settings there. To change the font
properties of specific text within a paragraph, select the text and change the
settings in the Character Designer. When the properties are set the way you
want them, click Apply To Selection.
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USING VARIOUS WEIGHTS

Some fonts have more than one weight—for example, Helvetica Condensed
Bold and Helvetica Condensed Black. Because the Format>Style submenu lists
only Bold, you have to choose other weights from the Default Font properties of
the Paragraph Designer or from the Character Designer instead.
USING NUMERIC UNDERLINING

With standard character underlining, the offset and thickness of the line is
determined by the weight and size of the character’s font. For example, the
underline beneath bold text is thicker than the underline beneath light text.
With numeric underlining, the offset and thickness is not determined by the
character’s font. Numeric underlining has the same offset and thickness
wherever it appears. To turn on numeric underlining, use a designer window.
For information on the designer windows, see “Using a designer window” on
page 4-8. The numeric underlining property does not appear in the
Format>Style submenu.
USING NONALPHANUMERIC CHARACTERS

The Symbol and Zapf Dingbats font families consist of unusual characters
rather than letters and numbers. You can use these characters in a variety of
ways. For example, the bullet symbol ■ is a Zapf Dingbats character. For a
complete list of these special fonts, see Chapter 3, “Character Sets,” in the
Quick Reference.

To choose a color
To make headings or other types of text stand out from the rest of the
document, you can use color. For example, some manuals use a different color
for first-level headings.
You can choose from the colors that have been defined in a document. When you
assign a color to text, you see the text if the color is visible in the current view.
For information on defining colors (or shades of gray) and on setting up color
views, see Chapter 17, “Color.”
1

Click in the paragraph that has the color you want to change or select specific
characters.

2

In the appropriate designer window, choose a color from the Color pop-up menu.

If you’re formatting an entire paragraph, use the Default Font properties of the
Paragraph Designer. If you’re formatting characters, use the Character
Designer.
3

Click Apply To Selection.

Using FrameMaker

4-9

FORMATTING TEXT

4

Specifying font properties

To use pair kerning
You can change the way FrameMaker spaces characters by turning on pair
kerning. Pair kerning moves a character closer to the previous character in the
same word to improve the appearance of text. Pair kerning also turns on
ligatures (combined letter pairs such as fi and fl in printed documents). The
character pairs that are kerned, the amount of kerning, and the ligatures that
have been defined depend on the font. Kerning pairs are customizable. For
information on customizing kerning pairs, see the online manual Managing
Frame Products.

To
To

Pair Kern off

Pair Kern on

1

Click in the paragraph that has the characters you want to kern or select specific
characters.

2

In the appropriate designer window, turn on Pair Kern.

If you’re formatting an entire paragraph, use the Default Font properties of the
Paragraph Designer. If you’re formatting characters, use the Character
Designer.
3

Click Apply To Selection.

To chang e the spread between characters
You can change the spread between characters. You can use spread to improve
the appearance of text in a large point size (such as a heading) or to increase or
decrease the number of lines in a paragraph to prevent a page break.
These installation instructions cover how to
assemble the glass carafe.

–5% spread (tight)

These installation instructions cover how to
assemble the glass carafe.

0% spread (normal)

T h e se in sta lla tion i nstr ucti ons cover
h ow to a sse m bl e the gl ass carafe.

10% spread (loose)

Spread is the extra space you want to add to or subtract from a font’s default
space between characters. Spread is expressed as a percentage of an em space
(a space as many points wide as the current font size is high). Normal spread is
0 percent.
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Click in the paragraph that has the characters you want to spread or select specific
characters.

Space is added to or subtracted from the space to the right of selected
characters. Therefore, if you’re adjusting the spread within a word, don’t select
the last character. Doing so changes the space after the word.
2

In the appropriate designer window, adjust the value in the Spread text box.

If you’re formatting an entire paragraph, use the Default Font properties of the
Paragraph Designer. If you’re formatting characters, use the Character
Designer.
To increase the space between characters, type a percentage greater than
0 (zero). To decrease the space, type a percentage less than 0 (zero).
3

Click Apply To Selection.

To use special capitalization
You can change the way characters are capitalized: uppercase, lowercase, small
caps, or as typed.
When you apply small caps to text, FrameMaker displays all the characters in
uppercase, though the text that was in lowercase appears in slightly smaller
capital letters. For example, Frame Technology displayed in small caps appears
as FRAME TECHNOLOGY.
1

Select the text whose capitalization you want to change or click where you want to
begin typing.

2

In the appropriate designer window, turn on special capitalization by choosing a
capitalization style from the Case pop-up menu.

If you’re using the Paragraph Designer, the Case pop-up menu is in the Default
Font properties.
Case pop-up menu

3

Click Apply To Selection.
SPECIFYING THE SIZE OF SMALL CAPS

You can set a document preference for the font size of small caps by choosing
Document>Text Options from the Format menu. In the Text Options dialog box,
type a percentage in the Small Caps text box and click Apply.

Using FrameMaker
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When calculating the size, FrameMaker multiplies the percentage you type by
the point size of the characters being affected. For example, when you enter a
value of 80% and then apply Small Caps to 10-point characters, the small-cap
characters are 8 points.
APPLYING SPECIAL CAPITALIZATION

Using the Paragraph Designer or the Character Designer to apply a
capitalization style to text changes only the appearance of the text. For
example, you can make lowercase text appear in uppercase letters by applying
a capitalization style.
Continuing the example, if you want to display headings in all uppercase
letters, but you want to display cross-references to the headings in mixed
uppercase and lowercase, type the headings as you want to display them in
cross-references and use the Uppercase capitalization style to make the
headings all uppercase.
If you want to change the text itself, rather than just its appearance, use the
Capitalization dialog box to replace selected text with text that is all uppercase,
all lowercase, or initial caps. To display the Capitalization dialog box, press
Esc e C.

To specify the size and placement of superscript and subscript text
FrameMaker formats superscript and subscript text (including footnote
references) according to the size and offset you specify. These settings are
document preferences that apply to all superscript and subscript text in the
document.

Type the size here.

Type the offset here.
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The size is a percentage of the point size of the superscript/subscript character.
For example, a subscript 10-point character shrinks to 6.5 points if the size
value is 65% (65% of 10 points). The minimum point size allowed for superscript
and subscript text is 1 point.
The offset is the distance from the baseline that FrameMaker shifts a
superscript or subscript character. The offset value is a percentage of the font
size. For example, a superscript character in a 10-point font shifts up 4 points if
the offset value is 40% (40% of 10 points).
3

Click Apply.

FORMATTING PASSAGES OF TEXT
You can change the formatting properties of a single paragraph or of several
adjacent paragraphs at once. Each time you press Return, FrameMaker creates
a new paragraph. A FrameMaker paragraph can be a body of text in the
conventional sense, or it can be a title, a heading, or an item in a numbered or
bulleted list.

Carafe Assembly

This section title is a
paragraph.

These installation instructions cover how to
assemble the glass carafe.
1 Screw the drip-through knob tightly onto
the bottom of the carafe lid.

Each item in the
numbered list is a
paragraph.

This body text is a
paragraph.

2 Slide metal belt and housing around
outside of carafe.
3 Attach metal handle ring to housing

A paragraph’s format is made up of properties that determine its appearance.
The tasks in this section show you how to change these formatting properties.
You can change the formatting properties in a text inset (text imported by
reference), but only when it doesn’t use formats from the source document. For
details, see “Formatting an imported text flow” on page 3-16.

To indent a paragraph
The left indent property of a paragraph is the distance from the left edge of the
text column to the start of text. The right indent is the distance from the end of
the text to the right edge of the text column. As the text you type reaches the
right indent, FrameMaker automatically wraps the text to the next line. You
don’t need to press Return unless you want to create a new paragraph.

Using FrameMaker
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You can specify indents for the first line of a paragraph and all lines after the
first to achieve a variety of effects. For example, the first line and all subsequent
lines of body paragraphs in this manual have the same indents. In numbered
step paragraphs, however, the first lines are indented less than subsequent
lines to achieve a “hanging indent.”
1

Click in the paragraph you want to indent.

If you want to indent several adjacent paragraphs, select all of the paragraphs.
2

Drag the indent symbol to a new location on the ruler.

First line indent symbol
Right indent symbol

Left indent symbol

SPECIFYING AN INDENT VALUE

You can specify a precise indent value by using the Basic properties of the
Paragraph Designer. Type the indents you want in the First, Left, and Right
Indents text boxes. Then click Apply To Selection.
ALIGNING THE INDENT WITH A RULER MARKING

To align the indent with a ruler marking, turn on Snap on the Graphics menu.
When you drag an indent symbol, it snaps to locations corresponding to the
snap grid.
If the snap locations don’t align with the ruler markings, you can change the
snap grid interval. For instructions, see “To set the grid spacing” on page 13-6.

To align a paragraph
The alignment property of a paragraph determines how the paragraph is
positioned within the left and right indents.

Left aligned
Center aligned
Right aligned
Justified

Left indent
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Alignment is relative to the paragraph’s left and right indents, not to the edges
of the column of text.
1

Click in the paragraph you want to align.

If you want to align several adjacent paragraphs, select all the paragraphs.
2

Choose an alignment type from the Alignment pop-up menu on the formatting bar.

The Alignment pop-up
menu shows that the current
paragraph is left aligned.

WORKING WITH JUSTIFIED TEXT

You can improve the appearance of justified paragraphs by adjusting the space
between characters and words. For instructions, see “To adjust the space
between words” on page 4-21 and “Allowing automatic letter spacing in justified
text” on page 4-22.

To define a tab stop
You can use tab stops to create numbered and bulleted lists, outlines, and
similar material that must be aligned at specific places.
Before inserting a tab in text, you need to define a tab stop. You can use the
formatting bar or the Paragraph Designer to define the locations of tab stops.
Then, when you press the Tab key, FrameMaker moves the insertion point to
the desired location.
You can choose from four types of tab stops—left, center, right, and decimal.

Left
Apples
Oranges
Grapefruit

■

Center
Apples
Oranges
Grapefruit

Right
Apples
Oranges
Grapefruit

Decimal
152.6457
3.16
3,458.75

To add a tab stop, click in a paragraph or select multiple paragraphs, and drag a tab
symbol from the appropriate tab well on the formatting bar to the desired position
below the top ruler.
Left

Center

Right

Decimal

Newly set tab stop

Using FrameMaker
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■

To move a tab stop, drag it to a new position.

If you change the position of a tab stop, FrameMaker moves any tabs in the
paragraph at that stop to match the new position. Text following the tabs moves
accordingly.
■

To add multiple tab stops at regular intervals, double-click the existing tab stop (on
the top ruler) that you want to duplicate at regular intervals, and use the Edit Tab Stop
dialog box to indicate the interval.

When you double-click a tab stop, FrameMaker displays the Edit Tab Stop
dialog box. Type the interval between tabs in the Repeat Every text box and
click Edit.
■

To delete a tab stop, drag it off the bottom of the top ruler.
ALIGNING TAB STOPS WITH RULER MARKINGS

To align tab stops with ruler markings, turn on Snap on the Graphics menu.
When you drag a tab symbol, it snaps to locations corresponding to the
snap grid.
If the snap locations don’t align with the ruler markings, you can change the
snap grid interval. For instructions, see “To set the grid spacing” on page 13-6.
USING DECIMAL TAB STOPS

When you use a decimal tab stop, FrameMaker aligns the tabbed text on the
decimal character. You can set the decimal character to whatever you want. For
example, you can use a comma when you’re working with European decimals.
Double-click a tab stop to display the Edit Tab Stop dialog box. Type the
decimal character in the Align On text box in the Alignment area and
click Edit.
ABSOLUTE TAB STOPS

FrameMaker tab stops are absolute as opposed to relative. For information on
pressing the Tab key with absolute tab stops, see “Absolute tab stops” on
page 3-6.

To specify an exact position for a tab stop
You can specify the exact position and alignment of an existing tab stop.
1

Double-click the tab stop you want to edit.

FrameMaker displays the Edit Tab Stop dialog box.
2

Type a new tab position in the New Position text box and choose a different alignment.

The position is the distance from the left edge of the column to the tab stop.
3
4-16
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To set a t ab leader
You can specify a pattern of characters—a leader—to fill the space between a
tab and the character following it. Typically, a leader is a series of periods, but
you can use any characters, such as hyphens and asterisks. Tab leaders are
useful for tables of contents that have a wide gap between columns. The leaders
make it easy to match items across columns.
Tab leader
Fees........................................... 43.53
Tax ............................................... 6.21

A leader can have more than one character and can use spaces.
1

Double-click the tab stop for which you want to define a leader.

FrameMaker displays the Edit Tab Stop dialog box.
2

In the Leader area, click one of the predefined tab leaders or type your own custom
leader.

3

Click Edit.

To put graphic lines above and below a paragraph
You can create a design element by placing a line or some other type of graphic
above or below a paragraph. For example, all top-level headings in a document
might rest on a long thin line. Or all of your chapter titles might be preceded by
some graphic element.

Brewing Coffee
Brewing Coffee

Brewing Coffee

You use reference frames on a reference page to create graphics that you want
to include in a paragraph’s format.
1

On a reference page, draw or import the graphic in a reference frame.

For information on creating reference frames, see “To create a reference frame
on a reference page” on page 19-23.
2

Click in the paragraph you want to put a line above or below.

If you want to put a line above or below several adjacent paragraphs, select all
of the paragraphs.
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3

In the Advanced properties of the Paragraph Designer, choose the reference frame
from the Frame Above ¶ or from the Frame Below ¶ pop-up menu.

All of the reference frames drawn on reference pages appear in the pop-up
menus.
4

Click Apply To Selection.
BOXING A PARAGRAPH

You can box a paragraph of text by creating a single-cell table. Set up the table
so that it doesn’t have a title, heading row, or footing row. Adjust the size of the
table so that the text and the box look the way you want. For information on
creating tables, see Chapter 6, “Tables.”

To choose the spacing between lines
The line spacing property is the amount of space between lines in a paragraph,
measured from the baseline of one line to the baseline of the next line. A
paragraph can have single spacing, 1.5 spacing, or double spacing. For
information on specifying a custom line spacing, see “To specify custom line
spacing” on page 4-19.

High-quality
roasting

Line spacing

By default, a single-spaced paragraph’s line spacing is approximately 120
percent of the default font size. For example, for font sizes of 10 and 15 points,
the single-spaced line spacing is 12 and 18 points, respectively. The default line
spacing for 1.5-spaced and double-spaced paragraphs is based on the singlespaced proportions. If you change a paragraph’s default font size, FrameMaker
automatically adjusts the line spacing.
1

Click in the paragraph that has the line spacing you want to set.

If you want to set the line spacing of several adjacent paragraphs, select all of
the paragraphs.
2
Spacing pop-up menu
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To specify custom line spacing
Rather than choosing single spacing, 1.5 spacing, or double spacing for a
paragraph’s line spacing, you can specify the exact line spacing you want.
You can also specify whether you want line spacing to be fixed. If a paragraph’s
line spacing is fixed, FrameMaker does not open up space to accommodate
larger font sizes that may occur in the paragraph.

Follow these steps
carefully, checking
each item as you go, to
complete final
inspection of Espresso
Fixed line spacing

Follow these steps

carefully, checking
each item as you go, to
complete final
inspection of Espresso
Nonfixed line spacing based on
the largest font in each line

If you want FrameMaker to increase the line spacing to accommodate a larger
font size, you can turn off the fixed line spacing property.
■

To specify custom line spacing, type the spacing you want in the Custom Line Spacing
dialog box.

Choose Custom from the Spacing pop-up menu on the formatting bar. In the
Custom Line Spacing dialog box, type the line spacing you want in the Custom
text box and click Set.
For tips on choosing an appropriate line spacing for a particular paragraph, see
“Guidelines for setting custom line spacing” on page 4-19.

GUIDELINES FOR SETTING CUSTOM LINE SPACING
The line spacing you specify depends on such
things as the font you’re using and its size, the
width of the margins, and the type of document
you’re creating.
Choose a line spacing based on
the paragraph’s default font size. For a 9-, 10-, or
11-point font, you would normally add from 1 to 3
points to arrive at the line spacing. Add from 2 to 4
Default font size

points for a 12-point font, from 3 to 6 points for a
14-point font, from 4 to 6 points for a 16-point font,
and from 5 to 6 points for an 18-point font.
Use more line spacing for sans serif
fonts, tall or boldface fonts, and fonts with a strong
vertical emphasis.
Special fonts

Long lines of text Use more line spacing for long
lines of text to make the paragraphs easier to read.
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■

To turn the fixed line spacing on or off, change the setting in the Custom Line Spacing
dialog box.

Choose Custom from the Spacing pop-up menu on the formatting bar. In the
Custom Line Spacing dialog box, change the Fixed Line Spacing setting and
click Set.

To set the spacing above and below a paragraph
When you press Return to create a new paragraph, FrameMaker adds space
between the first paragraph and the new one. FrameMaker determines the
amount of space by choosing either the first paragraph’s Space Below property
or the second paragraph’s Space Above property, whichever is larger.
If a paragraph falls at the top of a column, FrameMaker ignores the Space
Above setting. If the paragraph falls at the bottom of a column, FrameMaker
ignores the Space Below setting.
1

Click in the paragraph that has the space above or below you want to set.

If you want to set the space above or below several adjacent paragraphs, select
all of the paragraphs.
2

In the Basic properties of the Paragraph Designer, specify the amount of space in the
Space Above and Space Below text boxes, or choose values from the pop-up menus.

Space Above pop-up menu

Space Below pop-up menu

FrameMaker adds the value you specify to the paragraph’s line spacing.
Specifying zero points adds no extra space. Specifying the same number as the
paragraph’s line spacing adds the equivalent of one extra line of space.
3

Click Apply To Selection.
FACTORS THAT AFFECT PARAGRAPH SPACING

Feathering text and synchronizing text baselines can affect the spacing
between paragraphs. For information on feathering and synchronizing, see
“Aligning text in columns” on page 18-16.
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SETTING THE SPACE BETWEEN TWO PARAGRAPHS

You can specify how much space you want between two particular paragraphs.
This value changes the Space Below property of the first paragraph or the
Space Above property of the second paragraph, whichever is larger. If both have
the same properties, both are changed.
To set the space between two paragraphs, select them and choose Space
Between from the Spacing pop-up menu on the formatting bar.
Spacing pop-up menu

In the Space between Paragraphs dialog box, choose the number of blank lines
between paragraphs or type a custom spacing. Then click Set.
If more than two paragraphs are selected, FrameMaker adjusts the space
between all the selected paragraphs.

To adjust the space between words
FrameMaker adjusts the space between words to achieve even spacing in a line
and to fill lines consistently. You can specify how tightly you want words spaced
in a line.

UNDERSTANDING WORD SPACING
You can specify the minimum, maximum, and
optimum word spacing. The minimum spacing is
the smallest space allowed between words. The
maximum spacing is the largest space allowed
between words before FrameMaker tries to
hyphenate words or add space between letters in
justified paragraphs. The optimum spacing is what
FrameMaker tries to achieve.

Word spacing values are a percentage of the
standard space for the paragraph’s default font.
The standard space is 100%. Values below 100%
allow a tighter word spacing; values above 100%
allow a looser spacing. For example, a justified
paragraph with settings of 75% Minimum, 125%
Maximum, and 100% Optimum is more readable
than a justified paragraph with all settings of
100%.
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Each font has a standard space determined by the font’s manufacturer. You
change a paragraph’s word spacing by specifying a range for how much freedom
FrameMaker has in decreasing or increasing word spacing to fill a line.

A left-aligned paragraph
with a large range may
look justified.

Although the small tree or shrub
is of the genusCoffea, the name
of the beverage comes from the
Arabic word kahwah, which
originally referred to the bitter
taste of the beverage rather
than to the plant.

Although the small tree or
shrub is of the genus Coffea,
the name of the beverage
comes from the Arabic word
kahwah, which originally
referred to the bitter taste of
the beverage rather than to the

The same
paragraph with
little or no range
has a more ragged
right edge.

The greater the range, the more adjustments FrameMaker can make and the
more likely it will fill a line with text.
1

Click in the paragraph that has the word spacing you want to change.

If you want to change the word spacing of several adjacent paragraphs, select
all of the paragraphs.
2

In the Advanced properties of the Paragraph Designer, specify the minimum,
optimum, and maximum space to allow between words.

The default font’s standard
word space as specified by
the manufacturer

For information on the minimum, optimum, and maximum settings, see
“Understanding word spacing” on page 4-21.
3

Click Apply To Selection.
ALLOWING AUTOMATIC LETTER SPACING IN JUSTIFIED TEXT

Lines of text in a justified paragraph can have more than the maximum space
between words if FrameMaker can’t fit a word on a line and can’t hyphenate it.
To try to prevent this, you can add extra space between characters in justified
text by turning on Allow Automatic Letter Spacing in the Word Spacing area. If
a line in justified text is more loosely spaced than allowed by the Maximum
setting, FrameMaker adds a small amount of space between characters to try to
keep the space between words from going over the maximum.
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To control hyphenation
When FrameMaker hyphenates text, it breaks words at the ends of lines so that
the lines are approximately the same length. Without hyphenation, left-, right-,
and center-aligned paragraphs have more ragged edges, and justified
paragraphs have more white space between words.
This procedure describes how to turn on hyphenation for a paragraph so that
FrameMaker determines where the actual hyphens should be placed. For
information on techniques for hyphenating specific words, see “Additional
hyphenation controls” on page 4-23.

ADDITIONAL HYPHENATION CONTROLS
You can specify that
FrameMaker should not hyphenate a particular
occurrence of a word in a document.

In addition to being able to turn on and off the
hyphenation property of paragraphs, you can
control hyphenation in specific situations.

Suppressing hyphenation

Hyphenating specific words

You can define the
hyphenation points of any word so that when it
breaks anywhere in the document, the hyphen is
where you want it. You should probably do this
only for important, frequently used words—for
example, for product names. You can also specify
that a word is never to be hyphenated.

To suppress hyphenation, click at the beginning
of the word and press Shift-Meta-hyphen.
FrameMaker places a suppress hyphenation
symbol ( ) under the word. If the word falls
at the end of a line, FrameMaker shifts it to
the beginning of the next line rather than
hyphenate it.

Use the Spelling Checker window to set the
hyphenation points of a word. For more
information, see “To control the hyphenation of a
word” on page 9-11.

For information on suppressing the hyphenation of
a word wherever it occurs in a document, see “To
control the hyphenation of a word” on page 9-11.

If you don’t want to add a
different hyphenation point for all occurrences of a
word, you can define a hyphenation point for a
particular occurrence of a word.

Discretionary hyphen

To define a discretionary hyphen, click in the word
where you want to define the hyphenation point
and press Control-hyphen. FrameMaker places a
discretionary hyphenation symbol ( ) above the
word. If necessary, FrameMaker uses that point to
hyphenate the word.

Nonbreaking hyphen If you want an occurrence of
a word to have a hyphen but you don’t want lines
to break at that hyphen, you can insert a
nonbreaking hyphen. For example, this manual
uses a hyphen between keys in a sequence—for
example, Meta-Shift-hyphen. These hyphens are
typed as nonbreaking hyphens so that the entire
sequence always appears together in a line.

To type a nonbreaking hyphen, click where you
want to insert the hyphen and press Meta-hyphen.
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1

Click in the paragraph you want to hyphenate.

If you want to hyphenate several adjacent paragraphs, select all of the
paragraphs.
2

In the Advanced properties of the Paragraph Designer, turn on Hyphenate.

3

Type the minimum number of letters that can precede or follow a hyphen in the
Shortest Prefix and Shortest Suffix text boxes, respectively.

4

Type the maximum number of consecutive lines that can end with a hyphen in the
Max. # Adjacent text box.

5

Type the minimum length of a hyphenated word in the Shortest Word text box.

6

Click Apply To Selection.

Turn on hyphenation here.

PREVENTING THE LAST WORD IN A PARAGRAPH FROM HYPHENATING

To prevent the last word in a paragraph from hyphenating, set the maximum
number of adjacent hyphens to 1 in the Advanced properties of the Paragraph
Designer. Alternatively, you can insert a suppress hyphenation symbol in the
last word of the paragraph. For instructions, see “Additional hyphenation
controls” on page 4-23.
HYPHENATION AND SPELL-CHECKING LANGUAGE

By default, the US version of FrameMaker hyphenates and spell-checks words
according to the US English dictionary. The International English version of
FrameMaker hyphenates and spell-checks words according to the UK English
dictionary. You can choose a different language from the Language pop-up
menu in the Advanced properties of the Paragraph Designer.
A setting of None identifies a paragraph as having no language. Choose None
for paragraphs you don’t want to hyphenate or don’t want to check when you
run the Spelling Checker—for example, for paragraphs of computer code.
TURNING HYPHENATION OFF

If hyphenation is on for a paragraph, you can turn it off by turning off
Hyphenate in the Advanced properties of the Paragraph Designer.
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To control line breaks
As you type, FrameMaker automatically wraps text and determines where lines
break, either at a normal space character (which you insert by pressing the
space bar) or at a place where it can hyphenate a word. You can override the
FrameMaker line breaks for a specific line of text if the break doesn’t seem
appropriate. For example, if you have a two-word product name, you may not
want FrameMaker to break the line between the two words.
These line-break controls are not paragraph properties. They affect only the
particular lines of text in which they occur.
■

To force a line break, click where you want to break the line and press Meta-Return.

FrameMaker places a forced return symbol ( ) at the end of the line. Text to the
right of the forced return moves to the next line without creating a new
paragraph.
■

To keep two words together on the same line, select the space between the two words
and press Control-space.

FrameMaker places a nonbreaking space symbol ( ) between the two words. If
both words won’t fit together on the line, FrameMaker moves them both to the
next line.
■

To specify nonalphabetic characters after which a line break is OK, specify them by
using the Document>Text Options command on the Format menu.

Normally, FrameMaker won’t break a line after a nonalphabetic character, but
you can specify otherwise. For example, you can tell FrameMaker that it’s OK
to break a line after an underscore character (_).
To restart the computer
now, use the
REBOOT_SYSTEM
command.

Default line breaks

To restart the computer
now, use the REBOOT_
SYSTEM command.

Line breaks allowed after an
underscore character

To specify a nonalphabetic character after which FrameMaker can break a line,
choose Document>Text Options from the Format menu. In the Text Options
dialog box, type the characters in the Allow Line Breaks After text box and
click Set.

Using FrameMaker

4-25

4

FORMATTING TEXT

Controlling page breaks

TYPING SPECIAL CHARACTERS

All of the special characters that you type in a document by using character
combinations—for example, em dashes and bullets—can also be included in the
Allow Line Breaks After text box. When you type some character combinations
in the text box, FrameMaker displays a backslash (\) followed by one or two
characters—not the special character. For a complete list of the special
characters you can use, see Chapter 3, “Character Sets,” in the Quick Reference.

CONTROLLING PAGE BREAKS
In FrameMaker, text usually flows from page to page as you type. When text
reaches the bottom of the last page, FrameMaker creates a new page.
You control where FrameMaker breaks text across pages in several ways. You
can force a page break by making a paragraph, such as a heading, start at the
top of a page. You can specify how many lines of a paragraph must stay together
at the top or bottom of a page. And you can force a paragraph to stay with the
following paragraph.
You can combine these controls to enforce your own page-breaking rules—for
example, that a heading must be followed by at least three lines of text on the
same page.
Specifying that all
headings must have
at least three lines of
text beneath them…

Brewing Coffee

Blending Coffee
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To start a paragraph at the top of a column or page
You can specify that a paragraph should start at the top of a new column or
page. For example, you may want a heading to always start at the top of a new
page regardless of where it falls in the document.
1

Click in the paragraph that you want to start at the top of a column or page.

2

Choose Page Break from the Special menu.

3

In the Page Break dialog box, choose where the paragraph should start from the At
Top of Next Available pop-up menu.

You can choose whether the paragraph should start at the top of the next
column, next page, next left page, or next right page.
4

Click Set.
USING THE PARAGRAPH DESIGNER

If you’re using the Paragraph Designer, you can choose this property from the
Start pop-up menu in the Pagination properties.
REMOVING A PAGE BREAK

For information on removing a page break, see “To start a paragraph wherever
there’s room,” next.

To start a paragraph wherever there’s room
If you edit your document so that you no longer want a paragraph to start at the
top of a column or page, you can specify that it should start where it would
normally fall.
1

Click in the paragraph that you no longer want to start at the top of a column or page.

2

Choose Page Break from the Special menu.

3

In the Page Break dialog box, choose Wherever It Fits and click Set.
USING THE PARAGRAPH DESIGNER

If you’re using the Paragraph Designer, you can choose Anywhere from the
Start pop-up menu in the Pagination properties.
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To keep paragraphs together
FrameMaker can keep a paragraph in the same column as the previous
paragraph, the next paragraph, or both. When you set up a paragraph in this
way, you prevent paragraphs from breaking between two columns. For example,
you can specify that a heading always has at least one paragraph of text below
it. If the heading and the next paragraph won’t fit together at the bottom of a
column, FrameMaker moves them both to the top of the next column—to the
top of the next page in a typical single-column page layout.
1

Click in the paragraph that you want to keep with another paragraph.

2

In the Pagination properties of the Paragraph Designer, turn on Keep With Next ¶, Keep
With Previous ¶, or both.

3

Click Apply To Selection.
HOW FRAMEMAKER CALCULATES WHERE TO BREAK THE PARAGRAPH

The Keep With properties keep the end of one paragraph together in a column
with the beginning of another. Not all lines of the paragraphs necessarily stay
together.
The Widow/Orphan Lines property of each paragraph controls how many lines
of the paragraphs must stay together. For more information on widow and
orphan lines, see “To control widow and orphan lines,” next.

To control widow and orphan lines
A widow or an orphan occurs when a few lines of a paragraph appear alone at
the top or bottom of a column. These lines, isolated from the rest of the
paragraph, can interfere with a reader’s comprehension. You can specify the
minimum number of lines that can appear alone at the top or bottom of a
column—at the top or bottom of a page in a typical single-column page layout.
1

Click in the paragraph that has the widow/orphan property you want to change.

If you want to change the settings of several adjacent paragraphs, select all of
the paragraphs.
2

In the Pagination properties of the Paragraph Designer, type the minimum number
of widow and orphan lines to allow in the paragraph in the Widow/Orphan Lines
text box.

The largest number of widow and orphan lines you can specify is 100.
3
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KEEPING ALL LINES TOGETHER

To keep all lines of a paragraph in the same column, specify a large number for
the Widow/Orphan setting. The maximum number allowed is 100 lines.

FORMATTING SPECIAL HEADINGS
FrameMaker provides three types of special headings—side, straddle, and runin. Side heads are prominent; they stand to the side of the normal body text and
are easy to spot. As a navigation device, they’re good for scanning purposes. You
can also use them to create marginal notes or other types of text that you want
to display outside of the normal body text.
Straddle heads span columns in a multicolumn layout. They are also good for
scanning purposes.
Run-in heads are less conspicuous. Although they’re on the same line as normal
body text, they’re separate paragraphs. You can therefore include them in
tables of contents, create cross-references to them, include them in headers and
footers, and so on.

Original document

With side heads

With straddle
heads

With run-in heads

You can use any combination of side heads, straddle heads, and run-in heads in
a document.
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To set up side-head and body-text areas
If you use side heads in a document, you designate areas of the text frame for
the headings, the normal body text, and the space between (gap). You also
specify where you want to display side heads—on the left or right side of the
page, or on the inside or outside of facing pages.

Side-head area

Body-text area

Gap

You set up a side-head area for an entire flow at a time, but you can change the
size and placement of the area in specific text frames in the flow. When you set
up a side-head area in a flow, FrameMaker immediately moves all paragraphs
not designated as side heads to the body-text area.
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1

Click in the flow for which you want to set up a side-head area.

2

Choose Page Layout>Column Layout from the Format menu.

3

In the Column Layout dialog box, turn on Room for Side Heads.

4
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Specify the width of the side-head area and the gap between the side-head and
body-text areas.

Type the width of the sidehead area here.
Type the gap between the
side-head area and the
body-text area here.

When you specify the width of the side-head area and the gap, the remaining
space is allocated to one or more columns of body text.
5

From the Side pop-up menu, choose the side of the page on which you want to place
side heads.

Left side

6

Right side

Outside

Inside

Click Update Entire Flow.

FrameMaker moves all paragraphs not designated as side heads to the bodytext area. Any paragraphs already designated as side heads move to the sidehead area.

Using FrameMaker

4-31

FORMATTING TEXT

4

Formatting special headings

CHANGING SIDE-HEAD PROPERTIES FOR A TEXT FRAME

You allow for side heads in an entire flow at one time. However, you can change
the side-head properties—the width of the side-head area, the gap between the
side-head and body-text areas, and the side of the page on which the side heads
appear—for individual text frames in a flow. For example, you may want to
enlarge the side-head area on a page to accommodate an oversized side head.
To change the side-head properties for an individual text frame, click in the text
frame and choose Customize Layout>Customize Text Frame from the Format
menu. In the Customize Text Frame dialog box, change the side-head properties
as necessary and click Set.
The changes are considered a layout override for the selected text frame.
However, if you change the setting in the Room for Side Heads checkbox, the
change applies to the entire flow. You can remove layout overrides by using the
Page Layout>Column Layout command on the Format menu.
TURNING OFF SIDE-HEAD FORMATTING

Turn off the side-head property when you want to display side heads in columns
with the body text. To do so, click in the flow for which you want to turn off sidehead formatting and choose Page Layout>Column Layout from the Format
menu. Then turn off Room for Side Heads and click Update Entire Flow.

To create a side head
When you apply the side-head property to a paragraph, FrameMaker moves the
paragraph to the side-head area. If there’s an existing paragraph following the
side head, it’s shifted up, adjacent to the side head.
Before you create side heads, you define an area of the text frame for the side
heads and an area for the body text. For information on setting up a side-head
area for a text flow, see “To set up side-head and body-text areas” on page 4-30.
1
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2

In the Pagination properties of the Paragraph Designer, click Side Head and choose
an option from the Side Head Alignment pop-up menu.

Brewing
Coffee

First Baseline

3

Brewing
Coffee

Top Edge

Brewing
Coffee

Last Baseline

Click Apply To Selection.

If a side-head area has been set up for the text flow, FrameMaker moves the
paragraph to the side-head area.
SIDE HEADS IN MULTICOLUMN TEXT FRAMES

When a side head appears in a multicolumn text frame, the preceding text is
balanced across the columns. If a page contains several text frames, each text
frame contains its own side-head area.

Side heads in a single
text frame

Side heads in separate
single-column text frames

DETERMINING THE SPACE ABOVE A SIDE HEAD

The space between the side head and the preceding paragraph is determined by
the Space Below setting of the previous paragraph or the Space Above setting of
the side head, whichever is greater.
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To create a straddle head
Straddle heads span columns in a multicolumn text frame. If the text flow also
uses side heads, you can specify whether you want a straddle head to span just
the columns of body text or both the columns and the side-head area.

Across columns of body
text

Across columns and
side-heads

When a heading paragraph straddles columns, the text above the heading is
balanced across the columns.
1

Click in the paragraph that you want to straddle columns.

2

In the Pagination properties of the Paragraph Designer, click Across All Columns or
Across All Columns and Side Heads.

3

Click Apply To Selection.

To create a run-in head
Because your run-in heads share margins with normal body text, you may want
to give them a different font for contrast. You also need to decide how, or
whether, to punctuate them.
1
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Click in the paragraph you want to make a run-in head.
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In the Pagination properties of the Paragraph Designer, click Run-In Head and type
the punctuation, space, or combination of punctuation and space that you want to
use in the Default Punctuation text box.

For example, all run-in heads in a document can end with a colon (:) followed by
an em space, in which case the space is added between the head and the
paragraph that follows on the same line. The default punctuation is initially set
to a period followed by a space.
This punctuation does not appear in information generated from the run-in
heads—for example, in tables of contents or in cross-references.
3

Click Apply To Selection.

4

In the Default Font properties, change the run-in head’s font so that it stands out from
the surrounding text.

5

Click Apply To Selection.
DETERMINING THE SPACE ABOVE A RUN-IN HEAD

The space between the run-in head and the preceding paragraph is determined
by the Space Below setting of the previous paragraph or by the Space Above
setting of the run-in, whichever is larger.
TYPING SPECIAL CHARACTERS

All of the special characters that you type in a document by using character
combinations—for example, em dashes and bullets—can also be included in the
Default Punctuation text box. When you type some character combinations in
the text box, FrameMaker displays a backslash (\) followed by one or two
characters—not the special character. For a complete list of the special
characters you can use, see Chapter 3, “Character Sets,” in the Quick Reference.
USING A DIFFERENT DEFAULT PUNCTUATION

If a particular run-in head in your document needs different ending
punctuation from the default, simply type the punctuation you need after the
run-in head. FrameMaker ignores the punctuation specified in the Default
Punctuation text box but retains any special characters that are part of the
default, including em and en spaces.
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FORMATTING LISTS
You create numbered and bulleted lists by setting up autonumber formats for
paragraphs. An autonumbered paragraph is part of a series such as steps or
section headings. As you add autonumbered paragraphs to your document,
FrameMaker numbers them appropriately and renumbers existing
autonumbered paragraphs if necessary.
You use the Numbering properties of the Paragraph Designer to define an
autonumber format. An autonumber format can have a series label, a counter, a
tab, and any additional text you need.

Tab

Series label
Text

Counter

Figure 3. Projected Sales

To create a numbered list
The easiest way to use autonumbered lists is to create Paragraph Catalog
formats that you can use over and over again. For information on creating
paragraph formats, see Chapter 5, “Format Catalogs.” In particular, see “Tips
on creating formats” on page 5-12.
In the Numbering properties of the Paragraph Designer, you can specify the
autonumber format by typing and by selecting building blocks in a scroll list. In
addition, you can choose a character format for the autonumber and whether
the autonumber should appear at the beginning or end of the paragraph.

Building blocks include a
bullet symbol…
…a tab…
…and sample counters.

4-36

Using FrameMaker

You specify the
autonumber
format here.
Available
character formats

Formatting lists

.....

FORMATTING TEXT

For more information on autonumber formats, see “Understanding autonumber
formats” on page 4-37. For examples, see “Counters” on page 4-40.
1

Click in the paragraph that you want to autonumber.

If you want to autonumber several adjacent paragraphs, select all of the
paragraphs.
2

In the Numbering properties of the Paragraph Designer, type a series label in the
Autonumber Format text box.

You need to use a series label only if you have more than one autonumber series
in the current flow. A series label consists of any single printable character
followed by a colon (for example, F:). If you use a series label, it must appear at
the beginning of the format.
3

Specify the rest of the autonumber format.

You can type any text, spaces, or tabs (\t) required, and you can select building
blocks in the Building Blocks scroll list. When you select a building block, it
appears at the insertion point in the Autonumber Format text box. For
information on setting up autonumber formats, see “Understanding
autonumber formats” on page 4-37. For more information on setting up
counters, see “Counters” on page 4-40.
To insert a tab, type or select \t.

UNDERSTANDING AUTONUMBER FORMATS
An autonumber format can include a series label, a
counter, a tab, and any additional text you need.

and figure numbers on section numbers, they must
all be in the same series.

Series label A series label identifies different
types of autonumber series within the same flow.
For example, you might want to automatically
number tables, figures, and steps. Each of these is
a series, and each series is numbered
independently of the others. (Each set of steps
would not be a different series.)

Counter A counter is a placeholder that
FrameMaker replaces with a number or letter in a
sequence. For example, the counter <n+>
increments the paragraph’s number by 1, so if the
paragraph is the second in a series, FrameMaker
replaces <n+> with the number 2. You can use
multiple counters in a format. For more
information on counters, see “Counters” on
page 4-40.

A paragraph’s autonumber is based on the
previous numbered paragraph with the same
series label in the flow. If you want to base table

Text, tabs, and other punctuation An autonumber
can also include text, bullets, spaces, punctuation,
or tabs anywhere in the format.
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4

Select a Character Format for the autonumber in the Character Format scroll list.

An autonumber format can use only one character format.
If you leave the Character Format text box blank, the autonumber appears in
the paragraph’s default font. For information on character formats, see
“Creating and updating character formats” on page 5-17.
5

Choose a position for the autonumber from the Position pop-up menu.

The autonumber can appear at the beginning or end of the paragraph.
Autonumbers at the end of paragraphs are commonly used in equation formats.
6

Click Apply To Selection.

7

Set a tab stop position for the paragraph if necessary.

If you inserted a tab in the autonumber format, you need to define a tab stop for
the space between the number and the first word in the paragraph. Insert a tab
stop on the ruler. For details, see “To define a tab stop” on page 4-15.
REMOVING AUTONUMBERING

To remove autonumbering from a paragraph format, turn off the Autonumber
Format checkbox in the Numbering Properties of the Paragraph Designer, and
then click Apply. If you delete the format from the Autonumber Format text box
without turning off the checkbox, FrameMaker retains the autonumbering
when you click Apply.

To create a bulleted list
You can create a bulleted paragraph by including a bullet symbol in the
autonumber format. The advantage of using autonumbering to create bulleted
paragraphs (as opposed to simply typing the font’s bullet symbol at the
beginning of each paragraph) is that you can globally change the bullet symbol.
You can choose any symbol as your bullet symbol. For information on using a
different bullet symbol in an autonumbered paragraph, see “To use a different
bullet symbol,” next.
1

Click in the paragraph that you want to make bulleted.

If you want to make several adjacent paragraphs bulleted, select all of the
paragraphs.
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2

In the Numbering properties of the Paragraph Designer, click the bullet and tab
symbols in the Building Blocks scroll list.

Bullet symbol
Tab symbol

The symbols you click appear in the Autonumber Format text box. You can use
spaces rather than a tab if you want to.
3

Click Apply To Selection.

4

Set a tab stop position for the paragraph if necessary.

If you inserted a tab in the autonumber format, you need to define a tab stop for
the space between the bullet and the first word in the bulleted item. Insert a
tab stop on the top ruler. For details, see “To define a tab stop” on page 4-15.
REMOVING THE BULLET

To remove a bullet symbol from a paragraph format, turn off the Autonumber
Format checkbox in the Numbering Properties of the Paragraph Designer, and
then click Apply. If you delete the format from the Autonumber Format text box
without turning off the checkbox, FrameMaker retains the bullet when you
click Apply.

To use a different bullet symbol
You aren’t limited to using the • symbol as the bullet. You can use any character
you like. For example, you can use a Zapf Dingbats square ■ as a bullet symbol.
1

Create a character format with the font that has the bullet symbol you want to use.

For example, if you want to use 9-point Zapf Dingbats, create a character
format using that font. Give the format a descriptive name such as Bullet.
For information on creating character formats, see “Creating and updating
character formats” on page 5-17.
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In the Numbering properties of the Paragraph Designer, type the character
corresponding to the bullet symbol you want in the Autonumber Format text box
(rather than select the symbol in the Building Blocks scroll list).

For example, if you want a Zapf Dingbats square bullet, you type the lowercase
letter N, which prints as ■ in that font. To find out which character corresponds
to the bullet symbol you want, see Chapter 3, “Character Sets,” in the Quick
Reference.
3

Click the tab symbol in the Building Blocks scroll list.

4

Click the bullet character format that you created in the Character Format scroll list.

5

Click Apply To Selection.

COUNTERS
A counter consists of angle brackets (< and >) that surround a display style and
an increment value.

<n + >
Display style

Increment value

To indicate the display style, use a counter with one of these letters.
For this numbering style
Use
..........................................................................

Numeric (1, 2, 3, …)

n

Lowercase Roman (i, ii, iii, iv, …)

r

Uppercase Roman (I, II, III, IV, …)

R

Lowercase alphabetic (a, b, c, … aa)

a

Uppercase alphabetic (A, B, C, … AA)

A

To indicate how an autonumber is incremented, use a counter with one of these
increment values.
To
Use
..........................................................................
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Keep the value the same

<n>

Set the value to 1 or to any other number
you type after the equal sign

<n=1>

Increase the value of the counter by 1

<n+>
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To
Use
..........................................................................

Keep the value the same but don’t display

< >

Reset to zero (or any other number) but
don’t display

< =0>

Each counter is initially set to zero, but you can specify a different initial value.
Thereafter, the counter can maintain its current value, increase by 1, or be
reset to a different value. For example, use <n=1> to reset numbering back to
1 at the beginning of a new section or a new set of numbered steps.
If you want to keep the value the same without displaying it, you must put a
blank space between the angle brackets. If you leave out the blank space, the
angle brackets become part of the autonumber format.
MULTIPLE COUNTERS IN AN AUTONUMBER FORMAT

An autonumber format can have more than one counter. For example,
autonumbers for a series of section titles might each have two counters.
These counter strings
Would appear as
..........................................................................

<n+>.<n=0>

1.0

<n>.<n+>

1.1

<n>.<n+>

1.2

<n+>.<n=0>

2.0

The counters in each format are independent of each other. A counter’s position
in the string determines how it’s displayed and incremented. When
incrementing a counter, FrameMaker bases its value on the corresponding
counter in the previous autonumber paragraph in the same flow.
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AUTONUMBER EXAMPLES

The following example demonstrates multiple counters in section titles. The
counter before the period increments independently from the counter after the
period.
Example
Autonumber formats
Paragraph tags
..........................................................................

1.0 Getting started
1.1 Installing the product
1.2 Backing up the files
2.0 Entering data

<n+>.<n=0>\t

Head1

<n>.<n+>\t

Head2

<n>.<n+>\t

Head2

<n+>.<n=0>\t

Head1

The following example of multiple section heading levels uses as many as three
counters in a single format.
Example
Autonumber formats
Paragraph tags
..........................................................................

1.0 Getting started
1.1 Installing the software
1.2 Backing up the files
1.2.1 If an error occurs
1.3 Entering data

<n+>.<n=0>\t

Head1

<n>.<n+>\t

Head2

<n>.<n+>\t

Head2

<n>.<n>.<n+>\t

Head3

<n>.<n+>\t

Head2

The following example demonstrates outline style autonumber formats.
Example
Autonumber formats
Paragraph tags
..........................................................................

I Getting started
A Installing the product
B Backing up the files
II Entering data
A Opening a file
B Saving a file
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Head1

< ><A+>\t

Head2

< ><A+>\t

Head2

<R+>< =0>\t

Head1

< ><A+>\t

Head2

< ><A+>\t

Head2
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The first heading in the second set of alphabetic headings has incremented back
to A. It does so because the second counter of the previous format resets the
numbering back to zero (without displaying it), so <A+> equals A.
The < > counter tells FrameMaker to keep the value the same but not to
display it. This counter is used because a counter’s position in the string
determines how it’s displayed and incremented. If the < > counter were not in
that position, FrameMaker would produce this result:
I Getting started
B Installing the product
C Backing up the files
IV Entering data
E Opening a file
F Saving a file

The following example uses text (and a space) as part of the autonumber. It
includes a series label and shows how to restart series numbering by reusing
the <n=1> building block. Restarting numbering has been accomplished by
creating a format for the first step and another format for the remaining steps.
Example
Autonumber formats
Paragraph tags
..........................................................................

Step 1. Installing the product
Step 2. Backing up the files
Step 3. Entering data
Step 1. Running test sequences

S:Step <n=1>.\t

Step1

S:Step <n+>.\t

StepNext

S:Step <n+>.\t

StepNext

S:Step <n=1>.\t

Step1
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AUTONUMBERING BASED ON SECTION NUMBERS

Normally, you create a different series for each type of numbering scheme in a
flow. For example, headings, figures, and tables would each have a different
series label. But suppose you want numbering to be based on section numbers
such as the numbering shown in the following table.
Section numbers
Figure numbers
Table numbers
..........................................................................

Section 1
1.1
1.1.1
1.2
1.2.1

Figure 1-1
Figure 1-2

Table 1-1
Table 1-2

Section 2
2.1
2.1.1
2.2
2.2.1

Figure 2-1
Figure 2-2

Table 2-1
Table 2-2

If you were to set up a different series each for sections, figures, and tables,
FrameMaker wouldn’t be able to base the figure and table numbers on the
section numbers. To achieve this type of numbering, you must construct
autonumber formats in a single series. The following table shows the paragraph
formats you could create. It’s presented in table form so that you can clearly see
each counter’s position in the string, which affects how the counter increments.
Paragraph format
Autonumber Format
..............................................................................................

SectionTitle

H:Section

<n+>

Head1

H:

<n>

.<n+>

Head2

H:

<n>

.<n>

FigureTitle

H:Figure

<n>

TableTitle

H:Table

<n>

< =0>

< =0>

< =0>

< =0>

< =0>

< >

< >

.<n+>

< >

< >

< >

< >

-<n+>

< >

< >

< >

< >

-<n+>

Whenever a paragraph tagged SectionTitle occurs, the section number
increments by 1, and the remaining counter values are reset to zero. The <n+>
counters in the remaining formats each have their own position in the string.
That way, they increment independently.
The < > counters keep FrameMaker from resetting values back to zero.
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After you format some text, you can assign the format a name (its tag)
and store the format in a catalog. When you apply a catalog format to a
paragraph or to specific text within a paragraph, FrameMaker updates
the paragraph or text to match the catalog format.

Catalogs maintain consistency and speed up formatting
In most documents, you’ll want each type of paragraph or text to look
the same everywhere it’s used. For example, all body paragraphs should
have the same indent, default font, and alignment properties. By
creating and applying catalog formats, you can maintain complete
consistency in a document and in templates you create for formatting
other documents.
Using catalog formats also makes the job of formatting go faster. You
can quickly maintain and update formats throughout an entire
document.

A paragraph format defines the entire paragraph
The formats in the Paragraph Catalog contain the properties for the
paragraph as a whole. When you create a paragraph format, you
include information about indentation, alignment, the default font,
automatic numbering, tab stops, hyphenation, word spacing, and so on.
The format Head1 defines a
paragraph that is left
aligned, 9-point Helvetica
bold, with 4 points of space
below it.
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item as you go, to complete inspection of Espresso units.
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A character format sets the font properties of specific text
At times, you may want a specific text item—a character, word, or
phrase—to stand out from the rest of the text in a paragraph. For
example, you may want to italicize book references. For these types of
situations, you can use formats from the Character Catalog to change
the text’s font properties without changing anything else in the
paragraph.
The character format
Emphasis changes the font
of a specific text item to
bold italic.

f Catalog

Primo Cappuccino Model P
Follow these steps, checking each
item as you go, to complete inspection of Espresso units.
■

Visually inspect threading.

■

With gauge, measure distance and
angle of threads.

Bullet
Emphasis
ManualName
RunIn
StepNumber

Catalog changes affect all tagged text
A big advantage of using formats from the Paragraph Catalog and
Character Catalog is that you can change the properties of a paragraph
or selected text item and then update the catalog format and all
formats in the document with the same tag (name). In fact, you can
choose to update one, several, or all formats in the catalog.

Formats on the page can differ from catalog formats
There may be times when you want to change a particular paragraph or
text item so that its format no longer matches the catalog format with
the same tag. For example, you may want a particular paragraph to
start at the top of a page even though its corresponding catalog format
lets it start anywhere. In such a case, you can simply change the
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paragraph’s format without updating the catalog format, thereby
creating a format override.
This body paragraph’s
format matches the catalog
format with the same tag.

This paragraph has the tag
Body, but its format does not
match the catalog format
with the same tag.

How Coffee Got Its Name

¶ Catalog

Although the small tree or shrub is of the
genus Coffea, the name of the beverage
comes from the Arabic word kahwah, which
originally referred to the bitter taste of the
beverage rather than to the plant.

Body
Footnote
Head1
Head2
Table Title

Coffee is so universally popular both
because of its flavor and its energizing
effect, which is produced by caffeine.
Caffeine is an alkaloid present in green
coffee in amounts between 0.8 and 1.5

If you follow the instructions for changing text properties in the
previous chapter literally, without creating or updating a catalog
format, you create overrides of this kind. If you change a catalog
format, FrameMaker detects any overrides of that format and gives you
a chance to retain them. For example, you may want to retain page
break overrides.

Templates and sample files demonstrate a variety of formats
For ideas on the types of formats you may want to create, look at the
FrameMaker templates or sample files. If you find a paragraph that has
a format similar to the format you want, you can copy its format to your
document and add it to your document’s catalog. From there, you can
make any changes to the format you want.

In this chapter
This chapter tells you how to apply formats from the Paragraph
Catalog and Character Catalog, how to create new formats, and how to
update the properties of existing formats.
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APPLYING FORMATS
All documents have a Paragraph Catalog and a Character Catalog. When you
apply a catalog format to text, FrameMaker changes the text to match the
catalog format’s properties. You can apply a format by choosing it from a catalog
or by copying it from another paragraph or text item. You can also specify, as
part of a paragraph’s format, the format to be used when you press Return to
create a new paragraph.

To apply a format from the Paragraph Catalog
When you apply a format from the Paragraph Catalog to a paragraph,
FrameMaker changes the paragraph to match the catalog format’s properties.
For additional ways to choose a format from the Paragraph Catalog, see “Other
ways to choose from catalogs” on page 5-5.
1

Click in the paragraph to which you want to apply a catalog format.

If you want to apply a format to several adjacent paragraphs, select all of the
paragraphs.

OTHER WAYS TO CHOOSE FROM CATALOGS
You can choose paragraph and character formats
from the catalogs in several ways.
For quick access to Paragraph
Catalog formats, you can choose them from
the Paragraph Format pop-up menu on the
formatting bar.

Paragraph formats

The current paragraph’s tag
appears in the Paragraph
Format pop-up menu.

You can also choose formats from the
Format>Paragraphs submenu.
For quick access to Character
Catalog formats, you can choose them from the
Format>Characters submenu.

Character formats

After selecting the paragraph
or text item to which you want to apply a format,
press Control-9 to apply a paragraph format or
press Control-8 to apply a character format.

Keyboard shortcuts

To prompt you to type a tag, the Tag area in the
status bar at the bottom of the document window
is highlighted. It contains either ¶: for paragraph
format or ƒ: for character format.
Start typing the format’s tag. You need to type only
a few characters before the name appears in the
Tag area. Type lowercase letters to search forward,
and type uppercase to search backward. You can
also use the up arrow and down arrow keys to
scroll through formats. Press Return to apply the
format or, if you decide to cancel the operation,
click in the document without pressing Return.
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2

Click the Paragraph Catalog button
in the upper-right corner of the document
window to display the Paragraph Catalog.

3

Click a format in the Paragraph Catalog to apply that format to the paragraph.

The Tag area on the left side of the status bar shows the paragraph’s tag.
The paragraph’s tag
changes to the tag of the
format you click.

To apply a format from the Cha racter Catalog
When you apply a format from the Character Catalog to specific text within a
paragraph, FrameMaker changes the text to match the catalog format. Later, if
you don’t want to use the format on that text anymore, you can change the text
back to the paragraph’s default font. For information on changing text back to
the default font, see “Removing a character format” on page 5-7.
For additional ways to choose a format from the Character Catalog, see “Other
ways to choose from catalogs” on page 5-5.
1

Select the text to which you want to apply a character format.

Don’t select an entire paragraph. If you do, the character format you apply is
considered a format override of the paragraph’s default font. See “Tagged text
and format overrides,” next.
If you click in the paragraph without selecting any text, FrameMaker applies
the character format you choose to any text you type at the current insertion
point.
2

Click the Character Catalog button
in the upper-right corner of the document
window to display the Character Catalog.

3

Click a format in the Character Catalog to apply that format to the selected text.

The Tag area on the left side of the status bar shows the text’s character tag.
The text’s tag changes to
the tag of the format you
click.

TAGGED TEXT AND FORMAT OVERRIDES

Text with a character format is not considered an override of the paragraph
where it resides (unless you selected the entire paragraph). When you update a
paragraph format, character formats are not removed from paragraphs that are
changed; format overrides are removed. For information on format overrides,
see “Overriding a catalog format’s properties” on page 5-13.
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REMOVING A CHARACTER FORMAT

To remove a character format from text and redisplay the text in the default
font of the paragraph, select the text and click Default ¶ Font in the Character
Catalog. For example, if you apply the Emphasis format to a word and then
decide you don’t want it to have this format, select the word and apply Default ¶
Font from the Character Catalog.

To apply a format from a different paragraph or text item
You can apply the paragraph or character format of text to another paragraph
or text item. FrameMaker applies the format’s tag along with its other
properties.
You apply a format in this way by copying it to the FrameMaker Clipboard and
pasting it in another location. Because you’re using the Clipboard, you can
paste the format in a different document as well. If you paste the format in a
different document, the format is not automatically added to the appropriate
catalog. In the case of a paragraph format, you can add it to the catalog if you
want to.
1

Click in text with the paragraph or character format you want to copy.

2

Choose Copy Special>Paragraph Format or choose Copy Special>Character Format
from the Edit menu.

3

Click where you want to apply the format.

If you’re copying a character format, select the text to which you want to apply
the format.
4

Choose Paste from the Edit menu.
ADDING A COPIED PARAGRAPH FORMAT TO A CATALOG

After you copy a format from one document to another, you can store the format
in the second document’s Paragraph Catalog. For information on storing
formats in the catalog, see “To create a paragraph format” on page 5-11.

To apply a format to paragraphs or characters with certain tags
You can apply a format to multiple paragraphs or text items in a variety of
ways. You can apply a format to all paragraphs or text in the document; to all
whose tags occur in a selection; or to all that have a particular tag. For example,
you could apply the format Head1 to all paragraphs currently tagged Head2.
1

If you want to apply a format to paragraphs or text items with several different tags,
select consecutive paragraphs or text items that have those tags.

If you want to apply the format to all paragraphs or text items, or to paragraphs
or text items with one particular tag, you can skip this step.
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When you select multiple paragraphs or text items, conflicting properties in the
Paragraph Designer or Character Designer, including the tag, are set to As Is.
For more information on the As Is setting, see “Understanding the As Is
setting” on page 5-18.
2

In the Paragraph Designer or Character Designer, choose the format you want to
apply from the Paragraph Tag or the Character Tag pop-up menu.

The designer window displays the properties of the format you choose,
including the tag.

This is the format you want
to apply.

Paragraph Tag pop-up menu

THE PARAGRAPH DESIGNER
The Paragraph Designer includes several areas
and commands for creating and changing
paragraph formats.
This text box identifies which
format will be applied or
updated.

Basic is one of six groups of
properties you can choose
to display from this menu.

In the commands area, you can apply all properties
in all property groups (including the tag) to the
current paragraph’s format. You can also update
all paragraph formats that have the same tag,
including the format stored in the Paragraph
Catalog. Additionally, in the Commands pop-up
menu, you can choose commands for updating
specific properties of selected paragraph formats.
The Paragraph Designer displays property
changes you make with the formatting bar. These
changes apply only to the current paragraph, as if
you had clicked Apply in the Paragraph Designer.
If you want to update the catalog format, you must
use one of the Update commands.
If you use the Paragraph Designer to change
properties, the paragraph doesn’t change to reflect
the new properties until you apply or update them.

The buttons and commands
in this area let you choose
how you want to apply
changes or update formats.
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3

Choose Global Update Options from the Commands pop-up menu.

4

Choose the paragraphs or text items you want to retag.

Click here to retag all
paragraphs or text items in
the document.
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Choose a tag from the
pop-up menu to retag all
paragraphs or text items
currently assigned the tag
you choose.

Click here to retag all
paragraphs or text items
whose tags occur in the
selection.

5

Click All Properties in the Use Properties area if you’re retagging paragraphs.

When you retag text items with the Character Designer, the Global Update
Options dialog box does not include this choice because the Character Designer
doesn’t have property groups.
6

Click Update.

To apply a format to the next paragraph
Normally, when you press Return, FrameMaker applies the current
paragraph’s format to the new paragraph. But you can specify that
FrameMaker use a different format when you press Return. For example, you
can specify that when you press Return in a heading paragraph, the next
paragraph will be a body paragraph.
1

From the Paragraph Tag pop-up menu in the Paragraph Designer, choose the format
that has the Next ¶ Tag property you want to update.

The format’s properties are displayed in the Paragraph Designer.
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2

From the Next ¶ Tag pop-up menu in the Basic properties, choose the tag you want
FrameMaker to apply to the next paragraph.

The format you specify must be in the Paragraph Catalog. If the format isn’t in
the catalog, FrameMaker ignores this setting.
3

Click Update All.

FrameMaker updates the catalog format and all paragraphs in the document
with the same tag. The Next ¶ Tag property does not affect any existing next
paragraphs. It applies the specified format only to new paragraphs you create
by pressing Return.

CREATING AND UPDATING PARAGRAPH
FORMATS
Each FrameMaker template and blank paper template already has a
Paragraph Catalog with existing formats that you can modify or use as the
foundation for creating new ones.
Each type of paragraph in a document should have its own catalog format. For
example, there should be separate formats for body paragraphs, numbered
steps, and headings. When creating new formats for a document, you start by
assigning the default font to a single body paragraph. Then you determine its
appearance, placement, and other properties. Once the body paragraph is
correctly formatted and catalogued, you can modify its properties to create the
other paragraph formats.
When you update a format, you can choose to update all properties, one group of
properties, or several properties within a group. You can also choose which
formats you want to update. For a brief overview of using the Paragraph
Designer to update formats, see “The Paragraph Designer” on page 5-8.
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To create a paragraph format
To create a paragraph format, you can modify the properties of an existing
paragraph’s format. For example, to create various heading levels, you can start
with the first level and then change the font size and style to create the other
levels. After you modify an existing paragraph’s format, you store the format in
the Paragraph Catalog with a different tag.
1

Click in a paragraph that has a format similar to the one you want to create.

2

Modify the paragraph’s properties.

You can use any of the methods described in Chapter 4, “Formatting Text.”
3

Choose New Format from the Paragraph Format pop-up menu on the formatting bar.

Paragraph Format pop-up
menu

You can also choose New Format from the Commands pop-up menu in the
Paragraph Designer.
4

In the New Format dialog box, type a name for the new format in the Tag text box.

For suggestions on naming paragraph formats, see “Tips on creating formats”
on page 5-12.
5

To indicate that the format should be stored in the Paragraph Catalog, turn on Store in
Catalog.

Normally, you’ll want to store a newly created format in the Paragraph Catalog.
Formats that are stored in the Paragraph Catalog can be updated or copied to
other documents by using the Import>Formats command. If you don’t want this
format available for use elsewhere, don’t store it in the catalog. Formats that
aren’t stored in the catalog can be applied to other paragraphs only by copying
and pasting.
6

To apply the new format to the current paragraph, turn on Apply to Selection.

7

Click Create.
USING ANOTHER DOCUMENT’S PARAGRAPH CATALOG

If you’re using a particular document as a template for other documents, you
can copy the Paragraph Catalog from the template to a new document. You do
this by using the Import>Formats command. For information on importing
formats, see “Importing formats into a document” on page 21-12.
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To update a paragraph format
After changing a paragraph’s properties, you can update the corresponding
catalog format and all paragraphs in the document with the same tag. When
you update a catalog format, all properties in all property groups are updated to
match the current paragraph.

TIPS ON CREATING FORMATS
You’ll find it easier to use and maintain the
Paragraph Catalog and Character Catalog if you
follow these guidelines for creating formats. For
examples of various formats and how they look
when applied to paragraphs, look at the catalogs in
the FrameMaker templates and sample files.
Standardized tags By standardizing tags, you can
easily copy formats between documents. For
example, if you use Heading1 for first-level
headings in one document, use the same tag for
first-level headings in other documents.

Use consistent
naming conventions for similar kinds of
paragraphs or text items within a paragraph. For
example, if you use Heading1 for first-level
headings, use Heading2 for second-level headings.

of emphasis (to bold, for example), and you won’t
need to change the tag.
Tags are case-sensitive:
Body is not the same as body.

Consistent capitalization

Formats for numbered lists To create numbered
lists, you can create one format for the first item in
the list and a second format for the remaining
items in the list. Set the counter to <n=1> for the
first format and <n+> for the second format. For
examples of autonumber formats, see “Counters”
on page 4-40.

Consistent naming conventions

Next paragraph

Tags that indicate function Give each format a tag
that’s easy for you and others to remember,
recognize, and type. A tag should indicate the use,
not the appearance, of the format.

When creating the formats for a numbered list,
you can specify that the format for the first item
will be automatically followed by the format for the
second.

For example, use the character tag Emphasis for a
format that uses italics for emphasis. Doing so
provides more flexibility than having a format
named Italic, because you can change your method

For information on specifying the format
FrameMaker uses when you press Return, see “To
apply a format to the next paragraph” on page 5-9.
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You can specify that one type of
paragraph should normally be followed by a
paragraph with a different format. For example, in
most documents, a heading should always be
followed by a body paragraph.
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Click in a paragraph that has the format you want to update.

The paragraph’s format may not match the catalog format with the same tag,
depending on whether the paragraph contains any format overrides. If you
want to start out with the catalog format’s properties (without any overrides),
choose the format from the Paragraph Tag pop-up menu in the Paragraph
Designer, even if the tag you want is already displayed in the Paragraph Tag
text box.
2

Change the paragraph’s properties.

You can use any of the techniques described in Chapter 4, “Formatting Text.”
3

Choose Update All from the Paragraph Format pop-up menu on the formatting bar.

The asterisk indicates that
the paragraph’s format no
longer matches the catalog
format with the same tag.

Paragraph Format pop-up menu

OVERRIDING A CATALOG FORMAT’S PROPERTIES
When you change the properties of a paragraph or
text item, that paragraph’s or text’s format no
longer matches the catalog format with the same
tag. If you’re formatting quick, one-time-only
documents, these format overrides pose no
problem. If you’re using the catalog formats to
maintain consistency in a document, you’ll
probably want to eliminate the overrides by
updating the catalog format with the same tag.
(Text that is assigned a character format is not
considered an override of the paragraph where it
resides.)
However, there may be times when you want to
retain overrides so that the paragraph’s format no
longer matches the catalog format with the same

tag. For example, you may want a particular
paragraph to start at the top of a page even though
its corresponding catalog format lets it start
anywhere. In such a case, you simply change the
paragraph’s format without updating the catalog
format.
FrameMaker indicates that a paragraph or text
item has format overrides by displaying an
asterisk (*) next to the tag in the Tag area as well
as in the Paragraph Format pop-up menu.
If you later modify the catalog format, you can
choose whether you want to retain format
overrides when FrameMaker updates all
paragraphs in the document with the same tag.
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4

In the Update Paragraph Format dialog box, indicate whether you want to remove
manual page breaks or other paragraph format overrides.

Leave the checkboxes off if you want to keep the overrides. Turn on the
checkboxes if you want to remove the overrides.
For information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13.
5

Click Update.
USING THE PARAGRAPH DESIGNER

If you use the Paragraph Designer to modify a paragraph’s properties, you can
update the catalog format and all paragraphs with the same tag by clicking
Update All in the Paragraph Designer.
If FrameMaker detects format overrides in any of the paragraphs being
updated, it displays an alert that asks whether you want to retain or remove
them. For information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13.
RESETTING THE PROPERTIES

If you change properties in the Paragraph Designer and then decide you don’t
want to update them, you can reset the properties to match the current
paragraph.
To display the properties of the current paragraph, choose Reset Window from
Selection from the Commands pop-up menu in the Paragraph Designer.

To update other paragraph formats with a property group
Paragraph properties are divided into six groups that are displayed separately
in the Paragraph Designer. You can use any group of properties from one
paragraph format to update other formats. For example, if you want to change
the default font properties for an entire document, you can change them for one
format and apply the changes to the remaining formats in the catalog without
changing any other properties.
You can update part of a group of properties as well as an entire group. For
instructions, see “To update other paragraph formats with one or two
properties” on page 5-16.
1

Click in a paragraph or select consecutive paragraphs.

Click in a paragraph if you want to update one or all paragraph formats in the
document with a property group from that paragraph. The Paragraph Designer
displays the properties of the paragraph, including its tag.
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Select consecutive paragraphs if you want to update more than one, but not all,
paragraph formats. For example, you can select items in an autonumbered list
to change a property group for the various formats represented there. When you
select multiple paragraphs, conflicting properties in the Paragraph Designer,
including the tag, are set to As Is. For more information on the As Is setting, see
“Understanding the As Is setting” on page 5-18.
2

In the Paragraph Designer, delete the tag from the Paragraph Tag text box if the text
box isn’t empty.

Deleting the tag from the text box keeps FrameMaker from changing the tags of
the formats you update.
3

From the Properties pop-up menu, choose the property group you want to apply.

4

Make any changes necessary to set up the properties the way you want them.

For example, select a different building block to define an autonumber format.
5

Choose Global Update Options from the Commands pop-up menu.

6

Choose the formats to which you want FrameMaker to apply the properties.

Current property group
Click here to apply the
properties to all formats in
the document.

Choose a tag from the
pop-up menu to apply
the properties to the
paragraphs and to the
catalog format with
that tag.

Click here to apply the
properties to all paragraphs
and to all catalog formats
whose tags occur in the
selection.

7

Click the current property group in the Use Properties area.

8

Click Update.

FrameMaker applies the properties to the Paragraph Catalog formats you
specified and to all paragraphs in the document with the same tags.
If FrameMaker detects format overrides in any of the paragraphs being
updated, it displays an alert that asks whether you want to retain or remove
them. For information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13.
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DISPLAYING ANOTHER FORMAT’S PROPERTIES

After deleting the tag from the Paragraph Tag text box, you can display the
properties of any catalog format without displaying the format’s tag. To do this,
hold down the Shift key when you choose the format from the Paragraph Tag
pop-up menu. You can then update a different catalog format with those
properties.

To update other paragraph formats with one or two properties
At times, you may want to update one or two properties of one or more
paragraph formats without changing any other properties. For example, you
may want to change some or all formats from justified to left aligned. Rather
than update each format separately, you can update them all at once.
1

If you want to update more than one, but not all, paragraph formats, select
consecutive paragraphs that have the formats you want to change.

If you want to update all paragraph formats or just one, you can skip this step.
2

In the Paragraph Designer, display the group of properties from which you want to
select one or two properties to apply.

3

From the Commands pop-up menu, choose Set Window to As Is.

Settings in all property groups in the Paragraph Designer change to indicate
that their status is As Is. FrameMaker won’t change properties set to As Is
when it updates the other formats. For example, the Paragraph Tag text box is
blank so that updating other formats won’t change their tags.

The Paragraph Tag text box
is blank.
Other text boxes become
blank to indicate As Is.

Checkboxes dim to indicate
As Is.
As Is appears in pop-up
menus.

For more information on setting properties to As Is, see “Understanding the As
Is setting” on page 5-18.
4
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Change only the properties you want to update, leaving the rest set to As Is.

5

Choose Global Update Options from the Commands pop-up menu.

6

Choose the formats to which you want to apply the properties.
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Current property group
Click here to apply the
properties to all formats in
the document.
Click here to apply the
properties to all paragraphs
and catalog formats whose
tags occur in the selection.

Choose a tag from the
pop-up menu to apply the
properties to the paragraphs
and the catalog format with
that tag.

7

Click the current property group in the Use Properties area.

8

Click Update.

FrameMaker applies the properties to the Paragraph Catalog formats you
specified and to all paragraphs in the document with the same tags.
If FrameMaker detects format overrides in any of the paragraphs being
updated, it displays an alert that asks whether you want to retain or remove
them. For information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13.

CREATING AND UPDATING CHARACTER
FORMATS
Each FrameMaker template and blank paper template already has a Character
Catalog with existing formats that you can modify or add to. You should set up
a format for each type of text item used in the document. For example, you can
have character formats for boldface product names, italicized book titles, and
so on.
When defining the properties of a character format, you use the Character
Designer. For details, see Chapter 4, “Formatting Text.” The Character
Designer has the same areas and commands as the Paragraph Designer, so you
use it exactly the same way. With the Character Designer, you can change the
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font properties of a text item—the same font properties used in the Paragraph
Designer to update entire paragraphs.
For information on how the Character Designer works, read about how the
Paragraph Designer works in “The Paragraph Designer” on page 5-8.

To create a new character format
Normally, applying a character format changes only one or two properties of the
selected text. For example, you may have a character format that changes the
selected text to italic without changing the font family or size. When creating a
character format, you specify the properties you want and set the remaining
properties to As Is.
When you create a new character format, FrameMaker stores the format in the
Character Catalog and applies it to the selected text.
1

Select some text.

UNDERSTANDING THE AS IS SETTING
The As Is setting in the Paragraph Designer,
Character Designer, and Table Designer has three
purposes. When properties are set to As Is in a
designer window, text boxes are empty, checkboxes
are dim, and As Is appears in pop-up menus.
If you
select multiple paragraphs, text items, or tables
that have different values for a property, the
designer window displays As Is for that property.

When selecting items with different properties

For example, if you select two paragraphs, one
centered and the other left aligned, the Alignment
pop-up menu displays As Is.
If you want to
change some, but not all, of the properties, you can
turn the properties you don’t want to change to As
Is. When FrameMaker applies properties, it
doesn’t change properties set to As Is.
When changing several properties

For example, if you want to change all headings
from centered to left aligned, but you want to leave
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the rest of their properties intact, you can set all
properties to As Is, change only the alignment
property, and then update all heading formats.
FrameMaker changes only the alignment property
of those formats. The As Is setting is not actually
stored as part of the format.
When creating a character format When you create
a character format, you use As Is to specify the
properties that FrameMaker won’t change when
you apply the format to specific text within a
paragraph. In this case, the As Is property is
stored as part of the character format.

For example, you can create a character format
named Emphasis that changes selected text to
italics while leaving the font family and size as it
is. By turning on As Is for these other settings, you
tell FrameMaker to leave them as they are when it
applies the format to text.
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2

In the Character Designer, choose Set Window to As Is from the Commands
pop-up menu.

All property settings in the Character Designer change to indicate that their
status is As Is.

Text boxes become blank to
indicate As Is.
As Is appears in pop-up
menus.
Checkboxes dim to indicate
As Is.

For more information on the As Is setting, see “Understanding the As Is
setting” on page 5-18.
3

Change only the properties you want to include in the character format, leaving the
rest set to As Is.

4

Choose New Format from the Commands pop-up menu.

5

In the New Format dialog box, type a name for the new format in the Tag text box.

For suggestions on naming character formats, see “Tips on creating formats” on
page 5-12.
6

To indicate that the format should be stored in the Character Catalog, turn on Store in
Catalog.

Normally, you’ll want to store a newly created format in the Character Catalog.
Formats that are stored in the Character Catalog can be updated or copied to
other documents by using the Import>Formats command. If you don’t want the
format copied to other documents by the Import>Formats command, don’t store
it in the catalog. Formats that aren’t stored in the catalog can be applied to
other text items only by copying and pasting.
7

To apply the new format to the current text item, turn on Apply to Selection.

8

Click Create.
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USING ANOTHER DOCUMENT’S CHARACTER CATALOG

If you’re using a particular document as a template for other documents, you
can copy the Character Catalog from the template to a new document. You do
this by using the Import>Formats command. For information on importing
formats, see “Importing formats into a document” on page 21-12.

To update a character format
When you change the properties of text with a character format, you can
update the Character Catalog format and all formats in the document with the
same tag.
1

In the Character Designer, choose the format you want to change from the Character
Tag pop-up menu.

When you choose the format from the pop-up menu, the properties of the
Character Catalog format, including the As Is settings, are displayed.
Make sure you perform this step even if it means choosing the same tag as the
one currently displayed. If you don’t, the properties of the current text are
displayed in the Character Designer, and those properties won’t show the As Is
settings of the Character Catalog format with the same tag.
2

Change the desired properties.

3

Click Update All.

If FrameMaker detects format overrides in any of the text being updated, it
displays an alert that asks whether you want to retain or remove them. For
information on format overrides, see “Overriding a catalog format’s properties”
on page 5-13.
RESETTING THE PROPERTIES

If you change properties in the Character Designer and then decide you don’t
want to update them, you can reset the properties to match the current text.
To display the properties of the current text, choose Reset Window from
Selection from the Commands pop-up menu in the Character Designer.
To redisplay the As Is settings of the Character Catalog format, choose the
catalog format from the Character Tag pop-up menu.

To update properties of other character formats
At times, you may want to update one or two properties of one or more
character formats without changing any other properties. For example, you
may want to add a color to all character formats. Rather than update each
format separately, you can update them all at once.
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1

If you want to update more than one, but not all, character formats, select text that
includes the formats you want to change.

If you want to update all character formats or just one, you can skip this step.
2

In the Character Designer, choose Set Window to As Is from the Commands
pop-up menu.

Properties in the Character Designer change to indicate that their status is As
Is. When it updates the other formats, FrameMaker won’t change properties set
to As Is. For example, the Character Tag text box is blank so that updating
other formats won’t change their tags. For information on the As Is setting, see
“Understanding the As Is setting” on page 5-18.
3

Change only the properties you want to update, leaving the rest set to As Is.

4

Choose Global Update Options from the Commands pop-up menu.

5

Choose the formats to which you want to apply the properties.

Click here to apply the
properties to all characters
in the document.

Choose a tag from the
pop-up menu to apply the
properties to the characters
and catalog format with
that tag.

Click here to apply the
properties to all characters
and the catalog formats
whose tags occur in the
selection.

6

Click Update.

FrameMaker applies the properties to the Character Catalog formats you
specified and to all character formats in the document with the same tags.
If FrameMaker detects format overrides in any of the formats being updated, it
displays an alert that asks whether you want to retain or remove them. For
information on format overrides, see “Overriding a catalog format’s properties”
on page 5-13.
UPDATING ALL CHARACTERS

If you choose the All Characters and Catalog Entries option, FrameMaker
updates all characters in the document, including characters in text lines. It
also updates the default font properties of all paragraph formats and the
properties of all character formats.
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RENAMING AND DELETING FORMATS
As you design the paragraph and character formats needed for a document, you
may need to rename a format or delete a format altogether.

To rename a catalog format
You may need to rename a format if, for example, your naming conventions
change, or if you want to import a catalog from a template and don’t want a
format to be overwritten.
1

In the Paragraph Designer or Character Designer, choose the tag you want to
change.

In the Paragraph Designer, choose from the Paragraph Tag pop-up menu; in the
Character Designer, choose from the Character Tag pop-up menu.
Make sure you perform this step even if it means choosing the same tag as the
one currently displayed. Choosing a tag from the pop-up menu ensures that the
properties of the catalog format are displayed.
2

Type a new name in the Paragraph Tag or Character Tag text box and click
Update All.

Because the tag in the text box differs from the tag under the Update All
button, FrameMaker asks whether you want to rename the format.
3

Click OK to rename the format.

To delete a format from a catalog
You may need to delete a format if, for example, you imported a catalog from a
template and an old format is no longer needed. Deleting a format from a
catalog does not affect any paragraphs or characters that have the same tag—
the paragraphs or characters simply have a tag that isn’t in the catalog.
1

Display the Paragraph Catalog or Character Catalog and click Delete.

2

In the Delete Formats from Catalog dialog box, select the format in the scroll list and
click Delete.

You can delete additional formats if you want to.
3

Click Done.

The formats are not actually deleted from the catalog until you click Done.
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A table organizes related information by placing it in cells arranged in
rows and columns. FrameMaker tables are already formatted with cells
that you can fill in.

Standard types of rows
A table can have heading, body, and footing rows as well as a title.
Title

Heading rows

Body rows

Footing row

Table 1-1:

Guide to Public Transportation

Route Name

Frequency of Service in Minutes
FIRST

7–9AM

4–6PM

EVE

LAST

PH

Powell & Hyde

6:09

10

6

8

12:31

PM Powell & Main

6:33

10

6

8

12:42

F

Closed 10 Nov. through 15 Dec.

Market

FIRST

7–9AM

4–6PM

EVE

LAST

Footing rows are less common than heading rows, although they can be
useful for repeating column headings at the bottom of a table or for
explaining symbols used in the table.

Text, graphics—even other tables
You can type and format text in a table cell just as you do in other parts
of a document. You can apply paragraph and character formats, insert
variables and cross-references, draw or import graphics, or even insert
another table.
As you add text and graphics to a cell, FrameMaker automatically
increases the cell’s height to accommodate its contents.
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You start with an empty table or ordinary text
Creating a FrameMaker table usually involves inserting an empty
table and filling in the contents of cells. The features of the empty table
are determined by its format.
Table 1: New York

This table’s format includes
an autonumbered title.

Day

Itinerary

Monday

Visit the Metropolitan
Museum.

The format specifies a
shaded heading row and
ruling lines that separate the
heading and body rows.

Tuesday

Visit the Museum of
Modern Art.

The format positions the text
in the six cells.

The format centers the table
in the text column.

Table formats are stored in the Table Catalog, which functions just like
the Paragraph Catalog. You can add formats to the Table Catalog,
update catalog formats, and apply new formats to existing tables.
You can also convert existing text to a table. If the text is in another file,
you can import and convert it in one step.

You can change the format as you work
When you insert a table, you can change the number of rows and
columns its format calls for. As you work in the table, you can add,
delete, rearrange, or resize rows and columns. For tables with special
requirements, you can rotate headings, combine adjoining cells, and
make other customizations.

In this chapter
This chapter shows you how to insert tables, how to fill them in with
text and graphics, and how to convert text to tables. It also shows you
how to rearrange and resize rows and columns and how to rotate tables
and table cells.
Rearranging and resizing rows and columns are changes you can make
to the defaults of a table’s format. Chapter 7, “Table Formats,” describes
the more refined format changes you can make with the Table Designer.
It shows you how to apply format changes to existing tables and how to
store new and updated table formats in the Table Catalog. Chapter 7
also describes a number of special table customizations.
Using FrameMaker
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INSERTING AND MANIPULATING TABLES
With FrameMaker, you can insert a new, empty table and fill in its contents.
The table’s initial format is based on the format you choose from the Table
Catalog.

This table has an
autonumber title; you fill in
the rest.
You fill in the contents of the
heading, body, and footing
cells.

If you’ve modified the initial format of an existing table and want to use its
format for additional tables, you can duplicate the existing table and then edit
the new table’s contents.
After you’ve inserted a table, you can move it to another location, rotate it, or
delete it. You can select individual cells, rows, or columns or the entire table.

To insert a new, empty table
When you insert a new, empty table, you select a format in a scroll list in the
dialog box. This scroll list displays the formats in the Table Catalog. A table
format includes the table’s position in the text frame, its cell margins, its ruling
and shading, and whether it has a title. A table format also has default settings
for the number of body, heading, and footing rows; the number and width of
columns; and paragraph formats. You can specify a different number of rows
and columns as you insert a table, or you can change any of its properties after
you insert it.
Just as it does when creating an anchored frame, FrameMaker anchors a new
table where you click in text. Similarly, tables that straddle columns derive
some of their layout properties from the text to which they are anchored.
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Click in the line of text to which you want to anchor the table.

You can’t insert a table in a footnote or in another table. For information on
inserting a table in text when the text is in a multicolumn layout, see “Tables
that straddle” on page 6-5. In certain cases, text will run around the inserted
table. For details, see “Running text around a table” on page 6-6.

TABLES THAT STRADDLE
A table in a multicolumn text frame can straddle
columns, and its position may be affected by
straddle paragraphs.
Anchored in a straddle paragraph A table anchored
in a multicolumn text frame straddles columns
when its anchor symbol is in a straddle paragraph.
A table anchored
in a straddle
paragraph...

A top-of-column
table anchored
below a straddle.

...always straddles
the full column
width.

...whatever its
width...

A table that extends into a
second column of the body area straddles all
columns in the body area. A table that extends into
the side-head area straddles the side-head area
as well.

Wider than a column

Table straddles
all columns.

Anchored below a straddle paragraph If the anchor
symbol for a top-of-column table appears below a
paragraph that straddles columns, the table
appears in the next column but just below the
straddle paragraph instead of at the top of the
column.

If you resized the table in the example so that it
was wider than the column plus the gutter, the
table would move to the top of the next page and
straddle all columns there.
If a straddle table is defined as
floating, it can “jump over” straddle paragraphs
that come after the table’s anchor. For more
information, see “To control where a table begins”
on page 7-30 and “Anchored frames in
multicolumn layouts” on page 15-9.

Defined as floating

Table straddles side-head
area and columns.
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2

Choose Insert Table from the Table menu.

3

Select a format for the table.

Select a table format.

These text boxes display the
format’s default number of
columns and rows.

RUNNING TEXT AROUND A TABLE
Text does not run around a table that is anchored
directly in a column of text. You can, however, run
text around a table that is in an anchored frame or
in a text frame disconnected from the main flow.
To run text
around a table in an anchored frame, create an
anchored frame positioned as Run into Paragraph
and then insert a text frame in the anchored frame
to hold the table. You can align the anchored frame
on the left or right side of the column, or on the
side closer to or farther from the binding in a
double-sided layout. For more information, see “To
run text around an anchored frame” on page 15-13.

Table in an anchored graphic frame

Table in a frame anchored
as Run into Paragraph with
left alignment
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Table in a disconnected frame To run text around a
table that is not anchored to text but instead
remains in one place on a page as text changes,
draw a text frame directly on a page and place the
table in it. This sort of text frame is not connected
to the main flow. For more information, see “To add
a text frame” on page 13-26. To adjust the text
runaround, select the text frame and choose
Runaround Properties from the Graphics menu.
For details, see “To run text around a graphic” on
page 13-30.

Table in a frame not
connected to the main flow
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The table formats available are template-dependent. In a new, blank document,
FrameMaker provides two table formats—Format A and Format B.
4

If necessary, type a different number of rows or columns in the Columns and Rows text
boxes.

5

Click Insert.

To select in a table
Many of the procedures for working in a table require that you first select the
cells, rows, or columns, or the entire table on which you want to work.

Shipment
Date

Selection
handle

15 March
15 March
15 March

When a cell rather than just its contents is selected, a selection handle is
visible.
■

To select a single cell, drag across the cell’s border and back into the cell.

■

To select multiple cells, drag across all the cells you want to select.

■

To select entire rows or columns, drag across the rows or columns you want to select.

You can select a column quickly by dragging from a heading cell into the first
body cell.
■

To select the entire table, select a cell in the table and choose Select All of Table from
the Edit menu.

You can select the table quickly by dragging across the heading row and then
downward into the body rows.
■

To extend a selection, Shift-click the last cell you want to include in the selection.
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To duplicate a table
After setting up a table exactly the way you want it, you can duplicate it
elsewhere in the same document or in another document. This way, you can use
the table as the foundation for additional tables. For example, you can set up a
table with rotated headings or headings that straddle cells and then duplicate
the table wherever you want similar tables. Perhaps you also created some
custom ruling or shading for the table.
When you duplicate a table, its format and contents are copied. You can edit the
text of the new table or delete its contents and start again. You can also change
any of its formatting.
1

Select the table you want to duplicate.

2

Choose Copy from the Edit menu.

3

Click in the line of text below which you want to anchor the new table.

You can’t insert a table in a footnote.
4

Choose Paste from the Edit menu.

To move a table
You can move a table to a new location in the same document or in another
document.
1

Select the table you want to move.

2

Choose Cut from the Edit menu.

FrameMaker displays an alert that asks whether you want to leave the cells
empty or remove them from the table.
3

Click Remove Cells from Table and click Cut.

FrameMaker removes the entire table and places it on the FrameMaker
Clipboard.
4

Click in the line of text to which you want to anchor the table.

You can’t insert a table in a footnote.
5
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To rotate a table
You can include a table with a different orientation from the document’s. The
rotated table can be on a page by itself or in a page of unrotated text. For
example, you may want to include a landscape table in a portrait document.

Earthquake of 1906

Earthquake of 1906

Unrotated text
Rotated master page
Rotated table

13

By itself

■

Great Events

13

Great Events

With unrotated text

To create a rotated table on a page by itself, create a rotated master page and apply
it to the body page where the table appears.

For information on creating a rotated master page, see “To create a rotated
master page” on page 19-18. For information on applying a master page, see “To
assign a different master page to body pages” on page 19-7. If document editing
causes the table to move to a different page, you’ll need to reapply master
pages.
■

To insert a rotated table in a page of unrotated text, use a text frame in an anchored
frame.

First create an anchored frame and draw a text frame in it. Insert the table in
the text frame and then rotate the text frame counterclockwise. You may need
to adjust the size of the text frame or the anchored frame to view the entire
table. For information on drawing a text frame, see “To add a text frame” on
page 13-26.
If you want to edit the table, unrotate the text frame and then rotate it back
when you’re finished. For information on rotating a text frame, see “To rotate an
object” on page 14-14.
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To delete a table
You can delete a table from a document if you don’t need it any longer. When
you delete a table, it isn’t placed on the FrameMaker Clipboard for future
pasting as it is when you cut it (choose Cut from the Edit menu).
1

Select the table you want to delete.

2

Press Delete.

FrameMaker displays an alert that asks whether you want to leave the cells
empty or remove them from the table.
3

Click Remove Cells from Table and click Clear.

FrameMaker deletes the entire table.

FILLING IN TABLES
Each cell in a table has its own column of text. You can type text in cells, and
you can insert anchored frames for holding graphics or other tables. Special
variables let you specify continuation text in the titles or heading rows of
multipage tables. You can also copy, cut, and paste the contents of cells just as
you do text and graphics in any other part of a FrameMaker document.
As you type text or when you insert an anchored frame in a cell, FrameMaker
expands the cell’s height as needed.

To enter text in a table
In addition to being able to type normal text in a table, you can also insert
cross-references, footnotes, variables, and markers.
You format text in a table cell just as you format paragraphs in a regular
column of text. For example, you can apply paragraph or character formats to
table cell text. For more information on paragraph formatting in a table, see
“Default paragraph formats” and “Setting paragraph indents and tab stops,”
next.
■
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■

.....

TABLES

Filling in tables

To select the contents of an adjacent cell, use one of the following key combinations.
To select the contents of
Use
..........................................................................

■

Next cell

Tab

Previous cell

Shift-Tab

Cell below

Meta-n

Cell above

Meta-p

To insert a tab in a table cell, press Esc Tab.
DEFAULT PARAGRAPH FORMATS

Each new table has a default paragraph format for its title and for the heading,
footing, and body cells for each column. The default paragraph formats are
determined by the table format. You can assign a different format to any
paragraph in any cell, and you can modify the format of any paragraph.
For information on how FrameMaker determines the default paragraph
formats when you store a table format in the catalog, see “Table properties” on
page 7-4.
SETTING PARAGRAPH INDENTS AND TAB STOPS

The area in a cell that can be filled with text is like a single-column text frame
on a page. The cell margins are the space outside that area, like the margins of
a page. Paragraph indents and tab stops in a cell are relative to the edge of the
area, not to the edge of the cell. For information on setting cell margins, see
“Positioning and autonumbering text within cells” on page 7-31.
USING TABLE FOOTNOTES

When you insert footnotes in a table, the footnote text appears directly
underneath the table. For information on using table footnotes, see “To insert a
footnote” on page 11-4.
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To set up multipage tables
If a table spans more than one page and has a title, heading rows, or footing
rows, FrameMaker repeats the rows on each page of the table. You can edit the
contents of these rows on the first page only.
In a multipage table, you may want to display special text in the title or
heading rows—for example, the text (Continued). FrameMaker provides two
system variables to include special text: Table Continuation and Table Sheet.
Table Sheet variable

Table Continuation variable

Table Sheet variable

Northern Directory: Sheet 1 of 2
Last

First

Address Northern Directory
City(Continued):
State
SheetZIP
2 of 2

Armini

Kelly

Atkins

Neil

Chang

Joanne

Rollins

Len

340 Red St. Apt. 10-A
Saratoga
CA
98055
Last
First
Address
City
791 Haven St.
Redwood City
CA
94063
Dorrini
Sophia
via degli Arcadi 14
Roma
22 10th St.
Mt. View
CA
98500
Yu
Priscilla
5699 Fallen Leaf Terrace
Sacramento
4567 Tree View
Los Gatos
CA
95809

Country ZIP
Italia

I-55070

USA

95819

The Table Continuation variable displays continuation text, and the Table
Sheet variable displays page-count information.
1

On the first page of the table, click in the title or heading where you want to insert the
variable.

2

Choose Variable from the Special menu.

3

In the Variable dialog box, select one of the table variables.
System variable
Default definition
..........................................................................

Table Continuation

(Continued)

Table Sheet

(Sheet <$tblsheetnum> of <$tblsheetcount>)

The Table Continuation variable begins with a space. On the first page of a
table, this variable displays a nonbreaking space ( ). On subsequent pages, it
displays the text in its definition.
The Table Sheet variable displays the current and total number of pages that
the table spans. If the table doesn’t break across pages, it displays a
nonbreaking space. If the table spans more than one page, the variable displays
its full definition—for example, (Sheet 2 of 4).
4
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EDITING THE DEFAULT DEFINITIONS

You can change the default definitions of the table variables. For example, you
may want the Table Sheet variable to display Page 2 of 4 with no parentheses.
Or you may want to assign a different character format to a variable. For
information on editing variable definitions, see “To change the definition of a
system variable” on page 12-13.

To place a graphic in a cell
You draw or import graphics in anchored frames placed inside cells. The steps
shown here provide general instructions on how to insert a graphic that’s
centered in a cell. You can adapt the instructions to position the anchored frame
differently or to insert a graphic in a cell that also contains text.
1

Click in an empty paragraph in the cell where you want to place a graphic.

2

Use the Paragraph Designer to position the paragraph in the cell.

For example, in the Basic properties of the Paragraph Designer, specify the
alignment as Centered to center the paragraph horizontally. In the Table Cell
properties, specify the cell’s vertical alignment as Middle.
For information on using the Paragraph Designer to change a paragraph’s
properties and to create and modify paragraph formats, see Chapter 4,
“Formatting Text,” and Chapter 5, “Format Catalogs.”
3

In the Basic properties of the Paragraph Designer, turn off Fixed in the Line
Spacing area.

Doing this allows the size of the anchored frame you create to affect the
paragraph’s line spacing, which in turn affects the height of the cell.
4

Create an anchored frame, anchored at the insertion point.

Choose Anchored Frame from the Special menu and choose At Insertion Point
from the Anchoring Position pop-up menu. Then specify the size of the anchored
frame and click New Frame. For more information on creating anchored frames,
see Chapter 15, “Anchoring Graphics.”
5

If the anchored frame is wider than the cell, resize the column to accommodate
the frame.

For information on resizing columns, see “To resize a column with the mouse”
on page 6-19.
6

Place the graphic in the frame and resize the frame as appropriate.

7

Use the Align command on the Graphics menu to center the graphic in the frame.

In the Align dialog box, click T/B Centers and L/R Centers. For information on
using the Align command, see “To align objects” on page 14-10.
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To insert a table in a cell
Occasionally, you may need to insert a table in a cell.

Day

Itinerary

Monday

Visit the Metropolitan Museum.

Tuesday

Visit the Museum of Modern Art.
Tour Schedule
10 AM

All points of interest

12 noon Observation deck only
2 PM

All points of interest

Before you can insert a table in a cell, you need to create an anchored frame in
the cell and draw a text frame in the anchored frame. Then you can insert a
table in the text frame. After you insert the table, you can format it just as you
would any other table.
1

Click in the cell in which you want to insert a table.

2

Create an anchored frame anchored below the current line.

Choose Anchored Frame from the Special menu and choose Below Current Line
from the Anchoring Position pop-up menu. Next, choose centered alignment
and specify the size of the anchored frame. Try to set the width and height of
the frame to be slightly larger than the width and height of the table you want
to insert. You can always resize the frame later. Finally, click New Frame.
For more information on creating anchored frames, see Chapter 15, “Anchoring
Graphics.”
3

If the anchored frame is wider than the cell, resize the column to accommodate the
frame.

For information on resizing columns, see “To resize a column with the mouse”
on page 6-19.
4

Draw a text frame in the anchored frame.

Use the Text Frame tool on the Tools palette. For information on drawing a text
frame, see “To add a text frame” on page 13-26.
5

Click in the text frame and insert a table.

Adjust the table so it fits within the text frame, or adjust the anchored frame
and text frame to accommodate the table.
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To duplicate a cell’s contents
You can duplicate a cell’s contents in other cells in the same table or in a
different table. You can duplicate just the cell’s contents or both its contents and
format (such as the custom ruling and shading).

Selected cell

Day

Itinerary

Day

Itinerary

Monday

Visit the Metropolitan
Museum.

Monday

Visit the Metropolitan
Museum.

Tuesday

Visit the Museum of
Modern Art.

Tuesday

Visit the Museum of
Modern Art.

Day

Day

Cell’s contents duplicated
without its format

■

Cell’s contents and format
duplicated

To duplicate a cell’s contents without duplicating the cell’s format, select the contents
and copy and paste it to another cell.

Make sure the selection handle is not visible when you select the cell’s contents.
■

To duplicate both a cell’s contents and format, select the entire cell and copy and
paste it to another cell.

Select the entire cell by dragging across the border; the selection handle should
be visible when you select the cell. You can select multiple cells to copy. Pasting
a cell’s format automatically overwrites any contents of the cell in which you’re
pasting it.

To delete a cell’s contents
You can delete a cell’s contents without deleting the cell itself. This leaves an
empty cell that you can refill.
1

Select the cell that has the contents you want to delete.

You can select multiple cells.
2

Press Delete.

FrameMaker deletes the contents of the selected cells unless you selected an
entire row or column. In that case, FrameMaker displays an alert that asks
whether you want to leave the cells empty or remove them from the table.
3

If FrameMaker displays the alert, click Leave Cells Empty and click Clear.
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REARRANGING ROWS AND COLUMNS
As you work in a table, you may find that the rows or columns aren’t exactly as
you want them. For example, you may have too many rows or too few columns.
You can easily add and delete rows and columns. If you need to move a row or
column, you can simply cut and paste it to a new position. You can also split a
table into two tables or combine two tables into one.

To add an empty row or column
You can add a new empty row or column, and you can duplicate one or more
existing rows or columns. You can add heading, body, and footing rows.
When adding rows or columns to a table, you specify how many you want to add
and where you want to insert them. The cells in the new rows or columns get
their paragraph formats from the row or column containing the cell you
indicate. For example, you can click in a cell and add three rows. The cells in all
three rows will have the same paragraph formats as the cells in the row in
which you clicked.
1

Type the number of rows
you want to add here.
Type the number of columns
you want to add here.
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Click in a cell adjacent to where you want to add the rows or columns.

A

B

C

1

2

3

4

5

6

7

8

9

To add a
column here,
click in any
cell in column
B or C.

A

B

C

1

2

3

4

5

6

7

8

9

2

Choose Add Rows or Columns from the Table menu.

3

Specify the number of rows or columns you want to add.

Add Rows pop-up menu
Add Columns pop-up menu

4
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Choose where you want to insert the rows or columns from the Add Rows or the Add
Columns pop-up menu.

If you’re adding rows, you can insert them above or below the indicated cell or
in the heading or footing areas.
If you’re adding columns, you can insert them to the left or right of the
indicated cell.
5

Click Add.
ADDING A ROW QUICKLY

To quickly add a row below the current row, press Control-Return. FrameMaker
adds a row with the same format as the previous row.

To duplicate a row or column
You can duplicate rows and columns by copying the ones you want to duplicate
and pasting the copies in new positions. If you duplicate a row or column, its
contents are also copied.
1

Select the rows or columns you want to duplicate.

2

Choose Copy from the Edit menu.

FrameMaker puts the copied rows or columns on the FrameMaker Clipboard.
3

Click in a row or column next to where you want to insert the copied rows or columns.

4

Choose Paste from the Edit menu.

FrameMaker displays either the Paste Rows or Paste Columns dialog box.
5

Specify where you want to insert the rows or columns and click Paste.

If you’re pasting rows, you can insert them above or below the current row, or
you can replace the current row. If you’re pasting columns, you can insert them
to the left or right of the current column, or you can replace the current column.

To move a row or column
You can rearrange rows and columns by cutting the ones you want to move and
pasting them in new positions. If you move a row or column, its contents are
moved with it.
1

Select the rows or columns you want to move.

You have to select whole rows or whole columns.
2

Choose Cut from the Edit menu.
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3

In the Cut Table Cells dialog box, click Remove Cells from Table and click Cut.

FrameMaker puts the copied rows or columns on the FrameMaker Clipboard.
4

Click in a row or column adjacent to where you want to insert the cut rows or columns.

5

Choose Paste from the Edit menu.

FrameMaker displays either the Paste Rows or Paste Columns dialog box.
6

In the Paste Rows or Paste Columns dialog box, specify where you want to insert the
rows or columns and click Paste.

If you’re pasting rows, you can insert them above or below the current row, or
you can replace the current row. If you’re pasting columns, you can insert them
to the left or right of the current column, or you can replace the current column.
REPLACING ROWS OR COLUMNS

When you attempt to replace the current rows or columns with the cells on the
FrameMaker Clipboard, FrameMaker replaces them exactly only if the number
of rows or columns on the Clipboard is equal to the number of selected rows or
columns. If the number on the Clipboard is greater than the number you select
to replace, FrameMaker pastes as many rows or columns as will fit. If the
number on the Clipboard is less than the number you select to replace,
FrameMaker continues to paste until it fills the rows or columns you selected to
replace.

To delete a row or column
When you delete a row or column, FrameMaker displays an alert that asks
whether you want to delete just the contents of the selected cells or both the
contents and the cells.
1

Select the rows or columns you want to delete.

Make sure you select entire rows or columns. If you don’t, FrameMaker deletes
the contents of the selected cells without prompting you for a decision.
2

Press Delete.

FrameMaker displays an alert that asks whether you want to leave the cells
empty or remove them from the table.
3
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To split or combine tables
You can split a table into two smaller tables, and you can combine rows or
columns from two tables into one table. You split and combine tables by moving
rows or columns. For details on how to cut and paste rows and columns, see “To
move a row or column” on page 6-17.
■

To split a table, cut the rows or columns you want to make into a new table and paste
them in a text frame.

FrameMaker anchors the new table wherever you click. The new table’s format
matches the format of the table from which you cut the rows or columns.
■

To combine rows or columns from two tables, cut the rows or columns from one table
and paste them into another table.

If you cut and paste rows, the two tables must have the same number of
columns. If you cut and paste columns, the tables must have the same number
of rows.

RESIZING ROWS AND COLUMNS
AND ROTATING CELLS
As you work in a table, FrameMaker automatically adjusts the height of a row
based on the contents of the tallest cell. Beyond these automatic adjustments,
you can specify different sizes for rows and columns. For example, you can
increase or decrease the width of a column, increase or decrease the height of a
row, or make all rows and columns the same size. In addition to this basic cell
resizing, you can straddle cells with one larger cell, and you can rotate cells.

To resize a column with the mouse
The easiest way to change the width of a column is to select it and drag a
handle until the column is the right size.

You can drag a handle…

…to resize a column.

You can resize a column without affecting the width of any other columns.
Doing this increases or decreases the width of the entire table. Alternatively,
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you can move the border between two columns so one column grows wider, the
other narrower, and the entire table remains the same width.
There are additional, more precise ways to change the width of a column. For
details, see “To specify specific column width options” on page 6-20.
■

To change a column’s width without changing the width of any other columns in the
table, select a cell in the column and drag the selection handle.

As you drag, the column’s width appears in the status bar, and the table grows
to accommodate the new width.
■

To move the border between two columns, select a cell in the column to the left of the
border and Shift-drag.

The overall width of the table doesn’t change.
RESIZING MULTIPLE COLUMNS

To change the width of more than one column at a time, select cells in the
columns you want to change and drag a handle. FrameMaker resizes the
selected columns to fit the new width while keeping their proportions the same.
ALIGNING THE WIDTH WITH THE SNAP GRID

To align the column border with the snap grid, turn on Snap on the Graphics
menu before you change the width.

To specify specific column width options
You can resize columns in a number of specialized ways. For example, you can
make all columns in a table the same width, or you can scale all columns to fit
within a specific width.
1

Select cells in the columns you want to resize.

2

Choose Resize Columns from the Table menu.

3

In the Resize Selected Columns dialog box, specify how you want to resize the
columns and click Resize.

For information on the available options, see “Resize column options” on
page 6-21.
MAKING ALL COLUMNS THE SAME WIDTH

To make all columns in a table the same width, select the entire table before
choosing the Resize Columns command. In the Resize Columns dialog box, click
To Equal Widths Totalling and leave the value in the text box unchanged. (The
current value is the total width of the table.)
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MAKING A TABLE WIDER THAN A COLUMN

If you resize a table so that it extends into a second column, it will straddle the
columns of text. If the layout has side heads, such a table can extend into the
side-head area as well. For more information, see “Tables that straddle” on
page 6-5.

To duplicate a column’s width
You can copy and paste a column’s width in order to duplicate it in the same
table or in a different table.
1

Select one or more cells in the column that has the width you want to copy.

2

Choose Copy Special>Table Column Width from the Edit menu.

RESIZE COLUMN OPTIONS
The option you choose in the Resize Selected Columns dialog box depends on the column width you want to
achieve.
Width to achieve
Text box action
Explanation
...................................................................................................

A specific width

In the To Width text box, type the
width.

By default, the text box contains the
value of the leftmost selected
column.

A percentage of the original In the By Scaling text box, type the
widths
percentage.

100% leaves the columns unchanged;
50% halves the widths; and 200%
doubles the widths.

The same width as
another column in the
table

In the To Width of Column Number
text box, type the number of the
column that has the width you want
to copy.

Columns are numbered from left to
right. By default, FrameMaker
displays the number of the leftmost
selected column.

Equal widths within a
specified total width

In the To Equal Widths Totalling text By default, FrameMaker displays
box, type the width to be divided
the total width of the selected
equally among the selected columns. columns.

The width you specify
while still keeping the
column proportions the
same

In the By Scaling to Widths Totalling By default, FrameMaker displays
text box, type the total width.
the width of the text column
containing the column.

The width of the widest
In the Maximum Width text box, type
paragraph (as if there were the maximum width for columns.
no line wrapping) or frame
in the selected cells

Use this setting to eliminate line
wrapping in a column or to make the
columns just wide enough to contain
the headings.
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3

Select one or more cells in the column that has the width you want to change and
choose Paste from the Edit menu.

To increase the height of a row
FrameMaker automatically adjusts the height of a row based on the cell’s
contents. You can further increase the height of a row—for example, to create
extra white space above and below vertically centered text. You can also make
all rows in a table the same height.
1

Click in the row that has the height you want to increase.

2

Choose Row Format from the Table menu.

3

In the Row Format dialog box, type the row height in the Minimum text box and
click Set.
MAKING ALL ROWS THE SAME HEIGHT

You can make all rows the same height by determining the height of the
tallest row in a table and then specifying its height as the minimum height for
all rows.
To determine the height of the tallest row, hold Control-Shift while drawing a
selection border around the row. FrameMaker displays the height in the status
bar. Then select the entire table and specify this value for the minimum height
in the Row Format dialog box.

To straddle cells
You can combine cells horizontally into a single cell that straddles several
columns, or you can combine cells vertically into a single cell that straddles
several rows. In a straddle cell, text and graphics flow across cell borders as if
there were a single cell.
This cell straddles six
columns.
This cell straddles two rows.
Calcium
Iron

Composition
of Brown
Rice
32.0 mg
1.6 mg

Composition of Other Rice
Enriched
White Rice
White Rice
24.0 mg
75%
24.0 mg
75%
0.8 mg
50%
2.9 mg
180%

Enriched
Converted Rice
50.0 mg
190%
2.9 mg
180%

If you straddle cells that have contents, FrameMaker merges the contents,
creating separate paragraphs for each of the merged cells. You can also
unstraddle cells.
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Select the cells you want to straddle.

You can straddle only cells that are in the same type of row—heading, body, or
footing.
2

Choose Straddle from the Table menu.
UNSTRADDLING CELLS

To replace a straddle cell with the original cells, select it and choose Unstraddle
from the Table menu. FrameMaker puts the contents of the straddle cell in the
upper-left new cell, not back in the original cells. You can replace several
straddle cells at a time.

To rotate a cell
Although you can rotate any cell in a table, heading cells are the ones most
commonly rotated.

HOUSING

CRIME

EDUCATION

THE ARTS

RECREATION

Ranking Metropolitan Areas

190

141

298

50

51

Greenville

129

175

261

302

304

Hurrytown

171

54

17

64

175

Rotated cells
METRO AREA
Stressburg

You can type in a rotated cell just as you do in any other cell. As you type in a
rotated cell, the cell height increases and the text doesn’t wrap. You can limit
the height of rotated cells so that text will wrap when it reaches the limit.
1

Select the cells you want to rotate.

2

Choose Rotate from the Graphics menu.

3

In the Rotate Table Cells dialog box, click the orientation to which you want to rotate
the cells and click Rotate.
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LIMITING THE HEIGHT OF A ROTATED CELL

If a rotated cell becomes too tall, you can set the maximum height for the row
rather than force a line break. FrameMaker wraps text to the next line when it
reaches the limit. For details on specifying row height, see “To increase the
height of a row” on page 6-22.

CONVERTING TEXT TO A TABLE
You can convert paragraphs of text—including text you import from another
application—to a table. For example, you may have created a table by using
tabbed text and you now want to convert it to a true table.
Day
These tabbed paragraphs…

…have been converted to
a table.

Itinerary

Monday

Visit the Metropolitan Museum.

Tuesday

Visit the Museum of Modern Art.
Day

Itinerary

Monday

Visit the Metropolitan Museum.

Tuesday

Visit the Museum of Modern Art.

Conversely, you may find that information you thought would work best in a
table actually works better as regular text. In such a case, you can convert the
table to regular text.
After converting text to a table, examine it to make sure everything is where it
should be. A misplaced tab or extra return in the text can result in an
inaccurate table.
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To convert existing text to a table
When converting text to a table, you specify whether FrameMaker should
turn each paragraph into a row or into an individual cell. If you turn
paragraphs into rows, the paragraphs must contain some sort of character that
indicates where FrameMaker should separate them into cells. A commonly
used character is a tab.
FrameMaker bases the widths of columns in the new table on the table format
you specify. You can change the column widths, as well as any other table
formatting, after FrameMaker creates the table.
1

Select the text you want to convert.

2

Choose Convert to Table from the Table menu.

3

Select a format for the table.

Select a table format.
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4

Specify how you want to convert paragraphs.
To convert this type of text
Do this
..........................................................................

5

Paragraphs with tab characters
separating information you
want placed in separate cells

Click Tabs.

Paragraphs with spaces
separating information you
want placed in separate cells

Click Spaces. Then type the number of
spaces below which FrameMaker should
not create a separate cell.

Paragraphs with other
characters separating
information you want placed in
separate cells

Click Other. Then type a list of
characters, any one of which
FrameMaker can use to separate
information into cells.

Paragraphs (such as those in a
bulleted list) that you want
placed in separate cells

Click A Cell. Then type the number of
columns you want in the table.

In the Heading Rows text box, type the number of paragraphs in the selection that are
headings.

If the paragraphs you’re converting don’t include a heading, turn on Leave
Heading Rows Empty. You can fill in the headings after converting the text.
6

Click Convert.

The table is anchored to the end of the paragraph immediately preceding the
selected text.

To convert an imported file to a table
You can import a text file and then convert it to a FrameMaker table. To do this
you need to convert the entire file, not just a portion. For example, you can
import a tabular text file you saved from a spreadsheet and then convert it to a
table.
1

Click in the line of text below which you want to insert the table.

You can’t import a table into a footnote or into another table.
2

Import the file.

The file you import from must be a text file, not another FrameMaker file. You
can import by reference or by copy. For information, see “Editing tables
imported by reference,” next. For information on importing files in general, see
“Importing text” on page 3-12.
3

In the Import Text File dialog box, click Convert to Table and click Import.

FrameMaker displays the Convert to Table dialog box.
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Select a format for the table and specify how you want to convert paragraphs.

For information on the settings in the Convert to Table dialog box, see “To
convert existing text to a table” starting on page 6-25.
5

Click Convert.
EDITING TABLES IMPORTED BY REFERENCE

When you import a text file by reference and convert it to a table, the resulting
table is a text inset. This means you can’t edit the contents of the table from
within FrameMaker, and you can’t format the text beyond the formatting
defined for the table format you used. You can, however, edit the original text
file and then update the table in FrameMaker by selecting the table, choosing
Text Inset Properties from the Edit menu, and then clicking Update Now.
You can also update the table along with other text insets by choosing Update
References from the Edit menu.
MERGING A TEXT FILE INTO AN EXISTING TABLE

If you have a text file that you want to merge into an existing table, first import
the text file (by copying) and then convert it to its own table. Finally, merge this
table into an existing table. For information on merging tables, see “To split or
combine tables” on page 6-19.

To edit a table after conversion
After converting text to a table, you might have to edit the table. If you
imported the text by reference, you edit the text in the original text file and
update the text inset. For details, see “Editing tables imported by reference” on
page 6-27.
If you imported the text by copying, you can edit the table after conversion. For
example, when you convert tabular text that contains forced returns,
FrameMaker treats each return as the end of a paragraph. This causes text
that should be together in one cell to be split into two or more cells.
The tabbed text contains forced returns.

Type of Fund

Risk Level

After conversion, text that should be together appears in
separate cells.

Average Rate of Return¶

Type of Fund§
Appreciation from
Very high
stocks of new companies§

15.5%

Tax-free yields from
municipal bonds§

11.6%

Low

Risk Level§

Average Rate of
Return§

Appreciation from§

Very high§

15.5%§

stocks of new companies§

§

§

Tax-free yields from§

Low§

11.6%§

municipal bonds§

§

§
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In addition, because FrameMaker adds a column for each tab, extra columns
can occur if the converted text had extra tabs.
■

To combine text that is split across two or more cells, cut and paste the text from the
lower cells into the upper cell and delete the extra rows.

As a shortcut, you can choose Straddle from the Table menu and then choose
Unstraddle. This leaves empty cells that you can then delete.
■

To delete extra columns, cut and paste the cells into the correct locations and delete
the extra columns.

To convert a table to text
You may want to convert a table to text—for example, if you need to copy a
FrameMaker table into an application that doesn’t recognize tables. When you
convert a table to text, FrameMaker turns each cell into a separate paragraph.

You can convert a table to
text row by row…

…or column by column.

1

Click in the table you want to convert to text.

2

Choose Convert to Paragraphs from the Table menu.

3

In the Convert to Paragraphs dialog box, click Row by Row or Column by Column and
click Convert.
CONVERTING A TABULAR TEXT INSET TO TEXT

To convert a table whose text has been imported by reference to editable
paragraphs, you break the link to the text file it came from. To do this, select
the inset, choose Text Inset Properties from the Edit menu, and then click
Convert to Text.
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Creating and storing table formats is similar to creating and storing
paragraph formats. You can store a table’s format in a catalog. You can
apply a different format to an existing table, and FrameMaker will
update the table’s format to match the catalog format.

Table formats define the appearance of tables
When you insert a new table, you choose a format in the Table Catalog.
The catalog format determines the defaults of the table—the number of
heading, footing, and body rows; the number and width of columns; and
the paragraph formats for heading rows, footing rows, body cells, and
the title, if there is one.
In addition, the catalog format determines the position of the table and
of its title, cell margins, ruling, shading, and other properties.

You create formats with the Table Designer
You can examine and change most of a table format’s properties by
using the Table Designer, a window like the Paragraph Designer and
Character Designer.
You use the Table Designer
to change the table’s
position and cell margins,
ruling, and shading.

Table 2-1: Northern Area Directory
Last

First

Address

City

State

ZIP

Armini

Kelly

340 Red St. Apt. 10-A

Saratoga

CA

98055

Atkins

Brian

340 Haven St.

Redwood City

CA

94063

Chang

Joanne

22 10th St.

Mt. View

CA

98500

Rollins

Len

4567 Tree View

Los Gatos

CA

95809

The Table Designer also gives you access to the Table Catalog. Catalog
formats store the properties you set with the Table Designer. They also
store default properties, such as the number of rows and the width of
columns, that you set in other ways.
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Custom settings apply special effects
All properties of a table format are general ones. For example, a table
format can establish a shading percentage for columns or rows but not
for specific cells. If you want to shade a specific cell for a special effect,
you can use a custom setting. You can also customize ruling, cell
margins and vertical alignment, page breaks, and row formatting.

Phone List
Last Name

First Name

Phone List
Dept. Num.

Extension

Arthur

Lee

123

4434

Arthur

Lee

123

4434

Bates

Susan

234

4312

Bates

Susan

234

4312

Brown

Bob

345

4456

Brown

Bob

345

4456

Davis

William

567

4598

Davis

William

567

4598

Before customizing

Last Name

First Name

Dept. Num.

Extension

Ruling and shading have been customized.

If you update the format of a table that has custom settings, or if you
apply a new catalog format, the custom settings are retained.

Catalog changes affect properties set in the Table Designer
When you apply a different catalog format to an existing table, the
catalog format’s Table Designer settings apply to the table, removing
any format overrides. The table retains its number of rows, width of
columns, and other format properties not set in the Table Designer,
along with any custom settings.
When you modify the properties of a table and then update the
corresponding catalog format, you choose whether to retain Table
Designer overrides in other tables with the same tag. Only the catalog
format reflects changes to properties not set in the Table Designer.

In this chapter
This chapter shows you how to use the Table Designer to apply, create,
and modify table formats. It also shows you how to customize tables.
Chapter 6, “Tables,” shows you how to set other table properties and to
create custom straddle cells and rotated cells.
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WORKING WITH TABLE FORMATS
Table catalog formats determine the position and initial appearance of tables
you insert. When you create a new format, you can add it to the catalog. For
information on how the Table Catalog stores formats, see “Table properties” on
page 7-4.
You can change the position or appearance of an existing table by applying a
different format or by changing the definition of its current format. You can
change the format of an individual table and apply the changes to that table
only or to the corresponding catalog format and all existing tables with the
same tag. Occasionally, you may need to make the same change to all tables in a
document. For example, you may want to make all tables left aligned instead of
centered.

TABLE PROPERTIES
The Table Designer sets
three groups of table format properties—Basic,
Ruling, and Shading.

Three types of settings affect the appearance of a
table—format properties set in the Table Designer,
default format properties not set in the Table
Designer, and custom settings. The Table Designer
properties and the default properties are stored in
the Table Catalog; however, only those properties
set in the Table Designer are updated when you
apply a new or modified table format to an existing
table.

Table Designer properties

The following table spells out the types of
properties stored in the Table Catalog and the
types that are updated when you apply a different
format to an existing table. More information on
the types of properties follows the table.

• Paragraph format of the first paragraph in the
title (if there is one)

The defaults of table format
properties not set in the Table Designer are stored
in the Table Catalog.
Default properties

• Number of heading, footing, and body rows
• Number and widths of columns

• Paragraph format of the topmost paragraph in
the heading, body, and footing cell of each column
Several custom settings affect the
appearance of individual tables.

Custom settings
Table properties
Stored?
Updated?
................................................

Format properties set in
the Table Designer

Yes

Yes

Default properties not set
in the Table Designer

Yes

No

Custom settings

No

No
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You can also change the formats of tables in a text inset (text imported by
reference) as long as it doesn’t use formats from the source document. For
details, see “Formatting an imported text flow” on page 3-16.

To use the Table Designer
You use the Table Designer to create and change table formats just as you use
the Paragraph Designer to create and change paragraph formats.
You can choose a format
tag from the Table Tag
pop-up menu.

You can choose a group of
properties from the
Properties pop-up menu.

You can change
properties here.

In the left side of the Table Designer, you choose a table format and property
group and specify how you want to apply properties. In the right side of the
Table Designer, you change the table’s properties. As you change properties in
the Table Designer, the table’s appearance doesn’t change until you apply or
update the properties.
■

To display the Table Designer, choose Table Designer from the Table menu.

■

To display a different property group, choose the group from the Properties
pop-up menu.

You can choose from Basic, Ruling, and Shading properties. Apply changes or
update the catalog before choosing a different property group. If you don’t,
FrameMaker will prompt you to do so.
■

To apply property changes, click Apply To Selection or Update All.

If you click Apply To Selection, FrameMaker applies all properties in all groups
to the current table without updating the Table Catalog format. Doing this
creates a format override for that table.
If you click Update All, FrameMaker updates the corresponding catalog format
and all tables in the document with the same tag. Properties set in the Table
Designer, as well as default properties not set in the Table Designer are
Using FrameMaker
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updated. If FrameMaker detects format overrides in any of the tables being
updated, it will ask whether you want to remove the overrides.
■

To reset properties after making some changes in the Table Designer, choose Reset
Window from Selection from the Commands pop-up menu.

This changes the properties to match the current table. You can reset the
properties only if you haven’t yet applied the changes or updated the catalog
format.
TABLE FORMAT OVERRIDES

For general information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13, which describes overrides to paragraph and character
formats (the same principles apply to table format overrides). With tables, only
those properties set in the Table Designer can be overridden. Custom settings
and changes to default properties are not considered format overrides.

To display a catalog format’s properties
When you click in a table, its properties are displayed in the Table Designer.
Those properties may not match the properties of the catalog format with the
same tag, depending on whether the table contains any format overrides.
■

To display a catalog format’s properties in the Table Designer, choose the format from
the Table Tag pop-up menu even if its tag is already displayed in the Table Tag
text box.

To apply a different format to a n existing table
You choose a format from the Table Catalog when you insert a new table. You
can apply a different format at any time.
When you apply a different format to an existing table, FrameMaker changes
only those properties set with the Table Designer. It won’t change the default
properties not set in the Table Designer or the custom settings.

(Cell Body)

(Cell Body)

(Cell Body)

Table 1:

When a format from the Table
Catalog is applied to…
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W INTE R

0.00

325.15

0.00

SPRIN G

0.00

0.00

561.64

…an existing table with different default
properties and custom settings…

Corn

Fruit
Apples

(Cell Body)

(Cell Body)

Oranges

(Cell Heading)

(Cell Body)

Grain

Fruit
Apples

(Cell Heading)

Corn

Grain

Oranges

Table 1: Harvest by Seasons

W IN T ER

0.00

325.15

0.00

SPR IN G

0.00

0.00

561.64

Table 1: Harvest by Seasons

…the default and custom properties are
retained.
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For information on Table Designer, default, and custom properties, see “Table
properties” on page 7-4.
1

Click in the table to which you want to apply a new format.

2

In the Table Designer, choose the format you want to apply from the Table Tag
pop-up menu.

The menu contains the formats in the Table Catalog.
3

Click Apply To Selection.

To apply a format to tables with certain tags
You can apply a format to multiple tables in a variety of ways. You can apply a
format to all tables in the document; to all whose tags occur in a selection; or to
all that have a particular tag. For example, you could apply Format B to all
tables currently tagged Format A.
When you apply a different format to a table, FrameMaker overwrites only
those properties set with the Table Designer. It won’t overwrite the default
properties not set in the Table Designer or the custom settings.
1

Click in a table or select consecutive tables.

If you want to apply a format to one or all tables in the document, click in any
table.
If you want to apply a format to more than one, but not all, tables in the
document, select consecutive tables. Select the tables you want to retag. (To
select multiple tables, you must select their anchor symbols.) In the Table
Designer, conflicting properties, including the tag, are set to As Is. For more
information on the As Is setting, see “Understanding the As Is setting” on
page 5-18.
2

In the Table Designer, choose the format you want to apply from the Table Tag
pop-up menu.

The menu contains the formats in the Table Catalog.

Using FrameMaker
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When you choose a format, the Table Designer displays the properties of the
format you choose, including the tag.

This is the format you want to
apply.

Table Tag pop-up menu

3

Choose Global Update Options from the Commands pop-up menu.

4

Choose the tables you want to retag.

Click here to retag all tables
in the document.

Click here to retag the
tables in the selection and
all tables with the same tags
as these tables.

Choose a tag from the
pop-up menu to retag all
tables currently assigned
the tag you choose.

5

Click All Properties in the Use Properties area and click Update.

CREATING AND UPDATING TABLE FORMATS
Each FrameMaker template and blank paper template already has a Table
Catalog set up with predefined formats. If the existing table formats aren’t
appropriate for your needs, you can modify their properties or use them as the
foundation for creating new formats. You create a new table format by changing
the properties of an existing table and adding the format to the Table Catalog
with a different tag.
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When you update a table format, you can choose to update all properties, one
group of properties, or several properties within a group. You can also choose
which formats you want to update.
As you add more formats to the Table Catalog, you’ll need to maintain the
catalog. For example, you can rename a format if you’re using it for a different
type of table than originally planned, or you can delete a format that you no
longer need.

To create a table format
If no existing table formats are appropriate for your table, you can create a new
format. After you modify the properties of an existing table, you store the
format in the Table Catalog with a different tag.
This procedure shows the general steps for adding a new format to the Table
Catalog. Instructions for changing specific table properties are described in
other sections of this chapter and in Chapter 6, “Tables.”
1

Click in a table that has a format similar to the one you want to create.

Actually, you can click in any table. However, the more similar the format is to
the format you’re defining, the fewer changes you’ll have to make.
2

Set up the rows and columns.

If necessary, add or delete body, heading, and footing rows and adjust the
number of columns and their widths. For instructions, see Chapter 6, “Tables.”

TIPS ON NAMING FORMATS
You’ll find it easier to use and maintain the Table
Catalog if you follow these guidelines for naming
formats. For examples of various formats and how
they look when applied to tables, look at the
catalogs in the FrameMaker templates and sample
files.
Standardized tags By standardizing tags, you can
copy formats between documents. For example, if
you use PriceList for a tag in one document, use
the same tag for similar tables in other documents.

Tags that indicate function Give each format a tag
that’s easy for you and others to remember,
recognize, and type. A tag should indicate the use,
and not the appearance, of the table.

For example, you could use the tag PartsList for a
table that contains a list of parts in two columns.
Such a name is more flexible than one named
2ColumnTable; if you change the table to include a
third column, you won’t have to change the tag.
Tags are case-sensitive:
PartsList is not the same as partslist.

Consistent capitalization

Using FrameMaker
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3

Use the Table Designer to modify other table properties.

Table Designer modifications are described in other sections of this chapter. You
can change the Basic, Ruling, or Shading properties. As you change properties
in the Table Designer, the table’s appearance doesn’t change until you apply the
properties.
After you make changes, click Apply To Selection.
4

Use the Paragraph Designer to create paragraph formats for the text within the table.

You may want to define paragraph formats for the following parts of the table:
the title, heading cells, body cells, and footing cells. For information on creating
paragraph formats, see Chapter 5, “Format Catalogs.”
5

When the table looks the way you want, choose New Format from the Commands
pop-up menu in the Table Designer.

6

Type a name for the new format in the Tag text box.

Type the tag name here.

For suggestions on naming table formats, see “Tips on naming formats” on
page 7-9.
7

To indicate that the format should be stored in the Table Catalog, turn on Store in
Catalog.

Normally, you’ll want to store a newly created format in the Table Catalog. If
you don’t want the format overwritten or copied to another document by the
Import>Formats command, don’t store the format in the catalog.
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8

To apply the new format to the current table, turn on Apply to Selection.

9

Click Create.
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USING ANOTHER DOCUMENT’S TABLE CATALOG

If you’re using a particular document as a template for other documents, you
can copy the Table Catalog from the template to a new document. You do this by
using the Import>Formats command. For information on importing formats,
see “Importing formats into a document” on page 21-12.

To update a table format
After changing a table’s properties, you can update the corresponding catalog
format to match the table. The properties applied to the catalog format include
those set in the Table Designer and the defaults not set in the Table Designer—
for example, the default paragraph formats. In addition, properties set in the
Table Designer are applied to existing tables in the document with the same
tag. Default properties that aren’t changed in the Table Designer are not
applied to existing tables.
1

Click in a table that has the format you want to update.

The table’s format may not match the catalog format with the same tag
depending on whether the table contains any format overrides. If you want to
start out with the catalog format’s properties (without any overrides), choose
the format tag from the Table Tag pop-up menu in the Table Designer, even if
the tag you want is already displayed in the Table Tag text box.
2

Change the table’s properties.

You can use the Table Designer to change the Basic, Ruling, or Shading
properties. You can also change default properties. For details on changing
default properties, see the methods described in this chapter and in Chapter 6,
“Tables.” For a list of default properties you can change, see “Table properties”
on page 7-4.
3

Click Update All.

If FrameMaker detects format overrides in any of the tables being updated, it
displays an alert that asks whether you want to retain or remove them. For
general information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13, which describes overrides to paragraph and character
formats (the same principles apply to table format overrides).
TABLES IN TEXT INSETS

If a table is in a text inset (text imported by reference) that uses the source
document’s formats, you must update the table’s format in the source
document. For details, see “Formatting an imported text flow” on page 3-16.
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To update other table formats with a property group
You can use a group of properties from one table format to update other
formats. For example, if you want to change the default ruling properties of all
tables in a document, you can change them for one format and apply the
changes to the remaining formats in the catalog without changing any other
properties.
These instructions apply to whole groups of properties. For instructions on
changing one or two properties in a group, see “To update other table formats
with one or two properties” on page 7-14.
1

Click in a table or select consecutive tables.

If you want to update one or all table formats in the document with a property
group from a table, click in that table. The Table Designer displays the
properties of the table, including its tag.
If you want to update more than one, but not all, of the table formats, select
consecutive tables. Select the tables that have the formats you want to update.
(To select multiple tables, you must select their anchor symbols.) In the Table
Designer, conflicting properties, including the tag, are set to As Is. For more
information on the As Is setting, see “Understanding the As Is setting” on
page 5-18.
2

From the Properties pop-up menu, choose the property group you want to update.

3

In the Table Designer, delete the tag from the Table Tag text box if the text box isn’t
empty.

Deleting the tag from the text box keeps FrameMaker from changing the tags of
the formats you update.

7-12

Using FrameMaker

4

Change the properties as necessary.

5

Choose Global Update Options from the Commands pop-up menu.

6
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Choose the table formats to which you want FrameMaker to apply the properties.

Current property group
Click here to apply the
properties to all table
formats in the document.

Click here to apply the
properties to all tables and
all catalog formats whose
tags occur in the selection.

Choose a tag from the pop-up
menu to apply the properties
to the tables and to the
catalog format with that tag.

7

Click the current property group in the Use Properties area and click Update.

FrameMaker applies the properties to the Table Catalog formats you specified
and to all existing tables in the document with the same tags.
If FrameMaker detects format overrides in any of the tables being updated, it
displays an alert that asks whether you want to retain or remove them. For
general information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13, which describes overrides to paragraph and character
formats (the same principles apply to table format overrides).
DISPLAYING ANOTHER FORMAT’S PROPERTIES

After deleting the tag from the Table Tag text box, you can display the
properties of any catalog format without displaying the format’s tag. To do this,
hold down the Shift key when you choose the format from the Table Tag pop-up
menu. You can then update a different catalog format with those properties.
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To update other table formats with one or two properties
You can update one or two properties of one or more table formats without
changing any other properties. For example, you can change some or all table
formats from centered to left aligned. Rather than update each format
separately, you can update them all at once.
1

Click in a table or select consecutive tables.

If you want to update one or all table formats in the document, click in any
table.
If you want to update more than one, but not all, of the table formats, select
consecutive tables. Select the tables that have the formats you want to update.
(To select multiple tables, you must select their anchor symbols.) In the Table
Designer, conflicting properties, including the tag, are set to As Is. For more
information on the As Is setting, see “Understanding the As Is setting” on
page 5-18.
2

In the Table Designer, display the group of properties from which you want to select
one or two properties to apply.

3

From the Commands pop-up menu, choose Set Window to As Is.

Settings in all property groups in the Table Designer change to indicate that
their status is As Is. FrameMaker won’t change properties set to As Is when it
updates the other formats. For example, the Table Tag text box is blank so that
updating other formats won’t change their tags.

The Table Tag text box is
blank.

As Is appears in
pop-up menus.

Other text boxes become
blank to indicate As Is.

For more information on setting properties to As Is, see “Understanding the As
Is setting” on page 5-18.
4
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5

Choose Global Update Options from the Commands pop-up menu.

6

Choose the table formats to which you want FrameMaker to apply the properties.

Current property group
Click here to apply the
properties to all table
formats in the document.

Click here to apply the
properties to the tables in
the selection and all tables
with the same tags.

Choose a tag from the
pop-up menu to apply the
properties to the catalog
format with that tag.

7

Click the current property group in the Use Properties area.

8

Click Update.

FrameMaker applies the properties to the Table Catalog formats you specified
and to all tables in the document with the same tags.
If FrameMaker detects format overrides in any of the tables being updated, it
displays an alert that asks whether you want to retain or remove them. For
general information on format overrides, see “Overriding a catalog format’s
properties” on page 5-13, which describes overrides to paragraph and character
formats (the same principles apply to table format overrides).

To rename a catalog format
You may need to rename a table format if, for example, your naming
conventions change, or if you want to copy an entire catalog from a template
and don’t want a particular format to be overwritten.
1

Click in a table that has the format you want to rename.

2

In the Table Designer, choose the tag you want to change from the Table Tag
pop-up menu.

Make sure you perform this step even though it means choosing the same tag as
the one currently displayed. Choosing a tag from the pop-up menu ensures that
the properties of the catalog format are displayed.
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3

Type a new name in the Table Tag text box and click Update All.

Because the tag in the Table Tag text box differs from the tag under the Update
All button, FrameMaker asks whether you want to rename the format.
4

Click OK to rename the format.

To delete a format from the Table Catalog
You may need to delete a table format if, for example, you copied a Table
Catalog from a template and an old format is no longer necessary. Deleting a
format from the catalog does not affect any tables that have the same tag—the
tables simply have a tag that isn’t in the catalog.
1

In the Table Designer, choose Delete Format from the Commands pop-up menu.

2

In the Delete Formats from Catalog dialog box, select the format in the scroll list and
click Delete.

You can delete additional formats if you want to.
3

Click Done when you’ve finished deleting formats.

The formats are not actually deleted from the catalog until you click Done.

ADDING AND REMOVING TABLE TITLES
A table title appears in its own text frame above or below a table and is
repeated on all pages of a multipage table. You can format a table title just as
you would any other paragraph in a document. For example, you can center the
title, set its default font, and include an autonumber format.

Table 2: Harvest by Seasons

Corn

Apples

Oranges

Winter

0.00

325.15

0.00

Corn

Apples

Spring

0.00

0.00

561.64

Winter

0.00

325.15

0.00

560.85

0.00

0.00

Spring

0.00

0.00

561.64

0.00

0.00

0.00

Summer

Summer
Fall

Harvest by Seasons
Centered title below the table

Fall

Oranges

560.85

0.00

0.00

0.00

0.00

0.00

Left-aligned, autonumbered
title above the table

You use the Table Designer to add a title to a table. When you add a table
format to the Table Catalog, FrameMaker stores the title properties set in the
Table Designer as part of the catalog format. It also stores the title’s paragraph
format. If you apply this catalog format to an existing table, only the Table
Designer properties, not the existing title’s paragraph format, are changed.
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To set up a table title
When you set up a title for a table, you specify whether you want to display the
title above or below the table and how big a gap you want between the title and
the table. FrameMaker adds an empty text frame for the title, and you fill in
the text.
1

Click in the table to which you want to add a title.

2

In the Basic properties of the Table Designer, choose Above Table or Below Table from
the Title Position pop-up menu.

Title Position pop-up menu

3

In the Gap text box, specify the amount of space between the table and the title.

4

Apply the changes.

For information on applying properties, see “To use the Table Designer” on
page 7-5.
DISPLAYING A TITLE ON THE FIRST PAGE ONLY

You can have a title displayed only on the first page of a multipage table by
setting up a body text paragraph as the title and then inserting an untitled
table below the paragraph. In the paragraph’s format, make sure you turn on
the Keep With Next setting in the Pagination properties of the Paragraph
Designer. Doing this prevents the title from becoming separated from the table.
USING TABLE VARIABLES IN TITLES

In a multipage table, you can use two system variables to include special text
on subsequent pages—for example, the text (Continued). The Table
Continuation variable displays continuation text, and the Table Sheet variable
displays page-count information. For information on using the special table
variables, see “To set up multipage tables” on page 6-12.

To remove a table title
You remove a title from a table by changing the table format.
1

Click in the table that has the title you want to remove.

2

In the Basic properties of the Table Designer, choose No Title from the Title Position
pop-up menu.
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3

Apply the changes.

For information on applying properties, see “To use the Table Designer” on
page 7-5.

USING RULING AND SHADING
You can create tables that are visually appealing and easy to read by using
ruling and shading. For example, you can use ruling around the outside edges of
a table and shading only in the heading cells. Or you may want to use ruling to
separate all cells in a table and use shading for every other body row.
Table 3: Harvest by Seasons

Grain

All cells are ruled.

Apples

Winter

0.00

325.15

0.00

Spring

0.00

0.00

561.64

560.85

0.00

0.00

0.00

0.00

0.00

Summer

Every other row is shaded.

Fruit

Corn

Fall

Oranges

When formatting a table, you can create the regular ruling and regular shading
for the table. The regular ruling and shading affect entire rows and columns
and they are part of the format that is stored in the Table Catalog.
You can also set up custom ruling and shading for a table. Custom ruling and
shading aren’t limited to entire rows or columns and aren’t stored as part of the
Table Catalog format. If you customize the ruling or shading of a table and later
apply a different format to the table, the customized ruling or shading is not
overwritten by the new format.
Each document contains predefined ruling styles that you can use in tables.
FrameMaker provides six ruling styles, ranging from very thin to thick
and including a double ruling. You can edit these ruling styles or create
additional ones.

To set up regular ruling
You can specify ruling for columns, body rows, heading and footing rows, and
outside edges of a table. For example, you can use thick ruling beneath the
heading row and thin ruling between every other body row.
For examples of the ruling patterns you can create for rows and columns, see
“Regular ruling” on page 7-19.
1
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Click in the table in which you want to specify regular ruling.

2

Choose the column for
which you want to specify a
special ruling style for its
right edge.
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In the Ruling properties of the Table Designer, set up the column ruling styles.

Choose a style for the
special column ruling.

Choose a style for the right
edges of the remaining
columns.

If you want to use the same style for all ruling between columns, choose it from
both pop-up menus. If you don’t want to have ruling between columns, choose
None. The same applies for setting up body row ruling styles in the next step.

REGULAR RULING
You can set up the regular ruling for columns, body
rows, heading and footing rows, and the outside
edges of a table.
Columns You can choose a ruling style for the
right edge of a specific column and a different style
for the right edges of all other columns.

You can choose a ruling style to use
periodically between body rows and a different
style for the remaining rows.

Heading and footing rows You can choose a ruling
style to separate heading and footing rows from
body rows and a different style to appear between
heading and footing rows (if there’s more than one
of each).

Body rows

Outside edges You can choose a ruling style for
the outside edges of a table.

You can specify that the bottom ruling should
appear only on the last page of a multipage table.
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3

Set up the body row ruling styles.

Choose an interval for a
special ruling below rows.
Choose a style for the
special row ruling.

4

Choose a style for the
bottom edges of remaining
rows.

Set up the heading and footing row ruling styles.

Choose a style for the ruling
separating heading and
footing rows from body
rows.

Choose a style for the ruling
between heading and
footing rows when there is
more than one of each.

If you don’t want to have ruling between heading and footing rows, choose
None. The same applies for setting up the outside-edge ruling styles in the next
step.
5

Set up the outside-edge ruling styles.

Turn on if you want to
display the bottom ruling
only on the last page of a
multipage table.

Choose styles for the ruling
around the outside edges of
the table.

6

Apply the changes.

For information on applying properties, see “To use the Table Designer” on
page 7-5.
CUSTOM RULING

If you change the regular ruling of a table containing custom ruling, the custom
ruling is retained. Wherever the two settings are in conflict, the custom settings
prevail. Custom ruling can be changed only with the Custom Ruling and
Shading dialog box. For information on custom ruling, see “To customize
ruling,” next, and “To remove custom ruling or shading” on page 7-28.
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To customize ruling
You can customize the ruling for individual cells, rows, or columns to draw
attention to specific areas of a table.

January
Sunday

Monday

Tuesday

1

Wednesday

Thursday

2

Friday

Saturday

3

4

5

Staff
Meeting

6

7

8

9

10

11

12

14

15

16

17

18

19

FIRST
DRAFT
DUE

Custom cell ruling
13

A table’s custom ruling is not stored as part of the format when you use the
table to create a new catalog format. When you apply a different format to a
table with custom ruling, the custom ruling is not overwritten by the new
format’s regular ruling.
1

Select the cells, rows, or columns for which you want to customize ruling.

2

Choose Custom Ruling & Shading from the Table menu.

3

Choose a custom ruling style.

Turn on to create custom
ruling.

Select the ruling style you
want to apply.
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The scroll list shows the document’s predefined ruling styles. For information
on modifying and creating ruling styles, see “To create or edit a ruling style” on
page 7-22.
4

In the To Selection area, specify which parts of the current selection you want to
change.

The Inside Borders settings apply only if you’ve selected more than one cell.
Turn on Row to apply the ruling style to the horizontal borders in the selection’s
interior. Turn on Column to apply the ruling style to the vertical borders.
5

To keep from changing any shading, turn off Custom Cell Shading.

6

Click Apply.
HOW CONFLICTING RULING TAKES PRECEDENCE

Custom ruling always takes precedence over regular ruling. For example, if a
table’s regular ruling for a row is a thick line, and if you apply a thin custom
ruling to a cell in that row, the thin ruling appears.
If you apply conflicting custom ruling to adjacent cells, thicker lines take
precedence over thinner ones; double-line ruling lines take precedence over
single ruling lines.

To create or edit a ruling style
If the predefined ruling styles aren’t appropriate for your needs, you can create
additional styles as well as editing or deleting existing ones. The total number
of styles allowed is 22. If you edit a ruling style, the change applies to both
regular and custom ruling that uses that style.
While you work with ruling styles, you may want to zoom to 200 or 400 percent.
Doing this allows you to see slight differences in line thickness that you can’t
see at 100 percent.
1

Choose Custom Ruling & Shading from the Table menu.

2

In the Custom Ruling and Shading dialog box, select an existing style in the Apply
Ruling Style scroll list.

Select the ruling style you want to edit or, if you’re creating a new style, select
one similar to the style you want to create.
3
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Type the width and choose a color and pen pattern for the style.

The width can be between
0.015 and 360 points.

The colors listed are those
that have been defined in
the document.

The percentages
correspond to the gray
boxes in the Pen area of the
Tools palette.

5

Click Single or Double to specify if the style should be single- or double-lined.

If you click Double, specify the space separating the lines in the Gap text box.
The gap can be between 0.015 and 360 points.
6

If you’re creating a new style, type a different name in the Name text box and
click Set.
DELETING A RULING STYLE

To delete a ruling style, select it in the Custom Ruling and Shading dialog box
and click Edit Ruling Style. In the Edit Ruling Style dialog box, click Delete.
If the style was used as part of a table’s regular ruling, FrameMaker changes
those occurrences to use no ruling. If the style was used as a custom ruling in a
table, FrameMaker removes the custom ruling and restores the table’s regular
ruling.

To set up regular shading
You can specify a shading percentage for heading and footing rows and two
percentages for body rows or columns. By specifying two percentages for rows or
columns, you can create tables with a shading pattern. For example, you can fill
the heading row and every other body row with different shades.

You can fill the heading
row…

Anne ($)

Marie (Fr) Patrick ($)

John (£) Wendy ($)

150

1500

300

14

500

400

2200

100

27

475

225

2000

225

20

625

300

950

300

18

450

…and every other body row
with different shades.
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1

Click in the table in which you want to specify regular shading.

2

In the Shading properties of the Table Designer, choose the heading and footing row
shading from the pop-up menus.

Choose a fill percentage
from the pop-up menu.

Choose a color from the
pop-up menu.

If you don’t want to have shading in the heading and footing rows, choose None
from the Fill pop-up menu.
3

In the Body Shading area, choose whether you want to shade rows or columns from
the Shade By pop-up menu.

4

Specify the first part of the shading pattern for body rows or columns.

Type the number of rows or
columns for the first part of
the pattern.
Choose a color from the
pop-up menu.

Choose a fill percentage
from the pop-up menu.

If you want the same shading percentage for all rows or columns rather than a
pattern, type the same number in the First and Next text boxes.
5

Specify the second part of the shading pattern.

Type the number of rows or columns for the second part of the pattern in the
Next text box. Choose a color and a percentage from the pop-up menus.
6

Apply the changes.

For information on applying properties, see “To use the Table Designer” on
page 7-5.
SHADING BOTH ROWS AND COLUMNS

You can’t shade both rows and columns in one table by using the Table Designer
alone. You can, however, achieve the effect by using custom shading along with
the regular shading.
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CUSTOM SHADING

If you change the regular shading of a table containing custom shading, the
custom shading is retained. Wherever the two settings are in conflict, the
custom settings prevail. Custom shading can be changed only with the Custom
Ruling and Shading dialog box. For information on custom shading, see “To
customize shading,” next, and “To remove custom ruling or shading” on
page 7-28.

To customize shading
As with ruling, you can customize the shading for individual cells, rows, or
columns to draw attention to specific areas of a table.

June
Sunday

Monday

Tuesday

Wednesday

1

Thursday

Friday

Saturday

2

3

4

5

9

10

11

12

16

17

18

19

Pole
Vault

6

7

8
200
Meter
Hurdles

Custom cell shading

13

14

15
400
Meter
Relay

A table’s custom shading is not stored as part of the format when you use the
table to create a new catalog format. When you apply a different format to a
table with custom shading, the custom shading is not overwritten by the new
format’s regular shading.
1

Select the cells, rows, or columns for which you want to customize shading.

2

Choose Custom Ruling & Shading from the Table menu.
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3

Specify a fill percentage and color for the shading.

Turn on to create custom
shading.

Choose a color from the
pop-up menu.

Choose a fill percentage
from the pop-up menu.

The percentages in the pop-up menu correspond to the gray patterns in the Fill
area of the Tools palette.
4

To keep from changing any ruling styles, turn off Custom Cell Ruling.

5

Click Apply.
HOW CONFLICTING SHADING TAKES PRECEDENCE

Custom shading always takes precedence over regular shading. For example, if
a table’s regular shading for a row is a light gray, and if you apply a darker
custom gray to a cell in that row, the darker shading appears.

To display a cell’s ruling and shading settings
Because regular and custom ruling and shading work together, sometimes it’s
difficult to look at a table and tell which is which. FrameMaker can show the
ruling and shading settings for one or more cells in a table and indicate if the
settings are regular or custom.
1

Select the cells, rows, or columns that have the ruling and shading properties you
want to see.

2

Choose Custom Ruling & Shading from the Table menu.

The dialog box displays the most recent settings applied to a table, not the
properties of the current selection.

7-26

Using FrameMaker

.....

TABLE FORMATS

Using ruling and shading

3

In the Custom Ruling and Shading dialog box, click Show Current Settings.

FrameMaker displays the Current Selection’s Settings dialog box.

If this appears
Then the selected cells use
..........................................................................

4

Mixed

More than one ruling style, fill, or color

From Table

The regular ruling or shading set in the Table
Designer

A ruling style, fill, or color

The indicated custom ruling style, fill, or color

Click Done.

To remove regular ruling or sha ding from specific cells
If you don’t want any ruling or shading for specific cells, rows, or columns in a
table, you can customize those areas by turning off the regular ruling or
shading. Because doing this creates a custom setting, it takes precedence over
any regular setting that may be applied to the table later. If you want to display
the ruling or shading again, you’ll need to remove the custom setting. For
details, see “To remove custom ruling or shading,” next.
1

Select the cells, rows, or columns that have the regular ruling or shading you want to
remove.

2

Choose Custom Ruling & Shading from the Table menu.

3

In the Custom Ruling and Shading dialog box, select None in the Apply Ruling Style
scroll list or choose None from the Fill pop-up menu.

If you’re removing ruling, make sure Custom Cell Ruling is turned on. If you’re
removing shading, make sure Custom Cell Shading is turned on.
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4

If you’re turning off ruling, specify which parts of the current selection you want to
change in the To Selection area.

5

Click Apply.

To remove custom ruling or sha ding
When you remove custom ruling or shading, FrameMaker restores the table’s
regular ruling or shading.
1

Select the cells, rows, or columns that have the custom ruling or shading you want to
remove.

2

Choose Custom Ruling & Shading from the Table menu.

3

In the Custom Ruling and Shading dialog box, select From Table in the Apply Ruling
Style scroll list or choose From Table from the Fill pop-up menu.

If you’re removing ruling, make sure Custom Cell Ruling is turned on. If you’re
removing shading, make sure Custom Cell Shading is turned on.
4

If you’re turning off ruling, specify which parts of the current selection you want to
change in the To Selection area.

5

Click Apply.

POSITIONING TABLES
When formatting a table, you need to decide how to position it within the text
column. Positioning a table is similar to positioning text; you specify such
things as the space above and below, indents, and alignment.
You can also specify whether a table should start at the top of a column or page.
If you let a table start wherever there’s room and it continues on to another
page, the number of orphan rows you specify—the minimum number of rows
that can appear alone at the beginning or end of a text column—can affect the
positioning of the table.
You use the Table Designer to position a table. When you add a format to the
Table Catalog, FrameMaker stores the positioning properties set in the Table
Designer as part of the catalog format. If you apply a catalog format to existing
tables, their positioning properties are changed to match the catalog format.
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To indent a table
When you specify the indents of a paragraph, the left and right indents
determine the overall width of the paragraph. Table indents work differently.
The left and right indents you specify for a table determine where the table’s
edge is positioned horizontally when it’s left aligned, centered, or right aligned.

A left-aligned table is
positioned at the left
indent.

A right-aligned table is
positioned at the right
indent.

A centered table is
centered between the
left and right indents.

1

Click in the table that has the indent you want to change.

2

In the Basic properties of the Table Designer, type values for the left and right indents.

The indent you specify is the distance from the edge of the text column to the
edge of the table.
3

Apply the changes.

For information on applying properties, see “To use the Table Designer” on
page 7-5.

To align a table
The alignment of a table determines where the table appears horizontally
within its left and right indents.

Side Closer to Binding alignment

Side Farther from Binding alignment

1

Click in the table you want to align.

2

In the Basic properties of the Table Designer, choose Left, Center, Right, Side Closer to
Binding, or Side Farther from Binding from the Alignment pop-up menu.
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3

Apply the change.

For information on applying properties, see “To use the Table Designer” on
page 7-5.

To specify the space above and below a table
You can specify the space above and below a table just as you control the space
above and below a paragraph.
1

Click in the table that has the spacing you want to set.

2

In the Basic properties of the Table Designer, type spacing values in the Above and
Below text boxes.

3

Apply the changes.

For information on applying properties, see “To use the Table Designer” on
page 7-5.
THE SPACE BETWEEN BODY TEXT AND A TABLE

When you specify the space above and below a table, FrameMaker determines
the space between the table and the preceding paragraph by choosing either the
paragraph’s space below or the table’s space above, whichever is larger.
Similarly, the space between the table and the following paragraph is either the
table’s space below or the paragraph’s space above, whichever is larger.
When the table is at the top of a column, FrameMaker ignores the Above
setting. When the table is at the bottom of a column, FrameMaker ignores the
Below setting.

To control where a table begins
You can specify where a table appears in relation to its anchor symbol.
Normally, a table appears under the line of text containing the anchor symbol.
However, you can force FrameMaker to start a table at the top of a page or
column. You can also let the table float. Floating allows FrameMaker to move
the table to the first text column that can hold it without also moving the line of
text containing the table’s anchor symbol. If the table moves to the next text
column, text fills the white space below the line containing the anchor symbol.
1

Click in the table that has the placement you want to specify.

2

In the Basic properties of the Table Designer, choose the placement from the Start
pop-up menu.

3

Apply the change.

For information on applying properties, see “To use the Table Designer” on
page 7-5.
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ORPHAN ROWS AFFECT FLOATING

Floating moves the table to the next column only when the minimum number of
orphan rows allowed won’t fit at the bottom of the current column. For
information on specifying the allowable number of orphan rows, see “To set the
minimum number of rows on a page” on page 7-36.

POSITIONING AND AUTONUMBERING TEXT
WITHIN CELLS
You can specify the position of text within the cells of a table. A cell margin is
the distance between the cell edge and the cell text frame. For example, a cell’s
margin can be 8 points from the left edge and 6 points from the top. The indent
properties of a paragraph in a cell are measured from the cell margins.

The regular cell margins are
defined in the Table
Designer.

Type

Risk

The paragraph’s indents
are defined in the
Paragraph Designer.

When formatting a table, you can set the regular cell margins. The regular cell
margins affect all cells in the table and are part of the format that is stored in
the Table Catalog.
You can customize the margins for individual table cells by changing them in
the paragraph format of the first paragraph in the cell (if there’s more than one
paragraph). Because they’re part of a paragraph format, custom cell margins
aren’t normally stored as part of the Table Catalog format. When you customize
cell margins in a table and later apply a different format to the table, the
custom cell margins aren’t overwritten by the new format’s regular margins.
When specifying custom cell margins, you can also customize the vertical
alignment of text in the cell. Text in a cell can be top aligned, middle aligned, or
bottom aligned.
You can also determine how the numbering of autonumber paragraphs will
proceed in a table. Autonumbering can proceed across rows or down columns,
whichever you specify. This property also directs the numbering of footnotes in
a table.
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To set up regular cell margins
FrameMaker uses the regular cell margins for all cells in the table. You specify
the top, bottom, left, and right margins.
1

Click in the table in which you want to specify regular cell margins.

2

In the Basic properties of the Table Designer, type the distances for the top, bottom,
left, and right margins in the Default Cell Margins area.

3

Apply the changes.

For information on applying properties, see “To use the Table Designer” on
page 7-5.
CENTERING TEXT VERTICALLY

If you want to center text vertically, make the top margin slightly larger than
the bottom margin. For example, you could make the top margin 5 points and
the bottom margin 3 points.
CUSTOM MARGINS ARE RETAINED

If you change the regular cell margins of a table containing custom cell
margins, the custom margins are retained. Wherever the settings are in
conflict, the custom settings prevail. Custom cell margins can be changed only
with the Paragraph Designer. For information on changing custom cell margins,
see “To customize cell margins,” next.

To customize cell margins
Occasionally, cells in a table need margins that are different from the regular
margins. For example, the heading cells may have top margins that are
different from other cells in the table.

Custom top margin is
10 points.

Regular top margins are
4 points.

Day

Itinerary

Monday

Visit the Metropolitan Museum.

Tuesday

Visit the Empire State Building from 8:00 AM
until 9:00 AM.
Visit the Museum of Modern Art from 10:00 AM
until 3:00 PM.

You can specify custom cell margins for individual cells. When you customize
cell margins in a table and later apply a different format to the table, the
custom cell margins are not overwritten by the new format’s regular margins.
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Under certain conditions, custom cell margins can become part of a table
format’s default properties that are stored in the catalog. For details, see
“Catalog format defaults” on page 7-34.
1

Click in the first paragraph of the cell that has margins you want to customize.

2

Choose Paragraphs>Designer from the Format menu.

3

In the Table Cell properties of the Paragraph Designer, specify the top, bottom, left, or
right margins, whichever ones you want to customize.

Choose the type of margin
you want to specify...

...and type a number here.

For
Choose
..........................................................................

A margin relative to the
regular cell margin

From Table Format, Plus

A margin relative to the
edge of the cell

Custom

For tips on which setting to choose, see “Specifying a type of margin,” next.
4

Apply the changes.

If you want to apply the changes to the current paragraph only, click Apply To
Selection. This creates a format override for that paragraph. For information on
format overrides, see “Overriding a catalog format’s properties” on page 5-13.
If you want to apply the changes to the Paragraph Catalog format and to all
paragraphs in the document with the same tag, click Update All. If
FrameMaker detects format overrides in any of the table paragraphs being
updated, it displays an alert that asks whether you want to retain or remove
them.
SPECIFYING A TYPE OF MARGIN

You should use the From Table Format, Plus setting if you want the cell
margins to change when new regular margins are applied in the Table
Designer. For example, you can reduce the margins in all cells at once
(including cells with customized margins) by specifying smaller regular
margins in the Table Designer.
You should use the Custom setting, on the other hand, if you don’t want the
cell’s margins to change when new regular margins are applied.
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CATALOG FORMAT DEFAULTS

Because they’re part of a paragraph format, custom cell margins and alignment
aren’t normally stored as part of the Table Catalog format. However,
FrameMaker does store the paragraph formats of the first title paragraph and
the topmost paragraph in the heading, body, and footing rows of each column. If
you customize the cell margins or alignment of any of these paragraphs and
then store the table format in the catalog, future tables that use that format
will have the custom settings as their defaults.

To customize vertical alignment of text
Formats in the Table Catalog include paragraph formats for text in table cells,
and those paragraph formats include vertical alignment. The vertical
alignment determines where FrameMaker places the text within a cell’s
margins—at the top, in the middle, or at the bottom.

Bottom-aligned text

Cost of
Living:
Rodeo
City

Middle-aligned text

Top-aligned text

Living Costs
(U.S. Avg. = 100)

Average
Household
Income
and Taxes

Occupations
(U.S. Avg. = 100)

Goods

Housing: 104

Income: $32,262

Blue collar: 105

Food products

Food: 74

Taxes: $235

White collar: 95

Tire retreads

Other: 97

Cattle

You can specify custom vertical alignment for individual cells. When you
customize vertical alignment in a table and later apply a different format to the
table, the custom vertical alignment settings are not overwritten by the new
format’s default alignment settings.
Under certain conditions, custom vertical alignment can become part of a table
format’s default properties that are applied to new tables. For details, see
“Catalog format defaults” on page 7-34.
1

Click in the first paragraph of the cell that has text alignment you want to customize.

2

Choose Paragraphs>Designer from the Format menu.

3

In the Table Cells properties of the Paragraph Designer, choose Top, Middle, or Bottom
from the Cell Vertical Alignment pop-up menu.

4

Apply the change.

If you want to apply the change to the current paragraph only, click Apply To
Selection. This creates a format override for that paragraph. For information on
format overrides, see “Overriding a catalog format’s properties” on page 5-13.
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If you want to apply the change to the Paragraph Catalog format and to all
paragraphs in the document with the same tag, click Update All. If
FrameMaker detects format overrides in any of the table paragraphs being
updated, it displays an alert that asks whether you want to retain or
remove them.

To specify the direction of autonumbering in a table
You number paragraphs in a table just as you number them in other places in a
document—by specifying an autonumber format in the Numbering properties
of the Paragraph Designer. For information on specifying an autonumber
format, see “Formatting lists” on page 4-36.
Autonumbering in a table can proceed across rows or down columns, whichever
you specify. You specify the direction of autonumbering in a table by setting a
property in the Table Designer.

1. Blue

2. Yellow

1. Blue

4. Yellow

3. Green

4. Black

2. Green

5. Black

5. Red

6. White

3. Red

6. White

Numbering across rows

Numbering down columns

This property also sets the direction of autonumbering of footnotes in a table.
1

Click in the table in which you want to specify the autonumbering direction.

2

In the Basic properties of the Table Designer, choose Row First or Column First from the
Numbering pop-up menu.

3

Apply the change.

For information on applying properties, see “To use the Table Designer” on
page 7-5.

Using FrameMaker

7-35

7

TABLE FORMATS

Controlling page breaks in multipage tables

CONTROLLING PAGE BREAKS
IN MULTIPAGE TABLES
If FrameMaker can’t fit all the rows of a table in a text column, it moves some of
the rows to the next page or column. You can control how FrameMaker breaks
the table between pages or columns. For example, you can set the minimum
number of rows that can appear on a page or column, or you can ensure that
two rows always appear together on the same page or column. You can also
force a break at any point in a table.
The minimum number of rows is a regular table format property—one that you
specify in the Table Designer, store in the catalog format, and update. Keeping
two rows together or forcing a break are custom settings. When you apply a
different format to the table, these settings are not overwritten. When you use
the table to create a new catalog format, these settings don’t become part of the
format.
If a table runs across multiple pages, you can use variables to indicate that the
parts on subsequent pages are continuations or to display page numbering
information. For information on using these special table variables, see “To set
up multipage tables” on page 6-12.

To set the minimum number of rows on a page
If a table won’t fit on a single page or column, FrameMaker decides where to
break it based on the number of orphan rows allowed for the table. The orphan
row property determines the minimum number of body rows that must be kept
together on a page or column. For example, you can specify 3 for the orphan row
property to ensure that at least three body rows appear on each page or column
the table spans.
There are eight rows here—
more than the minimum of
three.
If there weren’t room for
these three rows, the whole
table would move to the
next page.
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You can also set up this property so that the table never breaks across pages or
columns.
1

Click in the table in which you want to change orphan rows.

2

In the Basic properties of the Table Designer, type the number of rows in the Orphan
Rows text box.

The number can be between 1 and 255.
3

Apply the change.

For information on applying properties, see “To use the Table Designer” on
page 7-5.
PREVENTING A TABLE FROM BREAKING

If you don’t ever want a table to break across pages, specify a large orphan
setting such as 99.

To keep rows together
Occasionally, you may have rows in a table that should always be kept together
on a page. You can specify that a particular row should always stay with the
previous or next row. FrameMaker won’t separate the two rows when it breaks
the table across pages.
Next Row and Previous Row are custom settings. When you apply a different
format to the table, these settings are not overwritten. When you use the table
to create a new catalog format, the settings don’t become part of the format.
1

Select the row you want to keep together with the next or previous row.

2

Choose Row Format from the Table menu.

3

In the Keep With area of the Row Format dialog box, turn on Next Row or Previous Row
and click Set.
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To break a table at a specific place
Just as you can have FrameMaker always place a table or paragraph at the top
of a page or column, you can do the same with a specific row in a table. Later,
you can remove the page break if you want to.
The choices for page breaks are custom settings. When you apply a different
format to the table, these settings are not overwritten. When you use the table
to create a new catalog format, the settings don’t become part of the format.
1

Select the row you want to force to the top of the next column or page.

2

Choose Row Format from the Table menu.

3

In the Row Format dialog box, choose Top of Column or one of the Top of Page options
from the Start Row pop-up menu and click Set.
REMOVING A CUSTOM PAGE BREAK

If you no longer want to force a row to the top of the next column or page, select
the row. In the Row Format dialog box, choose Anywhere from the Start Row
pop-up menu.
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In FrameMaker, you can search for items such as character formats,
tags, and anchored frames as well as for text. You can replace what you
find with something comparable—one tag for another—or with
something completely different.

The Find/Change window is always at hand
You search a document by specifying the item you’re searching for in
the Find/Change window. The Find/Change window can stay open as
you work, so you can search for an item, do something else, search for
another occurrence of the item, and so on.

Wildcards broaden the search
You can customize the search by considering case, matching whole
words only, or using wildcards. Wildcards let you broaden your search
to any character or sequence of characters. For example, typing *aker
finds maker and any other word ending in aker; [a-s]aker finds
baker and maker but not shaker and taker.

You can search for items other than text
The item you search for can be specific text, text with a certain
character format, or any occurrence of a particular format. The item
can also be a marker, a cross-reference, a text inset, or a variable.
Practically speaking, you can search for text and anything that uses or
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affects text, and you can define the item you search for as broadly or as
narrowly as your purposes dictate.

You choose the type of
item to find from a
pop-up menu.

The pop-up menu lists
several other items.

You can also quickly find the graphics in a document by searching for
anchored frames.

Replacement choices give you precise control
Once you find an item, you can replace it, continue your search for more
occurrences of it, or replace the item and search for a different item. If
you want to replace all occurrences, you can make the replacement
automatically.
Your control over the kinds of replacement available is as precise as
your control over searches. You can replace text with other text, one
paragraph tag with another, one type of cross-reference with another,
and so on. But you can also search for one kind of item and replace it
with another kind. For example, you can search for a word and replace
it with an illustration.
You can even clone the case of the text being replaced, so that tea is
replaced with coffee and Tea with Coffee.

In this chapter
This chapter shows you how to search a document for a variety of items
and replace items in a variety of ways. It provides a list of wildcards you
can use for text searches on page 8-8 and a list of special characters you
can search for on page 8-9. Searchable items other than text are listed
on page 8-5.
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SEARCHING A DOCUMENT
FrameMaker can search for a number of items in a document. Besides
searching for text, it can also search for items such as tables, markers, crossreferences, and paragraphs with a certain tag. When FrameMaker finds an
item, you can replace the item or continue searching for other occurrences of
the item.
You use a standard search procedure for most items, but some items require
additional steps. For example, when searching for conditional text, you need
to ensure that the condition tag is showing and then tell FrameMaker which
condition tags to search for. For information on the standard search procedure,
see “To search for any item,” next. Special search procedures start on page 8-7.

To search for any item
You need to tell FrameMaker what item to search for. Do you want to find a
word? A paragraph with a particular tag?
By default, FrameMaker begins searching at the insertion point and continues
through the document. It searches only pages of the type the insertion point is
on—for example, only body pages or only master pages. When FrameMaker
reaches the end of the document, it continues the search at the beginning. After
searching the main flow, it searches the other text frames and text lines.
Because FrameMaker searches flow-by-flow rather than page-by-page, it may
appear to jump around within the document while searching.
If FrameMaker finds the item, you can change the item or continue searching
for its next occurrence.

Choose the item from the
pop-up menu.
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1

Click in the document where you want to begin the search.

2

Choose Find/Change from the Edit menu.

3

Choose the item you want to find from the Find pop-up menu.

Find text box
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If you choose Character Format or Conditional Text from the Find pop-up
menu, FrameMaker displays a dialog box in which you enter additional
information. For a complete list of all the items you can search for, see “What
you can search for” on page 8-5.

WHAT YOU CAN SEARCH FOR
You can search for any type of item listed on the
Find pop-up menu in the Find/Change window.
The items on the list are described below.
Text

The text you type in the Find text box.

Character Format Text with the formatting you
specify in the Find Character Format dialog box.
Paragraph Tag A paragraph with the tag you type
in the Find text box.
Character Tag Text with the character tag you
type in the Find text box.
Any Marker

Any marker regardless of its type.

A marker of the kind you type in
the Find text box.

Marker of Type

A marker that contains the text you
type in the Find text box.

Marker Text

Any cross-reference
regardless of its format.

Any Cross-Reference

A cross-reference with
the format you type in the Find text box.

Cross-Reference of Format

A cross-reference
that FrameMaker is unable to update. If
FrameMaker finds one, it displays the marker text
of the unresolved cross-reference in the Find text
box. For more information, see “To resolve a crossreference when a marker is deleted” on page 10-21.

Unresolved Cross-Reference

Any Text Inset

Any text imported by reference.

Any text inset that
FrameMaker is unable to update from its source.

Unresolved Text Inset

A user or system variable.
FrameMaker can find the variables only on the
type of page currently displayed.

Any Variable

A user or system variable with
the name you type in the Find text box. Search
body and master pages separately to find all
variables.

Variable of Name

Anchored Frame Any anchored frame. You can
find graphics by searching for anchored frames.
Footnote Any footnote. FrameMaker selects the
footnote reference and the text of the footnote.
Any Table

Any table regardless of its tag.

A table with the tag you type in the
Find text box.

Table Tag

Conditional text with the
condition tag settings you indicate in the Find
Conditional Text dialog box.

Conditional Text

Automatic Hyphen A word that FrameMaker has
automatically hyphenated. FrameMaker bases
automatic hyphenation on the dictionaries.

Text that
matches the contents of the FrameMaker
Clipboard. FrameMaker matches text,
capitalization, and character formatting.

Text & Character Formats on Clipboard

Using FrameMaker
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4

If your choice requires it, type the item in the Find text box.

When you choose Text, Paragraph Tag, Character Tag, Marker of Type, Marker
Text, Cross-Reference of Format, Variable of Name, or Table Tag from the Find
pop-up menu, type the particular item you want to find in the text box.
Anytime you type text in the Find text box, you can customize the search by
turning on Consider Case, Use Wildcards, or Whole Word. For more
information, see “To customize a search” on page 8-7.
5

Click Find.

If FrameMaker finds an exact match for what you specified in the Find window,
it displays the page that contains the item and selects the item. You can click
Find again to search for the next occurrence.
You can also search for the next occurrence by choosing a command—Find
Next—from the Edit menu. For information on changing an item, see “To
change any item” on page 8-15.
REVERSING THE SEARCH DIRECTION

By default, FrameMaker searches toward the end of a document. You can
reverse the direction by turning on Find Backward.
IF FRAMEMAKER CAN’T FIND THE ITEM

If FrameMaker doesn’t find the item even though you’re pretty sure it’s there,
check the Find/Change window. Did you spell the text in the Find text box
correctly? Did you include too many or too few spaces? Are the appropriate
checkboxes on or off? If you’re searching for an item on a body page, is the
insertion point on a body page?
CANCELING A SEARCH

You can cancel a search at any time. While FrameMaker is searching, point in
the document window and press Control-c.
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To customize a search
You can search for exactly what you type in the Find text box—the exact word
with the exact capitalization. Alternatively, you can search for a variant of what
you type—any sequence of characters that contains the characters you type,
with any pattern of capitalization. For example, you could find the paragraph
tags 1Heading, 2Heading, and Heading3 by typing head.
You can broaden the search even further with wildcards. For example, you could
find the paragraph Heading3 and all tags beginning with an h by typing h*.
For a complete list of wildcards, see “Wildcards” on page 8-8.
■

To find an item with specific capitalization, type text with the capitalization you want
to find in the Find text box and turn on Consider Case.

With this text,
meta or Meta
won’t be
found.

Consider Case checkbox

■

To ignore capitalization when searching, turn off Consider Case.

In this case, it doesn’t matter what capitalization you use for the text in the
Find text box. If you type main in the Find text box and turn off Consider
Case, FrameMaker finds any capitalization—for example, main, Main,
and MAIN.
■

To match only a complete word, type the word in the Find text box and turn on
Whole Word.

If you type phone in the Find text box and turn on Whole Word, FrameMaker
won’t find telephone.
■

To find a set of characters that may be part of a longer word or part of more than one
word, turn off Whole Word.

If you type old in the Find text box, FrameMaker finds words such as bold
and oldest as well as old. If you type San F, FrameMaker finds both San
Francisco and San Fernando.
■

To find an item by using wildcards, type the text and wildcards in the Find text box and
turn on Use Wildcards.

If you type Number[1-9] in the Find text box, FrameMaker finds all
occurrences of the word Number followed by any number between 1 and 9.

Using FrameMaker
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SEARCHING FOR A WILDCARD

FrameMaker uses ordinary characters such as * and ? as wildcards. When Use
Wildcards is turned off, you can find these characters just as you would any
other characters. But when Use Wildcards is on, you need to put a backslash (\)
before each wildcard character to find the character. For example, with Use
Wildcards on, you type \* to find an asterisk.

To search for text
Normally, when searching for text, you search for words. However, you can
search for any text including single characters, phrases, and special characters
such as tabs and em spaces that aren’t on your keyboard.
■

To find text, choose Text from the Find pop-up menu, type the text in the Find text box,
and click Find.

You can search for text that looks exactly like what you type in the Find text
box or that is a variation of what you type. For information, see “To customize a
search” on page 8-7.

WILDCARDS
You can type the following wildcards in the Find text box.
To find
Type
For example
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Zero or more characters, excluding *
spaces and punctuation

f*t finds words such as feet, foster, and different.

One or more spaces and
punctuation characters

|

*any| finds words such as any., many?, and Tiffany, but
not anything.

Any single character, excluding
spaces and punctuation

?

m??e finds four-letter words that begin with m and end
with e—for example, mate and mile.

Any one of the characters in the
brackets

[ab]

[rml]ate finds rate, mate, late, and also words such as
berate, isolate, and material.

Any one character not in the
brackets

[^ab]

[^rml]ate finds fate, gate, and date, but not rate, mate,
or late.

Any one character in a range

[a-f]

[a-f]iction finds dictionary and fiction, but not friction.
(For information on how FrameMaker orders characters,
see Chapter 3, “Character Sets,” in the Quick Reference.)

The beginning of a line

^

The end of a line

$
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To find a character that doesn’t appear on your keyboard, type a special character
combination in the Find text box.

For a list of special characters and the character combinations that represent
them, see “Special characters” on page 8-9.
■

To find a backslash (\), type two backslashes (\\) in the Find text box.

Because a backslash usually indicates a special character, you need to type an
extra backslash for any backslash you want to find.
FINDING TEXT THAT INCLUDES SPACES

When you type text that includes spaces in the Find text box, FrameMaker
searches for the text with the same number of spaces in the same places. You
can find special spaces such as em spaces and thin spaces as well as regular
spaces.

SPECIAL CHARACTERS
The special characters include spaces, hyphens,
positions (such as the start of a word), and symbols
(such as the tab symbol and the end-of-paragraph
symbol).

Character
Special character
combination
................................................

Suppress hyphenation

\_ (underscore)

Character
Special character
combination
................................................

End-of-flow symbol

\f

Start-of-word

\<

Tab

\t

End-of-word

\>

Forced return

\r

End-of-paragraph

\p (lowercase)

Start-of-paragraph

\P (uppercase)

You indicate a nonbreaking space by typing a
backslash and pressing the space bar. You indicate
a regular space by pressing the space bar or
typing \s.

Nonbreaking space

\ (space)

Thin space

\i or \st

En space

\N or \sn

Em space

\M or \sm

Numeric space

\# or \s#

Discretionary hyphen

\- (hyphen)

Nonbreaking hyphen

Meta-hyphen

You can use most of the special characters for
replacement purposes—for example, replacing a
tab symbol with two em spaces. You cannot use
these three special characters for replacement
purposes: end-of-flow, start-of-word, and end-ofword characters.
For additional special characters that you can
search for and replace, see Chapter 3, “Character
Sets,” in the Quick Reference.

Using FrameMaker

8-9

SEARCHING

8

Searching a document

To search for a character format
You can search for any character format. For example, you can search for any
text in italics. Or you can search for text with several character format
properties—for example, 12-point Helvetica bold text with a change bar.
You can also search for a particular word or phrase with particular character
formatting. For information, see “To search for text with a particular character
format” on page 8-11.
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1

Click in text with a character format similar to (or the same as) the character format
you want to search for.

2

In the Find/Change window, choose Character Format from the Find pop-up menu.

3

Make sure that the settings in the Find Character Format dialog box represent the
character format of the current text by pressing Shift-F9 or Control-Shift-F8.

4
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If necessary, change the settings to the character format you want to find.

To search for the format of the current text, leave the properties as they are. To
search for text with some of the properties of this format specified and some
overlooked, change the settings of the properties you want to overlook to As Is.
You change a setting to As Is by clicking a checkbox until it is dim, choosing As
Is from a pop-up menu, selecting As Is in a scroll list, or deleting the text in a
text box. For example, if you don’t care what color is assigned to the text, choose
As Is from the Color pop-up menu.
To search for text with a completely different format, change the properties to
match that format.
5

Click Set.

6

In the Find/Change window, click Find.
RESETTING THE FORMAT

After making some changes in the dialog box, you can reset the dialog
box to match the format of the current text. To do so, press Shift-F9 or
Control-Shift-F8.
FINDING A FEW CHARACTER FORMATTING PROPERTIES

To find text with only a few character formatting properties, press Shift-F8 to
specify all properties as As Is. Then specify only the properties you want to find.
For example, to find any text that is italic, specify all properties as As Is and
then choose Italic from the Angle pop-up menu.

To search for text with a particular character format
You can search for text with a specific character format and capitalization—for
example, the word London in 10-point italic text. With these specifications,
FrameMaker won’t find London if it’s a different size, isn’t italic, or is
capitalized differently.
1

Copy the text with the character format you want to find to the FrameMaker
Clipboard.

You can copy as much text to the Clipboard as you like. However, when
searching for text by using the contents of the Clipboard, FrameMaker uses
only the first 126 characters on the Clipboard.
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2

Choose Text & Character Formats on Clipboard from the Find pop-up menu.

Don’t type the word in the Find text box. For general search instructions, see
“To search for any item” on page 8-4.
3

Click Find.

To search for a marker
FrameMaker uses markers for cross-references, indexing, conditional text,
and other purposes. It can find any type of marker or just the marker type
you specify.
FrameMaker can also find particular markers with certain text even when the
marker text isn’t visible in the document. For example, you might search for an
index marker with specific text in order to edit the marker text.
1

In the Find/Change window, choose a marker item from the Find pop-up menu.

To find all markers in the document, choose Any Marker. To find one specific
type of marker, choose Marker of Type. To find a marker with specific text,
choose Marker Text.
2

Unless you’re searching for any marker, fill in the Find text box.

If you’re searching for a specific type of marker, type the marker name.
If you’re searching for specific marker text, type the text. You may want to keep
the Marker window visible so that you can see the text of the selected marker in
the Marker window. Also, if you want to edit the marker text, you need to edit it
in the Marker window, not the Find/Change window. To display the Marker
window, choose Marker from the Special menu.
3

Click Find.

To search for conditional text
You can search for visible text that uses a specific condition tag. When
FrameMaker finds visible conditional text, it selects all adjacent text that uses
the same condition tag.
1

Display the conditional text you want to find.

If the conditional text isn’t showing, choose Conditional Text from the Special
menu and show the text with the condition tag. For information on showing
conditional text, see “To change the view of a conditional document” on
page 26-16.
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In the Find/Change window, choose Conditional Text from the Find pop-up menu.

3

Move the condition tags of the text you want to find to the In list.
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FrameMaker will search for
any text with the tag
Secretary.

Use the arrow buttons to move the condition tags. For example, to search for
text with the Secretary condition tag, select the Secretary tag in the As Is scroll
list and click the left arrow button twice.
To find conditional text that doesn’t have a particular condition tag, move the
tag to the Not In scroll list. For example, to find all text that doesn’t have the
CEO condition tag, move CEO to the Not In scroll list, and move Secretary,
Manager, and Comments to the As Is scroll list.
To find all conditional text, move all tags to the As Is scroll list.
4

Click Set.

5

In the Find/Change window, click Find.
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To use the Find/Change command from the keyboard
You can search for items without using the mouse. You use keyboard shortcuts
to open the Set Find/Change Parameter dialog box (which requires fewer
keystrokes than the Find/Change dialog box), move the insertion point between
the different areas of the dialog box, and start a search. These keyboard
shortcuts are useful when you want to create a macro that finds and changes
items without using the mouse gestures.
1

Point in a document window and press Esc f i s.

The Set Find/Change Parameters dialog box appears.
2

Fill in the dialog box just as you would the Find/Change window and press Return.

Use keyboard shortcuts to move from setting to setting and to choose
items from pop-up menus. For a complete list of keyboard shortcuts, see
Chapter 2, “Keyboard Shortcuts,” in the Quick Reference.
3

Press Esc f i n to start the search.

CHANGING ITEMS YOU FIND
After FrameMaker finds an item, you can change it in various ways. Generally,
you find text and replace it with other text, but you can also change the
character format of the found item. You can also apply the contents of the
Clipboard to the item; for example, you can copy a variable to the Clipboard and
replace a word with the variable.
When changing items in a document, you change each occurrence of the item as
FrameMaker finds it or have FrameMaker automatically make the change
throughout the document. If FrameMaker makes the change automatically, you
don’t get a chance to approve each change, however.
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To chang e any item
After FrameMaker finds an item, you can change it to text, change its character
format, or apply the contents of the Clipboard to the item.
1

Find an item.

For information on finding an item, see “Searching a document” on page 8-4.
2

In the Find/Change window, choose an option from the Change pop-up menu and
provide text or a character format.

If you choose To Text, type the text in the Change text box. If you choose
Character Format, FrameMaker displays a dialog box in which you identify a
character format. If you choose By Pasting, select the item you want to paste
and copy it to the FrameMaker Clipboard.
3

Click Change.

To continue searching for the item, click Change & Find. FrameMaker changes
the item and then searches for the next occurrence. For information on
changing all occurrences of an item, see “To make changes automatically” on
page 8-18.
When you click Change or Change & Find without any text selected in the
document, FrameMaker inserts or applies the replacement item at the
insertion point.
DELETING WHAT FRAMEMAKER FINDS

To delete an item that FrameMaker finds, choose To Text from the Change
pop-up menu, leave the Change text box blank, and click Change.

To replace an item with text
You can replace anything that FrameMaker finds with text. For example, you
can replace a marker with a phrase as well as replace a word with another
word. If the capitalization is important, you can have FrameMaker capitalize
the replacement text with the same capitalization as the original text.
■

To replace an item with text, choose To Text from the Change pop-up menu, type the
text in the Change text box, and click Change.

Type the replacement text exactly as you want to display it in the document.
FrameMaker changes the item.
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■

To change text to a special character, type the character combination in the Change
text box.

You can use tabs, em spaces, and other characters that aren’t on your keyboard
by typing special character combinations. For information on these characters,
see “Special characters” on page 8-9.
■

To give replacement text the same capitalization as the text being replaced, turn on
Clone Case.

For example, if you turn on Clone Case and type tea in the Find text box and
coffee in the Change text box, FrameMaker replaces Tea with Coffee and tea
with coffee. This setting is useful when the text you’re replacing isn’t always
capitalized.
■

To include a backslash (\) in replacement text, type two backslashes (\\) in the
Change text box.

Because a backslash usually indicates a special character, you need to include
an extra backslash for any backslash you want to change.
CHANGING MARKER TEXT

You can’t change marker text by using the Find/Change window. If
FrameMaker finds a marker with text, and if you type different text in the
Change text box and click Change, FrameMaker replaces the marker—not the
marker text—with the text in the Change text box. To change marker text, use
the Marker window.

To chang e the character forma t
You can change the character format of any item that FrameMaker finds. For
example, you can search for the name of a product and change the text to italic
small caps. Or you can search for all text with a particular character format and
change it to a different character format.
1

In the Find/Change window, specify the item you want to find.

2

Click in the document.

If you’re changing several character formatting properties, click in text that has
a character format similar to the one you want to apply to the found text. If
you’re changing one or two character formatting properties, click in any text.

8-16

Using FrameMaker

.....

SEARCHING

Changing items you find

3

Choose To Character Format from the Change pop-up menu.

4

In the Change to Character Format dialog box, change the settings to the character
format you want to apply and click Set.

To prevent FrameMaker from applying a property to found text, specify the
property as As Is. (Do this by dimming a checkbox, choosing As Is from a scroll
list, or deleting text in a text box.) If you’re changing a few character format
properties, specify all the properties as As Is and then specify the properties
you want to change. Specify all properties as As Is by pressing Shift-F8.
To display the character formatting of the current text in the dialog box, press
Shift-F9 or Control-Shift-F8.
5

In the Find/Change window, click Find and then click Change.

To chang e by pasting from the Clipboard
You can replace anything that FrameMaker finds with the contents of the
Clipboard. For example, you can replace a word with a graphic in an anchored
frame. Or, if you use the Copy Special>Paragraph Format command to put a
paragraph format on the Clipboard, you can apply the format to the current
paragraph.
1

Copy something to the Clipboard.

Copy an item by selecting it and then choosing Copy from the Edit menu. You
can copy a variable, an anchored frame, or any other item in a document.
To copy a paragraph format, a character format, condition tag settings, or a
table column width to the Clipboard, use the appropriate Copy Special
command on the Edit menu.
2

In the Find/Change window, specify the item you want to find.

3

Choose By Pasting from the Change pop-up menu.

4

Click Find and then click Change.

FrameMaker finds the first occurrence of the item. You can continue searching
for the item or change it by clicking one of the change buttons.
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To make changes automatically
Occasionally, you may want to change all occurrences of an item automatically.
For example, you may want to replace all occurrences of an old product name
with a new name.
When you change all occurrences, FrameMaker may make changes you didn’t
intend—for example, changing occurrences of a word when it is part of a longer
word. Also, you can’t undo the changes FrameMaker automatically corrects. For
these reasons, consider first saving your document and then manually changing
several occurrences of the item. When you’re confident that FrameMaker is
replacing only the item you want, go ahead and have FrameMaker change all
occurrences automatically.
1

In the Find/Change window, specify the item to find and the item to replace it with.

2

If you’re changing text, turn on Whole Word.

This limits the search to the text you type in the Find text box. This way,
if you’re changing tea to coffee, FrameMaker won’t replace teamwork with
coffeemwork.
3

Turn on Document or Selection.

To change the text in the entire document, turn on Document. To change text in
a range, select the text in the document and turn on Selection.
4
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When you run the Spelling Checker, FrameMaker uses a basic
dictionary and several custom dictionaries to check text for spelling
errors and common typing mistakes. The FrameMaker Thesaurus lists
synonyms, antonyms, and related words for the words you look up.

Typing errors and misspellings
The FrameMaker Spelling Checker helps with your typing as well as
your spelling. When you check spelling, you can also check for repeated
words, unusual hyphenation or capitalization, straight quotation marks
(when curved are called for), and extra spaces.

Unusual capitalization
Repeated words
Extra spaces
Misspelling

COffee is consumed, either hot or cold, by
nearly one-third of of the earth’s inhabitants.
This popular beverage is brewed from the
roasted and ground seeds of the tropical
evergreen coffee shrub, wich originated in
Africa.

When the Spelling Checker finds a questionable word, it suggests the
most likely correction along with some other possibilities. You can select
a correction, type your own correction, or leave the word as is.

You can make the check go faster
Before you select a correction, you can choose to correct all future
occurrences of the error automatically. If you leave a word as is, you can
also choose not to change future occurrences. And you can choose to
overlook particular types of words or expressions—for example,
acronyms such as WYSIWYG or expressions that contain punctuation
such as the pathname /bin.
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Custom dictionaries help you work more productively
The Spelling Checker works on this principle: it compares the words in
your document with the entries in several dictionaries, flags words that
don’t appear in any of the dictionaries, and lists similar entries as
possible corrections.
The main dictionary contains 120,000 common words, and there is a
separate site dictionary, which may contain terms added by your
system administrator, if your system is on a network. You create
document dictionaries and personal dictionaries yourself, using words
flagged during checks. The document dictionary works with a specific
document, while the personal dictionary works with all your
documents.

The Thesaurus gives definitions and offers substitutes
The FrameMaker Thesaurus provides word definitions and lists
synonyms and antonyms for words you look up. You can use the
Thesaurus when you review word choices during revision. But you
might also use the Thesaurus in the earliest stages of composition.
Sometimes finding a particular word generates the idea you want.

figment n. fiction, fable, fabrication; see
concoction, fantasy, invention, falsehood, lie,
misrepresentation, untruth, anecdote,
narrative, story, tale, yarn, fish story. –n.
mutt, cur, an animal of mixed breed,
offshoot. Ant. purebred, thoroughbred,
pedigreed.

FrameMaker remembers words as you look them up—up to the last 10.

In this chapter
This chapter shows you how to check and correct your spelling and
typing, manage the dictionaries used by the Spelling Checker, and use
the Thesaurus.
Using FrameMaker
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CHECKING SPELLING
When you spell-check a document, FrameMaker questions any words in it that
aren’t in one of its dictionaries. If a questioned word is spelled correctly, you can
confirm its spelling by adding the word to your personal dictionary. If a
questioned word is misspelled, you can correct its spelling. FrameMaker
provides suggestions for the correct spelling.
Besides misspelled words, FrameMaker can find typing errors that don’t
involve spelling—repeated words, extra or misplaced spaces, or unusual
capitalization, for example. You tell FrameMaker the specific kinds of typing
errors you want it to look for.
You can have FrameMaker limit its check so that it overlooks certain types of
words. For example, you may want FrameMaker to overlook words that contain
digits so it won’t question filenames.
For information on correcting or confirming a questionable spelling, see
“Correcting and confirming spellings” on page 9-9.

To check for spelling errors
You can direct FrameMaker to check all the text in a document, the text on the
current page, a range of text, or a single word. FrameMaker confines the check
to the type of page displayed. For example, if a body page is displayed, only the
text on body pages is checked.
1

Choose Spelling Checker from the Edit menu.

2

Choose the text you want to spell-check.

In most cases, you will want to spell-check the text on the body pages. To
display a body page, choose Body Pages from the View menu.
To check
Do this
..........................................................................
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All text in a document

Click in the document and click Document in the
Spelling Checker window.

All text on a page

Click on the page and click Current Page in the
Spelling Checker window.

Specific text

Select the text.

A word

Click to place an insertion point in the word.
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Click Start Checking.

FrameMaker begins spell-checking at the insertion point.
If you’re checking a selection of text or a single word, hold down Shift as you
click Start Checking.
When FrameMaker finds a questionable word, the word appears in a text box at
the top of the Spelling Checker window. The message to the left of the text
box—for example, Misspelling? —explains why the word has been
questioned.

Look for messages here.
Questionable words
appear here.

4

Correct or confirm the spelling.

For details, see “Correcting and confirming spellings” on page 9-9.
5

If necessary, click Start Checking to find the next questionable word.

FrameMaker finds the next questionable word. When the document contains no
more questionable words, the message Spelling OK appears in the Spelling
Checker window.
If you click Start Checking without first correcting or confirming the word just
questioned, FrameMaker continues to question that word. After it reaches the
end of the document (or range of text to be checked), it returns to the word and
questions it again.
CANCELING THE SPELLING CHECKER

To cancel spell-checking, point in the Spelling Checker or document window,
and press Control-c.

Using FrameMaker

9-5

SPELLING AND WORD CHOICE

9

Checking spelling

CHECKING SUPERSCRIPT AND SUBSCRIPT TEXT

When you spell-check, FrameMaker overlooks superscript and subscript text as
well as vertically kerned text. You can spell-check this type of text by
reformatting the text so that FrameMaker spell-checks it, running the Spelling
Checker, and then reformatting the text to look the way you want. If you
previously spell-checked the document, click Dictionaries in the Spelling
Checker window and turn on Mark All Paragraphs for Rechecking before
running the Spelling Checker. For details, see “Rechecking after changing
options” on page 9-7.
CHECKING SPELLING IN TEXT INSETS

FrameMaker does not spell-check the contents of text insets. To check spelling
in a text inset, open its source file and check the source file’s spelling.

To check for typing errors
When you spell-check a document, FrameMaker also checks for potential typing
errors. For example, it can find repeated words and it can find spaces before or
after certain characters.
1

In the Spelling Checker window, click Options.

2

Turn on the appropriate options and click Set.
To have the Spelling Checker
The Spelling
question
Turn on
Checker finds
..........................................................................
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Repeated words

Repeated Words

the the

Words hyphenated
incorrectly

Unusual
Hyphenation

over-abundance

Unusual capitalization

Unusual
Capitalization

GReen

A repeated character

Two in a Row—and
specify a character

[[ (if you specify a
left bracket)

Straight quotation marks

Straight Quotes (")

"

Extra spaces between
words and sentences

Extra Spaces

Extra spaces

Spaces before specific
characters

Space Before—and
specify a character

Space before a
period . (if you
specify a period)

Spaces after specific
characters

Space After—
and specify a
character

“ Space after a
quotation mark
(if you specify a
quotation mark)
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Start spell-checking.
RECHECKING AFTER CHANGING OPTIONS

If you change options after spell-checking a document, you may want to run the
Spelling Checker again. This is because FrameMaker ordinarily rechecks only
paragraphs that have been edited since the prior check. To recheck all
paragraphs, even the unedited ones, click Dictionaries in the Spelling Checker
window and turn on Mark All Paragraphs for Rechecking. Then proceed with
the check.
RESETTING SPELLING CHECKER OPTIONS

If you change the Spelling Checker options and then want to reset the default
options, click Get Defaults in the Spelling Checker Options dialog box.

To limit the types of words checked
You can prevent FrameMaker from questioning a word not only by putting the
word in a dictionary (see “To correct or confirm a spelling” on page 9-9), but also
by excluding the word from spell-checking, thereby limiting the check so that
words of its type are overlooked. For example, you might tell FrameMaker to
overlook all words that contain digits to prevent questioning filenames such as
DocPlan1993 and Chap1.doc. You may also want to overlook site-specific
words, such as command names or pathnames, that would clutter the
dictionary.
Be careful when specifying words to be overlooked. The more words
FrameMaker overlooks, the greater the possibility your document will have
misspelled words.
1

In the Spelling Checker window, click Options.

2

Turn on the appropriate options and click Set.
To overlook
Turn on
..........................................................................

One-character words

Single-Character Words

Uppercase words

Words That Are All Uppercase

Words that contain specific
characters

Words Containing—and specify a character

Roman numerals

Roman Numerals

Words that contain
numbers

Words with Digits
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If you change one of these options after you spell-check a document, you should
have FrameMaker mark all paragraphs in the document for rechecking before
you spell-check again. For more information, see “Rechecking after changing
options” on page 9-7.
3

Start spell-checking.
OVERLOOKING INDIVIDUAL PARAGRAPHS OR TEXT LINES

If you don’t want FrameMaker to spell-check certain paragraphs or text lines,
assign no language to them; that is, change their language property to None.
For information on changing the spell-checking language, see “To spell-check in
a different language,” next. When you set the language of a paragraph or text
line to None, FrameMaker no longer provides hyphenation for it.

To spell-check in a different language
In FrameMaker, each paragraph and each text line is assigned a language.
When you spell-check, FrameMaker uses the main dictionary of the language
assigned to the paragraph or text line. You can change the language
FrameMaker uses to spell-check text by changing the language assigned to
the text.
■

To change the language of a single paragraph or of all the paragraphs in a
document, use the Advanced properties in the Paragraph Designer.

For information on the Paragraph Designer, see “To display a designer window”
on page 4-6.
■

To change the language of a text line, use the Language pop-up menu.

The menu appears when you choose Object Properties from the Graphics menu.
All installed languages appear in the Language pop-up menu.
LANGUAGES AVAILABLE

FrameMaker provides dictionaries for the following languages: US English,
International English, German, Swiss German, French, Canadian French,
Spanish, Catalan, Italian, Portuguese (Portugal), Portuguese (Brazil), Danish,
Dutch, Norwegian, Nynorsk, Finnish, and Swedish.
Not all dictionaries are automatically installed. If you need to use a dictionary
not currently installed, ask the system administrator to install it for you.
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CORRECTING AND CONFIRMING SPELLINGS
When you spell-check a document, FrameMaker finds questionably spelled
words and possible typing errors and suggests corrections for them. You can
accept the suggestion or provide your own correction. If a questioned word is
spelled correctly, you can confirm its spelling by adding the word to a personal
or document dictionary. And if you add the word to a personal dictionary, you
can indicate where the word can be hyphenated, that it can’t be hyphenated, or
that it should always be hyphenated.
As well as suggesting a correction for a misspelled word, FrameMaker can
correct it automatically. This saves time when you spell-check a document that
has multiple occurrences of the same error.

To correct or confirm a spelling
When FrameMaker questions the spelling of a word, you must decide whether
the word is misspelled. If the word is misspelled, you can provide the correct
spelling. If the word is spelled correctly but is questioned because it isn’t in one
of the FrameMaker dictionaries, you can add the word to a personal or
document dictionary.
■

To correct a misspelling, make sure the correctly spelled word is in the Correction text
box and click Correct.

The correctly spelled word
appears here.

If the word FrameMaker suggests is not the word you want, you can select a
different word in the Correction scroll list. If the Correction scroll list doesn’t
include the word you want, you can type the word in the Correction text box. Or
you can move the insertion point to the document window and type the word
correctly there.

Using FrameMaker
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■

To correct a typing error, make sure the correctly typed text is in the Correction text
box and click Correct.

FrameMaker lists only one suggestion for mistyped text, such as repeated
words. If the suggestion is not correct, you can type the correct text in the
Correction text box, or you can type it directly in the document window.
If FrameMaker questions something that you don’t consider to be a typing
error, you can turn off the option to find that type of potential error. For
example, you can stop FrameMaker from questioning the use of straight
quotation marks. For information on specifying the kinds of typing errors to
include in a spell-check, see “To check for typing errors” on page 9-6.
■

To add a word to a personal dictionary, make sure the intended word is in the text box
labeled Misspelling? and click Learn.

FrameMaker checks your personal dictionary when spell-checking any
document. Add to this dictionary words that are neither document-specific nor
site-specific—for example, your name. For more information, see “To manage
personal or document dictionaries” on page 9-13.
■

To add a word to a document dictionary, make sure the intended word is in the text
box labeled Misspelling? and click Allow in Document.

The document dictionary is stored only with the document being checked.
FrameMaker uses this dictionary regardless of who is checking the document,
unlike the way it uses the personal dictionary. For more information, see “To
manage personal or document dictionaries” on page 9-13.
LEARNING WORDS THAT CONTAIN UPPERCASE LETTERS

If FrameMaker learns a word that contains uppercase letters, and if Unusual
Capitalization is on in the Spelling Checker Options dialog box, FrameMaker
considers any other capitalization of the word a spelling mistake. For example,
if FrameMaker learns Trinidad, it questions the spelling of TRINIDAD and
trinidad. However, if FrameMaker learns trinidad, in all lowercase letters, it
allows you to spell the word with any type of capitalization, regardless of how
the Spelling Checker options are set.
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To correct spellings automatically
You can have FrameMaker automatically correct future occurrences of a
misspelled word or typing error. The error isn’t questioned in any document you
open, and you don’t have to provide the correction. FrameMaker keeps track of
the errors to automatically correct until you exit FrameMaker or tell it to stop
making the corrections.
With typing errors, when FrameMaker automatically corrects an error, it also
changes the entire class of errors to which it belongs. For example, if you direct
FrameMaker to replace the the with the, it also replaces repeated words such as
and and with and. For information on the classes of typing errors, see “To check
for typing errors” on page 9-6.
1

Click Start Checking in the Spelling Checker window.

2

When FrameMaker questions a word or typing error, turn on Automatic Correction.

Before you decide to change a particular typing error automatically, make sure
you know what other changes will be made. Make sure that the word you
correct automatically isn’t a misspelling of another word. For example, if thst is
a misspelling of both test and that, you won’t want to change it automatically to
either word.
3

Click Correct.
CLEARING AUTOMATIC CORRECTIONS

When you exit FrameMaker, the list of corrections that FrameMaker
automatically makes is cleared. If you need to clear the list before exiting, click
Dictionaries in the Spelling Checker window and click Clear Automatic
Corrections.

To control the hyphenation of a word
When you add a word to a personal dictionary, FrameMaker calculates and
remembers the points where it can hyphenate the word. If the hyphenation
points that FrameMaker suggests aren’t appropriate, you can change them
before adding the word. You can also direct FrameMaker to always hyphenate
or never hyphenate a word. For example, you can hyphenate heavy-duty
wherever it appears but never hyphenate your company’s name.
For more information on hyphenation, see “To control hyphenation” on
page 4-23.
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■

To show a word’s hyphenation points, type the word in the Word text box and click
Show Hyphenation.

Hyphens appear at the
word’s hyphenation points.

If the word is in the main dictionary or your personal dictionary, FrameMaker
uses the dictionary definition of the word to determine the word’s hyphenation
points. If the word isn’t in one of these dictionaries, FrameMaker calculates the
hyphenation points.
If a word is hyphenated inappropriately, you can change its hyphenation points
and add it to your personal dictionary.
■

To change the hyphenation of a word, show the word’s hyphenation points, adjust the
hyphenation, and click Learn.

Add or delete hyphens as necessary.
■

To prevent FrameMaker from hyphenating a word, type the word in the Word text box,
type a hyphen before the word, and click Learn.

Make sure the word doesn’t contain any hyphens other than the one before it.
REHYPHENATING THE DOCUMENT

When you make any hyphenation changes, rehyphenate the document so that
you can see the new hyphenation. To do this, click Dictionaries in the Spelling
Checker window and click Rehyphenate Document.
FINDING AUTOMATIC HYPHENS

You can search your document for all hyphens that FrameMaker has inserted
automatically. This is useful when you want strict control over hyphenation—
for example, before printing the final draft of a book. To find all the automatic
hyphens, use Automatic Hyphen on the Find pop-up menu in the Find/Change
window.
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MAINTAINING DICTIONARIES
When you spell-check a document, FrameMaker compares each word in it with
the words in a main dictionary and three custom dictionaries: a site dictionary
maintained by your system administrator, a personal dictionary, and a
document dictionary for each document. As you spell-check a document, you can
add unknown words or hyphenated compound words to the dictionaries.
Instructions for maintaining personal and document dictionaries follow. For
information on the site dictionary, see the online manual Changing Setup Files.
For more information on the contents of the dictionaries, see “Four types of
dictionaries” on page 9-13.

To manage personal or document dictionaries
FrameMaker automatically creates a personal dictionary for you and a
document dictionary for each of your documents. You can simply use the
Spelling Checker to add or delete words, or you can manage the dictionaries
directly. When you work with a dictionary directly, you can examine and edit its
contents or merge it with another dictionary. You can create multiple personal
dictionaries and then use them one at a time.
If you make changes to either a personal or document dictionary, mark all
paragraphs for rechecking before you spell-check the document again. For more
information, see “Rechecking after changing options” on page 9-7. For
information on adding words to a personal or document dictionary, see “To
correct or confirm a spelling” on page 9-9.

FOUR TYPES OF DICTIONARIES
Each dictionary contains a different set of words.
Main dictionary Contains words found in a

standard dictionary such as Webster’s. You can’t
add words to or delete words from this dictionary.
Site dictionary Contains some technical terms as

well as words common to your site—for example,
the company name and product names. The site
administrator can add or delete words.
FrameMaker provides one site dictionary for each
language it supports.

Personal dictionary Contains words you use often.
FrameMaker uses this dictionary whenever you
spell-check any document. You can add or delete
words. You can also create several personal
dictionaries and switch between them.
Document dictionary Contains words that are
acceptable in a particular document. FrameMaker
uses this dictionary regardless of who is editing
the document. You can add words to or delete
words from it. This dictionary is part of the
document, not a separate file like the other
dictionaries.
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■

To delete a word from the personal or document dictionary, type the word in the Word
text box in the Spelling Checker window and click Unlearn.

■

To delete the contents of the document dictionary, click Dictionaries in the Spelling
Checker window and choose Clear from the Document Dictionary pop-up menu.

■

To create another personal dictionary, create a document file, place words with their
hyphenation points in the file, and save the file in Text Only format.

The first line of the file must be:
<MakerDictionary 2.0>
When you save the file, choose Text Only from the Format pop-up menu in the
Save Document dialog box and click Save. In the Save as Text dialog box, click
Only between Paragraphs and click Save.
■

To use a different personal dictionary, click Dictionaries in the Spelling Checker
window, choose Change Dictionary from the Personal Dictionary pop-up menu, and
identify the location of the dictionary.

In the dialog box that appears, type or select the name of the file that contains
the personal dictionary you want to use. The default personal dictionary is
located in the file fmdictionary in your home directory. FrameMaker
displays the name of the current personal dictionary at the bottom of the
Dictionary Functions dialog box.
■

To check the spelling of a document without using the personal dictionary, click
Dictionaries in the Spelling Checker window and choose Set to None from the
Personal Dictionary pop-up menu.

■

To copy the contents of a dictionary to a file, click Dictionaries in the Spelling Checker
window and choose Write to File from the Personal Dictionary or Document Dictionary
pop-up menu.

You can edit this file and then merge it with the dictionary. Instructions for
merging and editing follow.
■
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EDITING A DICTIONARY

You edit a dictionary by having FrameMaker write its contents to a file, editing
the file, and merging the file with the dictionary. When you remove words from
the dictionary, delete the original dictionary before merging the file. Otherwise,
the deleted words remain in the dictionary.
Delete the document dictionary by choosing Clear from the Document
Dictionary pop-up menu in the Dictionary Functions dialog box. Delete a
personal dictionary by deleting the file that contains the dictionary. (The
default personal dictionary is in the file fmdictionary in your home
directory.)
USING FRAMEMAKER TO EDIT A DICTIONARY

When you use FrameMaker to edit a dictionary, treat line endings as paragraph
breaks when you open the file. To do this, choose Text Only from the Format
pop-up menu in the Save Document dialog box when you save the file. Make
sure the file is named correctly and click Save. In the Save as Text dialog box,
click Only between Paragraphs and click Save.

To quickly add unknown words to a dictionary
If your document contains many correctly spelled words that FrameMaker will
question, you can expedite spell-checking by adding these words to a dictionary
in a separate operation before you begin to spell-check. To do this, you generate
a file of words that FrameMaker questions, edit this file to contain just the
correctly spelled words, and then merge the file with a dictionary.
1

In the Spelling Checker window, click Dictionaries.

2

In the Dictionary Functions dialog box, click Write All Unknown Words to File and
click OK.

3

In the Store Spell-Checking Results in File dialog box, type or select a filename for the
dictionary file and click OK.

FrameMaker creates a dictionary file that contains all the unknown words in
the document. The dictionary file doesn’t include typing errors such as repeated
words, capitalization errors, or extra spaces. (For a complete list of typing
errors, see “To check for typing errors” on page 9-6.)
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4

Edit the dictionary file with a standard text editor or with FrameMaker.

Delete any words you don’t want to add to your dictionary—for example, any
misspelled words.
For information on using FrameMaker to edit a dictionary, see “Using
FrameMaker to edit a dictionary” on page 9-15.
5

In the Spelling Checker window, click Dictionaries.

6

Choose Merge from File from the Personal Dictionary pop-up menu or the Document
Dictionary pop-up menu and click OK.

If you expect the words to appear in several documents, you should merge the
words with a personal dictionary.
7

In the Merge File into Document Dictionary dialog box or the Merge File into Personal
Dictionary dialog box, type or select the filename of the dictionary file and click OK.

To add a hyphenated compound word to your personal dictionary
Your document may contain a hyphenated compound word—a word or phrase
made up of multiple words connected by hyphens. By default, FrameMaker
spell-checks each word in a hyphenated compound word rather than check the
hyphenated compound word as a whole. For example, with the word heavy-duty,
FrameMaker spell-checks first heavy and then duty. By changing the default
settings, you can have FrameMaker spell-check hyphenated compound words
as one word, and you can add hyphenated compound words to your personal
dictionary.
1

In the Spelling Checker window, click Options.

2

In the Spelling Checker Options dialog box, turn on Unusual Hyphenation and
click Set.

FrameMaker spell-checks the hyphenated compound word as one word, rather
than checking the individual words.
3

Choose Document>Text Options from the Format menu.

4

In the Text Options dialog box, remove the hyphen from the Allow Line Breaks After
text box and click Apply.

This prevents FrameMaker from hyphenating the individual words that make
up the hyphenated compound word.
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In the Word text box in the Spelling Checker window, type the hyphenated compound
word to be added to your personal dictionary.

Type a hyphen at the beginning of the compound word, and type a backslash (\)
before each hyphen that connects words. For example, to add the word vicepresident, type -vice\-president. For more information on specifying
hyphenation points, see “To control the hyphenation of a word” on page 9-11.
6

Click Learn.

USING THE THESAURUS
You use the Thesaurus to look up synonyms, related words, and antonyms for a
word you specify. Synonyms have the same meaning, related words a similar
meaning, and antonyms the opposite meaning. If you specify figment, the
FrameMaker Thesaurus provides synonyms such as fiction and fable, related
words such as concoction and fantasy, and antonyms such as fact.
The Thesaurus lets you improve on a word already in a document or search for
the right word to insert in it. In the example, you can replace figment with any
of the synonyms, related words, or antonyms it shows.
The search for a word doesn’t need to end with the first set of synonyms, related
words, and antonyms you find. You can look up any one of these words,
displaying its synonyms, related words, and antonyms, and so on. FrameMaker
keeps track of the last 10 words you looked up, so you can quickly go back to a
word you previously looked up.
Some words have more than one meaning. For example, cover can be a noun or
a verb. In these cases, FrameMaker displays synonyms, related words, and
antonyms for each meaning.
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To look up a word
FrameMaker provides several ways of navigating through the Thesaurus.
■

To look up a word visible in the document window, select the word and choose
Thesaurus from the Edit menu.

Information about the word appears in the Thesaurus window.
■

To look up a word not visible in the document window, make sure that no text is
selected, choose Thesaurus from the Edit menu, type the word in the Thesaurus Look
Up dialog box, and click Look Up.

When you click Look Up, information on the word appears in the Thesaurus
window.
■

To look up a phrase, make sure that no text is selected, choose Thesaurus from the Edit
menu, type the phrase in the Thesaurus Look Up dialog box, and click Look Up.

Type hyphens between each word in the phrase. For example, type
free-for-all.
If you try to look up a phrase by selecting the phrase in the document window
and then choosing the Thesaurus command, FrameMaker places only the first
selected word in the Thesaurus Look Up dialog box.
■

To look up a synonym, a related word, or an antonym displayed in the Thesaurus
window, click the word.

Synonyms, related words, and antonyms are shown in bold in the Thesaurus
window.
■

To look up a word again, choose the word from the Word pop-up menu.

The Word
pop-up menu

This menu lists the last 10 words you looked up.
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■

To look up a word that is not displayed in the Thesaurus window, click Look Up, type
the word in the Thesaurus Look Up dialog box, and click Look Up.

The Look Up button appears in both the Thesaurus window and the Thesaurus
Look Up dialog box. When you click Look Up in the Thesaurus window, the
dialog box appears. When you click Look Up in the dialog box, information
appears in the Thesaurus window.
VIEWING MORE INFORMATION

If you see arrows in the lower-right corner of the Thesaurus window, more
information on the word in the Word pop-up menu is available. Click the down
or up arrow button to display the next or previous page of information.
CAPITALIZATION OF WORDS

When you look up a word, FrameMaker displays the words in the Thesaurus
window with capitalization that matches the word you looked up.
HOW FRAMEMAKER DETERMINES THE LANGUAGE TO USE

FrameMaker uses the language of the current paragraph. If a word isn’t
selected, or if the insertion point isn’t in a paragraph, FrameMaker uses the
custom document language. For information about custom document
languages, see the online manual Changing Setup Files.
Alternatively, you can specify a different language when looking up a word. To
do so, click Look Up in the Thesaurus window, type the word you want to look
up, and choose a language. Then click Look Up. The dictionaries must be
installed before you can use a Thesaurus.
FrameMaker provides a Thesaurus for each of the following languages:
US English, International English, German, Swiss German, French, Canadian
French, Spanish, Italian, Danish, Dutch, Norwegian, and Swedish.
Not all Thesauruses are automatically installed. If you need to use a Thesaurus
not currently installed, ask the system administrator to install it for you.
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To replace or insert a new word
You can replace a selected word with a word from the Thesaurus window.
Alternatively, you can place a word displayed in the Thesaurus window at the
insertion point in the document. The replacement or addition can be either the
word looked up or one of the words in bold in the Thesaurus window—its
synonyms, antonyms, or a related word.
■

To replace a selected word in your document with the word looked up in the
Thesaurus, click Replace.

■

To replace a selected word in your document with a word in bold in the Thesaurus
window, Control-click the word and click Replace.

■

To insert the word looked up in the Thesaurus in your document, place the insertion
point in the document and click Replace.

■

To insert a word in bold in the Thesaurus window in your document, place the insertion
point in the document, Control-click the word, and click Replace.
REPLACING SEVERAL OCCURRENCES OF A WORD

When replacing the selected word in your document with a word from the
Thesaurus, you replace only the selected word—not all occurrences of the
selected word. To replace all occurrences, use the Find/Change command. For
more information, see “To make changes automatically” on page 8-18.
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FrameMaker provides standard formats for cross-references to other
pages or headings, and you can add your own formats. The formats
make it unnecessary to type the cross-references. When page numbers
or headings change, FrameMaker can automatically update the crossreferences.

FrameMaker inserts the cross-reference
When you need a cross-reference, you place the insertion point where
you need the reference and choose a format from a menu. The format
provides a cross-reference sentence or phrase, appropriately formatted
and punctuated (for example, See “Inspection List” on page 7-71.). The
format also provides building blocks that stand for the specifics—for
Inspection List and 7-71 in the example. You don’t type a word.

Include headings and page numbers in the cross-reference
When you choose the cross-reference format, you also specify a
paragraph—the source of the cross-reference—from a list. If the
paragraph is a heading, such as Inspection List, the text of the heading
can appear in the cross-reference as is. You don’t have to retype the
contents.
7-70
7-69

For more information,
see “Inspection List” on page 7-71.

7-71

Inspection List
Follow these steps carefully, checking
each item as you go, to complete final
inspection specifications at hand so that

Whether or not the cross-reference includes identifying text,
FrameMaker can put the page number of the source—7-71 in the
example—in the cross-reference for you.
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You can change the formats and add new ones
FrameMaker documents contain a number of cross-reference formats.
You can revise these formats, and you can define new ones. For
example, you can create a complex definition that permits crossreferences such as See “Inspection List” under “Getting Started.” In the
example, Inspection List is the text of the source paragraph. Getting
Started is the text of a preceding higher-level heading.

Two types of cross-references
FrameMaker provides two types of cross-references—paragraph and
spot. Normally, you use paragraph cross-references to cross-reference
entire paragraphs—for example, a heading or a paragraph of text that
describes a related subject. FrameMaker automatically places a marker
at the beginning of the paragraph you cross-reference. The page on
which the marker occurs is where FrameMaker refers the reader.
Sometimes, however, you may want to cross-reference a particular
location in a paragraph. In this case you need a spot cross-reference.
You manually insert the cross-reference marker exactly where you
want to refer the reader. If FrameMaker breaks the paragraph across
two pages, the cross-reference refers to the correct page number, rather
than the page number on which the paragraph begins.

Maintaining cross-references is easy
FrameMaker can update cross-references automatically whenever you
open or print a document. And when pagination changes in an open
document, as it often does, you can update all the cross-references with
a single command. FrameMaker updates page numbers and revises
titles and headings in the cross-references. Updates need special
attention only when you move the source to another file or delete the
source.

In this chapter
This chapter shows how to create cross-references, create the formats
they use, and help FrameMaker maintain the cross-references as you
revise their source documents.

Using FrameMaker
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CREATING A CROSS-REFERENCE
FrameMaker provides two types of cross-references—to paragraphs and to
spots. You use paragraph cross-references when you refer to a heading or some
other text that occupies a whole paragraph. You use spot cross-references when
you refer to an individual word or phrase—a spot—in a paragraph.
Paragraph cross-references are easier for you to create because you don’t have
to mark a particular spot. They also make it easier to edit a document that
contains them, because you don’t have to work around an easy-to-miss marker
buried in the middle of a paragraph. For more information on cross-reference
markers, see “A marker identifies the source of a cross-reference” on page 10-4.
Editing the cross-reference itself is confined to choosing a different format or
source for it. You change the format to reword the cross-reference, and you
change the source to refer to a different paragraph or spot. If you want to edit a
cross-reference as you do regular text, you must convert it to text. And after
conversion, FrameMaker no longer updates the text as a cross-reference.

A MARKER IDENTIFIES THE SOURCE OF A CROSS-REFERENCE
FrameMaker uses markers to keep track of the
source of each cross-reference. For example, if you
move a marker and then update the crossreferences, FrameMaker uses the information at
the new location of the marker.
You can display the information FrameMaker
keeps for each cross-reference marker by
displaying the Marker window and then choosing
Marker of Type from the Find pop-up menu in the
Find/Change window. Type Cross-Ref in the
text box and then begin the search. As
FrameMaker finds cross-reference markers, the
text box in the Marker window displays
information on each cross-reference marker.
• For paragraph cross-references, FrameMaker
displays the five-digit number it assigned to the
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marker and the paragraph tag and text of the
paragraph being cross-referenced. (The marker
text doesn’t get updated, so the tag and text may
be out of sync with the cross-reference.)
• For spot cross-references, FrameMaker displays
the marker text you typed for the marker.
Within a document, if you copy and paste text that
contains a cross-reference marker, FrameMaker
pastes the text but not the marker. The crossreference still refers to the text in its original
location.
However, if you copy text that contains a marker,
delete the original marker, and then paste the text,
FrameMaker does paste the marker.
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To insert a paragraph cross-reference
When you insert a paragraph cross-reference, FrameMaker places a marker at
the beginning of the paragraph you’re cross-referencing.
7-68

7-71

Carafe Assembly

Inspection List

These installation instructions cover
how to assemble the glass carafe. If you
are unsure that all parts are present,
see “Inspection List” on page 7-71.

Follow these steps carefully, checking
each item as you go, to complete final
inspection of Espresso Yourself units.
Have your gauge and your copy of the
engineering specifications at hand so
you can confirm all measurements.

1 Screw the drip-through knob tightly

Cross-reference

Cross-Ref marker

The wording and appearance of the cross-reference itself depend on the crossreference format you choose and the information in the source paragraph
you mark.
1

If you’re cross-referencing another document, open the document.

You must have write permission to the document in order for FrameMaker to
add a marker to it.
2

Click where you want to insert the cross-reference.

7-68

Carafe Assembly
These installation instructions cover
how to assemble the glass carafe. If you
are unsure that all parts are present,
1 Screw the drip-through knob tightly
onto the bottom of the carafe lid.

Where you want to insert
the cross-reference

You can insert a cross-reference in text frames but not in text lines.
3

Choose Cross-Reference from the Special menu.

Using FrameMaker
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4

If the document you’re cross-referencing is not the current one, choose the name of
the document from the Document pop-up menu.

If you’re cross-referencing information in another document, choose the name of
that document from the Document pop-up menu. Otherwise, leave the pop-up
menu set to Current.

Choose the source
document here.
Choose Paragraphs here.
Select the paragraph tag of
the paragraph to crossreference here.

Select the
paragraph to
cross-reference
here.

Choose the format here.

This line displays
the current
format.

The Document pop-up menu lists all open, named documents. If the document
to cross-reference is not open, click Cancel, open the document, and begin
again. If the document to cross-reference is open but has never been saved, save
and name the document.
5

10-6

Using FrameMaker

Choose Paragraphs from the Source Type pop-up menu.

.....

CROSS-REFERENCES

Creating a cross-reference

6

In the Paragraph Tags scroll list, select the tag of the paragraph you want to crossreference.

For example, if you’re cross-referencing a paragraph with the tag 1Heading,
select 1Heading in the Paragraph Tags scroll list. FrameMaker displays all the
paragraphs in the document with the 1Heading paragraph tag in the
Paragraphs scroll list.
7

In the Paragraphs scroll list, select the particular paragraph to cross-reference.

With paragraphs in text insets, the cross-reference marker FrameMaker
inserts is lost when the text inset is updated. For more information, see “Crossreferencing a paragraph in a text inset” on page 10-7.
8

Choose the format of the cross-reference from the Format pop-up menu.

This menu lists the names of cross-reference formats in the current document.
For information on creating new cross-reference formats or modifying existing
formats, see “Creating a cross-reference format” on page 10-10.
9

Click Insert.

FrameMaker puts the cross-reference at the insertion point and a marker at
the start of the paragraph to which the cross-reference refers. FrameMaker
inserts a marker only if there isn’t a cross-reference marker already there.
CROSS-REFERENCING A PARAGRAPH IN A TEXT INSET

To make sure the cross-reference marker for a paragraph in a text inset is not
removed when the inset is updated, insert a cross-reference to that paragraph
in the source document. First, open the source of the inset, and then insert a
cross-reference to the paragraph anywhere in the source document. When you
insert the cross-reference, FrameMaker inserts a marker in the source
document, at the beginning of the paragraph. At that point you can delete the
cross-reference text. The marker will remain.
Next, save the source document, update the text inset, and insert another crossreference to the paragraph, this time in the document that contains the inset.
The cross-reference uses the marker that exists in the updated inset.
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To insert a spot cross-reference
Before you can insert a spot cross-reference, you have to manually insert a
marker. The marker indicates the spot within a paragraph to which
FrameMaker refers—for example, a word or phrase. If the paragraph continues
on the following page, the cross-reference refers to the page that contains the
marker—not the page on which the paragraph begins.
1

Click where you want to insert the marker.

For example, if you want to direct readers to a definition, click at the start of the
defined word. Or, if you want to direct readers to an anchored frame, click next
to the anchored frame symbol. You can put a marker anywhere within a column
of text.
If you want to insert a cross-reference marker in a text inset, insert the marker
in the source document.
2

Choose Marker from the Special menu.

3

Choose Cross-Ref from the Marker Type pop-up menu and define the marker.

Choose Cross-Ref.
Type the description here.

The Marker Text text field helps you identify the marker when you insert a spot
cross-reference. For example, if you insert a marker where system variable is
defined, you can type Definition of system variable. This text appears
in the Cross-Reference dialog box when you select Cross-Reference Markers
from the Source Type pop-up menu. It doesn’t appear in the cross-reference
itself. The marker text can be up to 255 characters long.
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Click New Marker.

If Text Symbols is on in the View menu, a marker symbol ( ) appears at the
insertion point. This symbol doesn’t appear in the printed document.
5

Insert a cross-reference.

Use the directions for inserting a paragraph cross-reference (beginning on
page 10-5). However, rather than choose Paragraph Tags from the Source Type
pop-up menu, choose Cross-Reference Markers. When the marker text of the
marker you just created appears in the Cross-Reference Markers scroll list,
select the marker text, choose a cross-reference format, and click Insert.
GOING TO THE SOURCE

You can display the source of a cross-reference by double-clicking the crossreference and clicking Go to Source in the Cross-Reference dialog box.
FrameMaker displays the page that contains the source of the cross-reference
and puts the insertion point at the marker. If the source is in a text inset, the
text inset is selected.

To edit a cross-reference
You can edit a cross-reference by changing its source or format. You can also
move it or delete it entirely.
You can edit the individual characters in a cross-reference after converting it to
text. But, after the conversion, the text of the cross-reference loses the
connection with its source and can’t be updated if the source changes.
■

To use a different source for a cross-reference, double-click the cross-reference,
change the source in the dialog box that appears, and click Replace.
You can change the Document, Source Type, and Source Text.

■

To use a different format for a cross-reference, double-click the cross-reference,
choose a different format from the Format pop-up menu, and click Replace.

If none of these cross-reference formats is appropriate, you need to create a new
format. For more information, see “To create a cross-reference format” on
page 10-11.
■

To select a cross-reference, click it.

■

To move or copy a cross-reference, select it, cut or copy it, and paste it in the new
location.
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■

To delete a cross-reference, select it and press Delete.

When you delete a cross-reference, FrameMaker doesn’t delete the marker at
the source of the cross-reference. You can delete the marker yourself, but it’s not
necessary. If you leave it, you avoid the risk of deleting the wrong marker or
creating unresolved cross-references, because other cross-references may use
that marker.
CONVERTING A CROSS-REFERENCE TO TEXT

You can convert all the cross-references in a document, all the cross-references
in a document with a particular cross-reference format, or a single crossreference. To convert a single cross-reference, select it; otherwise, click in the
document. Then click Convert to Text in the Cross-Reference dialog box.
Indicate the range of cross-references to convert and click Convert. If you
convert a cross-reference to text, FrameMaker no longer updates the crossreference.

CREATING A CROSS-REFERENCE FORMAT
The format of a cross-reference determines its appearance—the wording, the
information it contains, and its character format. For example, the format of the
cross-reference See also “Carafe Assembly” on page 7-68 determines that the
section title is in quotation marks. The cross-reference also provides the words
See also and on page, and it provides building blocks that stand for the actual
section title and page number.
Cross-reference formats of this kind help you use a consistent cross-reference
style throughout a document. Their building blocks let you edit the document
without having to update cross-references in it by hand. In the example, you
could change the title Carafe Assembly or move it to another page without
having to change the cross-reference. FrameMaker does the updating for you.
FrameMaker provides a number of cross-reference formats, and you can change
them or create others. The variety of building blocks FrameMaker provides lets
you create almost any format you can imagine.
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To create a cross-reference format
A cross-reference format consists of a name and a definition. The definition
consists of building blocks and text. The definition for the format that might
appear in text as
See page 18 in Starting MetaForce 2.0
would look like this.
Text you type

Text you type

Text you type

See page <$pagenum> in <TitleFont><$paratext>.

Building block

Building blocks

You use text for words, punctuation, and regular and nonbreaking spaces. You
add text to a definition by typing it. Building blocks appear between angle
brackets (< and >). You add them by clicking in a list.
1

Choose Cross-Reference from the Special menu.

2

In the Cross-Reference dialog box, click Edit Format.

3

Name and define the format.

Type the name of the
format here.
Type text and insert building
blocks here.

Click a building block to
insert it in the definition.

Using FrameMaker
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Format names are case-sensitive; Page and page would be separate formats.
The complete definition, including typed text and building blocks, can be up to
255 characters long. You insert a building block in the Definition text box by
clicking it in the Building Blocks scroll list.
For information on using the building blocks, see “To insert a building block” on
page 10-13. For information on changing the format of a cross-reference, see “To
change a cross-reference format” on page 10-16.
4

Click Add, and then click Done.
TYPING SPECIAL CHARACTERS

An angle bracket (< or >) ordinarily signals a building block. To include an
angle bracket as text in a cross-reference definition, precede it with a
backslash (\).
A few FrameMaker characters are not part of the ISO Latin 1 character set
used in dialog boxes. As you type these characters in the Definition text box,
they appear as a backslash followed by one or two characters. These special
characters are displayed correctly when FrameMaker displays the crossreference in the document. For a list of these special characters, see Chapter 3,
“Character Sets,” in the Quick Reference.
IMPORTING CROSS-REFERENCE FORMATS

You can copy cross-reference formats from one document to another just as you
can copy paragraph formats. After opening both documents, choose
Import>Formats from the File menu of the document to which you are copying.
In the dialog box, identify the other document, turn on only Cross-Reference
Formats, and click Import. For information on importing formats into a
document, see “Importing formats into a document” on page 21-12. For
information on importing formats into documents in a book, see “To update the
format of files” on page 24-26.
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To insert a building block
FrameMaker provides three types of building blocks.
Building Blocks:
<$filename>
<$pagenum[paratag]>
<$paratext[paratag]>
<$paratag[paratag]>
<$paranum[paratag]>
<$paranumonly[paratag]>
<Default ¶ Font>

A source of a cross-reference
A paragraph that precedes a source

A character format

A building block that refers to the source of a cross-reference is indicated by a
dollar sign ($) and no square brackets ([ and ]). One that refers to a paragraph
that precedes a source is indicated by a dollar sign, with the tag of the
paragraph referred to enclosed in square brackets. One that refers to a format
in the Character Catalog has no dollar sign and no square brackets.
■

To refer to the source paragraph, insert a building block with a dollar sign and no
square brackets.
To include
Use this building block
..........................................................................

The page number of the source

<$pagenum>

The text of the source paragraph excluding
its autonumber

<$paratext>

The tag of the source paragraph

<$paratag>

The autonumber of the source paragraph
including any text in the autonumber format

<$paranum>

The autonumber of the source paragraph
excluding any noncounter text

<$paranumonly>

The full pathname of the source document

<$fullfilename>

The name of the source document

<$filename>

Using FrameMaker
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■

To refer to a paragraph preceding the source, insert a building block with a dollar sign
and square brackets.
To include
Use this building block
..........................................................................

The page number of the preceding
paragraph with the specified tag

<$pagenum[paratag]>

The text of the preceding paragraph with
the specified tag

<$paratext[paratag]>

The tag of the preceding paragraph with
the specified tag

<$paratag[paratag]>

The autonumber and any noncounter text
in the autonumber format of the preceding
paragraph with the specified tag

<$paranum[paratag]>

The autonumber excluding any noncounter
text of the preceding paragraph with the
specified tag

<$paranumonly[paratag]>

Replace the word paratag in the building block with the tag of the paragraph to
which you want to refer. Don’t delete the square brackets. To avoid confusing
FrameMaker, don’t use a paragraph tag with a name that includes square
brackets. For examples, see “Using preceding-paragraph building blocks” on
page 10-14.

USING PRECEDING-PARAGRAPH BUILDING BLOCKS
A cross-reference to a subsection often needs to
identify the section that contains it. For example, a
cross-reference to the subsection “Troubleshooting”
might identify the section “Assembling a Carafe”
where it is found:
See “Troubleshooting” in “Assembling a Carafe.”
In this cross-reference, “Troubleshooting” is the
source paragraph. If the paragraph tag for
“Assembling a Carafe” is 1Heading, the crossreference format would be the following:
See “<$paratext>” in
“<$paratext[1Heading]>.”
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The building block “<$paratext[1Heading]>.”
corresponds to the definition
“<$paratext[paratag]>.”
Alternatively, the cross-reference format could be
the following:
See “<$paratext>” in
“<paratext[ChapTitle, 1Heading]>.”
In this case, the format identifies
“Troubleshooting” with either chapter title
(ChapTitle) or section heading (1Heading),
whichever was closest to it. You can use this
feature for various effects.

■
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To change the character format of the text, insert a character format.

The Building Blocks scroll list includes all the formats in the Character Catalog
of the current document. A character format inserted in the definition applies to
all text between it and the next character format inserted. To avoid confusing
FrameMaker, don’t use a character tag with a name that includes angle
brackets.
If you don’t insert a character format in the definition, FrameMaker uses the
default font of the paragraph that contains the cross-reference. If you change
the character format for the cross-reference, the change applies only to the
cross-reference, not to the text following it in the paragraph. Insert
<Default ¶ Font> in the definition to return to the default font before the
end of the cross-reference.
For information on adding character formats to the Character Catalog, see “To
create a new character format” on page 5-18.
SOURCE AND CHARACTER-FORMAT EXAMPLES

Here are four cross-reference formats with examples of cross-references they
might produce. All the formats use source building blocks, and the last two use
character format building blocks.
For this cross-reference
Use this text and these building blocks
..........................................................................

page 23

page <$pagenum>

Chapter 4, “Distribution
Channels.”

Chapter <$paranumonly>,
“<$paratext>.”

Section 2.3.4, Product
Champions.

Section <$paranumonly>,
<Title><$paratext>.

See Training, next.

See <Title><$paratext>
<Default ¶ Font>, next.
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To chang e a cross-reference format
You may want to change the default cross-reference formats or the formats you
create yourself.
1

Choose Cross-Reference from the Special menu.

2

In the Cross-Reference dialog box, click Edit Format.

3

Select the format you want to change and edit the name or definition.

4

Click Change and then click Done.

Edit the format’s name
here.
Edit the format’s definition
here.

Select the format to edit
here.

FrameMaker displays the Update Cross-References dialog box. If the document
contains cross-references to other documents, click References to All Open
Documents or References to All Documents and then click Update. If the
document doesn’t contain cross-references to other documents, click Internal
Cross-References and then click Update.
After changing a cross-reference format, you can make the same change in
other documents by using the Import>Formats command. For more
information, see “Importing formats into a document” on page 21-12.
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DELETING A CROSS-REFERENCE FORMAT

To delete a cross-reference format, click Edit Format in the Cross-Reference
dialog box. In the dialog box that appears, select the format you want to delete
in the Formats scroll list, click Delete, and then click Done.
If you delete a cross-reference format that some cross-references in the
document use, FrameMaker asks whether you want to convert these crossreferences to text.
CHANGING THE FORMAT OF CROSS-REFERENCES IN TEXT INSETS

You can change the format of cross-references in a text inset if the inset uses
the formats of the document into which it is imported. If the inset uses formats
from the source document, you need to change the formats in the source
document. For more information on formatting text insets, see “Formatting an
imported text flow” on page 3-16.

MAINTAINING CROSS-REFERENCES
When you insert a cross-reference, FrameMaker supplies information from the
source—for example, the current page number or the paragraph of text. If you
edit the source of a cross-reference, the cross-reference may no longer be
accurate. If the pagination of your document changes, your cross-references
may also be inaccurate. In either case, FrameMaker needs to update the
information it supplies.
Normally, FrameMaker automatically updates all cross-references when you
open a document. It also updates all cross-references to open documents when
you print a document. But you can manually instruct FrameMaker to update if
you have edited a document or if you have suspended automatic updating to
improve performance. And whether or not updating is automatic, you need to
help with the update process when there are unresolved cross-references—
sources that FrameMaker can’t find.

Using FrameMaker
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To resolve a cross-reference after automatic updating
Normally, FrameMaker automatically updates cross-references when you open
or print a document. If FrameMaker can’t resolve a cross-reference during the
update, FrameMaker displays an alert. After dismissing it, you can resolve the
cross-references.
1

If the alert appears when you open the document, click Continue to dismiss it.

If the alert appears when you print the document, click Cancel.
2

Choose Update References from the Edit menu.

3

In the Update References dialog box, choose Update Unresolved Cross-References
from the Commands pop-up menu.

FrameMaker displays the Update Unresolved Cross-References dialog box.

The number of unresolved
references in the current
document

The number of unresolved
references whose source
was previously in the
selected document

In the example, there are four unresolved cross-references, and three of them
used to have their source in the current document.
4

Resolve the cross-reference.

If you think a source has been moved to another document or the document that
contains it has been moved, use the technique in “To resolve a cross-reference
when a marker is moved” on page 10-20 to resolve the cross-reference. If you
think the source should be in the document listed for it, use “To resolve a crossreference when a marker is deleted” on page 10-21.
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UPDATING CROSS-REFERENCES WHEN PRINTING

FrameMaker automatically updates all cross-references to open documents
when you print a document (if you haven’t suspended automatic updating).
FrameMaker updates cross-references to the versions of the open documents
that are saved to disk, not the versions saved in memory. To make sure that
FrameMaker updates cross-references that reflect changes you’ve made to the
open documents when you print, save the open documents prior to printing.

To suppress automatic updating
If a document contains many cross-references, you can improve its opening and
printing times by suppressing automatic updating. After suppressing automatic
updating, you can still update cross-references manually.
1

Choose Update References from the Edit menu.

2

In the Update References dialog box, choose Suppress Automatic Updating from the
Commands pop-up menu.

3

In the Suppress Automatic Reference Updating dialog box, turn on Suppress
Automatic Updating of All Cross-References and click Set.

4

In the Update References dialog box, click Done.

At this point, FrameMaker updates cross-references only on your instructions—
that is, manually. For information, see “To update cross-references manually,”
next.

To update cross-references manually
You should manually update all cross-references in a document routinely before
printing (if automatic updating is suppressed) or before distributing the
document. You should also update routinely after editing the document or
editing any other documents that are sources for the cross-references. For
information on updating cross-references in a book, see “Generating and
updating” on page 24-18.
1

Choose Update References from the Edit menu.

2

In the Update References dialog box, turn on All Cross-References and click Update.

If FrameMaker resolves all the cross-references, you’re finished. If
FrameMaker can’t resolve all the cross-references, it displays an alert. When
you click Continue in the alert box, FrameMaker displays the Update
Unresolved Cross-References dialog box.
If you think a source has been moved to another document or the document that
contains it has been moved, use the technique in “To resolve a cross-reference
when a marker is moved,” next, to resolve the cross-reference. If you think the
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source should be in the document listed for it, use “To resolve a cross-reference
when a marker is deleted” on page 10-21.
IF YOU’RE USING CONDITIONAL TEXT

FrameMaker can update all cross-references in the document except those with
markers in hidden conditional text. Show the text that contains the source of
the cross-reference before updating the cross-references.

To resolve a cross-reference when a marker is moved
FrameMaker can’t update a cross-reference if the marker indicating its source
is not in the expected file—for example, if the source has been moved to a
different file or the file itself has been moved or renamed. If FrameMaker
detects such an unresolved cross-reference during manual updating, it displays
the Update Unresolved Cross-References dialog box. For details, see “To update
cross-references manually” on page 10-19.
1

In the Update Unresolved Cross-References dialog box, select the file that used to
contain the source of an unresolved cross-reference and a file to look in for the
source.

Select the file that
contained the source here.

Select the file
that may now
contain the
source here.

In the example, there are four unresolved cross-references in the file. The
source for one of them used to be in the file Employees. If you renamed that
file NewEmployees, you can resolve the cross-reference by selecting
Employees in the Total of Unresolved Cross-References scroll list and
NewEmployees in the Look In scroll list.
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Click Update.

If FrameMaker can’t perform the update, select a different file in the Look In
scroll list if you think it might contain the source. If you can’t locate the file that
contains the source, the cross-reference marker may have been deleted. If you
think the source should be in the document listed for it, use the techniques in
“To resolve a cross-reference when a marker is deleted,” next, to resolve the
cross-reference.
You can resolve cross-references to any other file listed in the Total of
Unresolved Cross-References scroll list by redisplaying the Update Unresolved
Cross-References dialog box and repeating steps 1 and 2.
3

Click Done.

To resolve a cross-reference when a marker is deleted
FrameMaker can’t update a cross-reference if the marker indicating the source
is deleted. If FrameMaker detects such an unresolved cross-reference during
manual updating, it displays the Update Unresolved Cross-References dialog
box. For details, see “To update cross-references manually” on page 10-19.
If you no longer need the cross-reference because the source text itself was
deleted, you should delete the cross-reference. Otherwise, you should search for
the source text and insert a new marker in it.
1

In the Update Unresolved Cross-References dialog box, click Done.

2

Choose Find/Change from the Edit menu.

3

In the Find/Change window, choose Unresolved Cross-Reference from the Find
pop-up menu and click Find.

FrameMaker finds the first unresolved cross-reference and selects it. In the
Find/Change window, FrameMaker displays the marker text of the last-used
source marker for the cross-reference to help you locate the source.
4

If FrameMaker finds an unresolved spot cross-reference, insert a new cross-reference
marker in the appropriate text.

For details, see “To insert a spot cross-reference” on page 10-8. After inserting
the new cross-reference marker, you can continue the search for unresolved
cross-references just as you would continue any other search.
5

If FrameMaker finds an unresolved paragraph cross-reference, double-click the
cross-reference.
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6

In the Cross-Reference dialog box, specify a different source and click Replace.

Use the Source Type and Source Text scroll lists to specify the source. At this
point, you can continue the search for unresolved cross-references just as you
would continue any other search.
GENERATING A LIST OF UNRESOLVED CROSS-REFERENCES

There is another way to handle unresolved cross-references besides using the
Find/Change command. You can generate a list of unresolved cross-references.
The generated list indicates whether each missing source is internal (in the
current document) or external (in a different document). It also lists the
paragraph tag, text, and page number of the unresolved cross-reference. The
paragraph tag and text may be inaccurate because FrameMaker doesn’t update
them after you initially insert the cross-reference.
To generate the list, choose Generate/Book from the File menu. In the dialog
box that appears, choose List of References from the List pop-up menu and click
Generate. Move Unresolved Cross-Refs to the Include References scroll list and
click Generate. For more information, see “Generating a list of references” on
page 22-9.
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FrameMaker creates, numbers, and positions footnotes for you. You
simply identify the passage to be footnoted and type the footnote text.
You can define the footnote format or use the default definition.

You type directly on a body page
Creating a footnote is easy. FrameMaker puts the footnote reference
number where you want it, inserts a matching number for the footnote
itself at the bottom of the text column, and moves the insertion point to
a position right after the footnote number so you can begin typing. You
type on the body page itself, not in a separate window, so you see just
how the footnote will look.

The reference appears at
the insertion point.

You type the footnote text
next to the footnote
number.

Caffeine is an alkaloid present in green
coffee in amounts between 0.8 and 1.5
percent for the Arabic varieties.1

1. Journal of the International Coffee
Institute

Footnotes adapt to your revisions
FrameMaker footnotes keep up with even the most extensive revisions.
You never have to renumber them or cut and paste. If you insert a
footnote reference before another footnote reference, FrameMaker
adjusts the numbering and inserts the new footnote before the old one.
If you move or remove a paragraph that contains a footnote reference,
FrameMaker moves or removes the footnote and adjusts the
numbering.
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You can define the footnote format
The format of footnotes is determined by properties you can define. You
can change the paragraph format used for footnote text, number
continuously rather than start over on every page, use letters or
symbols rather than numbers, and so on.
Changes to some properties can change the look of your pages. For
example, you can change the maximum height the lines of footnote text
can reach, or you can change the space separating the main text from
the first footnote. You can also change the separator line that appears
in the space or even remove the line.
Caffeine is an alkaloid present in green
coffee in amounts between 0.8 and 1.5
percent for the Arabic varieties.1

Caffeine is an alkaloid present in green
coffee in amounts between 0.8 and 1.5
percent for the Arabic varieties.1

1. Journal of the International Coffee
Institute

1. Journal of the International Coffee
Institute

Two different separators

You can create table footnotes and endnotes
FrameMaker provides three alternatives to standard footnoting. You
can footnote individual table cells. (Footnotes appear at the end of a
table even if the table extends several pages.) You can refer to the same
footnote from several reference points in the main text or from several
cells in a table. And, if you don’t mind maintaining the notes, you can
create endnotes that appear at the end of the document.

In this chapter
This chapter shows you how to create footnotes and how to change the
format they use.
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CREATING A FOOTNOTE
When you create a footnote, FrameMaker places the footnote reference and the
footnote itself in the same text column. If the footnote reference moves to
another column or page, FrameMaker moves the footnote with it. Similarly,
when you insert a footnote reference in a table, FrameMaker places the footnote
at the end of the table. If the table flows onto a second page, all the footnotes
appear on the second page regardless of the page on which the footnote
reference appears.
You can create a single footnote that has several footnote references—for
example, a table footnote with references in several cells. You can also create
endnotes—notes that appear at the end of a document rather than at the foot of
a page.
Both these variants on the standard footnote employ a technique that uses
FrameMaker cross-references and autonumbers. For general information on
cross-references, see Chapter 10, “Cross-References.” For information on
autonumbers, see “Formatting lists” on page 4-36.

To insert a footnote
When you insert a footnote, you select a position for the footnote reference and
then type the text for the footnote. FrameMaker numbers the footnote, formats
the footnote text, and inserts a separator if the footnote is the first one in a
column.
1

Click where you want to place the footnote reference in the text.

You can insert a footnote reference in a column of text or in a table cell.
2

Choose Footnote from the Special menu.

FrameMaker inserts the footnote reference, displays the footnote number at the
bottom of the column or below the table, places the insertion point after the
footnote number, and renumbers any footnotes that follow.

The insertion point appears
after the number.

11-4

Using FrameMaker

3

.....

FOOTNOTES

Creating a footnote

Type the text of the footnote at the insertion point.

When you finish typing the footnote, you can return to the main text by clicking
in it or by choosing Footnote from the Special menu.
CHANGING OR DELETING A FOOTNOTE

You can change footnote text as you do any other text. You can’t, however,
change a footnote number because FrameMaker maintains the numbering. To
delete a footnote, select the footnote reference (not the footnote text) and press
Delete. FrameMaker deletes the reference, deletes the footnote, and renumbers
subsequent footnotes.
PLACING TWO FOOTNOTE REFERENCES TOGETHER

If you need to place two footnote references together, place a space or a comma
between them—for example, references 5 6 or references 5,6. Otherwise the
second footnote won’t be created. (If the footnote references are superscripted,
the space or comma between them should also be superscripted.)

FOOTNOTES IN MULTICOLUMN LAYOUTS
When a paragraph straddles columns, a footnote whose reference is above the
paragraph is positioned above or below the paragraph depending on the Across
All Columns setting in the Pagination properties of the Paragraph Designer.
If Across All Columns is on, the footnote appears below the straddle paragraph,
at the bottom of the text frame (which is typically the bottom of the page).
If Across All Columns is off, the footnote appears just above the straddle
paragraph, at the bottom of the column containing its reference.

1
1986 - 1990 Recordings
With the Across All
Columns setting on, the
footnote appears here.

1
1.

With the Across All
Columns setting off, the
footnote appears here.

1986 - 1990 Recordings

1.
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IF A FOOTNOTE DOESN’T FIT IN A COLUMN

FrameMaker tries to keep footnotes in the column where the corresponding
footnote reference appears. However, this isn’t always possible. For example, if
you insert a footnote reference at the bottom of a column of text so there is no
space for the footnote below it, FrameMaker moves the footnote to the bottom of
the next column. In such cases, forcing a column or page break before the
footnote reference keeps the reference and the footnote together in the same
column. You can also force column and page breaks by keeping paragraphs
together or by controlling widow and orphan lines. For more information, see
“To keep paragraphs together” on page 4-28 and “To control widow and orphan
lines” on page 4-28.
Also, adding text to a footnote may cause the last footnote in a column to move
to the bottom of the next column. To reduce the chance of a footnote not fitting
in a column, you can allocate more space for footnotes in a column. For
information, see “Maximum height per column” on page 11-10.

To insert additional references to a footnote
You may want several references to the same footnote. For example, you may
have several cells in a table that use the same footnote.
Table 1: New York
Type of Fund

Risk Level

Average Rate of Return

High-tech stocks

Very high

15.5%

Tax-free bonds

Lowa

6.8%

Money-market

Lowa

7.2%

a In a volatile market, “low-risk” becomes a relative term.

You can create multiple footnote references by inserting the first reference in
the usual way and then using cross-references for additional footnote references
to the same footnote.
1
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2

Create a cross-reference format for additional footnote references.

The format needs to display a particular number with a particular format.
FrameMaker displays the correct footnote number because the footnote itself is
an autonumbered paragraph. You, however, need to make sure that the number
looks like the footnote reference. For example, if you have created a character
format for superscript named Superscript, the cross-reference format
<Superscript><$paranumonly> displays the autonumber of a paragraph as
a superscript. When you use it to refer to a paragraph that contains a footnote,
it displays the footnote number in superscript.
3

Click where you want to insert the additional footnote reference.

4

Insert a cross-reference to the footnote where you clicked.

Choose Cross-Reference from the Special menu. In the Cross-Reference dialog
box, select the paragraph tag for document footnotes or table footnotes in the
Source Type scroll list, select the footnote to which you’re creating a crossreference in the Reference Source scroll list, and choose the cross-reference
format you created from the Format pop-up menu. Then click Insert.
FrameMaker inserts a cross-reference to the footnote that looks just like the
original footnote reference.
MAINTAINING CROSS-REFERENCES TO FOOTNOTES AFTER EDITING

After you edit a document, make sure that cross-references to footnotes are
accurate. For example, the cross-reference to the footnote reference may be
misnumbered, or the footnote—unless the reference is in a table—may be on
the wrong page. If the cross-reference is misnumbered, update the crossreferences in the document. If the footnote is on the wrong page, fix the page
break or move the footnote. For information on updating cross-references, see
“Maintaining cross-references” on page 10-17.

To insert endnotes
Endnotes appear at the end of a document rather than at the foot of a page or
table.
References

1
2
3

1

4
2
1

Footnotes

2

Endnotes
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You type the endnotes at the end of the document just as you would any other
paragraphs, give the endnote paragraph autonumbers, and then use crossreferences to the autonumbered paragraphs as endnote references. Because you
can cross-reference from either normal text or a table cell, this technique lets
you combine endnotes from passages of normal text and table cells in the same
set of endnotes.
1

Create an autonumber paragraph tag for endnotes.

For information on creating autonumber paragraphs, see “Formatting lists” on
page 4-36.
2

Create a cross-reference format for endnote references.

The cross-reference format needs to display a particular number with a
particular format. It also needs to make the number stand out from the
surrounding text. FrameMaker displays the correct endnote number because
the endnote itself is an autonumbered paragraph. For example, if you have
created a character format for superscript named Superscript, the crossreference format <Superscript>[<$paranumonly>] displays the
autonumber of a paragraph in square brackets and as a superscript.
3

Type the first endnote at the end of the document and assign it the paragraph tag for
endnotes.

4

Click where you want to insert the endnote reference and cross-reference the
endnote.

Use the cross-reference format you created for endnotes.
5

Create additional endnotes as you created the first one.

You don’t have to repeat the first two steps of this procedure for each additional
endnote. You can use the same autonumber paragraph format and crossreference format you created for the first endnote. Make sure that the sequence
of endnotes reflects the sequence of references in the document. This isn’t
automatic as it is with footnotes.
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MAINTAINING ENDNOTES

If you change the order of endnote references during revision of the text that
contains them, the order of the endnotes themselves doesn’t change. You have
to arrange them in the correct order yourself. Then you update the crossreferences to update the endnote reference numbers. For information on
updating cross-references, see “Maintaining cross-references” on page 10-17.
If you delete an endnote and not the reference to it, you’ll have an unresolved
cross-reference. Either delete the endnote reference or reinsert the endnote.
If you’re not willing to maintain the endnotes, you should use footnotes.
FrameMaker automatically maintains footnote order and numbering.

CHANGING THE FOOTNOTE FORMAT
If the footnote format you start with isn’t appropriate for your document, you
can change any of the footnote properties—the style of numbers, the numbering
format, or the paragraph format to use for footnote text, for example. And you
have complete control over the size and contents of the separator—the area
between the bottom of the column or table and the first footnote.
FrameMaker uses separate formats for document and table footnotes. If your
document includes both types of footnotes, you need to define document footnote
properties, table footnote properties, and separators for both types of footnotes.

To chang e footnote properties
When you change footnote properties, all new and existing footnotes use the
new properties. You can change the properties of the document footnotes, the
table footnotes, or both.
1

Click in a text frame or in a table cell.

Click in a text frame outside a table cell to change document footnote
properties. Click in a table cell to change table footnote properties.
2

Choose Document>Footnote Properties from the Format menu.

Depending on where you clicked, either the Footnote Properties dialog box or
the Table Footnote Properties dialog box appears.
For information on changing the values in the Footnote Properties or the Table
Footnote Properties dialog box, see the following sections.
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3

Change the properties of the footnote.

Type the paragraph format
to use for the footnote here.
Specify the numbering
style here.

Specify the look of the
footnote number here.

The Footnote Properties dialog box for document footnotes is illustrated. In the
Table Footnote Properties dialog box, you have the same options, except that
you can’t set the maximum space allowed for footnotes, start the numbering
over for each page, or indicate the starting footnote number.
4

Click Set.
MAXIMUM HEIGHT PER COLUMN

If adding another footnote causes the height of the footnotes plus the footnote
separator to exceed the maximum height per column, FrameMaker moves the
last footnote to the bottom of the following text column. You can adjust the
maximum height allowed by typing a different value in the Maximum Height
Per Column text box.
PARAGRAPH FORMAT

By default, documents include paragraph formats named Footnote and
TableFootnote. You can change the definitions of these formats to change the
look of footnotes.
You can also use other formats in the Paragraph Catalog for footnotes. To use
another paragraph format, type its name in the Paragraph Format text box.
The format in the Paragraph Format text box applies to new footnotes. To
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change the format of an existing footnote, apply a paragraph format to it
directly.
NUMBERING STYLE

You can choose a numbering style from the pop-up menu or type a style in the
Custom text box. The menu provides numbers and letters. Your custom style
can use any combination of numbers, letters, and symbols. Simply type them in
the order you want to use them. With document footnotes, you can start
numbering over on each page or number sequentially throughout the document.
When you number sequentially, you can start from any number. The numbering
of table footnotes starts over with each table. For details, see “More about
footnote numbering styles” on page 11-11.
NUMBERING FORMAT

You specify the format of the footnote reference in main text and the footnote
number in the footnote. Either number can be in the superscript, baseline, or
subscript position, and either can have a prefix and suffix. For example, the
following footnote places the footnote number in baseline position and uses a
period and space as a suffix to the footnote number.
1. Use footnotes sparingly.

MORE ABOUT FOOTNOTE NUMBERING STYLES
Numbers can be Arabic (numeric) or Roman. Both
Roman numerals and letters can appear in
uppercase and lowercase. The default numbering
style for document footnotes is numeric. The
default style for table footnotes is lowercase
letters.
You can use special character combinations to type
custom characters that don’t appear on the
keyboard; for example, press Control-q space to get
the dagger character (†). For a list of these
character combinations and for information on
typing them in a dialog box, see Chapter 3,
“Character Sets,” in the Quick Reference.

If you use symbols in a custom style and there are
more footnotes than symbols, the symbols are
repeated. For example, if you use the two symbols
* and † and there are three footnotes, the third
footnote is marked **.
*
†
**

*
†
**

The symbol is repeated.
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To chang e the separator
The footnote separator is a graphic frame automatically placed between the
bottom of the body text or table and the first footnote. It usually contains a line
or other design element to provide visual separation between the body text and
the footnotes. The height of the frame determines the space between the body
text or table and the footnote.
Separator frames for document and table footnotes are stored on a reference
page. Their names are the same as the paragraph formats used for these
footnotes—by default, Footnote and TableFootnote.
Caffeine is an alkaloid present in green
coffee in amounts between 0.8 and 1.5
percent for the Arabic varieties.1
Footnote
1. Journal of the International Coffee
Institute

Reference page

Body page

You can change these separators on the reference page.
For more information on using graphic frames on reference pages, see “Working
with reference pages” on page 19-22.
1

Choose Reference Pages from the View menu.

2

Display the page that contains the footnote separator frame.

3

Edit the frame or its contents.

You can change the size of the frame, change the size or position of the line in it,
or remove or replace the line. If you reduce the height of the frame, the first
footnote is positioned closer to the bottom of the text or table. If you move the
line downward in the frame, the first footnote stays in the same position but the
line moves closer to it.
4
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Variables represent text that will change—for example, the current
date—or text that may change—for example, a product name. Variables
save you the trouble of changing the text yourself. You can define your
own user variables or work with the FrameMaker system variables.

Variables are placeholders for text
Variables are useful when you expect the text to change often or when
you know the same text will be used in several places. For example, if
you insert a current date variable in a memo template, you don’t have
to type the date in memos that use the template. If you’re writing about
a product that has not yet been named, you can insert a name variable
wherever you refer to the product. When the name is finalized, you
don’t have to type the new name in all those places. You simply change
the variable in one place.

User and system variables provide flexibility
Two types of variables—user and system—give you complete flexibility
in the way you use placeholders. User variables, such as the product
name variable, are defined by you. System variables derive information,
such as the current date, from the computer system.

You name and define user variables
You create a user variable by naming and defining it. A definition is
made up of text and building blocks for the character format of the text.
For example, a product name variable defined as <Title>Primo Coffee
Maker would appear on the page as Primo Coffee Maker. If the
character format Title was defined as italic, the variable would appear
as Primo Coffee Maker.
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FrameMaker updates the values of system variables
FrameMaker provides the names and default definitions of system
variables. A system variable is defined by an arrangement of building
blocks that FrameMaker updates, by character format blocks, and by
text characters such as the comma and the spaces that appear in the
date May 1, 1995. You can edit the default definitions by changing the
format or text and by adding, removing, and rearranging blocks. With a
system variable, FrameMaker substitutes the current value for items in
the definition when it displays the variable in the document.

Running headers and footers use system variables
Running headers and footers contain page numbers, chapter titles, or
section headings that may change from page to page. You manage these
items by inserting variables in the headers and footers on a master
page—the nonprinting page that determines the design of the page.
FrameMaker provides the correct values for each body page.
This system variable
causes the current
section name to appear
on the body page.

Running H/F 1

Earthquake of 1906

Fire ravaged the city

Fire ravaged the city

Earthquake of 1906

This system variable
causes the current page
number to appear on the
body page.

#

Master page

14

15
15

Body pages

You can get other special header and footer effects by using variables
with paragraph autonumbers, markers, and condition tags.

In this chapter
This chapter shows you how to work with user and system variables. It
also shows you how to create running headers and footers with system
variables. It provides a list of system variables and their definitions on
page 12-11 and a list of building blocks used in date and time variables
on page 12-17.
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WORKING WITH USER VARIABLES
When you create a user variable, first you give it a name and then you define it.
The definition includes the text of the variable and any character formatting it
needs. When you insert the variable, FrameMaker displays its value—the text
in the character format you specified. If you insert the variable in several places
in the document, the same text and format appear at each place.
The FrameMaker templates don’t provide any user variables. If you’re using
one of these templates, you have to create your own user variables. If you’re
using a template created at your site, it may already include some user
variables.
You can change the definition of any user variable. For example, if you’re using
a variable to represent the name of a product that will change later in the
development cycle, you’ll need to change the definition of the variable when the
name is finalized. When you change the definition, FrameMaker updates all
occurrences of the variable in your document to use the new definition.
You can’t edit occurrences of the variable directly in a document. To change the
variable, you change its definition, or you convert it to text and then edit it in
the document. If you convert it to text, however, FrameMaker no longer
considers the text a variable.

To insert a user variable
You can insert a user variable on any type of page in a FrameMaker document.
If you know the name of the variable you’re inserting, you can use a keyboard
shortcut.
When you insert a user variable, its value is displayed at the insertion point.
You can move it, replace it with another variable, or delete it. You can delete a
single instance of the variable you inserted or delete it entirely—name and
definition—from the document.
1

Click where you want to insert the variable.

You can insert a variable in a text frame but not in a text line.
2
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Select a variable in the Variables scroll list and click Insert.

Variables appropriate for
the current page appear
here.

The definition of the
selected variable appears
here.

The user variables appear in the scroll list after the system variables. The last
system variable is Table Sheet.
KEYBOARD SHORTCUT

Click where you want to insert the variable and press Control-0 (zero). The Tag
area on the left side of the status bar prompts you for a variable name.

The highlighted Tag area
prompts you to type a tag.

Start typing the variable name. You may need to type only a few characters
before the name appears in the Tag area. Type lowercase letters to search
forward; uppercase to search backward. You can also use the up arrow and
down arrow keys to scroll through variables. Press Return to insert the variable
in the document or, if you decide to cancel the operation, click in the document
without pressing Return.
You need to type only enough letters to identify the variable uniquely. For
example, if there is only one variable beginning with P (such as ProductName),
the phrase ProductName appears in the Tag area when you type P.
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MOVING OR REPLACING A USER VARIABLE

When you click a variable, FrameMaker selects the variable. You can then copy
or move the variable just as you do editable text—by using the Cut, Copy, and
Paste commands.
You can replace an existing variable. First, double-click the variable to display
the Variable dialog box. Then select a different variable in the Variables scroll
list and click Replace.
DELETING A USER VARIABLE

To delete a single occurrence of a user variable, select the variable and press
Delete. To delete the variable definition from the document, start by selecting
the user variable in the Variable dialog box and clicking Edit Definition. In the
dialog box that appears, click Delete and then click Done. FrameMaker converts
all occurrences of the variable in your document to editable text. At that point,
FrameMaker no longer considers the text a variable.

To create a user variable
Before you create a user variable, you need to decide on the name of the
variable, the text it will contain, and the character format of the text.
For example, you might create a user variable for a product name that may
change or for a long manual name that is difficult to type. You can also change
the character format within the variable definition.
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Click in a text frame.

2

Choose Variable from the Special menu.

3

In the Variable dialog box, click Create Variable.
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Type the name and definition of the variable.

Type the name here.

Type text and insert
character formats here.

Variable names are case-sensitive; Product and product would be separate
variables. The complete definition, including typed text and character formats,
can be up to 255 characters long. You insert a character format in the Definition
text box by clicking it in the Character Formats scroll list.
5

Click Add.

The variable appears in the User Variables scroll list. To add more user
variables, repeat step 4.
6

Click Done to return to the Variable dialog box.

FrameMaker adds the user variable or variables to the document. If you decide
not to add the variables, click Cancel rather than Done.
FORMATTING CHARACTERS IN THE DEFINITION

The Character Formats scroll list includes all the formats in the Character
Catalog of the current document. A character format inserted in the variable
definition applies to all text between it and the next character format inserted
or to the end of the variable. To avoid confusing FrameMaker, don’t use a
character format with a name that includes angle brackets.
If you don’t insert a character format in the definition, FrameMaker uses the
default font of the paragraph that contains the variable. If you change the
character format for the variable, the change applies only to the variable, not to

Using FrameMaker

12-7

VARIABLES

12

Working with user variables

the text following it in the paragraph. Insert <Default ¶ Font> in the
definition to return to the default font before the end of the variable.
TYPING SPECIAL CHARACTERS

An angle bracket (< or >) ordinarily signals a character format. To include an
angle bracket in a variable definition as text, precede it with a backslash (\).
A few FrameMaker characters are not part of the ISO Latin 1 character set
used in dialog boxes. As you type these characters in the Definition text box,
they appear as a backslash followed by one or two characters. These special
characters are displayed correctly when FrameMaker displays the variable in
the document. For a list of these special characters, see Chapter 3, “Character
Sets,” in the Quick Reference.
IMPORTING USER VARIABLES

When another document already has user variable definitions you want to use,
you can copy those definitions to your document or to files in a book by using the
Import>Formats command on the File menu. For information on importing
formats into a document, see “Importing formats into a document” on
page 21-12. For information on importing formats into documents in a book, see
“To update the format of files” on page 24-26.

To chang e the definition of a user variable
You can change the name or the definition of a user variable before or after you
insert the variable in a document. For example, if you have a user variable that
defines a product code name, you’ll eventually need to change the definition of
the variable to the final product name.
When you change a user variable, FrameMaker immediately updates the
variable throughout the document. If the user variable appears in the header or
footer on a master page, you may need to redisplay the page to see the update.
1

Click in a text frame.

2

Choose Variable from the Special menu.

3

In the Variable dialog box, select a user variable in the Variables scroll list and click
Edit Definition.

When you select a variable, its name and definition appear in the text boxes.
4

In the Edit User Variable dialog box, change the variable name or the definition.

To change the variable name, edit the text in the Name text box.
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To change the user variable definition, edit the text in the Definition text box.
For information on user variable definitions, see “To create a user variable” on
page 12-6.
5

Click Change.

6

Click Done to return to the Variable dialog box.

FrameMaker changes the definition of the user variable in the document. If you
decide not to change the variable definition, click Cancel rather than Done.
VARIABLES IN TEXT INSETS

If the variable resides in a text inset that doesn’t use the current document’s
formats, you need to change the variable in the source document. For
information on text insets and their formatting options, see “Importing text” on
page 3-12.
CONVERTING A USER VARIABLE TO TEXT

If you no longer want text in your document to be treated as a variable, you can
convert the variable to text. You can then edit the text. However, FrameMaker
no longer updates the text if the variable definition changes.
Except for variables in text insets, you can convert all the variables in a
document, all the occurrences of a particular variable in a document, or a single
variable. To convert a single variable, double-click it; otherwise, click in the
document. Then click Convert to Text in the Variable dialog box, indicate the
range of variables to convert, and click Convert.

WORKING WITH SYSTEM VARIABLES
FrameMaker documents come with a set of system variables. You can’t add to
the set, delete a variable from it, or rename a variable. The system used by
these system variables is FrameMaker and your computer system working
together. The variables display information that FrameMaker or your computer
system generates—for example, the current page number, the page count of the
document, the current date.
Each system variable has a name and a definition. You can’t change the name of
a system variable, but you can change the definition—for example, the way the
current date is displayed. For a complete list of the system variables and their
default definitions, see “Default values for system variables” on page 12-11.
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Probably the most common way to use system variables is in background text
frames. (A background text frame is on a master page and doesn’t have a flow
tag.) FrameMaker shows whatever is in these text frames on the corresponding
body pages. For example, by inserting the appropriate system variable in
background text frames, you can display the filename at the foot of every page
in a document or have FrameMaker number the pages automatically.

You can insert system
variables in any
background text frame...

...including a footer text
frame.

#

/usr/doc/survey

Master page

16

/usr/doc/survey

Body page

You also use system variables for running headers and footers, which can give
information about the contents of a page and so can change from page to page.
For details, see “Using system variables in headers and footers” on page 12-18.
For information on master pages and background text frames, see “Creating
headers and footers” on page 18-10.
FrameMaker automatically updates the value of system variables inserted on
master pages. For example, when the value of the current date changes,
FrameMaker updates all occurrences of the variable throughout the document.
However, if you place a system variable on a body or reference page,
FrameMaker automatically updates the value of the variable only when you
open or print the file. You can manually update the value of the variable when
the file is open.

To insert a system variable
You can insert a system variable in any text frame. If you know the name of the
variable you’re inserting, you can use a keyboard shortcut.
When you insert a system variable, its value is displayed at the insertion point.
You can move it, replace it with another variable, or delete it.
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Click where you want to insert the variable.

For most system variables, you can click in any text frame.
If you’re inserting the Current Page # or a running header or footer variable,
you must click in a background text frame on a master page. For information,
see “Using system variables in headers and footers” on page 12-18.
2

Choose Variable from the Special menu.

DEFAULT VALUES FOR SYSTEM VARIABLES
Most of the system variables can be inserted in any text frame on a body, reference, or master page. The
Current Page # and Running H/F 1, Running H/F 2, Running H/F 3, and Running H/F 4 variables can be
inserted only in a background text frame on a master page.
System variable
Default definition (US version)
Sample display
...................................................................................................

Current Page #

<$curpagenum>

3

Page Count

<$lastpagenum>

18

Current Date (Long)

<$monthname> <$daynum>, <$year>

October 11, 1995

Current Date (Short)

<$monthnum>/<$daynum>/<$shortyear> 10/11/95

Modification Date (Long)

<$monthname> <$daynum>, <$year>,
<$hour>:<$minute00> <$ampm>

Modification Date (Short)

<$monthnum>/<$daynum>/<$shortyear> 9/24/95

Creation Date (Long)

<$monthname> <$daynum>, <$year>

Creation Date (Short)

<$monthnum>/<$daynum>/<$shortyear> 7/1/95

Filename (Long)

<$fullfilename>

/usr/biff/memos/staffing

Filename (Short)

<$filename>

staffing

Running H/F 1

<$paratext[Title]>

The Turbulent Oceans

Running H/F 2

<$paratext[Heading1]>

Threat of Extinction

Running H/F 3

<$marker1>

Inspection Checklist

Running H/F 4

<$marker2>

Drawing Objects

Table Continuation

(Continued)

(Continued)

Table Sheet

(Sheet <$tblsheetnum> of
<$tblsheetcount>)

(Sheet 1 of 2)

September 24, 1995, 10:48 am

July 1, 1995
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3

Select a system variable in the Variables scroll list.

Variables appropriate for
the current page appear
here.

The definition of the
selected variable appears
here.

FrameMaker lists the variables allowed at the insertion point in the document.
For example, if the insertion point is in a text frame on a body page,
FrameMaker doesn’t display the current page variable.
4

Click Insert.

In most cases, FrameMaker displays the value of the variable on both the
master and the corresponding body pages. However, if you insert the page
number variable, FrameMaker displays a number sign (#) on the master page
and the actual page number on the body page.
KEYBOARD SHORTCUT

Click where you want to insert the variable and press Control-0 (zero). The Tag
area on the left side of the status bar prompts you for a variable name.

The highlighted Tag area
prompts you to type a tag.

Start typing the variable name. You may need to type only a few characters
before the name appears in the Tag area. Type lowercase letters to search
forward; uppercase to search backward. You can also use the up arrow and
down arrow keys to scroll through variables. Press Return to insert the variable
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in the document or, if you decide to cancel the operation, click in the document
without pressing Return.
You need to type only enough letters to identify the variable uniquely. For
example, if there is only one variable beginning with P (such as Page Count),
the phrase Page Count appears in the Tag area when you type P.
MOVING, REPLACING, OR DELETING A SYSTEM VARIABLE

When you click a variable, FrameMaker selects the variable. You can then copy
or move the variable just as you do editable text—by using the Cut, Copy, and
Paste commands. You can delete it by pressing Delete.
You can replace an existing variable. First, double-click the variable to display
the Variable dialog box. Then select a different variable in the Variables scroll
list and click Replace.
UPDATING A SYSTEM VARIABLE ON BODY OR REFERENCE PAGES

FrameMaker automatically updates the values of system variables on body and
reference pages whenever you open or print the file. If the value of a variable
changes after you open or print the file, you can update the variable again by
clicking Update in the Variable dialog box. If you change the definition of the
variable, FrameMaker immediately updates the variable throughout the
document, regardless of the type of page on which the variable occurs.

To chang e the definition of a system variable
You can change the definition of a system variable before or after you insert
the variable in a document. The definition of a system variable is similar to the
definition of a cross-reference format. It consists of building blocks and text.
The definition that might appear in a table title as Sheet 3 of 5 would look
like this.
Text you type

Text you type

Text you type

(Sheet <$tblsheetnum> of <$tblsheetcount>)

Building block

Building block

You use text for words, punctuation, and regular and nonbreaking spaces. You
add text to a definition by typing it. Building blocks appear between angle
brackets (< and >). You add them by clicking in a list.
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When you change the definition of a variable, FrameMaker immediately
updates the variable throughout the document, regardless of the type of page
on which the variable occurs.
1

Click in a text frame.

For most system variables, you can click in any text frame. If you’re changing
the definition of the Current Page # or a running header or footer variable, you
must click in a background text frame on a master page. For information, see
“Using system variables in headers and footers” on page 12-18.
2

Choose Variable from the Special menu.

3

In the Variable dialog box, select a system variable in the Variables scroll list and click
Edit Definition.

4

Redefine the variable.

Type text and insert building
blocks here.

Building blocks appropriate
for the variable are listed
here.

A definition can contain typed text and building blocks. The complete definition,
including typed text and building blocks, can be up to 255 characters long. You
insert a building block in the Definition text box by clicking it in the Building
Blocks scroll list.
The building blocks displayed in the scroll list depend on the system variable
you’re editing. For example, if you’re editing the Page Count variable, the
<$curpagenum> and <$lastpagenum> building blocks are displayed. If
you’re editing the filename variables, the <$fullfilename> and
<$filename> building blocks are displayed.
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Click Edit in the Edit System Variable dialog box.

FrameMaker makes the change throughout the document. If the variable
appears on the current page, and if you inserted the variable on a master page,
FrameMaker won’t update the value until it redraws the page. To redraw the
current page, page forward and back a page.
FORMATTING CHARACTERS IN THE DEFINITION

The Building Blocks scroll list includes all the formats in the Character Catalog
of the current document. A character format inserted in the variable definition
applies to all text between it and the next character format inserted or to the
end of the variable. To avoid confusing FrameMaker, don’t use a character
format with a name that includes angle brackets.
If you don’t insert a character format in the definition, FrameMaker uses the
default font of the paragraph that contains the variable. If you change the
character format for the variable, the change applies only to the variable, not to
the text following it in the paragraph. Insert <Default ¶ Font> in the
definition to return to the default font before the end of the variable.
For information on adding character formats to the Character Catalog, see “To
create a new character format” on page 5-18.
TYPING SPECIAL CHARACTERS

An angle bracket (< or >) ordinarily signals a building block. To include an
angle bracket in a variable definition as text, precede it with a backslash (\).
A few FrameMaker characters are not part of the ISO Latin 1 character set
used in dialog boxes. As you type these characters in the Definition text box,
they appear as a backslash followed by one or two characters. These special
characters are displayed correctly when FrameMaker displays the variable in
the document. For a list of these special characters, see Chapter 3, “Character
Sets,” in the Quick Reference.
IMPORTING SYSTEM VARIABLES

When another document already has system variable definitions you want to
use, you can copy those definitions to your document or to files in a book by
using the Import>Formats command on the File menu. For information on
importing formats, see “Importing formats into a document” on page 21-12. For
information on importing formats into documents in a book, see “To update the
format of files” on page 24-26.
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VARIABLES IN TEXT INSETS

If a variable resides in a text inset that uses the source document’s formats, you
need to change the variable in the source document. For information on text
insets and their formatting options, see “Importing text” on page 3-12.
CONVERTING A SYSTEM VARIABLE TO TEXT

If you no longer want text in your document to be treated as a variable, you can
convert the variable to text. You can then edit the text. However, FrameMaker
no longer updates the text if the variable definition changes.
Except for variables in text insets, you can convert all the variables in a
document, all the occurrences of a particular variable in a document, or a single
variable. To convert a single variable, double-click it; otherwise, click in the
document. Then click Convert to Text in the Variable dialog box, indicate the
range of variables to convert, and click Convert.

To chang e the styles of dates a nd times
You can use system variables for the current date, the date the document was
last modified, and the date the document was created. There are long and short
versions of each date, and FrameMaker provides variable building blocks for
fine-tuning the definitions of the six variables. The building blocks display
seconds, minutes, and hours as well as days, months, and years. For details, see
“Date and time building blocks” on page 12-17. The default values of the six
variables are listed in “Default values for system variables” on page 12-11.
As with all system variables, FrameMaker automatically updates the value of
the variable as long as you insert the variable in a background text frame on a
master page. However, when you insert the variable on a body or reference
page, you may need to update the variable yourself. For more information, see
“Updating a system variable on body or reference pages” on page 12-13.
■

To display the current date, insert the Current Date (Long) or Current Date (Short)
variable.

FrameMaker updates the values of these variables whenever it redraws a
page—for example, when zooming or when changing pages.
■

To display the date the file was created, insert the Creation Date (Long) or Creation
Date (Short) variable.

FrameMaker sets the values of these variables when you create a document by
using the New command.
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To display the date the document was last modified, insert the Modification (Long) or
Modification (Short) variable.

FrameMaker updates the values of these variables whenever you save or print
a document.

DATE AND TIME BUILDING BLOCKS
You can redefine the six date and time variables by using the building blocks listed below.
Building block
What it displays
Example
...................................................................................................

<$second>

Seconds

8 or 32

<$second00>

Seconds with a zero placeholder for numbers smaller than 10

08 or 32

<$minute>

Minutes

8 or 32

<$minute00>

Minutes with a zero placeholder for numbers smaller than 10

08 or 32

<$hour>

Hours

8 or 12

<$hour01>

Hours with the zero placeholder for numbers smaller than 10

08 or 12

<$hour24>

Hours between 01 and 24

08 or 22

<$ampm>

The morning or evening designation using lowercase letters

am or pm

<$AMPM>

The morning or evening designation using uppercase letters

AM or PM

<$daynum>

The number of the day

8 or 28

<$daynum01>

The number of the day with the zero placeholder for numbers
smaller than 10

08 or 28

<$dayname>

The name of the day

Monday

<$shortdayname>

The abbreviated name of the day

Mon

<$monthnum>

The number of the month

8 or 12

<$monthnum01>

The number of the month with the zero placeholder for numbers
smaller than 10

08 or 12

<$monthname>

The name of the month

August

<$shortmonthname>

The abbreviated name of the month

Aug

<$year>

The year

1995

<$shortyear>

The abbreviated year

95
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CHANGING THE LANGUAGE

FrameMaker uses the language of the current paragraph to determine the
language used in date and time system variables. For example, the current date
variable may appear as 10 December 1995 in an English paragraph but as
10 Dezember 1995 in a German paragraph. If you change the language of a
paragraph, FrameMaker updates the system variables in the paragraph to use
the new language.

USING SYSTEM VARIABLES IN HEADERS
AND FOOTERS
A running header or footer variable gives information about the contents of a
page and so can change from page to page. For example, you can include
information such as the manual title, the number and title of the current
chapter, the name of the current first-level section, and the current page
number in the running headers and footers.
Running headers and footers use system variables such as the current page and
current date variables. They also use four system variables provided especially
for running headers and footers.
One of four variables
provided for running
headers and footers

Running H/F1

Master page

Undersea Study

Body page

The value of a running header or footer variable can be a paragraph with a
particular tag—usually a title or heading paragraph—or marker text. You can
use these variables with their default definitions, or you can customize them—
for example, by changing the heading paragraph tag that appears in the
running header.
Keep in mind that a system variable has both a name and a definition. With
running header and footer variables, the name appears on the master page; the
value on each body page depends on the definition and the contents of the page.

To insert a variable in a running header or footer
You insert a running header or footer variable in a background text frame on a
master page. The techniques for inserting a variable are the same whether the
variable has the default definition or a custom definition. But it makes sense to
insert the variable before you customize, because it’s easier to perfect the
definition of the variable when it’s already in place.
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For information on customizing the definition of a running header or footer
variable, see “To display the text, autonumber, or tag from a paragraph” on
page 12-20, “To display text from a marker” on page 12-22, “To display a
condition tag” on page 12-23, or “To create dictionary-style headers or footers”
on page 12-24.
1

Choose Master Pages from the View menu.

2

Click in a background text frame.

If you are using blank paper, you see default header and footer text frames. If
no header or footer text frames are included, you can draw your own. You can
also move or resize the text frames to match the design of your document.
3

Choose Variable from the Special menu.

4

Select one of the running header/footer variables in the Variables scroll list.

The definition of the
selected variable refers to a
paragraph tagged Title.

By default, the Running H/F 1 and Running H/F 2 variables use definitions that
refer to paragraphs. The Running H/F 3 and Running H/F 4 variables use
definitions that refer to markers. You can change these default definitions as
necessary.
5

Click Insert.

FrameMaker displays the name of the variable on the master page and the text
of the running header or footer on the body page.
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To display the text, autonumber, or tag from a paragraph
The most common application of running headers and footers is to refer to a
paragraph by its tag and show the text, autonumber, or tag from that
paragraph. For example, a running header might be the current section
heading or the chapter number. For more examples, see “More text,
autonumber, and tag examples” on page 12-20.
FrameMaker searches on each body page to find a paragraph with the tag you
specify and then puts the paragraph’s text, autonumber, or tag in the running
header or footer for that page. If a page doesn’t contain a paragraph with the
tag you specify, FrameMaker searches backward through the preceding pages
and uses information from the first appropriate paragraph it finds.
1

Insert a variable in the header or footer.

MORE TEXT, AUTONUMBER, AND TAG EXAMPLES
Here are some examples of variables in running headers and footers that use paragraph tags.
Running header/footer
variable definition
Sample display
Explanation
...................................................................................................

<$paratext[1Heading]>

Changing a Filter

The text of the first paragraph FrameMaker finds
with the tag 1Heading

<Header><$paratext
[1Heading]>

CHANGING A
FILTER

The text of the first paragraph FrameMaker finds
with the tag 1Heading; the text appears in the
Header character format—uppercase, italic letters

<$paranum[1Heading]>

Chapter 2

The complete autonumber definition of the first
paragraph FrameMaker finds with the tag
1Heading

<$paranumonly[1Heading]>

2

Just the autonumber of the first paragraph
FrameMaker finds with the tag 1Heading

<$paratag[1Heading]>

1Heading

The tag of the first paragraph FrameMaker finds
with the tag 1Heading

<$paratext[ChapTitle,
AppendixTitle]>

Filters

The text of the first paragraph FrameMaker finds
with either the ChapTitle or AppendixTitle tag

<$condtag[Retail,
Wholesale,No Prices]>

Retail

The condition tag of the condition currently
showing; if both conditions are hidden, the text
No Prices appears
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Edit the definition of the variable so that it includes a building block that uses
[paratag].

The table explains the four [paratag] building blocks.
To show this from the paragraph
Use this building block
..........................................................................

The text

<$paratext[paratag]>

The autonumber including any text in the
autonumber format

<$paranum[paratag]>

The autonumber excluding any noncounter
text in the autonumber format

<$paranumonly[paratag]>

The paragraph tag

<$paratag[paratag]>

Replace the word paratag in the building block with the tag of the paragraph
for which you want to display information. Don’t delete the square brackets. To
avoid confusing FrameMaker, don’t use a paragraph format with a name that
includes square brackets.
MORE THAN ONE TAG

You can include more than one paragraph tag in the [paratag] part of a
building block. When you include multiple paragraph tags, FrameMaker
searches the current page and then backward in the document and uses the
first paragraph it finds with one of the tags. If a page contains multiple
paragraphs with the tags, FrameMaker uses the paragraph closest to the top of
the page. Separate the tags with commas as in the following example:
<$paratext[1Heading,2Heading]>
This building block lets you include different levels of headings in the same
header or footer.
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To display text from a marker
If the text you want to show in a header or footer doesn’t appear in a paragraph
of its own, you can show text associated with a marker. For example, you can
use a marker to show an abbreviated version of a title or to summarize the
contents of a page.
Inspection Checklist

Primo Coffee Systems:
Inspection Checklist
Follow these steps carefully, checking
each item as you go, to complete final
inspection of Espresso units.

Inspection Checklist is
specified as the marker text.

FrameMaker searches for a marker just as it does for a paragraph tag,
searching the current page and then backward from the current page until it
finds an occurrence of the marker.
1

Insert a variable in the header or footer.

By default, the Running H/F 3 and Running H/F 4 variables use definitions
that look for markers.
2

Edit the definition of the variable to use a <$marker1> or <$marker2> building
block.

The <$marker1> building block displays the text of a Header/Footer $1
marker. The <$marker2> building block displays the text of a
Header/Footer $2 marker.
3

Display a body page and click where you want to insert a marker.

4

Choose Marker from the Special menu.

5

Choose one of the marker types, type the marker text, and click New Marker.

Choose
Header/Footer $1 or
Header/Footer $2 here.

Type the marker text here.
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When you type the marker text, make sure that the spaces, punctuation, and
capitalization are as you want them. You can’t format the marker text in the
Marker Text text box. To format the marker text, insert a character format
building block before the marker building block in the system variable
definition.

To display a condition tag
In a document that uses conditional text, you can show a condition tag that
appears on the current page in the running header or footer. FrameMaker
doesn’t include a predefined variable for this purpose, but you can redefine any
of the existing running header and footer variables to use the conditional tag
building block. Unlike the system variables that refer to a paragraph or a
marker, variables with the conditional tag building block search only on the
current page.
1

Insert a variable in the header or footer.

2

Edit the definition of the variable to use the <$condtag [hitag,...,lotag,
nomatch]> building block.

Replace hitag, lotag, and the ellipsis with one or more condition tags you want
FrameMaker to look for. Replace nomatch with the text you want to display if
FrameMaker doesn’t find one of the tags in the definition. If you don’t want to
display any text when there’s no match, type a nonbreaking space (press
Control-space) in place of nomatch.
FrameMaker searches a page for the tags you specify. If it finds one of the tags,
the tag appears in the running header or footer. If it finds more than one tag,
the tag that comes earliest in the definition appears.
USING CONDITION TAGS FOR CLASSIFIED INFORMATION

If your document contains classified information, you can apply condition tags
such as Top Secret and Secret to the classified information. Then set up the
header or footer of the document to include the Top Secret or Secret condition
tag on the pages that contain classified information. To have FrameMaker
display Top Secret on pages with both Top Secret and Secret information and
Unclassified on pages with neither condition tag, define the building block as
<$condtag[Top Secret,Secret,Unclassified]>.
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To create dictionary-style headers or footers
If you’re setting running headers or footers in a document such as a
dictionary, an index, or a glossary, you can use dictionary headers or footers
to show the range of information that appears on one body page or on two facing
body pages.
Abacus

This header shows the first
entry on the left page.

Frame

This header shows the last
entry on the right page.

Abacus
Cycle

Data
Frame

Bit
Edition

1

Insert two variables in the headers or footers of two facing master pages.

For example, you can insert Running H/F 1 on the left master page and
Running H/F 2 on the right master page.
2

3

Edit the definition of the variable on the left master page to use the
<$paratext[paratag]> building block.
Edit the definition of the variable on the right master page to use the

<$paratext[+,paratag]> building block.
Replace paratag with the paragraph tag of dictionary terms in both variables.
The plus sign (+) on the right master page tells FrameMaker to find the last
paragraph on the page matching the tag rather than the first paragraph.
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You illustrate a document by using the FrameMaker drawing tools—
working with objects such as straight and curved lines, circles,
polygons, text lines, and text frames.

You draw and combine objects to create illustrations
An illustration usually includes several objects. Some objects, such as
the straight lines in the following illustration, stand alone. Others are
combined into more complex shapes.

JAZZMATAZZ

This line of text is an object.
This is a grouping of three objects—two rectangles
and an ellipse—with a gray fill pattern.
The top and bottom lines are also objects.

Text lines, such as the one in the illustration, are separate objects. You
can also add text frames to your illustration for text that flows from line
to line.

You can draw anywhere you wish
You can draw objects anywhere on a page and run the document text
around the objects. Objects you draw on a page don’t move as you edit
text. If you want an illustration to move with the surrounding text, you
must put the object in an anchored frame.

13-2
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You use the Tools palette and grids as you draw
When you draw, you choose the tool and properties you want on the
Tools palette. Use the snap grid and Gravity to help you draw and
position objects.

Selection and drawing tools

Fill and pen patterns

Line widths, line ends, and
dashed line styles
Color

You choose properties for different effects
You can change the properties of any object. For example, you can
change the thickness of lines, make them dashed rather than solid,
make the ends rounded, and even add arrowheads. You can also change
the fill pattern of objects using shades of gray or patterns included with
FrameMaker, and you can change the color.
You can choose the properties an object will have before you draw it, or
you can draw first and change the object’s properties later.

In this chapter
This chapter shows you how to display the Tools palette; set up the
grids; draw objects, select them, and change their properties; add text;
and customize settings on the Tools palette.

Using FrameMaker
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Chapter 14 shows you how to work and rework objects to polish your
illustrations. It explains how to resize, reshape, flip, and rotate objects,
and how to align objects, distribute them equally apart, and group them
together. Chapter 15 shows you how to anchor graphics to text.

SETTING UP THE DRAWING ENVIRONMENT
Before you draw or edit objects, take a few moments to set up your drawing
environment—the Tools palette and the drawing grids.
The Tools palette contains drawing tools. It also contains pop-up menus you use
to change an object’s properties. You can use a larger Tools palette if you have
room on the screen. Individual patterns and other settings are visible on the
large Tools palette, as are some commands from the Graphics menu.
Grids—a visible grid and an invisible snap grid—are available as drawing aids.
The visible grid appears on the screen but does not appear in the printed
document. You use the visible grid as a guideline when you draw or arrange
objects.

Visible grid
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The invisible snap grid has magnetic properties. As you draw, move, resize, or
reshape objects on the screen, they snap to the invisible grid. As you rotate
objects, they snap to the rotation grid. The snap grid can help you draw objects
that are the same size and that are aligned with one another.
As an object is moved closer to a
point on the invisible snap grid,
the object is automatically
aligned with the snap grid.

You can choose your own spacing for the grids.

To display the Tools palette
You usually have the Tools palette open as you draw or edit objects.
■

Choose Tools from the Graphics menu.

■

Click the Tools button

at the right side of the document window.

To display the large Tools palette
If you have room on your screen, you may prefer to use the large Tools palette.

Selection and drawing tools

Fill and pen patterns

Graphics commands

Color

Gravity and Snap

Line widths, ends, and
dashed line styles

Tools palette toggle

Using FrameMaker
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Fill patterns, pen patterns, line widths, line ends, and dashed line styles are
visible on the palette. When you want to change an object’s properties, you can
click the setting you want rather than choose it from a pop-up menu as you do
on the small Tools palette. Also, the large Tools palette includes many of the
commands from the Graphics menu. You choose a command on the palette by
clicking it.
■

To display the large Tools palette, click the Tools palette toggle
Tools palette.

on the small

■

To change back to the small Tools palette, click the Tools palette toggle on the large
Tools palette.

To turn the grids on and off
When you turn on the visible grid, grid lines appear in the margins of a page
and in frames. When the fill pattern of a text frame is None, the page’s grid
lines also appear through the text frame. When you turn on the snap grid, the
document’s appearance doesn’t change, but objects snap to the grid as you draw,
move, resize, reshape, or rotate them.
These grids can be on or off in any combination: grid lines with Snap on or off,
or no grid lines with Snap on or off.
■

To show or hide the visible grid, choose Grid Lines from the View menu.

■

To turn the snap grid on or off, choose Snap from the Graphics menu.

When the snap grid is on, the checkbox next to the command name on the menu
is on.

To set the grid spacing
You can set the space between lines in the visible grid and in the snap grid. You
can also set the snap interval for rotating objects—for example, every
15 degrees.
1
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2

Set intervals for the visible grid, snap grid, and rotating objects, and then click Set.

Choose the space between
grid lines in the visible grid.
Type the interval for the
snap grid.
Type the snap interval
(in degrees) for rotating
objects.

You should make the visible grid interval a multiple of the snap grid interval.
For example, if the snap grid spacing is .125", you could make the visible grid
spacing .125", .25", or .5".
You can type a whole number or a decimal in the Snap Rotate text box. When
you set the value to zero, objects won’t snap when you rotate them.

DRAWING OBJECTS
The Tools palette contains tools for drawing objects.

Line

Arc

Rectangle

Rounded Rectangle

Polyline

Oval

Polygon

Freehand

Text Frame

Text Line

Graphic
Frame

Use the Line, Polyline, Arc, and Freehand tools to create various types of lines.
Use the Rectangle, Rounded Rectangle, Oval, and Polygon tools to create closed
shapes. Use either the Text Frame or Text Line tool to add text to a graphic, and
use the Graphic Frame tool to crop objects. For an overview of text and graphic

Using FrameMaker
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frames, see “Frames” on page 13-33. For information on cropping objects, see
“To crop or mask a graphic” on page 14-19.
Objects drawn on a page don’t move as you edit text. Objects in an anchored
frame move with the surrounding text. For information on anchored frames, see
Chapter 15, “Anchoring Graphics.”

To draw any object
Regardless of which type of object you’re creating, drawing an object is a simple
series of clicks or drags. As you draw, FrameMaker displays the outline of the
object, so you can experiment with the shape before completing the action.
After you draw an object, it has the current properties—the properties that
appear next to the pop-up menus on the Tools palette. The object is also
selected, to make changing these properties easier.

Current fill and pen patterns

Current line widths, line
ends, and dashed line styles
Current color

You can choose an object’s properties before you draw it, or you can change
them after you draw. For information on choosing properties, see “Choosing
object properties” on page 13-18.
1

Click a drawing tool.

When you click a tool, the pointer changes to a drawing cross ( ) in the
document window for all tools except the Text Line tool. When you click the
Text Line tool, the pointer changes to .
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2

Draw the outline of the object.

In some cases, you click at various points to draw an object. In other cases, you
drag from the beginning of a shape to the end. Don’t worry about the exact
placement of an object when you draw it. You can move it easily later.
The remaining instructions in this section describe exactly how to draw each
type of object.
3

Release the mouse button.
TEXT CAN RUN AROUND OBJECTS

When an object (except a text line or an equation) overlaps a text frame, the
text in the text frame can run around the object. To change the object’s
runaround properties, use the Runaround Properties command on the Graphics
menu. For details, see “To run text around a graphic” on page 13-30.
FRAMEMAKER POSITIONS OBJECTS ALONG THEIR PATHS

The outline that appears as you draw an object is the object’s path—an
imaginary line through the center of its border.

Path
Border

FrameMaker uses the path to position objects. So when the snap grid is on as
you draw, FrameMaker aligns the path—not the outside of the border—with
the snap grid.
DRAWING SEVERAL OBJECTS OF THE SAME TYPE

After you draw an object, the pointer normally changes back to so you can
select objects or to so you can select text. To draw another object, you must
click a drawing tool again.
To draw several objects of the same type (except text lines) without clicking the
tool each time, Shift-click a tool. To stop using the tool, click another drawing
tool or one of the selection tools
on the Tools palette.
To draw another text line without clicking the tool again, press Return at the
end of a text line and continue typing. For more information, see “To add a text
line” on page 13-25.

Using FrameMaker
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To draw a line
You can draw a line in any direction, or you can constrain the line to horizontal
or vertical or to a 45-degree angle.
1

Click the Line tool

.

2

Click where you want to start the line.

3

Click where you want to end the line.

Click to start.

Click to end.

You can also drag from the beginning point to the endpoint.
To draw a horizontal or vertical line, or a line at a 45-degree angle, Shift-click or
Shift-drag.
DRAWING CONNECTED LINES

When you want to draw several connected lines, you can use the Line tool to
draw them and use the Gravity feature to make sure they connect. Or you can
use the Polyline tool to draw the connected lines all at once. For details, see “To
draw a polyline or polygon” on page 13-11.

To draw a rectangle, a square, an oval, or a circle
You use the Rectangle tool to draw a rectangle or a square. You use the Oval
tool to draw an oval or a circle. A common use of the Rectangle tool is to draw a
border around a graphic.
1

Click the Rectangle tool
tool
.

, the Oval tool

2

Drag diagonally across the area in which you want the object to appear.

To draw a square or circle, Shift-drag.
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Release the mouse button.

Drag.

Release.

DRAWING A BORDER AROUND A GRAPHIC

To draw a border around a graphic, simply draw a rectangle around the
graphic. Make sure the rectangle has a fill pattern of None. For details on
choosing a fill pattern, see “To change a graphic property” on page 13-19.

To draw a polyline or polygon
A polyline is a series of connected line segments. A polygon is a closed polyline
shape.

Polyline

Polygon

1

Click the Polyline tool

or the Polygon tool

2

Click at a vertex of the polygon or polyline.

3

Click at each vertex in turn.

Filled polygon

.

To draw a horizontal or vertical segment, or a segment at a 45-degree angle,
Shift-click at a vertex.
4

Double-click at the last vertex.

Click to start.

Click at each vertex.

Double-click to end.

Using FrameMaker
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To draw a regular polygon
A regular polygon has equal angles and equal sides. For example, a pentagon is
a regular polygon with five sides.
1

Draw a circle or square that is slightly larger than the regular polygon you want to
create.

If you draw a rectangle or an oval, the polygon you create won’t be regular.
2

Select the object and choose Set # Sides from the Graphics menu.

3

In the Set Number of Sides dialog box, specify the number of sides and the start angle
of the polygon.

For example, when you specify three sides and a start angle of zero degrees, the
circle becomes an equilateral triangle with a vertex at the top.
0°

0°
45°

Original object

4

Number of sides = 3
Start angle = 0°

Number of sides = 3
Start angle = 45°

Click Set.

To draw an arc
An arc is a section of an oval or a circle. When you draw an arc in FrameMaker,
it initially is a 90-degree arc. To create one with a different angle, draw the arc
and then reshape it. For details on reshaping an arc, see “To reshape an arc” on
page 14-22.
1

Click the Arc tool

.

2

Put the pointer where you want to start the arc.

3

Drag along the path of the arc.

To draw a circular arc, Shift-drag.
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Release the mouse button.

Drag.

Release.

CORRECTING THE SHAPE OF AN ARC

If the arc isn’t the shape you want (for example, if it’s concave rather than
convex), don’t release the mouse button. Drag the cross back to the starting
point and draw the arc again, dragging along the path you want the arc to
trace.

Drag the cross back to the
starting point.

Redraw the arc.

To draw a freehand curve
A freehand curve is similar to a curve you draw with a pen on paper. Draw
freehand curves when you need shapes with smooth, continuous curves—Bezier
curves.
The snap grid is ignored for all but the first point of a freehand curve; however,
you may want to turn the snap grid off before drawing the curve.
1

Click the Freehand tool

.

2

Put the pointer where you want to start the freehand curve.

3

Drag along the path of the curve.

Using FrameMaker
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4

Release the mouse button.

When you release the mouse button, FrameMaker approximates a curve along
the path you drew and displays reshape handles and control points so you can
reshape the curve. For information, see “To reshape a curve” on page 14-20.

Control point

Reshape handle
Drag.

Release.

CONTROLLING THE SHAPE MORE PRECISELY

For more precise control over the shape of the curve, you can create a curve by
drawing polylines or polygons and then smoothing them. For information, see
“To draw a polyline or polygon” on page 13-11 and “To smooth and unsmooth an
object” on page 14-18.

To draw an unanchored graphic frame
You use unanchored graphic frames to crop graphics and to hold reference art
on a reference page. For details, see “To crop or mask a graphic” on page 14-19
and “Working with reference pages” on page 19-22.
1

Click the Graphic Frame tool

.

2

Put the pointer where you want to start the frame.

3

Drag diagonally to where you want to end the frame.

To draw a square frame, Shift-drag.
4

Release the mouse button.

Drag.

Release.

USING ANCHORED FRAMES

When you want a graphic to move along with related text as you edit a
document, put the graphic in an anchored frame. For details, see Chapter 15,
“Anchoring Graphics.”
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SELECTING OBJECTS
When you draw an object, the object is automatically selected. You can select
different objects to change their properties or to edit the objects.
You can select one object or several. Handles appear around each selected
object. When you drag a handle, you resize an object.

JAZZMATAZZ
Handles

You can use the Smart Selection tool or the Object Selection tool. The Smart
Selection tool allows you to place an insertion point or select text when the
pointer is over text. The Object Selection tool always selects objects.

To choose a selection tool
FrameMaker provides two tools on the Tools palette that you can use to select
objects—the Smart Selection tool and the Object Selection tool.
Smart Selection tool

Object Selection tool

Normally, the Smart Selection tool is active (highlighted).
In general, use the Smart Selection tool as you work. When the Smart Selection
tool is active, the pointer changes shape as you move it—to an I-beam ( )
indicating that you’ll place an insertion point in text or to a hollow arrow ( )
indicating that you’ll select an object when you click.

These installation
instructions cover
how to assemble the
glass carafe
When the I-beam is
visible, you can select only text.

These installation
instructions cover
how to assemble the
glass carafe
When the hollow arrow is
visible, you can select only objects.

Use the Object Selection tool when you’re working with text lines and text
frames as objects—for example, when you want to move or resize a text frame.
When the Object Selection tool is active, you can select only objects. This means

Using FrameMaker
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that when you click in text, you select the text line or text frame as an object
rather than put an insertion point in the text.
■

To use a selection tool, click it on the Tools palette.

Normally, FrameMaker activates the Smart Selection tool when you finish
drawing an object.
■

To keep the Object Selection tool active after drawing an object, Shift-click it on the
Tools palette.

To select an object
You select all objects (except text lines and text frames) in the same way, no
matter which selection tool is active.
■

To select an object, click it.

If the object is hollow (a fill pattern of None), click its border.
Selecting an object deselects any currently selected objects.
■

To select a text line or text frame when the Smart Selection tool is active, Control-click
the line or frame.

To select several objects
You may want to change the fill or pen pattern of several objects at once. Or you
may want to align several objects with one another.
You can select several objects at once, or you can add objects to an existing
selection. However, all the objects must be on the same page or in the same
graphic frame. Also, when you select a graphic frame, nothing else can be
selected at the same time.
■

To select several objects in the same area, point outside the objects and drag
diagonally to draw a selection border around them.

JAZZ

Drag.

JAZZ

Release.

All objects you want to select must be completely within the selection border.
■
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To select all objects in a graphic frame, select the frame and choose Select All in
Frame from the Edit menu.

Selecting objects

■

To select all objects on a page, click outside any objects or text on the page and
choose Select All on Page from the Edit menu.

■

To add an object to a selection, hold down Shift while you click the object.
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If you’re adding a text line or text frame to the selection using the Smart
Selection tool, hold down Control-Shift while you click.
■

To add several objects in the same area to a selection, hold down Shift and drag
diagonally to draw a selection border.

When you release the mouse button, all the objects completely within the
selection border are added to the selection. If any objects within the selection
border were selected when you began dragging, they are deselected.
IF YOU MOVE THE OBJECT BY MISTAKE

If the pointer is on an object when you begin dragging to draw a selection
border, you move the object rather than draw a selection border. If this happens,
immediately choose Undo from the Edit menu to reposition the object. Then
hold down Control-Shift while you drag. This forces a selection border to
appear.

To deselect objects
You may occasionally select an object you didn’t intend to. Or you may want to
select all the objects in an area and then deselect the ones you don’t want,
rather than select the ones you want one by one.
You can deselect one object, several objects, or all selected objects at once.
■

To deselect the only object selected, click outside the object.

■

To deselect one of several selected objects, Shift-click the object (not a handle).

■

To deselect all selected objects, click on the page away from any objects.

■

To deselect several objects in the same area, point outside all the objects, hold down
Shift, and drag diagonally to draw a selection border around the objects.

When you release the mouse button, all the objects completely within the
selection border are deselected. If any objects within the selection border were
not selected when you began dragging, they are selected.

Using FrameMaker
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CHOOSING OBJECT PROPERTIES
Object properties include the fill pattern, pen pattern, line width, line end,
color, and whether the line is solid or dashed. Pen pattern applies to the border
of an object, fill pattern to the interior.
Line width

Fill pattern
Pen pattern

Line end

You choose object properties from pop-up menus on the Tools palette.

Fill
Pen
Line Widths
Line Ends
Line Style
Color

You can also make objects look alike by applying one or more properties from
one object to another.
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To chang e a graphic property
You can choose properties before you draw an object, or you can select objects
that you’ve already drawn and change their properties. After you choose a
property (except for the color), it remains the current property until you choose
another or until you exit FrameMaker.
■

To fill an object with a pattern, choose the pattern from the Fill pop-up menu.

The eight gray fill patterns have the following percentages: 100, 90, 70, 50, 30,
10, 3, and 0 percent (white). To make an object transparent (so objects in back of
it show through), choose None. You can fill any object except lines, text lines,
and equations.
■

To select a pattern for the border of an object, choose the pattern from the Pen
pop-up menu.

The gray pen patterns have the same percentages as the gray fill patterns. If
you don’t want the object to have a border, choose None. To see the border of an
object that uses both a pen and a fill pattern of None, turn on Borders on the
View menu. A dotted object border appears on the screen but does not appear in
the printed document.
■

To select a line width for a line or an object’s border, choose a width from the Line
Widths pop-up menu.

You can change the line width of any object except text lines.
You can also change the line width of an object with the Object Properties
command on the Graphics menu.
■

To change the ends of an arc, a line, a polyline, or a freehand curve, choose from the
Line Ends pop-up menu.

You can place an arrowhead at the beginning, at the end, or at both ends.
■

To determine whether a line or an object’s borders will be solid or dashed, choose
from the Line Styles pop-up menu.

■

To assign a color, choose one from the Color pop-up menu.

To draw several objects in the same color, hold down Shift when you choose the
color. The color you choose remains the current color until you close the Tools
palette, open a different document, or exit FrameMaker.
To assign the same color to all objects, select one object, hold down
Control-Shift, and choose a color.
You can also change the color of an object with Object Properties on the
Graphics menu. If an object isn’t visible after you assign it a color, make sure
that the color isn’t in the Invisible scroll list in the Define Color Views dialog
box for the current view. For details, see “Viewing colors” on page 17-11.

Using FrameMaker
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CHANGING THE PROPERTIES OF TEXT FRAMES AND TEXT LINES

You change any properties of a text frame and the color of a text line just as you
change the properties of other objects. For example, you can change the color or
fill pattern of a text frame to provide a background for text.
To change the color of text in a text frame, use the Character Designer or the
Paragraph Designer. For details, see “To choose a color” on page 4-9.
INSPECTING AN OBJECT’S PROPERTIES

You can inspect the properties of an object you’ve already drawn. With the
object selected, hold down Shift and choose Pick Up Object Properties from the
Graphics menu. The object’s properties appear as the current properties on the
Tools palette.
CHANGING THE AVAILABLE PROPERTIES

You choose properties from a set of choices on the Tools palette. You can change
the available choices for each property.
For information on changing the line widths, line ends, or line styles, see
“Customizing the line properties” on page 13-21. For information on changing
the colors in the Color pop-up menu, see “Assigning and defining colors” on
page 17-4. For information on changing the pen or fill patterns you can choose,
see the online manual Changing Setup Files.

To make objects look alike
You may want to change the properties of one object to match another. For
example, you may want to change the border width and color of one line to
match another.
1

Select the object that has the properties you want to copy.

2

Hold down Shift and choose Pick Up Object Properties from the Graphics menu.

The properties of the selected object become the current properties on the Tools
palette.
3
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Click the current object properties you want to apply to the selected objects.

Click here.

CUSTOMIZING THE LINE PROPERTIES
You can change many of the settings that appear on the Tools palette. For
example, you can change the available line widths, design your own arrowhead,
or use dotted lines instead of dashed lines. The new settings remain until you
exit FrameMaker.

Line widths

Line ends

Line styles

The changes you make don’t affect existing objects. After you change the
settings, you can use them for new or existing objects.

Using FrameMaker
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To chang e the line width settings
You can change the values assigned to the four line widths that appear in the
Line Widths area. For information on changing the line widths that appear
when you start FrameMaker, see the online manual Changing Setup Files.
1

Choose Set from the Line Widths pop-up menu on the Tools palette.

2

In the Line Width Options dialog box, type the line widths and click Set.

You can type the values in any order. When you click Set, the line widths are
sorted so the smallest value corresponds to the thinnest line in the Line Widths
pop-up menu and the largest value corresponds to the thickest line.
To revert to the line widths you had when you started FrameMaker, click Get
Defaults.

To chang e the line cap style
The cap style determines the appearance of any line ends that don’t have an
arrowhead. You can choose from three cap styles—projecting, round, and butt.
Projecting
Round
Butt

The projecting cap style uses a square cap that projects beyond the end of the
line. The round style uses a rounded cap. The butt style uses no cap.
1

Choose Set from the Line Ends pop-up menu on the Tools palette.

2

In the Line End Options dialog box, choose one of the line cap styles and click Set.
CHOOSING THE CAP STYLE FOR CONNECTING LINES

When two thin lines are connected, you may not notice the difference between
different cap styles. But when the lines are thicker, they may appear not to
intersect cleanly.

Projecting
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You get a clean intersection when the lines are the same thickness, meet at
right angles, and use a projecting cap. If the lines don’t meet at a right angle,
try a round cap for both lines. If the lines aren’t the same thickness, try a butt
cap for the thinner line when the lines meet at their endpoints and for the stem
of a T when they meet in a T.

To chang e the arrow style
You can choose from among several preset arrow styles. Arrow styles are
determined by their base angle, tip angle, and length. They can be filled, hollow,
or drawn with sticks.
B = Base angle
Filled

T = Tip angle
T

B

L = Length
Hollow
Stick

L

You can also create your own custom styles. For details, see “Creating a custom
arrow style” on page 13-24.
1

Choose Set from the Line Ends pop-up menu on the Tools palette.

2

In the Line End Options dialog box, choose one of the preset arrow styles and
click Set.

To chang e the dashed line style
You can change the pattern that FrameMaker uses when you choose the dashed
line style from the Line Styles pop-up menu. The pattern that appears in the
pop-up menu doesn’t change, but FrameMaker uses the new pattern.
1

Choose Set from the Line Styles pop-up menu on the Tools palette.

2

In the Dashed Line Options dialog box, choose one of the patterns and click Set.
USING A NONSTANDARD DASHED LINE STYLE

To copy a nonstandard dashed line style from another object, first select the
object. Then hold down Shift and choose Pick Up Object Properties from the
Graphics menu. Finally, select the object to which you want to apply the dashed
line style and click the current line style next to the Line Styles pop-up menu on
the Tools palette.
You can also use Maker Interchange Format (MIF) to create a nonstandard
dashed line style. For information, see the online manual MIF Reference.
Using FrameMaker
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CREATING A DOTTED LINE THAT USES ROUND DOTS

To create a dotted line that uses round dots, use a dashed line style of short
dashes with a round line cap. For information on changing the cap style, see
page 13-22.

USING TEXT WITH GRAPHICS
You can add single lines of text or text frames to a graphic. You use text lines for
single-line callouts. You use text frames for multiline callouts, paragraphs of
text, and any other text you want to wrap automatically from line to line.

PRM-0004
Text lines

Brewing unit

Text frame

Glass carafe
with cool-grip
handle

Adding text to graphics

Running text around graphics

CREATING A CUSTOM ARROW STYLE
When none of the available arrow styles in the
Line End Options dialog box meets your needs, you
can create a custom arrow style by specifying new
settings below the Custom button.
Between 10° and 175° (and at least 5°
greater than the tip angle)
Base angle

Tip angle
Length
Style

Between 5° and 85°

These are sample custom arrows.
Arrow
Base angle Tip angle
Length
................................................

70°

30°

10 points

80°

30°

10 points

70°

15°

10 points

70°

30°

5 points

Between 0 and 255 points
Filled, Hollow, or Stick

FrameMaker ignores the base angle setting when
you choose Stick.

13-24

The length you specify applies to objects that have
a line width of 1 point. When you use a thicker line
width, the arrowhead is longer.
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When graphics overlap text in a text frame, you can make the text run around
the graphics.

To add a text line
A text line is a single line of text that FrameMaker treats independently from
other text. Text lines grow or shrink in length as you edit them, but they don’t
wrap around to the next line. If a text line overlaps a text frame, the text in the
frame does not run around the text line.
You can assign character formats and a spell-checking language to text lines.
However, text lines can’t have paragraph formats, and they can’t contain
anchored frames, markers, variables, cross-references, or conditional text.
1

Select the Text Line tool

.

The pointer changes to a crossed I-beam ( ) when you move it to the document
window. The small horizontal line across the pointer indicates the baseline
position of the text.
2

Click in the text line to place an insertion point in it.

3

Type the text.

FrameMaker uses the last character format you typed or selected in the
document. You can change the character format at any time.

Prímo
Click.

Type.

ADDING ANOTHER TEXT LINE

When you press Return in a text line, you create a new, separate text line. For
example, to create two single-line callouts, type the first callout, press Return,
and type the second callout. Then you can select the text lines independently
and move them to the correct locations.
CHANGING THE CHARACTER FORMAT

You change the character format of text in a text line just as you do for any
other text. (For details, see “Specifying font properties” on page 4-7.) To change
the font of several text lines at once, select the text lines and change their
format.

Using FrameMaker
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CHANGING THE SPELL-CHECKING LANGUAGE

When you use text lines to create callouts in several languages, you can specify
the language you want the Spelling Checker to use for individual callouts. To
change the language that FrameMaker uses when spell-checking a text line,
select the text line and choose Object Properties from the Graphics menu. Then
choose a language from the Language pop-up menu and click Set.

To add a text frame
Unlike a text line, a text frame can contain more than one line of text. For
example, the main text in a document appears in text frames that FrameMaker
creates automatically when it creates new pages.
You use text frames for multiline callouts, paragraphs of text, and any other
text you want FrameMaker to wrap automatically from line to line. You also use
text frames when you want to insert variables, cross-references, or markers in
the text, when you want to include the text in a generated list, or when you
want to make the text conditional.
Text frames also appear on master pages to specify the placement of headers,
footers, and body text in a document. You can draw text frames on master pages
to customize the page layout of a document. For details, see Chapter 19,
“Custom Page Design.”
1

Select the Text Frame tool

.

2

Drag diagonally where you want to add the text frame.

3

Release the mouse button.

4

In the dialog box that appears, specify the number of columns and the gap and
click Set.

5

Double-click in the text frame to place an insertion point in it.

6

Type the text.

Carafe
Drag.
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FIXING AN OVERFLOWING TEXT FRAME

When the text you type overflows the text frame, the insertion point moves
below the bottom of the frame and the text doesn’t appear. If borders are visible,
the bottom border of the text frame is a solid line.
Coffee is consumed, either hot or cold, by
nearly one-third of the earth’s inhabitants.
This popular beverage is brewed from the
roasted and ground seeds of the tropical
Overflowing text frame

When the text overflows the text frame, you can enlarge the frame so the text
fits, or you can connect the flow of the text frame to another frame. You can also
decrease the font size of the text. To enlarge the text frame, Control-click the
frame to select it. Then drag a handle to enlarge the frame.
For details on connecting flows between text frames, see “Controlling the flow of
text” on page 20-7. For details on decreasing the font size of text, see
“Specifying font properties” on page 4-7.

To create reverse text
You may want to create reverse text (text that appears in white on a dark
background) for special emphasis.
1

Draw an object to act as the background for the text.

Generally, it’s best to use a nearly black fill pattern for the object.
2

Outside the background object, add a text line and type its text.

3

Move the text line so part of it disappears into the background object.

4

Select the text line.

If the Smart Selection tool is active, Control-click the text line to select it.
5

Choose White from the Color pop-up menu.

The text becomes white and appears partially cut out of the background object.
If the text doesn’t appear in front of the object, choose Bring to Front from the
Graphics menu. If you still have trouble, make sure the current color view of
the document shows White as Cutout. For details, see “Viewing colors” on
page 17-11.

Using FrameMaker

13-27

ILLUSTRATING A DOCUMENT

13

Using text with graphics

6

Move the text line so all its letters appear cut out of the background object.

Prímo
Move line part of the way.

Prímo
Choose White.

Prímo
Move line all the way.

CREATING REVERSE TEXT WITH A TEXT FRAME

To use a text frame rather than a text line to create reverse text, set the desired
pen, fill pattern, and color of the text frame. Then change the color of the text
with the Character Designer or the Paragraph Designer. For details, see “To
choose a color” on page 4-9.

To add a title to a graphic
You can use a text line or text frame as the title of a graphic, but you may find it
easier to use the FrameMaker table commands instead. The illustration below
is a single-cell table with the title below the table.

Figure 2-2. Widget

You can also use multicell tables to achieve various effects with graphics and
text. For details, see “Using multicell tables for graphics” on page 13-29.
Using this technique requires some knowledge of paragraph formats, table
formats, and anchored frames. For information on paragraph formats, see
Chapter 4, “Formatting Text,” and Chapter 5, “Format Catalogs.” For
information on table formats, see Chapter 7, “Table Formats.” For information
on anchored frames, see Chapter 15, “Anchoring Graphics.”
1

Create a single-cell table wide enough for your figure.

Use the Insert Table command on the Table menu.
2

Specify the location of the title.

Use the Table Designer command on the Table menu.
3

Format the table title.

Use any of the formatting methods described in Chapter 4, “Formatting Text.”
4
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Change the cell’s paragraph format so that the size of an anchored frame can affect
the paragraph’s line spacing.

Use the Custom Line Spacing dialog box to turn off fixed line spacing. For
details, see “To specify custom line spacing” on page 4-19.
6

Create an anchored frame in the cell for the graphic.

Anchor the frame at the insertion point.
7

Put the graphic in the frame and resize the frame appropriately.

If necessary, the cell grows vertically to accommodate the frame’s height.
8

If the frame is wider than the cell, change the column’s width.

Use the Resize Columns command on the Table menu.
9

Store the table format in the Table Catalog, with a name such as FigureTable.

The next time you need to add a table for a figure and its title, either use the
Insert Table command on the Table menu or copy and paste the table.

USING MULTICELL TABLES FOR GRAPHICS
Use multicell tables to achieve various effects.
For example, the following illustration is a two-cell
table.

The last illustration is a six-cell table. The figure is
in the first row, in a cell that straddles all three
columns. An autonumbered paragraph appears in
each cell in the second row.

Figure 2-2
Widget
2

The next illustration is also a two-cell table. One
cell contains several autonumbered paragraphs.
The other contains the figure.
2 Slide metal belt and housing around outside
of carafe.
3 Attach metal handle ring to housing
assembly by screwing it clockwise.
4 Screw black plastic handle into the metal
handle ring.

2

3

3

4

2 Slide metal belt and
housing around
outside of carafe.

3 Attach metal handle
ring to housing.

4 Screw black plastic
handle into the metal
handle ring.

4

Using FrameMaker

13-29

13

ILLUSTRATING A DOCUMENT

Using text with graphics

To run text around a graphic
You can make the text in a text frame run around a graphic. When a graphic is
placed directly on the page or in an unanchored frame, the text can follow the
contours of the graphic, or it can align vertically at the edge of an imaginary box
bounding the graphic.

No runaround

Run around Bounding Box

Run around Contour

For some purposes, you can also run text around anchored frames—for
example, to set a small graphic or a drop cap at the beginning of a paragraph.
For information on running text around an anchored frame positioned in this
way, see “To run text around an anchored frame” on page 15-13.
Text will not run around a text line or an equation. If text in a text frame runs
around a graphic, FrameMaker does not feather text in that frame. For
information on feathering text, see “To feather text to the bottom of text frames”
on page 18-17.
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Draw or place the graphic on either a master page or a body page.

When you place the graphic on a master page, it appears as a background
graphic on all associated body pages. You can then make the text on all the
associated body pages run around the graphic.
Make sure you click in the page margin before importing or pasting the graphic.
That way you won’t have an insertion point in a text frame and inadvertently
place the graphic in an anchored frame.
2

Select the graphic.

If the graphic is made up of several objects, select all the objects.
3

If the graphic’s runaround properties aren’t set as you want them, choose Runaround
Properties from the Graphics menu.

4

In the Runaround Properties dialog box, choose a runaround method and a gap.

Choose a runaround
method.
Indicates that the
runaround properties for
several selected objects are
not the same

Specify the space between
the graphic and the text.

If you want the text to follow the shape of the graphic, click Run around
Contour. If you want all the affected text to move the same amount, click Run
around Bounding Box.

Using FrameMaker
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5

Click Set.

If the settings don’t produce exactly the results you want, you can add an
additional object near the graphic to create the desired contour that the text
runs around. For information, see “Adjusting the way text runs around a
graphic” on page 13-32.
RUNNING TEXT AROUND AN IMPORTED GRAPHIC

If you want to run text around the contour of an imported graphic, make sure
the graphic is behind the text frame. To do so, select the graphic and choose
Send to Back from the Graphics menu.
PREVENTING TEXT FROM RUNNING AROUND A GRAPHIC

To stop text from running around a graphic, select the graphic and choose
Runaround Properties from the Graphics menu. In the Runaround Properties
dialog box, click Don’t Run Around and click Set.
ADJUSTING THE WAY TEXT RUNS AROUND A GRAPHIC

If the runaround setting of a graphic doesn’t give the text the look you want,
you can change the look by adding an object to the original graphic. Over the
original graphic, draw an object that has roughly the contours you want. Set the
object’s pen and fill pattern to None. (When borders are visible, you see a dotted
border around the object.) Then edit the object and its runaround properties as
necessary until the text runs around the object the way you want.
For the object, you can use a polyline to adjust a single line of text closer to or
farther away from the graphic. You can also use a rectangle to prevent text from
appearing in the column beside the graphic at all or any other object that has
the contours you want.
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Runaround changed by an
additional object

For information on drawing objects and changing their pen and fill patterns, see
“To draw any object” on page 13-8 and “To change a graphic property” on
page 13-19.

FRAMES
In FrameMaker, text and graphics appear in rectangular frames. Text frames
control placement of the document text. Graphic frames, which can be anchored
or unanchored, control the position and look of graphics. Anchored frames hold
graphics related to specific text and move along with the text as you edit it. You
can use anchored frames to crop the edges of the graphics they hold.
You use unanchored frames to crop graphics that stay in the same place on the
page. You can also use unanchored frames to hold reference art.
TEXT FRAMES FOR DOCUMENT TEXT

You type document text in text frames. When you fill a text frame, FrameMaker
creates a new page and automatically creates a text frame for it. The text frame
on the first page is automatically connected to the text frame on the next page
to form a single text flow running through the entire document.
The size and placement of text frames is determined by the page-margin
settings in the document’s column layout. The column layout also determines
the number of columns in the frame. Each paragraph’s format specifies the
paragraph’s indentation from the edges of the text frame. For information on
specifying column layout, see Chapter 18, “Basic Page Design.” For information
on formatting paragraphs, see Chapter 4, “Formatting Text.”
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GRAPHIC FRAMES

If you want a graphic to move along with specific text automatically because it’s
related to the text, you place the graphic in an anchored frame. You can create
an anchored frame with the Anchored Frame command on the Special menu.
You can also paste or import a graphic directly into text; FrameMaker creates
an anchored frame for you. For more information on anchored frames, see
Chapter 15, “Anchoring Graphics.”
If you don’t want the graphic to move, but you want it to appear at a specific
location on a page, you usually draw or import the graphic directly on the page.
If you need to crop a graphic or include it as reference art on a reference page,
you place it in an unanchored graphic frame—a graphic frame that doesn’t
move as you edit text. You draw unanchored graphic frames with the Graphic
Frame tool on the Tools palette. For details, see “To draw an unanchored
graphic frame” on page 13-14, “To crop or mask a graphic” on page 14-19, and
“Working with reference pages” on page 19-22.
Unanchored graphic
Cinder Cone Volcanoes
Cinder-cone volcanoes typically are
found in the Cascade Range in
Washington and Oregon. Mount St.
Helens, which last erupted in 1980, is
the most notorious example of this
type of mountain.
The internal structure of a cinder
volcano is shown in Figure 1-1.

Anchored frame

Cutaway view of
volcano

Text frame for document
text

Text frame for text in
graphics

Figure 1-1 Cinder volcano structure

TEXT FRAMES IN GRAPHICS

You can also use text frames for components of graphics—for example, for
callouts or captions. You draw these text frames yourself, with the Text Frame
tool on the Tools palette. For single lines of text in graphics, you can also use the
Text Line tool. For details, see “Using text with graphics” on page 13-24.
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them on the page
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ARRANGING OBJECTS 14-4

To reshape an arc 14-22

To move an object 14-4

To add or remove corners 14-22

To specify the exact position of an object 14-5
To delete or duplicate an object 14-6

MEASURING OBJECTS 14-23

To cut, copy, and paste an object 14-6

To measure an object 14-23

To change object stacking 14-7

To see the position of an object 14-24

To create a drop shadow 14-8

To measure any distance on the page 14-24

To group and ungroup objects 14-8
To join lines and curves 14-9
To align objects 14-10
To change the alignment of a text line 14-10
To distribute objects 14-11
To connect objects 14-12
FLIPPING AND ROTATING OBJECTS 14-13

To flip an object 14-13
To rotate an object 14-14
To rotate an equation or graphic frame 14-16
To unrotate and rerotate an object 14-16
RESIZING AND RESHAPING OBJECTS 14-16

To resize an object 14-17
To smooth and unsmooth an object 14-18
To change the corner radius of a rounded
rectangle 14-18
To crop or mask a graphic 14-19
To reshape a polygon or polyline 14-20
To reshape a curve 14-20

Using FrameMaker

14-1

14

EDITING ILLUSTRATIONS

.....

...................................

You edit an illustration by working and reworking the objects that
compose it—positioning and arranging them, flipping and rotating
them, and changing their sizes and shapes.

You edit as you draw
Drawing the objects in an illustration and then reworking those objects
are parts of the process of creating an illustration. You can draw part
of an illustration, rework the objects you’ve drawn, and then draw
some more.
You can zoom in to work with fine detail and zoom out for a sense of the
entire illustration.

You can arrange objects where you want them
You can make copies of objects you use repeatedly. You can position
objects anywhere on a page or in a graphic frame.
You can stack objects in front of one another, align them horizontally or
vertically, and distribute them so they’re an equal distance apart.

Draw main object.

Draw remaining objects.

Change fill, line weights, and
front/back relationships.

You can flip an object to create a mirror image. You can rotate most
objects to any angle you want.
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When you need to work with several objects as a unit, group them.
When you want to edit the objects individually, ungroup them.

Align, distribute, and
group.

Copy and flip left/right.

Rotate.

You can change an object’s size and shape
You can resize an object by changing its width or its height, or you can
change both to maintain the object’s proportions.
As you work with an object such as a line, polyline, or polygon, you may
find the original shape isn’t exactly what you want. You can add, move,
or remove corners to change the shape.

Resize objects larger or
smaller.

Ungroup to reshape and
edit the individual
objects.

Ungroup and smooth
selected objects.

You can smooth corners to create a freehand curve. You can change the
shape of freehand curves. And you can join lines and curves to create a
single complex outline.

In this chapter
This chapter shows you how to edit an illustration. It shows you how to
resize, reshape, flip, and rotate objects and how to align objects,
distribute them, and group them.
Chapter 13, “Illustrating a Document,” shows you how to create the
objects that make up an illustration.
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ARRANGING OBJECTS
You often move and duplicate objects after you create them, and you delete
objects you no longer need. You can move and duplicate objects directly on a
page or in a graphic frame. You can connect objects easily as you draw them,
resize them, or reshape them. You can also cut or copy objects to the
FrameMaker Clipboard and then paste them anywhere in the same document
or in a different document.
You can also arrange objects in relation to other objects. For example, in the
illustration below, the drop shadow on the left was created with two rectangles
stacked one in front of the other and then grouped together as a single object.
The rectangle, coffee maker, and text frame are aligned along their tops and
distributed an equal distance apart. The coffee maker and the coffee cup are
aligned along their baselines.

Prímo
Cappuccino
PRM-0004

Featuring grounds holder
and glass carafe with
cool-grip handles

You can also join individual lines and curves to create complex outlines, which
you can then fill or color.

To move an object
You can quickly move an object by dragging it, or you can make small position
adjustments by moving the object with the arrow keys.
For information on placing an object precisely, see “To specify the exact position
of an object,” next. For information on moving an object several pages away or
to another document, see “To cut, copy, and paste an object” on page 14-6.
■

To move an object approximately, select the object and drag its border (not a
handle).

To move the object horizontally or vertically, Shift-drag.
To move an object into a graphic frame, drag it until the pointer is in the frame.
To move an object out of a graphic frame, drag it until the pointer is outside the
frame. As you drag, the frame’s border may temporarily crop the object.
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When you drag the object, the status bar contains the distance from the upperleft corner of the object to the upper-left corner of the page (or frame, if the
object is in a graphic frame). If rulers are visible, lines in the rulers show you
the object’s position.
If Snap is on in the Graphics menu, objects snap to the invisible grid as you
drag them.
■

To move an object in small increments, select the object, hold down either Control or
Shift-Control, and press an arrow key.

The distance the object moves depends on the keys you hold down and the
current zoom setting. Zoom in to move an object by smaller amounts.
Hold down
At this zoom setting
To move an object
..........................................................................

Control

Shift-Control

50%

2.0 points

100%

1.0 point

200%

0.5 point

50%

12.0 points

100%

6.0 points

200%

3.0 points

To specify the exact position of an object
You can define the offset of an object from the left and top edges of its page or
graphic frame.
Offset from
left
Offset from
top

In this way, you can specify the exact position of an object. The position of an
object is determined from its path, not from the edge of its border. For details,
see “FrameMaker positions objects along their paths” on page 13-9.
1

Select the object.

2

Choose Object Properties from the Graphics menu.

Using FrameMaker
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3

In the Object Properties dialog box, specify the offsets from the top and left edges of
the page or graphic frame.

For all objects (except text lines and equations), specify the offsets in the Offset
From area.
4

Click Set.
SPECIFYING THE OFFSET OF A TEXT LINE OR AN EQUATION

For text lines and equations, specify the offset in the Alignment Point Offset
From area. The following illustration shows a left-aligned text line.
Offset from
left
Alignment

Text Line

Baseline

Offset from top

To delete or duplicate an object
You can delete or duplicate an object quickly without using the FrameMaker
Clipboard.
■

To delete an object, select the object and press Delete.

■

To duplicate an object quickly, first select the object. Then point on the object (not on
a handle), hold down Control, and drag the duplicate of the object with the middle
mouse button.

Depending on the direction you initially drag the object, its movement is
constrained to either a horizontal or vertical direction. To move the duplicate in
any direction, release the Control key and the mouse button after you make the
duplicate. Then drag the duplicate where you want it.

To cut, copy, and paste an object
You can use Cut, Copy, and Paste on the Edit menu to duplicate or move an
object. The Cut and Copy commands place a copy of the object on the
FrameMaker Clipboard. You can then paste the object anywhere in the same
document or in a different FrameMaker document.
Objects remain on the Clipboard until you choose Copy or Cut again, so you can
paste several copies of an object.
1

Select the object and then choose Cut or Copy from the Edit menu.

To remove the object and paste it elsewhere, use Cut. To leave the object
unchanged and paste a copy elsewhere, use Copy.
14-6
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Choose where you want to paste the object and then choose Paste from the Edit
menu.
To paste an object
Click
..........................................................................

On a page

In the margin of the page

In an existing graphic
frame

The frame border to select the frame

In text

In the text where you want the object

When you paste the object in a graphic frame or on a page that is the same size
as the one from which you copied or cut the object, FrameMaker puts the object
in the same relative location. Otherwise, FrameMaker centers it.
When you paste an object into text, FrameMaker inserts an anchor symbol ( ),
creates an anchored frame to hold the object, and centers the object in the
frame.

To chang e object stacking
When you draw or paste an object, FrameMaker places it in front of all other
objects on the page or in a graphic frame. If the object is filled, it obscures
objects in back of it. You can control how objects overlap by putting them in
front of or in back of other objects.
When you click overlapping objects, FrameMaker selects the frontmost object.
■

To put an object in front of other objects, select the object and choose Bring to Front
from the Graphics menu.

■

To put an object in back of other objects, select the object and choose Send to Back
from the Graphics menu.

Circle in front

Circle in back
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To create a drop shadow
You use a drop shadow when you want objects to convey a sense of depth. To
create a drop shadow, use two objects and stack them so the bottom object looks
like a shadow.
1

Draw the object for which you want to make a drop shadow.

2

With the object selected, choose Copy and then choose Paste from the Edit menu.

A copy of the object appears on top of the first object.
3

With the copy selected, choose a gray or black fill pattern on the Tools palette.

4

With the copy still selected, choose Send to Back from the Graphics menu.

The copy moves behind the original.
5

Move the copy up and to the left until a narrow band is visible.

Draw.

Copy and paste.

Change fill pattern.

Send to back.

Move.

To group and ungroup objects
When several objects (except graphic frames) are part of the same graphic, you
can group the objects. You can then move, resize, flip, or align them as a single
object.
You can combine a group of objects with other objects to form an even larger
group. Because FrameMaker groups and ungroups objects hierarchically, the
first set of grouped objects is maintained as a set when you group another object
with it.
■

To group objects, select them and choose Group from the Graphics menu.

One set of handles appears around the group.

Select objects.
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■

To ungroup objects, select the group and choose Ungroup from the Graphics menu.

Handles appear on each object in the group. When a group has been grouped
with other objects, you must choose Ungroup more than once to ungroup all
objects.

To join lines and curves
You can create complex outlines by joining individual lines, polylines, arcs, or
smoothed polylines created with FrameMaker drawing tools. The endpoints of
the objects you want to join must be touching, and the objects can’t be grouped.
Joining creates a single continuous curve. You can then change the new curve’s
properties, such as border width, pen and fill pattern, and color.

Objects drawn

Objects positioned
and selected

Objects joined

Fill pattern selected

For information on grouping objects so that you can reposition or resize them all
at once, see “To group and ungroup objects” on page 14-8.
1

Position the objects so that their endpoints touch.

The ends of the lines or curves must be within 1 point of each other. Turn on
Snap and Gravity and zoom in if necessary.
2

Select the objects and choose Join from the Graphics menu.

The new curve takes on the properties of the last object selected before
joining—for example, the object’s line width, pen pattern, or color. (In the
illustration above, the last object selected before joining was the polyline.)
IF YOU JOIN LINES OR CURVES BY MISTAKE

If you join lines or curves by mistake, immediately choose Undo from the Edit
menu to undo the mistake. Joining creates a single continuous curve (a Bezier
curve) that cannot be “unjoined” at a later time in the way that grouped objects
can be ungrouped.

Using FrameMaker
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To align objects
You can align objects (except graphic frames) with one another. You align
objects along a horizontal line by specifying the top/bottom alignment.

*
Before aligning

Tops

T/B Centers

Bottoms

You align objects along a vertical line by specifying the left/right alignment.

*

Before aligning

Left Sides

L/R Centers

Right Sides

FrameMaker aligns the objects—along their paths—with the last object you
select. (In the illustrations above, the last objects selected are marked with a
star.) When you select objects by dragging a selection border, FrameMaker
aligns the objects with the frontmost object (the one that appears last in draw
order).
You can also align a single object in a graphic frame or on a page.
1

Select the objects.

2

Choose Align from the Graphics menu.

3

In the Align dialog box, choose the alignment you want and click Align.

To align objects in only one direction, set the other direction to As Is.
ALIGNING AN OBJECT IN A GRAPHIC FRAME OR ON A PAGE

You can align one object in a graphic frame or on a page—for example, along the
left side of a graphic frame. Select only the object you want and use the Align
command.

To chang e the alignment of a text line
When you create a text line, it is left aligned on its alignment point (where you
clicked). You can change the alignment to centered or right aligned.
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FrameMaker maintains a text line’s alignment when you insert text; for
example, a centered text line remains centered.

Carafe
Centered word

Carafe Assembly
Centered phrase

1

Select the text line.

2

Choose Object Properties from the Graphics menu.

3

In the Object Properties dialog box, choose a new alignment from the Alignment
pop-up menu and click Set.

To distribute objects
You can move objects—distribute them—so they have an equal amount of space
between them. You can distribute objects horizontally and vertically. If you
specify the exact space between the objects (the edge gap), FrameMaker moves
all objects except the one at the left (or top). If you specify that the objects’
centers or edges should be equidistant, FrameMaker leaves the left and right
(or top and bottom) objects where they are and moves the others.
Horizontal distribution

Objects as drawn

Edge gap = .0625"

Equidistant centers

Equidistant edges

Objects as drawn

Edge gap = .0625"

Equidistant centers

Equidistant edges

Vertical distribution

1

Select the objects.

You can select the objects in any order.

Using FrameMaker
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2

Choose Distribute from the Graphics menu.

3

In the Distribute dialog box, choose the spacing you want and click Distribute.

To distribute objects in only one direction, set the other direction to As Is.
IF OBJECTS MOVE OFF THE PAGE

When you specify a large edge gap, objects may move off the page. If they do,
immediately choose Undo from the Edit menu.

To connect objects
It’s easier to connect objects when you use “gravity.” With Gravity on, an object
attracts the pointer as you draw, resize, or reshape a nearby object.
1

If Gravity isn’t already on, choose Gravity from the Graphics menu.

When Gravity is on, the checkbox next to the command name on the menu
is on.
2

Drag a handle of an object, or draw, close to the object to which you want to
connect.

As you drag, the handle jumps to connect the two objects.

Drag handle.

Release.

HOW GRAVITY WORKS

Objects have gravity along their paths and at their corners. Rectangles and
ovals also have gravity at their centers.
Some points on an object exert a greater pull than others. For example, the
corners of a triangle attract the pointer more than its sides do.
Gravity extends the same distance on the screen regardless of the zoom setting.
When you zoom in, objects and the space between them appear larger, so you
can drag a handle or draw closer to an object without the object attracting the
pointer.
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FLIPPING AND ROTATING OBJECTS
You can create a mirror image of an object by flipping it up and down or left and
right.

Original

Flipped up and down

Flipped left and right

You can rotate all objects (except equations and graphic frames) any number of
degrees. You can rotate graphic frames and equations in 90-degree increments.

Jazz
Objects rotate around their centers.

Jazz

All objects (except equations and text lines) rotate around their centers.
Equations and text lines rotate around their alignment points.

Text lines rotate around their alignment points.

You edit most rotated objects just as you edit unrotated objects. However, to edit
the contents of a rotated equation, or the contents of an anchored frame in a
rotated text frame, you first need to restore the equation or text frame to its
unrotated position.

To flip an object
You can flip all objects around their top/bottom or left/right center lines. You can
also create symmetrical objects by flipping.
■

To flip an object, select the object and choose Flip Left/Right or Flip Up/Down from the
Graphics menu.

Using FrameMaker
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■

To create a symmetrical object, draw an object, copy it, flip the copy, and move the
copy until it touches the original.

Draw.

Make a copy.

Flip and move.

Rather than move the duplicate to the original, you can use the Distribute
command with an edge gap of zero to ensure exact alignment of the objects. For
details, see “To distribute objects” on page 14-11.
TEXT IN A FLIPPED OBJECT

Flipping an object that contains text doesn’t flip the text in the object. For
example, the text in a flipped text line doesn’t appear reversed, but the
alignment point of the text line is flipped.

To rotate an object
You can quickly rotate all objects (except equations and graphic frames) any
number of degrees by dragging them. You can also specify the exact rotation of
an object from either its current or its unrotated position. For details, see
“Specifying the exact rotation of an object,” next.
You can also reset the rotation angle of a polygon or polyline to change its
natural orientation.
1

Select the object.

2

Hold down Control and drag a handle with the right mouse button.

Select.

Drag.

Release.

When Snap is on in the Graphics menu, the object snaps to multiples of the
angle specified in the View Options dialog box. (For details, see “To set the grid
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spacing” on page 13-6.) To constrain the rotation to 45-degree increments, hold
down Shift-Control while you drag with the right mouse button.
SPECIFYING THE EXACT ROTATION OF AN OBJECT

To specify the exact rotation of an object from its current position, select the
object and choose Rotate from the Graphics menu. In the Rotate Selected
Objects dialog box, specify the direction and amount of rotation and click
Rotate.
0°

0°
45°

You can rotate several ungrouped objects in this way. When you do, each object
rotates around its center.
To specify the exact rotation of an object from its unrotated orientation, select
the object and choose Object Properties from the Graphics menu. Then type the
angle in the Angle text box and click Set.
INSPECTING THE ROTATION ANGLE

To inspect an object’s rotation angle, select the object and choose Object
Properties from the Graphics menu. The rotation angle appears in the Angle
text box.
RESETTING THE ROTATION ANGLE

After you rotate a polygon, polyline, freehand curve, or grouped object, you can
reset the rotation angle of the object or group to zero. That is, you can define the
current orientation as the unrotated orientation. To do this, select the rotated
object or group and press Esc g 9.
When an object isn’t rotated, its handles are aligned parallel to the window
borders. Resetting the current rotation angle to zero repositions the handles
around the object.

Using FrameMaker
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To rotate an equation or graphic frame
You can rotate an equation or graphic frame in 90-degree increments. You
specify the rotation from the equation’s or frame’s unrotated position.
1

S elect the object.

2

Choose Rotate from the Graphics menu.

3

In the dialog box, choose the rotation angle you want and click Rotate.
INSPECTING THE ROTATION ANGLE

To inspect an equation’s or graphic frame’s rotation angle, select the frame or
equation and choose Rotate or Object Properties from the Graphics menu. The
rotation angle appears in the dialog box.

To unrotate and rerotate an object
You edit most rotated objects just as you edit unrotated objects. However, to edit
the contents of a rotated equation, or the contents of an anchored frame in a
rotated text frame, you first need to restore the equation or text frame to its
unrotated position. You may find it easier to edit other objects—for example, to
align and distribute them—in their unrotated position. After you edit the
object, you can rerotate the object to restore it to its rotated position.
■

To unrotate an object, select it and press Esc g 0 (zero).

■

To rerotate an object, select it and press Esc g 1 (one).

RESIZING AND RESHAPING OBJECTS
As you refine a graphic, you may want to change the size or shape of objects.
You can resize an object as precisely as you wish.
Reshaping possibilities are unlimited. For example, you can add a corner to a
polyline or polygon, move a corner to change the shape, and smooth a polyline
to create a freehand curve.

Polygon

Corner added

Corner moved

Smoothed

You can also crop a graphic to mask out certain parts. You can crop graphics
drawn with the drawing tools as well as images that you import.
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To resize an object
You can resize all objects except text lines.
1

Select the object.

2

Drag one of its handles.

Drag a side handle
to change either width
or height.

Drag a corner handle to
change both width and
height.

As you resize an object, FrameMaker displays its dimensions in the status bar.
To increase or decrease the dimensions proportionally, Shift-drag a corner
handle.
RESIZING AN OBJECT PRECISELY

You can resize an object by specifying its dimensions or a scale factor. Select the
object and choose Scale from the Graphics menu. Then type a scale factor or the
exact dimensions in the Scale dialog box and click Scale.
A scale factor increases both the height and width of an object proportionally.
The scale factor is always relative to the object’s current size (so 100 percent
means no change). The dimensions shown when you display the dialog box are
the object’s current dimensions.
RESIZING A TEXT LINE

You can’t resize a text line by dragging one of its handles—even if the text line
is part of a grouped object. To change the size of a text line, change the font size
of the text in the text line. For details, see “Specifying font properties” on
page 4-7.
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To smooth and unsmooth an ob ject
You can smooth polylines, polygons, rectangles, and rounded rectangles. When
you smooth a polyline, polygon, or rectangle, you change its angles to smooth
curves. When you unsmooth a curve, you restore its angles.

Before smoothing

After smoothing

Each time you smooth a rounded rectangle, you increase the curvature of its
corners (its corner radius).
When you unsmooth a freehand curve and later smooth it, its shape may be
somewhat different from the original.
■

To smooth an object, select the object and choose Smooth from the Graphics menu.

After smoothing a polygon or polyline, reshape handles and control points
appear so you can reshape the curve. For details, see “To reshape a polygon or
polyline” on page 14-20.
■

To unsmooth an object, select the object and choose Unsmooth from the
Graphics menu.

To chang e the corner radius of a rounded rectangle
You can define the curvature of the “corners” of a rounded rectangle by
specifying the radius of an imaginary circle drawn in the corner of a rectangle.
The longer the radius, the more curved the corners.

r

Radius (r) = .125 inches
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When you specify a corner radius, you also change the current drawing
properties. New rounded rectangles you draw have this corner radius until you
change it with the Object Properties command or until you exit FrameMaker.
1

Select a rounded rectangle.

2

Choose Object Properties from the Graphics menu.

3

In the Object Properties dialog box, specify the corner radius and click Set.

The largest meaningful radius is one-half the length of the shortest rectangle
side. For example, if the rectangle is 2 inches by 4 inches, the largest
meaningful radius is 1 inch (one-half of 2 inches).

To crop or mask a graphic
When you want to crop the edges of a graphic, you use an anchored or
unanchored graphic frame.

Uncropped graphic

Graphic placed and cropped in an
unanchored graphic frame

An anchored graphic frame moves with the surrounding text. An unanchored
graphic frame stays wherever you place it on a page, even when the text around
it moves as the result of editing.
When you want to mask an area of a graphic, particularly if the part you want
to mask is in the middle of a graphic, you can cover the area with nonbordered
objects.
■

To crop the edges of a graphic, create a graphic frame, put the graphic in the frame,
and resize the frame around the graphic.

When you resize the frame, the parts of the graphic that extend beyond the
frame’s border appear cropped.
For details on creating a graphic frame, see “To draw an unanchored graphic
frame” on page 13-14 and “Creating an anchored frame” on page 15-4.
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■

Original graphic

To mask an area of a graphic, put graphic objects (such as rectangles and polygons)
with a white fill and pen pattern in front of the parts you want to mask.

Selected polygon over
part to be masked

White fill and pen pattern

Resulting graphic

To reshape a polygon or polyline
You reshape a polygon or polyline by moving its corners one at a time.
1

Select the object.

2

Choose Reshape from the Graphics menu.

Reshape handles appear on the object, replacing the selection handles.
3

Drag a reshape handle.

To move the handle horizontally or vertically, Shift-drag.

Select.

Choose Reshape.

Drag.

Release.

To reshape a curve
You can create shapes with smooth, continuous curves—Bezier curves—either
by drawing freehand curves or by drawing polygons or polylines and then
smoothing them. You use reshape handles and control points to change the
shape of the curve.

Reshape handle
Control point

You can make reshape handles appear at each location that defines a curve.
Except at the ends of a curve, each reshape handle has two control points.
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Select the curve and choose Reshape from the Graphics menu.

Reshape handles appear at the locations that define the curve. Control points
also appear around one of the handles.
2

If the control points aren’t the ones you want, click the reshape handle where you
want to change the curve.

Control points appear around the reshape handle that you click—the two
control points that correspond to the reshape handle and the next closest one on
each side of the reshape handle.
3

Drag a reshape handle or drag or rotate a control point.

Dragging a reshape handle changes the position of the curve at the handle.
Dragging or rotating a control point changes the curvature. When you begin to
drag, a lever appears that touches the curve at the reshape handle. You can
achieve different effects by dragging along the lever or by rotating it.

Select Reshape.

Drag reshape handle.

Drag control point.

Rotate control point.

As you drag a reshape handle, the control points move as well, so the result is a
smooth curve. As you drag a control point, the curvature changes on both sides
of the reshape handle, so the result is also a smooth curve.
CRIMPING A CURVE

You crimp a curve by dragging a reshape handle without moving its control
points, or by changing the curvature on only one side of a reshape handle. To do
so, Control-drag the handle or the control point.

Select Reshape.

Drag reshape handle or
control point.

Using FrameMaker
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To reshape an arc
The easiest way to reshape an arc is to drag its endpoints.
You can also reshape an arc by specifying its start and end angles (measured
clockwise from 12 o’clock). For details, see “Specifying the start and end angles
of an arc,” next.
1

Select the arc.

2

Choose Reshape from the Graphics menu.

Reshape handles appear on the object, replacing the selection handles.
3

Drag a reshape handle.

As you drag a reshape handle, the start and end angle of the arc, and the
percentage of a circle that the arc represents, appear in the status bar.

Start and end angles

Arc: 270 -306

10%

Arc: 270 18

30%

Percentage of circle

SPECIFYING THE START AND END ANGLES OF AN ARC

To specify the start and end angles, select the arc and choose Object Properties
from the Graphics menu. Then type new Start Angle and End Angle values in
the Object Properties dialog box and click Set.

To add or remove corners
You can add sides and corners to a line, polyline, or polygon by adding reshape
handles, and you can remove sides and corners by removing reshape handles.

Removing a handle
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You can also add or remove reshape handles on a curve to change the number of
points that define the curve.
1

Select the line, polyline, polygon, or curve.

2

Choose Reshape from the Graphics menu.

3

Middle-click.

To add a corner, middle-click the object’s border where you want the corner. To
remove a corner, middle-click it.

MEASURING OBJECTS
As you arrange and resize objects in an illustration, you may want to know an
object’s dimensions and exact position.
The size of an object is the size of the rectangle that encloses its path. The
position is the distance from the top and left edges of the page or graphic frame.
1”
1”

.5”

.5”

Object size

Object position

To measure an object
You can measure an object by using the mouse or a dialog box.
■

With Snap off, select the object, point on one of its handles, and hold down the left
mouse button.

The dimensions appear in the status bar. If you move the mouse by mistake and
resize the object, immediately choose Undo from the Edit menu.
■

Select the object and choose Object Properties from the Graphics menu.

The width and height of the object appear in the Size area of the Object
Properties dialog box.
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To see the position of an object
You can inspect the position of a stationary object, or of an object you are
moving with the mouse.
■

To inspect the position of a stationary object, select the object and choose Object
Properties from the Graphics menu.

For all objects (except equations and text lines), the distance from the upper-left
corner of the page or graphic frame to the object’s topmost and leftmost point
appears in the Offset From area of the Object Properties dialog box.
For equations and text lines, the distance from the upper-left corner of the page
or graphic frame to the alignment point at the baseline of the text line or
equation appears in the Alignment Point Offset From area.
When the object is rotated, the values in the dialog box reflect the location of
the unrotated object.
■

To inspect the position of an object as you move it, look in the status bar.

The distance between the object and the upper-left corner of the page or graphic
frame appears in the status bar. When rulers are visible, guidelines in the
rulers also show the position of the object.

To measure any distance on the page
You can measure the distance between objects on a page.
1

Point where you want to start measuring.

2

Hold down Shift-Control and drag until the selection border encompasses the area
you want to measure.

Holding down Shift-Control forces a selection border to appear when you drag.
The dimensions of the selection border appear in the status bar. In the example,
the important dimension is height, the distance of 0.5 inch between the circle
and the baseline of the text.

A line of text
Width and height
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When you create an illustration that is related to specific text, you can
put the illustration in an anchored frame—a graphic frame that is
anchored to the text. Then, when you edit the text, the frame and its
contents move along with the text automatically.

Anchored frames move with the text
A graphic frame is an object that can contain other objects. It can
contain graphics you draw, clip art you copy from another document,
imported graphics, and text.
When you anchor a graphic frame to a specific text passage,
FrameMaker inserts an anchor symbol at the insertion point. The
frame—and everything in it—moves with the anchor symbol, so you
don’t have to reposition graphics when you edit the document.

Before inserting text

The frame moves down when you insert text
above the anchor symbol.

You choose the anchoring position
You can use an anchored frame for small graphics that appear in line
with paragraph text or for art that appears between columns or in the
page margin. You can also use an anchored frame for an illustration in
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a column of text—below the line that contains the anchor symbol, at the
top of the column, or at the bottom. An anchored frame positioned at
the top or bottom of the column moves only when an anchor symbol
moves to another column.

Margin art
Graphic in the top corner of
a paragraph
Illustration in a column of
text
Small graphic in a line of
text

You can even position an anchored frame in the top corner of a
paragraph with the paragraph text running around the graphic.
If you want an illustration to stay at a specific place on the page—for
example, a logo on letterhead stationery—don’t use an anchored frame
at all. Instead, draw, paste, or import the illustration directly onto the
page, without placing an insertion point in the text. Then drag the
illustration where you want.

Anchored frames are typical FrameMaker objects
You can copy and paste anchored frames, and you can resize them by
dragging them with the mouse. You can even drag some anchored
frames to a different position. In this way, they are like the objects you
create with the FrameMaker drawing tools.
Anchored frames have drawing properties such as border width, pen
pattern, and fill pattern. You can make the frames visible by changing
these properties. Visible frames can serve as borders or backgrounds for
their contents.

In this chapter
This chapter shows you how to create and position anchored frames, fill
them with text and graphics, and edit them.
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CREATING AN ANCHORED FRAME
When you create an anchored frame with the Anchored Frame command, you
specify its size and position. You can position it at the insertion point or in four
positions in the column—at the top of a paragraph (with the text running
around the frame), just below the line that contains the insertion point, at the
top of the column, and at the bottom of the column. You can also position it
outside a column of text.
You can also specify other properties that depend on the frame’s position. For
example, when the frame is placed in the line at the insertion point, you can
specify its distance from the baseline of the text. When the frame is in a column
of text, you can specify its alignment.
An anchored frame is also created—automatically—when you paste or import a
graphic at an insertion point. You can keep the properties assigned to the
frame, or you can change them.
You can create an anchored frame in a text frame or in a table cell (which
FrameMaker treats as a text frame), but not in a text line.

To create an anchored frame
When you create an anchored frame, you specify its position relative to the
insertion point. You also specify several other properties of the frame. You can
change any of the properties, including the frame’s position, at any time. For
details, see “Editing an anchored frame” on page 15-17.
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3

Choose the frame’s anchoring position and specify its size.

Specify the anchoring
position here.
Settings in this area differ for
each anchoring position.

Specify the frame size here.

The properties that appear in the Anchored Frame dialog box depend on the
anchoring position. For details, see the following instructions.
4

Click New Frame.

An anchor symbol ( ) appears at the insertion point when Text Symbols is on in
the View menu.

To position an anchored frame at the insertion point
You position an anchored frame at the insertion point when you want to insert
it in line with paragraph text—for example, to hold a small graphic such as a
picture of the keycap Enter . When you put a space on either side of the
anchored frame, the frame moves along from one line to another as you edit the
document, as if it were a word (rather than being attached to the preceding or
following word).
When an anchored frame is positioned at the insertion point, you can adjust the
frame’s position up or down relative to the baseline.
Positioning an anchored frame is one of the steps in creating it. For the entire
procedure, see “To create an anchored frame” on page 15-4.
1

In the Anchored Frame dialog box, choose At Insertion Point from the Anchoring
Position pop-up menu.
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2

Type the vertical position of the frame in the Distance above Baseline text box.

When you type 0 (zero), the bottom of the frame is aligned with the baseline of
the text. Positive numbers move the frame up; negative numbers move it down.

A price list for our

A price list for our

A price list for our

annual sale

annual sale

annual sale

is

attached. Please note

Zero distance

is

attached. Please note

Positive distance

is

attached. Please note

Negative distance

WHEN THE FRAME OBSCURES TEXT

The frame may obscure text in the line above or below. If it does, turn off fixed
line spacing to allow the line height to change with the contents of the line. For
details, see “To choose the spacing between lines” on page 4-18.
A price list for our
annual sale
is
attached. Please note
the new leather
covering option and
Fixed line spacing is on.

A price list for our
annual sale
is
attached. Please note
the new leather
Fixed line spacing is off.

SHRINKWRAPPING AN ILLUSTRATION

To shrink an anchored frame to the dimensions of its contents and place it in
the line at the anchor symbol, select the frame or an object in the frame and
press Esc m p. To enlarge a frame and place it below the line that contains the
anchor symbol, select the frame or an object in it and press Esc m e.

To position an anchored frame in a column of text
You position an anchored frame in a column of text when you want to insert it
below the current line, at the top of the column, or at the bottom. You can
choose the frame’s horizontal alignment in the column—left, center, right, side
closer to the binding edge, or side farther from the binding edge.
You can prevent a wide frame from extending beyond the edge of the column by
cropping the frame. And you can let the frame float to the next column that can
hold it if the frame and its anchor symbol won’t fit in the same column.
You can also position an anchored frame at the top of a paragraph, with the
paragraph text running around the frame—for example, to set a small graphic
or a drop cap at the beginning of the paragraph. For information, see “To run
text around an anchored frame” on page 15-13.
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Positioning an anchored frame is one of the steps in creating it. For the entire
procedure, see “To create an anchored frame” on page 15-4.
1

In the Anchored Frame dialog box, choose Below Current Line, At Top of Column, or At
Bottom of Column from the Anchoring Position pop-up menu.

Directly below the
anchor symbol

At the top of
the column

At the bottom of
the column

For information on the placement of top-of-column and bottom-of column
anchored frames in multicolumn layouts, see “Anchored frames in multicolumn
layouts” on page 15-9.
2

Choose the alignment from the Alignment pop-up menu.

Left

Center

Right

For a double-sided document, you can also choose Side Closer to Binding or Side
Farther from Binding.

Side Closer to Binding

Side Farther from Binding
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3

To allow a wide frame to extend beyond the edge of the column of text, turn off
Cropped.

Cropped off

Cropped on

When the frame is in a multicolumn text frame, it may straddle the columns.
For details, see “Anchored frames in multicolumn layouts” on page 15-9.
4

To allow a frame to float to the next column that can hold it, turn on Floating.

Floating off

Floating on

When Floating is off, both the frame and anchor move to the first column that
can hold them. White space remains at the bottom of the column.
When Floating is on, the anchor doesn’t move, but the frame floats to the next
column that can hold it. Text from the next column fills the space.
ANCHORED FRAMES AND RUN-IN HEADS

When you want to place an anchored frame below a line that contains a run-in
head, place the anchor symbol in the body paragraph, not in the run-in head.
Otherwise, the anchored frame obscures the text below the run-in head.
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To position an anchored frame outside a column
When you position an anchored frame outside a column of text in a text frame,
you can choose one of several positions: on the left or right side of the column,
on the side closer to or farther from the page edge, or on the side closer to or
farther from the binding in a double-sided layout.
You can adjust the frame’s position up, down, left, and right.
The positions are always relative to the sides of the column, so the frame may
appear between columns on a multicolumn page. For information on positioning

ANCHORED FRAMES IN MULTICOLUMN LAYOUTS
An anchored frame in a multicolumn text frame
can straddle columns, and its position may be
affected by straddle paragraphs.

appears below a straddle paragraph, the frame
appears in the column just below the straddle
paragraph rather than at the top of the column.

Anchored in a straddle paragraph When a frame is

anchored in a straddle paragraph, the frame
straddles columns just as the paragraph does.
Wider than a column An uncropped anchored
frame that extends into a second column of the
body area straddles columns in the body area. A
frame that extends into the side-head area
straddles the side-head area as well.
Anchored at top
of column

Anchored at
bottom of column

A bottom-of-column anchored frame is positioned
similarly when the anchor symbol appears above a
straddle paragraph.

Frame straddles
all columns.

Frame straddles side-head
area and all columns.

A cropped anchored frame straddles columns only
when it’s anchored in a straddle paragraph.
Top and bottom of column When the anchor

symbol for a top-of-column anchored frame

You can force the anchored frame to appear at the
top or bottom of the column (above or below a
straddle paragraph) by making the frame straddle
the columns. To do so, turn off Cropped in the
Anchored Frame dialog box and resize the
anchored frame until it extends into another
column. For more information, see “To position an
anchored frame in a column of text” on page 15-6
and “To resize an anchored frame” on page 15-20.
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an anchored frame so it always appears in the page margin, even in a
multicolumn document, see “Positioning anchored frames in the page margins”
on page 15-12.
Positioning an anchored frame is one of the steps in creating it. For the entire
procedure, see “To create an anchored frame” on page 15-4.
1

In the Anchored Frame dialog box, choose Outside Column from the Anchoring
Position pop-up menu.

2

Choose one of the settings from the Side pop-up menu.

Left

Right

Side Closer to Page
Edge

Side Farther from
Page Edge

For a double-sided document, you can also choose Side Closer to Binding or Side
Farther from Binding.

Side Closer to Binding
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Specify the vertical position of the frame in the Distance above Baseline text box.

When you type 0 (zero), the bottom of the frame is aligned with the baseline of
the text. Positive numbers move the frame up; negative numbers move it down.
A price list for our

A price list for our

A price list for our

annual sale is

annual sale is

annual sale is

attached.

attached.

attached.

Zero distance above
baseline

Positive distance above
baseline

Negative distance above
baseline

You can’t position the anchored frame above the top or below the bottom of the
text frame. If the setting would place the anchored frame above or below the
text frame, FrameMaker puts it as high or as low as possible. If you edit the
text so that the anchor symbol moves away from the top or bottom of the text
frame, FrameMaker adjusts the anchored frame’s position accordingly.
4

Specify the horizontal position of the frame in the Distance from Column text box.

When you type 0 (zero), the edge of the anchored frame is aligned with the
edge of the text column. Positive numbers move the anchored frame away from
the column; negative numbers move it into the column.
A price list for our

A price list for our

A price list for our

annual sale is

annual sale is

annual sale is

attached.

attached.

attached.

Zero distance from column

Positive distance from
column

Negative distance from
column

MAKING ROOM FOR ANCHORED FRAMES

When an anchored frame positioned between two columns is wider than the gap
between columns, you can widen the gap. For information, see “To change the
number of columns” on page 18-9 and “To change the number of columns on an
individual page” on page 19-13.
When you can’t widen the gap, you can move the anchored frame completely
inside the text column. For details, see “Moving a frame into a column” on
page 15-19.
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POSITIONING ANCHORED FRAMES IN THE PAGE MARGINS

You can position anchored frames so they always appear in the page margins,
even in a multicolumn layout in which they might otherwise appear between
columns. To do so, choose the Outside Text Frame anchoring position in the
Anchored Frame dialog box. Choose a side for the frame and specify other
settings, and then click New Frame. The positions in the margin are relative to
the sides of the text frame.

Left Side of Text
Frame

Side Closer to Binding

Right Side of Text
Frame

Side Closer to Page
Edge

Side Farther from
Page Edge

Side Farther from Binding

In a single-column layout, the Outside Text Frame setting has the same effect
as the Outside Column setting.
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To run text around an anchored frame
You can position an anchored frame at the top of a paragraph, with the
paragraph text running around the frame—for example, to set a small graphic
or a drop cap at the beginning of a paragraph.
When you run text around an anchored frame, you can choose one of these
positions: on the left or right side of the column or on the side closer to or
farther from the binding in a double-sided layout. The anchored frame is always
aligned vertically with the top edge of the text in the paragraph.
Positioning an anchored frame is one of the steps in creating it. For the entire
procedure, see “To create an anchored frame” on page 15-4.
1

In the Anchored Frame dialog box, choose Run into Paragraph from the Anchoring
Position pop-up menu.

2

Choose one of the settings from the Alignment pop-up menu.

Left Side of Text
Frame

Right Side of Text
Frame

For a double-sided document, you can also choose Side Closer to Binding or Side
Farther from Binding.

Side Closer to Binding

3

Side Farther from Binding

Specify the gap between the frame and the paragraph text in the Gap text box.

Using FrameMaker

15-13

15

ANCHORING GRAPHICS

Creating an anchored frame

INDENTS AND RUNAROUND TEXT

When an anchored frame is set to Run into Paragraph, FrameMaker aligns the
frame with the paragraph’s left indent when it appears at the left side of the
paragraph, and with the right indent when it appears at the right side. When
the paragraph has a first-line indent, the anchored frame does not change the
position of the indent.

Graphic extends
beyond the first-line
indent.

Larger first-line
indent

When you want to preserve a first-line indent, change the first-line indent
setting for the paragraph. For details, see “To indent a paragraph” on page 4-13.
TALL ANCHORED FRAMES

When an anchored frame set to Run into Paragraph is taller than the
paragraph, FrameMaker runs text from subsequent paragraphs around the
frame unless the paragraph that contains the anchor symbol is a straddle
paragraph.

Frame spanning
two paragraphs
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To create an anchored frame automatically
When you import or paste a graphic into text, FrameMaker creates an anchored
frame automatically to anchor the graphic to text. The frame always appears
centered below the current line. Once the frame is created, you can change its
properties. For details, see “Editing an anchored frame” on page 15-17.
■

Paste an object into text at the insertion point.

Cut or copy the object, click in text where you want to insert the anchor symbol,
and choose Paste from the Edit menu.
■

Import a graphic into text at the insertion point.

Click in text where you want to insert the anchor symbol, choose Import>File
from the File menu, and select the graphic file you want to import. For details,
see “Importing and changing a graphic” on page 16-4.

FILLING AN ANCHORED FRAME
You often put several objects in an anchored frame—imported images, graphics
you draw, and text frames or text lines.

To select an anchored frame
You need to select an anchored frame in order to paste or import objects into it
and in order to edit it. You can also use these steps to select unanchored graphic
frames.
1

If the frame’s border isn’t visible, choose Borders from the View menu.

2

Click the frame’s border.

To put graphics in an anchored frame
You can draw graphics in an anchored frame just as you draw elsewhere, and
you can move, paste, and import graphics into an anchored frame. You can also
use these methods to put graphics in unanchored graphic frames.
■

To draw an object directly in the graphic frame, use one of the drawing tools on the
Tools palette.

For information, see “Drawing objects” on page 13-7.
If you start drawing the object outside the frame, the object will be on the page
and not anchored to text.
■

To move an object into a graphic frame, drag the object until the pointer is within the
frame’s borders.

The object jumps into the frame when you drag across the frame’s border.
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■

To paste an object into a graphic frame from the FrameMaker Clipboard, select the
frame and choose Paste from the Edit menu.

■

To import a graphic into a graphic frame, select the frame and choose Import>File
from the File menu.

For information on importing graphics, see “Importing and changing a graphic”
on page 16-4.
IF A GRAPHIC DOESN’T MOVE WITH THE ANCHORED FRAME

If a graphic looks as though it’s in the anchored frame, but it doesn’t move with
the frame as you edit the surrounding text, the graphic is probably in front of
the frame rather than in the frame—perhaps because you pasted it on the page
rather than in the frame. Drag the graphic completely away from the frame and
then drag it back into the frame.

To put text in an anchored frame
You can put single lines of text or text frames in a graphic frame. You use text
lines for single-line callouts. You use text frames for multiline callouts,
paragraphs of text, and any other text that you want to wrap automatically
from line to line. You also use text frames when you want to insert variables,
cross-references, or markers in the text, when you want to include the text in a
generated list, and when you want to make the text conditional.
You can also use these methods to add text to unanchored graphic frames.
■

To add text in a text line, use the Text Line tool on the Tools palette.

For details, see “To add a text line” on page 13-25.
■

To add text in a text frame, use the Text Frame tool on the Tools palette.

For details, see “To add a text frame” on page 13-26.
ADDING A FIGURE TITLE

You can position a figure in an anchored frame and then use a text frame inside
the anchored frame for the figure title. But you’ll probably find it easier to
position and number the title consistently if you put the figure in a single-cell
table and then set up the table title as a figure title. For more information, see
“To add a title to a graphic” on page 13-28.
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To prevent an anchored frame from clipping its contents
An anchored frame’s contents are clipped when they extend into or beyond the
frame’s border.

Frame border

Widget

Clipped text

Clipped graphic

You can avoid clipping in several ways.
■

When there’s room outside the anchored frame, make the frame larger.

If a frame and its contents are clipped by the edge of a column of text, you can
turn off cropping in the Anchored Frame dialog box. For details, see “To position
an anchored frame in a column of text” on page 15-6.
■

When there’s room inside the anchored frame, move the object away from the edge
of the frame.

For details, see “To move an object” on page 14-4.
■

When the contents are clipped only by the width of the border, use the Tools palette to
make the anchored frame’s border narrower or to change the pen pattern to None.

For details, see “To change a graphic property” on page 13-19.

EDITING AN ANCHORED FRAME
You can change an anchored frame’s settings for anchoring position and size at
any time.
Anchored frames are objects like the rectangles you draw with the Tools
palette, and you can manipulate them as you do other objects—for example,
duplicate, delete, move, or resize them. You can also make an anchored frame
visible by changing its pen or fill pattern to a visible pattern, and you can
change the line width and line style of its border.
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To chang e an anchored frame’s settings
You can change any of the settings you used to create the frame—anchoring
position, size, and so on.
1

Select the frame.

2

Choose Anchored Frame from the Special menu.

3

Change the settings in the Anchored Frame dialog box and click Edit Frame.

To duplicate or delete an anchored frame
You duplicate or delete an anchored frame just as you duplicate or delete other
objects.
■

To duplicate an anchored frame, copy the frame, click in text where you want to
insert the duplicate, and choose Paste from the Edit menu.

When you copy an anchored frame, FrameMaker puts the frame (and any
objects it contains) on the FrameMaker Clipboard.
When you paste the frame, FrameMaker places the anchor symbol at the
insertion point.
■

To delete an anchored frame, select the frame and press Delete.

The anchored frame isn’t placed on the Clipboard.

To move a frame’s anchor symbol
You can move the anchor symbol to change where a frame is anchored. When
you do, the frame is anchored to the anchor symbol’s new location. In some
cases—for example, when the frame is positioned at the top or bottom of a
column of text—the frame may not change position even though the anchor
symbol moves.
1

Select the frame.

You don’t need to select the anchor symbol.
2

Choose Cut from the Edit menu.

When you cut an anchored frame, FrameMaker puts the frame (and any objects
it contains) on the FrameMaker Clipboard.
3

Click in text where you want to insert the anchor symbol.

4

Choose Paste from the Edit menu.

When you paste the frame, FrameMaker places the anchor symbol at the
insertion point.
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To move an anchored frame
You can move a frame anchored outside text frames, outside columns of text, or
at the insertion point without changing the location of the anchor symbol.
When a frame is anchored outside the text frame or outside the column, you
can’t move it above the top or below the bottom of the text frame.
■

For quick but approximate repositioning, drag the frame.

■

For more precise repositioning, move the frame in small increments with the
arrow keys.

For details, see “To move an object” on page 14-4.
■

For greatest precision, specify the location of the frame with the Anchored Frame
command on the Special menu or with the Object Properties command on the
Graphics menu.

For details on using the Object Properties command, see “To specify the exact
position of an object” on page 14-5.
MOVING A FRAME INTO A COLUMN

When you move a frame into a column (either by changing the Distance from
Text Frame setting in the Anchored Frame dialog box or by dragging the
frame), the text in the column doesn’t adjust to accommodate the frame. To
adjust the text in the column, use the Run into Paragraph setting to move the
frame completely inside the column and to run the text around the frame
automatically. For details, see “To run text around an anchored frame” on
page 15-13. Alternatively, you can change the paragraph indents to make room
for the frame. For details, see “To indent a paragraph” on page 4-13.
ROTATING A FRAME

You can rotate a frame in 90-degree increments. For details, see “To rotate an
equation or graphic frame” on page 14-16.
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To resize an anchored frame
You resize an anchored frame just as you resize other objects.
■

To resize the frame quickly but approximately, select the frame and drag one of its
handles.

■

To resize the frame precisely, specify its size with the Object Properties or Scale
command on the Graphics menu.

To chang e an anchored frame’s drawing properties
An anchored frame has properties like other objects. You can change its fill
pattern, its color, and the pen pattern, line width, and line style of its border.
1

Select the frame.

2

Choose the properties you want on the Tools palette.

For details, see “To change a graphic property” on page 13-19.
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You can import graphics into a document as well as create them with
FrameMaker drawing tools. The imported graphics can be created in
another application, digitized with a scanner, or captured from the
screen with FrameMaker.

Imported graphics behave like objects you draw
You can import bitmaps, Encapsulated PostScript (EPS) files, Desktop
Color Separation (DCS) files, and graphic insets. Whatever its format,
once you import the graphic it becomes a single object you can work
with just as you work with an object you create with the FrameMaker
drawing tools. You can move the graphic, resize it, anchor it to text, or
group it with other imported or internally created objects. And you can
cut, copy, and paste the imported graphic, using the same techniques
you use when you work with a simple object such as a rectangle.

MacPaint bitmap

You can import PostScript files into a text frame. The PostScript code
appears on the screen, but the image appears in the printed document
(on a PostScript printer).
FrameMaker includes filters you can use to import other graphic
formats. Your site may have additional filters. If the filter you use
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produces an appropriate format, you can treat the imported graphics as
a collection of editable FrameMaker objects.

Color and gray-scale images are treated as bitmaps
Bitmaps, gray-scale images, and color images are usually created with
a paint program or from a graphic that has been digitized with a
scanner. They are also produced by screen capture. Because bitmaps,
gray-scale images, and color images are all imported in the same way,
this chapter uses the term bitmap for all of them.
A true bitmap is a grid of black-and-white dots. Color and gray-scale
images are also composed of dots, with each dot assigned a color or a
shade of gray. FrameMaker displays color images in color on a color
monitor.

Vector graphics can be black and white, gray scale, or color
A vector graphic contains mathematical descriptions of the objects that
make up the graphic. As a result, it retains its crispness and clarity
when you resize it in FrameMaker, and it is printed at the resolution of
your printer. For example, files in PICT or Windows Metafile format can
contain vector graphic information.

You can import a graphic by copying or by reference
When you import a graphic by copying, the graphic becomes part of the
document. When you import by reference, FrameMaker maintains a
link to the graphic file and updates the document with the current
graphic each time the page is redisplayed.

Some imported graphics can be edited with a graphic inset
editor
A graphic inset is a graphic imported from a specially modified
application—a graphic inset editor. You can start an inset editor from
within FrameMaker, create the graphic inset, and then insert it in your
document. When you want to modify the inset, you can jump to the
editor, change the inset, and then display the updated inset in the
document.
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You can capture screens with FrameMaker
You can use the FrameMaker Capture command to capture any part of
your workstation’s screen—in monochrome, gray scale, or color. Then
you can import the captured screen just as you import any bitmap.

In this chapter
This chapter shows you how to import a graphic and change its scale,
find referenced graphic files, and view an imported graphic’s name. It
also shows you how to work with graphic insets and to capture screen
images.
Chapter 13 describes the drawing tools you can use to create graphics
within FrameMaker documents. Chapter 17 describes printing color
graphics and creating process color separations. The online manual
Using Frame Products on Multiple Platforms describes the graphic
formats you can import into FrameMaker documents.

IMPORTING AND CHANGING A GRAPHIC
You can import a graphic file into a FrameMaker document by copying or by
reference. When you import a graphic file by copying it, FrameMaker stores a
copy of the graphic in the document. When you import a graphic file by
reference, FrameMaker stores only the graphic’s pathname in the document.
For a discussion of the advantages and disadvantages of both methods, see
“Import by copying or by reference” on page 16-7.
After you import a graphic file, you can change its scale or even replace it with a
different graphic. And, as with any other object in FrameMaker, you can move
it, copy it, flip it, and so on.
You can import bitmaps, Encapsulated PostScript (EPS) files, Desktop Color
Separation (DCS) files, and graphic insets.
For a list of graphic formats you can import, see the online manual Using
Frame Products on Multiple Platforms. For information on EPS formats, see
“Encapsulated PostScript” on page 16-5. For information on DCS files, see “DCS
graphics” on page 16-9.
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To import a graphic
You can import a graphic into an anchored or unanchored graphic frame, into a
rectangle acting as a border, or right onto a page. For example, if you want the
graphic to move with text as you edit the document, import the graphic into an
anchored frame. If you want the graphic to stay where you put it—for example,
the logo of a letterhead—import it onto the page and position it where you
want it.
When you import a graphic, you sometimes specify an import filter based on the
graphic’s format. When you import a bitmap, you also specify its scale in dots
per inch (dpi). The larger the dpi value, the smaller the graphic is on the page.
1

Indicate where you want to place the graphic.

To place it in a graphic frame, select the frame or put an insertion point in a
text frame where you want to create an anchored frame.
To place it directly on a page, click in the page margin; don’t click on any object
or in any text frame on the page.
To replace an imported graphic or rectangle, select the object you want to
replace.
2

Choose Import>File from the File menu.

ENCAPSULATED POSTSCRIPT
An Encapsulated PostScript (EPS) file uses the
PostScript page description language. Each EPS
file contains PostScript code for printing the image,
and may also contain a preview image for viewing
on the screen. If an EPS file does not contain a
preview image, or if the platform does not support
the format of the preview image, it appears on the
screen as a gray box.
In Windows, the EPS file’s preview image appears
correctly on the screen when it is in TIFF or
Microsoft Windows MetaFile format. On the
Macintosh, the preview image appears correctly
when it is in TIFF or QuickDraw PICT format.

EPS Interchange (EPSI) files are designed for
cross-platform use. They contain a bitmap preview
image and can be imported and displayed on the
screen by Windows, Macintosh, and UNIX versions
of FrameMaker.
The UNIX version of FrameMaker cannot import
an EPS file saved in DOS/Windows EPS format
because this format contains binary data in the
header and in the preview image. To import a
Windows EPS file successfully on UNIX, save the
EPS file without a preview image or header, or
save it as an EPSI file. For details on removing the
preview and header from an EPS file, see the
online manual Using Frame Products on Multiple
Platforms.
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3

Select the graphic file you want to import and the import method.

Select the graphic file to
import.

Click an import method.

For information on the Import by Reference and Copy into Document settings,
see “Import by copying or by reference” on page 16-7.
4

Click Import.

5

If the Unknown File Type dialog box appears when you click Import, select an import
filter in the scroll list and click Convert.

When you import a bitmap, the dialog box shown with the following step
appears, and you continue with that step.
Otherwise, the imported graphic appears in the document and you’re finished.
When you import the graphic directly on the page, and the graphic overlaps a
text frame, text runs around the graphic. For information on running text
around a graphic, see “To run text around a graphic” on page 13-30.

16-6

Using FrameMaker

6

.....

IMPORTING GRAPHICS

Importing and changing a graphic

In the dialog box that appears if you’re importing a bitmap, choose a scaling option
and click Set.

Click here to scale the
graphic to fit inside the
selected rectangle.
Or click here to scale the
graphic to one of these dpi
values.
Or type a custom dpi value.

The measurements next to the dpi values show the size of the resulting image
at the various resolutions.

IMPORT BY COPYING OR BY REFERENCE
Copying a graphic into a document keeps the
document and its graphic together, making it easy
to copy them from one location to another.
However, copying a graphic into a document
increases the document size. In addition, if you
make changes to the graphic file, you must
reimport the graphic to update the document with
the latest version.
If you import a graphic file by reference,
FrameMaker stores only the pathname to the
graphic file in the document. Each time you open
the document, FrameMaker locates the graphic file
on the disk and displays it in the document. If you
make changes to the graphic file, FrameMaker
updates the document with the latest version of
the graphic each time the page is redisplayed.

Importing by reference conserves disk space. It lets
you use the same graphic in several places and
updates all occurrences of that graphic.
A few graphic file formats are not compatible
across platforms. If you need to display a graphic
on another platform, but the graphic’s format isn’t
supported there, import the graphic by copying it
into the document. FrameMaker saves the graphic
with the document, and also uses a filter to add the
graphic in FrameImage format (for bitmap
graphics) or FrameVector format (for vector
graphics), which can be displayed on all platforms.
For more information on FrameImage and
FrameVector formats, see the online manual Using
Frame Products on Multiple Platforms.
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When you choose to fit the graphic in the selected rectangle, FrameMaker
scales the graphic so the larger of its width and height just fits in the rectangle.
When you click Set, FrameMaker replaces the rectangle with the imported
graphic.
When you import the graphic directly on the page, and the graphic overlaps a
text frame, text runs around the graphic. For information on running text
around a graphic, see “To run text around a graphic” on page 13-30.
SUGGESTED SCALING OPTIONS

For the best printed results, choose a dpi value that divides evenly into the
resolution of your printer. For example, if you have a 300-dpi printer, import a
bitmap at 75, 100, 150, or 300 dpi. If you print to a high-resolution device, such
as a 1270 dpi or 2540 dpi printer, you can also choose a dpi value that divides
into the resolution of your printer leaving only a small remainder. For example,
many screen captures in this manual are imported at 141 dpi.

75 dpi

100 dpi

150 dpi

300 dpi

PROBLEMS DISPLAYING IMPORTED GRAPHICS

If the graphic appears as a gray box and an error message appears in the
window in which you started FrameMaker, you probably don’t have enough
memory allocated for images. For information on changing the memory
allocation for images, see the online manual Changing Setup Files.
If color images appear in black and white on a color monitor, change the
resource Maker.colorImages to True or restart FrameMaker with the
+colorImages command-line option. When you display color images in color,
their colors change depending on whether the window is active. For details, see
the online manual Changing Setup Files.
If a black-and-white image appears inverted, use the fminvert script to
invert the image. For details, see “fminvert” on page B-12.
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To chang e a bitmap’s scale
If you import a bitmap, you can make it larger or smaller by changing its
dpi value.
1

Select the bitmap and choose Object Properties from the Graphics menu.

2

In the Object Properties dialog box, click Set dpi.

3

In the Imported Graphic Scaling dialog box, select a new dpi value and click Set.

For information on choosing a bitmap scale, see “Suggested scaling options” on
page 16-8.
SHORTCUTS

You can also scale a bitmap by resizing it with the mouse or by choosing Scale
from the Graphics menu. To prevent the bitmap from being distorted, maintain
its proportions when you resize it. If you resize the bitmap with the mouse,
Shift-drag a corner handle. If you use the Scale command, specify a scale factor.

DCS GRAPHICS
DCS is a standard used by applications such as
Adobe Photoshop to allow the printing of processcolor graphics using a high-end PostScript
prepress system.
A DCS graphic comprises five files, all of which
must be present: a main file that contains the
preview image, and a file for each of the four color
separations. The filenames depend on the
application that created the files. The main file
might include the word Main or Master in its
name. In Photoshop, the main file is the only one
without a filename extension; each separation file
has an extension that indicates its color. For more
information, see the documentation for the
application that created the DCS graphic.

To import a DCS graphic, you import only the main
file. You can import it by reference or by copying.
When you import it by copying it into the
document, the document size increases
dramatically.
Always keep the main file and its separation files
in the same directory, and don’t rename any of the
files. Otherwise, FrameMaker won’t be able to find
the separation files.
Unlike other imported graphics, you can’t apply a
color to a DCS graphic using the Tools palette.
FrameMaker always uses the colors specified in
the separation files.
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To replace a graphic
If a graphic changes and you imported it by copying, or if you just want to
substitute one graphic for another, you can replace the existing graphic.
FrameMaker places the new graphic in the same location as the old one.
1

Select the current graphic.

2

Import the new graphic.

When the Imported Graphic Scaling dialog box appears, the dpi value of the
current graphic is automatically selected. You can keep the same dpi value or
choose another.

To import PostScript code
You can import PostScript code in a text frame to create special effects. Unlike
when you use an EPS file with a preview image, you don’t see a representation
of the printed image on the screen. However, when you print the file on a
PostScript printer, FrameMaker prints the image that the PostScript code
describes rather than printing the code as text in the text frame.
1

Draw a text frame to hold the PostScript code.

Use the Text Frame tool on the Tools palette. For details, see “To add a text
frame” on page 13-26. Depending on the PostScript code, you may need to draw
the text frame at the lower-left corner of the page. For details, see “How
FrameMaker prints the PostScript code” on page 16-11.
2

Type, paste, or import the PostScript code into the text frame.

3

Choose Customize Layout>Customize Text Frame from the Format menu.

4

In the Customize Text Frame dialog box, turn on PostScript Code and click Set.

You can select the text frame as an object, but you can no longer put an
insertion point in the frame.
EDITING THE POSTSCRIPT CODE

To edit the code in a PostScript code text frame, you must first select the text
frame and use the Customize Layout>Customize Text Frame command on the
Format menu to turn off PostScript Code. After you edit the code, use the
Customize Layout>Customize Text Frame command to turn it on again.
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REFERRING TO EXTERNAL POSTSCRIPT FILES

You can refer to external PostScript files in a PostScript code text frame. To do
this, place the following command at the beginning of a line in a PostScript code
text frame:
#include "filename"
where filename represents the pathname of the PostScript file.
You must type a full pathname to ensure that FrameMaker can find the include
file, unless the file is in the directory from which you started FrameMaker.
HOW FRAMEMAKER PRINTS THE POSTSCRIPT CODE

When you print the document, FrameMaker sets up the PostScript stack for the
code in the text frame. It pushes the text frame’s lower-left page-relative
coordinates, width, and height onto the PostScript stack before the imported
PostScript code is stored in the PostScript file. FrameMaker also resets the
origin (0,0) to the lower-left corner of the text frame. If the text frame that
contains the PostScript code isn’t located at the lower-left corner of the page,
the image may print off the page. The PostScript code must control its own
scaling and clipping.
To see how FrameMaker sets up the stack before it executes the code, use the
Print command to print the document to a file. You can then examine the
PostScript code for the entire document.
If a PostScript code text frame contains a PostScript error, the rest of the
document may not print, or may print incorrectly.
SAMPLE POSTSCRIPT CODE

For some examples of PostScript code you can place in a PostScript code text
frame, see the sample document SpecEffects, available from the Frame
electronic bulletin board service (BBS). For details, see “To reach the Frame
electronic bulletin board” on page A-4.
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MANAGING GRAPHICS IMPORTED
BY REFERENCE
When you open a document that contains a graphic file imported by reference,
FrameMaker looks for the graphic file with the pathname that was specified
when the file was imported, and then displays the graphic in the document. For
information on the pathname, see “How FrameMaker locates imported graphic
files” on page 16-12.
FrameMaker may not be able to find the graphic for several reasons.
• The document was moved to a new location, but the graphic files weren’t.
• The graphic file was removed or moved to a new location.
• The graphic file was renamed.
• The directory containing the graphic file was renamed.
If FrameMaker can’t find the graphic file it’s looking for, you can specify its new
location. You can also skip that file and continue opening the document.
At other times, a document may contain an imported file with a name you can’t
remember. As long as the file was imported by reference, you can look up its
filename.

HOW FRAMEMAKER LOCATES IMPORTED GRAPHIC FILES
The pathname that FrameMaker stores for a
graphic file imported by reference is usually
relative. That is, it shows the location relative to
the directory of the document that contains the
imported graphic. For example, rfiles/Palette
is a relative pathname indicating that Palette is
in the rfiles subdirectory of the document’s
directory. However, if FrameMaker has to traverse
the root of the file system when building the
pathname, it uses an absolute pathname that
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begins at the root (/). For example,
/usr/sales/rfiles/Palette is an absolute
pathname.
Because FrameMaker stores relative pathnames
whenever possible, it will continue to find the
graphic if you move the document and graphic files
to a different directory—as long as you keep the
files in the same relative locations. And if you save
the document in a different directory, FrameMaker
adjusts the pathnames accordingly.
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To organize graphic files
You’ll find it easier to maintain your graphic files and the FrameMaker
documents that contain them if you follow a few simple guidelines for
organizing the files.
■

Keep all graphic files for a document in one directory.

It’s easier to move or copy files in a single directory than to move or copy files
scattered in several directories.
■

Put graphic files in the same directory as the document or in a directory below the
document directory, and import them by reference.

If you move the document directory (and its subdirectories) to another location,
FrameMaker can still find the graphic files when you open the document.
■

Use a filename extension to indicate the graphic file type.

For example, you could use the extension .eps for Encapsulated PostScript
files. You may even want to create different directories for different graphic
file types.
■

Give graphic files descriptive names.

Documents are much easier to maintain when imported graphics have
filenames such as filemenu.eps rather than screen1.eps.
■

Consider the file-naming conventions of each computer platform on which you use
your FrameMaker documents.

For example, the Macintosh doesn’t allow colons in filenames, Windows 3.1 and
earlier versions allow filenames of up to eight characters with a three-character
extension, and spaces can cause problems on UNIX platforms. For more
information, see the online manual Using Frame Products on Multiple
Platforms.
■

Put graphic files that may be used in several documents in a central directory, and
import them by reference.

If a graphic file is changed, all documents that reference the graphic are
updated.

Using FrameMaker
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To locate a graphic FrameMaker can’t find
When you open a document that contains graphic files imported by reference,
FrameMaker looks for all the referenced graphic files. If FrameMaker can’t find
a graphic file, it displays a dialog box.

FrameMaker is looking for
this file…

… in this directory.

At this point, you can tell FrameMaker where to find the file, or you can decide
to skip the graphic and proceed with opening the document.
1

Indicate whether you want to display the graphic.
Purpose
Action
Notes
..........................................................................
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Find and display the
graphic

Use the scroll list to
select it and click
Update Document to
Use New Path.

FrameMaker creates a
new path to the file.

Skip the graphic file

Click Skip This File.

FrameMaker continues
to look for other graphic
files imported by
reference.

Skip other graphic
files if FrameMaker
can’t find them

Click Ignore All
Missing Files.

Use this option if you
copied a document (but
not the graphic files) to
another location and you
just want to edit its text.
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When you click Update Document to Use New Path, FrameMaker continues to
use the new path while opening the document to try to find other missing files.
That way, if you move your graphic file directory, you have to tell FrameMaker
the new path only once.
When you choose to skip the file, the skipped graphic appears as a gray
rectangle in the document. The next time you open the document, FrameMaker
tries to find the file again.
2

Click Continue.

To view an imported graphic’s filename
At times, you may want to know the name of a graphic file imported by
reference. For example, you may need to recapture a screen image and want to
give it the same name as the existing image.
1

Select the graphic and choose Object Properties from the Graphics menu.

The graphic’s pathname appears in the dialog box.
2

Click Cancel.
CREATING A LIST OF IMPORTED GRAPHICS

You can create a list of all the imported graphics in a document. For
information, see “Generating a list of references” on page 22-9.

WORKING WITH GRAPHIC INSETS
A graphic inset is a graphic created in a special application—a graphic inset
editor—and then inserted in a FrameMaker document. You use the inset editor
to modify the graphic inset as well as to create it. In either case, you can start
the editor from within FrameMaker
A graphic inset has one or more facets—representations of the image. One facet
might be used by the graphic inset editor, a second might be used to display the
image, and a third might be used for printing. For example, an inset may have a
bitmap facet for viewing and a PostScript facet for printing.
In general, you work with graphic insets just as you do with other imported
graphics—you can cut, copy, and paste them. This section gives a general
understanding of how to work with graphic insets. For more specific
information, see the documentation for your inset editor.
Graphic inset editors are available from a number of sources. For information,
see the FrameConnections™ Catalog. For information on obtaining this catalog,
see “To find out about a third-party product or service” on page A-8.
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To create a graphic inset
FrameMaker knows the name and location of the graphic inset editors
available to you. For example, your site could have a drafting application set up
as an inset editor so you can move in and out of the editor, generating technical
illustrations for a specification being written in FrameMaker. For information
on the inset editors you can use, see your system administrator. For information
on configuring your system to use inset editors, see the online manual
Changing Setup Files.
1

Choose Graphic Inset from the Special menu.

If only one inset editor is available, an alert appears that asks whether you
want to start the editor. If several inset editors are available, the Graphic Inset
Editors dialog box appears.
2

In the Graphic Inset Editors dialog box, select an editor in the scroll list and click Start.

If the inset editor is already running, the editor window appears in front of
other windows.
If the editor isn’t running, FrameMaker asks whether you want to start the
editor. Click OK to start the editor.
3

Use the inset editor to create the graphic inset.

For more information, see the documentation for your inset editor.
4

Indicate where you want to place the graphic inset in a FrameMaker document.

To place it in a graphic frame, select the frame or put an insertion point in a
text frame where you want to create an anchored frame.
To place it directly on a page, click in the page margin—don’t click any object or
in any text frame on the page.
To replace an imported graphic or rectangle, select the object you want to
replace.
5

Choose the command in the inset editor that places the graphic inset in a
FrameMaker document.

To edit a graphic inset
After pasting or importing a graphic inset into a document, you can use the
graphic inset editor to change the inset.
1

Double-click the graphic inset.

If the corresponding inset editor is already running, the editor window appears
in front of other windows and displays the graphic inset.
If the editor isn’t running, FrameMaker asks whether you want to start the
editor. Click OK to start the editor.
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2

Use the inset editor to modify the graphic inset.

3

Choose the command in the inset editor that places the graphic inset in a
FrameMaker document.
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CAPTURING A SCREEN IMAGE
You can capture an image of any rectangular area of your workstation’s screen
and store it in X11 X Window Dump (xwd) image format. For example, if you’re
using FrameMaker to write a manual for a software application, you may want
the manual to include illustrations of the software—menus, dialog boxes, the
results of operations, and so on. After capturing the images, you can import
them into a FrameMaker document.
You can capture images on both monochrome and color workstations. On a color
workstation, FrameMaker creates a color image. You can convert a color image
to black and white before importing it. For more information, see “xwd8to1” on
page B-13.

To capture an image
Before you capture a portion of your workstation’s screen, you first specify the
file in which you want to store the image. Then you indicate the rectangular
area you want to capture. You can edit the resulting graphic file with a paint
program that supports the xwd format.
1

Position the image you want to capture so that no other objects touch it or are
behind it.

Because you may not find it easy to capture the exact edge of the image,
providing a clean background makes screen captures look better. If the object
you want to capture is movable, move it over an empty window or a blank page
in a FrameMaker document. If the object is unmovable, you can crop stray bits
out of the captured image. For details, see “To crop or mask a captured image,”
next.
2

Choose Utilities>Capture from the File menu.

3

In the Capture dialog box, specify a filename and directory for the bitmap.

4

Click Capture.

After a few moments, the pointer changes to

.

For guidelines on naming and organizing filenames for screen images, see “To
organize graphic files” on page 16-13.
5

Position the pointer at one corner of the image.
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6

Drag across the image until the capture border surrounds the image.

As you drag, FrameMaker displays the outline of a capture border. Pixels under
the border are included in the bitmap. When you release the mouse button,
FrameMaker displays a message telling you the screen image has been
captured.

Capture
border

Drag.

7

Release.

Click Continue.

If you didn’t capture exactly the image you want, simply repeat the procedure.
USING THE COLOR MAP OF ANOTHER APPLICATION

When you capture an image in an application’s window, you probably want to
use the color map for that application rather than for FrameMaker. To do this,
you can specify a time interval to allow you to move the pointer to the
application’s window—thus switching the color map—before the screen is
frozen for capture. To specify the time interval, which is normally zero, edit the
resource Maker.captureDelayTime. For information on editing resources,
see the online manual Changing Setup Files.

To crop or mask a captured image
If a captured image has stray bits around the edges, you can remove them.
1

Capture the image as close to its edges as possible.

2

Create a new blank FrameMaker document to create a blank background.

3

Import the image onto the blank page.

Use a dpi value that matches the resolution of your screen, so the imported
image looks exactly the same as the original.
4

Turn off borders.

5

Draw objects with white fill and no pen pattern on top of the parts you want to remove.

6

Capture the image.

Make sure the zoom setting is 100 percent, so the imported image looks exactly
like the original.
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Color adds excitement to any document. With FrameMaker, it’s very
easy to apply color to text and objects.

You define the colors you want to use
You can create colors and give them any name you want. FrameMaker
provides three color models to choose from—CMYK, RGB, and HLS—
and includes PANTONE colors to help you define colors. Each of these
color models has a different purpose. For example, you use CMYK for
process printing and RGB for online viewing. And you use PANTONE
colors for spot color printing.
After you define the colors, you can assign them to text and objects in a
document. You can even include a color as part of character and
paragraph formats.
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You can see color views
You can define up to six views for checking the color assignments on the
screen. A view lets you look at some colors but not others. After defining
a view, you can use it again at any time.

You can print color separations
If you’re sending your document to a commercial print shop, you can
print process color and spot color separations. When printing process
color separations, FrameMaker prints four separate sheets (one
separation each for cyan, magenta, yellow, and black) for each page. The
commercial print shop uses the separations (which are printed on a
black-and-white printer) to create printing plates. On the press, each
plate is printed with the appropriate ink color. The colors on the page
are produced as mixtures of the four separation colors. When printing
spot color separations, FrameMaker prints one plate for each spot color
whenever it appears in a document.
You can also print composite pages that show all the colors on one page
as they appear on the screen. Composite pages are printed in color on a
color printer and in black or gray scale on a black-and-white printer.

Clean color printing requires proper registration
Because each color separation is run through the printing press
separately, each color must print correctly in relation to the other
colors. This relationship is called registration. With FrameMaker, you
can adjust individual objects for proper registration by using
overprinting that lets one colored object print over another one.

If registration is bad when
printing colors, gaps can
appear between colors.

Registration is corrected by
overprinting the objects.

In this chapter
This chapter explains how to assign colors to text and objects, how to
define and view colors, and how to print color documents.
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ASSIGNING AND DEFINING COLORS
You can assign color to text or objects. Before you start assigning and defining
colors, take a few moments to think about how you will use color. For a few tips,
see “Planning to use color” on page 17-4.
For example, you may want to assign a color to chapter or table headings. The
colors you assign are mixtures of the colors in the model you’re using.
The available color models are:
• CMYK (cyan, magenta, yellow, black): used by commercial print shops
• RGB (red, green, blue): screen colors, used primarily for creating online
hypertext documents
• HLS (hue, lightness, saturation): traditional color model used by artists
You can use PANTONE colors (PANTONE MATCHING SYSTEM) to define
colors that are mixed in precise formulas that print shops can match. You
usually use PANTONE colors for spot colors, but FrameMaker can provide
process color approximations for PANTONE colors.
FrameMaker stores colors separately for each document. You can create new
colors in a document or change the makeup of existing colors. If you import an
EPS image with its own PostScript color definitions, those definitions are added
to the document. You can also use the color definitions from another
FrameMaker document. For information on using color definitions from
another document, see “Importing formats into a document” on page 21-12.

PLANNING TO USE COLOR
As you plan to use color, consider these tips:
• Early in the design process find out if your
commercial print shop has any special
requirements. Your printer may be able to suggest
ways you can use FrameMaker to ease the
production process and reduce color printing costs.
• Become familiar with the range of colors
available on your monitor and printing devices.
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Not all monitors can display all colors, nor can all
printers print all colors.
• Consult a professional designer. The advice of a
designer can turn a good book design into an
excellent one.
• Always use character or paragraph formats to
assign color to text. This ensures that similar
paragraphs are the same color and makes it easier
to change colors.
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To assign colors to text and obj ects
The method you use to assign a color differs for text and objects. Any color in a
Color pop-up menu can be applied to FrameMaker text or objects. FrameMaker
supplies a set of standard colors that you can add to. For information on adding
colors, see “To create a new color” on page 17-6.
■

Use a paragraph format, character format, or Color pop-up menu to assign a color.
To assign a color to
Use
..........................................................................

Paragraphs

A format from the Paragraph Catalog

A word or phrase in a
paragraph

A format from the Character Catalog

A text line

A format from the Character Catalog, the Color
pop-up menu in the Object Properties dialog box,
or the Color pop-up menu on the Tools palette

Objects or imported
graphics

The Color pop-up menu on the Tools palette or the
Color pop-up menu in the Object Properties dialog
box

Text in a table

The method for assigning color to paragraphs or
to a word or phrase in a paragraph as described
above

Cells in a table

The Color pop-up menus in the Custom Ruling
and Shading dialog box or in the Table Designer

Change bars

The Color pop-up menu in the Change Bar
Properties dialog box

Equations or elements
in an equation

A format from the Character Catalog

If the Paragraph Catalog or the Character Catalog doesn’t contain the format
you need, you can create one. For information about creating a format that
contains color, see Chapter 5, “Format Catalogs.”
ASSIGNING COLOR TO A TEXT FRAME

If you want to tint the background of a text frame as if it were a rectangle,
Control-click the text frame to select it. Then use the Tools palette to change its
fill pattern to a visible pattern and to assign a color.
You can achieve the same effect by placing a tinted rectangle behind a text
frame that has its fill pattern set to None.
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ASSIGNING COLOR TO AN IMPORTED GRAPHIC

If you want to tint an imported black-and-white or gray-scale image, assign a
color to it just as you assign a color to an object created with the FrameMaker
drawing tools. When you print the object using spot color separations, the
image is printed on the plate for the color you assigned it.

To create a new color
You create colors by specifying the color levels in the model you’re using. New
colors are added to all the FrameMaker Color pop-up menus and to scroll lists.
You can also create a color by choosing a PANTONE color. For details, see “To
define PANTONE colors” on page 17-8.
1

Choose Color>Definitions from the View menu.

The Color Definitions dialog box appears.
2

If you want to change the color model, click a button in the Color Model area.

You can choose the color model you want to use to define colors for a document.
For information about the color models, see “Which color model to use” on
page 17-6, “Color levels in CMYK and RGB models” on page 17-22, and “Color
levels in the HLS model” on page 17-23.
The Color Definitions dialog box changes to reflect the new color model.

WHICH COLOR MODEL TO USE
Choose one of the color models to get the kinds of
color results you want. If you’re using only
PANTONE colors (to print spot colors), choose any
model. FrameMaker uses automatic color
matching to approximate the PANTONE colors in
the model you choose.
CMYK Use the CMYK model when you want to
create color separations for four-color process
printing. Commercial print shops can print most
colors from a combination of cyan, magenta, yellow,
and black (CMYK) color components. Each color
component is printed on a separate plate, in a
different concentration, depending on how much is
needed to create the desired color.

17-6

Using FrameMaker

RGB Use the RGB model when you are creating
colors that will be seen on a monitor (for online
documentation, for example). RGB colors are
created by mixing red, green, and blue light.
HLS The HLS model is most like the one artists
use to mix colors and is used in many application
programs’ color wheels for picking colors. Use this
model if you are familiar with color wheels. Hue is
the color’s general look (red, green, yellow, blue,
and so on). Lightness refers to the lightness or
darkness of a color. Saturation is a color’s clarity
(how little gray is in the color).

3

.....
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In the Name text box, type a name for the color.

The pop-up menu to the right of the text box lists the colors already defined for
the document.
4

Provide values for the new color.

The dialog box will vary depending on the color model you’re using. The
example shown here is for the CMYK model.

New color
Use the color value text
boxes and scroll bars to
specify the values that will
make up the new color.

Current color

As you change color values, if you’re using a color monitor, the New color square
changes to reflect the new settings. If you’re using a monochrome monitor, all
colors—except for white and very light colors—display as black. For more
information on color levels, see “Color levels in CMYK and RGB models” on
page 17-22 and “Color levels in the HLS model” on page 17-23.
5

Click Set.

The new color is added to the document and to the pop-up menu next to the
Name text box.
6

If this is the only color or the last color you want to create, click Done.

If you want to create additional colors, repeat steps 2 through 5, once for each
color you want to create, before clicking Done.
You can also alter and delete colors before clicking Done. Clicking Done doesn’t
apply a color to a currently selected object.
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NAME COLORS BY FUNCTION

If you’re creating a color for a specific purpose, name the color accordingly to
avoid confusion when assigning colors to objects. For example, rather than
name the color for callout rules or headings sky blue, you could name it callout
or heading. However, avoid creating multiple names for the same color. For
more information, see “Inconsistent color names” on page 17-19.

To define PANTONE colors
Use the PANTONE MATCHING SYSTEM for spot colors. PANTONE colors are
created with specific formulas. As long as you don’t edit the definition of a
PANTONE color, commercial print shops can precisely match the formula
represented by the color name.
1

Choose Color>Definitions from the View menu.

2

In the Color Definitions dialog box, choose PANTONE from the Other pop-up menu.

3

In the PANTONE Colors dialog box, select the color you want to define.

Use the scroll bar at the bottom of the dialog box to scroll to the color you want
to define. You can also type the name of the color in the text box. When you
type the name, the dialog box scrolls to the page that contains the color and
selects it.

Type the name of the color
here…

…or use the scroll bar to
display the color you want.
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You may want to use a PANTONE Color Reference Manual (swatch book) to
help you choose exactly the color you want.
4

Click Done.

The PANTONE color name appears in the Name text box in the Color
Definitions dialog box. It also appears as the Set Name below the Name text
box. The color values for the color model you’re using appear in the color value
text boxes.

PANTONE color name

Color values for this
PANTONE color
appear in these text
boxes.

5

If you want to assign a different name to the color, type the name in the Name
text box.

6

Click Set.

The new color is added to the document and to the pop-up menu next to the
Name text box.
7

If this is the only color or the last color you want to create, click Done.

If you want to create additional colors, repeat steps 2 through 6, once for each
color you want to create, before clicking Done.
You can also alter and delete colors before clicking Done. However, if you alter
the color values of a PANTONE color, FrameMaker removes the PANTONE
color name from the Name text box and the Set Name area in the Color
Definition dialog box. Clicking Done doesn’t apply a color to a currently selected
object.
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PANTONE COLOR ACCURACY

When printing PANTONE colors, remember that PANTONE Color computer
hard copy simulations used in this product are four-color process simulations
and may not match PANTONE-identified solid color standards. Use PANTONE
Color Reference Manuals for accurate color.
PANTONE Color simulations are only obtainable on licensed hardware when
driven by qualified Pantone-licensed software packages. Contact Pantone, Inc.
for a current list of qualified licensees. Pantone, Inc. assumes no responsibility
for color inaccuracies on nonlicensed output devices.  Pantone, Inc.,
1986, 1992.

To alter a color
You can change the mixture that makes up a color. When you change a color,
any objects currently assigned that color are updated. FrameMaker won’t let
you change the base colors (cyan, magenta, yellow, black, white, red, green, and
blue), PANTONE colors, or any colors used by imported EPS files.
1

Choose Color>Definitions from the View menu.

2

In the Color Definitions dialog box, choose the color you want to change from the
pop-up menu next to the Name text box.

You can also type the name of the color in the Name text box. The values for
that color appear in the color level text boxes.
3

Specify new values in the color level text boxes.

As you enter values, if you’re using a color monitor, the New color square
changes to reflect the new settings. The Current color square shows the color as
it originally appeared. If you’re using a monochrome monitor, all colors—except
white and very light colors—display as black. For more information on color
levels, see “Color levels in CMYK and RGB models” on page 17-22 and “Color
levels in the HLS model” on page 17-23.
To return to the original color definition, click Reset.
4

Click Set.

The changes are applied to the document.
5

If this is the only color or the last color you want to alter, click Done.

If you want to alter other colors, repeat steps 2 through 4, once for each color
you want to alter, before clicking Done. You can also create and delete colors
before clicking Done. Clicking Done applies all these actions to any text or
objects using the affected colors.
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To delete a color
When you delete a color, FrameMaker asks whether you want to assign black to
objects currently using that color. FrameMaker won’t let you delete the base
colors (cyan, magenta, yellow, black, white, red, green, and blue) or any colors
used by imported EPS files.
1

Choose Color>Definitions from the View menu.

2

In the Color Definitions dialog box, choose the color you want to delete from the
pop-up menu next to the Name text box.

You can also type the name of the color in the Name text box. The values for
that color appear in the color level text boxes.
3

Click Delete.

The new color is deleted from the document and from the pop-up menu next to
the Name text box. FrameMaker displays an alert if the deleted color is
assigned to any text or objects in the document.
4

If this is the only color or the last color you want to delete, click Done.

If you want to delete other colors, repeat steps 2 and 3, once for each color you
want to delete, before clicking Done.
You can also create and alter colors before clicking Done. Clicking Done applies
all these actions to any text or objects using the affected colors.

VIEWING COLORS
A color view specifies which colors are visible. For example, if your document
has black and a spot color, you could have one view in which both colors are
visible, one view in which only black is visible, and one view in which only the
spot color is visible. This feature is especially helpful if you are doing color work
on a monochrome monitor.

!

!

Preparation

Both colors visible

Only black visible

Preparation

Only spot color visible
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If you want to check that all headings use the correct color, you can set up a
view that turns off the color in question. Any headings still visible when that
view is displayed are not assigned the correct color.

To display a view
To check the color assignments in a document, you can turn on any one of the
six defined views.
1

Choose Color>Views from the View menu.

2

In the Define Color Views dialog box, turn on the view you want to display and
click Set.

To set up a view
For each view you set up, you specify which colors you want to display, which to
display as cutouts, and which not to display at all. Displaying a color as a cutout
makes the color appear cut out (white) where it overlaps text or objects in a
different color.
You may want to view cutout separations when you’re working on a
monochrome monitor. By cutting out a color when it appears in the foreground
of overlapping objects, you can better see which colors are assigned to which
objects. You can print cutout separations to create knockouts—separations in
which text and objects in one color are omitted when they overlap a different
color.
1

Choose Color>Views from the View menu.

2

Select a view number and move the color names to the appropriate scroll lists.

Choose one of six views
to set up.

Move the colors you want
to view here.
Move the colors you want
to cut out here.
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To move a color between scroll lists, select the color and click an arrow, or
double-click the color. To move all colors from one scroll list to another, select a
color in the list and Shift-click an arrow.
To return a view to the default settings, click Get Default at any time.
Colors in the Normal list appear on your monitor when you select the view. A
color in the Cutout list makes a color appear white when it overlaps text or
objects in a different color. Colors in the Invisible list do not appear in the view.
If you are using a monochrome monitor, all colors, including white, will be black
when visible. (White is normally cut out, but it appears as black to indicate
where white ink would be used.)
Consider leaving View 1 unmodified; that is, leave all colors (except white) in
the Normal scroll list. When you draw an object in a color that is invisible in the
current view, FrameMaker automatically switches to View 1.
3

If this is the only view or the last view you want to set up, click Set.

If you have additional views to set up, repeat step 2, once for each view you
want to set up, before you click Set. When you click Set, the currently selected
view is displayed.

PRINTING COLORS
If you have overlapping color objects in your document, you may need to adjust
the objects for proper registration before you print color separations. You can
turn on overprinting, which allows a colored object (most often a dark one) to
print on top of another colored object or background, or you can create a trap
and overprint only along the border of two adjoining objects.
You can print a composite for each page of a document, or you can print color
separations. A composite page contains all the colors that are displayed in the
current FrameMaker view of the document. (For information on changing a
document’s color view, see “Viewing colors” on page 17-11.) Printing a composite
page on a color printer produces color pages. When you print a composite page
on a black-and-white printer, you can print all colors as shades of gray or as
black.
There are several ways to print color separations. Each color you separate
requires a commercial printer to produce a printing plate for the separation.
This can be costly, so you want to consider how to print your documents with
the fewest number of separations. For example, if your commercial printer were
using a six-stage press, you could print four-color process separations and two
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spot colors. If your printer were using a four-stage press, you could use fourcolor process separations to simulate the spot colors.
Color-separated plates contain black objects where colored ones should appear.
These objects appear as shades of black to indicate percentages of color
saturation. For an illustration of how color separations print, see “Separated
process colors” on page 17-14.
This example shows the
separations for a two-color
document.

!

!

Preparation

Composite print that
contains black and a
spot color

Separated plate with
only black images
printed

Preparation

Separated plate with
only spot color images
printed

SEPARATED PROCESS COLORS

Cherry
0c
100m
65y
15k

Aqua
100c
0m
47y
15k

Composite plate

Cherry Aqua
0c

100c
100m

0m
65y

47y
15k

Cyan separation

Magenta
separation

Yellow separation

15k

Black separation

The first illustration shows a sample of a printed composite page, displaying all the colors as you see them
on the screen. The next four illustrations represent those colors separated into their CMYK components. To
illustrate the point, we printed these samples in color and added each object’s color component percentage.
However, when printed in FrameMaker, the objects would actually print as shades of black, without the
numbers underneath the objects. The shades of black consist of grids of dots of varying sizes—the larger
the dots, the darker the shade. This grid is a halftone screen. For more information on halftone screens, see
“To change halftone screen settings” on page 17-21.
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For general printing instructions, see “Printing a document” on page 2-37.

To overprint an object
When one colored object overlaps another, FrameMaker normally cuts out the
overlapped portion so that it appears white. When printing these objects, you
may see a small gap between colors. If you like, you can apply overprinting to
the top object so that the overlapped portion does not get cut out, thereby
eliminating the possibility that a color gap appears when the document is
printed.

FrameMaker cuts out this
portion and makes it
appear white.

Entire object prints

Color gap

Overprinting off

Overprinting on

For example, you might want to set a text frame or text line to overprint when
printing small dark type on a light background.
If overprinting produces unacceptable color results where the objects overlap,
you can apply trapping instead. For more information, see “To trap an object,”
next.
1

Select the object on top.

2

Choose Overprint from the Graphics menu.

3

In the Overprint dialog box, click Overprint and click Set.

If you later move the object over a different background, you may want to turn
overprinting off by clicking Don’t Overprint.

Using FrameMaker

17-15

COLOR

17

Printing colors

To trap an object
Overprinting to prevent a color gap may produce unacceptable color results,
especially when the object that would otherwise be cut out is darker than the
overprinting object. If this happens, you can turn overprinting off for the object
and apply a trap to the object. A trap is a line bordering the object on top that is
just wide enough to fill the color gap and overprint the other object along the
border of its cutout.

The trap—with
overprinting on

Overprinting off—FrameMaker
cuts out this portion and makes
it appear white.

Overprinting off

Color gap

No color gap

Without trapping

1

With trapping

Create a border for the object on top.

Duplicate the object, setting its fill to None, and assign a pen color to match the
object. For details on duplicating objects, see “To delete or duplicate an object”
on page 14-6. For details on setting fill and pen properties, see “To change a
graphic property” on page 13-19.
2

Set the border width.

The width of the trap depends on several factors: the size and contour of the
object, the type of printing paper, and the accuracy of the printing press.
Consult your commercial printer for information on suitable line widths for
trapping. For details on setting the border width, see “To change a graphic
property” on page 13-19.
3

Select the border and choose Overprint from the Graphics menu.

4

In the Overprint dialog box, click Overprint and click Set.

To print composite pages
Composite pages contain all the colors that are displayed on the screen. (For
information on changing the displayed colors, see “Viewing colors” on
page 17-11.) Composite pages are printed in color on a color printer and in black
or gray scale on a black-and-white printer.
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If you have an imported color graphic in your document and you want to print it
on a color printer, assign it the color Black. The graphic prints in its original
color.
1

Choose Print from the File menu.

2

Make sure Print Separations is off.

3

Set up the remaining print options as necessary and click Print.

Turn off Print Separations.

For information on the other printing options, see “To customize printing” on
page 2-39.
HOW COLORS ARE PRINTED ON COMPOSITE PAGES

If you’re using a color printer to print composite pages, colors print as defined.
If you’re using a black-and-white printer, you can choose to print colors in black
or in shades of gray. To print colors in black, edit the beginning of the
ps_prolog file. The ps_prolog file, located in the FMHOME/fminit
directory, contains instructions for changing the print settings. Changes to the
file take effect immediately. To make changes without affecting other users,
save a copy of the file with your changes to your personal fminit directory
(~/fminit/ps_prolog).
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To print color separations
When you print color separations, you choose which colors you want to print as
spot colors, which to print as process colors, and which not to print at all. Text
and objects are printed in black for each separation, and the color name of each
separation is printed outside of the registration marks.
Before printing color separations, make sure you have not set colors to print as
100% black or 100% white. If colors are set to print as 100% black or 100%
white, FrameMaker won’t print separations. For details, see “To customize
printing” on page 2-39.
1

Choose Print from the File menu.

The Print dialog box appears.
2

Turn on Print Separations.

3

Click Separations Setup.

4

Move the color names to the appropriate scroll lists.

Move the colors you want
to print as process color
separations here.
Move the colors you want
to print as spot color
separations here.
The numbers in the box
change to reflect changes
in the Positive/Negative and
Emulsion Up/Down settings.

To move a color between scroll lists, select the color and click an arrow, or
double-click the color. To move all colors from one scroll list to another, select a
color in the list and Shift-click an arrow.
FrameMaker prints four plates that contain the CMYK component for each
color listed in the Print As Process scroll list, even if you defined the color in a
model other than CMYK. FrameMaker prints one plate for each color in the
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Print As Spot scroll list. If you put Black in the Print As Spot scroll list,
FrameMaker prints two plates with black on them—one for the black spot color
items, one for the black component of the process colors. Colors in the Don’t
Print scroll list do not appear on any printed plate, but they may appear cut out
on other plates.
If you move colors that have different names but identical color definitions to
the Print As Spot scroll list, FrameMaker creates redundant separations, one
for each color you print. For information on avoiding redundant separations, see
“Inconsistent color names” on page 17-19.
5

Select Positive or Negative, select an Emulsion setting, and click Set.

These settings relate primarily to files that are printed to film. It is possible
that your commercial printer may want different settings for separations. Make
sure you ask your printer for the settings you need to use.
Printing plates as Negative images causes all black text and objects to print
white and all white areas to print black.
Printing Emulsion Down causes the plates to print as mirror images of their
normal appearance.
6

Set up the remaining print options as necessary and click Print.

For information on the other printing options, see “To customize printing” on
page 2-39.

INCONSISTENT COLOR NAMES
FrameMaker prints one separation for each color
name. However, the items included in the
separation are determined by their color values,
not by the color name. For that reason, if a
document contains two differently named colors
with the same values, FrameMaker prints two
identical separations, one for each color name, and
both colors will print on each separation.
To avoid creating such redundant separations,
name colors consistently across applications. For

example, if you import an EPS graphic with a spot
color into a document, make sure that the color’s
name is consistent with the name defined for it in
the document. Otherwise, the imported color’s
name is added to the document and FrameMaker
creates a separation for the color.
If a document contains inconsistently named
colors, print duplicate separations and then
manually remove one of them.
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IMPORTED GRAPHICS

When you print a composite (showing all colors on the same page) on a color
printer, all imported graphics appear on the page as they do on the screen.
The following table lists the imported graphics for which FrameMaker can
print separations.
Graphic format
Separate?
Comment
...........................................................................

CMYK TIFF

Yes

Non-CMYK TIFF graphics do not
separate.

DCS

Yes

EPS line art

Yes

Bitmapped image
in EPS

Varies

FrameMaker can print separations
only if the images can be separated
with Adobe Separator.

Other (for example,
PICT, WMF)

No

FrameMaker prints the graphic as a
composite image in the separation plate
that matches its color.

You can also print colors in EPS files as spot colors if the colors were named in
the application that created the EPS file.
SKIP BLANK PAGES

Printing color separations can be expensive, depending on the size of the job
and the type of printer being used. If you are printing with registration marks
on, you may not want to print sheets that contain only the marks and no text or
objects.
To keep FrameMaker from printing these blank sheets, turn on Skip Blank
Separation Pages in the Set Print Separations dialog box.
To ensure that FrameMaker prints exactly the same number of sheets for each
page, turn off Skip Blank Separation Pages.
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To chang e halftone screen settings
Process color separations are printed using grids of black dots for each color—
the larger the dots, the darker the shade of black in which the color is printed.
The halftone screen settings control how close together the dots appear (the
frequency in lines per inch), the orientation of the grid (the screen angle), and
the dot shape.
■

To change the halftone screen settings, edit the beginning of the ps_prolog file.

The ps_prolog file, located in the FMHOME/fminit directory, contains
instructions for changing the print settings. Changes to the file take effect
immediately. To make changes without affecting other users, save a copy of the
file with your changes to your personal fminit directory
(~/fminit/ps_prolog). For more information, consult your printer
documentation and your commercial printer.
■

To make changes without affecting other users, save a copy of the file with your
changes to your personal fminit directory.
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COLOR LEVELS IN CMYK AND RGB MODELS
Colors are created differently in each of the
FrameMaker color models.
Colors in the CMYK model are added to
each other. Levels of 0 to 100 percent in any of the
text boxes indicate the concentration of color of
that component. When you add the levels of color,
you can have a result of over 100 percent. High
percentages of cyan, magenta, and yellow produce
dark colors; middle-range percentages produce
muted or grayed colors; low percentages produce
light colors.

CMYK

RGB Red, green, and blue are combined in varying
amounts to create colors. Maximum amounts of
the colors (100 percent each) create white;
minimum amounts (0 percent each) create black.
Lighter colors require a high level for the primary
color and low levels for the other colors.
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COLOR LEVELS IN THE HLS MODEL
HLS Hues (in paint terms, pigment) are organized
around a color circle. For example, 0 degrees is red,
60 degrees is yellow, 120 degrees is green, 180
degrees is cyan, 240 degrees is blue, 300 degrees is
magenta. Lightness varies with the amount of
white in a color. Black is 0 percent lightness; white
is 100 percent. Saturation varies depending on
how pure the color is. 100 percent saturation is the
brightest color you can get; 0 percent saturation
shows no color (the color looks gray—how gray it
looks depends on the percentage of lightness). To
specify pure color, enter levels of 100 percent
saturation, 50 percent lightness, and the degree of
the hue you want.

Lightness

Hue

120

60

180

0
240

300
Saturation

HLS model
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You set up a page design when you first create a document, and you can
change the design at any time as you work in the document.

FrameMaker manages page design
FrameMaker uses master pages to keep track of the document’s page
design. A double-sided document has at least two master pages, one for
each side. A single-sided document uses the right master page only.
When you add text and illustrations to your document on body pages,
FrameMaker adds body pages as necessary and automatically uses the
page design from the correct master page.

You make simple layout changes from body pages
All documents have these layout components: page size, margins, the
number of columns on each page, and whether the document is singlesided or double-sided. If your document, whether single-sided or
double-sided, has a symmetrical layout, and if it uses no master pages
other than the standard left and right pages that FrameMaker
provides, you can change the layout while working on body pages;
FrameMaker automatically makes the changes to the appropriate
master and body pages.
This document, for
example, has one
column, an 8-1/2 x 11-inch
page size, and 1-inch
margins on all sides. It is
double-sided, with
headers and footers at
1/2 inch.
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If you make the components complicated, or if you require other design
components such as headers and footers, you work with the components
directly on the master pages.

You work with headers and footers on master pages
The headers and footers you create on master pages are background
text. Every time FrameMaker displays a body page, it displays
background text and graphics from the corresponding master page
along with the text frame in which you type.
Background graphics

Background text, including
a footer

You type the
document text in a
text frame.

Master page

Body page

You determine how pages are numbered
Another part of setting up a document’s basic page design is specifying
the page numbering scheme. Normally, FrameMaker uses Arabic
numerals, but you can choose a different numbering style. You can also
change a document so it starts with a page number other than 1.

Text flows from frame to frame
In a FrameMaker document, each page normally contains a singlecolumn text frame or multiple columns in a single text frame. The text
flows from the first page to the last because FrameMaker connects the
text frames automatically. You make the text frame connections
yourself only with documents in which you need to weave several text
flows together—for example, to continue a front-page newsletter article
on the back page, skipping over other articles on the intervening pages.
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Text in multicolumn layouts can be balanced
When text doesn’t fill the text frame in a multicolumn layout, you can
have FrameMaker balance the amount of text that appears in each
column on the page. You can also align text in adjacent columns by
feathering or synchronizing. Feathering adds vertical space to move
text to the bottom of each column. Synchronizing aligns the baselines of
body paragraphs along an invisible text frame grid.

Unfeathered,
unsynchronized columns

Feathered columns

Synchronized columns

In this chapter
This chapter shows you how to specify the basic page design for a
document—for example, page size, margins, the number of columns on
each page, and whether the document is single-sided or double-sided. It
also explains how to set up headers and footers and page numbering.
Finally, it describes how to align text in columns for a balanced
appearance.
Chapter 19, “Custom Page Design,” explains how to create the layout
directly on a master page—for example, a layout with asymmetrical
margins. It explains how to create and use a custom master page for a
special page such as the first page of a document or a rotated page. And
it explains how to create a one-time-only layout on a body page—for
example, how to widen the side-head area for a longer heading or
change the height of the text frame to fit an extra line of text on
the page.
Chapter 20, “Flow Design,” explains how to design documents that
require more than one text flow, such as multilingual documents and
some newsletters.
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CHANGING THE BASIC PAGE LAYOUT
You make basic page layout changes directly from a body page. You can change
a document’s page size, make it single-sided or double-sided, change the
margins, or change the number of columns. Whenever you make one of these
basic changes, FrameMaker automatically updates both the left and right
master pages. At the same time, it also updates the layout of any body pages
currently using those master pages. If your document uses another master
page—for example, for the first page of the document—you change its layout
directly. For details, see Chapter 19, “Custom Page Design.”
FrameMaker updates both the left and right master pages with the same
change because it presupposes a symmetrical layout. But if the layout is
asymmetrical when you initiate the change (for example, with a different
number of columns or different inside or outside margins on the left and right
master pages), FrameMaker warns you before making the change that the
asymmetry may be lost. If you want to retain the asymmetry, change the layout
directly on the master pages. For more information, see Chapter 19, “Custom
Page Design.”
If any of the body pages being updated when you change the basic layout
contain layout overrides, you get a chance to prevent the updates. For details,
see “To override the master page layout on a body page” on page 19-20.

To chang e the page size
When you change a document’s page size, you can choose from a variety of
standard page sizes, or you can specify a custom size.
1

Choose Page Layout>Page Size from the Format menu.

2

Specify the page size.

Choose a size from the
pop-up menu…

…or type a width and
height here.
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When you choose a size from the pop-up menu, FrameMaker displays the
correct dimensions in the Width and Height text boxes. When you type
dimensions in the text boxes, FrameMaker displays the correct size in the
pop-up menu. If the dimensions you type aren’t a standard size, Custom
appears in the pop-up menu.
3

Click Set.

Before changing the page size, FrameMaker runs a series of checks to make
sure the new size is compatible with existing text frames and graphics. If any
problems are detected, FrameMaker displays an alert suggesting what to do.
SPECIFYING CUSTOM PAGE SIZES

The custom page size you specify can be very small, depending on the
document’s margin settings, or as large as 216 inches by 216 inches
(approximately 548 by 548 centimeters).
PAGE SIZE AND EXISTING TEXT FRAMES

When you change the page size, FrameMaker changes the size of the text frame
to maintain the current page margins. FrameMaker also resizes the column or
columns to fit within the new text frame’s dimensions. If the document has any
custom master pages, FrameMaker won’t let you resize the document to a size
that can’t accommodate text frames on those master pages.

To make a document single- or double-sided
You can change a single-sided document to double-sided or a double-sided
document to single-sided.

Left page

Single-sided document
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When you set up a double-sided document, you tell FrameMaker whether the
first page is a left or a right page.
1

Choose Page Layout>Page Size from the Format menu.

2

In the Page Size dialog box, click Single-Sided or Double-Sided in the Pagination
area.

For a double-sided document, choose whether the first page should be a left or a
right page.

Choose left or right page here.

3

Click Set.

To chang e margins
The margin is the distance between the page edge and the text frame. For a
single-sided document, you set margins for the top, bottom, left, and right sides
of the text frame. For a double-sided document, you set the top, bottom, inside,
and outside margins for a symmetrical look.
Top

Left

Top

Inside

Top

Right
Outside

Outside

Bottom

Bottom
Single-sided

Double-sided

1

Put the insertion point in the main text flow or click in the page margin.

2

Choose Page Layout>Column Layout from the Format menu.

Using FrameMaker
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3

In the Margins area, type the margins in the text boxes.

Type page margins here.

Changes apply to the entire
flow.

In a typical multicolumn layout—one with a single text frame that contains
columns of equal width—adjusting the margins and the gap (space) between
columns determines the individual column width. When the multicolumn
layout is created with multiple single-column text frames, you change the page
margins by resizing the text frames directly on the master pages. For details,
see “To change the margins on an individual page” on page 19-12.
4

Click Update Entire Flow.
INCLUDING GUTTERS

If the document is going to be bound or kept in a binder, you may want to make
the inside margin slightly larger than the outside. This inside gutter space
allows extra room for the binding while keeping the margins looking balanced.
For example, the pages of a double-sided document might have 1-inch top and
bottom margins, a 1-inch outside margin, and a 1.25-inch inside margin.
ASYMMETRICAL MARGINS

You set up asymmetrical left and right margins in a double-sided document by
changing the text frames directly on the master pages. For example, you could
make the text frames on both the left and right pages appear on the right side
of the page, leaving an area of white space on the left. For information on
working with master pages, see Chapter 19, “Custom Page Design.”
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To chang e the number of columns
A text frame can contain one or more columns of text. All columns in the frame
are the same width and are separated by a uniform gap. When you initially set
up a multicolumn document, it has one text flow; text flows down each column
in a text frame starting with the leftmost column, and then from one text frame
to the next.
For information on creating more than one text flow, see Chapter 20, “Flow
Design.”
1

Put the insertion point in the main text flow or click in the page margin.

2

Choose Page Layout>Column Layout from the Format menu.

The Column Layout command affects the layout of the left and right master
pages, and of all body pages that use their layouts.
3

In the Columns area of the Column Layout dialog box, type the number of columns
and the gap.

The gap is the space between columns.

4

Click Update Entire Flow.

To change the number of columns for an individual text frame rather than for
all the frames in a flow, choose Customize Layout>Customize Text Frame
instead of Page Layout>Column Layout in step 2 above and follow a similar
sequence.
CREATING UNEQUAL-WIDTH COLUMNS OR GAPS

You can create a multicolumn layout that contains columns (or gaps between
columns) of differing widths. For details, see “Creating columns with different
widths or gaps” on page 19-13.
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CREATING HEADERS AND FOOTERS
When you create a new, blank document, FrameMaker creates background text
frames for headers and footers on the left and right master pages. To make it
easy for you to add centered and right-aligned information in headers and
footers, FrameMaker automatically adds center and right tab stops at the
center of the text frame and at the right margin, respectively.

Untagged text frames on
the master page for
headers and footers

You set up the headers and footers by displaying the master pages and typing
text in these background text frames. You create header and footer text just as
you create any other FrameMaker paragraph. You can apply paragraph and
character formats, add and move tab stops, and add graphics such as a line
above or below the text. You can also add system variables in headers and
footers for such things as the page number or the current date. In addition, you
can change the size and placement of the header and footer text frames to suit
your needs.

To display master or body pages
When working with master pages, you need to move back and forth between
them and the body pages.
■

To display the master page used by the current body page, choose Master Pages
from the View menu.

To facilitate working on master pages, FrameMaker displays frame and column
borders.
■

18-10
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To view the document’s other master pages while a master page is visible, click the
Next Page and Previous Page buttons or use the scroll bar.

The number
of master
pages in the
document

The name of the current
master page

To create or modify header and footer text frames
You set up headers and footers as background text on each master page in a
document. The master pages of FrameMaker templates and blank paper
templates already have header and footer text frames that you can resize or
move. You can draw background text frames for additional header and footer
information or for other background text. If you modify these background text
frames on a master page, FrameMaker automatically updates any body pages
using that master page.
■

To create a header or footer text frame, draw a text frame on a master page.

You draw a text frame with the Text Frame tool. For details, see “To add a text
frame” on page 13-26.
After you draw the text frame, FrameMaker displays the Add New Text Frame
dialog box.

Choose Background Text and click Add. The text frame created, like all text
frames for background text on master pages, is untagged. For details, see “To
add background text on a master page” on page 19-6.
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■

To resize a header or footer text frame on a master page, select the text frame and
drag a handle.

Control-click to select a text frame.
For information on resizing objects, see “To resize an object” on page 14-17.
■

To move a header or footer text frame on a master page, select the frame and drag it
to a new location.

Control-click to select a text frame.
For information on moving objects, see “To move an object” on page 14-4.

To enter header or footer text
You can create simple headers and footers by typing text in the header and
footer text frames on the master pages. You can also create running headers
and footers that display information about the page they’re on and that can
change from page to page.

A running header variable
on a master page is
automatically replaced by
actual text taken from a
body page.

In a simple footer, text you
type on a master page
appears on the body
page.

Running H/F 1

Earthquake of 1906

#

13

Great Events

Master page

Great Events

Body page

1

Click in the header or footer text frame on the master page.

2

If necessary, tab to the location where you want to type the text.

3

Type the text.
CREATING RUNNING HEADERS AND FOOTERS

In running headers and footers, the text changes from page to page. For
example, in this book the header shows the current chapter title and the firstlevel heading on the corresponding body pages. To create running headers and
footers, you insert system variables in background text frames on master pages.
For details, see Chapter 12, “Variables.”
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To add page numbers and dates
You can specify items such as the current page number, the document’s total
page count, and the current date in a header or footer. FrameMaker displays a
system variable in the header or footer on the master page and replaces it with
the correct value on each body page using that master page.
1

On the master page, click in the header or footer where you want to add the page
number or date.

2

Choose what you want to insert from the Format>Headers & Footers submenu.
What you want to
What you
insert
choose
Explanation
...........................................................................

Current page
number

Insert Page #

You can also include text in the page
numbering to produce numbering such
as page 1. For information on choosing
the numbering style (numeric, Roman,
or alphabetic), see “To set up page
numbering” on page 18-14.

The highest page
number in a
document

Insert Page
Count

You can also use page count with the
page number and text you type to
produce numbering such as
page 3 of 4.

Today’s date in
short form (for
example, 6/25/95)

Insert
Current Date

FrameMaker updates the date
whenever it redraws the page—for
example, when scrolling, zooming, or
redisplaying the page.

A different
variable

Other

Choosing Other displays the Variable
dialog box. For information on
inserting variables, see Chapter 12,
“Variables.”

CUSTOMIZING PAGE NUMBERS

You can mix text with the page numbering variables for numbering—for
example, page 1—by typing page followed by a space and then choosing Insert
Page #. You can produce a number such as page 3 of 4 by typing page followed
by a space, choosing Insert Page #, typing a space followed by of and another
space, and then choosing Insert Page Count.
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DETERMINING HOW PAGES ARE NUMBERED
A document’s basic page design includes its page numbering style. By default,
FrameMaker uses numeric style (1, 2, 3, …), starting with page 1. You can
choose a different numbering style (Roman or alphabetic), and you can start the
document with a page number other than 1. You can also tell FrameMaker to
add or delete empty pages at the end of a document.

To set up page numbering
You usually include page numbers in a document’s headers or footers. You can
choose numeric, Roman, or alphabetic page numbers. Roman and alphabetic
numbering can be in lowercase or uppercase letters.
All body pages in a document use the same numbering style. You can, however,
use different numbering styles from document to document in a book.
1

Choose Document>Numbering from the Format menu.

2

Type a page number in the 1st Page # text box.

Type the number of the first
page here.

Page # Style pop-up menu

Normally, a document starts with page 1, but you can specify any number.
3

Choose a style from the Page # Style pop-up menu and click Set.

The Page # Style pop-up menu shows a sample of each numbering style.
NUMBERING PAGES IN BOOKS

If you’re setting up page numbering in a book, use the Set Up File command in
the book window rather than use the Document>Numbering command on the
Format menu. That way, FrameMaker numbers the pages correctly each time
you update the book. For information on setting up page numbering in a book,
see “Controlling page and paragraph numbering” on page 24-12.
You must still specify the page numbering style for each document separately in
the Numbering Properties dialog box.
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To add or delete empty pages at the end of a document
You can specify that you want a document to have an even or an odd number of
pages. If necessary, FrameMaker adds a blank page at the end of the document
to achieve the correct pagination.
Conversely, after you edit a document, it may have unwanted blank pages at
the end, left there because you either deleted or reworked text. You can specify
that FrameMaker should delete these empty pages whenever you save or print
the document. FrameMaker deletes a blank page only if it uses the left or right
master page, if it doesn’t contain the start of a flow, and if it has no layout
overrides; otherwise, FrameMaker assumes it’s a page you want to keep and
does not delete it. For information on layout overrides, see “To override the
master page layout on a body page” on page 19-20.
FrameMaker also assumes it’s a page you want to keep if the page contains an
empty paragraph but is otherwise blank.
■

To automatically add a blank page at the end of a document if necessary, use the
Make Page Count Even or Make Page Count Odd settings in the Numbering Properties
dialog box.

Choose Document>Numbering from the Format menu to display the
Numbering Properties dialog box. From the Before Saving & Printing pop-up
menu, choose Make Page Count Even or Make Page Count Odd. Then click Set.
If the document is part of a book, use the Set Up File command in the book
window to set up the starting page side of each file. For information on setting
up documents in a book, see “Setting up a book” on page 24-4.
■

To automatically delete empty pages at the end of a document, use the Delete Empty
Pages setting in the Numbering Properties dialog box.

Choose Document>Numbering from the Format menu to display the
Numbering Properties dialog box. From the Before Saving & Printing pop-up
menu, choose Delete Empty Pages. Then click Set.
If the document is part of a book, FrameMaker may add an empty page again
when the book is updated, depending on the setup information for the
documents in the book. For details, see “To specify the numbering properties” on
page 24-13.
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ALIGNING TEXT IN COLUMNS
There are three ways to align text in the columns of a multicolumn layout so
that the text has an even appearance—by balancing, feathering, and
synchronizing.
In the simplest method, balancing, FrameMaker distributes text evenly across
the columns of a text frame that isn’t full of text.
When you feather text in a flow, FrameMaker adjusts the spacing between lines
and paragraphs so the last line of text in each column reaches the bottom of the
column. You specify the maximum amount of space FrameMaker can add.
When you synchronize text in a flow, the first lines of body paragraphs snap to
an invisible grid in the text frame. Synchronizing text makes body paragraphs
line up whenever they appear side by side in columns.
Balancing is a text frame property, but you usually turn it on or off for an entire
flow. Feathering and synchronization are both flow properties. If feathering and
synchronization are both on for a flow, feathering takes precedence over
synchronization. However, the first line in each column is synchronized.

To balance the text across columns
In a layout that uses a multicolumn text frame, you can balance the text across
columns that aren’t full of text—for example, columns on partly empty pages
that precede forced page breaks and on the last page of a document.

Balancing off
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1

Put the insertion point in the main text flow or click in the page margin.

2

Choose Page Layout>Column Layout from the Format menu.

3

In the Columns area of the Column Layout dialog box, turn on Balance Columns.
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Click Update Entire Flow.

To balance text for an individual text frame rather than for all the frames in the
flow, choose Customize Layout>Customize Text Frame rather than Page
Layout>Column Layout in step 2 above and follow a similar sequence.

To feather text to the bottom of text frames
When FrameMaker feathers (vertically justifies) text, it first adds space
between paragraphs, up to a limit that you set. If more adjustment is necessary,
it adds space between lines, up to another limit that you set.

Feathering pads vertical
spacing…

…to align text to the bottom
of the column.
Before feathering

After feathering

When text is feathered, FrameMaker may take longer to display pages, due to
the time required to compute the position of feathered text. For this reason, you
may want to turn on feathering only when you finish editing a document.
FrameMaker does not feather the text in a text frame in which text runs
around graphics.
1

Click in the flow you want to feather and choose Page Layout>Line Layout from the
Format menu.
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2

Turn on Feather.

3

In the Feather area, type the maximum amount of space FrameMaker can add
between lines (Interline Padding) and between paragraphs (Inter-¶ Padding).

Turn on Feather...

...and specify the padding
limits.

FrameMaker won’t exceed the padding limits you set. If it’s not possible to
feather text in a column without exceeding the limits, FrameMaker does not
feather that column.
4

Click Update Flow.
FEATHERING AND STRADDLES

In a multicolumn text frame that contains straddles—paragraphs, tables, or
anchored frames—FrameMaker adds vertical space to align the last baselines
of text in adjacent columns above each straddle.

Feathering aligns text above
straddles…

…and at the bottom of the
column.
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IF THE LAST LINE SEEMS TOO HIGH

When FrameMaker feathers, it leaves room for the largest possible descender
in the largest font size used in the line, even if no character with such a large
descender actually appears. If the last line in a column still seems too high,
check to see whether the column contains a nonprinting character (such as an
anchor symbol) in a font that’s larger than the surrounding text.

To synchronize baselines along a grid
When you synchronize (align) paragraphs in a flow, FrameMaker creates an
invisible grid in each text frame and aligns the baseline of the first line of each
specified paragraph to the grid.

Synchronizing snaps the first lines
of paragraphs to the text frame
grid.

Before synchronizing

After synchronizing

FrameMaker also aligns the first line after an anchored frame and tries to align
the first line in each column. Because headings in large fonts often appear at
the tops of columns, you need to specify a first-line synchronization limit.
FrameMaker won’t synchronize the first line in a column if its font size is larger
than the limit.
You can synchronize baselines even when the text appears in side-by-side text
frames—for example, in some newsletter-type layouts. For information, see
“Synchronizing baselines in a newsletter” on page 18-20.
1

Check the paragraph formats of the paragraph types you want to synchronize to
make sure they all have the same default font size and line spacing.

Fixed line spacing should be on.
2

Click in the flow you want to synchronize and choose Page Layout>Line Layout from
the Format menu.

3

In the Line Layout dialog box, turn on Baseline Synchronization and turn off Feather.

Using FrameMaker
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4

In the Synchronization area, type the line spacing you want to use for the text frame
grid in the Synchronize ¶’s text box.

Use the same line spacing as the paragraphs you want to synchronize.
Otherwise, FrameMaker won’t synchronize the paragraphs with the text
frame grid.
5

Type the largest font size to align at the top of a column in the First-Line
Synchronization Limit text box.

For details, see “First-line synchronization limit” on page 18-21.
6

Click Update Flow.
FIRST GRID LINE

Because there are no descenders above the first line in a column, the first grid
line is positioned from the top of the column a distance equaling two-thirds of
the specified line spacing.

SYNCHRONIZING BASELINES IN A NEWSLETTER
When you produce a newsletter that contains
articles that flow continuously from the first page
to the last, each page of the newsletter contains
several text frames—one for each column of text.
When the tops of adjacent text frames start at the
same position on the page, the invisible text frame
grids line up nicely. When text frames start at
different positions, however, you may need to
adjust their tops to line up their grids.
To line up the grids, resize adjacent text frames so
that the distance between their tops is evenly
divisible by the grid.
For example, if the grid is 12 points, you can start
a text frame 144 points (12 times 12 points), or
2 inches, from the top of an adjacent text frame.

12-point grid

Any multiple
of the
grid size
(0, 12, 24, 36,
and so on)

Separate text frames

You can use the Snap grid to correctly position the
text frames. Specify a Snap grid equal to the text
frame grid. Then resize the text frames until their
tops snap to any grid location. For more
information on the Snap grid, see “Setting up the
drawing environment” on page 13-4.
For more information on laying out newsletters
with FrameMaker, see Chapter 20, “Flow Design.”
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FIRST-LINE SYNCHRONIZATION LIMIT

The first-line synchronization limit controls whether the baseline of a heading
is placed on the first grid line when the heading falls at the top of a column,
even when the heading’s default font is larger than the grid can accommodate.
To place the baseline of a heading on the first grid line, FrameMaker lets the
heading extend above the top of the column as shown on page 18-19.
FrameMaker won’t synchronize font sizes larger than the limit you set.
For example, suppose the line spacing for body paragraphs is 12 points, the
column grid is 12 points, and the headings are 18 points. If you want the
headings to be aligned when they appear at the top of a column, specify 18 as
the first-line limit.
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When you create a new document, you start with standard left and
right master pages. You can change the page design of the existing
master pages, or you can create custom master pages. You use reference
pages to store graphics, boilerplate art, and formatting information.

Master pages control column layout
FrameMaker creates body page text frames by copying text frames from
the corresponding master page. The text you type on body pages flows
from page to page, and each text frame is identified by the name of its
flow—by its flow tag.
Untagged background text
frame

Running H/F 1

Discovery of Gravity

On body pages, you type in
tagged text frames.

Tagged template text frame

Untagged background text
frame

#

Great Events

Master page

13

Great Events

Body page

If you change a text frame on a master page, FrameMaker
automatically updates all body pages that use that master page.

Documents have standard and custom master pages
Every new, single-sided, blank document you create has a master page
named Right that is used by all body pages. A double-sided document
has two master pages named Left and Right that are used by left and
right body pages, respectively. Chapter 18, “Basic Page Design,” shows
you how to change the layout of these standard master pages in basic
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ways that don’t require you to display them. But you can modify them
in more elaborate ways by working with them directly.
You can also create your own custom master pages and have
FrameMaker use them on the body pages you specify. For example, you
may want the first page of the document to look different from the other
pages.

A document can use a
different layout on the
first page.

1

2

3

4

Or you may need to include a landscape page in a portrait document.

You can override the master page layout
For a unique page design that appears only once in a document, you can
change a body page’s layout directly—create a layout override. Doing
this creates a one-time-only page design that doesn’t affect the master
page or other body pages using the same master page.
You can also choose to assign no master page to a body page. Because it
has no master page, this type of body page has no headers, footers, or
other background text or graphics.

Graphics can be stored on reference pages
A reference page can contain graphics that you use on body or master
pages, allowing you to use one set of graphics consistently throughout a
document. Typically, you use these graphics to put a line above or below
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paragraphs such as headings and table titles and to put a line between
body text and footnotes.

Footnote

You can use a line from a
reference page…

Heading

Gravity

…in a heading on a body
page.

Figure Title

Reference page

Body page

A reference page can contain other items, such as formatting
information for tables of contents and indexes, frequently used text and
graphics, hypertext commands, and a library of clip art.

In this chapter
This chapter shows you how to change the column layout on master or
body pages and how to create custom master pages. It also explains how
to use reference pages.
For information on creating headers and footers on master pages, see
Chapter 18, “Basic Page Design.” Also see Chapter 18 for information
on specifying basic page layouts for single-sided documents and
symmetrical layouts for the standard left and right pages of doublesided documents. For information on designing documents that require
more than one text flow, such as multilingual documents and some
newsletters, see Chapter 20, “Flow Design.”

WORKING WITH MASTER PAGES
Master pages can contain two types of text frames. A template text frame
contains a tagged flow—a flow with a name—and it is used on body pages. You
type the document’s text in the corresponding text frames on these body pages.
A background text frame—for example, one for a header or footer—contains an
untagged flow. You type text in background text frames on master pages. The
text appears as background on corresponding body pages exactly as you typed
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it. For more information on flow tags, see “Using flow tags on a master page” on
page 19-5.
You can draw or import graphics—lines, boxes, or company logos—anywhere on
a master page. You can also type individual text lines. Graphics and text lines
appear on corresponding body pages exactly as they appear on the master page,
as part of the body page’s background—for example, as the company logo on
your stationery.

Master page text and
graphics form the
background of
corresponding body pages.

CONFIDENTIAL

Text line on a master page

CONFIDENTIAL

Graphics on a master page

Text in a background text
frame
Master page

Body page

USING FLOW TAGS ON A MASTER PAGE
Text flows from one text frame to the next
throughout a document. A text flow is a series of
connected text frames. Most documents have a
single text flow, from the first page to the last, in
which FrameMaker handles the text frame
connections automatically.
The text frames where you type text on body pages
come from the template text frames on master
pages. The current text frame’s flow tag is
displayed in the Tag area of the status bar.

In FrameMaker template documents and in new,
blank documents, the tag for the text flow is A. You
can create additional flows for multiflow
documents such as newsletters and magazines. For
details, see Chapter 20, “Flow Design.”
Background text frames, such as those for headers
and footers, appear only on the master pages and
have no flow tags.

Current text frame is untagged.
Current text frame is tagged A.
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You can type text in a template text frame on a master page, but the text won’t
appear on body pages. This allows you to type nonprinting comments on master
pages.

To add background text on a master page
Text you type in a background text frame on a master page appears on
corresponding body pages exactly as you type it. As part of basic page design,
you create headers and footers as background text. (For details, see “Creating
headers and footers” on page 18-10.) You can add other background text on
master pages as well. For example, in the FrameMaker fax template, the
informational headings are in a background text frame on the master page.
You apply paragraph and character formats to text in background text frames
just as you do to text on a body page. When you include a system variable such
as a page number or a date in a background text frame, FrameMaker displays
the appropriate text on the body pages. For details, see “Creating headers and
footers” on page 18-10. For more information on variables, see “Using variables
on a master page” on page 19-7.
1

Display the master page on which you want to add background text.

Choose Master Pages from the View menu to display master pages.
2

Draw a text frame.

Use the Text Frame tool on the Tools palette to draw a text frame. For details,
see “To add a text frame” on page 13-26. If you’re creating a header or footer, the
appropriate text frames may already exist.
If you draw the text frame on a master page, FrameMaker displays the Add
New Text Frame dialog box.
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In the Add New Text Frame dialog box, click Background Text and click Add.

The new text frame contains an untagged flow.
4

Double-click in the text frame to place the insertion point.

5

Type the background text in the text frame.
USING TEXT LINES

You can create single lines of background text by using the Text Line tool on the
Tools palette; however, you can’t apply paragraph formats or insert variables in
text lines. For information on creating text lines, see “Using text with graphics”
on page 13-24.

To assign a different master page to body pages
Body pages in a single-sided document use the right master page, and body
pages in a double-sided document alternately use the left and right master
pages. However, you can assign any master page to any body page at any time.
FrameMaker uses the template text frame from the master page on the body
page and displays background text and graphics. For information on creating
custom master pages, see “Working with custom master pages” on page 19-17.
1

With a body page displayed, choose Page Layout>Master Page Usage from the
Format menu.

USING VARIABLES ON A MASTER PAGE
You can use a variable on a master page by
inserting it in a background text frame.
FrameMaker automatically updates system
variables on master pages.
You generally use variables in headers and footers,
but you can also insert them in other background
text frames. For example, in the FrameMaker fax
template, the date is in a background text frame on
the master page.
Some variables, such as Filename, appear on a
master page as their current value. For variables
that change from page to page, the name of the

variable (or an abbreviation) appears on the
master page, and the current value appears only
on the corresponding body pages. For example, the
Current Page # variable appears on a master page
as a number sign (#), but on a body page it appears
as the actual page number.
For information on using variables in headers and
footers, see “To add page numbers and dates” on
page 18-13. For general information on inserting
and using system variables, see Chapter 12,
“Variables.”
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2

In the Use Master Page area, choose the master page you want to assign.

Click here to assign the
appropriate left or right
master page.
Choose the custom
master page from the
pop-up menu.

Click here to assign a
custom master page.

Current Master Page
pop-up menu

3

In the Apply To area, choose the body pages to which you want to assign the
master page.
To assign the master page to
Do this
..........................................................................

4
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The currently displayed body page

Click Current Page.

All pages within the range you
specify in the text boxes

Click Pages/To.

Only odd or even pages within the
range you specify in the text boxes

Turn off Odd or Even as necessary.

Only body pages within the
range you specify in the text boxes
that currently use a particular
master page

Turn on That Currently Use Master
Page and choose a page from the
Current Master Page pop-up menu.

Click Apply.
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HOW FRAMEMAKER APPLIES TEMPLATE TEXT FRAMES

When you assign a master page to a body page, FrameMaker updates the
column layout of that body page according to the template text flows on the
master page. (A template text flow is one that has a flow tag.) For each template
text flow on the master page, FrameMaker looks for a flow with the same tag on
the body page. If it finds one, it replaces the text frames that contain that flow
on the body page with the text frames on the master page. The text in those
body page text frames, and the connections between those text frames and the
text frames on other pages, are maintained.
Normally, all template flows on the master and body page correspond. However,
if the master page contains a template flow not found on the body page,
FrameMaker adds the text frames that contain that flow to the body page. If
the body page contains a flow not found on the master page, FrameMaker
leaves the text frames that contain that flow unchanged. This action could
result in overlapping text frames. For information on working with multiflow
documents, see Chapter 20, “Flow Design.”

CHANGING AND UPDATING COLUMN LAYOUT
A single-column layout for a page is based on a single text frame. A typical
multicolumn layout—one with equal-width columns—is also based on a single
text frame. You can create a layout that contains columns with different widths
or with different gaps by using several text frames on a page—one text frame
for each column of text.
When you change a template text frame on a master page, FrameMaker
automatically updates all body pages using that master page. By changing a
template text frame on a master page, you can vary the layout of the left and
right master pages as well as design your own custom master pages.
When you change a text frame on a body page, you create an override to its
master page layout. You can then choose to update the master page and all
corresponding body pages, or you can create a new master page. You can also
choose to do neither, leaving the override on the page. For information on
creating a new master page based on a body page layout, see “To create a
custom master page” on page 19-17. For information on creating a one-timeonly body page, see “To override the master page layout on a body page” on
page 19-20.
You can also change the column layout of the left and right master pages
together, creating a symmetrical layout. For details, see “Changing the basic
page layout” on page 18-5.
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To update body pages with master page changes
You can change template text frames on more than one master page and have
FrameMaker update all corresponding body pages in one step.
Before updating associated body pages with master page changes, FrameMaker
checks to see whether any body pages have column layouts that override their
master pages—for example, a different number of columns, a different gap
between columns, different margins, or different side-head settings. If any body
pages have layout overrides, you choose whether you want to keep the
overrides. If you choose to keep layout overrides, FrameMaker updates those
body pages with the master page’s background text and graphics but does not
copy the template text frames. For information on layout overrides, see
“Creating a one-time-only page layout” on page 19-20.
1

After making layout changes on master pages, display body pages.

When you leave the master pages, all body pages associated with changed
master pages are automatically updated.
If FrameMaker detects any layout overrides on body pages that use these
master pages, it displays an alert that asks how you want to handle them.
2

If FrameMaker displays an alert, choose whether you want to keep or remove
overrides and click Continue.

Click here to leave text
frames on body pages with
layout overrides as they are.
Click here to remove the
overrides and use the new
column layout.

The page number on which
the first override occurs

To update a master page with body page changes
You can make column layout changes on a body page, but you must update the
corresponding master page if you want FrameMaker to update other body
pages that use the same master page.
When you choose to update the corresponding master page and the other
associated body pages, FrameMaker checks to see whether any body pages have
column layouts that override their master pages. If any body pages have layout
19-10
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overrides (such as a different number of columns, a different gap between
columns, different margins, or different side-head settings), you choose whether
you want to keep the overrides. If you choose to keep layout overrides,
FrameMaker updates those body pages with the master page’s background text
and graphics but does not copy the template text frames. For information on
layout overrides, see “Creating a one-time-only page layout” on page 19-20.
1

After making layout changes on a body page, choose Page Layout>Update Column
Layout from the Format menu.

A message appears that asks you to confirm the master page and body pages
that are to be updated.

Click Update to update
the master page and
associated body pages.

If FrameMaker detects any layout overrides on body pages that use this master
page, it displays an alert that asks how you want to handle them.
2

If FrameMaker displays an alert, choose whether you want to keep or remove
overrides and click Continue.

Click here to leave text
frames on body pages with
layout overrides as they are.
Click here to remove the
overrides and use the new
column layout.

The page number on which
the first override occurs
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To chang e the margins on an individual page
You change the margins on a body page to customize that page or as a first step
in creating asymmetrical page layouts on left and right master pages. For
information on changing margins to create symmetrical layouts on left and
right pages, see “To change margins” on page 18-7.
When you change the margins on an individual body page, you choose whether
to update the corresponding master page and associated body pages. You can
create asymmetrical page layouts by updating. If you don't update, you
customize the page. For details on updating, see “To update a master page with
body page changes” on page 19-10.
You can also create asymmetrical page layouts by changing the margins of a left
or right master page directly. In this case, FrameMaker updates all associated
body pages automatically.
1

Select the text frame that has the margins you want to change.

To select the text frame, Control-click the frame.
2

Choose Customize Layout>Customize Text Frame from the Format menu.

3

Specify the new size and position.

Type the text frame
dimensions.

Type the top and left
margins.
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The offset from the top of the page is the top margin. The offset from the left
side of the page is the left margin. The bottom and right margins are then
determined by the text frame’s width and height.
4

Click Set.
DRAGGING TEXT FRAME EDGES

You can change the margins by selecting a text frame and dragging a resize
handle. To select a text frame, Control-click the frame.
When you narrow or widen a multicolumn text frame, the column widths
change to fit within the text frame, but the column gap remains the same.

To chang e the number of columns on an individual page
In a typical multicolumn document—one with equal-width columns—you can
change the number of columns and the gap between columns. You can also
create columns with different widths or with different gaps. For information,
see “Creating columns with different widths or gaps,” next.
When you change the number of columns on a master page, FrameMaker
automatically updates all associated body pages. When you change the number
of columns on a body page, you can choose whether to update the corresponding
master page and associated body pages. For details, see “To update a master
page with body page changes” on page 19-10.
1

Select the text frame you want to change.

To select the text frame, Control-click the frame.
2

Choose Customize Layout>Customize Text Frame from the Format menu.

3

In the Columns area of the Customize Text Frame dialog box, specify the number of
columns and (if it’s more than one) the gap between adjacent columns.

4

Click Set.
CREATING COLUMNS WITH DIFFERENT WIDTHS OR GAPS

Multicolumn documents with equal-width columns and gaps usually contain
one multicolumn text frame for the document text on each page. However, you
can also create a multicolumn layout with unequal column widths or gaps. To
do so, use one text frame for each column of text and position the text frames to
obtain the page margins and column gaps you want.
You can draw the text frames, or you can set up one text frame the way you
want it and then duplicate it. For more information, see “To draw a template
text frame,” next, and “To duplicate a text frame” on page 19-16.
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To draw a template text frame
If you want a master page to contain unequal-width columns of text, or if
you’re setting up the basic layout for a newsletter in which the articles don’t
flow continuously from the first page to the last, you need to use multiple text
frames—one for each column. For example, for a page with two unequal-width
columns, you add a second template text frame by drawing it on the
master page.
When you draw a text frame on a master page, FrameMaker automatically
connects the flows properly by prompting you to choose a flow tag. The new text
frame is connected to the text frame in which the flow currently ends, and
FrameMaker automatically updates all associated body pages.
For information on drawing a text frame on a body page and on using the text
frame as part of the document’s text flow, see “Drawing or duplicating a text
frame on a body page” on page 19-14.
1

Display the master page on which you want to draw a new text frame.

2

Draw a text frame.

Use the Text Frame tool on the Tools palette to draw a text frame. For details,
see “To add a text frame” on page 13-26. If you’re going to draw more than one
text frame, draw them in the order you want them connected.

DRAWING OR DUPLICATING A TEXT FRAME ON A BODY PAGE
When you draw or duplicate a text frame on a body
page, and you want to use the text frame as part of
the document’s text flow, you need to connect the
new text frame to the flow. If the new text frame is
the first one in the flow, you also need to turn on
Autoconnect.
To turn on Autoconnect for the first text frame in
the flow, select the text frame and choose
Customize Layout>Customize Text Frame from
the Format menu. Then turn on Autoconnect in the
Customize Text Frame dialog box and click Set.
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To connect text frames, use the Customize
Layout>Connect Text Frames command on the
Format menu to connect the text frames. For more
information, see “To connect text frames” on
page 20-10.
If the text frame you draw or duplicate on a body
page is part of the document’s text flow, you can
choose whether to update the corresponding
master page and associated body pages. For
details, see “To update a master page with body
page changes” on page 19-10.
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When you draw the text frame on a master page, FrameMaker displays the Add
New Text Frame dialog box.

3

Click Template for Body Page Text Frame and choose a tag from the Flow Tag
pop-up menu.

Choose the current flow tag unless you’re working with a multiflow document.
FrameMaker connects the text frame to the text frame in which the flow
currently ends.

The Tag area displays the
name of the current flow.

For information on creating new flow tags in a multiflow document, see
Chapter 20, “Flow Design.”
4

In the Columns area, specify the number of columns and (if it’s more than one) the
gap between adjacent columns.

If you’re setting up a column layout with unequal-width columns, set the
number of columns to 1, because you use a separate text frame for each column.
5

Click Add.
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To duplicate a text frame
After you set up a text frame, you can place a copy of it in another location,
either on the same master page or on a different one. FrameMaker copies the
text frame, any text in it, as well as the properties associated with the text
frame (including the flow tag).
If you copy the text frame to a master page, FrameMaker automatically
updates all associated body pages.
For information on duplicating a text frame on a body page and on using the
text frame as part of the document’s text flow, see “Drawing or duplicating a
text frame on a body page” on page 19-14.
1

Select the text frame you want to copy.

To select the text frame, Control-click the frame.
2

Choose Copy from the Edit menu.

3

Display the page on which you want to duplicate the text frame.

4

Choose Paste from the Edit menu.

If you paste the text frame on a master page, FrameMaker displays the Add
New Text Frame dialog box.

Click Template for Body Page Text Frame, choose a tag from the Flow Tag
pop-up menu, and click Add.
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Choose the current flow tag unless you’re working with a multiflow document.
FrameMaker connects the text frame to the text frame in which the flow
currently ends.

The Tag area displays the
name of the current flow.

For information on creating new flow tags in a multiflow document, see
Chapter 20, “Flow Design.”

WORKING WITH CUSTOM MASTER PAGES
Your documents may need body pages with layouts that differ from those of the
left and right master pages. For example, you may want the first page of a
document to look different from remaining pages. For such cases, you create
custom master pages.
After you create a custom master page, you change its column layout and add
background text and graphics as necessary. For details, see “Changing and
updating column layout” on page 19-9 and “To add background text on a master
page” on page 19-6. You can also add headers and footers. For details, see
“Creating headers and footers” on page 18-10.

To create a custom master page
You can create a custom master page by starting out with a blank page or by
basing the new page on an existing master page. First you create the new
master page, and then you customize it to suit your needs. After setting up the
custom master page, you can assign it to any body page in the document at any
time. A document can have up to 100 master pages. For information on
customizing page design, see “Working with master pages” on page 19-4 and
“Changing and updating column layout” on page 19-9. For information on
assigning master pages to body pages, see “To assign a different master page to
body pages” on page 19-7.
1

Choose Master Pages from the View menu.

The master page that corresponds to the current body page appears.
2

Choose Add Master Page from the Special menu.
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3

Choose the initial page layout.

Click here if you want to
base the new master page
on an existing page’s
design.
Choose the master page on
which you want to base the
new page from the pop-up
menu.

Click here if you want to
start out with a blank master
page.

4

Type a name for the master page in the Name text box and click Add.
BASING A NEW MASTER PAGE ON A BODY PAGE LAYOUT

You can also create a custom master page by making column layout changes on
a body page and then creating a new master page from the body page’s layout.
With the body page displayed, choose Page Layout>New Master Page from the
Format menu. Type a name for the master page in the New Master Page dialog
box and click Create.

To create a rotated master page

Quarterly Earnings

You can create a custom master page that changes the orientation of a body
page. For example, you may need a rotated orientation for a body page with a
very wide table.

Body text added after page
is rotated

Background text and graphics
added before page is rotated

1

Create a custom master page.

For details, see “To create a custom master page” on page 19-17.
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On the master page, set up any text frames and background text and graphics that
you want to display unrotated.

Headers and footers are background text. You should add them at this point if
you want them to have the same orientation (unrotated) as headers and footers
on the other master pages. If you want them to be rotated, you can add them
later. For information on drawing background text frames, see “To add
background text on a master page” on page 19-6.
3

Choose Customize Layout>Rotate Page Clockwise or Customize Layout>Rotate Page
Counterclockwise from the Format menu.

When FrameMaker rotates the page, part of it will probably be out of view. You
can adjust the window size so you can see as much of the page as possible.
4

Create any text frames and background text or graphics that you want to display
rotated.

If you want to display headers and footers rotated, you should add them at
this point.
TYPING IN ROTATED TEXT FRAMES

If you mix rotated and unrotated text frames on a page, you can type in rotated
text frames, or you can unrotate the page to make typing faster. To unrotate a
page, choose Customize Layout>Unrotate Page from the Format menu. When
you are finished, you can rotate the page back to its former orientation.

To rename a custom master page
You may need to rename a custom master page. For example, if you’re
importing master pages from a template to an existing document, and if you
don’t want an existing master page to be overwritten, you rename it before
importing. You can’t rename the left or right master page.
1

Display the master page you want to rename.

2

Click the page name in the status bar.

FrameMaker displays the Master Page Name dialog box.
3

Type the new name and click Set.

To delete a custom master page
If a document no longer uses a custom master page, you may want to delete it.
You can’t delete the left or right master page or any master page currently
assigned to a body page.
1

Display the master page you want to delete.

2

Choose Delete Page from the Special menu.
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CREATING A ONE-TIME-ONLY PAGE LAYOUT
In certain situations, you may need a body page with a layout that appears only
once in a document. For example, you can make a text frame longer to fit one
more line of text on the page. Or you may want to shrink a text frame to place a
graphic directly on the body page. In such cases, you can override a body page’s
master page layout without affecting other body pages.
You can also choose to assign no master page to a body page. Because it’s not
associated with a master page, this type of body page has no headers, footers, or
other background text or graphics. For example, you may want to include a
graphic that is too large to fit within the current top and bottom margins, or you
may want the last page of a document to be completely blank.

To override the master page layout on a body page
You can override the master page layout on a body page by changing the column
layout directly on the body page. The column layout of a body page with
overrides remains unique to that page unless you update the corresponding
master page.
1

Display the body page that has a master page layout you want to override.

2

Change the column layout.

Use any of the methods described in “Changing and updating column layout,”
beginning with “To change the margins on an individual page” on page 19-12.
When you change the column layout, the body page no longer matches its
corresponding master page. By not updating the master page, you create a
layout override.
UPDATING PAGES WITH OVERRIDES

When you change the template text frames on a master page, FrameMaker
detects any layout overrides when it attempts to update body pages. You can
choose to retain the overrides or to adopt the new layout. For information on
updating body pages with layout overrides, see “To update body pages with
master page changes” on page 19-10.
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To assign no master page to a body page
You create a one-time-only page layout with no headers, footers, or other
background text and graphics by assigning no master page to a body page. For
example, if each chapter in a book must have an even number of pages, and if
the last page of a chapter contains no body text, you may want that page to be
completely blank.
If the body page contains a text frame, the text frame is unaffected.
1

With a body page displayed, choose Page Layout>Master Page Usage from the
Format menu.

2

In the Use Master Page area of the Master Page Usage dialog box, choose None from
the Custom pop-up menu.

3

In the Apply To area, choose the pages to which you want to assign no master page.
To assign no master page to
Do this
..........................................................................

The currently displayed body page

Click Current Page.

All pages within the range you
specify in the text boxes

Click Pages/To.

Only odd or even pages within the
range you specify in the text boxes

Turn off Odd or Even as necessary.

Only body pages within the
range you specify in the text boxes
that currently use a particular
master page

Turn on That Currently Use Master
Page and choose a page from the
Current Master Page pop-up menu.

4

Click Apply.

5

Change the existing column layout as necessary.
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WORKING WITH REFERENCE PAGES
You can store frequently used graphics on reference pages and then use them
on body pages where they’re needed. By setting them up correctly on the
reference page, the graphics are always used consistently on body pages. For
example, to design a heading with a line below it, you draw the line in a
reference frame on a reference page and then include the reference frame as a
property of a paragraph format.

Footnote
Put lines on reference pages
for use in headings, table
titles, footnotes, and so on.

Heading
Figure Title

Earnings

Reference page

Body page

This line appears with
headings on body pages.

Reference pages can also hold boilerplate material or clip art that you want
positioned consistently throughout a document. You use boilerplate material or
clip art by copying it from the reference page and pasting it on body pages. For
example, you can store on a reference page symbols for signaling cautions
and notes.

You can put a boilerplate
graphic in an anchored
frame on a reference
page…

!

Caution Symbol

!

Preparation

…and then paste the
anchored frame on body
pages.
Reference page

Body page

A document normally has at least one reference page with some commonly used
graphics already set up. Some templates also have additional reference pages.
You can add your own graphics to an existing reference page, and you can
create additional reference pages.
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Reference pages can contain formatting information for generated lists and
indexes. For information on using reference pages for formatting generated
documents, see Chapter 22, “Generated Lists,” and Chapter 23, “Indexes.”
Reference pages can also contain hypertext commands. For details, see
Chapter 27, “Hypertext and View-Only Documents.”

To display reference pages
When a reference page is visible, you can click the Next Page and Previous Page
buttons or you can scroll to view the document’s other reference pages.
■

To display reference pages, choose Reference Pages from the View menu.

The name of the current
reference page

The number of reference
pages in the document

To create a reference page
Every new, blank document has a reference page named Reference with lines
for footnotes, table footnotes, and headings already set up. You can create
additional reference pages as necessary. A document can have up to 100
reference pages.
1

Display reference pages.

2

Choose Add Reference Page from the Special menu.

If the document doesn’t currently have any reference pages, the Add Reference
Page dialog box appears when you try to display a reference page. Otherwise,
the dialog box appears when you choose Add Reference Page.
3

In the Add Reference Page dialog box, type a name for the reference page in the
Name text box and click Add.

To create a reference frame on a reference page
In order to use a graphic as part of a paragraph format, you put the graphic in a
reference frame—an unanchored graphic frame—on a reference page. For
example, the reference frame for a footnote line might look like this:
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When you select a reference frame on a reference page, its name appears in the
status bar after the word Frame.

The name of the selected
frame

For information on using a reference frame in a paragraph format, see “To put
graphic lines above and below a paragraph” on page 4-17.
1

Draw an unanchored graphic frame on the reference page.

Use the Graphic Frame tool on the Tools palette to draw an unanchored graphic
frame. For details, see “To draw an unanchored graphic frame” on page 13-14.
After you draw the frame, FrameMaker displays the Frame Name dialog box.
2

Type a name and click Set.

Give the frame a short, descriptive name you’ll recognize later in the Frame
Above ¶ and the Frame Below ¶ pop-up menus in the Advanced properties of
the Paragraph Designer.
3

Put the graphic in the frame.

You can import a graphic file, use the Tools palette to draw a graphic, or
combine drawn and imported graphics.
4

Adjust the frame’s size and shape if necessary.

When you use a reference frame above or below a paragraph on a body page, the
whole frame appears on the body page, not just the graphic inside it. The height
of the frame affects the position of text above and below the frame.
5

Type the frame’s name above the frame.

Typing the name is strictly for your convenience in helping you identify the
frame quickly. Use the Text Line tool on the Tools palette to type the name. For
information on using the Text Line tool, see “To add a text line” on page 13-25.
Note that typing a different name here does not rename the reference frame.
For information on renaming the frame, see “To rename a reference frame,”
next.

To rename a reference frame
You can change the name of a reference frame if its use in the document
changes.
1
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Click the frame’s name in the status bar.

FrameMaker displays the Frame Name dialog box.
3

Type the new name and click Set.

If you rename a reference frame used in a paragraph format, you need to
update the format so that it uses the new frame name. For information on using
a reference frame in a paragraph format, see “To put graphic lines above and
below a paragraph” on page 4-17.
You should also type the new name in the text line above the reference frame.

To set up boilerplate graphics
You can set up boilerplate graphics—for example, margin symbols—in anchored
frames on a reference page. When you copy the graphics to body pages, they
appear correctly positioned in their anchored frames.
1

Create a reference page with the same column layout as the type of body page on
which you want to display the graphic.

Doing this ensures that the graphic is positioned correctly when you copy it to
body pages. To set up the column layout, you can copy the text frame from a
body page and paste it on the reference page. You can also draw a text frame on
the reference page and then use the Customize Layout>Customize Text Frame
command on the Format menu to change its layout.
2

On the reference page, set up the anchored frame exactly as you want to display it
on body pages, and put the graphic in the anchored frame.

You may want to add some text that describes what the symbol is used for.

Use the Anchored Frame
command to position the
anchored frame in the
reference page margin.

!

Caution Symbol

Descriptive text is not
copied to body pages.

For information on setting up anchored frames with the Anchored Frame
command, see Chapter 15, “Anchoring Graphics.”
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COPYING THE GRAPHIC TO BODY PAGES

You can quickly copy a boilerplate graphic to a body page. On the reference
page, select the anchored frame that contains the graphic and copy it. Then, on
the body page, click where you want to anchor the graphic and paste it. The
anchored frame is positioned correctly on the body page.
PLACING GRAPHICS DIRECTLY ON A REFERENCE PAGE

The graphics you put on a reference page don’t have to be in an anchored frame.
You can place graphics directly on reference pages and then copy and paste
them anywhere on body pages.

To rename a reference page
You may need to rename a reference page. For example, if you’re copying the
reference pages from a template to an existing document, and if you don’t want
a particular reference page to be overwritten, you rename it before copying
the pages.
1

Display the reference page you want to rename.

2

Click the page name in the status bar.

FrameMaker displays the Reference Page Name dialog box.
3

Type the new name and click Set.

To delete a reference page
If you delete a reference page that contains a graphic used in a paragraph
format, the graphic no longer appears in paragraphs using that format. When
this happens, the Frame Above ¶ or the Frame Below ¶ pop-up menu in the
Advanced properties of the Paragraph Designer is set to As Is for the
paragraphs.
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1

Display the reference page you want to delete.

2

Choose Delete Page from the Special menu.
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A document can have separate text flows, each with its own text frame
connections.

Text frames can be connected to control where text flows
With most books and reports, the text frame on each page is
automatically connected to the text frame on the next to form a single
text flow running through the entire document. But some documents
contain multiple text flows—for example, multilingual documents that
contain several side-by-side translations of the same text, or
newsletters in which an article that starts on one page continues
several pages later.

VIEWS

1

2

3

In a single-flow document, text flows from the bottom of one
page to the top of the next.

1

2

3

In a multiflow document, text often starts on one page and
continues several pages later.

In these documents, you specify how the text flows by connecting the
text frames yourself. In the multilingual example, each translation is in
a separate text flow. In the newsletter example, each article has its own
text flow.
Because each flow’s autonumbering is independent of the numbering in
other flows, you can maintain separately numbered lists, headings,
figure titles, and so on, for each flow.
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Each flow has a tag
A flow tag is the name you give a text flow. When you assign a master
page to a body page, FrameMaker uses the master page’s tagged text
frames on the body page. You can create additional flows on body pages
or master pages, depending on the type of multiflow document you’re
creating.

You can add pages manually to control connections
In most single-flow documents, you want FrameMaker to add a new
page automatically whenever you fill a text frame with text. The text
frame on the first page is automatically connected to the text frame on
the new page. In a multiflow document, you can tell FrameMaker not to
add a new page when a text frame gets filled. That way, you can add
pages yourself and control the connections.

In this chapter
This chapter shows you how to control the flow of text in a multiflow
document. Before creating a multiflow document, you should have a
good understanding of FrameMaker page layout and master page
usage. See Chapter 18, “Basic Page Design,” and Chapter 19, “Custom
Page Design.”
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SETTING UP FLOWS FOR A MULTIFLOW
DOCUMENT
Some documents use parallel text flows. An example of this type of document is
one with two side-by-side flows that contain text in different languages.

Français

English

Français

1

English

2

A newsletter, on the other hand, may have multiple flows, with some of them
running through the entire document.

VIEWS

1

2

3

To set up parallel flows
The best way to set up a document with parallel flows is to lay out and connect
the text frames on the master pages. Because the text frame connections are
the same throughout the document, you don’t normally need to make further
changes on the body pages.
Set up parallel flows by following these general steps. The rest of this chapter
describes the process in more detail.
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Set up the separate flows on one of the master pages.

Use a separate text frame for each flow and assign a different flow tag to each
text frame. Also make sure that Autoconnect is on for each flow so that
FrameMaker adds a new body page whenever text reaches the end of one of the
flows. For information on adding template text frames to master pages, see “To
draw a template text frame” on page 19-14 and “To duplicate a text frame” on
page 19-16. Instructions for assigning a flow tag and turning on Autoconnect
begin on page 20-9.

A

B

Left master page

2

A

B

Right master page

Repeat these steps for the remaining master pages.

All master pages should have the same flow tags. Otherwise, FrameMaker
won’t alternate properly between the left and right master pages when adding
body pages. For information on how FrameMaker correctly alternates between
the left and right master pages, see “Alternating left and right master pages,”
next.
3

Update body pages with the master page changes by displaying body pages.
ALTERNATING LEFT AND RIGHT MASTER PAGES

When text reaches the bottom of the last text frame in a flow with Autoconnect
on, FrameMaker creates a new body page using the appropriate left or right
master page. In order to create the new page correctly, the appropriate left or
right master page must contain all of the flow tags found on the current body
page. If any flow tag is missing, FrameMaker creates the new page with the
current body page’s master page instead.
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To set up the flows for a newsletter
The best way to set up a newsletter that requires nonparallel, multiple flows is
to establish a basic layout on the master pages and then define the flows on the
body pages. This approach, which applies to any document with multiple,
nonparallel flows, gives you the greatest amount of flexibility in determining
the way text flows through the document.
When you establish the basic layout, you determine the number and size of
columns; each column should be a separate text frame. However, you can resize
and delete these text frames on the body pages until they look right to you. The
master pages act only as the basic layout grid from which you work.
Set up newsletter-style flows by following these general steps. The rest of this
chapter describes the process in more detail.
If you’re creating a newsletter that has articles that flow consecutively from the
first page to the last, you don’t need to use the techniques described in this
chapter. For more information, see “Single-flow newsletters” on page 20-8.
1

On the master pages, specify the basic layout of the document.

Decide on the basic number of columns for the newsletter, and put that number
of single-column text frames on each master page. All of the text frames should
be in the same flow. For information on adding template text frames to a master
page, see “To draw a template text frame” on page 19-14 and “To duplicate a
text frame” on page 19-16.

VIEWS
A

A

First master page

A

A

A

Left master page

A

A

A

A

Right master page

Use these text frames as the layout grid within which you’ll have text flow and
place graphics.
2

Turn off Autoconnect so that FrameMaker won’t automatically add pages.

For instructions, see “To keep FrameMaker from generating new pages” on
page 20-9.
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Don’t update the master pages as you make changes on the body pages. When
you create a newsletter-type document, the master pages act only as the basic
layout grid from which you work.
When you disconnect text frames on body pages, you create separate untagged
flows. You don’t need to tag them because FrameMaker won’t create new pages
automatically and thus won’t need to connect text frames. Instructions for
connecting and disconnecting text frames begin on page 20-10.
5

If you want to synchronize text baselines in the newsletter, make sure the text frames
are placed appropriately.

If the newsletter contains several text flows, you need to synchronize baselines
for each flow. For information on synchronizing text baselines, see “To
synchronize baselines along a grid” on page 18-19 and “Synchronizing baselines
in a newsletter” on page 18-20.
6

Manually create new unconnected body pages as necessary.

For instructions, see “To add a new, unconnected page” on page 20-10. Connect
text frames between pages as necessary.

CONTROLLING THE FLOW OF TEXT
A flow’s basic properties are its flow tag and its Autoconnect setting. (You
specify both settings by using the Customize Layout>Customize Text Frame
command on the Format menu.) Autoconnect determines whether FrameMaker
automatically generates a new page when the flow’s text frames are full. In a
new, blank document, the main flow is tagged A. When you click in a text frame
that contains a tagged flow, the tag appears in the Tag area of the status bar.

The flow tag of the current
text frame

You can assign a flow tag to a new text frame or change a flow’s tag at any time.
You need to assign a tag only once for a flow. After that, connecting a text frame
to the flow assigns the tag to the text frame. If you change the flow tag or the
Autoconnect setting in one text frame in a flow, the change is made to the
entire flow.
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In a document with one flow or parallel flows, Autoconnect is usually on to tell
FrameMaker to add a new page whenever the flow’s text frames are full. The
new page takes the column layout of the appropriate master page (left or right),
and the text frames on the new page are automatically connected to the text
frames on the original pages.
When working on a document with nonparallel, multiple flows, in most cases
you’ll turn off Autoconnect. This allows you to add a new, unconnected body
page wherever you want and to control the connections between it and existing
pages.
If Autoconnect is off, and if the flow has more text than it can hold in its text
frames, the text overflows at the end of the last text frame in the flow. If borders
are visible, the bottom border of an overflowing text frame appears as a solid
line. Overflowing text is not deleted; it’s just hidden from view. As soon as you
connect the overflowing text frame to another text frame, the text reappears.

SINGLE-FLOW NEWSLETTERS
If you’re creating a newsletter or magazine that
has articles that flow consecutively from the first
page to the last, you don’t need to use the multipleflow method described in this chapter. Instead, use
one text flow for the entire newsletter.
With the single-flow method, you need only one
text frame per page, even with a multicolumn
newsletter, because one frame can contain several
columns. To create multicolumn layouts, use the
techniques described in Chapter 18, “Basic Page
Design,” and in Chapter 19, “Custom Page Design.”
Also with the single-flow method, you can place
graphics anywhere on the page; text will run
around them automatically. And you can make
paragraphs, tables, and frames straddle columns.
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Text runs around a graphic
placed directly on the
page.

One text frame can
contain several columns.

For information on runaround graphics, see “To
run text around a graphic” on page 13-30 and “To
run text around an anchored frame” on page 15-13.
For information on straddles, see “To create a
straddle head” on page 4-34, “Tables that straddle”
on page 6-5, and “Anchored frames in multicolumn
layouts” on page 15-9.
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To chang e a flow tag
You normally change flow tags on master pages. If two text frames are
connected, you need to disconnect them before you can change one of their flow
tags. For information on disconnecting text frames, see “To disconnect text
frames” on page 20-11.
1

Click in the text frame that has the flow tag you want to change.

2

Choose Customize Layout>Customize Text Frame from the Format menu.

3

In the Customize Text Frame dialog box, type a tag for the flow in the Flow Tag
text box.

You should keep flow tags short—B or C, for example—so they won’t obscure
other information in the Tag area of the status bar. You can’t assign a tag that is
already used on the current page.
4

If you want to keep FrameMaker from adding new pages when columns overflow, turn
off Autoconnect.

5

Click Set.
ASSIGNING FLOW TAGS WHEN DRAWING TEXT FRAMES

When you draw or paste a text frame on a master page, FrameMaker displays
the Add New Text Frame dialog box. There you can assign an existing flow tag
by choosing it from the Flow Tag pop-up menu. To assign a new flow tag, type
the name in the Flow Tag text box.

To keep FrameMaker from generating new pages
The Autoconnect setting in the Customize Text Frame dialog box determines
whether FrameMaker automatically adds new pages with connected text
frames. You can turn off Autoconnect if your document has multiple flows and
you need the flexibility to connect text frames in different parts of the
document. When Autoconnect is off, FrameMaker does not create new pages
for you.
1

Click in any text frame in the flow.

2

Choose Customize Layout>Customize Text Frame from the Format menu.

3

In the Customize Text Frame dialog box, turn off Autoconnect and click Set.
LEAVE AUTOCONNECT ON FOR ONE FLOW OR FOR PARALLEL FLOWS

Work with Autoconnect on if you’re working in a document with one main flow
or two parallel flows. If Autoconnect is on, FrameMaker creates a new page
whenever text in the flow reaches the end of its last text frame.
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To add a new, unconnected page
In documents with one main flow or two parallel flows, you don’t normally add
an unconnected body page; you let FrameMaker add connected pages
automatically when necessary. In a multiflow document in which Autoconnect
is off, or in other types of specialized documents, you can add new, unconnected
body pages. When the text reaches the end of a text frame, you add a new page
and connect the text frames as necessary.
1

From a body page, choose Add Disconnected Pages from the Special menu.

2

Choose the location and number of disconnected pages you want to add.

Type the page number
before or after which the
new pages should be
inserted.

Choose from the pop-up
menu whether to add the
new pages before or after
the specified page number.

Type the number of pages
you want to create.

3

Choose a master page from the Use Master Page pop-up menu.

4

Click Add.

To connect text frames
When two text frames are connected, the text flows from the end of the first text
frame to the beginning of the second. You can connect a text frame on a master
page to any other text frame on the same master page, and you can connect a
text frame on a body page to any text frame on any body page. You can also
connect or disconnect a text frame in the middle of a flow.
When you connect two text frames, FrameMaker assigns the first text frame’s
flow tag to the second frame. If the first text frame is untagged, the second
frame’s tag is used. That way, all connected text frames belong to the same flow
and have the same tag. If the first text frame contains overflowing text, the text
flows into the second frame when you make the connection.
1

Select the two text frames in the order in which you want text to flow.

To select the first text frame, Control-click it. To select the second text frame,
Control-Shift click it.
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If the text frames are on different pages, the first frame appears to be
deselected when you select the second one; however, FrameMaker remembers
the first selection.
2

Choose Customize Layout>Connect Text Frames from the Format menu.

If the first text frame you selected isn’t on a page that’s currently visible,
FrameMaker displays an alert that asks whether you want to connect to that
frame. Click OK.
ADDING A TEXT FRAME TO THE MIDDLE OF A FLOW

To add a text frame to the middle of a flow, first select the text frame you want
to add and then select the frame that should follow it. Connect these two text
frames.

To disconnect text frames
Disconnect text frames when you want to create separate flows—for example, to
add an article that needs to start at a specific location in a newsletter. If you
need to start a new flow in the middle of a column, you can split the text frame
that contains the column in two, and then disconnect the two text frames. For
information on splitting a text frame, see “To split a text frame” on page 20-13.
You can disconnect a text frame from the preceding text frame, the following
one, or both. You can also remove a text frame from the middle of a flow by
connecting the text frames before and after the one you want to remove.
Disconnect the second text
frame to start an article in a
fixed location.

1

If you continue to add text to
the first text frame, the text
overflows until you connect it
to a different text frame.

When you disconnect text frames on the same body page, FrameMaker creates
separate flows with no flow tags. When you disconnect text frames on different
body pages, FrameMaker creates separate flows with the same flow tag. In
either case, if you’re creating a newsletter-type document where Autoconnect is
off for each flow, the flow tags don’t matter. FrameMaker won’t create new
pages automatically and thus won’t need to make text frame connections.
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Disconnecting text frames does not affect existing text in the frames. When you
want to move text to a different text frame, cut and paste it after disconnecting
the frames.
1

Select the text frame you want to disconnect.

2

Choose Disconnect Previous, Disconnect Next, or Disconnect Both from the
Format>Customize Layout submenu.
DISCONNECTING TEXT FRAMES AND AUTOCONNECT SETTINGS

Disconnecting text frames affects the Autoconnect settings of both frames. If
you disconnect text frames on the same page, Autoconnect is off for both flows.
When you disconnect text frames on different pages, Autoconnect is affected as
follows:
Text frame
Flow
Autoconnect
disconnected
affected
setting
..........................................................................

Previous

Previous
Current

Off
On

Next

Current
Next

Off
On

Both

Previous
Current
Next

Off
Off
On

For information on changing the Autoconnect setting for a text frame, see “To
keep FrameMaker from generating new pages” on page 20-9.
REMOVING TEXT FRAMES FROM THE MIDDLE OF A FLOW

If you want text in a flow to bypass text frames currently in the flow, first select
the text frame immediately preceding the text frames you want to remove, and
then select the text frame immediately following the text frames you want to
remove. Connect those two text frames. The text flow skips over the unselected
text frames.
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To split a text frame
You can split a text frame in two and then disconnect the two text frames to
start a new flow. For example, you may want a new article with its own flow to
start in the middle of a text frame.
In a single-flow or parallel-flow document, when you change a text frame on a
body page, you should update the corresponding master page. In the case of a
multiflow newsletter, where you’re doing all of your text frame connections and
flow work on body pages, you don’t need to update the master page.
If you want to start a new flow in the middle of a column, you can split the text
frame in two and disconnect the two text frames.
This page has three text
frames, all part of the
same flow.

A
A

A

A

A

1

B

B

The middle text frame has
been split, and the two
resulting text frames have
been disconnected.

1

1

Click in the line above where you want to split the text frame.

2

Choose Customize Layout>Split Text Frame from the Format menu.

FrameMaker splits the text frame horizontally below the line that contains the
insertion point, creating two separate but connected text frames.
3

Select the bottom text frame and disconnect it from the previous one.

If the flow was tagged, FrameMaker removes the flow tag. If Autoconnect was
on before you disconnected the text frames, it is now off for both text frames.
For information on disconnecting text frames, see “To disconnect text frames”
on page 20-11.
4

Resize the text frames as necessary.
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“UNSPLITTING” TEXT FRAMES

If you split a text frame in two and you then change your mind before making
any other changes to the document, immediately choose Undo from the Edit
menu. If you make another change but you haven’t yet disconnected the two
text frames, delete the lower of the two frames and then resize the remaining
text frame to the size of the original unsplit frame.
If you already disconnected the two frames, cut the text from the second text
frame and paste it at the end of the first text frame. Then delete the second text
frame and resize the first one to the size of the original unsplit frame. Finally,
if you need to turn Autoconnect back on or reassign a flow tag for the text
flow, use the Customize Layout>Customize Text Frame command on the
Format menu.

To cross-reference text frames
When an article in a newsletter ends on one page and starts again in a text
frame on another page, you may want to tell the reader where to turn to
continue reading. Similarly, you may want to indicate where the later text
frame is continued from.

VIEWS
cont’d.
from
page 1

See
title,
page 3
1

Use a cross-reference to
indicate where the flow
continues.

1

2

3

Use a cross-reference to
indicate where the flow is
continued from.

Resize the two columns to make room for the cross-references.

Because each column in a newsletter is a separate text frame, you can resize
each column as necessary. Resize the bottom of the first column and the top of
the continuation column.
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Draw a text frame for each of the cross-references.

Draw a text frame below the first text frame and another above the
continuation text frame. Don’t connect either text frame to any other text
frame.
3

Insert a cross-reference in the empty text frame above the continuation text frame,
pointing to the first page of the article.

For information on creating cross-reference formats and inserting crossreferences, see Chapter 10, “Cross-References.”
4

Insert a cross-reference in the empty text frame below the first text frame, pointing to
the text in the continuation text frame.

To track a text flow
In a document with many flows, it’s easy to lose sight of where a flow continues.
You can see more text in a flow at once by zooming out.
1

Zoom out to 25 percent and adjust the window size to see as many pages as
necessary.

For information, see “To zoom in and out” on page 2-25.
2

Click in the flow you want to check and choose Select All in Flow from the Edit menu.

The flow is highlighted,
showing how it traverses the
pages of the document.

MOVING THROUGH A FLOW’S TEXT FRAMES

If you don’t want to zoom the document to see the flow, you can move the
insertion point through the flow. To go to text in the next connected text frame,
click in the last line of a text frame and press the down arrow key. To go to the
preceding text frame, click in the first line and press the up arrow key.

Using FrameMaker

20-15

FLOW DESIGN

20

Controlling the flow of text

To delete disconnected pages
You can use the Delete Pages command on the Special menu to delete
disconnected pages in a multiflow document. FrameMaker deletes the page
along with its contents.
1

Click in the page you want to delete.

2

Choose Delete Pages from the Special menu.

3

In the Delete Pages dialog box, type the first and last disconnected pages you want to
delete and click Delete.

If you want to delete only one page, type that page number in both text boxes.
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A template is a FrameMaker document you use as a foundation for
creating or formatting other documents. Templates provide an easy way
to apply design elements, and they ensure that your design is
consistent from one document to another.

Templates have formats, definitions, and other settings
A template can have any design elements you need to use in more than
one document—for example, paragraph, character, and table formats;
page layout information on master pages; and graphics and formatting
information on reference pages.
You can create a new document from a template to give it the template’s
design or reformat an existing document to match the template.
1

#

1

You can apply a template
to a document to update
the document’s design.

Template

Original document

Updated document

Templates can also have variable definitions, cross-reference formats,
conditional text settings, color definitions, and equation size and font
settings.
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You can use any FrameMaker document
When you create a new document, you can use any FrameMaker
document as a template—not just one that was created especially as a
template. FrameMaker makes a copy of the template and opens the
copy as the new document. The document contains the design defined in
the template and any text from the template.

You can also update an existing document
If you make changes to a template after creating new documents from
it, you may want to update the design of the new documents to match
the template. You can import the design to the new document in one
step. When you update a document from a template, you specify which
formats and other design elements you want to use. For example, you
could update only the Paragraph Catalog and leave the rest of the
document’s design as it is.

Use predefined templates or design your own
FrameMaker comes with templates already set up for portrait and
landscape pages and for books, memos, letters, viewgraphs, business
cards, and other types of documents. You can use these templates as
they are, modify them, or create custom templates of your own.

In this chapter
This chapter shows you how to design, set up, test, and organize custom
templates. It explains how to create templates for generated files and
conditional documents, as well as for ordinary documents. It also shows
you how to import formats from a template to update the formats in a
document.
You can look at a predefined template by opening it or by creating a new
document based on one. For information on opening an existing
template or creating a new document based on a predefined template,
see Chapter 2, “Basic Procedures.”
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PLANNING A CUSTOM TEMPLATE
As you develop a custom template, try to anticipate the needs of other users and
consider a wide range of issues that apply across documents. The more
forethought you bring to the template, the more useful and effective it will be.

To think t hrough the project
■

Try to anticipate the situations in which your template will be used.

Define all the formats and other design elements you think users might need.
The more complete your template, the less users need to customize their
documents. For an idea of formats and design elements you may need, glance
through the items discussed in “Setting up a custom template” beginning on
page 21-5.
■

Before starting to design and create your own templates, take a look at the
FrameMaker templates.

Looking at existing templates may give you ideas and examples of how to set up
master pages, paragraph and character formats, headers and footers, crossreference formats, autonumbering, and much more.
If you find a FrameMaker template that’s close to what you want, use it as the
basis for your template. Modify the FrameMaker template for your own needs
and save it under a different name as a new custom template. Using an existing
template rather than starting a new template from scratch saves you a great
deal of time.

To plan ahead for other users
■

Document your template for other people who will use it.

If the template has sample text, you can use that text to describe the parts of
the template. For example, a body paragraph might have the text This is a body
paragraph. When you finish with the template, prepare a document
summarizing its contents and put that document in the same directory as the
template.
■

If documents from your template will be translated into other languages, consider
letting the translators review the template design.

Some design elements may not work well with another language. The standard
page size and default measurements may need to be different for use in other
countries.
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To simplify the template
■

Remember that people who use your template may not know FrameMaker as well as
you do. Keep the design as simple and easy to use as possible.

■

Set up the template so that it works as seamlessly and automatically as possible.

For example, specify a Next ¶ Tag in the Basic properties of the Paragraph
Designer, or turn on Keep With Next or Previous in the Pagination properties.
■

If you’re preparing a set of templates for a book, consider making the templates
general so that you have as few of them as possible.

For example, you could create one template that is used for chapters, prefaces,
and appendixes. That way, you won’t have to update many templates if you
need to make changes to them.
■

Set up a master page for each page layout that will be used by documents created
from the template.

A chapter template might have a master page for a first page, a right page, a
left page, and a command page—even though only one or two of the chapters
will have command pages.

To plan the steps of the project
■

Decide on the fonts you’ll use as early as possible.

Fonts affect many other design elements in a template—for example, line
height in paragraphs and the height of header and footer columns.
■

Consider saving successive versions of a template in case you decide to use an
earlier version.

SETTING UP A CUSTOM TEMPLATE
You can set up a FrameMaker document as a template and use it to create or
update other documents. The template can have as much or as little formatting
information as you want.
When you set up a template, you lay out master pages, define and apply
formats, and define special text such as cross-reference formats and variables.
Refer to other chapters for detailed steps on how to perform these tasks. This
section provides only an overview to the process of creating a template.
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To design the page layout
It’s usually a good idea to begin a template by specifying the overall page
layout. This includes choosing the page size, defining the column layout,
creating master pages, and defining the basic document properties.
1

Create a new document.

You can start with either a custom new document or a copy of an existing
document you plan to modify. If you are designing a document that will be used
primarily online, make sure that your page size is no larger than the smallest
screen size on which it will be displayed. Your document may need to be in
landscape orientation if it will be used on laptop computers.
2

Define the column layout.

If you started with a custom new document, you have already specified your
column number and margins. If you are modifying an existing document, you
may want to change the column layout.
3

Add and name any custom master pages you’ll need.

4

Enter background text and graphics on the master pages, including headers and
footers.

The headers and footers might include the page number, date, chapter number
and title, section number and title, author, revision number, and draft release
(preliminary, final, and so on).
If a running header or footer shows the chapter or section number, it uses a
Running H/F variable that refers to the paragraph with that autonumber. To
set this up, think ahead to what the tag for that paragraph will be.
5

Define the custom document properties and view options.

Use the Document>Text Options command on the Format menu, the
Document>Numbering command on the Format menu, and the Options
command on the View menu.
DISPLAYING FACING PAGES

As you design the page layout, you can see how facing pages look by displaying
them side by side. Use Options from the View menu, and then choose Facing
Pages from the Page Scrolling pop-up menu. Make the window larger and zoom
out slightly, if necessary, to fit both pages in the window.
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To design the paragraph and character formats
After designing the page layout, you should define how you want the text to be
formatted. A good template has a paragraph and character format for every
type of text that will be used in the documents.
1

Create the paragraph formats.

Paragraph formats provide the foundation of text formatting, so you should set
them up before setting up the character formats. If your document will be
opened or printed on computers other than your own, use fonts in your
paragraph formats that are widely available.
2

Create the character formats.

Character formats should be overrides to paragraph default fonts. When
creating a character format, specify all the settings in the Character Designer
as As Is, and specify only the settings you want to change. This way, the format
will work with any paragraph format.
NAMING PARAGRAPH AND CHARACTER FORMATS

Use tags that express the purpose of the text rather than the appearance of it.
For example, name a format for emphasized text Emphasis rather than Bold.
Then if you decide to change to italics for emphasized text, you can redefine the
Emphasis format without having to retag any text.
Also use names that are easily recognizable. For example, you might name the
formats for numbered lists Step1 and StepNext rather than st1 and stn.
LABELING NUMBER SERIES

If the template has more than one set of autonumbers, add a label to the format
for each autonumber. For example, define step autonumbers as S:n+, where
S: is the label. For more information on autonumbering, see “Formatting lists”
on page 4-36.
CONTROLLING THE SPACE BETWEEN PARAGRAPHS

In paragraph formats, use either Space Above or Space Below throughout to
add space above or below the paragraph. Be consistent and use either
Space Above or Space Below throughout your document because FrameMaker
applies only the larger of the two values between paragraphs.
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To standardize graphics, frames, and tables
If the documents will contain graphics, frames, or tables, your template can
provide some standards to maintain consistency.
■

Put standard items on a reference page.

You can include graphics that users will need again and again—for example, a
symbol that calls attention to notes and cautions—and an anchored frame with
a standard height and width. Users can copy and paste these items as
necessary.
■

Create a paragraph format for anchored frames.

This provides consistent spacing around graphics. For example, a paragraph
format named Frame could contain a Space Below setting of 20 points and a
Line Spacing setting of zero. Then, each frame could be anchored to a blank
paragraph with the Frame tag.
■

Create both a paragraph format and a character format for callouts.

A template should have both formats because some callouts may be text lines
and some may be text frames. You cannot apply a paragraph format to a
text line.
■

Choose a color model and redefine colors if necessary.

Use the Color>Definitions command on the View menu.
■

Prepare standard table formats.

Only some of the properties you set for tables can be imported into another
document. The width of text in actual tables varies greatly, as do other
properties. So, regardless of how you prepare your tables, users will probably
need to adjust some of these properties themselves. Think of your tables as
models for users to start with. For a list of the properties that are stored in the
table format, see “Table properties” on page 7-4.

To define special text
A template can include definitions, formats, view options, and other settings for
handling special text.
■

Select a numbering style, a number format, and other footnote properties.

Use the Document>Footnote Properties command on the Format menu.
■

Define formats for cross-references.

Use the Cross-Reference command on the Special menu.
Standardize as much of the cross-reference format as possible. For example, if
cross-references should always be introduced by see, include that in the format
definition.
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Create user variables.

Use the Variable command on the Special menu.
Consider defining user variables for product names, document names, and
other items that may change during the course of the project.
■

Define condition tags, condition indicators, and view settings for conditional text.

Use the Conditional Text command on the Special menu. Define settings in the
Show/Hide Conditional Text dialog box.
■

Define equation sizes and fonts if any documents will have equations.

Use the Equations Sizes and Equations Fonts commands on the Equations
pop-up menu on the Equations palette.

CREATING TEMPLATES FOR UPDATING
DOCUMENTS
You can also create templates for formatting a generated file and changing the
view of conditional documents in a book file. These templates are not for
creating new documents.

To create a template for a generated file
If you generate a table of contents, an index, or some other kind of generated
file in a directory that contains another generated file of the same type,
FrameMaker uses the formatting of the existing generated file when generating
the new one, if the new file uses the same name (including the suffix and
extension, if any) as the existing generated file. In effect, the existing generated
file serves as the new file’s template, just as if you had imported formats from it.
You can use this FrameMaker feature to create generated-file templates that
contain page layout, paragraph and character formats, and the formatting
information that appears on the reference page. For information on importing
formats, see “Importing formats into a document” on page 21-12.
1

Open the document or book file from which you want to generate the table of
contents, index, or other file.

2

Generate the file.

For information on how to generate these files, see Chapter 22, “Generated
Lists,” and Chapter 23, “Indexes.”
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3

Format the generated file.

Follow the instructions in “Formatting a list” on page 22-14 and “Formatting an
index” on page 23-19. This formatted file is your template.
4

Save the generated file.

Make sure that this generated-file template is in the directory that contains the
document or book file that you will use to create a new generated file.

To create a set of templates for conditional documents in a book
If you often change the view of conditional documents that are part of a book,
you may find it helpful to have a template for each view. That way you can
change the view of all the files in the book at once, simply by importing the
settings from one of the templates into the book file.
If you want to change the view of a single document that contains conditional
text, it is easier simply to change which conditions are showing and which are
hiding. For information, see “To change the view of a conditional document” on
page 26-16.
1

Set up a basic template for the conditional document.

You use this template for editing the document. It should define all the
document’s condition tags.
In the Show/Hide Conditional Text dialog box, show all conditions and turn on
Show Condition Indicators.
2

Set up one template for each version of the conditional document.

You use these templates for viewing or printing one version at a time. There
should be a template for each condition tag you created in the basic template,
and a template for any combination of conditions you might want to view. You
can also use these templates to define variables and formats unique to a view.
In the Show/Hide Conditional Text dialog box for each template, show only the
condition or conditions to which the template corresponds, and turn off Show
Condition Indicators.
CHANGING THE VIEW

When you want to change the view, import the conditional text settings from
the appropriate template into the book file. Use the Import>Formats command
on the File menu.
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TESTING AND ORGANIZING TEMPLATES
Before making your templates available to other users, be sure to test the
templates thoroughly and put them in a logical, accessible place.

To test a template
The best way to test a template is to create several sample documents
from it and then examine the documents to see that everything looks the way
you want.
■

Intermingle different types of paragraphs on a page to make sure the line spacing
and leading look right.

Try each type of paragraph in a place where you expect it to be used. Sometimes
a paragraph looks fine in one place but not in another. For example, the space
after a body paragraph may look correct when it appears before another body
paragraph, but the space might be too large when it appears before a list.
■

Review all autonumbering carefully.

Examine the numbering for steps, figures, and any other autonumbered
paragraphs defined in the template. Check the alignment of double-digit lists
and chapter numbers.
■

Apply each master page to a body page.

■

Try each condition tag with its indicators on.

■

Test the color definitions.

Make sure color objects look the way you expect. Remember that colors on your
monitor do not look exactly the same as printed colors.
■

Create tables using various table formats.

■

Create equations to try out math element definitions and equation sizes and fonts.

■

Generate a table of contents from a sample document.

Check the chapter and heading autonumbering.
■

Add several sample documents to a book and update the documents.

Check any cross-chapter autonumbering such as chapter and page numbers.
■

Print a sample document to see how it looks.
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To organize templates in a directory
A template directory should contain all the related templates as well as a
document that describes the templates and how to use them.
1

Create a new directory.

Give the directory a recognizable name that identifies what the templates are
for. Put the directory in a place where your group of users has access to it and
will be able to find it.
2

Move each template into the new directory.

You could also save your templates in the Templates directory
($FMHOME/fminit/usenglish/Maker/Templates), which makes them
available to all users.
3

Set the file permissions so that template users have only read access to the templates.

Use the Save As command on the File menu to do this. Turn on Read
permission and turn off Write permission for the group.

IMPORTING FORMATS INTO A DOCUMENT
You can update a document by importing paragraph formats, table formats,
variable definitions, and other design elements from a template.
In general, when you import formatting information, FrameMaker merges the
information into the document rather than completely replacing the
information. For example, when you import a template’s Paragraph Catalog,
FrameMaker adds the template’s paragraph formats to the document’s
Paragraph Catalog. If any formats have the same name in both files, the
template’s format updates (overwrites) the document’s format. But if the
document has any formats that are not in the template, those formats remain
in the document.

To import formats into a document
You can import all the design elements from a template into a document, or you
can import just the ones you specify. You can also retain any format overrides in
the document—for example, tab settings—that were made to a paragraph but
not saved in a paragraph format.
1

Open the document you want to update and the template with the formats you want
to import.

The template must be named and saved.
2
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Choose the template from the Import from Document pop-up menu.

Choose the file with the
formats you want to use.

Settings you can update
in the current document

Format overrides

The pop-up menu lists all open, saved documents.
4

Turn on the Import and Update settings you want to apply to the current document.

If you’re updating variable definitions, cross-reference formats, or math
definitions, and if any of these items use character formats, turn on
Character Formats too so that the formats are added to the document.
For more information on these settings, see “Import and update settings” on
page 21-14.
5

To remove changes you made to individual formats without saving them in a catalog,
turn on settings in the While Updating, Remove area.

When you turn on Manual Page Breaks, FrameMaker removes page breaks
that are not part of the document’s Paragraph Catalog.
When you turn on Other Format/Layout Overrides, FrameMaker removes
paragraph, character, page layout, and table formatting overrides.
6

Click Import.
REMOVING FORMAT OVERRIDES IN THE CURRENT DOCUMENT

You can remove format overrides in a document without importing from
another document. To do this, choose Import>Formats from the File menu,
choose Current from the Import from Document pop-up menu, turn on the
settings in the While Updating, Remove area, and click Import.
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IMPORT AND UPDATE SETTINGS
When you use the Import Formats dialog box to
import and update one of the format items listed
below, the item is updated to match the imported
format. An item is updated only when the tags it
uses in your document are identical to the tags
used in the imported format.
The list describes the results of updating for each
item. If your document is a book file, and if you
import and update a format item, the results apply
to all the documents in the book file, even those
not open.
Paragraph Formats Merges the template’s
Paragraph Catalog into the document.
FrameMaker also copies the template’s footnote
properties, the characters in the Allow Line Breaks
After setting in the Text Options dialog box, and
the Feather settings in the Line Layout dialog box.
Character Formats Merges the template’s
Character Catalog into the document.

Merges the template’s master pages
into the document. If the template and the
document both have a master page with the same
name, the template’s master page replaces the
document’s. FrameMaker copies the change bar
properties and the Page Number Style settings
from the Numbering Properties dialog box.
FrameMaker also copies all the settings from the
Page Size dialog box and many of the settings in
View Options (the Display Units, which document
guides are on when you open a document, and Grid
Spacing).

Page Layouts
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Table Formats Merges the template’s Table
Catalog and ruling styles into the document. For
more information on which table formats are
updated, see “Table properties” on page 7-4.

Merges the template’s color
definitions and views into the document.

Color Definitions

Reference Pages Merges all but the template’s
FrameMath™ reference pages into the document.
If the template and the document both have a
reference page with the same name, the template’s
reference page replaces the document’s. To import
the FrameMath reference pages, turn on Math
Definitions.
Variable Definitions Merges the template’s variable
definitions into the document.
Cross-Reference Formats Merges the template’s
cross-reference formats into the document and
updates internal cross-references.
Conditional Text Settings Merges the template’s
condition tags and Show/Hide settings into the
document.

Copies the template’s equation
size and font settings, custom math element
definitions, and FrameMath reference pages into
the document. If any custom math elements in the
document are deleted when the reference pages
are merged, FrameMaker replaces the math
elements in equations with the name of the
element enclosed by question marks.

Math Definitions
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FrameMaker simplifies the creation of tables of contents and other
lists. You can generate lists that contain text from paragraphs or
markers you inserted throughout the text. The resulting list may be a
table of contents based on heading paragraphs, a list of illustrations
based on figure titles or captions, or any other page-based reference list.

You choose the type of information to include
For a list of headings such as a table of contents, you start by deciding
exactly which paragraphs you want to list. Usually, for a table of
contents, you include headings. For a list of illustrations, you could use
paragraphs tagged as figure titles or captions.
Source document

Style Guide
Punctuation
Commas

Fig. 1

1

Table of Contents
Punctuation .......................................1
Commas......................................1
Periods ........................................1

Periods
List of figures
Semicolons

Fig. 2

Table of contents

List of Figures
Fig. 1 Common errors.....................1
Fig. 2 Examples..............................1
Fig. 3 Punctuation symbols ............2

Lists such as glossaries include the text from markers rather than from
paragraphs.
Lists of references can include the fonts, cross-references, imported
graphics, text insets, or condition tags that appear in the source
document.
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Then FrameMaker generates the list
FrameMaker generates the list automatically when you give the
command. It extracts the information from the source document along
with the page number on which the information occurs, and builds the
list as a separate document.

Revisions and corrections are easy to manage
A generated list can quickly become outdated. As you revise your source
document, page numbers and text may change. You may also find errors
in the generated list. For example, an incorrectly tagged paragraph in
the source document may cause an entry to be missing or an extra entry
to appear in the list. You can trace such errors back to the source
document with a click of the mouse, make any corrections you need, and
then replace the earlier list with a current one.

You format the list only once
FrameMaker provides a basic format for generated lists. You can
substitute a template for the basic format or modify the basic format by
changing the page layout, changing the paragraph formats, or adding a
title. Once you set up the format, it will be retained when you generate
the list again.
Page design element
Title

Table of Contents

Paragraph
formats

Punctuation....................................... 1
Commas ..................................... 1
Periods........................................ 1

Tabs and tab leader dots

In this chapter
This chapter shows you how to create a list, how to fix problem entries
and update the list, and how to format the list.
For information on setting up and generating a list for a book file, see
Chapter 24, “Book Building.” For information on creating indexes, see
Chapter 23, “Indexes.”
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CREATING A LIST
A generated list can contain content from the source document—for example,
paragraph or marker text. When you generate a paragraph list, you choose the
tags of the paragraphs you want to include. When you generate a marker list,
you choose the marker type.

Style Guide

1
This table of contents includes first- and
second-level headings.

Punctuation
Commas
Periods

Table of Contents
Fig. 1
Semicolons

Fig. 2

Source document

Punctuation....................................... 1
Commas ..................................... 1
Periods........................................ 1
Semicolons ................................. 1
Colons ........................................ 2

Table of contents

A generated list can also contain references—information on the
source document’s fonts, cross-references, imported graphics, text insets, or
condition tags.

To prepare for a paragraph list
Before you generate a table of contents or other paragraph list, make sure you
have prepared your source document correctly.
■

Tag paragraphs consistently.

For example, use Heading1 for all first-level headings; don’t use it for any other
paragraphs.
■

Make each item you want to include in the list a single paragraph.

For example, you won’t get the desired results if a heading is two lines (with
each line in a separate paragraph).
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To mark a document for a marker list
When you’re preparing a table of contents or other paragraph list (or when
you’re preparing a list of references such as fonts or cross-references), you can
just generate the list. (For details, see “To generate a list” on page 22-7.)
However, when you’re creating a marker list, the markers must first be inserted
in the source document.
In many cases, the markers you want to extract are already in the document for
another purpose—for cross-references, running headers, conditional text, or
hypertext commands in a view-only document. But in other cases, such as
glossaries, you insert the markers yourself before generating the list.
1

Choose Marker from the Special menu.

The Marker window appears. You can leave it open while you insert additional
markers and edit the document.
2

Put the insertion point where you want to insert the marker.

You can insert markers only in text frames, not in text lines (objects drawn with
the Text Line tool).
To make it easy to edit around a marker, insert it at the beginning or end of a
paragraph. If the entry refers to a specific term in a paragraph, insert the
marker at the beginning of the term.
3

Choose a marker type from the pop-up menu and type the marker text that will
appear as an entry in the list.

Choose a marker type.

Type the list entry.

You can use Comment, Subject, Author, Glossary, or Equation markers or the
general-purpose Type markers.
You can also use Index markers, although you usually use them to generate an
index rather than a list. For a discussion of the differences between lists and
indexes, see “Lists of markers and indexes” on page 22-6.
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Don’t use the Conditional Text, Header/Footer $1, Header/Footer $2, Hypertext,
or Cross-Ref marker type. FrameMaker uses these for other purposes.
Marker text can be up to 255 characters long.
4

Click New Marker.

FrameMaker inserts a marker. When Text Symbols is on in the View menu, a
marker symbol ( ) appears.
MARKER SHORTCUTS AND EDITING

To use a word in the document as the entry text without typing marker text,
put a marker with no text in it at the beginning of the word. When you generate
the list or index, the word to the right of the marker becomes the text of an
entry.
To use a word or phrase in the document as the marker text, simply select it. As
long as the selected word or phrase doesn’t contain a marker, it automatically
appears in the Marker Text box. Then click New Marker.
For information on editing marker text after inserting a marker, see “Editing
and updating an index” on page 23-13. You edit and update all markers just as
you do index markers.
LISTS OF MARKERS AND INDEXES

A list of markers contains one entry for each marker inserted on a body page in
the source document. The marker text appears in the generated list exactly as
it does in the source document.
In an index of markers, entries are sorted alphabetically, and entries with the
same text are merged into a single entry with several page references. Also,
when you generate an index, FrameMaker recognizes some syntax in the
marker text that indicates index levels and special page numbering, sorting,
and formatting.
For information on generating an index, see Chapter 23, “Indexes.”
CHANGING NAMES OF MARKER TYPES

You can change the names of marker types that appear in the Marker window.
For information, see the online manual Changing Setup Files.
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To generate a list
After you prepare your source document for a table of contents or other list, you
generate the list from it. When you revise your source document, you can
update the list by generating it again.
You can generate a list of paragraphs, markers, or references. A table of
contents, a list of figures, or a list of tables is a paragraph list in which the
entries appear in the same order they appear in the source document. You can
also generate a list of markers ordered in this way. You can generate paragraph
or marker lists in alphabetical order as well.
For information on lists of references such as fonts, text insets, or condition
tags, see “Generating a list of references” on page 22-9.
1

Choose Generate/Book from the File menu in the source document.

2

In the Generate/Book dialog box, choose a type of list from the List pop-up menu.

3

Click Generate.

The labels in the dialog box that appears differ based on the type of list you’re
generating.

Filename suffix for the list
Items included in the list

Creates hypertext links to
the information in the source
document
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4

Move paragraph tags or marker types to the Include scroll list.

To move an item between scroll lists, select the item and click an arrow, or
double-click the item. To move all items from one scroll list to the other,
Shift-click an arrow.
The resulting list has the same name as the source document, plus a suffix that
depends on the item you chose in the List pop-up menu (for example, TOC for a
table of contents). You can change the suffix in the Filename Suffix text box
before you generate the list.
5

Click Generate.

FrameMaker generates the list and displays it on the screen in a separate
document. At this point, the list isn’t saved.
The first time you generate a list (if you don’t use a template for the list as
described in “To use a template for a list” on page 22-20), it uses the page layout
of the source document, and all entries use the same paragraph format. For
information on making changes to the format of a list—changes that won’t be
lost when you regenerate the list—see “Formatting a list” on page 22-14.
When the list exists in the source document’s directory, FrameMaker uses its
formatting when you generate the list again. So when you save the list, save it
in the same directory as the source document, and don’t change the filename.
Otherwise, FrameMaker won’t retain formatting changes when you update
the list.
UPDATING A LIST

When you make changes to a source document that affect the contents of the
list, generate the list again. For example, update a table of contents to include
revised headings and up-to-date page numbers or to change which paragraphs
are included.
Make sure you choose Generate/Book from the File menu in the source
document, not in the list.
DISPLAYING SOURCE INFORMATION BY CLICKING IN THE LIST

When you generate the list with Create Hypertext Links on, each entry in the
list contains a hypertext link to the corresponding information in the source
document. You can then easily trace an entry back to its source while editing, or
you can use the list as part of a hypertext-based online documentation system.
For more information on using hypertext links in the list to make editing easier,
see “To trace an entry back to its source” on page 22-12. For information on
creating online documentation, see Chapter 27, “Hypertext and View-Only
Documents.”
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GENERATING A LIST FROM A MULTIFLOW DOCUMENT

When the source document contains more than one text flow on a page,
FrameMaker extracts paragraphs or markers from the text flows, page by page
in the order in which they are drawn, from back to front.
GENERATING A LIST OF REFERENCES

You can generate a report that lists fonts, cross-references, or any of the
references listed below. This would be useful, for example, when you want to
check which fonts are used in a document before printing the document, or
when you want to make sure that external cross-references refer to the
appropriate documents.
To generate a list of references, choose List of References in the Generate/Book
dialog box. Then, in the Set Up List of References dialog box, choose the items
you want to include in the list and click Generate.
Item
Contents of generated list
..........................................................................

Condition Tags

The condition tags used and the pages on which they
occur

External
Cross-Refs

For each reference, the name of the document that
contains the source of the reference, the text of the
Cross-Ref marker at the source, and the page number on
which the cross-reference occurs

Fonts

A description of each font that appears on each page of
the document except for fonts used in equations, fonts in
imported Encapsulated PostScript (EPS) files, fonts that
appear only on reference pages, and fonts that appear on
master pages that have not been applied to the
document’s body pages

Text Insets

The path of each text file (or file containing the flow)
imported by reference and the page number on which
the text inset appears

Unresolved Text
Insets

The location of unresolved text insets

Imported
Graphics

The path of each graphic file imported by reference, its
dpi setting, and the page number on which the graphic
appears

Unresolved
Cross-Refs

The location of unresolved cross-references
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If you plan to generate and save several lists of references, specify a different
filename suffix for each list.
You can also generate these reports in index form rather than list form. Simply
choose Index of References from the Index pop-up menu in the Generate/Book
dialog box. In an index of references, each item appears once in alphabetical
order, followed by the page numbers on which it occurs. When you generate an
index of fonts, for example, FrameMaker creates an alphabetical list of fonts,
which can be much easier to read and print.
You can use the Document Reports command to provide other information on
the contents of a document. For details, see “Report generators” on page 22-10.
GENERATING A LIST ON OTHER PLATFORMS

If you plan to generate a list on more than one platform, see the online manual
Using Frame Products on Multiple Platforms.

REPORT GENERATORS
You can create reports with custom report
generators as well as with the Generate/Book
command whose uses are described in this chapter.
For example, FrameMaker includes a sample
report generator that counts the words in text
frames and text lines on body pages (including the
individual words in variables and crossreferences).
The types of reports you can generate at your site
vary, depending on the report generators that have
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been developed. Details on creating your own
report generators can be found in the
FDK Programmer’s Guide, which is included in the
Frame Developer’s Kit.
To use a report generator, choose
Utilities>Document Reports from the File menu.
In the Document Reports dialog box, click the
name of the report generator you want to use and
then click Run. For a brief description of the report
generator, click its name in the dialog box and then
click About.
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FIXING PROBLEM ENTRIES IN A LIST
Minor problems in the source document may cause corresponding problems in
the list. For example, an incorrectly tagged paragraph may cause an extra entry
to appear in the list or to be missing from it. Or an empty paragraph may cause
an extra line to appear in the list.

Punctuation 1
Commas 2
2
Periods 4

An extra line appears here.

Spelling 6
Rules of spelling are not absolute,
and there are many

This entry doesn’t belong in
the list.

You fix problem entries by tracing them back to the source document, fixing
them there, and then generating the list again. When you fix them by typing
directly in the list, your corrections disappear the next time you generate
the list.

To find missing entries
An entry may appear in the source document, but not in the list.
■

If all entries with a particular paragraph tag or marker type are missing, make sure the
Include scroll list in the Set Up dialog box contains the correct items.

For example, all first-level section headings might be missing.
■

If an occasional entry is missing, check the tag of the corresponding paragraph or the
type of the corresponding marker in the source document.

If the paragraph tag or marker type is incorrect, FrameMaker won’t include the
information in the list.

Using FrameMaker
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To trace an entry back to its source
When you’re trying to remove extra entries or fix typos or other problems, you’ll
find it helpful to trace an entry in the list back to the source document.
1

Turn on Create Hypertext Links in the Set Up dialog box when you generate the list.

Each entry in the list contains a hypertext marker. The marker text is a
hypertext command that allows you to display the corresponding information in
the source document with a click of the mouse.
2

Using the right mouse button, Control-click an entry in the list.

FrameMaker opens the source document, displays the page that contains the
corresponding source information, and selects the information. If you created a
marker list, the marker text appears in the Marker window. To display the
Marker window, choose Marker from the Special menu.
You can also lock the generated list as view-only and then simply click an
entry in the list to display the source information. To lock or unlock the list,
press Esc F l (lowercase L) k.

To remove extra entries
Careless formatting in the source document can cause a whole paragraph of
body text to appear in a paragraph list such as a table of contents. Or an extra
line that contains only a page number may appear in the list.
■

If the list contains an entry that doesn’t belong there, check the corresponding
paragraph tag or marker type in the source document.

The entry appears in the list because the paragraph tag or marker type
matches one of the tags or marker types you included in the list.
You should apply a different format to the paragraph or change the
marker type.
■

If the list contains an extra line with only a page number, delete the corresponding
empty paragraph in the source document.

If you need extra space between paragraphs in the source document, use the
spacing properties of the paragraphs’ formats rather than insert an empty
paragraph. For details, see “To set the spacing above and below a paragraph” on
page 4-20.
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To fix ent ries that take up more than one paragraph
A multiline heading in the source document can be a problem if the line breaks
were created by pressing the Return key so that each line is a separate
paragraph. The list will contain an entry for each paragraph in the heading.
Fixing the list requires changing the way the heading is handled in the source
document.
■

Delete the extra paragraph symbols in the source document.

To force a heading to break into two lines where you want, change the right
indent of the heading paragraph in the source document. If the heading is
centered, you may want to change both the left and right indents.

To fix bad line breaks
Bad line breaks in the list or its source document may separate information
that belongs together in the list. For example, the page number may appear on
a line by itself. A complex page number such as 2-3 may break across lines at
the hyphen. Or a forced return in the source document may be inappropriate
where it appears in the list.
■

Change the characters after which FrameMaker allows line breaks.

For example, FrameMaker normally allows a line break between an en dash (–)
and characters that follow it. To disallow line breaks after an en dash, use the
Document>Text Options command on the Format menu in the generated list.
For details, see “To control line breaks” on page 4-25.
■

Use nonbreaking spaces between the text and page number for each entry.

For instructions, see “To keep the page number with the entry text” on
page 22-17.
■

Change the prefix or suffix for the source document’s page numbers when you
generate the list for a book.

If the book’s pages are numbered by chapter (1-1, 1-2, …, 2-1, 2-2, …), the
prefix—for example, the chapter number and a hyphen—should use a
nonbreaking hyphen. For details, see “Controlling page and paragraph
numbering” on page 24-12.
■

Delete forced returns in the source document.

A forced return in the source document also appears in the generated list.
To change where a paragraph in the source document breaks into two lines,
change its right indent rather than insert a forced return. If a heading is
centered, you may want to change both the left and right indents.

Using FrameMaker
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FORMATTING A LIST
The first time you generate a list (if you don’t use a template as described in “To
use a template for a list” on page 22-20), it uses the page layout of the source
document, and all entries use the same paragraph format. You can use a
template for the list so it’s formatted the way you want from the start. You can
also change the page design and the formats in the list after you generate it just
as you do in any other document. When you generate the list again, your new
format is retained. However, when you apply text formatting changes directly
to the entries in the list, they are lost when you regenerate the list.
For example, you can change the headers and footers, the number of columns of
text, and the paragraph formats used for entries. You can add a title. And you
can use a tab and tab leader dots before the page numbers in entries, include
the autonumber of a paragraph in an entry, or rearrange the information in the
entries.
For information on changing page design, see Chapter 18, “Basic Page Design,”
and Chapter 19, “Custom Page Design.” For information on changing
paragraph and character formats, see Chapter 4, “Formatting Text,” and
Chapter 5, “Format Catalogs.”
Several of the formatting instructions that follow require you to edit a special
text flow on a reference page. For information on editing the special text flow,
see “To edit the special text flow,” next. For general information on reference
pages, see “Working with reference pages” on page 19-22.

To edit the special text flow
Many aspects of a list’s format and structure are controlled by a special text
flow on a reference page in the list. The text flow has a tag that matches the
filename suffix, such as TOC for a table of contents.
Each paragraph in the flow corresponds to a paragraph tag or marker type you
included in the list. For example, the paragraph tagged Heading1TOC in the
text flow for a table of contents corresponds to the entries for first-level
headings (tagged Heading1 in the source document). Building blocks such as
<$pagenum> and <$paratext> in each paragraph control what information
appears in the list and the order in which it appears.
If the list was created with hypertext links, the special text flow also contains a
paragraph that specifies the form of the hypertext commands in the list. The
paragraph’s tag begins with the word Active. For more information, see “Adding
hypertext links to generated files” on page 27-27.
1
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Display the reference page that contains the text flow.

The flow is usually on a reference page with the same name as the text flow—
for example, TOC for a table of contents—but it may have been moved to
another reference page.
3

Edit the appropriate paragraphs in the text flow.

See the following tasks for specific editing instructions.
4

Choose Body Pages from the View menu.

5

Generate the list again.

This lets you see the effect of the changes you made to the text flow.
Make sure you generate the list from the source document, not from the list.

To rearrange information in entries
You may want the page number to precede the text, or you may want some
other arrangement.
1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 22-14.
2

Rearrange the building blocks.

For example, to put the page number first, followed by the paragraph text,
rearrange the building blocks this way:
<$pagenum> <$paratext>
3

Generate the list again.

To chang e character formats
You can change the character format of any text appearing in a list. For
example, you can make the page number for all section headings in a table of
contents appear in bold.

Page numbers in bold

1

Punctuation
1 Commas
2 Periods
2 Semicolons

6

Spelling
6 Plurals
7 Foreign words

Using FrameMaker
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1

In the list, create a new character format.

Store the format in the Character Catalog.
2

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 22-14.
3

Type the character tag, between angle brackets (< and >), in the paragraph with the
tag that corresponds to the entries you want to change.

Type the character tag to the left of the item that has the character format you
want to change. For example, if you created the character format TOCPageNum
for the page number in first-level headings, use text such as:
<$paratext> <TOCPageNum><$pagenum>
4

Type <Default Para Font> where you want to change back to the paragraph’s
default font.

For example, if the page number preceded the paragraph text in the example
above, change the character format back to the paragraph’s default font as
follows:
<TOCPageNum><$pagenum><Default Para Font> <$paratext>
5

Generate the list again.

The character format changes to match your specification.
APPLYING CHARACTER FORMATS TO BUILDING BLOCKS

You can change the character format of text that appears in a list by applying a
character format directly to the building block rather than preceding it with the
character tag enclosed in angle brackets. To change the character format of an
entry, select it in the special text flow on the reference page (including the angle
brackets) and apply the desired character format.

To include paragraph autonumbers
You can include the autonumber—text and numbers inserted automatically as
part of a paragraph format—as well as the text of entries.

Paragraph autonumber
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Punctuation 1
1.1 Commas 1
1.2 Periods 2

2.0

Spelling 6
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Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 22-14.
2

Insert the <$paranum> building block where you want to insert the autonumber.

For example:
<$paranum> <$paratext> <$pagenum>
The entire autonumber appears in the generated list, except for any spaces or
tab characters at the end of the autonumber. To include only the autonumber
counters and the characters between them (for example, 2.2 rather than
Section 2.2), use the <$paranumonly> building block. For a complete list of
building blocks, see the online Help.

To keep the page number with the entry text
When an entry spans several lines, you can force the end of the entry text to
appear on the same line as the page number.

Punctuation 1
Commas 1
Periods 2
Semicolons 2
Colons 4
Hyphens and other
dashes 4

When the page number
moves to a new line, the
end of the entry moves
with it.

1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 22-14.
2

Replace the space between the <$paratext> and <$pagenum> building
blocks with a nonbreaking space, an en space, or an em space.

For information on typing special characters, see “To type characters not on the
keyboard” on page 3-6.
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To use tabs and tab leaders
You can include a tab and leader dots between the text and the page number.

Punctuation....................................... 1
Commas ..................................... 1
Periods........................................ 2

Tabs and tab leader dots

Spelling ............................................. 6

1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 22-14.
2

Select the space between the <$paratext> and <$pagenum> building blocks
in the paragraph with the entries you want to change.

3

Press Tab.

4

Change the paragraph format of the entry by adding a tab stop where you want to
align the page numbers.

For details, see “To define a tab stop” on page 4-15. The tab stop properties
include leader dots. For details, see “To set a tab leader” on page 4-17.
5

Update the paragraph formats of all entries with the same tag.

This stores the format in the list’s Paragraph Catalog, making it available the
next time you generate the list. For details, see “To update a paragraph format”
on page 5-12.

To add text in an entry
You can insert text at a specific location. For example, you may want to use
brackets to enclose the page number.

Punctuation..................................... [1]
Commas ..................................... 1
Periods........................................ 2

Brackets added around
page numbers for first-level
headings

Spelling ........................................... [6]

1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 22-14.
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Type the text where you want it to appear.

For example, to enclose the page number in brackets, type brackets around the
page number building block, like this:
<$paratext> [<$pagenum>]

To add a title
If you need a title for your list, add it after you generate the list the first time.
1

Type the title before the first entry in the list on the body page.

2

Create a new paragraph format for the title.

The paragraph tag must not end with the filename suffix, such as TOC for a
table of contents. When you generate the list again, FrameMaker replaces only
the paragraphs that have tags ending with the suffix, but retains the
paragraphs that don’t.

To retain format changes when generating
When you regenerate a list, all formatting instructions should be carried over to
the new list. If you made formatting changes that aren’t retained, check these
guidelines.
■

To retain formatting changes, don’t change the filename or location when you save
the list.

FrameMaker won’t find any formatting changes unless you save the list in the
same directory as the source document and you use the filename that
FrameMaker assigns.
■

To retain the title, make sure its paragraph tag doesn’t end with the filename suffix,
such as TOC for a table of contents.

■

To retain paragraph format changes, update all paragraphs that have the same tag.

This stores the formats in the list’s Paragraph Catalog, making them available
the next time you generate the list. For details, see “To update a paragraph
format” on page 5-12.
■

To retain character format changes in list entries, store the character formats in the
list’s Character Catalog.

This makes the formats available the next time you generate the list. For
details, see “Creating and updating character formats” on page 5-17.
■

To retain other changes, make them in the special text flow.

Using FrameMaker
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To use a template for a list
You can use a template for a list rather than generate the list and then make
format changes one by one. For information on creating a template for a list, see
“To create a template for a generated file” on page 21-9.
1

Copy the template to the source document’s directory, using the same filename as
the generated list.

2

Generate the list.

FrameMaker uses the format of the template.
UPDATING THE FORMAT OF A LIST FROM A TEMPLATE

Rather than copy a template to the source document’s directory, you can
generate the list and then update its formats from the template by using
the Import>Formats command on the File menu. Then generate the list
again so any changes in the special text flow are reflected in the list. If your
template uses a custom master page for the first page of the list, use the
Page Layout>Master Page Usage command on the Format menu to assign the
custom master page to the first body page. Finally, add a title if you want one.
STORING FORMATTING INFORMATION IN THE SOURCE DOCUMENT

You can store formatting information in the source document. For example, if
you store the special text flow, paragraph formats, and character formats you
use in the list, you won’t need to update these items from a template. They are
copied to the list automatically the first time you generate it.
If the page design of the list differs from that of the source document, you still
need to update the page design of the list from a template.
To store the formatting information in the source document, import the
paragraph and character formats for the entries into the source document’s
catalogs. Also copy the special text flow to a reference page in the source
document. For details, see “Importing formats into a document” on page 21-12.
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FrameMaker makes the task of compiling and updating an index
virtually automatic. You insert index markers in the text of a document,
and FrameMaker uses the markers to generate, sort, and arrange the
index.

The marker determines the form of an entry
When you insert an index entry, you provide the text for the marker
and specify the form of the index entry—for example, main entry,
subentry, or cross-reference to another entry.

Index
Main entry

A
abbreviating 18, 25–31
book titles 25, 29
chemistry terms 28
time periods 26–27
units of measure 30
See also acronyms
acronyms
alphabetizing 72

Page range

Subentries
Cross-reference to another
entry

You also specify whether the entry refers to a single page or to a page
range. The position of the marker in the document determines the page
number that appears in the index when you generate it. You can insert
index markers as you write or when the document is complete.

Careful planning minimizes revisions
A good index is consistent in style and structure. Careful planning
before you insert markers can reduce the number of revisions and
corrections you have to make later. For example, you need to decide
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whether you want one or two levels of subentries and whether you want
to use the singular or plural for nouns (object or objects).
You also need to decide whether to use action verbs or gerunds (add or
adding) and how entries should be capitalized (all in lowercase, with
initial capital letters, or in some other style). Last, you may want to
consider whether you’ll refer to page ranges (27–29) or to consecutive
pages (27, 28, 29).

FrameMaker turns your markers into an index
FrameMaker generates the index automatically when you give the
command. It extracts the marker text and page numbers from the
source document. The information is then sorted alphabetically,
combined when the entry text is the same, and arranged at the proper
levels when the marker text indicates subentries. The resulting index
appears in a separate document.

You can trace entries back to the source document
When you see the index, you’ll probably find some problems you want to
fix. You may find typos or inconsistent wording, and you may want to
add or delete some entries. Meanwhile, the source document itself may
be undergoing revisions and corrections. As such changes occur,
markers may move from page to page, and pagination will probably
change. When you’re ready to revise the index, you can trace index
entries back to their markers with a click of the mouse. You can then
generate an up-to-date index at any time.

You format the index only once
FrameMaker provides a basic format for generated indexes. You can
substitute a template for the basic format, or you can modify the basic
format by changing the page layout, changing the character and
paragraph formats, or adding a title. You can change how entries are
grouped under group titles and how several page numbers are
separated in an entry. You can even change the sort order for the entire
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index. Once you set up the format, it is retained when you generate the
index again.

Title

Index

Group title

A

Paragraph formats

Character format

Page number separators

abbreviating 18, 25–31
book titles 25, 29
chemistry terms 28
time periods 26–27
units of measure 30
See also acronyms
acronyms
alphabetizing 72

In this chapter
This chapter shows you how to create an index for a FrameMaker
document, update the index and fix problem entries, and change the
format.
For information on setting up and generating an index for a book file,
see Chapter 24, “Book Building.”
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CREATING AN INDEX
You indicate an index entry by marking it—inserting an index marker in the
text. A marker appears only as a marker symbol ( ) in the text, but it contains
the text of the index entry. You can see the marker text in the Marker window.
A marker can also contain building blocks that change the form of the entry.
Use building blocks to create subentries, cross-references, or page ranges. Also
use them to change the character format in an entry or to change the entry’s
location—its sort order.
abbreviating:time periods

Time periods
You can abbreviate units of time.
In technical material, units are
usually abbreviated.
Index marker in source document

abbreviating 18, 25–31
chemistry terms 28
time periods 26
units of measure 30

Formatted entry placed in the index

For a description of the building blocks you can use in an index entry, see “Index
building blocks” on page 23-6.

To mark an entry
Before generating an index for a document, you mark the index entries,
working with one marker at a time.
1

Choose Marker from the Special menu.

The Marker window appears. You can leave it open while you insert additional
markers and edit the document.
2

Put the insertion point where you want to insert the marker.

You can insert markers only in text frames, not in text lines (objects drawn with
the Text Line tool).
To make it easy to edit around a marker, insert it at the beginning or end of a
paragraph. If the index entry refers to a specific term in a paragraph, insert the
marker at the beginning of the term.

Using FrameMaker
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3

Choose a marker type from the pop-up menu and type the text of the index entry.

Choose the marker type.

Type the entry.

You usually choose a marker type of Index. To create several indexes for a
document—for example, a subject index and an author index—use a different
marker type for each. However, don’t use the Conditional Text type,
Header/Footer $1, Header/Footer $2, Hypertext, or Cross-Ref marker type for
index entries. FrameMaker uses these for other purposes.
A few characters have special meaning when used in marker text. To include a
colon (:), a semicolon (;), a bracket ([ or ]), an angle bracket (< or >), or a
backslash (\) in an entry, precede it with a backslash.
Marker text can be up to 255 characters long.

INDEX BUILDING BLOCKS
You can use building blocks in marker text to
control the form of the index entry and its location
in the index.
colon (:)

Separates levels in an entry

semicolon (;)

Separates entries in a marker

brackets ([]) Specifies a special sort order for the

entry
<$startrange>

Indicates the beginning of a page
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Suppresses the page number in the

entry
<$singlepage> In a marker that contains several
entries, restores the page number for an entry that
follows a <$nopage> building block
Character tag, between angle brackets (< and >)

Changes the character format (for example,
<Emphasis>)
<Default Para Font>

range
<$endrange>

<$nopage>

Indicates the end of a page range
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Click New Marker.

FrameMaker inserts a marker. When Text Symbols is on in the View menu, a
marker symbol ( ) appears at the insertion point.
MARKING AN ENTRY WITHOUT TYPING

To use a word in the document as the entry text without typing marker text,
put a marker with no text in it at the beginning of the word. When you generate
the index, the word to the right of the marker becomes the text of an entry.
To use a word or phrase in the document as the marker text, simply select it. As
long as the selected word or phrase doesn’t contain a marker, it automatically
appears in the Marker Text box. Then click New Marker.

To mark a subentry
Group several entries under the entry for a larger category of information by
marking them as subentries.

abbreviating
chemistry terms 28
time periods 26–27
units of measure 30

Subentries

You can also make subentries to subentries. An index usually has one subentry
level, two at most.
■

Mark the entry and subentry by using a colon (:) between them.

For example: abbreviating:chemistry terms
The subentry is always preceded by the entry to which it is subordinate, as in
the example. If you have two subentry levels, place a colon between the
subentry and the sub-subentry.

Using FrameMaker
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To mark a page range
Use a page range such as 25–31 to mark information that spans several pages.

abbreviating 18, 25–31
chemistry terms 28
time periods 26–27
units of measure 30

Page ranges

You insert two markers to indicate the range, one at the beginning of the range
and the other at the end.
1

Mark the beginning of the information and type <$startrange> at the beginning
of the marker text.

For example: <$startrange>abbreviating
2

Mark the end of the information and type <$endrange> at the beginning of the
marker text.

For example: <$endrange>abbreviating
Make sure you use exactly the same spelling, capitalization, and spacing in the
two markers.
When both markers appear on the same page, the page reference in the index
entry appears as a single page.
COMPRESSING SEVERAL ENTRIES INTO A PAGE RANGE

When the same marker text occurs on consecutive pages of a document, all the
page numbers usually appear in the index—for example, 23, 24, 25. Rather
than use <$startrange> and <$endrange> in two markers to indicate a
page range (23–25), you can make the page references in the index appear as a
page range automatically. For details, see “To compress several entries into a
page range” on page 23-22.
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To mark a cross-reference entry
Use a cross-reference entry to direct readers to other terms in an index. You
often use cross-reference entries rather than duplicate the entries and page
numbers for synonyms that already appear in the index.

captions. See legends
chemistry terms 19, 28, 43
See also scientific terms
colons 3

■

Cross-references

Mark the entry and type <$nopage> at the beginning of the marker text.

For example: <$nopage>captions. See legends
This prevents a page number from appearing with the entry in the index.

To chang e the character forma t in an entry
You can change the character format of the page number in an entry. For
example, you may want a word or phrase in an entry to appear in italics or you
may want the page number to appear in bold.
■

To use a different character format for part of an entry, mark the entry,
typing the character tag between angle brackets (< and >) before the part and
<Default Para Font> after it.

For example, to create the entry “captions. See legends,” use this marker text:
<$nopage>captions. <Emphasis>See<Default Para Font> legends
In this example, Emphasis is a character format set to italic. The character
format must be stored in the Character Catalog of the index.
■

To use a different character format for the page number, mark the entry, typing the
character tag between angle brackets (< and >) at the end of the marker text.

For example, to create the entry “abbreviating 24,” use this marker text:
abbreviating<PrimaryEntry>.
In this example, PrimaryEntry is a character format set to bold. The character
format must be stored in the Character Catalog of the index.
DISPLAYING PRINCIPAL ENTRIES IN ANOTHER FORMAT

When you want the page number for all principal entries to appear in another
format such as bold or italic, use a different marker type for these entries. You
can then change the character format of all the page numbers that correspond
to that marker type in one step. For information, see “To change the character
format of all page numbers” on page 23-21.
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To chang e the sort order of an entry
You can change where an entry appears in the index. For example, while 1980
would normally appear with other numbers in the index, you may want it to
appear under N (for nineteen eighty).
■

Mark the entry, typing the sorting information between square brackets ([ and ]) at
the end of the marker text.

The sorting information must be the last item in the marker text.
Entry
Sort position
Marker text
..........................................................................

navigation 47
1980 10
nouns 21

Under N (for
nineteen eighty)

1980[nineteen eighty]

capitalizing
in Chinese 10
foreign capitals 18

Under
capitalizing, but
ignoring the word
in

capitalizing:in
Chinese
[capitalizing:Chinese]

abbreviating
units 16
see also acronyms

As the last entry
under abbreviating

<$nopage>abbreviating:
see also acronyms
[abbreviating:zzz]

In these examples, 10 is the page number for the entry, provided automatically.
In the last example, zzz sorts the entry as the last subentry under abbreviating.
The entry has no page number because the marker text includes the
<$nopage> building block.

To put several entries in one marker
It may be convenient to put the marker text for several short entries in one
marker. Marker text can be up to 255 characters long.
■

Mark several entries in the same marker, using a semicolon (;) between entries.
Entries
Sorted under
Marker text
...........................................................................

23-10
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P
C

punctuation;colons

hyphens. See dashes
dashes 10

H
D

<$nopage>hyphens. See
dashes;<$singlepage>dashes

1980 10
1980 10

Numbers
N

1980[1980;nineteen eighty]
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In the second example, <$nopage> affects subsequent entries in the marker.
To return to a single page number, <$singlepage> is included with the next
entry in the marker.
In the last example, the semicolon makes the same entry text (1980) appear in
two places in the index—with numbers and under N.

To generate an index from marked entries
After you mark the entries in your source document, you can generate the
index. When you revise your source document, you can generate the index
again to update it.
1

Choose Generate/Book from the File menu in the source document.

2

In the Generate/Book dialog box, choose a type of index from the Index
pop-up menu.

Choose Standard Index unless you’re generating more than one index for the
document.
3

Click Generate.

4

Move the marker type(s) you used for the entries to the Include Markers of Type
scroll list.

Filename suffix for the index

Items included in the index

Creates hypertext links to
the markers in the source
document

To move an item between scroll lists, select the item and click an arrow, or
double-click the item.
The resulting index has the same name as the source document, plus a suffix
that depends on the item you chose in the Index pop-up menu (for example, IX
for a standard index). You can change the suffix in the Filename Suffix text box
before you generate the index.
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5

Click Generate.

FrameMaker generates the index and displays it on the screen in a separate
document. At this point, the index isn’t saved.
The first time you generate an index (if you don’t use a template for the index as
described in “To use a template for an index” on page 23-28), it uses the page
layout of the source document and some basic paragraph formatting for the
entries. For information on making changes to the format of the index—changes
that won’t be lost when you regenerate the index—see “Formatting an index” on
page 23-19.
When the index exists in the source document’s directory, FrameMaker uses its
formatting when you generate the index again. So when you save the index,
save it in the same directory as the source document, and don’t change the
filename. Otherwise, FrameMaker won’t retain formatting changes when you
update the index.
DISPLAYING SOURCE INFORMATION BY CLICKING IN THE INDEX

When you generate the index with Create Hypertext Links on, each entry in the
index contains a hypertext link to the corresponding marker in the source
document. You can then easily trace an entry back to its source while editing, or
you can use the index as part of a hypertext-based online documentation
system.
For more information on using hypertext links in the index to make editing
easier, see “To trace an entry back to its source” on page 23-13. For information
on creating online documentation, see Chapter 27, “Hypertext and View-Only
Documents.”
If your index has group titles such as A or A–C, turning on Create Hypertext
Links provides links for these titles as well as for the individual entries within
the groups. For information on using these links to navigate to the beginnings
of the groups, see “To add thumbtabs to a generated index” on page 27-29. For
information on creating group titles, see “To change entry groupings and group
titles” on page 23-26.
GENERATING AN INDEX ON OTHER PLATFORMS

If you plan to generate an index on more than one platform, see the online
manual Using Frame Products on Multiple Platforms.
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EDITING AND UPDATING AN INDEX
No matter how carefully you plan the index, you’ll probably want to make some
changes when you review the entire index for the first time. For example, some
entries may not use parallel phrasing; you may decide to change the
organization of some entries; or you may need to correct some spelling errors.
You revise or delete an index entry after tracing it back to its corresponding
marker in the source document. You add an entry just as you do when you
create the index in the first place.
Keep the index current by updating it after you edit the source document.

To trace an entry back to its source
When you review the generated index and find an entry that needs revision,
you have to trace the entry back to the corresponding marker in the source
document in order to revise the entry.
1

Turn on Create Hypertext Links in the Set Up dialog box when you generate the index.

Each page reference in the index includes a Hypertext marker. The marker text
is a hypertext command that allows you to display the corresponding
information in the source document with a click of the mouse.
2

Choose Marker from the Special menu.

3

Using the right mouse button, Control-click an entry or a page reference in the index.

FrameMaker opens the source document, displays the page that contains the
corresponding marker, and selects the marker. The marker text appears in the
Marker window.
You can also lock the index as view-only and then simply click a page reference
in the index to display the corresponding marker. To lock or unlock the index,
press Esc F l (lowercase L) k.
OTHER WAYS TO SELECT A MARKER

You can use the Find/Change command on the Edit menu to find and select a
marker by choosing Any Marker, Marker of Type, or Marker Text from the Find
pop-up menu. If you choose Marker of Type or Marker Text, fill in the Find text
box. When found, the marker is selected, and the marker text appears in the
Marker window. Don’t click Change in the Find/Change window to change the
marker text. If you do, FrameMaker replaces the marker itself. For details on
changing the text of a marker, see “To revise or delete an entry,” next.
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You can also select a marker by dragging through it. But if several markers
appear next to one another, you’ll find it difficult to select only one. In that case,
you can use keyboard shortcuts to select one character at a time. For details on
shortcuts, see the Quick Reference.

To revise or delete an entry
You revise entries by fixing their corresponding markers in the source
document. When you revise them by typing directly in the index, your changes
disappear the next time you generate the index. For example, you can use the
Spelling Checker to find spelling errors in an index. But when you find an error,
you correct it by changing the marker text in the source document.
When you trace an entry back to its corresponding marker in the source
document (as described previously), the marker is selected, and the marker text
appears in the Marker window.
■

To revise an entry, select the marker, change the text in the Marker window, and click
Edit Marker.

■

To delete an entry, select the marker in the source document and press Delete.

To update an index
Update an index after you revise marker text, add or delete markers, or fix
problem entries. Also update an index to include up-to-date page numbers after
revising the source document or to change which marker types are included.
■

Generate the index again.

For instructions, see page 23-11. Make sure you choose Generate/Book from the
File menu in the source document, not in the index.
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FIXING PROBLEM ENTRIES IN AN INDEX
If you type marker text or syntax incorrectly, the index will reflect it. The first
time you generate an index, problems often appear.

abbreviating 18, 29–??
book titles 25, 29
See also acronyms
time periods 26–27
asterisk 43
astrophysics terms,
capitalizing 73
astrophysics terms,
capitalizing 15

Incorrect sort order

Entries not grouped
correctly

Double question marks
indicate an incomplete
entry.

You fix problem entries with the same editing methods you use for normal
revisions to the index. You trace entries back to the source document and then
revise the text in the Marker window or delete the marker. When you fix entries
by typing directly in the index, your corrections disappear the next time you
generate the index.

To find missing entries
If an entry is missing entirely from the generated index, the corresponding
marker may have an incorrect marker type or be in hidden conditional text. If
you can’t find the marker in the source document, it was probably deleted
accidentally.
■

To find and select the marker, use the Find/Change command in the source
document.

In the Find/Change window, choose either Marker of Type or Marker Text from
the Find pop-up menu, and then type the marker type or marker text in the
Find text box. Choose Marker Text if you think the marker type might be
incorrect.
When a marker is selected, the marker text appears in the Marker window.
■

To make sure the marker isn’t in hidden conditional text, use the Conditional Text
command on the Special menu to show all conditional text, and then generate the
index again.

If the entry appears, its condition tag settings are incorrect. For information on
showing all conditional text, see “To change the view of a conditional document”
on page 26-16.
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■

To generate a list of markers, use Generate/Book on the File menu.

The list contains the marker text for all the markers, in page or alphabetic
order. You can then search the list for the entry you want. For details, see “To
generate a list” on page 22-7.

To fix ent ries that contain double question marks
Double question marks (??) appear in a page range when FrameMaker finds
only one of the two markers that mark the range.
■

Make sure that neither marker is missing.

■

Make sure that the spelling, punctuation, and capitalization of the marker text match
exactly, except for <$startrange> and <$endrange>.

In the illustration, a spelling difference causes the problem.
<$startrange>abbreviating:time period
<$endrange>abbreviating:time periods

This marker text…

abbreviating
time period 26–??
time periods ??–27

…results in these entries.

■

Make sure that <$startrange> appears in the first marker and that
<$endrange> appears in the second marker.

In the illustration, a missing <$startrange> causes the problem.

This marker text…

…results in this entry.

abbreviating
<$endrange>abbreviating

abbreviating 25, ??–31

If <$endrange> appears in the first marker, and <$startrange> appears
in the second marker, this index entry appears:
abbreviating ??–25, 31–??
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To fix ent ries that are sorted or grouped incorrectly
If sorting errors occur in a pattern—for example, if all numeric entries appear
at the end of the index rather than at the beginning—make sure that the
sorting information in the special text flow on the reference page is correct.
For more information, see “To change the sort order for an entire index” on
page 23-24.
However, most sorting problems result from incorrect marker text.
■

Make sure that the marker doesn’t contain an extra space.

In the illustration, an extra space in the second marker results in two lines in
the index where there should be only one.
abbreviating:book titles
abbreviating:book titles

This marker text…

abbreviating
book titles 25
book titles 29

…results in these entries.

■

Make sure that the punctuation is correct.

If a semicolon appears where a colon belongs, two main entries appear rather
than one subentry. If a colon is missing as in the illustration below, a subentry
appears incorrectly as a main entry.
abbreviating:book titles
abbreviating book titles

This marker text…

abbreviating
book titles 25
abbreviating book titles 29

…results in these entries.

■

Make sure that sorting information appears between square brackets ([ and ]) at the
very end of the marker text.
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■

Make sure that sorting information is correct.

Because :zzz is missing in the sorting information in the cross-reference entry
below, the cross-reference appears in the middle of the subentries rather than
at the end.
This marker text…

<$nopage>abbreviating:See also acronyms[abbreviating]

abbreviating 18, 25–31
book titles 25, 29
See also acronyms
time periods 26–27

…results in this entry.

In the example, use this marker text instead:
<$nopage>abbreviating:See also acronyms[abbreviating:zzz]

To remove page numbers from cross-reference entries
A cross-reference entry may incorrectly contain a page number.
abbreviating 18, 25–31
book titles 25, 29
See also acronyms 22
alphabetizing 46, 72

■

Make sure that <$nopage> appears at the beginning of the marker text for the
cross-reference entry.

To fix bad line breaks
Entries may break between numbers in a page range or between the end of the
entry and the first page number.

abbreviating book titles 18, 22, 25–
31
alphabetizing 46, 72
asterisks 43
astrophysics terms, capitalizing
15, 73

23-18

Using FrameMaker

Breaks on an en dash

Breaks before the first page
number

■

.....

INDEXES

Formatting an index

Change the characters after which FrameMaker allows line breaks.

For example, FrameMaker normally allows a line break between an en dash (–)
and characters that follow it. To disallow line breaks after an en dash, use the
Document>Text Options command on the Format menu in the index. For
details, see “To control line breaks” on page 4-25.
■

Change the characters used for page number separators.

To force the end of an entry to appear on the same line as the page number,
use nonbreaking spaces, an en space, or an em space as the separator
between them.
If you specified spaces or hyphens to appear between page numbers in a range,
make sure they are nonbreaking.
For details, see “To change page number separators” on page 23-22.
■

Change the prefix or suffix for the source document’s page numbers when you
generate the index for a book.

If the book’s pages are numbered by chapter (1-1, 1-2, …, 2-1, 2-2, …), the
prefix—for example, the chapter number and a hyphen—should use a
nonbreaking hyphen. For details, see “Controlling page and paragraph
numbering” on page 24-12.

FORMATTING AN INDEX
The first time you generate an index (if you don’t use a template as described in
“To use a template for an index” on page 23-28), it uses the page layout of the
source document and some basic paragraph and character formatting for the
entries. You can use a template for the index so it’s formatted the way you want
from the start. You can also change the page design and the formats in the
index after you generate it just as you do in any other document. When you
generate the index again, your new format is retained.
For example, you can change the headers and footers, the number of columns of
text, and the paragraph and character formats used for entries. You can add a
title. And you can use a tab and tab leader dots before the page numbers in
entries or include the autonumber of a paragraph in an entry rather than the
page number.
For information on changing page design, see Chapter 18, “Basic Page Design,”
and Chapter 19, “Custom Page Design.” For information on changing
paragraph and character formats, see Chapter 4, “Formatting Text,” and
Chapter 5, “Format Catalogs.”
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Several of the formatting instructions that follow require you to edit a special
text flow on a reference page. For information on editing the special text flow,
see “To edit the special text flow,” next. For general information on reference
pages, see “Working with reference pages” on page 19-22.

To edit the special text flow
Many aspects of an index’s format and structure are controlled by a special text
flow on a reference page in the index. The text flow has a tag that matches the
filename suffix, such as IX for a standard index. For each marker type
included in the index, the special text flow contains several paragraphs that
control the format and structure of entries generated from that marker type.
These paragraphs have tags that end with the filename suffix.
If the index was created with hypertext links, the special text flow also contains
a paragraph that specifies the form of the hypertext commands in the index.
The paragraph’s tag begins with the word Active. For more information, see
“Adding hypertext links to generated files” on page 27-27.
1

Choose Reference Pages from the View menu in the index.

2

Display the reference page that contains the text flow.

The flow is usually on a reference page with the same name as the text flow—
for example, IX for a standard index—but it may have been moved to another
reference page.
3

Edit the appropriate paragraphs in the text flow.

See the following tasks for specific editing instructions.
4

Choose Body Pages from the View menu.

5

Generate the index again.

This lets you see the effect of the changes you made to the text flow.
Make sure you generate the index from the source document, not from the
index.
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To chang e the character forma t of all page numbers
You can change the character format of page numbers for all entries created
with the same marker type. For example, if you want the principal entries in an
index to be more noticeable, you can use a different marker type for those
entries to have their page numbers appear in bold.

abbreviating terms 18, 25–31
alphabetizing 46, 72
asterisks 43
astrophysics terms,
capitalizing 15, 73

1

Principal entries in bold

In the index, create a new character format for the page numbers.

Store the format in the Character Catalog.
2

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 23-20.
3

Type the character tag, between angle brackets (< and >), at the start of the
paragraph with the tag that begins with the marker type.

For example, if IndexPageNum is a character format set to bold, you could type
the following in the paragraph tagged IndexIX:
<IndexPageNum><$pagenum>
When you generate the index again, the page numbers corresponding to entries
created from markers of type Index all change to bold.

To include paragraph autonumbers
If all paragraphs in the source document that can contain an index marker
have an autonumber—text and numbers inserted automatically as part of a
paragraph format—you can refer readers to the autonumber rather than a page
number. This is how the index to a printed Thesaurus often appears.
1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 23-20.
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2

Replace the <$pagenum> building block with <$paranumonly> in the
paragraph with the tag that begins with the marker type.

For example, to include the paragraph autonumber rather than the page
number in the entries generated from markers of type Index, replace the
building block in the paragraph tagged IndexIX.
The autonumber counters and the characters between them (for example, 2.2
for a paragraph whose autonumber is Section 2.2) appear in the index. To
include the entire autonumber in the index (except for spaces or tab characters
at the end of the autonumber), use the <$paranum> building block.

To compress several entries into a page range
When the same marker text occurs on consecutive pages of a document, all the
page numbers usually appear in the index—for example, 23, 24, 25. You can
make these page references appear in a page range (23–25) automatically.
1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 23-20.
2

Insert the <$autorange> building block at the beginning of the paragraph with the
tag that begins with the marker type.

For example, to compress the entries generated from markers of type Index
when possible, edit the paragraph tagged IndexIX to contain the following:
<$autorange><$pagenum>

To chang e page number separators
A typical index entry such as editing 1, 2–3 has a space after the entry text, a
comma and a space between page numbers, an en dash to show a range, and
nothing after the last number. You can change the en dash to to or change these
features in any other way.
1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 23-20.
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Edit the Separators paragraph.

You can change any separator, but you must use the numbers 1, 2, and 3.
Nonbreaking spaces
Em space

1, 2 to 3
With the change shown above, an em space appears between the entry text and
the first page number, and to appears between page numbers in a range.
Nonbreaking spaces were used to prevent 2 to 3 from breaking across lines.

To align page numbers
The page references in an index entry are normally separated from the entry
text by a space. When you want page numbers in an index to align with one
another, use a tab instead.
.

Index
A

Tab and tab leader dots

abbreviating ...................18, 25–31
book titles ......................25, 29
chemistry terms ...................28
time periods ...................26–27
units of measure ..................30
See also acronyms
acronyms
alphabetizing .......................72

1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 23-20.
2

Select the space before the number 1 in the Separators paragraph and press Tab.

3

Change the paragraph format for each level of the index by adding a tab stop where
you want to align the page numbers.

For details, see “To define a tab stop” on page 4-15. The tab stop properties
include leader dots. For details, see “To set a tab leader” on page 4-17.
4

Update the paragraph formats of all entries at each level of the index.

Make sure you update each format in the index’s Paragraph Catalog, making it
available the next time you generate the index. For details, see “To update a
paragraph format” on page 5-12.
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To ignore characters when sorting an index
By default, FrameMaker ignores hyphens, nonbreaking hyphens, en dashes,
and em dashes when sorting index entries. You can specify that FrameMaker
ignore other characters—for example, underscore characters or periods.
1

Display the reference page that contains the special text flow.

For details on the special text flow, see “To edit the special text flow” on
page 23-20.
2

Edit the IgnoreChars paragraph.

Add other characters you want to ignore when sorting, or delete characters you
want to consider.
SORTING THE INDEX LETTER BY LETTER

FrameMaker doesn’t usually ignore spaces when sorting index entries. As a
result, the entries are sorted word by word. To sort the index entries letter by
letter, add a space at the beginning of the IgnoreChars paragraph in the special
text flow. (The space cannot be at the end of the paragraph.)
Type of sort
Example
..........................................................................

Letter by letter

Typeface
Type font
Type lead
Typestyle

Word by word

Type font
Type lead
Typeface
Typestyle

To chang e the sort order for an entire index
Indexes are sorted so special symbols appear first, numbers appear second, and
alphabetic characters appear last. By default, alphabetic characters appear in
the correct sort order for the English language. You can change the sort order of
index entries—for example, to sort alphabetic characters based on the sort
order for another language.
You change the sort order by editing the contents of the SortOrder paragraph in
the special text flow. For details on the special text flow, see “To edit the special
text flow” on page 23-20.
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To move symbols, numbers, or alphabetic characters to another location in the index,
rearrange the building blocks in the SortOrder paragraph in the special text flow.

For example, to put the symbols at the end of an index, arrange the building
blocks as follows:
<$numerics><$alphabetics><$symbols>
■

To specify your own sort order for symbols, numbers, or alphabetic characters,
replace a building block in the SortOrder paragraph with the characters in the order
you want them to sort.

Each sort order building block represents several characters in a particular
order. The table below shows the order for US English. The alphabetic sort
order differs slightly for other languages.
Building block
Characters represented, in order
..........................................................................

<$numerics>

0 1 2 3 4 5 6 7 8 9

<$alphabetics>

AÁÀÂÄÃÅaáàâäãåª Bb CÇcç Dd EÉÈÊËeéèêë
Ffƒ Gg Hh IÍÌÎÏiıíìîï Jj Kk Ll Mm NÑnñ
OÓÒÔÖÕØoóòôöõøº Pp Qq Rr Ss Tt
UÚÙÛÜuúùûü Vv Ww Xx YŸyy Zz

<$symbols>

All other characters in ASCII order

Letter groups (for example, Dd above) are separated by spaces. Characters
within a letter group are sorted as if they were the same character, unless they
are the only characters that differ in the sorted text. For example, if two entries
differ only in their capitalization, the capitalized entry appears first:
Animus 2
animus 2
If you replace <$alphabetics> with individual characters, remember to
separate the letter groups with a space. Also, don’t press Return at the end of a
line. Let FrameMaker wrap the characters automatically from line to line.
If you replace <$symbols> with individual characters, use a backslash before
angle brackets (< or >).
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SORTING LETTER PAIRS AS IF THEY WERE A SINGLE LETTER

In some languages, letter pairs are sorted as a single letter. For example, in
Spanish, the letter pair ch should be sorted after c. To indicate that a letter pair
should be sorted in a particular way, specify the letter pair between angle
brackets (< and >)—for example: CÇcç<CH><Ch><ch>. In this example, all the
characters or letter pairs are in the same letter group (the letter C). The letter
pair CH is sorted after the letter C, and uppercase letter pairs are sorted before
lowercase letter pairs.

To chang e entry groupings and group titles
Index entries are grouped one letter at a time—all the A’s, all the B’s, and so
on—using the uppercase letter as a group title. If you have a small index or only
a few entries under some letters such as X, Y, and Z, you may want to group
letters differently and change the titles.
FrameMaker inserts group titles as if they were index entries, but uses a
different paragraph format. It uses the labels and sort positions you specify in
the GroupTitles paragraph in the special text flow. For details on the special
text flow, see “To edit the special text flow” on page 23-20.
■

To change the groupings and group titles, edit the GroupTitles paragraph in the
special text flow.

Replace the group titles (the characters between semicolons) with new titles, or
delete group titles you don’t want. Type text between square brackets ( [ and ] )
to specify how you want the group titles sorted.
For example, the following GroupTitles paragraph groups entries three letters
at a time. The group title A–C appears at the beginning of the A’s; D–F appears
at the beginning of the D’s; and so on.
Symbols[\ ];Numerics[0];A–C[A];D–F[D];G–I[G];J–L[J];M–O[M];
P–R[P];S–U[S];V–Z[V]

New group title
Sorting information

■

To create an index without group titles, edit the GroupTitles paragraph in the special
text flow to look like this:

[\ ];[0];[A];[B];[C];[D];[E];[F];[G];[H];[I];[J];[K];[L];
[M];[N];[O];[P];[Q];[R];[S];[T];[U];[V];[W];[X];[Y];[Z]
Empty paragraphs appear rather than group titles in the index. The sorting
information between the brackets ensures that the empty paragraphs appear in
the correct locations.
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To create an index with neither a group title nor a space between entry groupings,
delete all the text in the GroupTitles paragraph in the special text flow, but don’t
delete the paragraph symbol.
GROUPINGS IN HYPERTEXT DOCUMENTS

In a hypertext document, you can provide thumbtabs to the group titles to
make navigating through the index easier. For information, see “To add
thumbtabs to a generated index” on page 27-29.

To add a title
If you need a title for your index, add it after you generate the index the
first time.
1

Type the title before the first entry in the index on the body page.

2

Create a new paragraph format for the title.

The paragraph tag must not end with the filename suffix, such as IX for a
standard index. When you generate the index again, FrameMaker replaces only
the paragraphs that have tags ending with the suffix. It retains the paragraphs
that don’t.

To retain format changes when generating
When you regenerate an index, all formatting instructions should be carried
over to the new index. If you made formatting changes that aren’t retained,
check these guidelines.
■

To retain formatting changes, don’t change the filename or location when you save
the index.

FrameMaker won’t find any formatting changes unless you save the index in
the same directory as the source document and you use the filename that
FrameMaker assigns.
■

To retain the title, make sure its paragraph tag doesn’t end with the filename suffix,
such as IX for a standard index.

■

To retain paragraph format changes, update all paragraphs that have the same tag.

This stores the formats in the index’s Paragraph Catalog, making them
available the next time you generate the index. For details, see “To update a
paragraph format” on page 5-12.
■

To retain character format changes in index entries, store the character formats in the
index’s Character Catalog.

This makes the formats available the next time you generate the index. For
details, see “Creating and updating character formats” on page 5-17.
■

To retain other changes, make them in the special text flow.
Using FrameMaker
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To use a template for an index
You can use a template for an index rather than generate the index and then
make format changes one by one. For information on creating a template for an
index, see “To create a template for a generated file” on page 21-9.
1

Copy the template to the source document’s directory, using the same filename as
the index.

2

Generate the index.

FrameMaker uses the format of the template.
UPDATING THE FORMAT OF AN INDEX FROM A TEMPLATE

Rather than copy a template to the source document’s directory, you can
generate the index and then update its formats from the template by using
the Import>Formats command on the File menu. Then generate the index
again so any changes in the special text flow are reflected in the index.
If your template uses a custom master page for the first page of the index, use
Page Layout>Master Page Usage on the Format menu to assign the custom
master page to the first body page. Finally, add a title if you want one.
STORING FORMATTING INFORMATION IN THE SOURCE DOCUMENT

You can store formatting information in the source document. For example, if
you store the special text flow, paragraph formats, and character formats you
use in the index, you won’t need to update these items from a template. They
are copied to the index automatically the first time you generate it.
If the page design of the index differs from that of the source document, you still
need to update the page design of the index from a template.
To store the formatting information in the source document, import the
paragraph and character formats for the entries into the source document’s
catalogs. Also copy the special text flow to a reference page in the source
document. For details, see “Importing formats into a document” on page 21-12.
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You can group separate documents into one FrameMaker book. This
grouping lets you generate a single table of contents or other file for the
documents, and it greatly simplifies printing, numbering, crossreferencing, and formatting.

A book ties related files together
A book ties multiple files together so you can work with them as a
single unit. For example, you can number pages and paragraphs
continuously from one file to the next, update cross-references across
the files all at once, and so on.
BookTOC

1Chapter

2Chapter

3Chapter

BookIX

BookTOC
1Chapter
2Chapter
3Chapter
BookIX
A book might contain chapters and generated files for a manual.

You can generate a table of contents and an index for the entire book,
and you can print the entire book with single commands.

Files are listed in the book window
When you’re ready to assemble a book, you list the names and locations
of your files in a book window in the order you want them. The
information is saved in a book file. The book file can contain documents
and generated files.
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You specify the numbering system
Each file in a book can have its own numbering properties. For example,
you might start page numbering at i in the table of contents,
1 in the first chapter, number continuously through subsequent
chapters, and then start over again at 1 in the index. You can also add a
prefix or a suffix to page numbers—for example, 2- in page 2-1—and
you can specify whether a file begins on a left or right page.
Pagination can start at 1 in
some files and can be
continuous in others.

Table of Contents

i
ii

Chapter 1

Chapter 2

1

5
2

iii

Index

I-1
I-2

6
3

7
4

I-3
8
9

FrameMaker does the rest
When you’re ready to generate and update the files in the book, a
command starts FrameMaker creating or updating generated files such
as the table of contents. Page and paragraph numbering are updated
throughout the files, text insets are updated, and cross-references are
updated to match the new page and paragraph numbers.

You can use the book window for revisions
Once a book is set up, you can use its book window to do further work
on the files. You can open document files directly from the book window
to revise them, and you can use the book window to print, save, or
format files, even when they’re not open.
If you have two versions of a book, you can open two book windows and
run a comparison of the text and other items in the versions.

In this chapter
This chapter shows you how to set up the files in a book, specify page
and paragraph numbering, generate and update the files, work with
files from the book window, and compare two versions of a book. For
more detailed information on tables of contents and indexes, see
Chapter 22, “Generated Lists,” and Chapter 23, “Indexes.”
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SETTING UP A BOOK
When setting up a book, you first create a book file and then tell FrameMaker
which documents and other files you want to include in it. The filenames appear
in a book window in the order you specify. For information on preparing files for
a book, see “Organizing files for a book” on page 24-4.
Setting up is the beginning of the book-building process, and it’s useful to think
through the entire process before you begin.

To think t hrough the book-building process
Book building is assembling the parts of a book—table of contents, chapters,
and so on. You generate parts such as the table of contents during the assembly
process, but most of the book exists as separate parts before you assemble them.
When these parts are complete and you are ready to begin building the book,
you will find it easier to proceed if you have the whole process firmly in mind.
The steps of the book-building process follow. They are explained further in the
next sections.
1

Create a book file.

For details, see “To create a book file” on page 24-6.

ORGANIZING FILES FOR A BOOK
As you prepare your files for a book, follow these
tips to help you get organized.
Consolidate files Create a directory specifically for

your book. Then put the book file and all the
document files in this directory.
Separate chapters Put each chapter in a separate
FrameMaker document.
Divide long files If you have any chapters over
50 pages long, consider dividing them into
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separate files, making sure each file begins at the
top of a page (that is, don’t split sentences,
paragraphs, or tables across files).
FrameMaker opens and saves short documents
faster than it does long documents, so you might
find the separate files easier to work with. You can
number the pages and paragraphs continuously
throughout the files so they still fit together as a
chapter.
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Save and name the book file.

Save the book file periodically as you set up files and whenever you edit
the book.
3

Add the filenames for existing documents to the book file.

Think of these documents as the book’s chapters. For details, see “To add
document files to a book” on page 24-7.
For tips on preparing files for a book before you add them, see “Organizing files
for a book” on page 24-4.
4

Set up any generated files for the book—for example, a table of contents and
an index.

Setting up the generated files tells FrameMaker what information you want it
to find when generating the files and defines the files’ pagination and
autonumbering. For details, see “To add a generated file to a book” on page 24-8.
5

Specify the pagination and autonumbering for the documents.

This defines such characteristics as whether each document starts at page 1 or
continues where the previous document left off. For the steps to specify
pagination and autonumbering, see “Controlling page and paragraph
numbering” on page 24-12.
6

Generate and update the book.

Generating and updating a book updates page and paragraph numbering in all
the files in the book, updates text insets in the book’s files, updates crossreferences so they are correct based on the new page and paragraph numbers,
and creates or updates generated files. Although this is the last step in the
book-building process, there are other times when you should generate and
update the book. For information on how to generate and update a book, see
“Generating and updating” on page 24-18. For information on when to generate
and update a book, see “When to generate and update” on page 24-20.
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To create a book file
You typically generate the book file from the first document that will be in the
book, but you can generate the book file from any document.
1

Open one of the documents you want to include in the book.

2

Choose Generate/Book from the File menu.

3

In the Generate/Book dialog box, click New Multifile Book and click Generate.

A book window appears showing the contents of the book file (so far just the
document you started with). If any files generated from this document—for
example, a table of contents or an index—are in the same directory, they also
appear in the book window.
FrameMaker gives the book
a name based on the
document’s name, plus the
extension .book.
The name of the document
you generated from
appears in the book
window.

4

Name the book.

You probably want to give the book a name more general than the name of a
document in it—for example, Manual rather than 1Chapter. You can rename
the book file when you save it.
SAVING, RENAMING, AND CLOSING A BOOK FILE

You can save, rename, and close a book file just as you can a document file.
Choose Save, Save As, Revert to Saved, or Close Book from the File menu in the
book window. For information on these commands, see Chapter 2, “Basic
Procedures.” Be aware that saving a book file saves only the book and not the
files in it.
FrameMaker lets you open, save, or close all the files in a book file at once. Hold
down Shift, open the book’s File menu, and choose Open All Files in Book,
Save All Files in Book, or Close All Files in Book. For information on these
commands, see “Working with files in a book window” on page 24-24.
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To add document files to a book
You can add document files or generated files to a book. When you add a file to a
book, you are actually adding only its name and location to the book file. The
book file can then find the document or generated file when you choose
commands from the book window in order to work with a file.
These instructions are for adding a document file. For information on adding a
generated file, see “To add a generated file to a book” on page 24-8.

Select a single file you want
to add.

1

Choose Add File from the File menu in the book window.

2

Specify which document files you want to add to the book.

Location for the files
you’re adding

Or turn on this setting to add
all the files in the scroll list
that are saved in Normal
format.

You can add any document saved in Normal format. Rather than add files one
at a time, it may be quicker to add all the files in the scroll list, delete unwanted
files from the book, and then rearrange the files in the order you want.
You can change to another directory in this scroll list just as you do in similar
scroll lists.
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3

Specify where the document files should go in the book.

Select a filename in the scroll list below the Add File pop-up menu, and choose
Add File After or Add File Before from the pop-up menu.
4

Click Add.

The filename appears in the scroll list below the Add File pop-up menu where
you specified.
5

If this is the only file or the last file you are adding, click Done.

If you have more files to add, repeat steps 2 through 4, once for each file you
want to add to the book, before clicking Done.
USING A WILDCARD TO DISPLAY FILENAMES

You can limit the contents of the Document File scroll list. In the
Add File to Book dialog box, click Document File, type a wildcard in the text box
above the list, and press Return. This is helpful when you want to add all
similarly named files to a book. For example, to display only the files ending
with .doc, type *.doc in the text box and press Return. To display the entire
contents of the directory again after using a wildcard, type an asterisk (*) in the
text box and press Return. For information on other wildcards, see “Wildcards”
on page 8-8.
RENAMING A DOCUMENT FILE IN A BOOK

A book isn’t updated automatically to reflect filename changes of the files in the
book. To change the name of a document in a book, change the filename on the
disk. Then delete the old filename from the book file and add the new one. For
information on deleting files from a book file, see “To rearrange or delete files”
on page 24-12.

To add a generated file to a book
You can add any kind of generated file to a book—for example, a table of
contents, a list of figures, or an index. The file need not exist yet; it will be
created when you generate it. When you generate the file, FrameMaker gathers
information from the files in the book.
When you add a generated file to a book, you also define the information you
want to include in it and the pagination and autonumbering properties.
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FrameMaker bases the name of a generated file on the book’s filename. Before
adding a generated file, make sure the book file has the name you want.
For background information on generated files and how to prepare for them, see
Chapter 22, “Generated Lists,” and Chapter 23, “Indexes.”
1

Choose Add File from the File menu in the book window.

2

Specify which type of generated file you want to add to the book.

Choose a file type from one
of these pop-up menus.

Location for the file
you’re adding

Don’t click Document File even if you want to add an existing generated file. If
you add the file as a document, FrameMaker won’t recognize it as a generated
file and won’t update it.
3

Specify where the generated file should go in the book.

Choose Add File After or Add File Before from the pop-up menu and select a
filename in the scroll list below the pop-up menu.
4

Click Add.

Another dialog box appears, showing the items FrameMaker can search for
when generating the file.
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5

Move the items you want in the generated file to the Include scroll list.

The information in the scroll lists varies depending on the type of file you’re
generating. For a table of contents or other list based on paragraph tags, the
paragraph tags used in the book’s documents appear. For an index or other
marker list, the FrameMaker marker types appear. For a list of references or
index of references, the items Condition Tags, External Cross-Refs, Fonts,
Imported Graphics, Text Insets, Unresolved Cross-Refs, and Unresolved Text
Insets appear.

Include scroll list

Pagination and
numbering properties
for the file

To move an item between scroll lists, select the item and click an arrow, or
double-click the item. To move all items from one scroll list to the other,
Shift-click an arrow.
6

To include automatically generated hypertext links in the generated file, turn on
Create Hypertext Links.

FrameMaker automatically creates hypertext links for each item in the Include
scroll list. When you click a generated entry in the document (for example, a
section name in a table of contents), FrameMaker opens the source document
and displays the appropriate page.
7

Specify pagination and autonumbering for the generated file in the bottom part of the
dialog box.

The settings are the same as they are for a document file. For information on
them, see “To specify the numbering properties” on page 24-13.
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Click Set.

The generated file’s name, followed by a plus sign (+), appears in the
book window and in the scroll list below the Add File pop-up menu in the
Add File to Book dialog box. The file hasn’t been generated yet; you’ll generate
and update all the files in the book when you finish setting up the book file. For
information on generating files, see “To generate and update files in a book” on
page 24-20.
9

If this is the only file or the last file you are adding, click Done.

If you have more generated files to add, repeat steps 2 through 8, once for each
generated file you want to add, before clicking Done.
USING AN EXISTING FILE AS A GENERATED FILE

If you generated and formatted a table of contents or other generated file before
creating the book, or if you want to use a template for a generated file, you can
use the existing file as a generated file in the book.
First use the Add File command to add a new generated file to the book, making
sure that you click a generated file option in the dialog box. If you don’t,
FrameMaker won’t recognize the file as a generated file and won’t update it.
Then put the existing generated file in the directory that contains the book file,
using the name of the generated file in the book. (Look in the book window to
get the generated file’s name.)
RENAMING A GENERATED FILE

When you add a generated file to a book, FrameMaker assigns the file a name
based on the book’s filename. In general, you shouldn’t change the name of the
generated file. If you rename the book file using the Save As command, the
name of the generated file changes in the book window. FrameMaker won’t be
able to find the renamed generated file when you try to generate, update, or
open it. If this happens, change the generated file’s name on the disk to match
the name in the book window.
If you rename the book file outside of FrameMaker, and if you want the
filename of a generated file to be based on the book’s current filename, delete
the generated file from the book. Then add the generated file again.
FrameMaker gives the file a name based on the book’s current filename.
Finally, change the file’s setup using the Set Up File command.
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To rearrange or delete files
You can change the order of files in a book file and delete files from a book file.
When you delete files, the filenames are removed from the book window, but the
files remain on the disk.
1

Choose Rearrange Files from the File menu in the book window.

2

Select a file and click Move Up, Move Down, or Delete.

Files in the book, in their
current order

You can rearrange and delete as many files as you want.
3

When the files are arranged correctly, click Done.

CONTROLLING PAGE AND PARAGRAPH
NUMBERING
You can specify numbering properties for each file in a book. For example, you
might start page numbering at 1 in the table of contents and first chapter,
continue through subsequent chapters, and then start over again at 1 in the
index. You can also add a prefix or suffix to the page number—for example, 3- in
page 3-6.
Some aspects of page and paragraph numbering are set in the book file—
whether a file begins on a left or right page, whether the page and paragraph
numbering are continued from the previous chapter, and whether page
references in generated files have a prefix or suffix.
Other aspects are set in the documents themselves—including the numbering
style (for example, Arabic or Roman), and the prefix or suffix you want to use in
page footers or in cross-references.
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To specify the numbering properties
When you generate a book, you can specify whether a file begins on a right or
left page and whether numbering continues from the previous file in the book.
You can also add a prefix or suffix to the page numbers that FrameMaker puts
in the entries of generated files. For example, you can include a chapter number
before page numbers to create page references such as 2-3 in a table of contents.
For information on adding a prefix or suffix to the numbers in the file’s headers
or footers, see “To include chapter numbers in headers or footers” on
page 24-15.
1

In the book window, select the name of the file whose numbering properties you want
to change.

2

Choose Set Up File from the File menu In the book window.

3

To put text before or after the file’s page numbers in generated files, fill in the Prefix or
Suffix text box.

Type a prefix or suffix you
want to use in generated
files.

For example, if you want a prefix such as 1- to appear for a chapter number
when a page number from Chapter 1 appears in a generated file, type the
chapter number and the hyphen in the Prefix text box. If you later rearrange
files in the book so that the prefix is no longer accurate, you change the prefix in
this dialog box.
If the prefix or suffix contains a hyphen, use a nonbreaking hyphen
(Meta-hyphen) to prevent lines in generated files from breaking at the hyphen.
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4

To specify the page side of the file’s first page when the book is generated, choose a
setting from the Starting Page Side pop-up menu.
Choose
To
..........................................................................

5

Read from File

Use the file’s current first page side

Next Available
Side

Have FrameMaker set the first page side of a file based on
the last page in the previous file, which is useful when
you have two files that combine to make one chapter, or
when you have a two-sided document but chapters can
start on either side

Left or Right

Make sure the first page is always a left or a right page

To specify the file’s pagination, choose a setting from the Page Numbering
pop-up menu.
Choose
To
..........................................................................

6

Continue

Continue page numbering from the previous file in
the book

Restart at 1

Restart page numbering in this file

Read from File

Use the file’s current first page number

To specify the file’s autonumbering, choose a setting from the Paragraph Numbering
pop-up menu.
Choose
To
..........................................................................

7

Continue

Continue paragraph numbering from the previous file in
the book

Restart

Restart paragraph numbering in this file

Click Set.

You’ll see the changes when you generate and update files in the book.
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To include chapter numbers in headers or footers
You may want to number pages by chapter, such as 2-3 for page 3 of Chapter 2.
You can either type the chapter number directly in the header or footer of each
chapter or use a running header/footer variable for the chapter numbers. When
you use a variable, the numbers are updated automatically whenever you
update the book or rearrange its files.
The page numbers in document headers and footers are not affected by the
prefix or suffix specified with the Set Up File command.
1

Display the master page that contains the header or footer you want to contain the
chapter number.

2

Edit a Running H/F variable so that it refers to the autonumber of the paragraph with
the chapter title.

Use the <$paranum> or <$paranumonly> building block, and include the
tag of the chapter title in the variable definition. The variable definition might
look like this:
<$paranum[ChapterTitle]>
Use the Variable command on the Special menu to edit and insert the variable.
For details, see “To insert a variable in a running header or footer” on
page 12-18, “To change the definition of a system variable” on page 12-13, and
“To display the text, autonumber, or tag from a paragraph” on page 12-20.
3

Put the insertion point in the header or footer where you want to add the chapter
number and insert the Running H/F variable.

4

Type a hyphen.

5

Insert the Current Page # variable.

Use the Headers & Footers>Insert Page # command on the Format menu. For
details, see “To add page numbers and dates” on page 18-13.
The header or footer should look like this on a body page:

Running H/F variable for
the chapter number

2-3
Current Page # variable
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INSERTING CHAPTER NUMBERS IN MULTIFILE CHAPTERS

If you have separated a long chapter into several files, it’s possible that only the
first file contains the chapter number in the chapter title.
If a file that is part of the chapter does not have a chapter number, and you
want the chapter number to appear in its header or footer, insert the number in
a paragraph at the top of the first page by applying a paragraph format that
uses the autonumber series label used in the autonumbering properties for your
chapter. The paragraph format should use a nonincrementing counter. For more
information on autonumbering, see “To create a numbered list” on page 4-36.
If you don’t want the paragraph to appear in the document, draw a text frame
and connect it to the beginning of the main text flow. Make the text frame small
enough that it contains only the paragraph with the chapter number. Then set
the paragraph’s color to White. (If you should later join the separate files into a
single file, make sure you delete this text frame.) For instructions on drawing
text frames, see “To add a text frame” on page 13-26. For instructions on
connecting flows, see “To connect text frames” on page 20-10. For instructions
on setting a paragraph’s color, see “To choose a color” on page 4-9.

To include chapter numbers in cross-references
If your book’s pages are numbered by chapter (for example, 2-6), you probably
want cross-references to include the chapter number as part of the page
number—for example, see page 2-6.
■

Create a cross-reference format that includes the chapter number.

Use the same paragraph tag in the cross-reference format that you used in the
Running H/F variable (see “To include chapter numbers in headers or footers”
on page 24-15). The cross-reference format might look like this:
See page <$paranum[ChapterTitle]>-<$pagenum>.
To keep the chapter number on the same line as the page number, use a
nonbreaking hyphen (Meta-hyphen) in the cross-reference format.
For information on cross-reference formats, see “Creating a cross-reference
format” on page 10-10.
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To show the total page count of a book
You can show the total page count of a file or book along with the page
numbers—for example, 4 of 15 on page 4 of a 15-page document.
When you insert the page count in a file’s header or footer with the Page Count
variable, FrameMaker shows the number of pages in that file, not in the entire
book. If you want to show the number of pages in a book, you can make page
numbering continuous across files, put the page count in the last file’s header or
footer, and cross-reference it from the other files in the book.
1

Set up the files for continuous page numbering.

Use the Set Up File command on the File menu in the book window. For
information on setting continuous page numbering, see “To specify the
numbering properties” on page 24-13.
2

Insert the Page Count variable in the header or footer of the last file in the book.

Put the variable in an otherwise empty paragraph.

Page Count variable in a
separate paragraph

Use the Headers & Footers>Insert Page Count command on the Format menu.
For details, see “To add page numbers and dates” on page 18-13.
3

Create a new paragraph format for the paragraph with the page count.

Store the format in the Paragraph Catalog so that you can insert a crossreference to the paragraph. For information on creating formats, see “To create
a paragraph format” on page 5-11.
If you don’t want the page count to appear where you put it, either resize the
text frame so the page count is hidden or set the variable’s color to White.
4

In the other files in the book, insert cross-references to the paragraph with the
page count.

Put the cross-references in the header or footer of each file in the book,
including the last one. They should refer to the text of the paragraph with the
page count. For information on inserting cross-references, see “To insert a
paragraph cross-reference” on page 10-5.
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To create a master table of contents or index for several books
When you’re producing several related books, you may want to create a master
table of contents or index for the books.
1

Create a new book file that contains the files in all the books in the order you
want them.

For instructions, see “Setting up a book” on page 24-4. If you are adding files
that were generated in the original books, add them to the new book as
document files. For details, see “To add document files to a book” on page 24-7.
2

Add a table of contents, an index, or other generated file to the new book file.

Use the Add File command on the File menu in the book window. For details,
see page 24-8.
3

Specify how page numbers should appear in the generated file.

Use the Set Up File command on the File menu in the book window for each file
in the book. Make sure you set the Starting Page Side and Page Numbering
options to Read from File and the Paragraph Numbering option to Continue.
For details, see “To specify the numbering properties” on page 24-13.
You can use a different prefix or suffix for each book. For example, if you’re
creating a master index for a user manual and a reference manual, you could
use a U as the prefix for all files in the user manual and an R for all files in the
reference manual. You could also use capital Roman numerals for volume
numbers.
4

Generate the files.

Use the Generate/Update Book command on the File menu in the book window.
For details, see “Generating and updating,” next.

GENERATING AND UPDATING
After setting up a book and specifying page and paragraph numbering for each
file in the book, you generate and update the files. This is the last step in book
building.
When you generate and update, FrameMaker updates page and paragraph
numbering in all files in the book, updates text insets in the files, updates crossreferences so they are correct based on the new page and paragraph numbers,
and creates or updates generated files. You can change these settings after you
generate and update the book, but you must generate and update the book
again so that the changes take place.
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FrameMaker also adds empty pages where required to make sure that each file
begins where you specify. Extra pages may appear where you don’t want them if
you incorrectly specified the pagination for the files.
For example, if the first file ends on a right page and the second file has
Starting Page Side set to Right, FrameMaker adds an empty left page to the
first file. But if the Starting Page Side in the second file is set to Left, or to Next
Available Side, FrameMaker doesn’t add an empty page. For information on
setting pagination preferences, see “To specify the numbering properties” on
page 24-13.

To chang e the setup of files in a book
When you want to change the starting page side or the page or paragraph
numbering of any document or generated file in a book, you must change its
setup. These changes do not affect the document or file until you generate and
update the book. You can also change the setup of an existing generated file so
the next time the book is generated and updated, FrameMaker adds automatic
hypertext links to it or uses different paragraph tags or markers.
1

In the book window, select the name of the file you want to change.

2

Choose Set Up File from the File menu in the book window.

3

Make the changes in the Set Up dialog box.

The available options are different depending on whether you are changing a
generated file or a document file.
Specify pagination and autonumbering for the file. For more information on
these options, see “To specify the numbering properties” on page 24-13.
To include automatically generated hypertext links in a generated file, turn on
Create Hypertext Links. FrameMaker automatically creates hypertext links for
each item in the Include scroll list the next time the book is generated and
updated.
4

Click Set.

The changes you just made appear in the document or file the next time you
generate the file.
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To generate and update files in a book
You should generate and update a book when you make any of a number of
changes to a document file or a book file. For a list of these changes, see “When
to generate and update” on page 24-20. When you generate and update a book,
FrameMaker updates the pagination, autonumbering, text insets, and crossreferences in all the documents in the book file. You can change the pagination
or autonumbering of any document in a book, add automatically created
hypertext links to an existing file, or change the paragraph tags and marker
types a generated file uses at any time. However, you do not see the effects of
the changes until you generate and update the book. For more information, see
“To change the setup of files in a book” on page 24-19.
1

Choose Generate/Update from the File menu in the book window.

WHEN TO GENERATE AND UPDATE
Generate and update files in a book whenever you
do the following:

pagination to change, it can affect the pagination
of documents that follow.

• Set up a new book

• Add a new color to a file in a book

The names of generated files appear in the book
window after you set it up, but the actual files do
not exist until you generate and update.

If you print process color separations, you won’t be
able to print the new color until you generate and
update.

• Add a generated file to an existing book using
Add File

• Add a new paragraph tag to a file in a book

• Rearrange or remove files in a book
• Change the setup information of a document or
generated file using the Set Up File command
• Edit a document file so that other files in the
book are no longer current
If you change a chapter title, for example, your
table of contents is no longer accurate. Or if you
edit some text and cause the document’s
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For example, if you set up a table of contents, you
won’t be able to include the paragraph tag until
you generate and update.
• Change the conditional text settings or
overrides in a document file
• Change formatting information in the special
flow on a reference page of a generated file
If you edit a special flow, the changes do not appear
in the generated file until you generate it again.
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In the Generate/Update Book dialog box, move the names of the files you want to
generate to the Generate scroll list.

Only generated files appear
in the list.

To move a filename between scroll lists, select the filename and click an arrow,
or double-click the filename. To move all filenames from one scroll list to the
other, Shift-click an arrow.
If the book contains several generated files, you can generate them all at
once. If you want to update the pagination, autonumbering, text insets, and
cross-references without generating any files, move all the filenames to the
Don’t Generate list.
3

Click Update.

If a file is open, FrameMaker updates it only in your computer’s memory and
not on the disk. You need to save the file to keep the changes. If a file isn’t open,
FrameMaker changes it on the disk.
Messages occasionally appear in the book window’s status bar when you
generate and update files in a book. These messages describe problems with
cross-references, conditional text settings, and print separation settings in the
book’s files. For a list of the messages, see “Messages when generating and
updating” on page 24-22.
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IF FRAMEMAKER DOESN’T GENERATE A FILE

If you don’t get a generated file that you expected, make sure the name of the
generated file has a plus sign (+) after it in the book window. If it does not have
one, FrameMaker considers the file a document and won’t generate it.
This happens when you add the file as a document file rather than as a
generated file when you set up the book. To solve the problem, delete the file
from the book window and then add it again as a generated file. For
instructions, see “To add a generated file to a book” on page 24-8.

MESSAGES WHEN GENERATING AND UPDATING
While generating and updating files, FrameMaker
may display messages in the book window’s status
bar or in an alert box. These messages let you
know the status of the generating and updating
process, alert you to any problems, and name the
first file in which the problem was found. (Later
files may have similar problems.)
The file indicated contains
unresolved cross-references. For information on
fixing unresolved cross-references, see “To update
cross-references manually” on page 10-19.

Unresolved Cross-Refs

Conditional text
settings differ from file to file in the book.

Inconsistent Show/Hide Settings

You can fix the settings in one file at a time, using
Conditional Text on the Special menu. See “To
change a tag’s condition indicators” on page 26-8.
But you’ll probably find it easier to fix the settings
throughout the book at once. To do this, update the
settings with the Import>Formats command on the
File menu. For more information, see “To update
the format of files” on page 24-26.
The file indicated
contains color separation settings that differ from
Inconsistent Color Settings
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settings for other files in the book, or the indicated
file has a color defined differently in other files in
the book. For information on color settings, see “To
print color separations” on page 17-18. For
information on creating and naming colors, see “To
create a new color” on page 17-6.
Couldn’t Open File FrameMaker encountered a
problem opening the file. For example, the file may
be in the wrong format, it may have been saved
with an earlier version of FrameMaker, or it may
use unavailable fonts. For more information on the
problem, open the file.

The contents of generated
files, the page count, or cross-references changed
while generating and updating files in the book.
FrameMaker tried to update the files again, but
the contents continued to change. For example, if a
book contains both a list of markers and an
alphabetical list of markers, and if both contain
hypertext links, the number of markers grows each
time the files are generated. If this happens, move
one of the generated lists out of the Include scroll
list when you use the Generate/Update command
again.

Book Not Self-Consistent
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IMPROVING PERFORMANCE

To generate and update files faster, open as many of the files in the book as
possible before you use the Generate/Update command. After using the
command, save all the files in the book and the book file. This makes generating
and updating faster the next time. (If you don’t have saved copies of these files,
FrameMaker may need to scan them twice for operations such as calculating
page count and updating page numbers.)

To add or delete empty pages
After you generate a book, you may find that you didn’t set up your documents’
pagination properly, and you may need to add or delete an extra page so that
each file in the book starts on the side (left or right) you want. Every file in a
book has its own setting that tells FrameMaker whether to add or delete a page
before saving or printing the document. (For information on this setting, see
“Determining how pages are numbered” on page 18-14.) If, when the book is
generated, the setting causes FrameMaker to add or delete a page in a
document, then the next document in the book may start on the wrong side. You
can make sure the pagination in a book is correct by changing a document’s
setup through the book file. Changing the setting in the book file overrides the
individual document’s setup.
1

In the book window, select the filename right after the file with the extra page.

For example, if the first chapter contains an extra page, select the second
chapter.
2

Choose Set Up File from the File menu in the book window.

3

In the Set Up File dialog box, change the setting in the Starting Page Side
pop-up menu.

Change the setting to Left or Right as appropriate, or change it to Next
Available Side. For details, see “To specify the numbering properties” on
page 24-13.
4

Save the book file.
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WORKING WITH FILES IN A BOOK WINDOW
You can use a book window to open, save, print, and close individual files in a
book. You can also open, save, and close all the files in a book and print and
update the format of several files or all the files.

To open files
You can use the book window to open a single file or all the files in a book
at once.
■

To open one file in a book, double-click its filename in the book window.

You can also select the file in the book window and press Return. You can use
the Open command on the File menu in the book window to open any file,
whether or not it’s in the book.
■

To open all files in a book, hold down Shift and choose Open All Files in Book from the
File menu in the book window.
IMPROVING PERFORMANCE

You can open files more quickly with the Open All Files in Book command if you
first suspend the automatic updating of text insets and cross-references. To do
so, choose Suppress Automatic Reference Updating from the Edit menu in the
book window. In the Suppress Automatic Reference Updating dialog box, turn
on the checkbox and click Set. This suppresses automatic updating, but only
when you use the Open All Files in Book command. When you open an
individual document that has automatic update settings on, text insets and
cross-references still update.

To print files
You can print one or more files from a book window. The normal printing
options are available, except for thumbnails and print range; FrameMaker
always prints the entire file when you print a file from a book.
To make sure your page numbering, cross-references, text insets, and generated
files are up to date, generate and update the book before you print files from it.
1

Choose Print from the File menu in the book window.

2

In the Print Book Files dialog box, move the names of files you want to print to the Print
scroll list.

To move a filename between scroll lists, select the filename and click an arrow,
or double-click the filename. To move all filenames from one scroll list to the
other, Shift-click an arrow.
3
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Specify printing options in the Print dialog box.

Make sure these numbers
match the size of paper in
the printer.

Type the number of copies
to print and the name of the
printer.

You can create a PostScript print file by typing a filename in the Print Only to
File text box. Be aware that a PostScript file for a big book can be quite large.
You can create a separate PostScript file for each file in the book by typing an
asterisk (*) for the PostScript filename in the Print Only to File text box.
For information on the other options in the dialog box, see “To customize
printing” on page 2-39.
5

Click Print.

To stop printing, press Control-c.
PRINTING SPECIFIC PAGES IN A FILE

You can print specific pages in a file as you normally do—open the file, choose
Print from the File menu, type the start and end page numbers in the Print
dialog box, and click Print.
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To update the format of files
If you want to change the page design, paragraph formats, or other formats in a
chapter, you can make the changes in one file and then update all the chapters
in the book at once. You can update files more quickly if you open as many of the
files in the book as possible before using the Import>Formats command.
1

Open the file with the formats you want to use.

The file must be named and saved.
2

In the book window, choose Import>Formats from the File menu.

3

Specify the file with the formats and the files you want to update.

Choose the file with the
formats you want to use.

Move the files you want to
update into the Update
scroll list.

The Import from Document pop-up menu lists all open, saved documents.
To move a filename between scroll lists, select the filename and click an arrow,
or double-click the filename. To move all filenames from one scroll list to the
other, Shift-click an arrow.
4

Turn on the Import and Update settings you want to apply to the files.

For information on these settings, see “Import and update settings” on
page 21-14.
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To remove format overrides, turn on While Updating, Remove settings.

If you turn on Manual Page Breaks, FrameMaker removes page breaks that are
not part of a paragraph’s format definition.
If you turn on Other Format/Layout Overrides, FrameMaker removes
paragraph, character, page layout, and table formatting overrides.
6

Click Import.

If a file is open, FrameMaker updates it only in your computer’s memory and
not on the disk. You need to save the file to keep the changes. If a file isn’t open,
FrameMaker changes it on the disk.

To save or close all files
You can save or close one document in a book file just as you do with any other
file—by using the Save or Close command on the document’s File menu. But
you can also save or close all open files in a book at once.
■

To save all files in a book, hold down Shift and choose Save All Files in Book from the
File menu in the book window.

FrameMaker saves the book file and all open files in the book that have
changed.
■

To close all files in a book, hold down Shift and choose Close All Files in Book from the
File menu in the book window.

FrameMaker closes the book file and all open files in the book.

To close a book file
Close a book file when you finish using it.
■

To close the current book file, choose Close from File menu in the book window.

If changes made to the book haven’t been saved, FrameMaker asks whether you
want to save the changes or cancel closing the book.

COMPARING BOOKS
You may want to keep different versions of a book as you work on the book or as
you prepare it for production. FrameMaker can compare two versions of a book
to show you what has changed in the newer version. It looks not only at the text
in the two versions, but also at footnotes, markers, anchored frames, text insets,
variables, and cross-references.
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To compare two versions of a book
When you compare two versions of a book, FrameMaker creates two documents
that explain the results—a composite document that lets you see the
differences side by side and a summary report of the differences. FrameMaker
compares only the documents whose filenames match between the two books.
For more information on how FrameMaker compares documents, see
“Comparing document versions” on page 25-9.
1

Open both versions of the book file.

2

In the newer version, choose Utilities>Compare Books from the File menu in the book
window.

3

Choose the older version and which documents you want FrameMaker to create.

Choose the older version
you want to compare to the
newer version.

Choose which documents
you want to create.

The Older Book pop-up menu lists all open, named book files.
4

Click Options and set up the comparison options in the Comparison Options
dialog box.

For information on the options in this dialog box, see “To compare two versions
of a document” on page 25-10.
5

Click Compare.

When the comparison is complete, FrameMaker displays the summary and
composite documents. The summary document, named newerbookSummary,
lists differences in setup information. Composite documents, named
filenameCMP, describe the differences in each file. The documents are all
placed in the newer book’s directory. If files with these names already exist,
FrameMaker does not overwrite them, but saves the older files, adding the
extension .backup to their names.
If there are no differences between the two versions, FrameMaker displays an
alert and does not create any new documents.
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When you revise a document, FrameMaker helps you keep track of the
revisions. You can add change bars, create revision pages, and compare
two versions.

Change bars flag document revisions
When you revise a document, you may want to keep track of changes for
yourself or for your readers. Change bars are an effective way of
identifying new or changed material.
A change bar visually
identifies new or revised text.

You can have change bars appear automatically when you edit text, or
you can insert change bars in specific locations. Later, you can remove
all change bars in the document or you can selectively remove
individual change bars.

Revision pages preserve existing pagination
You can use revision pages to replace existing pages, or you can insert
them between existing pages. Then you can print and distribute only
the revised pages. Later, you can repaginate the document to once again
number the pages consecutively.

You can compare the revision with the original
If you receive a revised document with changes that have not been
flagged by change bars or revision pages, or if you want more specific
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information on the changes, you can compare the new version to the old
version.
FrameMaker creates a composite document and a summary document
when you compare two versions of a document.
New
version

The Long Book

The Short Long Book

Old
version

Deleted: Short
Inserted: Long

The Short Book
Composite document

Summary document

The composite document is a conditional document that combines both
versions to allow you to see the changes side by side. The summary
document contains a general summary and a revision list for each type
of item being compared.

In this chapter
This chapter shows you how to use change bars and revision pages to
indicate document changes and how to compare a revision with the
original.
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MARKING REVISIONS WITH CHANGE BARS
A change bar is a vertical line (usually in the margin) that visually identifies
new or revised text. You can have change bars appear automatically whenever
you insert, change, or delete text, or you can select the specific text that you
want marked with change bars. If you want all changes marked, you should let
FrameMaker automatically insert the change bars. However, if you want only
occasional changes marked, it is probably easier to mark the text yourself.
Later you may want to remove the change bars from text. For example, between
drafts of a manual you’ll want to erase the old change bars before adding new
ones. Or you can also remove individual change bars.
When you add change bars to text, you change the paragraph’s format so that it
no longer matches the Paragraph Catalog format with the same tag. If you later
update the document with the paragraph formats from another document and
you remove format overrides, the change bars are removed.
If you have two versions of a document, you can insert change bars in the newer
version by comparing the versions. For information on adding change bars this
way, see “Adding only change bars” on page 25-13.

To add change bars automatically
If it’s important that every change you make to a document be flagged, you can
have FrameMaker add change bars automatically. For example, if a document’s
revisions will be incorporated into translated versions, it’s important that the
language translators see where even the smallest changes occur.
1

Choose Document>Change Bars from the Format menu.

2

Specify the distance from the column of text to the change bars and the thickness of
the bars.

Type the distance here.
Type the thickness here.
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3

Choose the position of the change bars from the Position pop-up menu.

The position is relative to the edges of the column that contains the changed
text, regardless of whether it’s a single- or multicolumn page.

Left side

Right side

Side closer to
page edge

Side farther from
page edge

4

Choose a color for the change bars from the Color pop-up menu.

5

Turn on Automatic Change Bars and click Set.
POSITIONING CHANGE BARS

On a two-column page, you probably wouldn’t choose the side farther from the
page edge because that would put the change bar next to the other column. On
a single-column page, you could choose nearer or farther, but you would
probably choose farther to put the change bar in the wider margin.

To add change bars to selected text
At times, you may want to flag only the most important changes to your
document rather than flag every change. For example, if you’re sending out the
second revision of a document for review, you may not want to call the
reviewers’ attention to every added comma or reorganized sentence. Instead,
you probably want them to focus on substantive changes.
For these situations, you can select specific text to mark with change bars
rather than add them automatically.
1

Select the text you want to mark.

2

Choose Characters>Designer from the Format menu.

3

Turn on the Change Bar property in the Character Designer and click Apply.

The change bar will appear next to only the lines you select.
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ADDING CHANGE BARS TO ENTIRE PARAGRAPHS

If you want to display a change bar next to one or more entire paragraphs,
regardless of how much text in the paragraphs has actually changed, click in a
paragraph or select several paragraphs. Then choose Paragraphs>Designer
from the Format menu. In the Paragraph Designer, turn on Change Bar in the
Default Font properties and click Apply.

To create a character format that adds change bars
Another way to selectively apply change bars to text is to create a character
format that adds change bars. Creating a character format is probably the
easiest way to selectively apply change bars; once you create a character
format, you simply select the text and apply the character format to it. Using a
character format also allows you to retain change bars when you update your
document with new paragraph formats and remove format overrides.
1

Click in any paragraph and choose Characters>Designer from the Format menu.

2

In the Character Designer, choose Set Window to As Is from the Commands
pop-up menu.

3

Turn on Change Bar.

4

Choose New Format from the Commands pop-up menu.

5

In the New Format dialog box, type a tag name and turn on Store in Catalog.

6

Click Create.

To remove change bars
Regardless of how you added change bars to your document, you can remove
them all at once or selectively. For example, if you change your mind about a
revised paragraph and restore the original, you save your reviewers confusion if
you remove the change bar next to the paragraph.
■

To clear all change bars from a document, use the Document>Change Bars
command on the Format menu.

In the Change Bars dialog box, turn on Clear All Change Bars and click Set.
■

To remove several change bars, use the Character Designer.

Choose Characters>Designer from the Format menu. For each change bar you
want to remove, select the text with the change bar, turn off Change Bar, and
click Apply.
■

To remove a single change bar, select the text and press Esc c h.

This technique is especially useful during revision, when you change a passage
and then change it back to its original state.
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To remove a change bar applied by a character format, select the text and apply the
Default ¶ Font from the Character Catalog.

This removes the change bar character format.
REMOVING A CHARACTER TAG

If you’ve marked text as changed by applying a character format that displays a
change bar, you can remove the change bar in any of the ways described above.
However, the only way to remove the tag from the text is to select the text and
apply the Default ¶ Font from the Character Catalog.
SEARCHING FOR CHANGED TEXT

The Find/Change command is useful for searching for text with a particular
character format or tag. For example, you can search for all text with the tag
you’ve used to apply change bars and replace it with a different character
format. For information on using the Find/Change command, see Chapter 8,
“Searching.”

CREATING REVISION PAGES
When you add or delete parts of a document, the page numbers of existing text
and graphics may change. Rather than change the pagination of existing
material, you may want to issue revision pages. A revision page inserted
between existing pages is called a point page because FrameMaker appends a
period (or “point”) and a number or letter to the previous page number.

1–2.a
1–1

1–2.b

1–2

1–3

1–4

The page numbers of point
pages are based on the
number of the main page
before them.

You can create revision pages only in a document with a single text flow and no
body page overrides of master page layouts.
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To freeze pagination
If you intend to use revision pages in a document, freeze the pagination before
revising the document. When you add text or graphics, FrameMaker inserts
revision pages for the new material; when you delete text or graphics,
FrameMaker does not repaginate the existing pages.
1

Press Esc p z to display the Freeze Pagination dialog box.

2

Choose a numbering style for point pages from the Point Page # Style pop-up menu.
Choose
For numbering that looks like this
..........................................................................

3

Numeric

2.3

roman

2.iii

ROMAN

2.III

alphabetic

2.c

ALPHABETIC

2.C

Click Freeze.
CHANGING THE NUMBERING STYLE

Later, if you want to change the numbering style without unfreezing the
document, you can press Esc p z to display the Unfreeze Pagination dialog box.
Choose a different numbering style and then click Set Page # Style.
FrameMaker immediately changes the point page numbering style throughout
the document.
DOCUMENTS WITH MULTIPAGE TABLES OR FLOATING
ANCHORED FRAMES

If a document contains multipage tables or anchored frames with Floating on,
freezing pagination may produce undesirable results. Check the document’s
page numbering carefully after freezing the pagination.
PARAGRAPHS THAT BREAK BETWEEN PAGES

If a document contains paragraphs that break between pages, freezing
pagination may produce undesirable results. The portion of a paragraph that
occurs on a revision page becomes its own separate paragraph or page. When
you unfreeze the pagination, FrameMaker can’t merge the portion with its
previous paragraph.
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To unfreeze pagination
After printing your revision pages, you can repaginate the document so that it
once again numbers all pages consecutively.
1

Press Esc p z to display the Unfreeze Pagination dialog box.

2

Click Unfreeze.

To avoid having empty pages after the last repaginated page, choose
Delete Empty Pages in the Numbering dialog box. For more information, see
“To add or delete empty pages at the end of a document” on page 18-15.

COMPARING DOCUMENT VERSIONS
When you compare two versions of a document, FrameMaker creates two
documents that explain the results—a composite document that lets you see the
differences side by side and a summary report of the differences.
The composite document is a conditional document. You choose the condition
tag you want to apply to changed text, and you specify whether FrameMaker
should flag changes with change bars. In the composite document, differences
are considered to be insertions or deletions. For information on conditional
documents, see Chapter 26, “Conditional Documents.”
The summary document contains a general summary and a revision list for
each type of item being compared. You can create the summary document as a
hypertext document, with links to the actual pages where the changes occurred.
By creating a hypertext summary document, you can quickly display changed
pages for reading or editing. In the summary document, differences are
considered to be insertions, deletions, or changes.
For information on how these documents are organized, see “Reading the
composite and summary documents” on page 25-14. For information on
comparing book versions, see “Comparing books” on page 24-27.
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To compare two versions of a document
This section explains how to compare two versions of a document in general
terms. Subsequent sections describe how to set up the comparison options for
handling inserted and deleted text, adding change bars, and generating a
hypertext summary document.
When FrameMaker compares the content of documents it also compares
formats that affect content—variables and cross-references.
1

Open both versions of the document.

If the documents contain conditional text, all conditions must be visible.
2

In the newer version, choose Utilities>Compare Documents from the File menu.

3

Choose the older version and the documents you want FrameMaker to create.

Choose the older version
you want to compare to
the newer version.

Choose which documents
you want to create.
Click here to set up
comparison options.

All open, named documents (except the current document) are listed in the
Older Document pop-up menu.
4

Click Options and set up the comparison options in the Comparison Options
dialog box.

For information on the options in the dialog box, see “To handle inserted and
deleted text in the composite document” on page 25-11, “To insert change bars
in the composite document” on page 25-13, and “To create a hypertext summary
document” on page 25-13.
5

Click Compare.

When the comparison is complete, FrameMaker displays the summary and
composite documents. If there are no differences between the two versions,
neither document is created.
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For information on the form and content of composite and summary documents,
including a complete list of the items compared in them, see “Reading the
composite and summary documents” on page 25-14.
COMPARING DOCUMENTS THAT CONTAIN CONDITIONAL TEXT

When you want to compare the full texts of two documents that contain
conditional text, you simply show all conditions before performing the
comparison. However, when you want to exclude some conditions from the
comparison, you need to save copies of both documents, show the tags of the
conditions you want to compare, and delete the rest of the tags. Simply hiding
these conditions saves you the step of copying the documents, but it gives you
unexpected results.
When you want to compare the different conditions in a single document, save
two copies of the document, show different tags in the two documents, and, in
both, delete tags for all the conditions you don’t show. For information, see
Chapter 26, “Conditional Documents.”
COMPOSITE AND SUMMARY DOCUMENT FILENAMES

The composite document has the same name as the newer version with CMP
appended to the end. For example, if the newer version is named Report3,
FrameMaker names the composite document Report3CMP.doc.
The summary document is named Summary.doc. If you create multiple
summary documents, unlock the file by pressing Esc F l (lowercase L) k and use
the Save As command to give the documents unique names.
COMPARING DOCUMENTS WITH MULTIPLE FLOWS

You can compare documents with multiple flows. However, to prevent
FrameMaker from comparing the wrong flows, make sure each flow has a
unique tag and that the flows to compare have the same flow tag. For
information on changing a flow tag, see “To change a flow tag” on page 20-9.

To handle inserted and deleted text in the composite document
In the composite document, all changes are considered insertions or deletions.
You can choose how you want the composite document to indicate inserted and
deleted text by using the Comparison Options dialog box. When the composite
document is displayed, conditional text is visible and the condition indicators
are on.
For information on displaying the Comparison Options dialog box, see “To
compare two versions of a document” on page 25-10.
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■

To mark inserted text, choose one of the Mark Insertions With settings in the top half of
the Comparison Options dialog box.

Click here to apply the
Inserted condition tag.
Or type the name of a
different condition tag here.
Or click here if you don’t
want to mark inserted text.

The preset condition indicators for the Inserted condition tag are green and
underline.
Click Set when you’re ready to return to the Compare Documents dialog box.
■

To mark deleted text, choose one of the Mark Deletions With settings in the bottom
half of the Comparison Options dialog box.

Click here to apply the
Deleted condition tag.
Or type the name of a
different condition tag here.
Or type text to insert in
place of deleted text.

The preset condition indicators for the Deleted condition tag are red and
strikethrough.
You can specify any text to substitute for deleted text. For example, you can
substitute Confidential everywhere that text has been deleted.
Click Set when you’re ready to return to the Compare Documents dialog box.
■
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To insert change bars in the composite document
When you want to call attention to changes in the composite document, you can
mark them with change bars.
■

In the Comparison Options dialog box, turn on Mark Changes with Change Bars.

FrameMaker uses the current settings in the Change Bars dialog box. For
details, see “To add change bars automatically” on page 25-4.
For information on displaying the Comparison Options dialog box, see “To
compare two versions of a document” on page 25-10.
ADDING ONLY CHANGE BARS

When all you want to do is add change bars to a newer version of a document,
turn on Mark Changes with Change Bars in the Comparison Options dialog
box, click Nothing in the Mark Insertions With area, and click Replacement
Text in the Mark Deletions With area. Leave the Replacement text box empty.
The composite document will be a copy of the newer version with change bars
marking all changes.

To create a hypertext summary document
If you’re going to use the summary document to help you work in the source
documents, you may want to generate the summary as a hypertext document.
When you do so, the page numbers in the summary document become active
areas, with hypertext links to the newer version, the older version, and the
composite document. When you click the page number of an indicated change,
FrameMaker displays the page in the source document that contains that
change.

Page Numbers
Composite Newer

Older Change

1
3

1
3

1
3

4

4

4

Inserted:
Inserted:
Inserted:

Text
“Record set ”
“Expanded data...”
“Conclusions...”

3
Expanded data

Summary document
Newer version

■

In the Comparison Options dialog box, turn on Create Hypertext Links in Summary.

In the summary document, click on the page number of the page to display.
For information on displaying the Comparison Options dialog box, see “To
compare two versions of a document” on page 25-10.
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USING HYPERTEXT DOCUMENTS

For information on hypertext documents, see Chapter 27, “Hypertext and ViewOnly Documents.” For information on generating hypertext lists and
documents, especially note the section “Adding hypertext links to generated
files” on page 27-27.
COMPOSITE DOCUMENT

In the composite document, FrameMaker considers all changes to be insertions
or deletions. For example, if the contents of a graphic frame have changed, both
versions appear in the composite: the older version is marked as deleted; the

READING THE COMPOSITE AND SUMMARY DOCUMENTS
The composite document starts out as a copy of the newer version. As the newer version is compared to the
old version, inserted text is flagged and text that was deleted is pasted in and flagged. The summary
document begins with a general summary and then contains a revision list for each type of item compared
(flows, text, variables, and so on).

The Inserted
condition tag
has been
applied to
inserted text.

The summary
shows the
modification
dates and the
total number
of changes.

The Deleted
condition tag
has been
applied to
deleted text.

Revision lists
show the page
numbers, the
type of
difference,
and the actual
change.

Summary document

Composite document
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newer version is marked as inserted. Variables in the composite document use
the newer definitions; however, they aren’t marked as changed. Only inserted
and deleted variables are considered changes.
SUMMARY DOCUMENT

In the summary document, differences are considered insertions, deletions, or
changes. If an item has moved, it’s marked as deleted and inserted. Regardless
of the change, FrameMaker displays the number of the page on which the
change occurs in the composite document, the newer document, and the older
document. For insertions, the page number given for the older version is the
page where the item would be inserted to match the newer version. For
deletions, the page number for the newer version is the page where the item
would have appeared if it hadn’t been deleted.
If your document contains duplicate markers, the first occurrence of the marker
is listed in the summary document. You can find the other occurrences in the
document by using the Find/Change command.
ITEMS COMPARED

When comparing two versions of a document, FrameMaker checks the contents
of flows with the same names on body and reference pages. When checking
these flows, it looks at inserted and deleted text, footnotes, anchored frames,
tables, variables and their definitions, cross-reference formats and references,
footnote text, and marker types and text.
When comparing anchored frames, FrameMaker compares the objects in the
frame. If the objects in the frame are different, or if they are in different
positions, FrameMaker marks the entire anchored frame as changed. For
example, when you change the order of objects in the frame—by using the Front
or Back command—FrameMaker considers the anchored frame changed.
When comparing text insets, FrameMaker compares the modification date, the
filename, the relative pathnames of text insets, and the way the inset was
imported (for example, if the lines were merged into paragraphs, each line was
imported as a paragraph, or if the text was converted to a table). If any of these
are different, FrameMaker marks the entire text inset as changed.
When comparing graphic insets and imported graphics, FrameMaker compares
the contents and dpi of the inset or imported graphic. For example,
FrameMaker checks whether the object has been flipped, inverted, or rotated. It
also compares the size of the bounding box. When comparing imported
graphics, FrameMaker compares how the graphic was imported—by reference
or by copying. If the graphic was imported by reference, FrameMaker compares
the relative pathnames. If any of these are different, FrameMaker marks as
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changed the line that contains the anchored frame of the graphic inset or the
imported graphic.
When comparing equations, FrameMaker compares the size of the equation, the
location of the equation within its graphic frame, and the math expressions. If
there are differences in any of these areas, FrameMaker marks the entire
equation as changed.
When comparing tables, FrameMaker checks the number of rows and columns,
whether cells are straddled, and whether cells are rotated. If any of these are
different, FrameMaker marks the entire table as changed. If text in cells has
changed, only the new table appears in the composite document and
FrameMaker marks as changed the line that contains the table’s anchored
frame. If more than 75 percent of the cells have changed, FrameMaker marks
the entire table as changed.
ITEMS NOT COMPARED

FrameMaker doesn’t compare master page flows (including header and footer
flows) or untagged flows; graphic objects or text lines not in anchored frames;
anchored frame positions; footnote properties or numbers; paragraph,
character, or table tags; text or table formatting; tags in the Paragraph Catalog,
Character Catalog, or Table Catalog; or the contents of text insets. Because
FrameMaker doesn’t check the formatting of text or tables, FrameMaker won’t
notice different ruling or shading in a table or a different color assigned to text.

25-16

Using FrameMaker

26

CONDITIONAL DOCUMENTS

Maintaining multiple versions in one document

.....

..................................

PLANNING A CONDITIONAL
DOCUMENT 26-4

To think through the project 26-4
To plan ahead for other users 26-5
To implement the plan 26-6
CREATING CONDITION TAGS 26-6

To create a condition tag 26-7
To change a tag’s condition indicators 26-8
To delete a condition tag 26-8
USING CONDITION TAGS 26-9

To apply or change a condition tag 26-10
To copy and paste condition tag settings 26-13
To create nonprinting comments 26-13
To remove a condition tag from text 26-14
WORKING IN A CONDITIONAL
DOCUMENT 26-15

To change the view of a conditional document 26-16
To edit conditional text 26-17
To find conditional text 26-18
To use variables 26-19
To print a conditional document 26-20

Using FrameMaker

26-1

26

CONDITIONAL DOCUMENTS

.....

...................................

If you’re preparing several versions of a document, each with minor
differences, you can use one FrameMaker document for all the versions.
You create multiple versions of the same document by using conditional
text. You can also use conditional graphics.

Conditional text for each version
Conditional text is specific to one version of a document. Unconditional
text is common to all versions. You can use conditional text to produce
separate documents for similar products, for example, or to include
comments, which can be hidden before you print the final copy.

Two versions of a sales
brochure

ModuLINE CEO
Low-Back Executive Seat
Model 225K/YR
■

Covering options include Corinthian leather
in 5 textures and tones, or natural cotton
and wool coverings in over 20 colors, all with
stain-proof and tear-proof linings

■

Backed by ModuLINE’s lifetime guarantee

ModuLINE Manager
Low-Back Office Seat
Model 186P

Some of the material is the
same in both versions; this is
the unconditional text.
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Covering options include natural cotton and
wool coverings in 8 hues, all with stain-proof
and tear-proof linings

■

Backed by ModuLINE’s lifetime guarantee

Art can also be
conditional.
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You can make any unit of text conditional, from one character to entire
sections. Graphics, tables, cross-references, footnotes, markers, and
table rows can be conditional.

Conditional text is easy to see
Using condition indicators, you can change the appearance of
conditional text to make it easy to identify.
Condition indicators
(underline and strikethrough)
identify two conditions.

■

Covering options include Corinthian
leather in 5 textures and tones, or natural
cotton and wool coverings in over 20
colors, 8 hues, all with stain-proof and tearproof linings

FrameMaker gives you many choices for viewing and printing
conditional text. You can view all versions of a document at the same
time, show all condition indicators, turn off the condition indicators, or
hide selected versions of the document. Whatever you display is what
appears in the printed document.

You can add comments you don’t want to print
As you work on a document, you may want to write notes to yourself or
to your reviewers. You may want to include these comments in early
drafts but not in the final printed draft. You can manage such a
situation by using conditional text for your comments.

You can merge separate versions
If you already have two versions of a document, you can merge them
into one conditional document for future editing. When you merge two
versions, FrameMaker compares the versions and creates a composite
conditional document.

In this chapter
This chapter shows you how to plan and work in a conditional
document. It also provides information on creating and using
conditional tags. For information on merging and comparing
documents, see Chapter 25, “Revision Management.”
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PLANNING A CONDITIONAL DOCUMENT
When planning a conditional document, you should examine the nature of the
material and, because others may have to work in or maintain a conditional
document you create, look at how different people can take turns working with
it. Plan to treat conditional material consistently to make the document easier
to use and maintain. Others will need to know the conventions you followed as
you applied condition tags. The guidelines that follow will help you plan a
conditional document and make sure it conforms to your plan.

To think t hrough the project
■

Define what the finished versions of your document should look like.

For example, if you are creating a manual that describes a program that runs
on both UNIX and Windows platforms, you might want to be able to produce at
least two versions: a UNIX version and a Windows version. If you want to
produce these versions with editorial comments sprinkled in the text during the
review process, you will want even more versions: UNIX with comments, UNIX
without comments, Windows with comments, and Windows without comments.
■

Decide how many condition tags are necessary to achieve the desired versions.

A version of a document is defined by a unique set of condition tags. For
example, a version of a finished UNIX manual might be defined by having a
UNIX condition tag showing, a Windows condition tag hidden, and a Comments
condition tag hidden.
■

Evaluate the extent to which the document can be conditional and how you can
organize the material to simplify development and maintenance.

For example, you might be able to organize a book so it has some chapters that
are conditional, some that are the same for all versions, and some that are
different for each version.
■

Identify the items you can handle with variables instead of conditional text.

Words and phrases—for example, product and company names—are easier to
work with as variables.
■

Determine the smallest unit of conditional text.

For example, if a conditional document will be translated, a whole sentence
should be the smallest amount of text you make conditional. Because word
order often changes during translation, using conditional text for part of a
sentence could complicate translation.
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■

Decide whether to make spaces and punctuation conditional.

If conditional text begins or ends with punctuation, make the punctuation
conditional too. This makes the text easier to read when you’re viewing more
than one version.
To avoid word spacing problems, such as having an unconditional space
followed by a conditional space, set standards for handling spaces following
conditional text (either always conditional or always unconditional).

■

Covering options include Corinthian
leather in 5 textures and tones, or natural
cotton and wool coverings in over 20
colors, 8 hues, all with stain-proof and tearproof linings

The punctuation and
spaces after conditional
words are also conditional.

To plan ahead for other users
■

If a conditional document has several authors, plan document structure and
work flow.

Break a document into several small files so several people can work on
different parts of the document at the same time.
■

Decide how you will provide explanatory notes to other authors.

To help explain a conditional document, add comments where you think they’d
be helpful and apply the predefined Comment condition tag to them. (Or, if you
plan to use the Comment tag for something else, create a new condition, give it
a name such as Explanation, and apply the new condition tag to your
comments.)
■

For conditional text that will appear side by side, decide which condition tags to put
first and use this order throughout the document.

The order can help distinguish tags that make up a version. It will also help
subsequent authors maintain the document.
For example, text in the CEO
condition always appears
before text in the Manager
condition.

ModuLINE CEOManager
Low-Back Executive Office Seat
Model 25K/YR186P
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To implement the plan
■

Use a text frame rather than a text line for the text you want to make conditional.

Text lines cannot be made conditional.
■

If the document will contain graphics imported by reference into a conditional
anchored frame, create separate locations for the graphics in each version.

This simplifies file management when you need to copy or archive a version of
the document with its graphics files.
■

If a document will contain conditional graphics, create a separate anchored frame
for each version.

■

Insert index markers in the appropriate conditional or unconditional text.

By careful placement of index markers, you can create conditional indexes. An
index marker in conditional text will appear in the generated index only in a
version that defines that condition tag as showing.
■

When inserting cross-references in conditional text, make sure both the reference and
the source of the cross-reference have the same condition tag.

Otherwise, the cross-reference marker and the source marker may not appear
in the document at the same time.
When FrameMaker updates cross-references, it considers only the markers that
are showing. If conditional text is hidden, FrameMaker will not find a marker
in it, and the cross-references may be unresolved.

CREATING CONDITION TAGS
Condition tags make up a version of a document. In the product brochure
example at the beginning of this chapter, there are two condition tags—CEO
and Manager. You can also create a condition tag for comments that you don’t
want to show when the document is printed.
Each condition tag has condition indicators that can help you easily see your
conditional text. You can change a condition tag’s indicators at any time, or you
can delete the tag altogether.
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To create a condition tag
When you create condition tags, you should use condition indicators so that you
can distinguish text in one version from text in another. (If your conditional
document will be used to create many versions, use color indicators and work on
a color monitor.) Try to use meaningful names, beginning with a unique first
letter for quick tagging from the keyboard.
1

Choose Conditional Text from the Special menu.

2

In the Conditional Text window, click Edit Condition Tag.

3

In the Edit Condition Tag dialog box, type a name, specify condition indicators for the
condition tag, and click Set.

Type the name of the
condition tag here.

To specify the appearance
of tagged text, choose a
style and color from the
pop-up menus.

The condition tag appears in the Conditional Text window.
USING COLORS AS CONDITION INDICATORS

Conditional text appears in magenta when it is assigned two or more
overlapping condition tags that use different colors as condition indicators. For
this reason, you might not want to use magenta to indicate a particular
condition.
USING CONDITION TAGS FROM ANOTHER DOCUMENT

If another document has the conditional text settings that you want to use in
your current document, you can import them. You do this by choosing the
Import>Formats command from the File menu. For more information, see
“Importing formats into a document” on page 21-12.
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To chang e a tag’s condition indicators
You can change the appearance of conditional text by changing the tag’s
condition indicators. You will notice the change when you display the document
with its condition indicators showing. For information on how to display
condition indicators, see “To change the view of a conditional document” on
page 26-16.
1

In the Conditional Text window, select the tag you want to change.

2

Click Edit Condition Tag.

The Edit Condition Tag dialog box displays the tag’s current settings.
3

In the Edit Condition Tag dialog box, use the pop-up menus in the Condition Indicators
area to choose a new style or color and click Set.

For a tip on assigning colors, see “Using colors as condition indicators” on
page 26-7.

To delete a condition tag
You can delete a condition tag when you no longer need it in a document. When
you delete a condition tag, you do not automatically delete text that has that
tag. FrameMaker gives you the choice of making the text unconditional or
deleting the text.
1

In the Conditional Text window, select the tag you want to delete.

2

Click Edit Condition Tag.

The Edit Condition Tag dialog box displays the tag’s current settings.
3

In the Edit Condition Tag dialog box, click Delete.

If the document contains text with the condition tag you deleted, FrameMaker
removes the condition tag from the text.
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If the following dialog box appears, choose either to make the text unconditional or to
delete it and then click OK.

You see this dialog box when any text in the document has only one condition
tag and that tag is the one you want to delete.

TIP FOR ARCHIVING VERSIONS

A quick way to archive one version of a conditional document is to make a copy
of the document and, in that copy, to delete all condition tags not used to create
that version.
GENERATING A LIST OF CONDITION TAGS

To determine if a condition tag is being used in a document, you can generate a
list or index of condition tags that appear on each page of a document. To do
this, use the Generate/Book command to generate a list of references that
includes condition tags. (For details, see “To generate a list” on page 22-7.) If the
list shows that a condition tag has not been used, you may want to delete it.

USING CONDITION TAGS
To make text conditional, you apply tags by using the Conditional Text window,
by using the keyboard, or by copying and pasting condition tag settings.
When you put the insertion point in conditional text, the text’s condition tags
appear in parentheses in the Tag area of the status bar.

Condition tag of
selected text
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In any conditional document, some text may be used in more than one version.
You can apply as many condition tags to a selection of text as you like. The
condition indicator of each version applied to a passage of text is visible. Text
with two or more condition tags that use different colors as condition indicators
always appears in magenta.

ModuLINE CEOManagerSecretary
Low-Back Executive Office Seat
Model 25K/YR186P654S

The CEO indicator is a line
under the text; the Manager
indicator is a line through the
text; the Secretary indicator is
a line over the text.

To apply or change a condition tag
When you use the Conditional Text window to apply a condition tag, you can
apply more than one tag to a selection at a time.
1

Select the item you want to make conditional.
To make this conditional
Select
..........................................................................

Text in a text frame,
table cell, or footnote

Text

Anchored frame and
its contents

Frame’s border or anchor symbol

An entire table

Table’s anchor symbol

Table row

Whole row

Cross-reference

Cross-reference text

Footnote

Footnote reference (the number in the main text)

Marker

Marker symbol

Variable

Variable text

To make new text you’re about to type conditional, click where you want the
text to begin.
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Choose Conditional Text from the Special menu.

The Conditional Text window shows the condition tag settings of the
selected text.

If the text currently has
no condition tag, the
Unconditional button is on.

If only part of
the selection is
conditional, all
tags appear here.

If all of the selection is in a
certain condition, that tag
appears here.

If the entire
selection is
conditional, any
tags applied to
only portions of
the selection
appear here.

If none of the selection is in
a condition, that condition
tag appears here.

3

Move the condition tags to the appropriate scroll lists.

To move a condition tag between scroll lists, select the tag and click an arrow, or
double-click the tag. To move all tags from one scroll list to another, select a tag
in the list and Shift-click an arrow.
To include text in a condition, select the text and move the condition tag to the
In scroll list. To exclude text from a condition, select the text and move the
condition tag to the Not In scroll list. Condition tags in the As Is scroll list will
not be applied.
4

Click Apply.

If text is selected, FrameMaker applies the settings to the text. If you have put
an insertion point in the document, the settings apply to text you type until you
move the insertion point or press Return.
If you apply a condition tag that’s currently hidden, the selected text disappears
unless it is also part of a condition that is showing. For information on viewing
hidden text, see “To change the view of a conditional document” on page 26-16.
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MAKING ARTWORK CONDITIONAL

Because an anchored frame’s anchor symbol is a text symbol, it can be
conditional just as any other text. For this reason, you can treat graphics or
artwork in anchored frames as conditional “text.”
For an example of conditional artwork, see the sales brochure illustrated on
page 26-2. There, one frame is anchored in text with the CEO condition, and the
other frame is anchored in text with the Manager condition. The artwork, each
in its own frame, is shown or hidden depending on whether the text at the
anchor is shown or hidden.
KEYBOARD SHORTCUT TO CHANGE A CONDITION TAG

After selecting the item to which you want to apply a condition tag, press
Control-4. The Tag area at the bottom of the document window prompts you to
type the tag.

Tag area

Start typing the tag name. You may need to type only a few characters before
the name appears in the Tag area. Type lowercase letters to search forward;
type uppercase to search backward. You can also use the up arrow and down
arrow keys to scroll through the tags. Press Return to apply the condition tag
or, if you decide to cancel the operation, click in the document without pressing
Return.
AVOIDING UNRESOLVED CROSS-REFERENCES

If you insert a cross-reference to a source paragraph (such as a heading), and if
the first word in the paragraph is conditional, the Cross-Ref marker that
FrameMaker inserts is also conditional (with the first word’s condition tag).
This means the marker will be hidden when you hide the first word’s condition
tag settings. As a result, the cross-reference will be unresolved.
To avoid this, enlarge the view, carefully select just the Cross-Ref marker at the
beginning of the source paragraph, and make it unconditional. The marker will
always be visible so the cross-reference will be resolved no matter which version
is visible.
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To copy and paste condition ta g settings
If a condition tag is already in use somewhere in a document, copying and
pasting it is often the quickest way to apply it to other text.
1

Put the insertion point in text with the condition tag settings you want to copy.

The text’s condition tags appear in the Tag area.
2

Choose Copy Special>Conditional Text Settings from the Edit menu.

3

Select the item to which you want to paste the tag or click to place the insertion point.

4

Choose Paste from the Edit menu.

FrameMaker applies the settings to the selected text. If no text was selected,
any text you type at the insertion point will have the condition tag.
If you paste the settings into a different document, the tag name appears in
that document’s Conditional Text window so you can use it again.
FIND AND CHANGE CONDITION TAG SETTINGS

You can also use the Find/Change command to paste condition
tag settings. Select the text with the tags you want to paste and choose
Copy Special>Conditional Text Settings. Set up the Find/Change window to
search for the item you want to make conditional, and change it by using the
By Pasting option on the Change pop-up menu. For more information, see “To
search for conditional text” on page 8-12 and “To change by pasting from the
Clipboard” on page 8-17.

To create nonprinting comments
You can apply the Comment condition tag to items that you don’t want to
include in the final printed draft of a document. By default, the Comment tag
has condition indicators of red underline. You can change the indicators if you
want to, or you can create a different tag for your comments.
1

Apply the Comment condition tag to the comments.

For information on how to apply a condition tag, see “To apply or change a
condition tag” on page 26-10. Alternatively, you can apply a different condition
tag or change the condition indicators of the Comment tag.
2

Use the Show/Hide dialog box to hide the comments.

When you print the document, the comments will not appear.
For information on how to show or hide conditional text, see “To change the
view of a conditional document” on page 26-16.
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PUTTING COMMENTS IN THE MARGIN

You can put comments in margins by using anchored frames. See “Creating an
anchored frame” on page 15-4.

To remove a condition tag from text
When you no longer want text to be part of a version, you can remove the text’s
condition tag for that version. When you remove all the tags from conditional
text, either the text becomes unconditional or it is deleted, depending on your
choice.
For example, when editing a document you realize that a phrase you wrote and
made conditional for one version actually applies to both versions of the
document. You can remove the condition tag from the text and make the text
unconditional.
Removing a condition tag from text is not the same as deleting a tag from a
document. When you remove a tag from text, the tag remains in the document
so it can be applied again later.
1

Select the item with the tag you want to remove.

For instructions on what to select, see the table in “To apply or change a
condition tag” on page 26-10.
2

Choose Conditional Text from the Special menu.

3

Select the condition tags you want to remove.

If you want to remove all
condition tags from the
selection, click here.

If you want to choose which
condition tags to remove,
move them to the Not In
scroll list.
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To move a condition tag between scroll lists, select the tag and click an arrow, or
double-click the tag. To remove all condition tags from a selection, click
Unconditional.
4

Click Apply.
KEYBOARD SHORTCUT TO REMOVE A CONDITION TAG

After selecting the item from which you want to remove condition tags, press
Control-5. The Tag area at the bottom of the document window prompts you to
type the tag.

Tag area

Start typing the tag name. You may need to type only a few characters before
the name appears in the Tag area. Type lowercase letters to search forward;
type uppercase to search backward. You can also use the up arrow and down
arrow keys to scroll through the tags. Press Return to remove the condition tag
from the item or, if you decide to cancel the operation, click in the document
without pressing Return.
If you’re removing the last condition tag in the selection, the Remove Condition
Tags dialog box appears. Choose to make the text unconditional or to delete it
and then click OK.
KEYBOARD SHORTCUT TO REMOVE ALL CONDITION TAGS

To remove all tags from a selected item, press Control-6.

WORKING IN A CONDITIONAL DOCUMENT
You can view or print all unconditional and conditional text simultaneously, or
you can turn off the display of one or more versions. FrameMaker ignores
hidden conditional text when formatting a document. Hidden conditional text is
represented on the screen by a conditional text marker (
), a nonprinting text
symbol.
One version showing,
with condition indicators off
and text symbols on

■

Covering options include natural cotton
and wool coverings in 8 hues, all with
stain-proof and tear-proof linings

Markers show where
conditional text is hidden.
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You should usually work with text symbols turned on when you’re working in a
conditional document. Conditional text markers alert you to text that is in
other versions of the document.
If you’re displaying more than one version, or if you’re showing one version and
want to see which part is conditional, you can turn the condition indicators on.
When you edit a conditional document, FrameMaker generally pays attention
only to the versions currently displayed. This means, for example, that when
you use the Find/Change command to locate text, FrameMaker searches
through only displayed versions. However, you can cut, copy, and paste hidden
text by selecting the conditional text marker (
) and by using the commands
on the Edit menu.
A conditional document may need different variable definitions for each
version. A simple way to manage these differences is to create a template for
each version of the document with each template defining the variables for that
version. Once these templates are created, you can import their formats into
the conditional document.

To chang e the view of a conditional document
A conditional document can display any number of conditions at a time and can
have any of its condition indicators on or off.
1

Choose Conditional Text from the Special menu.

2

In the Conditional Text dialog box, click Show/Hide.

3

In the Show/Hide Conditional Text dialog box, select the condition tags of the text you
want to show and indicate whether you want to display their condition indicators.

Click here if you want to
display all conditional text.

Move the tags you want to
display to this list.
Turn on to display the
condition indicators.
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To move a condition tag between scroll lists, select the tag and click an arrow, or
double-click the tag. To move all tags from one scroll list to the other, select one
tag in the list and Shift-click an arrow.
4

Click Set.

When text has more than one condition tag, the text will be visible if any of its
tags are in the Show scroll list.
VIEWING IMPORTED CONDITIONAL TEXT

When you import text containing passages of conditional text into a document,
all the condition tags applied to text in the source document are imported so
that you can use them to show or hide imported conditional text. Even if the
flow is imported by reference and appears in a text inset, you can change views
of conditional text in the flow in the document containing the inset.
Whether a passage of conditional text is initially shown or hidden when you
import it depends on the match between the condition tags in the source
document and the target document (the document you’re importing into).
When condition tags
When condition tags
When Show All is on
match
don’t match
in target document
..........................................................................

Conditional text is
initially shown or hidden
according to the setting
in the target document.

Conditional text is
initially shown or hidden
according to the setting
in the source document.

All conditional
text is initially
shown.

For information on importing text, see “To import a text flow” on page 3-13 and
“What gets imported” on page 3-16.

To edit conditional text
You may want to work with all conditional text visible, using condition
indicators to distinguish the different conditions. Work with conditional text
hidden when you don’t want global changes such as finding and changing to
affect certain versions.
■

To copy and paste conditional text, use the Copy and Paste commands just as you do
when working with unconditional text.

When you copy text, FrameMaker copies its conditional text markers and
condition tag settings.
When you paste text with a condition tag that’s not in the destination
document, FrameMaker adds the tag to the destination document.
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■

To delete conditional text, use the Cut command.

When you try to cut hidden conditional text, FrameMaker displays an alert that
asks you to either delete the text or cancel the command.
■

To apply format changes to hidden text, use the Paragraph Designer and the
Character Designer.

Paragraph and character format changes you apply to selections don’t update
conditional text hidden within the selection. To apply a format change to all
paragraphs or characters, including hidden conditional text, click Update All in
the designer window or choose Update All from the Paragraph Format pop-up
menu on the formatting bar.
Applying format changes with the Import>Formats command also updates
hidden conditional text.
■

To spell-check all text, show all conditional text before using the Spelling Checker.

FrameMaker doesn’t spell-check hidden conditional text.
■

To search through all text, show all conditional text before using the Find/Change
command.

FrameMaker doesn’t search through hidden conditional text.
■

To compare the full texts of two documents, show all conditional text before choosing
Utilities>Compare Documents from the File menu.

If you want to exclude a condition from the comparison, save a copy of both
documents, delete the condition tags you do not want to compare, and then
compare the documents. If you want to compare the differences in a single
conditional document, save two copies of the document, show different
conditional settings for the one and the other, delete hidden conditions in both,
and then compare the two documents. In both cases, you need to delete the
conditions you don’t want to compare; simply hiding them can give unexpected
results.

To find conditional text
Use the Find/Change command to search for text belonging to any visible
condition tag. FrameMaker will find conditional text in text frames, graphic
frames, and table cells, but will not find conditional table rows. FrameMaker
doesn’t search through hidden conditional text.
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Choose Find/Change from the Edit menu.

2

In the Find/Change dialog box, choose Conditional Text from the Find pop-up menu.
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In the Find Conditional Text dialog box, select the conditions you want to find and
click Set.

To find text in a condition,
move the appropriate tag
to this list.
Leave the remaining
tags here.

To find text that is not in a
condition, move the
appropriate tag to this list.

To find all conditional text, leave all tags in the As Is scroll list.
To move a condition tag between scroll lists, select the tag and click an arrow, or
double-click the tag. To move all tags from one scroll list to another, select one
tag in the list and Shift-click an arrow.
4

Click Find in the Find/Change window.

To use variables
A conditional document may need different variable definitions for each
version. Create a template for each version of the document containing the
definitions for each version. For example, a sales kit uses a variable with the
product’s name, and the conditional document describes two products. Each
version also needs different header and footer information. Create a template
for each version of the kit, using a variable that uses the proper product name
as its definition and that has the correct header and footer variables.
■

To define variables, create a template for each version of the document.

Each template should have only one version visible and should define the
variables for that version. For information on defining variables, see
Chapter 12, “Variables.”
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■

To use variable definitions from another document, choose the Import>Formats
command from the File menu.

In the Import Formats dialog box, turn on Variable Definitions and turn off the
remaining checkboxes unless there are other items you need from that
document. For information on the Import>Formats command, see “Importing
formats into a document” on page 21-12.

To print a conditional document
When you are ready to print a finished version of a document, follow these
guidelines.
■

Change your view of the document to include only the version you want to print, and
turn off condition indicators.

■

If your document contains variables, make sure the variable definitions are correct for
the version you’re printing.

■

Spell-check the document.

This will catch double spaces, punctuation problems, and unusual hyphenation.
■

Update cross-references.

You may see an alert about unresolved cross-references. If so, you’ll have to fix
them. You may have cross-reference markers in conditional text that is
currently hidden. Show the version, and update the cross-references again. For
more information on correcting unresolved cross-references, see “Maintaining
cross-references” on page 10-17. For a tip on how to prevent some unresolved
cross-references, see “Avoiding unresolved cross-references” on page 26-12.
■

Save a copy of the document for each version before manually adjusting line and
page breaks.

Use the copy for each version for making the adjustments and for printing.
These adjustments will differ with each version. Use the original document for
future edits.
■

If the document is part of a book, update the book and its generated files.

If the book contains documents with different condition tag indicators for the
same tag, or if some condition tags are displayed in one document but are
hidden in another, FrameMaker displays an alert. If this occurs, click Cancel to
stop generating and correct your documents’ conditional text settings.
■

Check the index for double question marks (??), which indicate missing or incorrect
index markers.

For more information, see “To fix entries that contain double question marks”
on page 23-16.
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Most FrameMaker documents are destined for the printed page.
Hypertext documents are designed and written to be read on the
screen.

Hypertext encourages nonsequential exploration
With hypertext documents, you can set up an instructional online
environment, such as an interactive help system or a guided product
demonstration. Readers can page through the contents sequentially or
explore at random, following the paths you provide.

Hypertext commands link information
When you set up a hypertext document, you designate active areas.
These active areas contain hypertext commands that tell FrameMaker
how to respond when someone clicks one of the areas.
For example, readers might click in a list to learn about a specific item,
or click part of a graphic for a more detailed drawing of that part. They
can choose a topic from a pop-up menu, or they can click buttons to
navigate through a document.
2
45
The reader clicks a word,
phrase, or graphic to display
more information.

Whales
Mugs

Whales

You can set up links within a single hypertext document or between two
different hypertext documents. You can also set up a link that opens a
different document as a new unnamed document, ready for editing.
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You can generate a hypertext table of contents
Hypertext lists such as tables of contents and indexes provide quick
access to documents you want to distribute online. For example, you can
generate a hypertext table of contents from a book file.
Contents

A reader can open the
table of contents and click
a topic.

Dolphins.............1
Seals................27
Whales.............45
Sea Lions.........71

45

Whales

FrameMaker opens the
appropriate document
and displays the correct
page.

Readers can display, but not edit, view-only documents
You distribute your hypertext documents to readers in View Only
format. Readers can open and read such documents, but they can’t edit
them. After setting up and testing a hypertext document, you change it
to View Only format. If you need to edit it further, you change it back to
Normal format.
If your readers don’t have FrameMaker for reading online hypertext
documents, you can distribute FrameReader or FrameViewer with your
hypertext system. With FrameReader or FrameViewer, readers can
open and navigate through documents and also use a few FrameMaker
commands, such as Print, Copy, and Find. You can also convert a
FrameMaker document to an Adobe Acrobat document so that readers
can view it with Acrobat Exchange or Acrobat Reader.

Expert designers can create complex hypertext systems
With in-depth knowledge of FrameMaker, you can change the view-only
window display or selectively disable menu commands. These types of
expert controls are available through a Maker Interchange Format
(MIF) file. For information on using MIF to set up the view-only
window, see the online manual MIF Reference.
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In this chapter
This chapter shows you how to develop a hypertext online system, how
to use specific hypertext commands, and how to generate a hypertext
list. This chapter also shows you how to work in a view-only document
and how to convert a hypertext document to an Adobe Acrobat
document.

DEVELOPING AN ONLINE SYSTEM
Creating effective and easy-to-use online documents takes careful planning.
You need to design a page size and layout that’s appropriate for the type of
computer the document will be read from and for the type of reader who will
use it. Well-designed online systems usually include graphics or symbols that
the reader can click to navigate through the system. These graphics are made
active with hypertext commands, and they often appear in the same place on
each page. For example, you can create active areas from which readers can
choose topics to explore.
If you’ve never created a hypertext document or online system before, you may
want to research the subject before starting. You can learn things such as how
to organize material for an online document and what types of font families,
styles, and sizes look best on the screen.

To plan an online system
This section describes a few pointers to keep in mind when creating a hypertext
online system with FrameMaker.
■

Write several short documents rather than one long one.

A long document takes longer to open. With a series of short documents
(typically 10 pages or less), there is little delay if a reader clicks an active area
to display a page from another document.
■

Use fonts that are readily available.

You may want to use fonts such as Times and Helvetica because these fonts are
available on most systems and they print on all PostScript printers.
■

Keep all of the documents that make up the system together in one directory.

This way you won’t have to keep track of pathnames for imported graphics and
hypertext commands that require filename specifications.
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To create an online system
After planning your online document or system, create the hypertext
documents using these general steps. The rest of this chapter describes the
process in more detail.
1

Design the pages.

2

Write the contents.

3

Designate the areas where you want to insert hypertext commands.

4

Insert hypertext commands that tell FrameMaker what to do when your reader clicks
an active area.

5

Test the commands.

6

Change the documents to View Only format.

7

Distribute the documents to your readers.

PREPARING AREAS FOR BECOMING ACTIVE
A reader navigates through an online hypertext system by clicking active areas,
which are areas containing hypertext commands. An active area can be a range
of text, a graphic, or different parts of the same graphic. You can set up active
areas on body pages, or you can set them up on master pages so they appear in
the same location on all body pages. For example, you can set up navigational
buttons on master pages.
Before you insert a hypertext command, you must first prepare the area. You
can prepare a range of text by making it visually different from surrounding
text. Or you can prepare a graphic by drawing a text frame around it into which
you insert the hypertext command. After you insert a hypertext command, the
prepared area becomes active.
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To prepare a text area
A text area can be a word, a phrase, or an entire paragraph. If your reader
clicks in a text area that contains a hypertext command, FrameMaker finds the
hypertext command, highlights the area, and performs the command. You may
want to visually distinguish the text area from surrounding text, or you may
want the area to look the same as surrounding text.
■

To designate a word or a phrase as an active area, select the text and change its
character format.

Underlined text can be
active.

Changing the character format defines the boundaries of the text area. Most
formatting differences are recognized—for example, underlining, super- and
subscripting, and color. The only formatting changes that are ignored are pair
kerning, spread, change bars, and case.
■

To designate a word or phrase as an active area without changing its appearance,
use a character format that sets all properties to As Is.

For information on creating and applying character formats, see Chapter 5,
“Format Catalogs.”
■

To designate an entire paragraph as an active area, make sure there are no
character format changes in the paragraph.

As long as there are no character format changes in the paragraph,
FrameMaker searches the paragraph until it finds a hypertext command and
then highlights the entire paragraph and performs the command.
USING A SINGLE TEXT AREA FOR MULTIPLE HYPERTEXT COMMANDS

If a document has a string of text items, and if each item needs a hypertext
command, you can make the entire string a single area without character
changes and then insert the various hypertext commands. FrameMaker divides
the string into active areas based on the locations of the markers.

First area

Second
area

Third area

Fourth area

When a reader clicks in the string, FrameMaker determines which active area
was clicked and executes the correct hypertext command.
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To prepare a graphic
Graphics provide a visual key of what the reader can click. For example,
readers can click an icon to display information on a topic.
You can click a graphic to
display a different topic.

An active area over a graphic can contain a hypertext command that simply
jumps to another location or that divides the graphic into a matrix of hypertext
commands.
1

Draw a text frame that covers the entire graphic you want to make active.

A hypertext command must be in a text frame. For information on using the
Text Frame tool to draw a frame, see “To add a text frame” on page 13-26.
Make sure that the graphic is not set to have text run around it. For details, see
“Preventing text from running around a graphic” on page 13-32.
2

Set the text frame’s fill and pen patterns to None.

This makes the text frame transparent so that readers see only the graphic
behind the frame. For information on setting fill and pen patterns, see
“Choosing object properties” on page 13-18.
3

Use the Bring to Front command on the Graphics menu to place the text frame in front
of the graphic, if it isn’t already there.

To prepare the same area on several pages
You can create an area that appears in the same location on more than one
page. You do this by setting up the area on a master page and inserting the
hypertext command there. For example, you can create active buttons on
master pages that readers can click on body pages to display the next or
previous page.
The reader can click the
double arrow to retrace
steps.

The reader can click the left arrow
to go to the previous page or the
right arrow to go to the next page.

You can override master page active graphics on individual body pages if you
want to send the reader somewhere else. For example, you can create a
next-page button with an override on the last body page of each document
because there is no next page to display.
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■

To have an active area appear on more than one page, set up the area on a master
page rather than on a body page.

The active area appears in the background of corresponding body pages. When
your reader clicks that area on a body page, FrameMaker looks for a hypertext
command on the master page. If you cover the active area with a graphic, or
with a text frame that doesn’t contain a hypertext command, you mask the
active area on the body page where you put that graphic or frame.
When you draw the text frame on a master page, FrameMaker asks whether
you want to create a template frame or a background frame. Text frames for
active areas should be background (untagged) text frames.
■

To override a master page command on an individual body page, put a graphic or a
different hypertext command over the area on the body page.

For example, you can create an inactive, shaded button covering the next-page
button on the last body page of each document.
The body page override
masks out the active area.

Alternatively, you can place a text frame that contains its own hypertext
command over the graphic on the body page.
The body page override could display
the first page of a different document.

CREATING NONPRINTING BUTTONS

You can create navigation buttons and other such graphics that won’t print if
your reader prints the document. To make a graphic nonprinting, assign a color
to the graphic and then put that color in the Don’t Print list in the Set Print
Separations dialog box. In the same dialog box, turn on Skip Blank Separation
Pages. Make sure Print Separations is on in the Print dialog box and that you
click Save Settings Only. For more information on making a color nonprinting
and on printing separations, see Chapter 17, “Color.”
Because you have to print separations to make a color nonprinting, this
technique for creating nonprinting buttons works only if the document is all one
color except for the buttons. That way, when the document prints, only one
sheet will print for each page.
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INSERTING A HYPERTEXT COMMAND
You insert hypertext commands in prepared areas. After you insert a command,
the area is active. Hypertext commands let your reader navigate through the
view-only documents, display alerts, execute operating system commands, start
other applications, close documents, and exit FrameMaker.
You use markers to insert hypertext commands.

Hypertext command marker

After inserting a hypertext command, you can edit the marker or delete it at
any time.

To insert a hypertext command
You use a marker to insert a hypertext command in a prepared area. When a
reader clicks an active area, FrameMaker highlights the area and executes the
command. If you insert a hypertext command into an otherwise empty text
frame over a graphic, the entire text frame becomes active. When the reader
clicks an active text frame, FrameMaker highlights the entire frame.
1

Click in a prepared area where you want to insert a hypertext command.

If you’re inserting a command in a text area, later text editing will be easier if
your marker is at the beginning or end of a word.
2

Choose Marker from the Special menu.

3

Choose Hypertext from the Marker Type pop-up menu and type the actual hypertext
command.

Choose Hypertext from the
pop-up menu.
Type the hypertext
command here.

Hypertext commands must be typed lowercase. The optional parameters such
as filename and linkname can be uppercase or lowercase, but they are
case-sensitive. A hypertext command can be up to 255 characters long. For a list

Using FrameMaker
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of hypertext commands, see “Hypertext commands” on page 27-40. For
information on individual commands and their syntax, see “Using specific
hypertext commands” on page 27-11.
4

Click New Marker.

If Text Symbols is on in the View menu, a marker symbol ( ) appears at the
insertion point.

To edit a hypertext command
When you test your hypertext system, you may need to go back and edit some
commands. If the document is in View Only format, you must change it back to
Normal format before you can edit the hypertext commands.
1

If the document is in View Only format, press Esc F l (lowercase L) k to change it to
Normal format.

2

Choose Marker from the Special menu to display the Marker window.

3

In the document, select the marker with the command you want to change.

To select a marker in an otherwise empty text frame, triple-click anywhere in
the frame. You can also use the Find command to find and select hypertext
markers.
4

In the Marker window, edit the command in the Marker Text text box.

5

Click Edit Marker.

To delete a hypertext command
When you test your hypertext system, you may need to delete a command. If
the document is in View Only format, you must change it back to Normal
format before you can delete a hypertext command.
1

2

If the document is in View Only format, press Esc F l (lowercase L) k to change it to
Normal format.
Select the marker you want to remove.

To select a marker in an otherwise empty text frame, triple-click anywhere in
the frame. You can also use the Find command to find and select hypertext
markers.

27-10

3

Press Delete.

4

To change the document to View Only format, press Esc F l (lowercase L) k.
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USING SPECIFIC HYPERTEXT COMMANDS
You can use FrameMaker hypertext commands to set up a navigable hypertext
system such as FrameMaker online Help. FrameMaker Help uses most of the
hypertext commands described in the following pages. For a list of the
hypertext commands you can use, see “Hypertext commands” on page 27-40.

To examine FrameMaker Help
Before you set up your online system, you may find it helpful to examine
FrameMaker Help.
1

Click Help in the main FrameMaker window and find a page you want to view.

2

Press Esc F l (lowercase L) k to change it to Normal format.

3

Turn on borders and text symbols.

4

Use the Marker window to view the hypertext commands.

You may need to display the master page or reference page to view some of the
commands.

To create a link to a topic
You can set up a simple link from one location in a hypertext document to
another location in the same document or in a different document. You use
either the gotolink or the openlink command to specify the topic you
want to display, and you use the newlink command to mark the spot on the
referenced page. Every gotolink and openlink command must have a
corresponding newlink command.
2
45
You insert gotolink
or openlink where the
jump starts…

Whales
Mugs

Whales

…and newlink at the
destination.

FrameMaker displays the referenced information in the same window when
you use the gotolink command. It displays the information in a new window
when you use the openlink command. For example, you can use openlink
commands to open sample documents that readers can use independently of the
main documents.

Using FrameMaker
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1

Insert either a gotolink or an openlink command in the active area where
you want to initiate the jump.

The syntax of each command is
gotolink filename:linkname
openlink filename:linkname
where filename is the name of the document you want to display and
linkname is any descriptive word or phrase that you’ll also use in the
corresponding newlink command. If the topic you want to display is in the
current document, you don’t need to include the filename and colon in the
command. For information on including a pathname, see “Including a
pathname in a hypertext command” on page 27-12.
2

Insert a newlink command in the location you want FrameMaker to display.

The syntax of this command is
newlink linkname
where linkname is the same descriptive word or phrase that you used in the
corresponding gotolink or openlink command.
The linkname in the newlink command must match the linkname in the
corresponding gotolink or openlink command. For example, a linkname
with a trailing space differs from a linkname without a trailing space. Also, the
linkname is case-sensitive; Changing Units is not the same as changing units.

INCLUDING A PATHNAME IN A HYPERTEXT COMMAND
The filename option in hypertext commands can
contain a pathname. In a pathname, directory
levels are separated by a slash (/). The pathname
can include shell environment variables, such as
$HOME, to indicate the reader’s home directory.
If your hypertext documents will be used on
several platforms, use filenames that are valid on
all the platforms. For information on file-naming
requirements on different platforms, see the online
manual Using Frame Products on Multiple
Platforms.
Relative pathnames FrameMaker searches for a
relative pathname beginning in the directory that
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contains the current document. To go up one
directory level, use two periods (..). For example,
suppose a hypertext command refers to a
document named myfile that is stored in a
directory named training. If the training
directory is in the same directory as the current
document, use the pathname training/myfile.
If the training directory is at the same level as
the directory that contains the current document,
use ../training/myfile.
Absolute pathnames FrameMaker searches for an
absolute pathname beginning at the top of the file
system. Absolute pathnames begin with a slash.
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EXAMPLE

The command gotolink mammals:whales finds the location in the
document mammals that contains the hypertext command newlink whales.
FrameMaker displays the page in the current window.
CREATING LINKS BY USING CROSS-REFERENCES

You can set up simple links by using cross-references. When the reader clicks a
cross-reference in a view-only document, FrameMaker treats the crossreference the same as a gotolink command. If a cross-reference happens to
be present in the same text area as a hypertext command, the cross-reference
link takes precedence over the hypertext command.
You can use MIF to specify that cross-references should not be active in your
hypertext document. You can also specify that clicking an active cross-reference
causes FrameMaker to open a new window. For information on using MIF to
customize hypertext documents, see the online manual MIF Reference.

To create a link to a specific page
You can set up a simple link from a location in a hypertext document to a
specific page in the same document or in a different document. You can use
either the gotopage or the openpage command to specify the page you want
to display.
2
You insert
here…

gotopage

Whales
Mugs

45

Whales

…to display page 45 in the
current window.

FrameMaker displays the referenced page in the same window when you use
the gotopage command. It displays the information in a new window when
you use the openpage command.
You can also use a variation of the gotolink command to display the first or
last page of a document. You can use the previouspage and nextpage
commands to display the previous and next pages.

Using FrameMaker
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■

To display a specific page of a document, put either a gotopage or an openpage
command in the active area where you want to initiate the jump.

The syntax of each command is
gotopage filename:pagenumber
openpage filename:pagenumber
where filename is the name of the document you want to display and
pagenumber is the number of the page you want to display. When the page you
want to display is in the current document, you don’t need to include the
filename and colon in the command. For information on including a pathname,
see “Including a pathname in a hypertext command” on page 27-12.
■

To display the first or last page of a document, use the gotolink firstpage or
gotolink lastpage command.

The syntax of each command is
gotolink filename:firstpage
gotolink filename:lastpage
where filename is the name of the document you want to display. When the
page you want to display is in the current document, you don’t need to include
the filename and colon in the command. For information on including a
pathname, see “Including a pathname in a hypertext command” on page 27-12.
■

To display the previous or next page of a document, use the previouspage or
nextpage command.

The syntax of each command is
previouspage
nextpage
If the first page of the document is already displayed, previouspage has no
effect. If the last page of the document is displayed, nextpage has no effect.
EXAMPLE OF GOTOPAGE

The command gotopage 8 displays page 8 of the current document.
The command gotopage mammals:8 displays page 8 of the document
mammals.
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EXAMPLES OF GOTOLINK

The command gotolink firstpage displays the first page of the current
document.
The command gotolink mammals:lastpage displays the last page of the
document mammals.
EXAMPLE OF PREVIOUSPAGE AND NEXTPAGE

You can use the previouspage and nextpage commands on master pages
for displaying the previous and next pages.
This active area contains
the previouspage
command.

This active area contains
the nextpage
command.

RESIZING THE DOCUMENT WINDOW AUTOMATICALLY

FrameMaker displays referenced information in a window resized to fit the
page when you use the gotolinkfitwin or openlinkfitwin command.
For example, a document containing a gotolinkfitwin command on a
portrait page will resize the window to display the landscape page containing
the corresponding newlink command.
The syntax of the gotolinkfitwin and openlinkfitwin commands is
identical to that of the gotolink and openlink commands.

To create a way to open a new, unnamed document
You can create a link to another document and have FrameMaker open the
document in another window as a new, unnamed document. For example, you
can create an online system for your site’s document templates. A user can
choose a template from a list or pop-up menu to open the template as a new,
unnamed document.
■

To open a new, unnamed document, use the opennew command.

The syntax for this command is
opennew filename
where filename is the name of the document you want to open. For
information on including a pathname, see “Including a pathname in a hypertext
command” on page 27-12.

Using FrameMaker
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To create a way to retrace steps
FrameMaker keeps track of each page the reader jumps to in a document
window—up to 69 jumps—by storing the jumps on a stack, with the most recent
jump on top. A reader can retrace steps by jumping to previous locations on the
stack. For information on how each hypertext command affects the stack, see
“The hypertext stack” on page 27-16.
■

To display the previous location in the stack, use the previouslink command.

The syntax for this command is
previouslink filename:linkname
where filename and linkname define the location FrameMaker should
display when the stack is empty. If the stack is empty, and if you haven’t
provided a filename and linkname, FrameMaker leaves the current page
displayed. For information on filenames and linknames, see “To create a link to
a topic” on page 27-11. For information on including a pathname, see “Including
a pathname in a hypertext command” on page 27-12.

THE HYPERTEXT STACK
Not all hypertext commands affect the stack.
alert Has no effect.
alerttitle Has no effect.

openlink Creates a separate stack for the newly
opened window, and leaves the stack in the current
window unchanged.

gotolink Stores the current location on the
stack before jumping.

openlinkfitwin Creates a separate stack for
the newly opened, resized window, and leaves the
stack in the current window unchanged.

gotolinkfitwin Stores the current location on
the stack before jumping.

opennew

Has no effect.

gotopage Stores the current location on the
stack before jumping.

openpage Creates a stack for the newly opened
window, and leaves the stack in the current
window unchanged.

matrix Commands in the matrix have the same
effect on the stack as they would elsewhere.

popup Commands in the pop-up menu have the
same effect on the stack as they would elsewhere.

message system Has no effect.

Displays the last location stored

newlink Has no effect.

previouslink
on the stack.

nextpage Stores the current location on the
stack before displaying the next page.

previouslinkfitwin
stored on the stack.

Displays the last location

previouspage Stores the current location on
the stack before displaying the previous page.
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EXAMPLE

You can use the previouslink command on master pages to display the
previous location in the stack.
This active area contains
the previouslink
command.

RESIZING THE DOCUMENT WINDOW AUTOMATICALLY

FrameMaker displays referenced information in a window resized to fit the
page when you use the previouslinkfitwin command. For example, a
document containing a previouslinkfitwin command on a portrait page
will resize the window to display the landscape page specified in the stack.
The syntax of the previouslinkfitwin command is identical to that of the
previouslink command.

To create a matrix of links over a graphic
You can draw a text frame over a graphic and create a matrix of equal-sized
cells that correspond to hypertext commands. When a reader clicks a matrix
item in a hypertext document, FrameMaker highlights the cell and executes the
corresponding hypertext command. For example, the matrix could be a group of
math symbols.

∑ ∏ ∫
°∫ ∩ ∪
A matrix of six cells

If the reader were to click one of the math symbols, FrameMaker would
highlight the area around the symbol and execute the corresponding hypertext
command. For details on how this sample matrix would be set up, see
“Example,” next.
1

Put the graphic in your document.

The graphic should be appropriate for setting up as a matrix of equal-sized cells
such as the sample math symbols.
2

Prepare the graphic to be an active area.

Draw a single text frame around the entire graphic; you’ll specify the
dimensions of the matrix in the hypertext command you insert. For information
on preparing a graphic to be an active area, see “To prepare a graphic” on
page 27-7.
Using FrameMaker
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3

Insert a single hypertext matrix command in the text frame, leaving the rest of the
frame empty.

The syntax for this command is
matrix rows columns flowname
where rows and columns are the numbers of rows and columns in the
matrix, and flowname is the tag of a text frame you’ll create on a reference
page. The flowname cannot contain embedded spaces.
You’ll specify the individual hypertext commands for the matrix cells in the
reference page text frame.
4

Draw a text frame on a reference page and assign a flow tag that matches the
flowname in the matrix command.

For information on using the Text Frame tool to draw a text frame, see “To add
a text frame” on page 13-26. For information on assigning flow tags, see “To
change a flow tag” on page 20-9.
5

Type one hypertext command in each paragraph in the text frame.

The commands should correspond to the items in the first row of the matrix,
from left to right, followed by the second row, and so on. Each command must fit
on one line. You can resize the text frame if necessary.
EXAMPLE

For the math symbols matrix shown earlier, the matrix command is
matrix 2 3 MathSymbols because the matrix contains 2 rows and
3 columns, and the corresponding hypertext commands are in a reference page
text frame tagged MathSymbols. The text frame appears on the reference page
as follows:
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To create a pop-up menu of links
Your hypertext document can display a pop-up menu from which readers can
choose an item that links to related information. When the reader points on an
active area that contains the popup command and holds down the mouse
button, FrameMaker displays the pop-up menu you define. For example, a
document on marine mammals could use a pop-up menu to display topics.

The reader can choose
Seals from the pop-up menu
to display information on
seals.

For details on how the sample marine mammals pop-up menu would be set up,
see “Example of a pop-up menu and submenu” on page 27-20. For information
on creating a hypertext submenu, see “To create a submenu of links,” next.
1

Create the graphic button the reader will press to display the pop-up menu.

2

Prepare the graphic to be an active area.

Draw a single text frame around the entire graphic. For information on
preparing a graphic to be an active area, see “To prepare a graphic” on
page 27-7.
3

In the text frame, insert a single popup command and leave the rest of the frame
empty.

The syntax for this command is
popup flowname
where flowname is the tag of a text frame you’ll create on a reference page.
You’ll specify the items and hypertext commands for the pop-up menu in the
reference page text frame. The flowname cannot contain embedded spaces.
4

Draw a text frame on a reference page and assign a flow tag that matches the
flowname in the popup command.

For information on using the Text Frame tool to draw a text frame, see “To add
a text frame” on page 13-26. For information on assigning flow tags, see “To
change a flow tag” on page 20-9.
5

Type the menu name in the flow and press Return.

This is the name that will appear at the top of the pop-up menu.

Using FrameMaker
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6

Type a menu item in each subsequent paragraph.

Each subsequent single-line paragraph in the flow contains an item that will
appear in the pop-up menu. If necessary, widen the text frame so that each item
fits on a single line.
7

Insert a hypertext marker in each line except the line that contains the menu name.

When your reader chooses an item from the pop-up menu, FrameMaker
performs the corresponding hypertext command.

To create a submenu of links
A hypertext pop-up menu can display a submenu from which readers choose an
item that links to related information. When the reader points on a pop-up
menu item that contains the popup command and holds down the mouse
button, FrameMaker displays the submenu you define. For example, a pop-up
menu on marine mammals could use a submenu on seals to display subtopics.

...then choose an item from
the submenu to display
information about fur seals.

The reader can choose
Seals from the pop-up menu
to display a submenu about
seals...

EXAMPLE OF A POP-UP MENU AND SUBMENU
For the Marine Mammals pop-up menu shown on
page 27-19, the menu name is Marine Mammals.
The text frame that contains the menu items and
markers appears as follows:
Menu name
Hypertext
marker

Hypertext marker
containing popup
command

to your readers, or a popup command to display a
submenu of items.
For the Seals submenu shown on page 27-20, the
submenu name is Seals. The text frame that
contains the submenu items and markers appears
as follows:
Submenu name
Hypertext
marker

You can use a gotolink command in each menu
item to display related information, an alert or
alerttitle command to provide a short message
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You can also use a gotolink, alert, or
alerttitle command in a submenu item.
However, you can’t use a popup command in a
submenu item.
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For details on how the sample marine mammals submenu would be set up, see
“Example of a pop-up menu and submenu” on page 27-20. For information on
creating a pop-up menu, see “To create a pop-up menu of links” on page 27-19.
1

Locate on the reference page the text frame that describes the pop-up menu for
which you want to create a submenu.

2

In the text frame for the pop-up menu, insert a single hypertext popup command in
the line for which you want the submenu to appear.

The syntax for this command is
popup flowname
where flowname is the tag of a text frame you’ll create on a reference page.
You’ll specify the items and hypertext commands for the submenu in the
reference page text frame. The flowname cannot contain embedded spaces.
For example, to create a Seals submenu in the Seals entry, insert a hypertext
marker that contains the command popup SealSubMenu.
This step and the steps following are similar to the steps for creating a pop-up
menu of links.
3

Draw a text frame on a reference page and assign a flow tag that matches the
flowname in the popup command.

For information on using the Text Frame tool to draw a text frame, see “To add
a text frame” on page 13-26. For information on assigning flow tags, see “To
change a flow tag” on page 20-9.
4

Type the submenu name in the flow and press Return.

Type a submenu name that matches the item in the pop-up menu.
5

Type a submenu item in each subsequent paragraph.

Each subsequent single-line paragraph in the flow contains an item that will
appear in the submenu. If necessary, widen the text frame so that each item fits
on a single line.
6

Insert a hypertext command in each line except the line that contains the
submenu name.

You can use a gotolink, alert, or alerttitle command in a submenu
item. However, you can’t use a popup command in a submenu item.
When your reader chooses an item from the submenu, FrameMaker performs
the corresponding hypertext command.

Using FrameMaker
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To create an alert message
You can use a hypertext command to display an alert box that contains a title
and a message. You can also specify a default title for all hypertext alert boxes
in a document.
■

To display a hypertext alert box with the title FrameMaker—Alert, use the alert
command.

The syntax for this command is
alert message
where message is the text you want to display in the alert box. The message
can be up to 249 characters long.
■

To display an alert box with a title other than FrameMaker—Alert, use the
alerttitle command.

The syntax for this command is
alerttitle title:message
where title is the title of the alert box and message is the text you want to
display in the alert box. A colon separates the text that appears in the alert
box’s title bar from the text that appears in the alert box. The total number of
characters in title and message cannot exceed 243 characters.

SPECIFYING A DEFAULT TITLE FOR ALERTS IN A DOCUMENT
You can specify a default title other than
FrameMaker—Alert for all hypertext alert boxes in
a document created with the alert command. To
do so, draw a text frame on a reference page,
assign it the flow tag AlertTitle, and type the
default title in the text frame.
For example, if the default title Not Available
Online appears in a flow tagged AlertTitle on the
reference page, that title, not FrameMaker—Alert,
will appear in the title bar of any alert box created
with the alert command.
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The default title will also appear in the title bar of
any alert box created with the alerttitle
command in the following form, without a title:
alerttitle :message
If you provide a title before the colon, it overrides
the default title.
For information on using the Text Frame tool to
draw a text frame, see “To add a text frame” on
page 13-26. For information on assigning flow tags,
see “To change a flow tag” on page 20-9.
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EXAMPLE

To display the following alert box when the reader clicks an active area, you use
this hypertext command.
alerttitle Unavailable:This document is currently under
development.

To create a way to close documents
The two hypertext commands for closing documents work just as the Close and
Close All Open Files commands on the File menu.
■

Use the quit command to close the current view-only document.

The syntax for this command is
quit
■

Use the quitall command to close all open view-only documents.

The syntax for this command is
quitall
The quitall command also closes view-only documents that have already
been closed to an icon.
SAVING CHANGES

If the document contains unsaved changes—for example, when the reader
changes the document to Normal format—FrameMaker prompts the reader to
save the document before closing.

Using FrameMaker
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To create a way to exit FrameMaker
The hypertext command for exiting FrameMaker works the same as the Exit
command in the main FrameMaker window.
■

Use the exit command to exit FrameMaker.

The syntax for this command is
exit
SAVING CHANGES

If the document contains unsaved changes—for example, when the reader
changes the document to Normal format—FrameMaker prompts the reader to
save the document before closing.

To create a way to execute commands
You can use hypertext commands to start other applications and perform the
commands you specify. For example, your reader can start a database
application from a FrameMaker view-only document to retrieve and
display data.
You can also use hypertext commands to execute UNIX commands. For
example, the reader can click an active area to create a particular directory in
the current directory.
■

To send messages to an application that is already running, use the message
command.

The message command sends messages to FrameMaker clients by way of the
Frame Application Program Interface™ (API). For information on using the
message command, see the FDK Programmer’s Guide, which is included in the
Frame Developer’s Kit™.
■

To execute a UNIX command, use the message system command.

The syntax for this command is
message system command
where command is the text of any UNIX command you can type in an xterm
window.
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EXAMPLE

The command message system ls $FMDOCDIR causes FrameMaker to list
the contents of the directory in which the document resides when the reader
clicks an active area that contains the command.
In this example, FrameMaker passes the command to sh(1) for execution;
stdout and stderr are redirected to your xterm window. FrameMaker waits
for the command, script, or program to finish before continuing.
U S I N G T H E $FMDOCDIR A N D $FMDOCNAME E N V I R O N M E N T V A R I A B L E S

You can use the environment variables $FMDOCDIR and $FMDOCNAME with
the message system command. When the reader clicks an active area that
contains the command, $FMDOCDIR is set to the directory that contains the
current document and $FMDOCNAME is set to the name of the current
document.
For example, the command
message system cp /HypertextDir/Data $FMDOCDIR
copies the file named Data from the HypertextDir directory to the
directory that contains the current document.
The command
message system cp /HypertextDir/$FMDOCNAME.Data $FMDOCDIR
copies the file named the same as the current document with the extension
Data from the HypertextDir directory to the directory that contains the
current document.

To test a hypertext document
After you’ve written the document and inserted the hypertext commands, you
should test the commands to make sure that all of your links are set up
correctly, that the pop-ups and matrix commands work correctly, and so on. For
a list of common errors, see “Debugging tips” on page 27-26.
■

To activate hypertext commands without changing the document to View Only
format, Control-right-click active areas.

FrameMaker responds as if the document were view-only; the hypertext
command is executed and the appropriate page is displayed.
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■

To speed up cross-checking of links between documents, display both documents in
separate windows.

To force a new window to open, Control-Shift-right-click an active area if the
document is not view-only; Shift-click the active area if the document is
view-only.
■

To quickly check the text of hypertext commands, generate a list or index of
hypertext markers.

The generated list will contain the text of all hypertext markers inserted on
body pages in the document and their page numbers. Use the generated list to
review the text of alerts and to verify that each gotolink and openlink
command has a corresponding newlink command.
For information on generating lists, see Chapter 22, “Generated Lists.”

DEBUGGING TIPS
You may come across these common errors when testing a hypertext document.
If you see this
It could mean
...................................................................................................

The current page continues to be
displayed when you click an active area.

The gotolink or openlink command’s corresponding
newlink command is missing or contains an incorrect
linkname.
You accidentally used a marker type other than Hypertext
when you inserted the hypertext command.
You have several hypertext markers next to one another.

The first page of the referenced document
The corresponding newlink command is missing, but the
is displayed rather than the intended page. gotolink command contains a valid filename.
The gotopage command contains an invalid page number.
The wrong page is displayed.

You may have used the same linkname twice.

The entire text frame over a graphic
doesn’t highlight when clicked.

There is an extra character or marker in the text frame.
Look for and delete the character or marker.

An item is missing from a pop-up menu.

The hypertext command for that item is not correct. If no
commands are correct, the pop-up menu does not appear
at all.

27-26

Using FrameMaker

Adding hypertext links to generated files

.....

HYPERTEXT AND VIEW-ONLY DOCUMENTS

ADDING HYPERTEXT LINKS TO GENERATED
FILES
When you generate an index or list such as a table of contents, FrameMaker
can insert hypertext links for jumping from the generated file to locations in the
source document—that is, in the document that is the source of the generated
file. These links provide easy access to online information; you can click a topic
or page number in the generated file and FrameMaker displays the appropriate
page in the referenced document.
A common use of generated hypertext documents is to provide a table of
contents for online documents. You can change the generated table of contents
to View Only format and distribute it with your online documents. Another use
of generated hypertext lists or indexes is for debugging documents. For
example, when creating an index for a book file, you can generate the index
with hypertext links and then quickly fix index marker errors by jumping to the
exact locations of the markers.
There are two FrameMaker commands that generate documents.
Generate/Book generates documents such as tables of contents, lists of figures,
and indexes. Compare Documents generates composite and summary
documents.

To generate a hypertext document
The Generate/Book command has set up dialog boxes in which you specify what
you want included in the generated list or index. Similarly, the Compare
Documents command has a dialog box for specifying what you want included in
the summary and composite documents. After you generate a hypertext
document, you can add it to your online system. For details, see “To incorporate
generated files into an online system” on page 27-32.
■

To generate a hypertext document from an individual FrameMaker document, turn on
Create Hypertext Links in one of the Set Up dialog boxes of the Generate/Book
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command or in the Compare Options dialog box of the Compare Documents
command.

Make sure Create
Hypertext Links is on.

For complete information on using the Generate/Book command to generate
lists and indexes, see Chapter 22, “Generated Lists,” and Chapter 23, “Indexes.”
For complete information on using the Compare Documents command, see
Chapter 25, “Revision Management.”
■

To generate a hypertext document from a book file, use the Set Up File command on
the book window’s File menu.

For instructions on using the Set Up File command, see “To change the setup of
files in a book” on page 24-19.
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To add thumbtabs to a generated index
You can make a generated online index easier to navigate by adding thumbtabs.
Readers click on a thumbtab letter to display the page in the index that
contains entries that start with that letter.
Readers click on a
thumbtab…

ABCDEFGHIJKLMNOPQRSTUVWXYZ

N

…to display the index page
with the matching group
title.

O
P-R

For information on generating indexes, see Chapter 23, “Indexes.”
1

With Create Hypertext Links on in the Set Up dialog box for the index, generate
the index.

For details, see “To generate a hypertext document” on page 27-27.
2

On the index master page, use the Text Line tool to type the thumbtab letters.

Choose Master Pages from the View menu to display master pages. For details
on using the Text Line tool, see “To add a text line” on page 13-25.
3

Draw a text frame over each thumbtab letter.

For details on drawing a text frame, see “To add a text frame” on page 13-26.
4

Insert a gotolink command in the text frame for each thumbtab letter.

For example, in the text frame over the thumbtab letter A, insert the hypertext
command gotolink A. The A, and the other alphabetical group titles in an
index, are automatically treated as links when you generate the index with
hypertext markers.
If the index contains a collapsed group title, such as P–R, insert the same
gotolink command in the text frame for each of the thumbtab letters in the
range. For example, insert gotolink P-R in the three text frames for P, Q,
and R.
For details on inserting a hypertext command, see “To insert a hypertext
command” on page 27-9. For more information on group titles, see “To change
entry groupings and group titles” on page 23-26.
5

Save the index in View Only format.
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To activa te a hypertext command in a Normal-format document
When you generate a hypertext document, FrameMaker opens the document in
Normal format. Because it’s not a view-only document, you can’t just click an
active area to activate its hypertext command. If you don’t intend to change the
document to View Only format, you can still activate the hypertext commands.
Use the following key combination.
■

Control-right-click the active area.

To control how FrameMaker displays the source document
When you click an active area in a generated hypertext document, FrameMaker
opens a new window and displays the correct page in the source document—the
referenced document that is the source of the generated file. The specific item
on the page is highlighted and centered in the window. You can change how
FrameMaker displays the referenced document. For example, FrameMaker can
display the referenced document in the current window. That way, the
generated file can be merged into a larger online system.
1

Generate the hypertext document.

For details, see “To generate a hypertext document” on page 27-27.
2

In the generated file, display the reference page that contains the special flow for the
list or index.

The flow tag of the special flow is the same as the document’s suffix. For
example, the special flow for a table of contents is tagged TOC, the special flow
for an index is tagged IX, and so on. To determine a flow’s tag, click in the text
frame and look in the Tag area at the bottom of the document window.

Flow tag
Paragraph
tag

3

In the special flow, find the paragraph that controls how the referenced document is
displayed.

In a table of contents, the paragraph’s tag is ActiveTOC; in an index, it’s named
ActiveIX; and so on. The paragraph will look something like this:
gotoObjectId <$relfilename>:<$ObjectType> <$ObjectId>
To determine a paragraph’s tag, click in the paragraph and look in the Tag area
at the bottom of the document window.
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Edit the paragraph so that it contains the display command you want.

For a list of the commands you can use, see “Display commands for generated
hypertext documents” on page 27-31. In addition to the commands in the list,
you can use the message command to send messages to applications you’ve
created with the Frame Application Program Interface (API). For details, see
the FDK Programmer’s Guide, which is included in the Frame Developer’s Kit.
5

Save the generated file and then regenerate it from the source document.
OVERRIDING THE GENERATED FILE’S DISPLAY COMMAND

You can also specify how a specific document is displayed, overriding the
display command contained in the ActiveTOC or ActiveIX paragraph in the file
generated from that document. For example, you may want a generated index
that references several files, including a glossary file, to display the glossary in
one window and all the other files in another window.

DISPLAY COMMANDS FOR GENERATED HYPERTEXT DOCUMENTS
When the reader clicks an active area in a generated hypertext document, FrameMaker displays the
correct page in the referenced document. The following table lists some of the hypertext commands you can
use for controlling how the referenced document is displayed. (The gotoObjectId command is a special
hypertext command used only in generated files.) You should type the commands exactly as shown. Use the
<$relfilename> building block to have FrameMaker create a relative pathname from the generated file
to the other document. Otherwise, use <$fullfilename> for a full pathname. (The examples in the
following table show only the <$fullfilename> building block.)
To display
Type
...................................................................................................

The highlighted item centered in gotoObjectId <$fullfilename>:<$ObjectType> <$ObjectId>
the current window
The highlighted item centered in openObjectId <$fullfilename>:<$ObjectType> <$ObjectId>
a new window
The page in the current window
with nothing highlighted

gotopage <$fullfilename>:<$pagenumonly>

The page in a new window with
nothing highlighted

openpage <$fullfilename>:<$pagenumonly>

An alert that displays the
filename of the referenced
document

alert <$fullfilename>
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To specify the display command for a document, start by drawing a text frame
on its reference page and assigning it the flow tag HypertextLinks. In the
text frame, type either gotoObjectId or openObjectId. Then save the
document and regenerate. When you click in the generated file, the referenced
document will be displayed using the command specified in the
HypertextLinks flow on the referenced document’s reference page, rather
than using the command in the ActiveTOC or ActiveIX paragraph in the
generated file.

To incorporate generated files into an online system
If you’re simply using the generated hypertext document as a debugging tool,
the document is ready to use. If, however, the generated file is going to be part
of a hypertext online system, there are some things you may want to do to
enhance its usability.
■

Set up links from the referenced documents back to the generated file.

Use any of the hypertext commands. For example, you can create an Index or
Table of Contents button that jumps back to the generated file.
■

Add active areas to the master pages of documents for navigating through the online
system.

For example, you can create buttons for paging forward and backward.
■

Add links to other parts of the online system in the source documents and in
generated files.

■

Change the generated file to View Only format and distribute the online documents.

WORKING IN VIEW-ONLY DOCUMENTS
When you create an online system, you may need to tell your readers how to use
it, especially if they’re not experienced FrameMaker users. For example, you
may need to tell them how to navigate through your system or how to open
more than one document window.
You distribute online documents in View Only format. Readers can view, but
not edit, a view-only document.
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To chang e a document to View Only format
When you finish preparing a hypertext document, change the document to View
Only format. This locks the document so readers won’t be able to make any
changes to it. If you need to edit a view-only document, you must first change it
back to a Normal-format document. For tips on the things you should do before
making a document view-only, see “View-only guidelines” on page 27-33.
■

To save a document in View Only format, choose Save As from the File menu, choose
View Only from the Format menu in the Save As dialog box, and click Save.

■

To change a document to View Only format without saving it, press
Esc F l (lowercase L) k.

■

To change a view-only document to Normal format, press Esc F l (lowercase L) k.
VIEW-ONLY GUIDELINES

Readers will see the contents of a view-only document exactly as it appeared
when you made it view-only. Before changing a document to View Only format,
use the View menu to turn off the display of the grid, the ruler, text symbols,
and borders.
If the document will be used across a network, set the file permissions so that
readers don’t have write permission to the document. This prevents readers
from making changes to the document should they change it to Normal format.
MAKING BOOK FILES VIEW-ONLY

You can’t save a book file in View Only format. However, if a reader opens a
book file from FrameReader or FrameViewer, it will automatically open in View
Only format.
HIGHLIGHTED MARKERS IN VIEW-ONLY DOCUMENTS

When you click an active area in a view-only document, FrameMaker doesn’t
highlight the corresponding cross-reference marker or hypertext marker that
contains the corresponding newlink command. (If the document is in Normal
format, the marker does highlight.) To highlight the marker in a view-only
document, set the value of the document’s DViewOnlySelect MIF statement
to Yes. For more information, see the online manual MIF Reference.
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To navigate to specific pages
Readers can display pages in view-only documents in a variety of ways. If
you’ve customized your view-only window environment, some viewing methods
may not be available.
■

Click any active area.

■

Click the page buttons in the window border.

If you customized your view-only window environment, the page buttons may
not be available.
■

Use the scroll bar.

■

Use the commands on the Navigation menu.

■

Use the Viewer menu.

Point inside the view-only document window and hold down the right mouse
button. FrameMaker displays the Viewer menu, from which you can choose
where you want to jump.

To go backward and forward in the stack
The reader can jump back to previous locations in the stack and then jump
forward again. For information on the hypertext command stack, see “To create
a way to retrace steps” on page 27-16.
■

To jump backward in the stack, click an active area with a previouslink or
previouslinkfitwin command, or choose Go Back from the Navigation menu.

■

To jump forward in the stack, press Esc v N.

You can jump forward in the stack only if you have previously jumped
backward.
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To open a new window
If you use a gotolink command to display a referenced document in the
current window, the reader can force FrameMaker to open a new window
instead.
■

Shift-click an active area to open a new window for displaying the referenced
document.

To use menu commands
Some FrameMaker commands are available in view-only documents. For
example, you can copy text and graphics from a view-only document and paste
them in a Normal-format document, search for text and paragraph tags, and
print.
View-only document windows have three FrameMaker menus: File, Edit, and
Navigation. If you customized your view-only window environment, some
commands may not be available. For information on disabling commands, see
the online manual MIF Reference.
In order to use some menu commands, you have to place an insertion point.
Other menu commands, such as Copy, require that you select items.
■

To place the insertion point or to select an object in a view-only document,
Control-click.

Control-clicking in a view-only document is the same as clicking in a Normalformat document.

Coffee is consumed, either hot or cold,
by nearly one-third of the earth’s
inhabitants. This popular beverage is
brewed from the roasted and ground
seeds of the tropical evergreen coffee

The insertion point looks
different in a view-only
document.

■

To select in a view-only document, Control-drag.

Control-dragging in a view-only document is the same as dragging in a Normalformat document.
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CONVERTING FRAMEMAKER FILES TO ADOBE
ACROBAT FILES
You can convert a FrameMaker document or book file to an Adobe Acrobat
document, distribute it in that form, and use Acrobat Exchange or Acrobat
Reader to view it. If the FrameMaker document (or the set of FrameMaker
documents listed in the FrameMaker book file) has cross-references or
hypertext commands, FrameMaker converts them to the corresponding Acrobat
links when you print from FrameMaker to a PostScript file. FrameMaker
hypertext alert messages are converted to Acrobat notes. FrameMaker also
supports Acrobat bookmarks and article threads.
Adobe Acrobat documents use the Portable Document Format (PDF). You
prepare a FrameMaker document for conversion by printing it to a PostScript
file, and use the Adobe Acrobat Distiller application to convert the PostScript
file to a PDF file. For more information on Acrobat Distiller, Acrobat Exchange,
or Acrobat Reader, see the Adobe documentation for those applications.
For a list of items to consider when preparing to create PDF files, see
“Considerations and limitations” on page 27-38.

To prepare a document for conversion
As a first step in producing a PDF file for an Acrobat document, you create a
PostScript file. For a FrameMaker document, you print the entire document as
a single PostScript file. For a FrameMaker book file, you print the documents
listed in the book file as a single PostScript file or as a set of PostScript files. In
either case, you print both odd- and even-numbered pages in front-to-back
order, without separations, and without skipping blank pages. As part of the
process, you specify the paragraphs that will appear as bookmarks for the
Acrobat document, and specify their hierarchy.
For information on printing a FrameMaker document as a PostScript file and
other printing settings, see “To customize printing” on page 2-39. For
information on printing files from a book, see “To print files” on page 24-24.
1

Choose Print from the File menu.

If you’re printing a book file, move the desired files to the Print scroll list in the
Print Files in Book dialog box and click Print.
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In the Print dialog box, turn on Generate Acrobat Data.

3

Click Acrobat Setup.
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Move paragraph tags between scroll lists as necessary.

Bookmarks appear for
paragraphs with tags
included in this list...
...in levels shown by these
indents.
Set the level of the included
paragraph here.

The paragraphs in the Include Paragraphs scroll list will have bookmarks
in the PDF file. FrameMaker uses the paragraph formatting of the document
to determine default settings—which tags initially appear in which of the
two lists.
To move a tag between scroll lists, select the tag and click an arrow, or
double-click the tag. To move all the tags from one scroll list to the other,
Shift-click an arrow.
To return the scroll lists to the default settings, click Get Defaults.
5

Change bookmark levels for the included paragraphs as necessary.

The hierarchy of the bookmarks in the PDF file will reflect the indentation
levels of the paragraphs in the Include scroll list. FrameMaker uses the
paragraph formatting of the document to determine default indents. To move
the level of an item, select it and click a Bookmark Level arrow. To change the
level of all items, Shift-click a Bookmark Level arrow. If the indent for a tag
exceeds six levels, n> precedes the paragraph tag, where n is the indentation
level of the paragraph tag. The maximum level for a bookmark is 50.
Only first-level bookmarks will be visible when the PDF file is first displayed.
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6

Click Set.

7

In the Print dialog box, turn on Print Only to File and type a pathname and filename in
the text box.

To ensure that links to other PDF files will work, don’t change the default
filename for the PostScript file for a document.
If you’re creating a PostScript file for a book, you can improve the performance
of the resulting PDF file by creating a separate PostScript file (and thus a
separate PDF file) for each file in the book, rather than a single PostScript file
for the entire book. To do so, type an asterisk (*) for the filename in the Print
Only to File text box. FrameMaker creates a PostScript file for each file in the
book at the pathname specified. For information on the advantages of creating a
separate PostScript file for each file in a book, see “Considerations and
limitations” on page 27-38.
If your documents will be used on several platforms, make sure the filenames
for your FrameMaker documents are valid on all the platforms. For information

CONSIDERATIONS AND LIMITATIONS
There are a few items to bear in mind before
converting a FrameMaker document to an Acrobat
document.
Some Acrobat 2.0 features aren’t
available with converted FrameMaker documents.

Acrobat 2.0

• Article threads always follow a document’s page
order, even if the FrameMaker document’s text
flows from back to front.
• If the PDF file for a book file was created from a
single PostScript file, you can’t link from an
external document into the book file. To permit
links from external documents to documents
within a book, print the book as separate
PostScript files, either by printing the files
individually or by printing them as a book file and
specifying an asterisk (*) for the book file’s
PostScript filename. Creating separate PostScript
files for large book files can also improve display
performance of the resulting PDF files.
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Some Acrobat 2.0 features aren’t
available if you create a PDF file from a
FrameMaker document with version 1.0 of the
Distiller or view it with version 1.0 of the Reader
or Exchange application. For example, links to
external files, the display of files containing pages
in both landscape and portrait orientation, and
article threads will not work.

Acrobat 1.0

Graphics For optimal display of bitmap graphics,
import them into the FrameMaker document at a
dpi value that divides evenly into the resolution of
the intended display device. For more information,
see “Suggested scaling options” on page 16-8. To
improve the display performance of PDF files,
avoid using complex master pages that contain
multiple complex graphics.
Filenames Don’t change the default filename when
printing to a PostScript file. Altering the filename
disables links to and from the other files.
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on file-naming requirements on different platforms, see the online manual
Using Frame Products on Multiple Platforms.
8

Click Print.

FrameMaker creates one or more PostScript files. Use the Acrobat Distiller
application to convert the PostScript files to PDF files. After using the Distiller
application, the name of the PDF file it creates should be identical to the
original FrameMaker file except for the .pdf extension.
TEXT FLOW TAGS AND ARTICLE THREAD NAMES

Each tagged text flow that appears on a body page of a FrameMaker file
becomes a thread in the PDF file after conversion. The name of the thread in
the PDF file is the same as the flow tag in the FrameMaker file.
PARAGRAPHS AND LEVELS INCLUDED BY DEFAULT

FrameMaker uses the paragraph format settings of the document to determine
which paragraph tags appear in the Include Paragraphs scroll list and how they
are indented. For example, a paragraph that starts at the top of a column may
appear in the Include scroll list with no indent (to create a top level bookmark),
a paragraph that straddles columns may appear indented one level, an
autonumbered paragraph may appear indented two levels, and so on.
CHECKING BOOKMARK SETUP

You can check the assigned levels of bookmarks in the draft of a PDF file by
including paragraph tags along with the paragraph text in the bookmarks. To
do so, turn on Include Paragraph Tags in Bookmark Text in the Acrobat Setup
dialog box. Turn this option off when you print the final draft of the document.
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HYPERTEXT COMMANDS
This list summarizes the hypertext commands.
Each command and its syntax are described in
detail in “Using specific hypertext commands” on
page 27-11.
alert Displays an alert box.
alerttitle Displays an alert box with a userdefined title.
exit Exits the FrameMaker application.
gotolink Displays the location in the current or
a different document that contains a corresponding
newlink command. The page is displayed in the
current window.
gotolink firstpage Displays the first page of
the current or a different document.
gotolink lastpage Displays the last page of
the current or a different document.
gotolinkfitwin Executes a gotolink
command and then resizes the window to fit the
document page displayed.
gotopage Displays a specific page in the current
or a different document. The page is displayed in
the current window.
matrix Allows the reader to choose from matrix
items that activate hypertext commands.
message Sends a message to another application
that is already running.
message system Executes a UNIX shell
command.

newlink Marks the location that will be
displayed when either the gotolink or the
openlink command is activated.
nextpage
document.

Displays the next page of the current

openlink Displays the page in the current or a
different document that contains a corresponding
newlink command. The page is displayed in a
new window, leaving the current window open.
openlinkfitwin Executes an openlink
command and then resizes the new window to fit
the document page displayed.
opennew Opens a different document as a new,
unnamed document. The document is displayed in
a new window, leaving the current window open.
openpage Displays a specific page in the current
or a different document. The page is displayed in a
new window, leaving the current window open.
popup Displays a pop-up menu of items, each
containing a hypertext command.
previouslink
reader viewed.

Displays the last location the

previouslinkfitwin Executes a
previouslink command and then resizes the
window to fit the document page displayed.
previouspage Displays the previous page of the
current document.
quit Removes the current window from the
screen.
quitall Removes all view-only windows from
the screen.
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FrameMaker provides a full palette of math elements to streamline the
creation of typeset equations. You create an equation by inserting an
equation object of a particular font size in a document and then
inserting the math elements—numbers, symbols, operators, and so
on—in the object.

You start with an equation object
When you create an equation, you choose a font size—Small, Medium,
or Large. FrameMaker inserts the new equation object in an anchored
frame, and you work with the equation there.

A circle whose center is at the origin and whose radius is r is
represented by the equation .¶
Anchored frame
New equation object

?

You use a palette to insert math elements
The Equations palette contains the commands you use to create and
change equations, as well as the symbols, operators, functions, and
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other math elements you insert in equations. As you insert and edit
elements, the equation’s mathematical syntax adjusts automatically.

The pop-up menu appears
on every page.

The names of the
pages appear
here, with the
current page
highlighted.

This part of the palette
changes from page to
page.

If the Equations palette doesn’t include a math element you need, you
can create your own. If FrameMaker displays an element in a form that
doesn’t match what you want, you can change the element’s definition.
When you finish the equation, you shrinkwrap it in the anchored frame
so it takes up as little space as possible.

A circle whose center is at the origin and whose radius is r is
represented by the equation x 2 + y 2 = r 2 .¶
Shrinkwrapped equations

If the center is located at (a,b) instead of at (0,0), the circle is
represented by the equation below.¶
( x – a )2 + ( y – b )2 = r 2 ¶

EQ 20

You can format and evaluate equations
After you create equations, you can change their format—their fonts,
their alignment, and the exact positioning of their math elements and
the amount of white space around them. Or you can use commands on
the Equations palette to evaluate the equation mathematically.

In this chapter
This chapter shows you how to create an equation object and then
insert and edit math elements in the equation. It also shows you how to
create custom math elements and change the definition of built-in
elements. Chapters 29 and 30 show you how to format equations and
how to evaluate them mathematically.
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You can put an equation in line with paragraph text or on display in a
paragraph of its own. Either way, FrameMaker creates an anchored graphic
frame for the equation.
You can also position an equation with other objects in an existing graphic
frame, anchored or unanchored.

Suppose that the axes of an ellipse lie along the lines x = x 0 and
In line

y = y 0. The ellipse is represented by the following equation.
( x – x0 ) 2 ( y – y0 ) 2
--------------------- + --------------------- = 1
a2
b2

Display

EQ 21

For example, the ellipse shown below has axes of x = 2 and y = 4.
Its horizontal axis is 8 units long. Its vertical axis is 6 units long.
In a graphic frame with
other objects

( x – 2 )2 ( y – 4 )2
------------------- + ------------------- = 1
16
9

To create an equation, you first insert an equation object in the document and
then insert math elements in the equation. While this section describes how to
create equations, it doesn’t provide detailed instructions on inserting math
elements. For that information, see “Inserting math elements in an equation”
on page 28-8.
When working with an equation, zoom in until the characters in the equation
are easy to read.

To create an in-line equation
An in-line equation appears in line with paragraph text.
1

Click in text where you want to insert the equation.

If the text is in a rotated text frame, unrotate it first by pressing Esc g 0 (zero).
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at the right side of the document window.

You can also choose Equations from the Special menu to display the Equations
palette.
3

On the Equations palette, choose one of the New Equation commands from the
Equations pop-up menu.

Small, Medium, or Large specifies the font sizes used in the new equation.
A new equation object appears as a question mark in an anchored frame below
the line with the insertion point. The first math element you insert replaces the
question mark prompt.

4

Insert the math elements in the equation.

Type them or click items on the Equations palette. For details, see “Inserting
math elements in an equation” on page 28-8.
5

Choose Shrink-Wrap Equation from the Equations pop-up menu.

This shrinks the frame around the equation and puts the equation on the line of
text at the anchor symbol.

6

If the equation seems too close to the text on either side, insert a space before or after
the frame.

FrameMaker treats the frame that contains an in-line equation as a character
and doesn’t provide any extra space around it.
7

To close the Equations palette, point in it and press Control-x Control-c.
IF THE EQUATION IS TOO TALL FOR THE LINE

To open up more space above or below the equation, turn off fixed line spacing
using the Line Spacing pop-up menu on the formatting bar. For details, see “To
specify custom line spacing” on page 4-19.
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To create a display equation
A display equation appears in a paragraph of its own.
1

Click in an empty paragraph.

If you need to add a new empty paragraph, press Return at the end of the
paragraph above where you want the equation.
2

Choose an existing paragraph format from the Paragraph Format pop-up menu in the
formatting bar or set up your own format.

The paragraph format determines the alignment (left, right, or center), vertical
spacing, and any autonumber for the paragraph that contains the equation.
If you created the document from a FrameMaker book or report template, use
the format named Equation.
3

Click the Equations button

at the right side of the document window.

You can also choose Equations from the Special menu to display the Equations
palette.
4

On the Equations palette, choose one of the New Equation commands from the
Equations pop-up menu.

Small, Medium, or Large specifies the font sizes used in the new equation.
A new equation object appears as a question mark in an anchored frame below
the empty paragraph. The first math element you insert replaces the question
mark prompt.
.

5

Insert the math elements in the equation.

Type them or click items on the Equations palette. For details, see “Inserting
math elements in an equation” on page 28-8.

28-6

Using FrameMaker

Creating equations

6

.....

CREATING EQUATIONS

Choose Shrink-Wrap Equation from the Equations pop-up menu.

This shrinks the frame around the equation and puts the equation in the empty
paragraph.

7

To close the Equations palette, point in it and press Control-x Control-c.

To create an equation in a graphic frame with other objects
You may want to use an equation to annotate a graphic in a graphic frame or to
put more than one equation in a graphic frame. The graphic frames that
contain equations can be either anchored or unanchored.
1

Click the Equations button

at the right side of the document window.

You can also choose Equations from the Special menu to display the Equations
palette.
2

Select a graphic frame or an object in a graphic frame.

If you select a frame, the equation will appear centered in it.
If you select an object, the equation will appear centered in the frame that
contains the object.
3

On the Equations palette, choose one of the New Equation commands from the
Equations pop-up menu.

Small, Medium, or Large specifies the font sizes used in the new equation.
A new equation object appears as a question mark inside the frame. The first
math element you insert replaces the question mark prompt.
.
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4

Insert the math elements in the equation.

Type them or click items on the Equations palette. For details, see “Inserting
math elements in an equation” on page 28-8.
5

To close the Equations palette, point in it and press Control-x Control-c.
PLACING THE EQUATION EXACTLY WHERE YOU WANT IT

You move the equation as you do any object: Control-click the equation to select
it and then drag it. You can also position it precisely with the arrow keys or
with the Object Properties command on the Graphics menu. For details, see “To
move an object” on page 14-4 and “To specify the exact position of an object” on
page 14-5.

INSERTING MATH ELEMENTS IN AN EQUATION
An equation contains expressions made up of math elements—alphanumeric
characters, operators and other mathematical elements from the Equations
palette, and strings.
Alphanumeric characters

String

(x –
Operators

a )2

+ (y –

b )2

=

Radius 2
Expression

After you create an equation object, you insert math elements in it by typing
them or by clicking items on the Equations palette. For details on creating
equations, see “Creating equations” on page 28-4. For a description of the math
elements on the Equations palette, see “The Equations palette” on page 28-9.
If the element you’re typing needs an operand, a question mark prompt ( ? )
appears; otherwise an insertion point appears.
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When you insert a math element in an equation, FrameMaker adjusts the
mathematical syntax. The result depends upon the scope of operation—the
selection or the location of the insertion point. For example, when you insert x
in a fraction, the result depends on whether the numerator, the denominator, or
the entire fraction is selected.
If you multiply by x
The result is
Explanation
..........................................................................

Only the 7 is multiplied by x.

or

FrameMaker adds parentheses to show
that the entire expression 2y + 7 is
multiplied by x.
The entire fraction is multiplied by x.

or

Notice that the size of the insertion point in the first and last examples above
indicates the scope.
Most mistakes in equations result from an incorrect scope of operation—having
too little or too much selected when inserting an element. Be careful to select
the range you want before inserting an element.

THE EQUATIONS PALETTE
The Equations palette has nine pages of math
elements and commands. To display a page, click
its name at the top of the palette.
Greek characters, atomic symbols,
diacritical marks, and strings

Symbols

Roots, powers, signs, subscripts,
superscripts, and logic symbols
Operators

Large Sums, products, integrals, intersections,
and unions
Delimiters Parentheses, brackets, braces, and
substitution

Equal, less than, greater than, similar
to, subset of, superset of, and proportional to

Relations

Integrals, derivatives, partial
derivatives, gradients, and limits

Calculus

Matrices

Matrices and matrix commands

Functions Trigonometric, hyperbolic, and
logarithmic functions; commands for evaluating
expressions; and commands for creating and
applying rules
Positioning Controls to adjust the position of an
expression and the spacing around it; commands to
specify alignment; and commands to set and clear
manual line breaks

Using FrameMaker
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To insert a math element from the keyboard
You insert alphanumeric characters (the letters of the alphabet and the digits 0
through 9) from the keyboard. You can also insert every item on the Equations
palette from the keyboard.
The Equations palette doesn’t have to be open when you insert an item from the
keyboard.
■

To insert an alphanumeric character, type it.

■

To insert a symbol that appears on the keyboard, type it.

You can type parentheses, brackets, plus signs, equal signs, and so on. If you
type an open parenthesis, FrameMaker inserts the closing parenthesis.
■

To insert an element by typing a backslash sequence, type a backslash (\) and the
string that identifies the element and then press Return.

For example, to insert the symbol for infinity ( ∞ ), type \infty and press
Return. For information on the backslash sequences, see the shortcuts in
FrameMaker online Help.
When you insert a built-in function such as sin, you don’t need to type the
backslash.
■

To insert an element using a shortcut, press the sequence of keys.

For information on the shortcuts, see FrameMaker online Help.

To insert a string
A string is a series of characters that FrameMaker interprets as a unit.

one electron volt = 1.60 × 10 –19 joule
Strings

Unlike characters that make up an expression, the characters in a string do not
usually appear in italics and are not multiplied together.
1

Click Start String on the Symbols page.

You can also type an apostrophe (') or a double quotation mark (") to start the
string.
Two double quotation marks ("") appear.
2

Type the text of the string.

The quotation marks disappear, and the text appears as you type.
3

Click End String on the Symbols page.

You can also press Return to end the string.
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USING EVALUATION COMMANDS WITH STRINGS

Strings have no mathematical meaning in FrameMaker. For example,
evaluation commands can evaluate the function tan but not the string “tan”.
TO INSERT A STRAIGHT APOSTROPHE OR DOUBLE-QUOTE IN A STRING

To insert a straight apostrophe or straight double-quote in a string in an
equation, hold down the Control key while pressing the appropriate key or keys.

To insert a horizontal or vertical list of expressions
An equation object usually contains one equation or expression. But you can set
up a horizontal or vertical list in which several expressions are all in the same
object. An equation object can contain just a list of expressions, or the list can be
part of a larger expression.

2xy

Horizontal list

3ab

y = ( x – 3 )2
Vertical list aligned on
equal signs

= x 2 – 6x + 9
FrameMaker aligns the expressions in the list automatically. When you move
the list, all the expressions maintain their relative positions. For information on
changing the alignment of items in a list of expressions, see “To align items in a
vertical list or multiline equation” on page 29-9.
When you select a list, all the expressions in the list are selected as one object.
1

Select the expression you want to be the first item in the list.

2

Click the horizontal list element
Operators page.

or vertical list element

on the

A horizontal or vertical list appears. The selected expression is the first item in
the list. A second item appears in the list as a question mark prompt.
Before clicking
After clicking
Explanation
............................................................

Horizontal list
Vertical list
Vertical list as part of a
larger expression

Using FrameMaker
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When more than one question mark prompt appears, press Tab to move from
one prompt to another.
ADDING AN ITEM TO A HORIZONTAL OR VERTICAL LIST

To add an item to a horizontal or vertical list, select one of the items in the list
and click the horizontal list element
or vertical list element
on the
Operators page.

To insert a symbol
The Symbols page on the Equations palette contains the Greek alphabet, other
symbols, and diacritical marks.

Greek letters
Diacritical
marks

Other symbols

The Symbols page doesn’t include Greek letters that have Roman-alphabet
equivalents, such as the uppercase alpha (A).
1

Select an expression or put the insertion point in an equation.

2

Click an element on the Symbols page.

Click the dot or prime button once for each dot or prime diacritical mark you
want to insert.
Greek letters and atomic symbols appear at the insertion point or question
mark prompt or are multiplied by the selection. Diacritical marks appear on the
element to the left of the insertion point or on the selected expression.
Before clicking
After clicking
..........................................................................
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SUMMATION AND PARTIAL DIFFERENTIAL SYMBOLS

For a summation, product, or partial differential element that FrameMaker can
interpret and manipulate mathematically, insert the elements from the Large
page and Calculus page rather than from the Symbols page, because elements
from the Symbols page are not evaluated.

To insert an operator
The Operators page on the Equations palette contains commonly used
operators—addition, subtraction, multiplication, and division—as well as roots,
powers, signs, subscripts, superscripts, and logic symbols.

1

Select an expression or put the insertion point in an equation.

2

Click an element on the Operators page.
Before clicking
After clicking
..........................................................................

When more than one question mark prompt appears, press Tab to move from
one prompt to another.
DIVISION OPERATORS

FrameMaker creates a fraction when you insert a horizontal or vertical division
sign. If you make a selection first, the selection becomes the numerator.
Before clicking
After clicking
..........................................................................
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You change the division operator to a slash (/), a horizontal bar (–), or a division
symbol ( ÷ ) by using Toggle Format on the Operators page. For details, see “To
toggle an element’s format” on page 28-25.
EXPONENTS AND SUPERSCRIPTS

FrameMaker can evaluate exponents, but not superscripts, mathematically.

Superscript
Exponent

To insert a large element
The Large page on the Equations palette contains sums, products, integrals,
intersections, and unions.

1

Select an expression or put the insertion point in an equation.

2

Click an element on the Large page.

FrameMaker places the element at the insertion point or applies it to the
selection.
Before clicking
After clicking
..........................................................................

When more than one question mark prompt appears, press Tab to move from
one prompt to another.
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ADDING OPERANDS

You can add an operand after inserting a math element on the Large page. For
details, see “To add an operand to an element” on page 28-19.

To insert a delimiter
The Delimiters page contains delimiters such as parentheses, brackets, and
braces.

1

Select an expression, or put the insertion point in an equation.

2

Click an element on the Delimiters page.

FrameMaker places delimiters at the insertion point or around the selection.
Before clicking
After clicking
..........................................................................

When more than one question mark prompt appears, press Tab to move from
one prompt to another.
TOGGLING THE FORMAT OF PARENTHESES

You can also represent parentheses as brackets ([ and ]) or braces ({ and }). For
details, see “To toggle an element’s format” on page 28-25.

Using FrameMaker
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To insert a relation
The Relations page contains relation symbols such as =, <, >, ≈, ≡, ∈, ⊃, and ⊂.

1

Select an expression or put the insertion point in an equation.

2

Click an element on the Relations page.

All relation symbols—except the binary equal sign
—apply to the
character to the left or right of the insertion point or to the selection. When you
insert a relation symbol between multiplied elements, it applies to the elements
on either side of the insertion point.
Before clicking
After clicking
..........................................................................

When more than one question mark prompt appears, press Tab to move from
one prompt to another.
EQUAL SIGNS

Binary equal signs
appear to the right of the current expression. When
the insertion point or selection is in a subscript or superscript, the equal sign
appears in the subscript or superscript.
Before clicking
After clicking
..........................................................................
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To insert a binary equal sign at the insertion point rather than to the right of
the expression, press Esc m =.
Before
After
..........................................................................

To insert a calculus element
The Calculus page contains integrals, derivatives, partial derivatives,
gradients, and limits.

1

Select an expression or put the insertion point in an equation.

2

Click an element on the Calculus page.

FrameMaker places a calculus symbol at the insertion point or applies it to the
selection.
Before clicking
After clicking
..........................................................................

When more than one question mark prompt appears, press Tab to move from
one prompt to another.
CHANGING THE POSITION OF OPERANDS IN AN INTEGRAL

To change the position of operands, use the Toggle Format button. For details,
see “To toggle an element’s format” on page 28-25.

Using FrameMaker
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To insert a matrix
The Matrices page contains elements for matrices ranging in size from 1 by 1 to
3 by 3. After creating a matrix, you can add rows and columns. For details, see
“To change a matrix” on page 28-26.

1

Select an expression or put the insertion point in an equation.

2

Click an element on the Matrices page.

FrameMaker places a matrix at the insertion point or selection. When an
expression is selected, it becomes the first cell in the matrix.
Before clicking
After clicking
..........................................................................

When more than one question mark prompt appears, press Tab to move from
one prompt to another.

To insert a function
The Functions page contains trigonometric, hyperbolic, and logarithmic
functions and also the sgn, limit, and general functions.

General function
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2

Click an element on the Functions page.
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FrameMaker places functions at the insertion point or at the selection. When
an expression is selected, the expression becomes the argument of the function
(except for the limit and general functions).
Before clicking
After clicking
..........................................................................

When more than one question mark prompt appears, press Tab to move from
one prompt to another.

To add an operand to an element
Radical symbols, gradient symbols, and logarithms can have one or two
operands. Integrals and other symbols on the Large and Calculus pages can
have one, two, or three operands.
3

x = y–1

2

Operands

∫ 3x 2 dx
0

You can add operands to these elements without starting over.
1

Click or select anywhere in the expression with the element.

2

Click Add Operand on the Large or Calculus page.

A question mark prompt appears where the new operand will go.

Using FrameMaker
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3

Click on the Equations palette or type to insert the operand.

To insert a custom math element
You can insert custom math elements that have been defined for a document.
For example, you may want to use additional operators that aren’t built into
FrameMaker. For details on defining custom math elements, see “Creating and
changing math element definitions” on page 28-27.
1

On the Equations palette, choose Insert Math Element from the Equations
pop-up menu.

2

In the Insert Math Element dialog box, select the element name and click Insert.
USING EVALUATION COMMANDS WITH CUSTOM MATH ELEMENTS

Custom math elements have no mathematical meaning in FrameMaker. For
example, a custom math element for an operator will be treated as an operator
in an equation, but FrameMaker will not be able to evaluate it.

EDITING EQUATIONS
You can edit an equation as you edit text—adding, changing, and removing
math elements, and cutting, copying, and pasting them. And you can remove
extra delimiters and rearrange elements. As you edit an equation, FrameMaker
adjusts the syntax of the equation as necessary.
You can change a matrix—add or delete rows and columns, delete brackets, and
change row height and column width.
You can also choose among several representations for some math elements
such as parentheses, and you can add operands to others such as integrals and
summations.
If your equation is shrinkwrapped, unwrap the equation before editing it. This
makes the anchored frame full-sized again, giving you more room to work.
If you decide not to keep a change, you can undo it just as you would undo a text
change—by using Undo on the Edit menu.
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To shrinkwrap an equation
Shrinkwrapping an equation shrinks the surrounding anchored frame so that
it’s just large enough for the equation and puts the frame at the insertion point.

A circle whose center is at the origin and whose radius is r is
represented by the equation .¶

Before shrinkwrapping

x2 + y2 = r 2

A circle whose center is at the origin and whose radius is r is
represented by the equation x 2 + y 2 = r 2 .¶

After shrinkwrapping

Shrinkwrap an equation when you finish working with it so that the equation
doesn’t take up any more space than it needs and so that it aligns with the
baseline of the surrounding text.
1

Click in the equation or select its frame.

2

On the Equations palette, choose Shrink-Wrap Equation from the Equations
pop-up menu.

FrameMaker resizes the frame, positions it at the anchor symbol, and puts the
insertion point after the frame.
The edges of a shrinkwrapped equation may not appear on the screen, but they
will appear in the printed document.
UNWRAPPING AN EQUATION

You unwrap an equation to enlarge the anchored frame for easier editing. Click
in the equation or select its frame, and choose Unwrap from the Equations
pop-up menu on the Equations palette. FrameMaker enlarges the frame, places
it below the current line, and puts the insertion point in the equation.

Using FrameMaker
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To place and move the insertion point
You need to put the insertion point in an equation before editing it.
■

To put the insertion point next to a specific character, click as close as possible to the
character.

■

To put the insertion point next to an entire equation, click at the far right end of the
equation.

Notice that the size of the insertion point varies depending on its location in the
equation. This helps you determine whether the insertion point is in the right
place.
■

To move the insertion point, use the arrow keys.
Direction
Key to press
..........................................................................

Right

Right arrow

Left

Left arrow

From beside a fraction to its numerator

Down arrow

To select part of an equation
When you insert an element, the selection defines the scope of operation for the
element. At other times, the selection identifies the part of an equation you
want to edit, format, or evaluate.
As you select elements in an equation, FrameMaker interprets the elements
mathematically. In b 2 – 4ac , for example, FrameMaker interprets b 2 and
– 4ac as expressions. The expression – 4ac is made up of subexpressions.
You can select any subexpression or expression in an equation.
■

To select part of an equation using the mouse, drag through the elements you want to
include.

Selecting in an equation is similar to selecting text elsewhere in FrameMaker.
However, as you drag, notice that the selection jumps to include the next
subexpression.
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To extend the selection using the keyboard, press the space bar.

The selection expands to include the next higher expression.

If you start with the a
selected…

…pressing the space bar
once extends the selection
to include the 2…

…and pressing the space
bar twice includes the next
higher expression.

In the example, pressing the space bar a third time selects the entire equation.
■

To change the selection, use the arrow and Tab keys.
Direction
Key to press
..........................................................................

Right to the next subexpression

Right arrow

Left to the next subexpression

Left arrow

Right to the next question mark prompt

Tab

To replace an element
You can replace an element or an entire expression.
1

Select what you want to replace.

2

Press Delete.

The element is removed, and a question mark prompt appears.

3

Click on the Equations palette or type to insert the replacement.

The new element replaces the prompt.

Using FrameMaker
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To delete an element
You can delete one element at a time or an entire expression at once.
1

Select what you want to delete.

2

Press Delete.

The element is removed, and a question mark prompt appears.

3

Press Delete again.

The prompt disappears. FrameMaker also removes any elements that are no
longer necessary—for example, the plus sign in the example.

DELETING AN ENTIRE EQUATION

To delete an equation object from the graphic frame that contains it, select the
equation (Control-click) and press Delete.
To delete the graphic frame along with the equation, select the frame and press
Delete.

To cut, copy, and paste an element
You can cut or copy an element or expression to the FrameMaker Clipboard and
then paste it in another part of an equation. You cut and paste an expression to
move it somewhere else and copy and paste it to put a copy of it somewhere else.
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Select what you want to cut or copy.

2

Choose Cut or Copy from the Edit menu.

3

Click to place an insertion point or select an expression you want to replace.
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Choose Paste from the Edit menu.

The element on the Clipboard appears at the insertion point, is applied to the
selection, or replaces the question mark prompt.

To remove parentheses
After entering or editing an equation, you can sometimes end up with extra
delimiters—either because you inserted too many or because FrameMaker
inserted ones you didn’t want. You can remove extra delimiters from an
equation. But if you later use evaluation commands, FrameMaker evaluates
the equation as if the delimiters were still present.
■

To remove all parentheses, braces, or brackets in an expression, select the expression
and click Remove Parentheses on the Delimiters page.
Before clicking
After clicking
..........................................................................

■

To remove one delimiter, place the insertion point to the right of the delimiter and
press Delete.

FrameMaker removes the delimiter. If the delimiter has a mate, such as the left
parenthesis between a and b in the example, the mate is also removed.
Before
After
..........................................................................

To toggle an element’s format
Some math elements can be represented in more than one way.
For example, parentheses can appear as ( x ) , [ x ] , or { x } . Division can appear as

x
x ÷ y, x ⁄ y, or -- .
y
You can switch from one format to another without starting over.
1

Select the entire element.

Using FrameMaker
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2

Click Toggle Format on the Operators, Large, Delimiters, or Calculus page.

The command is the same on all four pages and operates on any element
with multiple formats. You might need to click more than once for the format
you want.

To chang e a matrix
You can change the number of rows or columns in a matrix and add or remove
brackets around it.
You can also allow the width to vary from column to column, depending on the
column’s contents, or specify that all columns be of equal width.
Similarly, you can allow the height to vary from row to row.
■

To add a row or column to a matrix, put the insertion point in the matrix and then
choose Add Row or Add Column from the Matrix Commands pop-up menu on the
Matrices page.
Before Add Column
After Add Column
..........................................................................

Add Row puts a new row at the bottom. Add Column puts a new column at the
far right.
■

To delete a row or column from a matrix, select the row or column and press Delete.
Before
After
..........................................................................

■
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To change the row height or column width in a matrix, select the matrix and choose
All Equal or Proportional from the Matrix Row Height or Matrix Column Width pop-up
menu on the Matrices page.

Proportional column widths

Equal column widths

If you choose Proportional, each row will be tall enough to hold the tallest cell in
the row. Each column will be wide enough to hold the widest cell in the column.
If you choose All Equal, each row will be tall enough to hold the tallest cell in
the entire matrix. Each column will be wide enough to hold the widest cell in
the entire matrix.
PERFORMING MATRIX OPERATIONS

For instructions on transposing a matrix or performing matrix algebra, see
“Matrix Commands pop-up menu” on page 30-4.

CREATING AND CHANGING MATH ELEMENT
DEFINITIONS
If you need a math element that doesn’t appear on the Equations palette, you
can create a custom element of your own. If you want to display an element on
the palette—a built-in element—differently in your document, you can redefine
the element.
a ✱ b = sin–1 x
Custom math element

Built-in element, redefined

You can also update all the math element definitions from another document.
For details, see “Importing formats into a document” on page 21-12.
Custom math element definitions are stored on a special FrameMath reference
page. (The page’s name begins with FrameMath.) Each definition is a text line
in an unanchored graphic frame whose name is the element name.
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To define a math element
You can define a custom math element for a document when you need an
element that doesn’t appear on the Equations palette—for example, a new
operator (✱). However, FrameMaker won’t be able to evaluate custom math
elements mathematically.
You can also redefine how a built-in math element appears. For example, you
may want to redefine the built-in inverse sine function (asin) so it appears as
sin–1. While you can redefine the appearance of a built-in element, you can’t
change its behavior—its type. For a description of math element types, see
“Math element types” on page 28-30.
1

Display a FrameMath reference page.

Choose Reference Pages from the View menu. Then display a FrameMath
reference page.
If there’s no FrameMath reference page in the document, display a reference
page and then choose Add Reference Page from the Special menu. Name the
new page FrameMath1. (Capitalize the letters F and M as shown.)
2

Draw an unanchored graphic frame on the page.

Use the Graphic Frame tool on the Tools palette. For details, see “To draw an
unanchored graphic frame” on page 13-14.
3

In the Frame Name dialog box, type a name for the element.

You can use the name of a built-in element or define an entirely new element.
To see the names of built-in elements, place the insertion point in an equation
and choose Insert Math Element from the Equations pop-up menu on the
Equations palette. In the Insert Math Element dialog box, turn off Show
Custom Only.
4

Add a text line in the graphic frame and create the math element in the text line.

To add a text line, use the Text Line tool on the Tools palette. For details, see
“To add a text line” on page 13-25.
You can type any characters in the text line. You can change their
character format using either the Font, Size, and Style submenus or
Characters>Designer on the Format menu. You can also change their position
by using micropositioning shortcuts. For a complete list of keyboard shortcuts,
see Chapter 2, “Keyboard Shortcuts,” in the Quick Reference.
Graphic
frame
Text line
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The math element could be as simple as a single character in a specialized font.
For all math elements except delimiters, the text line represents just the
mathematical symbol, not the operands. When you later insert the element in
an equation, FrameMaker places the operands in the appropriate places, based
on the type of the math element. For example, a large element such as a
summation or an integral sign has up to three operands—one above, one below,
and one to the right of the symbol.
FrameMaker uses the first text line in the graphic frame for the custom math
element, so make sure there’s only one text line in the frame.
5

Select the graphic frame.

6

On the Equations palette, choose Add Definition to Catalog from the Equations
pop-up menu.

7

If you’re defining a custom math element, choose an element type from the pop-up
menu in the Add Definition dialog box.

Choose an element type.

The element type indicates how the element behaves in relation to other
elements around it. For example, a plus sign (+) has the type infix, which means
that it has two operands, one to the left and one to the right. For information on
the types of math elements you can define, see “Math element types” on
page 28-30.
8

Click Add.
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DEFINING A DELIMITER

A custom delimiter can contain only one operand, even though some built-in
delimiters contain two or three. To indicate the location of the operand, insert a
space in the text line. If you do not insert a space in the text line, FrameMaker
places the operand between two copies of the delimiter.
Characters in delimiter

( ]
Space indicates the
operand.

MATH ELEMENT TYPES
You can define elements of the following types.

You cannot define elements of the following types.

Type
Example
Number of operands
...............................................

Type
Example
...............................................

Atom

α

None

Script

α 2, β 0

Infix

α+β

Two, one to the left and
one to the right of the
element

Derivative

d
dx

Prefix

–α

One, to the right of the
element

Diacritical mark

α', β̇˙

Postfix

α!

One, to the left of the
element

Matrix

Delimiter

(α)

One

Large

∞

∑

x2

Up to three, one each
above, below, and to the
right of the element

1

Vertical
list

α
β
γ

Two, arranged one
above the other

Function

sin α

One, to the right of the
element

Limit

28-30
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Up to two, one below
and one to the right of
the element

αβ
γ δ
x, 3 x

Roots
Substitution

x

Vertical division bar

α
--β

Horizontal list

xy

x=3

x+y

.....

CREATING EQUATIONS

Creating and changing math element definitions

DEFINING A VERTICAL LIST

The text line that defines a custom vertical list is used as a separator between
items in the list.
FINDING THE NAME OF A BUILT-IN ELEMENT

To find the name of a built-in element, choose Insert Math Element from the
Equations pop-up menu on the Equations palette. Turn off Show Custom Only
in the dialog box and scroll through the element names until you find the one
you want. Then click Cancel.

To chang e a custom math element definition
You can change a custom math element at any time. When you do, FrameMaker
shrinkwraps the equations again.
1

Display the FrameMath reference page that contains the math element.

If you inserted the custom math element into an equation, display the reference
page by selecting the element in an equation and choosing Update Definition
from the Equations pop-up menu on the Equations palette. Then click
Go to Frame in the dialog box that appears.
If you haven’t inserted the custom math element into an equation, choose
Reference Pages from the View menu. Then display the reference page
you want.
2

Edit the text line that defines the math element.

When you display a body page again, FrameMaker uses the modified definition.
DELETING A CUSTOM MATH ELEMENT DEFINITION

To delete a custom math element definition, display the FrameMath reference
page that contains the math element and delete the frame. If the element
appears in an equation, FrameMaker displays the element name, surrounded
by question marks, instead of the element.
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You can format equations you’ve placed in a FrameMaker document by
changing fonts, spacing, positioning, and alignment.

Precise control of positioning and spacing
You can change the position of an element and the amount of white
space around it.
2

x – 22  y – 42
 ----------+ ----------- = 1
 4 
 3 
Before changing spacing and
positioning

2

x – 2
y – 4
 ---------- ---------- 4  + 3  = 1




After

You can also update the definition of a math element to change the
spacing around the element wherever it appears in your document.

Full font control
You can change the character format of elements in an equation—for
example, to use color or a special font.
Color change

( x – x0 ) 2 ( y – y0 ) 2
--------------------- + --------------------- =
a2
b2

1

Font change

You can change a single equation from one preset size to another or
change the font sizes and character formats used for all equations in a
document.
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Several alignment options
You can control when an equation breaks across lines and how the lines
in a multiline equation, or the items in a list or matrix, are aligned.
2a + 3b – c
3a – b
2b + c
2a – 3b + 7c – 2

=
=
=
=

2x + 1
4x
3x – 7
2x + 4

Aligned along the left side of the
equal signs

You can also align several equations with one another, even if they
appear in different anchored frames.

In this chapter
This chapter shows you how to change the positioning and spacing of
elements and the fonts used in equations. It also shows you how to
control line breaks in multiline equations and how to align multiline
equations, lists, and matrices.
Chapter 28 shows you how to create equations and edit their contents.
Chapter 30 shows you how to evaluate equations mathematically.
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POSITIONING MATH ELEMENTS
IN AN EQUATION
FrameMaker positions math elements according to their mathematical
meaning in an equation. In some cases, though, you may want to microposition
elements—reposition them so they’re closer to or farther from other elements in
the equation.
10

∑ 2k – 7
k=1
Before micropositioning

10

∑ 2k – 7
k=1
Operands above and below
positioned closer to the summation

You can also control the amount of white space on each side of an element—left,
right, above, and below.

Default spacing

Space added to
the left and right

Space removed from
the left and right

Because the size of an element includes the white space around it, you can force
FrameMaker to use larger delimiters around an element or expression by
increasing the amount of white space above and below it.
Finally, you can update the spacing in a math element definition so the new
spacing appears wherever the element appears in the document.

To position an expression precisely
When you microposition an element or expression, its position changes with
respect to all other elements in the equation. For example, if you microposition
the middle expression closer to the one on the left as shown below, it moves
farther away from the one on the right.
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( x)( x – 4)( x – 1)

( x )( x – 4 ) ( x – 1 )

Before micropositioning

After moving the middle
expression to the left

■
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To position a selected expression, click a micropositioning arrow on the
Positioning page.

Micropositioning arrows

Click as many times as necessary. Each click moves an expression one pixel on
the screen. Zoom in for greater precision.
■

To remove micropositioning from a selected expression, click the button at the center
of the Microposition area on the Positioning page
.

■

To inspect the position offsets of a selected expression and adjust them numerically,
click Position Settings on the Positioning page.

The exact offsets appear in the Microposition Offset area of the Math Element
Position Settings dialog box.

To chang e the spacing around an expression
You can change the amount of white space around elements or expressions. For
example, you can force FrameMaker to use larger delimiters around an
expression by increasing the amount of white space above and below the
expression.

10

∑

10

2k – 6

k=1
Original spacing

∑ 2k – 6

Larger brackets

k=1
Space added above the top
operand and below the bottom one
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■

To add or subtract white space around a selected expression, click a spacing control
on the Positioning page.

Click plus (+) to add white
space and minus (–) to
subtract it.

Click as many times as necessary. Each click adds or subtracts one pixel of
space. Zoom in for greater precision.
To change the spacing around a math element of type infix, prefix, postfix, or
delimiter, adjust the space around the adjacent math elements instead. For
example, to add space on either side of the plus sign in the expression a + b ,
select the a and add space to the right. Then select the b and add space to the
left. For a description of math element types, see “Math element types” on
page 28-30.
■

To restore the amount of white space around a selected expression to the default
spacing, click the button at the center of the Spacing area on the Positioning
page
.

■

To inspect the spacing values of a selected expression and adjust them numerically,
click Position Settings on the Positioning Page.

The exact spacing appears in the Spacing area of the Math Element Position
Settings dialog box.
CHANGING THE SPACING IN A MATH ELEMENT DEFINITION

You can update some math element definitions—infix, prefix, postfix, large,
scripts, and the division bar—with new spacing. When you do, FrameMaker
adjusts the spacing around the element wherever it appears in the document
and rewraps the equations. For a description of math element types, see “Math
element types” on page 28-30.
After you adjust the spacing around the element in an equation, select the
element, and choose Update Definition from the Equations pop-up menu on the
Equations palette. Then click Update in the Update Definition dialog box.
To reset the spacing in a math element definition to the default spacing, select
the element and choose Update Definition from the Equations pop-up menu
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on the Equations palette. Then click Get Default in the Update Definition
dialog box.
CHANGING THE SPREAD BETWEEN CHARACTERS IN EQUATIONS

You can change the spread—the space between characters—uniformly in all
small, medium, and large equations. For details, see “To change equation font
size and spacing throughout a document” on page 29-15.

ALIGNING EQUATIONS
You can set an equation to break across lines in an anchored frame when it
reaches a particular width. You can change this width at any time. Or you can
set a manual line break in an equation to control exactly where the equation
breaks to another line. When an equation breaks across lines, the entire
equation remains in a single anchored frame.
You can change the alignment of lines in multiline equations, items in
horizontal and vertical lists, and cells in matrices.
You can manipulate equation objects as you do other objects. For information on
grouping, aligning, distributing, and rotating equations, see Chapter 14,
“Editing Illustrations.”

To chang e an equation’s automatic line-break width
You can set an equation to break across lines automatically. When you change
the line-break width, the equation is reformatted to the new width.

Original equation

( x + 1 ) 8 = x 8 + 8x 7 + 28x 6
+ 56x 5 + 70x 4 + 56x 3
+ 28x 2 + 8x + 1
Equation set to break after 1.25 inches

1

Click in the equation or select any part of it.

2

Choose Object Properties from the Graphics menu.

Using FrameMaker
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3

Edit the value in the Automatic Line Break After text box and click Set.

The value is preset to the width of the equation’s frame.

Edit this value.

To chang e equation line-breaking manually
You can force an equation to break across lines at a specific location in the
equation.
Don’t use manual line breaks to create separate equations. Instead, insert a
vertical list of expressions. For more information, see “To insert a horizontal or
vertical list of expressions” on page 28-11.
■

To insert a manual line break, click where you want the equation to break into two
lines and then choose Set Manual from the Line Breaking pop-up menu on the
Positioning page.

Manual line
break controls

A line-break symbol ( ) appears at the insertion point.

( x + 1 ) 8 = x 8 + 8x 7 + 28x 6 + 56x 5 +
70x 4 + 56x 3 + 28x 2 + 8x + 1
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To remove a manual line break, select the part of the equation that contains the linebreak symbol and then choose Clear Manual from the Line Breaking pop-up menu on
the Positioning page.

To chang e the alignment of a display equation
The alignment (left, center, or right) of a display equation is controlled by the
format of the paragraph that contains the equation.

If the center is located at (a,b) instead of at (0,0), the circle is
represented by the equation below.
( x – a )2 + ( y – b )2 = r 2

Paragraph alignment set to
Center

EQ 22

Suppose that the axes of an ellipse lie along the lines x = x 0 and

1

Click in the paragraph that contains the equation, not in the equation itself.

2

Change the paragraph’s alignment.

Use the Alignment pop-up menu in the formatting bar or in the Paragraph
Designer. For details, see “To align a paragraph” on page 4-14.

To align items in a vertical list or multiline equation
You can automatically align items in a vertical list and lines in a multiline
equation along their left or right sides, their centers, or their equal signs. You
can also set your own manual alignment points for items in a vertical list and
for a multiline equation. Manual alignment points override automatic
alignment.

Aligned along the left side
of the equation

Aligned along a manual
alignment point in the first line

Using FrameMaker
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■

To set automatic alignment for a vertical list or multiline equation, click in the equation
or list and choose an item from the Left/Right pop-up menu on the Positioning page.

Alignment
options

When you choose Left of = or Right of =, the lines are aligned along one side of
an equal sign. A line with no equal sign is aligned along its left side.
■

To set a manual alignment point for an item in a vertical list, click in the item where
you want the manual alignment point and choose Set Manual from the Left/Right
pop-up menu on the Positioning page.

A manual alignment symbol (|) appears at the insertion point. The item aligns
with other items in the list at the manual alignment point.
■

To set a manual alignment point for a multiline equation, click in the first line of the
equation where you want subsequent lines to align and choose Set Manual from the
Left/Right pop-up menu on the Positioning page.

A manual alignment symbol (|) appears at the insertion point. Subsequent
lines left-align with the manual alignment point.
■

To clear a manual alignment point, select the part of the equation that contains the
manual alignment point and choose Clear Manual from the Left/Right pop-up menu
on the Positioning page.

You can also clear a manual alignment point by setting another.
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To left-, center-, or right-align equations with one another
You can align several equation objects with one another in a graphic frame, just
as you align other objects. FrameMaker maintains the equation objects’
alignment as you edit the equations. For example, if two equations are leftaligned, FrameMaker maintains the left alignment as the equations expand or
shrink.
1

Select the equations to be aligned.

Make sure that the last equation you select is the one you want to align with.
To select the equations, Control-Shift-click them.
2

Choose Align from the Graphics menu.

For information on the Align command, see “To align objects” on page 14-10.

To align equations along a point
You can align several equation objects along a manual alignment point, even
when they’re in separate graphic frames.
Two equations aligned at a
manual alignment point

FrameMaker aligns the equations with the manual alignment point in the first
equation object and maintains the equation objects’ alignment as you edit the
equations. For example, if two equations are left-aligned, FrameMaker
maintains the left alignment as the equations expand or shrink.
1

Set the manual alignment point in one of the equations you want to align.

You do this in an equation just as you set a manual alignment point in a
vertical list.
If you don’t set a manual alignment point, FrameMaker aligns an equation
along its left side by default.
For details about setting a manual alignment point or choosing an automatic
alignment, see “To align items in a vertical list or multiline equation” on
page 29-9.
2

Click in the equation.

3

Choose Object Properties from the Graphics menu.

Using FrameMaker
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4

Choose Manual alignment and specify the location of the alignment point within
the frame.

Type the offset of the
alignment point from the left
edge of the frame.
Choose Manual.

The left offset is the distance from the left edge of the frame to the manual
alignment point—for example, the right side of an equal sign.
You don’t need to specify the top offset precisely. You can move the equation up
or down later, just as you do any other object.
5

Click Set.

6

Repeat steps 1 through 5 for each equation object you want to align.

Use the same distance from the left edge for each equation, but change the top
offset to position the equation vertically in the frame.
If the equations you’re aligning are in different anchored frames, make sure the
frames’ left edges align with one another.

To align items in a horizontal list
You can align the items in a horizontal list along their tops, bottoms, or
baselines.
5

∑k

Baseline

x+y

k=1
Baseline-aligned

1
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Choose an item from the Up/Down pop-up menu on the Positioning page.

Vertical
alignment
options

To align cells in a matrix
You can align the cells in each row of a matrix along their tops, bottoms, or
baselines. You can align the cells in each column at the right, left, or center, or
along equal signs.

x+y
x
x
-- x 2 – y 2
y

Baseline

x+y x
x
-y
x2 – y2

Center
Aligned along baselines and centers

■

Aligned along left sides and bottoms

To align cells in each row of a selected matrix, choose an item from the Up/Down
pop-up menu on the Positioning page.

You can select any part of the matrix or just click in it.
■

To align cells in each column of a selected matrix, choose an item from the Left/Right
pop-up menu on the Positioning page.

You can select any part of the matrix or just click in it.

To check alignment settings
You can inspect the alignment settings for a multiline equation, vertical or
horizontal list, or matrix.
1

Select the entire equation, list, or matrix.

You can drag through the equation, list, or matrix to select it, or you can put the
insertion point in it and press the space bar repeatedly.
2

On the Positioning Page, click Position Settings.

Using FrameMaker
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CHANGING FONT SETTINGS
A document has font settings that apply to all equations in it. These settings
determine the font sizes and spacing for small, medium, and large equations.
They also determine the specific character format used for Greek characters
and for symbols, functions, numbers, strings, and variables.
You can change these settings at any time, and you can update them from
another document. For details, see “Importing formats into a document” on
page 21-12. The changes will appear in all equations in the document and in
any new equations you add to it.
You can also change the preset size—Small, Medium, or Large—and the color of
an entire equation or change the character format of just one element or
expression in an equation.

To chang e the character forma t of an expression
You can change the character format that FrameMaker uses for individual
math elements or expressions. For example, you might want to display an
element in a larger point size or in bold.
You can’t change the spread, superscript, subscript, underline, overline,
strikethrough, change bar, or pair kerning properties for any element. You also
can’t change the font family for individual Greek characters and symbols and
for some operators. For information on changing the font family for all Greek
characters and symbols in a document, see “To change the font for Greek
characters and symbols” on page 29-15.
■

To change the character format of an element or expression, select it and use the
same method you would use with text.

For details, see “To choose a font family, style, and size” on page 4-8.
■

To create a superscript or subscript, use the appropriate operator.

For details, see “To insert an operator” on page 28-13.
■

To change the spread of characters, microposition them.

For details, see “To position an expression precisely” on page 29-4.
■
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To chang e equation font size and spacing throughout a document
You can change the font size and spacing for all small, medium, and large
equations in a document. When you do, FrameMaker reformats and rewraps all
equations in the document.
1

On the Equations palette, choose Equation Sizes from the Equations pop-up menu.

2

In the Equation Sizes dialog box, specify the font sizes and spread.

Spread is expressed as a percentage of the font size. Positive Spread values
cause wider spacing around elements; negative values cause narrower spacing.
3

Click Set.
RETURNING FONT SETTINGS TO THEIR DEFAULT VALUES

To return the settings to their default values, choose Equation Sizes from the
Equations pop-up menu on the Equations palette. Then click Get Defaults.

To chang e the font for Greek characters and symbols
Greek characters and symbols in equations normally appear in the Symbol font.
However, FrameMaker also allows you to use fonts such as Mathematical Pi
and Universal Greek if these fonts are installed on your system.
When you change the font, FrameMaker reformats and rewraps all equations
in the document.
1

On the Equations palette, choose Equation Fonts from the Equations pop-up menu.

2

Choose one of the available fonts from the Math Symbols pop-up menu and click Set.

Choose a font.
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INSTALLING ADDITIONAL MATH FONTS

FrameMaker can display any font that appears in the pop-up menu, but it can
print the font only if the printer fonts are available on your system. For
information on installing additional fonts for FrameMaker, see the online
manual Managing Frame Products.

To chang e the character format for functions, numbers, strings, and variables
Functions, numbers, and strings normally appear in Times. Variables normally
appear in Times italic. However, you can change the character format that
FrameMaker uses for each of these kinds of elements. For example, you may
want to display all elements in Helvetica, with functions in italic and variables
in bold.
When you change the character format, FrameMaker reformats and rewraps all
equations in the document.
1

Create the character format you want.

Use Characters>Designer on the Format menu. For details, see “To choose a
font family, style, and size” on page 4-8 and “Creating and updating character
formats” on page 5-17.
You can’t change the spread, superscript, subscript, underline, overline,
strikethrough, change bar, or pair kerning properties.
2

On the Equations palette, choose Equation Fonts from the Equations pop-up menu.

3

In the Equation Fonts dialog box, choose the character format you want from the
Functions, Numbers, Strings, or Variables pop-up menu.

The pop-up menus contain the formats stored in the Character Catalog.
4
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Evaluate Integrals 30-15

Matrix Transpose 30-4

Evaluate Derivatives 30-15

Matrix Algebra 30-4

Evaluate Derivatives 1 Level 30-16

ADDITION MENU 30-5

RULES MENU 30-16

Add Fractions 30-5

Enter Rule 30-16

Order Sum 30-6

Apply Rule 30-17

Order Sum Reverse 30-6

Designate Dummy 30-17

MULTIPLICATION MENU 30-6

OTHER REWRITES MENU 30-18

Factor 30-7

Simplify 30-18

Factor Some 30-7

Simplify Some 30-19

Multiply Out 30-7

Isolate Term 30-20

Multiply Out Once 30-8

Expand First Term 30-20

Distribute 30-8

Expand All Terms 30-20

Distribute Over Equality 30-9
DIVISION MENU 30-9
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After you create an expression or equation, you can transform it by
changing its mathematical representation and evaluate it by
substituting values and performing computations.

You can transform and evaluate equations
You transform expressions and equations by using commands that
change their mathematical representation but not their meaning. For
example, you multiply polynomials, factor terms, simplify expressions,
and combine fractions.
y = ( x + 4 )3
Expanded

y = ( x + 4)( x + 4)( x + 4)

Multiplied out

y = ( x + 4 ) ( x 2 + 8x + 16 )

Multiplied out again

y = x 3 + 12x 2 + 48x + 64

You evaluate expressions by computing their actual value.
x 3 + 12x 2 + 48x + 64

Expanded

x 3 + 12x 2 + 48x + 64

Value substituted

343 – 125

Result computed

218
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Evaluation commands are on the Equations palette
You evaluate and transform expressions by using commands on the
Matrices and Functions pages on the Equations palette.

Commands for
evaluating and
transforming
equations

To evaluate an expression, you select it—or part of it—and choose a
command from the menu. For example, you might select an expression
and then choose Multiply Out from the Multiplication pop-up menu on
the Functions page.

In this chapter
This chapter describes the commands on the Matrix Commands pop-up
menu of the Matrices page and the commands on the six pop-up menus
of the Functions page.
Chapter 28 and Chapter 29 show you how to insert, edit, and format
equations.

Using FrameMaker
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Matrix Commands pop-up menu

MATRIX COMMANDS POP-UP MENU
Use the Matrix Commands pop-up menu on the Matrices page to create, edit,
and evaluate matrices.

This section describes the Matrix Transpose and Matrix Algebra commands.
For information on the other commands in the menu, see “To change a matrix”
on page 28-27.

Matrix Transpose
Transposes the rows and columns of a selected matrix.
Before
After
..........................................................................

a b c
d e f

a d
b e
c f

Matrix Algebra
Performs matrix multiplication and addition and evaluates dot and cross
products in a selected matrix.
Before
After
..........................................................................
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2 a b
c d

2a 2b
2c 2d

2 b a b
c 2d c d

2a + bc 2b + bd
ac + 2cd bc + 2d 2

2 b + 3 a

2+3 b+a

Addition menu
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Before
After
..........................................................................

a
a
b • 2
c
c

aa + b2 + cc

1
a
2 × b
3
c

2c – 3b
3a – 1c
1b – 2a

After performing matrix algebra, you can use the Simplify command to combine
like terms. For details, see “Simplify” on page 30-18.

ADDITION MENU
Use the Addition pop-up menu on the Functions page to add fractions and order
polynomials. This section describes the Addition commands in the order they
appear on the menu.

Add Fractions
Adds selected fractions, expressing the result as a single fraction. This
command also combines like terms.
Before
After
..........................................................................

1 4
--- + --3 5

17
-----15

a 2a
--- + -----4 3

11a
--------12

2x 3a
------ + -----y
b

2bx + 3ay
------------------------by

Using FrameMaker
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If the selected expression contains the sum of more than two fractions, Add
Fractions adds only the first two. Use this command repeatedly to combine all
the fractions.
Before
Done once
Done twice
..........................................................................

2x 3a 2a
------ + ------ – -----y
b 3b

2bx + 3ay 2a
------------------------- – -----by
3b

3b ( 2bx + 3ay ) – 2aby
------------------------------------------------------3yb 2

Order Sum
Arranges polynomials in decreasing powers of a selected variable. In the
example below, you select an x—any x—before choosing Order Sum.
Before
After
..........................................................................

x 3 + 2x 5 – 4x 2 + 1 – x

2x 5 + x 3 – 4x 2 – x + 1

Order Sum Reverse
Arranges polynomials in increasing powers of a selected variable. In the
example below, you select an x—any x—before choosing Order Sum Reverse.
Before
After
..........................................................................

x 3 + 2x 5 – 4x 2 + 1 – x

1 – x – 4x 2 + x 3 + 2x 5

MULTIPLICATION MENU
Use the Multiplication pop-up menu on the Functions page to factor terms,
multiply out expressions, and distribute multiplication and division over
addition. This section describes the Multiplication commands in the order they
appear on the menu.

30-6

Using FrameMaker

Multiplication menu

.....

EVALUATING EQUATIONS

Factor
Factors a selected term out of a product. In the examples below, you select an
a—any a—before choosing Factor.
Before
After
..........................................................................

ac + bc

bc
a c + ------ 

a

a 2 + 2a + 1

1
a a + 2 + --- 

a

Factor Some
Factors a selected term from only those terms that contain it. In the example
below, you select the first x before choosing Factor Some.
Before
After
..........................................................................

xy + 2x + v

v + ( y + 2 )x

Multiply Out
Simplifies the selected expression, distributes multiplication over addition, and
expands a selected term raised to a positive integral power.
Before
After
..........................................................................

( a – 3 ) ( 2a + 4 )

2a 2 – 2a – 12

( a – 3 ) ( 2a + 4 ) ( a 2 + 3 )

2a 4 – 2a 3 – 6a – 6a 2 – 36

( a + 2b ) 4

a 4 + 8ba 3 + 24a 2 b 2 + 32ab 3 + 16b 4

a ( b + c ) ( 2a + 4 )

2a 2 b + 4ab + 2a 2 c + 4ac

The Simplify command also simplifies the selected expression. For details, see
“Simplify” on page 30-18.

Using FrameMaker
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Multiplication menu

Multiply Out Once
Multiplies the first pair of factors on the left side of a selected expression.
Before
After
..........................................................................

a ( b + c ) ( 2a + 4 )

ab ( 2a + 4 ) + ac ( 2a + 4 )

If you use Multiply Out Once several times, the results appear in a
different form.

Distribute
Performs a variety of operations depending on the expression you select.
Several examples follow.
■

Distributes division over addition.
Before
After
..........................................................................

a+b
-----------c

a b
--- + --c c

Use the Add Fractions command to perform the reverse operation. For details,
see “Add Fractions” on page 30-5.
■

Distributes multiplication over addition.
Before
After
..........................................................................

a(b + c)

ab + ac

Use the Factor command to perform the reverse operation. For details, see
“Factor” on page 30-7.
■

Transforms products and quotients involving radicals and exponents into a
single expression raised to a power.
Before
After
..........................................................................

ab 2

( ab ) 2

a3b2

( a3 / 2b )2

a2 b
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Division menu

Use the Simplify command to perform the reverse operation. For details, see
“Simplify” on page 30-18.

Distribute Over Equality
Performs the same operation on both sides of an equal sign.
Before
After
..........................................................................

( x = y )z

xz = yz

( x = y) – 5

x–5 = y–5

( x = y )2

x2 = y2

DIVISION MENU
Use the Division pop-up menu on the Functions page to perform long division,
convert division to multiplication, and convert negative exponents to positive.
This section describes the Division commands in the order they appear on
the menu.

Long Division
Performs long division in a fraction that contains a polynomial numerator and
denominator.
In the example below, you select an x—any x—before choosing Long Division.
You would select an x in the fraction of the first result and choose Long Division
again to obtain the second result.
Before
First result
Second result
..........................................................................

x 2 + 2x + 1
--------------------------x+1

1x + 1
x + --------------x+1

x+1

Using FrameMaker
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Remove Division
Converts division to multiplication in a selected expression by changing
positive exponents to negative and negative exponents to positive.
Before
After
..........................................................................

x
----y2

xy –2

c
b + --d
-----------x

( b + cd – 1 )x – 1

To convert negative exponents into division operators, use the Remove Negative
Powers command.

Remove Division 1 Level
Converts division to multiplication, as Remove Division does, but applies only
to the first level of operators.
Before
After
..........................................................................

x
----y2

xy –2

c
b + --d
-----------x

b + --c-  x – 1

d

To convert the first level of negative exponents into division operators, use the
Remove Negative Powers 1 Level command.
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Remove Negative Powers
Converts negative exponents to positive in a selected expression by replacing
multiplication with division and division with multiplication.
Before
After
..........................................................................

xy –2

x
----y2

( b + cd –1 )x –1

c
b + --d
-----------x

Remove Negative Powers 1 Level
Converts negative exponents to positive, as Remove Negative Powers does, but
applies only to the first level. If the selected expression has no negative
exponents at the first level, this command has no effect.
Before
After
..........................................................................

( b + c –1 ) –2

1
-----------------------( b + c –1 ) 2

xy –2

xy – 2 (no effect)

EVALUATION MENU
Use the Evaluation pop-up menu on the Functions page to evaluate expressions
numerically. This section describes the Evaluation commands in the order they
appear on the menu.

Using FrameMaker
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Evaluation menu

Number Crunch
Changes integers to floating-point numbers in a selected expression and then
evaluates the expression.
Before
After
..........................................................................

3π
sin -----2

–1

–3

3

log ( 2e 2 – 1 )

2.6230813

e 2 + 7π

29.380205

Use the Show All Digits command to show up to 15 decimal places in a floatingpoint number. For details, see “Show All Digits” on page 30-12.
Number Crunch displays NaN (Not a Number) for operations that result in
undefined values and Infinity for operations that result in a value too large to
calculate. Extremely small numbers may be evaluated to zero.
Before
After
..........................................................................

1 1
--- – --0 0

NaN

1
--0

Infinity

Show All Digits
Shows the full internal accuracy of a floating-point number.
Before
After
..........................................................................

3.1415927 …
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Evaluate
Evaluates the selected expression. The operations performed depend on the
type of expression selected. Several examples follow.
■

Rewrites an expression raised to a power less than 20 as a product.
Before
After
..........................................................................

a3

■

aaa

Computes the factorial of an integer. If the result is too large to calculate, the
result appears as Infinity.
Before
After
..........................................................................

5!

■

120

Computes the determinant of a 1 x 1 or 2 x 2 matrix.
Before
After
..........................................................................

a b
c d

■

ad – bc

Extracts a term from a sum or product.
Before
After
..........................................................................
5

∑

5

x3

1+

x=1

∑ x3
x=2

■

Evaluates a substitution just as the Evaluate Substitution command does. For
details, see “Evaluate Substitution,” next.

■

Rewrites an Evaluate Between operator as a difference.
Before
After
..........................................................................

x2

8
x=6

x2

x=8

– x2

x=6

Using FrameMaker
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■

Rewrites the logarithm of a product as a sum of logarithms and rewrites a
logarithm of a power as a product.
Before
After
..........................................................................

■

log 2xy

log 2 + log x + log y

log a n

n log a

Rewrites a logarithm to a base in terms of natural logarithms.
Before
After
..........................................................................

log x
----------log 2

log 2x

■

Rewrites a choice function in terms of factorials.
Before
After
..........................................................................

x!
----------------------y! ( x – y )!

 x
 y

Evaluate Substitution
Performs a specified substitution and then simplifies the expression. When an
Evaluate Between operator is selected, this command rewrites the expression
as a difference.
Before
After
..........................................................................

x2

sin ( 2x )
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x=6
π
x=0

sin ( 2x )

x=π

– sin ( 2x )

x=0
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Evaluate Integrals
Rewrites a selected integral with a polynomial integrand. This command
converts a definite integral into an indefinite integral evaluated between the
upper and lower bounds. Use Evaluate Integrals several times to integrate a
polynomial fully.
Before
Done once
Done twice
..........................................................................
3

∫

∫

x 2 dx

1

( dx )x 2

x=1

3

∫ ( x 2 + 3x – 2 ) dx
1

x3
----3

3

3

∫ ( x 2 + 3x – 2 ) dx x = 1

3
x=1

3

∫ ( dx )x 2 + ∫ 3x dx + ∫ –2 dx x = 1

In the second example above, use Evaluate Integrals two more times to fully
evaluate the integral.
Done three times
Done four times
..........................................................................

x3
----- + 3 ∫ x dx – 2x
3

3
x=1

x 3 3x 2
----- + -------- – 2x
3
2

3
x=1

Evaluate Derivatives
Evaluates a selected derivative, applying the chain rule to complex expressions
when necessary. Evaluates a partial derivative only when all dependencies are
explicitly written.
This command treats elements in a total derivative as if they depended on the
variable of differentiation. Use the Evaluate command to expand an nth
derivative before using this command to evaluate it.
Before
After
..........................................................................

d
( 3x 3 – 2x 2 – 3 )
dx

9x 2 – 4x

∂
sec xy tan xy
∂x

y sec xy tan2 xy + y sec3 xy

Using FrameMaker
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Evaluate Derivatives 1 Level
Evaluates only the first level of a selected derivative.
Before
After
..........................................................................

d
( 3x 3 – 2x 2 – 3 )
dx

d
d 3 d
3x + – 2x 2 + – 3
dx
dx
dx

∂
( sec xy tan xy )
∂x

tan xy

∂
∂
sec xy + sec xy tan xy
∂x
∂x

RULES MENU
Use the Rules pop-up menu on the Functions page to store and apply rules that
transform expressions. This section describes the Rules commands in the order
they appear on the menu.

For example, use Enter Rule to store a rule such as a = a + 3. Then use Apply
Rule to substitute a + 3 for a in another expression.

Enter Rule
Stores a rule for substituting one expression for another. Select the expression
you want to store as a rule before you choose Enter Rule. You can store only one
rule at a time.
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Apply Rule
Substitutes one term or set of terms for another in a selected expression, using
the rule stored with the Enter Rule command.
Rule entered
Before rule is applied
After rule is applied
...........................................................................

a = a+3

a 2 – 2ab + b 2

x← y

3xy + 2x – x 2

( a + 3 ) 2 – 2b ( a + 3 ) + b 2
3y 3 / 2 + 2 y – y

Before you apply a rule that contains a dummy variable, first select the term
you want the dummy variable to replace. In the example below, x is the dummy
variable in the rule, and the last b in the expression is selected.
Rule entered
Before rule is applied
After rule is applied
..........................................................................

x← y

a 2 – 2ab + b 2

a 2 – 2ab + y 2

Designate Dummy
Designates a selected term to be a dummy variable. A dummy variable in a rule
allows you to substitute the expression on the right side of the rule for any
variable, not just the variable explicitly named on the left. A dummy variable
appears in boldface. For example, if you designate x in the rule x = a – 2 to be
a dummy variable, you can substitute a – 2 for any variable in an expression,
not just x.
Select the term you want to be a dummy variable before you choose Designate
Dummy. Then use the Apply Rule command to replace a selected expression
with the expression assigned to the dummy variable.

Using FrameMaker
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OTHER REWRITES MENU
Use the Other Rewrites pop-up menu on the Functions page to simplify
algebraic expressions and to isolate and expand terms. This section describes
the menu commands in the order they appear on the menu.

Simplify
Simplifies the selected expression. The operations performed depend on the
type of expression selected. Several examples follow.
■

Performs integer arithmetic.
Before
After
..........................................................................

c+0

c

4!

24

1 2
--- + --3 5

11
-----15

When the result is too large to calculate, it appears as Infinity.
■

Groups terms in a sum or product.
Before
After
..........................................................................
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2ab + 3ab

5ab

ab ( ac )

a 2 bc

a xa2 x + 3

a3 x + 3

km
km
8 ------- + 4 ------hr
hr

8km 4km
----------- + ----------hr
hr
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Divides out common factors in a fraction.
Before
After
..........................................................................

( ab ) 2
------------a2b

1b

2x 3 y 2
-------------6xy 5

x 2 y –3
------------3

Use the Remove Negative Powers command to remove negative powers from
the result. For details, see “Remove Negative Powers” on page 30-11.
■

Interprets the complex number i, represented by the Greek letter iota (ι).
Before
After
..........................................................................

– ab

■

ι a b

Distributes exponentiation across multiplication and division.
Before
After
..........................................................................

( xy ) 2
 --x 
 y

2

Note that simplifying

x2 y2
x2
----y2
x 2 produces x rather than x .

Simplify Some
Simplifies the selected expression, as the Simplify command does, but does not
multiply fractions.
Before
After
..........................................................................

km
km
8 ------- + 4 ------hr
hr

km
12 ------hr
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Isolate Term
Isolates a selected expression on one side of the equal sign. This command does
not combine terms or solve for the selected expression. In the examples, you
select the first x before choosing Isolate Term.
Before
After
..........................................................................

x3 + x + 2 = 0

x = ( – x – 2 )1 / 3

bx + by = c

c – by
x = -------------b

log x = z

x = ez

Expand First Term
Expands the first term of a selected summation or product.
Before
After
..........................................................................
4

∑ x3
x=2

x=3

5

∏

4

∑ x3 + 8
5

( x3 – 2 )

x=2

6 ∏ x3 – 2
x=3

Expand All Terms
Expands all terms of a selected summation or product.
Before
After
..........................................................................
4

∑ x3

8 + 27 + 64

x=2
5

∏ x3 – 2
x=2
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RESOURCES AND
OTHER PRODUCTS

.....

..................................

As you use FrameMaker, you can turn to many sources for help. In addition to
the printed and online documentation mentioned at the beginning of this
manual, Frame offers technical support programs, training classes, and other
resources that will help you use the application as effectively as possible. You
may also want to know about other Frame products that were designed to work
with FrameMaker.
This appendix covers these topics.
Topic
Page
..........................................................................

Obtaining technical support

A-1

Taking a training class

A-3

Ordering Frame products

A-5

Finding out about third-party
products and services

A-8

OBTAINING TECHNICAL SUPPORT
In the United States and Canada, software registration entitles you to 30 days
of free technical support, after which you need to subscribe to a support
program. The 30 days begin at the time of your first phone call. As a registered
user, you will also receive copies of Frame Focus, a newsletter with news and
information on product updates. When you need support, you can telephone,
fax, write, or use an online service to contact Frame Technical Support. Frame
will be able to answer your questions most efficiently if you gather key
information before you ask for help.

To subscribe to a support program
After the first 30 days of complimentary technical support, you need to
subscribe to a support program to continue receiving support. Frame offers a
number of fee-based support programs for US and Canadian customers, as well
as free online, automated self-help support options.
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Obtaining technical support

■

For information on FrameMaker support programs and how to subscribe to them, call
Frame Technology at (800) 537-2634.

■

To obtain information on support programs outside the United States and Canada,
contact your local sales support representative or your distributor.

■

To purchase technical support, contact your local sales support representative or call
(800) U4-FRAME [(800) 843-7263].

To prepare for contacting Frame Technical Support
Before you contact Frame Technical Support, please take the time to consult
your FrameMaker manuals and the online Release Notes. The manuals might
answer your questions and so save you time and effort. If the manuals do not
answer your questions, take the following steps before you contact Frame
Technical Support.
■

Make sure your hardware meets the minimum system requirements listed in the
installation instructions.

■

Make sure your hardware and peripherals are set up correctly and that all cable
connections are secure.

■

Know the product name, operating system version, description of hardware, exact
error message (if any), and the steps to re-create the problem.

■

Know which release of FrameMaker you’re using.

To find out the release number, click INFO in the main FrameMaker window.
Click OK to close the dialog box.

To telephone Frame Technical Support
If you have purchased technical support, or if you are in your complimentary
support period, you can telephone Frame Technical Support. For information on
purchasing technical support, see “To subscribe to a support program” on
page A-1.
■

In the United States or Canada, call (408) 975-6466.

Frame Technical Support is available Monday through Friday from 6:00 AM to
5:00 PM Pacific time.
■

Outside the United States and Canada, call your local technical support
representative or your local Frame reseller.

To send faxes and electronic mail
Frame Technical Support can be reached via fax and electronic mail.
■
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Send Internet electronic mail to comments@frame.com.
Using any World Wide Web browser, open this Uniform Resource Locator (URL) site:

http://www.frame.com/SERVICES/Services.doc.html
You can send questions, comments, bug reports, or feature requests with the
online forms.

To receive information by fax
Using a TouchTone telephone and a fax machine, you can call FrameFacts and
request technical support documents to be sent to you at a fax number you
specify. These documents contain technical notes and tips that were created by
the staff of Frame Technical Support.
1

Call (408) 975-6731.

2

Listen to the recorded message and follow the instructions on how to have a
document faxed to you.

To transfer files to and from Frame Technical Support
The Frame File Transfer Protocol (FTP) Server transfers files between your
remote system and Frame Technical Support. To use this service, you must be
able to connect to the Internet.
1

On the Internet, connect to the remote system named ftp.frame.com or to the
system named 192.111.118.8.

TAKING A TRAINING CLASS
Frame Technology provides classes at its training
centers in San Jose, Chicago, and Atlanta and at
customer sites. To enroll in classes at Frame or to
schedule Frame training at your location, call the
Frame Training Coordinator at (408) 975-6242.
Training is also offered by Frame Authorized
Training Centers (ATCs) throughout the United
States and Canada. To inquire about Frame ATCs,
phone (800) U4-FRAME [(800) 843-7263],
extension 884.

To inquire about authorized training in Europe,
contact:
Frame Technology International Limited
3 Furzeground Way
Stockley Park
Uxbridge, Middlesex UB11 1DE, United Kingdom
Telephone: 44 (0)81 606 4100
Fax: 44 (0)81 606 4101
To inquire about training outside North America
and Europe, contact your local sales support
representative.
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2

Once you are connected, log in as anonymous.

You will see messages that give you directions on how to transfer files.
3

When prompted for a password, enter your electronic mail address.

To reach Frame Technical Support on CompuServe
Frame Technology maintains a section in the Desktop Publishing Vendors
Forum on CompuServe. CompuServe members can use it to contact Frame
Technical Support or other FrameMaker users, and to upload or download
FrameMaker-related files, such as templates, clip art, and filters.
1

To reach the Frame Technology section, type GO DTPVEND.

2

Browse the forum for section 12, “Frame Technology.”

To reach the Frame electronic bulletin board
Frame Technology provides an electronic bulletin board service (BBS) named
Frame Online. You can use it to upload or download FrameMaker-related files,
such as templates, clip art, and filters, and to read the latest press releases on
upgrades and special programs. The BBS runs 24 hours a day.
1

Set your telecommunications application to 8 bits, no parity, and 1 stop bit, and set
terminal emulation to TTY, TEXT, or ANSI.

ANSI terminal emulation, if available, gives the best screen display.
2

Use a telecommunications application to dial (408) 975-6729 or (408) 975-6730.

You can connect at up to 9600 baud.

To reach the Frame electronic bulletin board (Macintosh only)
There is a bulletin board service (BBS) specifically for Macintosh users. The
BBS uses the TeleFinder application to present a Macintosh interface, and
supports access up to 9600 baud.
1

Set your telecommunications application to 8 bits, no parity, and 1 stop bit, and set
terminal emulation to TTY, TEXT, ANSI, or ANSI BBS.

2

Dial (408) 975-6738 and select the Register with the BBS option.

After registering, be sure to download the TeleFinder application when you are
prompted to do so. After downloading TeleFinder, the BBS hangs up
automatically.
3

Start TeleFinder by double-clicking its icon in the Finder.

The Auto Dialer dialog box appears.
4

A-4

Using FrameMaker

In the appropriate text boxes, type the telephone number (408) 975-6738, the name
you used to register on the BBS, and the password you used to register on the BBS.
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5

In the Modem Setting scroll box, select the modem that most closely matches your
modem.

6

Click Dial to connect to the BBS.

For more information, see the TeleFinder Balloon Help or online TeleFinder
documentation.

To reach Frame on the World Wide Web
Frame Technology maintains a World Wide Web home page on the Internet
from which you can read and download information on Frame, Frame products
and services, and third-party products and services.
■

Using any World Wide Web browser, open this Uniform Resource Locator (URL) site:

http://www.frame.com

To write to Frame Technical Support
You can send letters to Frame Technical Support.
■

In the United States and Canada, write to the following address.

Frame Technology Corporation
333 West San Carlos Street
San Jose, California 95110-2711
USA
Attention: Technical Support
■

Outside the United States and Canada, write to your local sales support representative
or your distributor.

ORDERING FRAME PRODUCTS
Frame Technology offers publishing applications, utilities, and developer’s
materials that work with FrameMaker to provide complete publishing
solutions. For information on developer’s materials, see “Frame Developer’s Kit”
on page A-6. For information on companion products to FrameMaker, see
“Companion products” on page A-7. You can order any of these Frame products
by phone.

To order other Frame products
Frame applications and utilities are available from your favorite software store
or distributor and directly from Frame.

Using FrameMaker
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Ordering Frame products

■

In the United States and Canada, call (408) 975-6161.

Frame Customer Relations is available Monday through Friday from 6 AM to
5 PM Pacific time. A Customer Relations representative can direct you to your
nearest Frame reseller or can accept your order directly.
■

Outside the United States and Canada, call your local Frame distributor or reseller. In
Europe, you can contact Frame at the following address.

Frame Technology International Limited
3 Furzeground Way
Stockley Park
Uxbridge, Middlesex UB11 1DE
United Kingdom
Telephone: 44 (0)81 606 4100
Fax: 44 (0)81 606 4101

To find out about new Frame products
Frame Technology is committed to improving its products and offering new
ones. At any time, you can call to find out about new Frame products.
■

In the United States and Canada, contact your local sales support representative or
call (800) U4-FRAME [(800) 843-7263].

FRAME DEVELOPER’S KIT
Frame Technology provides the Frame Developer’s
Kit (FDK) for people who want to control
FrameMaker sessions and create applications.
The FDK consists of three parts: the Frame
Application Program Interface (API), the Frame
Development Environment™ (FDE), and the
Frame Intermediate Printer Language (IPL).
With the API, you can write C programming
language applications that take control of a
FrameMaker session and communicate
interactively with the FrameMaker user. The API
gives your application direct access to the text and
graphic objects in a document. Using the API, your
application can do anything a real user can do, and
more. For example, you can create grammar

API

A-6

Using FrameMaker

checkers, voice-control utilities, version-control
utilities, filters, and database publishing packages.
The API consists of header files, function libraries,
sample source code, and utilities.
The FDE provides a way to create
applications, across platforms and across Frame
products, by simply recompiling. The FDE includes
a set of header files, libraries, wrappers, and
makefiles for each supported platform, as well as a
variety of utilities.

FDE

IPL The IPL lets you customize the X Windows
version of FrameMaker to use a page description
language other than PostScript.

For information on ordering the FDK, see “To order
other Frame products” on page A-5.

Ordering Frame products
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Outside the United States and Canada, call your local Frame distributor or reseller. In
Europe, you can contact Frame at the following address.

Frame Technology International Limited
3 Furzeground Way
Stockley Park
Uxbridge, Middlesex UB11 1DE
United Kingdom
Telephone: 44 (0)81 606 4100
Fax: 44 (0)81 606 4101

COMPANION PRODUCTS
Frame offers a wide family of products that can
help solve your document management needs.
Localized versions of
FrameMaker are available in a number of
languages. For information on the availability of
localized versions, contact your local sales
representative.

Localized versions

Many Frame products include the FrameMaker
International Dictionaries; but if you don’t already
have them, you can order them. For a list of
languages and how to order them, see “Languages
available” on page 9-8.
Thesauruses are available in several languages.
For more information, see “How FrameMaker
determines the language to use” on page 9-19.
FrameMaker for other platforms FrameMaker
documents are cross-platform compatible. If you
work on a network with other platforms, you may
want to order FrameMaker for the other platforms.
FrameMaker+SGML This unique product has all
the functionality of FrameMaker, plus the ability
to easily create precisely structured documents
based on rules that specify the order and content of
information and provide context-sensitive
formatting. The FrameMaker+SGML™ product
includes many functions and utilities to facilitate

creating and using Standard Generalized Markup
Language (SGML) documents so that you can
import and export documents across different
publishing technologies.
FrameReader lets you distribute
hypertext-navigable, view-only versions of Frame
documents. These documents can be searched and
printed on demand. FrameReader is included in
the CD-ROM edition of FrameMaker and may be
freely distributed for noncommercial use.

FrameReader

FrameViewer provides all the online
functionality of FrameReader, along with
additional features. FrameViewer can read both
FrameMaker format and Maker Interchange
Format (MIF) and is customizable with the Frame
Developer’s Kit (FDK).

FrameViewer

Document management Frame has a family of
document management products that are
particularly useful when you have a number of
authors contributing to a document or need to
route several documents for review or approval.
These products provide indexed or hierarchical
storage; many kinds of retrieval; security; support
for any file and media type; special integration of
FrameMaker documents; integration of scanned
documents; and version control.

Using FrameMaker
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Finding out about third-party products and services

PRODUCT SUGGESTIONS

We are always interested in your comments and suggestions for improving
FrameMaker.
Send us your comments by fax, electronic mail, World Wide Web, or regular
mail. Please mark your comments Attention: Product Development. For
addresses and phone numbers, see page A-2 and page A-4.

FINDING OUT ABOUT THIRD-PARTY PRODUCTS
AND SERVICES
There are hundreds of third-party products that work with or complement
FrameMaker. Frame can help you find a third-party product to suit your needs.
The FrameConnections Catalog is a resource guide to applications, clip art,
printers, utilities, training centers, and the like. The catalog also includes
listings for consultants and service bureaus.

To find out about a third-party product or service
You can obtain the FrameConnections Catalog—an extensive catalog of Frame
third-party products.
■

In the United States and Canada, contact your local sales support representative or
call (800) U4-FRAME [(800) 843-7263] and ask for a copy of the FrameConnections
Catalog.

■

Download an online version of the catalog by accessing Frame’s forum on
CompuServe, Frame’s bulletin boards, or Frame’s ftp site.

There are three versions of the catalog: fconnect.z (UNIX version),
fconnect.zip (Windows version), or fconnect.hqx (Macintosh version).
For information on Frame’s bulletin boards, see page A-3. For information on
Frame’s ftp site, see page A-4.
■

Using any World Wide Web browser, open this Uniform Resource Locator (URL) site:

http://www.frame.com/PARTNERS/Partners.doc.html
■
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Outside the United States and Canada, ask your local Frame distributor or reseller for
a copy of the FrameConnections Catalog.
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You use FrameMaker utility programs to perform batch operations on
FrameMaker files and to convert files from one graphic or text format to
another.
The utility programs are stored in the same directory as the main FrameMaker
program files. If you can start FrameMaker from any directory, you can also
start the utility programs from any directory. However, if you must change to a
particular directory to start FrameMaker, you must also change to that
directory to start one of the utilities.
This appendix describes the following utilities in alphabetical order.
Utility
Purpose
Page
..........................................................................

fmbatch

Opens, prints, reformats, and saves FrameMaker
files without actually displaying them

B-1

fmcopy

Copies FrameMaker installation files from one file
system to another

B-12

fminvert

Inverts a monochrome bitmap

B-12

fmprint

Prints FrameMaker files without opening and
displaying them

B-12

xwd8to1

Converts color images to monochrome

B-13

FMBATCH
You use fmbatch to open, print, reformat, and save FrameMaker files without
actually displaying them. If the files are structured documents or books created
with FrameMaker+SGML, you can also use fmbatch to validate them. (For
information, see the documentation for FrameMaker+SGML.)
If you have a local or remote connection to an X server, you can use fmbatch
directly at your graphics workstation or in a remote shell from a nongraphics
terminal.
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fmbatch

You perform fmbatch operations by issuing fmbatch commands. You can
store commands in a text file—a batch file—and issue all the commands in the
file at once, or you can issue commands one at a time (interactively).
For example, the following fmbatch commands open, update, print, save, and
close a file:
Open MyFile
Update MyFile
Print MyFile
Save MyFile
Quit MyFile
Notice that fmbatch commands are case-sensitive. For example, Print is a
valid fmbatch command, but print is not.
You can use fmbatch in shell scripts to automate some simple FrameMaker
operations. For example, a shell script may use fmbatch to generate a book
file, save all documents in Maker Interchange Format (MIF), edit the MIF files
to set the document’s window position and size, and convert the MIF files back
to documents.
For a list of fmbatch commands, see “fmbatch commands” on page B-3. For
detailed instructions on using fmbatch, see the pages indicated below.
For information on
See page
..........................................................................
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Using fmbatch for batch operations

B-3

Using fmbatch interactively

B-5

Printing messages to standard error output

B-6

Opening a file

B-6

Verifying that FrameMaker is still running

B-7

Printing an open file

B-7

Closing a file or exiting fmbatch

B-8

Saving an open file

B-8

Executing a UNIX command

B-9

Updating cross-references and generating files

B-10

Importing the formats from one document to another
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To use fmbatch for batch operations
You use batch files to perform the same set of operations frequently. For
example, you can create a batch file to open, print, and close a book file. Each
time you print a draft of the book, you can use the same batch file. Because you
use batch files to issue several commands at once, you don’t have to monitor the
results of each command.
You can use a shell script to build an fmbatch batch file. Doing this lets you
process many different directories of FrameMaker documents without worrying
about their filenames.
When you store a batch file in the directory that contains the files you want to
use, you won’t have to use full pathnames in your fmbatch commands.
Otherwise, you use either absolute or relative pathnames.
■

To create a batch file, use any standard text editor.

When you use FrameMaker to create the file, save the file in Text Only format.
■

To add an fmbatch command to a batch file, type the command on a
separate line.

To add a comment, type a number sign (#) at the beginning of the line.
fmbatch interprets the whole line as a comment.
■

To run fmbatch using a batch file, type fmbatch batch_file at any UNIX shell
prompt.

batch_file is the name of a batch file that contains fmbatch commands.

FMBATCH COMMANDS
echo Prints messages to standard error output

Quit

help or ?

Save

Displays a list of fmbatch commands

ImportFormats Updates the formats in an open
document or in all the documents in a book file,
using the formats from another open document
Open

Opens a document or book file

OpenTextFile
ping

Opens a text file

Verifies that FrameMaker is still running

Prints an open file, using its own print
settings or the print settings from another file

Print

Closes a file or exits fmbatch
Saves an open file

SaveAs Saves an open file, using a different name
or format
system

Executes a UNIX command

Update Updates cross-references and generates
all the generated files in an open book

Validates the contents of an open
structured document or book (see the
documentation for FrameMaker+SGML)

Validate

Using FrameMaker
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fmbatch

The fmbatch program starts FrameMaker, executes all the commands in the
batch file, and then exits. Messages appear as fmbatch processes the
commands.
ECHOING FMBATCH COMMANDS

To echo each command as it’s executed, start fmbatch with the -v option,
using the following statement: fmbatch -v batch_file

FMBATCH FILE EXAMPLE
Here is an example of a C-shell script that builds a batch file to save all documents in the current directory
as MIF files. To use this script, type it in exactly as shown, then change to the directory that contains the
documents you want to process, and type the full path to the script. The script creates a batch file in the
current directory that you can use with fmbatch.
*** batch file ***
#! /bin/csh -f
# C shell script to build an fmbatch command file
# that saves all documents in the current directory
# as MIF files
set scriptname = createbatch
set batchfile = commands.batch
rm -f $batchfile >& /dev/null
touch $batchfile
foreach f ( * )
# don’t add directories or the batch file
if ( ! -d "$f" && "$f" != "$batchfile" ) then
echo "Open $f" >> $batchfile
echo "echo Saving $f to $f.mif" >> $batchfile
echo "SaveAs m $f $f.mif" >> $batchfile
echo "Quit $f" >> $batchfile
endif
end
echo ""
echo "$scriptname is done. See batch file in $batchfile."
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USING QUOTATION MARKS IN FMBATCH COMMANDS

You can use quotation marks as part of a filename. If the filename includes
single quotation marks, enclose the statement in double quotation marks. If the
filename includes double quotation marks, enclose it in single quotation marks.
For example: Open "My 'Unquotable' Quotes File"

To use fmbatch interactively
Use commands interactively (one at a time) for operations that you perform
infrequently.
■

To start fmbatch, type fmbatch at any UNIX shell prompt and press Return.

If you have a single Frame product installed on your computer, whether
FrameMaker, FrameMaker International Edition, or FrameMaker+SGML,
fmbatch starts it and displays a prompt (fmbatch->).
When you run fmbatch from the directory that contains the files you want to
use, you won’t have to use full pathnames in your fmbatch commands.
Otherwise, you use either absolute or relative pathnames.
STARTING FMBATCH WITH MORE THAN ONE FRAME PRODUCT

If you have more than one Frame product installed, you can use the following
fmbatch options to start a specific product.
To start
Type
........................................................................

FrameMaker

fmbatch -makername maker

FrameMaker
International Edition

fmbatch -makername imaker

FrameMaker+SGML

fmbatch -makername makersgml

FrameMaker+SGML
International Edition

fmbatch -makername imakersgml

When you have both FrameMaker+SGML and FrameMaker installed on your
computer, and you enter fmbatch at a UNIX shell prompt, fmbatch starts
FrameMaker+SGML.
■

To execute an fmbatch command, type it at the prompt and press Return.

Messages appear as fmbatch processes the command. When it finishes
processing the command, fmbatch displays its prompt so you can enter
another command.
If you receive a message telling you that a file doesn’t exist, make sure you used
the correct pathname.

Using FrameMaker

B-5

FRAMEMAKER UTILITIES

B

fmbatch

For a list of fmbatch commands and their use, type help or ? at the
fmbatch prompt.
■

To exit fmbatch, type Quit and press Return.

You can also press Control-d.

To print messages to standard output
You can print status messages to indicate progress in processing a batch file.
■

To print status messages, use the echo message command.

message is the text you want to print.
EXAMPLE

The following commands open a file, save it in the normal format with a
different filename, and then echo the message File renamed.
Open /usr/doc/MyOldFile
SaveAs d /usr/doc/MyOldFile /usr/doc/MyNewFile
echo File renamed

To open a file
You can open any type of file with fmbatch that you can open with the
FrameMaker Open command. You must open a file with fmbatch before you
can perform any other fmbatch operations on it.
■

To open any type of file that FrameMaker can open, use the Open filename
command.

filename is the name of the file you want to open.
■

To open a text file, use the OpenTextFile type filename command.

filename is the name of the file you want to open; type is one of the following
file types.
To open this file type
Use this option
..........................................................................

A line-oriented text file (in which each line is treated
as a separate paragraph)

a

A paragraph-oriented text file (in which consecutive
nonempty lines are considered part of a paragraph,
and an empty line signifies a paragraph break)

t

EXAMPLE

The following command opens MyTextFile, a paragraph-oriented text file.
OpenTextFile t MyTextFile
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To verify that FrameMaker is still running
You can verify that the copy of FrameMaker started by fmbatch is still
running.
■

Use the ping command.

If FrameMaker is still running, this message appears:
Calling Frame... done.
If FrameMaker isn’t running, these messages appear:
Calling Frame... done.
fmbatch: unable to raise Frame; exiting.

To print an open file
You can print a file that you opened with fmbatch. You can also use all the
print settings from a different FrameMaker document. For example, you may
want to print to a PostScript print file rather than print to a printer. Or you
may want to send a group of documents to a particular printer, printing the
documents’ last sheet first.
If the open file you’re printing is a book file, fmbatch prints the entire book. If
you print a book file to a PostScript print file, fmbatch creates a single large
PostScript file.
You must open the file and the print settings file (if you’re using one) with
fmbatch before you print. Otherwise, fmbatch displays an error message.
■

To print a file with its own print settings, use the Print filename command.

filename is the name of the file you want to print.
■

To print a file with the print settings from another FrameMaker document, use the
Print filename settings_file command.

filename is the name of the file you want to print. settings_file is the
name of the FrameMaker document that contains the print settings you want
to use.

Using FrameMaker
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EXAMPLE

The following command prints MyDocument with the print settings from
PrinterLastSheet, another document that has been set up to print its last
sheet first.
Print MyDocument PrinterLastSheet
To set up print settings in the other document, open the document with
FrameMaker and choose the Print command. Specify the settings you want in
the Print dialog box and click Save Settings Only. Then save the document.
If the print settings document is set up to print to a file rather than to a printer,
fmbatch prints to a file whose name is based on the name of the document or
book you’re printing. For example, if you’re using a print settings document
that prints to a PostScript file, fmbatch prints the file MyDocument to the
file MyDocument.ps and places MyDocument.ps in the same directory as
MyDocument.

To close a file or exit fmbatch
When you close a file or exit fmbatch, the program doesn’t check whether you
saved changes. So be sure to save any changes you made.
■

To close a file, use the Quit filename command.

filename is the name of the file you want to close.
You must specify a filename when you use the Quit command. Otherwise,
fmbatch exits.
■

To exit fmbatch, use the Quit command.

fmbatch closes all open files and then exits. fmbatch exits, automatically,
when it reaches the end of a batch file.

To save an open file
You can save an open document or a book file with the current filename and
format. You can also save a file with a different name or format.
When you save a document with fmbatch, it does not give you a warning about
overwriting an existing file. If a document with the name exists, fmbatch first
renames the original file, giving it a .backup suffix, and then saves your
changes under the original name.
■

To save a file with its current name and format, use the Save filename command.

filename is the name of the file you want to save.
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To save a file with a different name or format, use the

SaveAs option source_file destination_file command.
source_file is the name of the file you want to save. destination_file is
the name with which to save it. option is one of the following single-character
codes for the file format in which to save.
To save in
Use this option
..........................................................................

Normal format

d

View Only format

l (lowercase L)

Paragraph-oriented text format

t

Line-oriented text format

a

Interchange format (MIF)

m

The current format

- (hyphen)

Specify only one format. If you don’t specify a format, fmbatch saves the file
in its current format (the format in which it was opened). You cannot use the l,
t, or a option when saving a book file. If a document is in View Only format,
you cannot save it in Normal format with the SaveAs command.
EXAMPLE

To save the document MyReport as a FrameMaker document in the
Interchange format, use the following command.
SaveAs m MyReport MyReport.mif

To execute a UNIX command
You can execute UNIX commands from within fmbatch. For example, you may
want to copy or move files after you process them.
■

Use the system "command" command.

command is any UNIX command you can type—within single or double
quotation marks—in an xterm window at a shell prompt.
fmbatch passes the command to sh(1) for execution.
EXAMPLE

To copy the file MyFile from your home directory to the /tmp directory, use
the following command.
system "cp ~/MyFile /tmp/MyFile"

Using FrameMaker
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To update cross-references and generate files
You can update all cross-references in a document or book.When you update
the cross-references in a book, fmbatch also regenerates all generated files in
the book.
You must open the file with fmbatch before you generate or update files.
Otherwise, fmbatch displays an error message.
When you use a batch file to update cross-references and to generate files,
fmbatch quits when it runs into an error such as an unresolved crossreference or a missing file.
■

Use the Update filename command.

filename is the name of the file you want to update.

To update an open document’s format from another document
You can import and update the formats in a document or in all files in a book.
For example, you may want to update paragraph and character formats to use
different fonts throughout a book.
You must use fmbatch to open both the document or book into which you are
importing formats and the document or book from which you are importing
formats before you update the document or book. Otherwise, fmbatch
displays an error message.
■

Use the ImportFormats options filename filename_with_formats
command.

filename is the document or book into which you want to import formats.
filename_with_formats is the document from which you want to import
formats. options includes one or more of the following one-character codes
for the formats that you can import.
To copy
Use this option
..........................................................................
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Paragraph formats

p

Character formats

f

Page layouts (master pages)

l (lowercase L)

Cross-references

c

Variable definitions

v

Reference pages

r

Table formats

t

Conditional text settings

x

fmbatch
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To copy
Use this option
..........................................................................

Color definitions

k

Math definitions

m

You can specify any combination of options you want. If you don’t specify an
option, fmbatch imports all formats.
FrameMaker normally does not remove manual page breaks and other format
and layout overrides when you import and update formats. However, when you
import and update formats with fmbatch, it removes these format overrides.
The following two options allow you to preserve manual page breaks and other
format and layout overrides when you import and update formats with
fmbatch.
To preserve
Use this option
..........................................................................

Manual page breaks

B

Other format and layout overrides

O (the uppercase letter O)

The options correspond to the settings available with the Import>Formats
command on the File menu. For information on the settings, see “Importing
formats into a document” on page 21-12.
EXAMPLE

The following command imports the conditional text settings and color
definitions from MyTemplate to MyNewFile while preserving the manual
page breaks in MyNewFile.
ImportFormats x k B MyNewFile MyTemplate
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FMCOPY
The fmcopy script copies a directory from one place to another, preserving
symbolic links and permissions. Use it to copy FrameMaker installation files
from one file system to another. For example, to copy FrameMaker installation
files from the directory /var/frame to the directory /var/FrameMaker,
type:
fmcopy /var/frame /var/FrameMaker
For complete instructions on using fmcopy, type fmcopy at any UNIX shell
prompt.

FMINVERT
You use the fminvert binary to invert a monochrome Sun rasterfile or X11
xwd 1-bit image so that portions previously black appear white and portions
previously white appear black.
■

Type the following command at any UNIX shell prompt.

fminvert filename inverted_filename
filename is the name of the file you want to invert; inverted_filename is
the name of the inverted file. You can’t invert a gray-scale or color image.

FMPRINT
You use the fmprint script to print one or more FrameMaker documents or
books without opening and displaying them. You can use the print settings from
a different FrameMaker file.
■

To print a file using its own print settings, use the fmprint filename command.

filename is the name of the file you want to print.
■

To print a file using the print settings from another FrameMaker document, use the
fmprint -p settings_file filename command.

settings_file is the name of a FrameMaker document that contains the
print settings you want to use. filename is the name of the document or book
you want to print. fmprint works with the print settings from another
document just as the fmbatch Print command does. For details, see “To
print an open file” on page B-7.
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XWD8TO1
You use the xwd8to1 binary to convert color X11 xwd images to monochrome
images. Although you can import color xwd images directly into a FrameMaker
document, there are several situations in which you may want to convert an
image to monochrome first:
• Color images appear in color on color displays and are printed in color on
color printers. Color images are printed in gray scale on black-and-white
printers. When you want to print an image just as it appears on a
monochrome display, convert it to monochrome.
• Color images take up more space on disk than monochrome images. You may
want to convert them in order to conserve file space.
• Converting captured line art to monochrome may help preserve the meaning
and intent of the image. For example, a schematic diagram might use
different colors to display symbols and connections. When you print, you may
prefer that both be black instead of a gray-scale interpretation of the display
color.
Each color is converted to either black or white. The conversion is controlled by
a cutoff value—between 1 and 100—that determines the intensity at which
colors should be converted to black. An intensity value of 1 causes only black to
be converted to white. An intensity value of 99 causes all colors except white to
be converted to black. If you don’t specify a cutoff value, xwd8to1 uses a value
of 50.
■

Type the following command in an xterm window at a shell prompt.

xwd8to1 -i cutoff_intensity filename filename.mono
filename is the name of the color image. cutoff_intensity is the cutoff
value used to convert colors to black or white. filename.mono is the name of
the converted file.
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A macro is a shortcut for a sequence of keystrokes. You use macros to automate
tasks you perform often—for example, to type a word or phrase you use often or
to fill in a dialog box.
To create a macro, you record keystrokes as you perform a task. You also assign
the macro a trigger—a key sequence you’ll press to play back the macro. When
you press the trigger, FrameMaker plays back the macro as if you were typing
the keystrokes yourself.
You save macros in a macro file. If you use just a few macros from time to time,
you can probably keep them all in one macro file that’s read automatically
whenever you start FrameMaker. If you use macros extensively for several
kinds of activities, you can store your macros in several files.
This appendix describes how to record and play back macros, clear macros from
your workstation’s memory, and manage macro files. It also includes
descriptions of several sample macros.
For information on
See page
..........................................................................
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Before recording macros, become familiar with the FrameMaker keyboard
shortcuts. You’ll then know which keyboard shortcuts you like and for which
you won’t need to create macros. For a complete list of the keyboard shortcuts,
see the Quick Reference.
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To record a macro
While you’re recording a macro, all keystrokes—but not mouse clicks or mouse
movements—are recorded as part of the macro. For information on the
functions that macros can’t perform, see “Limitations” on page C-4.
1

Choose Utilities>Keyboard Macros from the File menu.

2

In the Keyboard Macros dialog box, turn on Record a New Macro and click Begin.

3

When FrameMaker asks whether you want to begin recording keys, click OK.

You can verify that FrameMaker is recording keystrokes by displaying the
File>Utilities submenu with the mouse. While recording keystrokes,
FrameMaker changes the Keyboard Macros command to Stop Recording Keys.
4

Type the keystrokes you want FrameMaker to record.

When you press a key, FrameMaker records it and carries out its normal
function.
If you make a mistake while recording a macro, choose Utilities>Stop Recording
Keys from the File menu. Then click Cancel in the dialog box that appears.
5

When you finish recording keystrokes, choose Utilities>Stop Recording Keys from the
File menu.

6

In the dialog box that appears, press the key or combination of keys you want to use
as a trigger.

The trigger can contain up to 15 keystrokes. As you type the trigger, characters
appear in the text box. Most keys appear as you’d expect. However, some
function and modifier keys appear differently. Some examples are shown in the
following table.
This key
Appears as
..........................................................................

F2, … F9

/F2, … /F9

Control

^

Meta

~

Shift

+

Esc

\!

For details on triggers you can use, see “Macro triggers” on page C-3. If you
don’t type a trigger, FrameMaker cancels the recording.
7
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When you finish typing the trigger, click Continue.
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In the dialog box that appears, type a comment for the macro, if appropriate.

Consider typing a comment for any macro you plan to keep. The comment,
which is optional, reminds you what the macro does. Include the macro’s trigger
and purpose with the comment. For example, if you create a macro that types
the word FrameMaker, you might add a comment like this:
Control-2: types FrameMaker
When you add the macro to a macro file, the comment is saved with the macro.
9

When you finish typing the comment, click Continue.

MACRO TRIGGERS
You can use any key on the keyboard for a macro
trigger, but you should avoid using a key that
already has a function assigned to it. For example,
if you use the Tab key as the only key in a trigger,
you won’t be able to insert a tab in text. Also, avoid
using keys that are already used for built-in
keyboard shortcuts. For a list of keyboard
shortcuts, see the Quick Reference.

This key sequence
Means
................................................

A trigger can include any combination of the
Control, Shift, and Meta keys. For example,
Control-8 and Meta-Control-8 are both valid.
You might choose one key to be the first in all your
macro triggers. For example, you might choose
Control-5 as a macro key and create triggers such
as Control-5 s m (to search for a marker symbol)
and Control-5 s a (to search for an anchor symbol).
Never use Esc or Control-r and the first letter of a
menu name as the only keys in a trigger, or you’ll
disable all the shortcuts for that menu. Also be
careful not to disable existing shortcuts or macros
with a new trigger. For example, if you choose
Esc e as a trigger, you can’t use the shortcuts for
the commands on the Edit menu.
Certain keys and key combinations have special
meanings when you’re assigning a macro trigger.

Backspace, Delete,
and Control-h

Delete the last trigger
keystroke

Control-u

Delete the whole trigger

Return, Control-]

Accept the trigger (clicks OK)

Tab

Move to the next setting

Shift-Tab

Move to the previous setting

Control-Tab

Move to the first setting

Control-c

Cancel the macro (clicks
Cancel)

To use these keys or key combinations in a trigger,
precede them with a backslash (\). The backslash
disables the special meaning of the next key typed
so you can use it as part of the trigger. For
example, suppose you want to use the key
combination Control-g Delete as a trigger. To
prevent Delete from deleting the previous
character in the trigger, type a backslash and then
press Delete. The trigger appears as ^g\Delete.
To include the backslash itself in a trigger, type it
twice.
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LIMITATIONS

FrameMaker can work with about 250 macros at a time. A macro can contain
up to 600 values. The Esc key and all characters are specified internally with
one value. Most other keys—for example, the space bar, Return key, and
function keys—are specified with two values. A few keys require three values.
There are a few things macros can’t do. In particular, a macro can’t:
• Pause for keyboard input and then continue
• Record mouse clicks or mouse movements
• Record the F10 keyboard shortcut that moves the focus to the menu bar
• Record the F4 keyboard shortcut that displays the Maker menu
CHANGING BUILT-IN KEYBOARD SHORTCUTS

FrameMaker has an extensive set of built-in keyboard shortcuts for editing text
and for choosing FrameMaker commands. If using macros doesn’t give you the
level of customization you need, you can add, change, or delete the built-in
shortcuts. For more information, see the online manual Changing Setup Files.

To play b ack a macro
When you play back a macro, FrameMaker responds as if you were typing the
keystrokes stored in the macro yourself.
■

Type the macro’s trigger.

Depending on the purpose of the macro, you may need to select text or objects
before typing the trigger. For example, if the macro changes the format of the
current paragraph, put the insertion point in a paragraph before typing the
trigger.

To cancel a macro
You can cancel a macro while it’s playing.
■
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Point in the document window and press Control-c.
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MANAGING MACRO FILES
When you record a macro, FrameMaker keeps it temporarily in memory and in
~/fmMacrosLog as one of your current macros. It remains there until you exit
FrameMaker or clear the current macros. When you exit FrameMaker, you’re
prompted to save any newly recorded macros. If you want to use the macros in
future editing sessions, add them to a macro file.
When you start FrameMaker, it reads macros from the first fmMacros file it
finds in the following directories. FrameMaker looks in the directories in this
order:
• The fminit directory in the directory where you started FrameMaker
(./fminit)
• The directory where you started FrameMaker (.)
• The fminit directory in your home directory (~/fminit)
• Your home directory (~)
You can also create special macro files for specific tasks, reading them into
FrameMaker as needed. For example, you can record special macros for specific
graphics tasks—such as aligning and distributing objects—and store them in a
different macro file. When you need to perform these tasks, you can read the
macros into FrameMaker and use them. When you’re finished, you can clear the
macros and then read your standard macros back in.

To save macros in a file
To save macros, you add them to a macro file. FrameMaker adds any macros
you recorded since the last time you saved or cleared them.
1

Choose Utilities>Keyboard Macros from the File menu.

2

In the Keyboard Macros dialog box, select a macro file by using the text box and
scroll list.
To
Do this
..........................................................................

3

Add the macros to your
standard set of macros

Make sure fmMacros is selected.

Add macros to a different
macro file

Select the file in the scroll list or type the
filename in the text box.

Create a new macro file

Type a new filename in the text box.

Turn on Add New Macros to File and click Begin.

Using FrameMaker
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To clear the current macros
When you record macros or read them from a file, the macros are stored in your
workstation’s memory and are the current macros. You can clear the current
macros from memory at any time. Clear the current macros, for example, if you
accidentally create a macro that disables an important key. You might also
want to clear macros before reading a special macro file.
Before clearing macros, make sure you save them if you recorded macros that
you want to use again; FrameMaker won’t warn you if you’re clearing macros
you haven’t added to a macro file.
When you clear macros, FrameMaker also clears shortcuts that were added in a
menu customization file during the session. For information on menu
customization files, see the online manual Changing Setup Files.
1

Choose Utilities>Keyboard Macros from the File menu.

2

In the Keyboard Macros dialog box, turn on Clear Current Macros and click Begin.

To read macros from a file
While working, you can read macros from any macro file. Doing so merges the
macros in the file with the current macros. If a macro in the file uses the same
trigger as a current macro, the macro in the file replaces the current macro. If
you want to replace all the current macros with the macros in a file, clear the
current macros before you read the macros from the file.
1

Choose Utilities>Keyboard Macros from the File menu.

2

In the Keyboard Macros dialog box, select a macro file by using the text box and
scroll list.

3

Turn on Read Macros from File and click Begin.

To delete a macro
If you already use a trigger for a macro, and if you want to use the same trigger
for a different macro, simply record the new macro. Even though FrameMaker
saves both macro definitions, it uses only the most recent macro definition for
the trigger.
If you used a trigger that disables an important keyboard function by mistake—
for example, the Tab key—you need to delete the macro. If you just recorded the
macro, you can clear the current macros. But if you have other newly recorded
macros you want to save, or if the macro has already been added to the file,
you’ll need to delete the macro from the macro file.
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1

Save any newly recorded macros in a macro file.

2

Using FrameMaker or any standard text editor, open the macro file and delete the
macro definition.
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The macro file is a text file. If you use FrameMaker, save the file as Text Only.
3

In FrameMaker, clear the current macros.

The macro you deleted is no longer in your workstation’s memory.
4

Read the edited macro file back into FrameMaker.
IDENTIFYING THE MACRO YOU WANT TO DELETE

If it’s difficult to read the actual keystrokes stored in the macro file, you can
usually identify the macro from the comment.
Macro comment

Macro definition

Types pathname for working directory
<Macro Macro15
<Label Macro15>
<Trigger ^p>
<TriggerLabel ^p>
<Definition \/usr\/doc\/Manual>
<Mode NonMath>
>

SAMPLE MACROS
You can use macros for simple tasks such as typing words or phrases you use
often, inserting a variable, and applying a format from a catalog. The sample
macros in this section are more complex. Most of them involve working with
dialog boxes—for example, changing an anchored frame or searching.
To record a macro that uses a dialog box, you’ll need to know the keyboard
shortcuts for moving around and changing settings in a dialog box. To record a
macro that uses another window, such as the Paragraph or Character Designer,
you’ll also need to know the keyboard shortcuts for redirecting input to the
other window. For a list of these keyboard shortcuts, see the Quick Reference.

Using FrameMaker
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To create a macro that uses a dialog box
This procedure shows you how to create a macro that uses a dialog box. For
specific examples, see the following two procedures.
1

Start recording the macro.

2

Use a keyboard shortcut to display the dialog box.

3

Press Control-Tab to move to the first setting in the dialog box.

Pressing Control-Tab ensures that the macro always starts filling in the dialog
box at the same setting.
4

Specify each setting of importance to you even if it’s already correct.

Specifying each setting ensures that the macro plays back in the same way no
matter what state the dialog box is in when the macro starts. To move forward
from setting to setting, press Tab. To move backward, press Shift-Tab.
5

Press Return to accept the settings and to close the dialog box.

Pressing Return has the same effect as clicking the default command button as
long as keyboard input is not directed to any other command button in the
dialog box. If you want the macro to click a different command button, tab to
the button and then press Return.
6

Stop recording the macro.
CREATING A MACRO THAT USES MORE THAN ONE WINDOW

When you create a macro that uses more than one window, use the keyboard
shortcuts to display and navigate through the window. When you are finished
with the window, press Esc F i d to redirect the pointer back to the document.

To chang e an anchored frame
You may want to make sure that all anchored frames in a document are the
same. To do so, record a macro that fills in the Anchored Frame dialog box with
the correct settings.
The macro in this example creates an anchored frame below the current line,
centers it within the text frame, turns on Cropped, turns off Floating, and
makes the frame 5 inches wide and 3 inches high. For general instructions on
creating a macro that uses a dialog box, see the previous procedure.
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Select an anchored frame you want to change.

2

Start recording the macro.
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3

Press Esc s a to display the Anchored Frame dialog box.

4

Press Control-Tab to move to the Anchoring Position pop-up menu, the first setting in
the dialog box.

5

Press the space bar to display the Anchoring Position pop-up menu.

6

Type 0 (zero) to make the Below Current Line menu item active and press Return.

Typing 0 (zero) moves to the first pop-up menu item. Type 0 (zero) even if
keyboard input is already directed to the first menu item, because it might not
be when you play back the macro.
7

Press Tab to move to the Alignment pop-up menu and press the space bar to display
the pop-up menu.

8

Type 0 (zero) to move to the first pop-up menu item.

9

Press the down arrow key once to move to the Center menu item and then press
Return.

10

Tab to the Cropped checkbox and type 1 to turn it on.

11

Tab to the Floating checkbox and type 0 (zero) to turn it off.

12

Tab to the Width text box and press Control-u to delete its contents.

13

Type 5 in.

14

Tab to the Height text box and press Control-u to delete its contents.

15

Type 3 in.

Using FrameMaker
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16

Press Return.

17

Stop recording the macro.

To create a macro that searches
Use the Set Find/Change Parameters dialog box to create a macro that
searches. The macro in this example searches for an anchored frame.
For general instructions on creating a macro that uses a dialog box, see “To
create a macro that uses a dialog box” on page C-8.
1

Put the insertion point in a document that contains an anchored frame.

2

Start recording the macro.

3

Press Esc f i s to display the Set Find/Change Parameters dialog box.

4

Press Control-Tab to move to the first text box in the dialog box.

The Find text box becomes active.
5

Press Shift-Tab to move back to the Find pop-up menu.

6

Press the space bar to display the Find pop-up menu.

7

Press 0 (zero) to move to the first pop-up menu item.

8

Press the down arrow key several times until the Anchored Frame menu item is active.

9

Press Return to accept the setting in the Find pop-up menu.

10

Press Return again to accept the settings and to close the dialog box.

Pressing Return has the same effect as clicking the Set button.
11

To start the search, press Esc f i n (for find next).

FrameMaker selects the next anchor symbol in the document.
12

C-10

Using FrameMaker

Stop recording the macro.

Sample macros

.....

KEYBOARD MACROS

To create a macro that displays a dialog box and stops
You may have noticed that you can’t choose the Utilities>Stop Recording Keys
command when a dialog box is displayed. But you can create a macro that ends
after displaying a dialog box. This allows you to create a macro that displays a
dialog box, fills in part of it, and then stops so you can fill in the rest.
This example saves you several keystrokes each time you open a file by
displaying the Open dialog box and by changing directories.
1

Start recording the macro.

2

Press Esc f o.

The Open dialog box appears.
3

Type the name of a directory in the text box and press Return.

The files in the directory appear in the scroll list.
4

Press Control-] to stop recording the macro.

Even though the Enter Trigger dialog box doesn’t appear until you close the
dialog box, the macro contains only the keystrokes you recorded before pressing
Control-].
5

Click Cancel.

The mouse movement and click aren’t recorded as part of the macro.
When you play back the macro, it displays the dialog box, changes directories,
and stops.
CREATING A MACRO THAT BEGINS IN AN OPEN DIALOG BOX

You can create a macro that begins after displaying a dialog box. For example,
you might want to create a macro that sets the format in the Save Document
dialog box and clicks Save. To do so, display the dialog box as you usually do.
Then press Control-] to start recording the macro. A message that tells you
FrameMaker is recording a macro appears in the window where you started
FrameMaker.

To create a macro that repeats
You use two macros to create a macro that repeats: The first macro performs
the task you want to repeat; the second macro plays back the first one several
times by pressing its trigger. To repeat the task several times, you press the
second macro’s trigger.
1

Record the macro you want to repeat.

The macro can be very involved. For example, it might search for the paragraph
tag of a first-level heading, move the insertion point to the next paragraph, and
paste a format that’s on the FrameMaker Clipboard.

Using FrameMaker
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2

Start recording the second macro.

3

While recording, press the first macro’s trigger as many times as you want the macro
to repeat.

4

Stop recording the macro.
CREATING A MACRO THAT REPEATS INDEFINITELY

You can create a macro that repeats until you cancel it. To do so, make the last
keystrokes you record the same as the macro’s trigger.
For example, suppose you want to browse through the pages of a file, pausing
briefly at each page. Record a macro whose first two keystrokes are Control-v
and Control-l (lowercase L)—to display the next page and then redisplay it.
Then record the keystrokes Control-x Control-a. Finally, stop recording the
macro, and specify Control-x Control-a as the trigger. When you play back the
macro FrameMaker executes the keystrokes Control-v and Control-l, and then
executes the keystrokes Control-x and Control-a, which starts the macro all
over again.
To stop the macro, press Control-c.
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This glossary contains industry-wide printing terms as well as terms used in
the FrameMaker manuals. For references to more information about a term,
see the index.
absolute pathname

A pathname that starts with a slash and the root directory name and fully
specifies the file’s location in the file system hierarchy (for example,
/usr/sales/Memo). See also pathname. Compare relative pathname.

active area

In a view-only document, text that surrounds a hypertext marker. An active
area extends to the first change in character format on either side of the
marker.

alignment

Text alignment defines the placement of text—left (ragged right), right
(ragged left), centered, or justified. Graphic alignment defines how objects
align—along their sides, centers, tops, or bottoms. See also justified text; tab
alignment.

alignment point

The point in an equation or a text line at which the contents are aligned. For
example, when you type in a text line that has an alignment point at the
center, the text line expands to the left and right while its center point does
not move.

anchored frame

A graphic frame that is tied to a specific location in the text. An object in an
anchored frame moves with the text as the anchor symbol ( ) moves. See also
graphic frame. Compare unanchored graphic frame.

arrow keys

The four directional keys on the numeric keypad.

As Is setting

A setting indicating that a selection has mixed properties—for example, two
paragraphs with different indents. Also indicates that the property should not
be changed when you apply the settings in the dialog box or window. To
indicate an As Is setting, checkboxes are dim, As Is appears in pop-up menus,
and text boxes are empty.
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ascender

A vertical stroke that extends above the body of some lowercase letters.
Compare descender.
Ascenders

b d k
asymmetrical page
layout

A double-sided page layout in which the left and right page layouts are not
mirror images. They may have different inside, outside, top, or bottom
margins. They may also have a different number of columns, a different gap
between columns, or different side-head settings. Compare symmetrical page
layout.

Autoconnect

A flow property that controls whether FrameMaker generates a new page
when you fill the last text frame of a text flow. If Autoconnect is on,
FrameMaker creates a new page and connects a text frame on the new page
with the text frame on the previous page.

automatic hyphen

A hyphen FrameMaker inserts when it needs to break a word at the end of a
line. See also discretionary hyphen; hyphenation points; suppress
hyphenation.

autonumber

An automatically generated number at the start or end of a paragraph.

background text
and graphics

Text and graphics that appear on body pages exactly as they do on the
corresponding master page. Background text frames, such as headers and
footers, are text frames with no flow tag. All graphics on master pages are
background graphics. See also flow tag; page design; template text frame.

baseline

The imaginary line on which letters and numbers rest.

b d k

Baseline

bitmap

A graphic composed of dots or pixels. Bitmaps are usually created with a paint
program, a screen capture utility, or a scanner. Because you import color and
gray-scale images just as you do bitmaps, this manual uses bitmap to refer to
all of them. See also color image; gray-scale image; pixel. Compare vector.

blank paper document

An empty FrameMaker document you create with the New command in the
main FrameMaker window or on the File menu. Blank paper documents
contain basic formatting information you can use to create your document.

body page

A printable page in a document; where you enter and edit the main text (not
the headers and footers) of a document.

body text

The main text in a document, not including headings.
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boilerplate

Text or graphics that are used repeatedly.

book file

A file that contains the filenames of documents in a book, as well as a
specification for how the files should be paginated and numbered. You use a
book file to perform tasks across all the files in the book—for example, to
generate tables of contents and indexes, manage pagination, print, update
cross-references, and import and update formats. See also generated file.

book window

A window that appears when you open a book file.

border

Nonprinting dashed or dotted lines that mark the edges of text frames and
text columns, imported graphics, tables, and graphic frames. Also refers to the
boundary around objects you draw with the FrameMaker drawing tools—for
example, rectangles, circles, and polygons. Compare selection border.

bounding box

The imaginary rectangle that is just large enough to surround an object.

building blocks

Text used in cross-reference formats, variable definitions, index marker text,
and in the special text flows that determine the format and structure of
generated files.

built-in math element

A mathematical element that appears on the Equations palette. See also
custom math element; math element.

bullet

A character—typically a filled-in or open circle (•) or square (■)—used to
draw attention to an item in a list. Character fonts contain an open-circle
bullet symbol; the Zapf Dingbats font contains a number of special symbols
commonly used as bullets.

callout

A short phrase that defines and highlights important parts of an illustration.
A thin line—a callout rule—usually connects a callout to the corresponding
part of the illustration. Compare caption.

caption

Text that accompanies and identifies an illustration. Compare callout.

capture

To store (in a file on the disk) a rectangular portion of the image on a
workstation’s screen so you can import it into a document. See also bitmap;
import.

catalog

See Character Catalog; Paragraph Catalog; Table Catalog.

change bar

A vertical line in the page margin that indicates an addition, a change, or a
deletion of text.

Character Catalog

Part of a document; contains formats that have been created and stored to
ensure consistent formatting of characters, words, and phrases. Compare
Paragraph Catalog.
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Character Designer

A window you can use to create and change character formats and store them
in the Character Catalog. Compare Paragraph Designer.

character format

The formatting information for characters, words, and phrases. This
information is used to override a paragraph’s default font and can be stored in
the Character Catalog.

character tag

The tag assigned to characters; the name of a format stored in the Character
Catalog.

cicero

A unit of measure used in Europe. One cicero is approximately 4.55
millimeters.

click

To press and release a mouse button. Refers to the left mouse button, unless
otherwise noted.

Clipboard

See FrameMaker Clipboard; X Window System Clipboard.

CMYK

A model used by commercial printers to simulate the appearance of any color
using just four colors of ink—cyan, magenta, yellow, and key (black). Each
color component is printed in a different concentration, depending on how
much is needed to create the desired color. The CMYK model is used to create
color separations for four-color process printing. See also color separation.

color image

A bitmapped graphic that contains 4 to 32 bits of information per pixel to
convey color. See also bitmap; gray-scale image.

color separation

The process of separating color on a page into components. For spot color
separations, FrameMaker prints a separate sheet of paper or film for each
color on each page. For process color separations, FrameMaker prints four
separate sheets (one each for cyan, magenta, yellow, and black) for each page.
The commercial printer uses the separations to create printing plates. On the
press, each plate is printed with the appropriate ink color, eventually
resulting in the complete page. See also process color; registration marks; spot
color.

condition indicator

A change in the way text appears on the screen when it’s tagged as conditional
text—for example, displaying the text in a different color or with an underline.

condition tag

The name of a version of a conditional document. Each condition tag is
associated with condition indicators—format changes that help identify the
versions of a conditional document.

conditional document

A document that contains the text for several versions. You use a conditional
document to produce several similar documents—for example, for similar
products—or to include comments, which you can hide before you print the
final copy.
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conditional text

Text specific to a version of a document. Conditional text is identified by one or
more condition tags identifying the versions the text is in.

crop

To trim a graphic to fit inside an area; to eliminate part of a graphic from
viewing and printing.

crop marks

Lines at the corners of a page that show where the paper is to be cut after
printing. See also registration marks.

cross-reference

A reference to related information in another part of the same document or a
different document.

current page

The page with a darkened border, indicating where FrameMaker will paste
text and objects.

current paragraph;
current table

The paragraph or table that contains the insertion point or selection.

custom math element

A user-defined math element. Custom math elements don’t appear on the
Equations palette. See also built-in math element; math element.

cutout

A method of printing an object when it is overlapped by another object of a
different color. The overlapped area is not printed, leaving it white. The
overlapping color is then printed over the cutout. Compare overprinting;
trapping.

default

A preset value in a dialog box or window.

default font

See paragraph default font.

descender

A vertical stroke that extends below the baseline of some lowercase letters.
Compare ascender.

y p q

Descenders

deselect

To remove highlighting from text or handles from objects.

designer

See Character Designer; Paragraph Designer; Table Designer.

dictionary

A collection of words and hyphenation information that FrameMaker uses to
check spelling and hyphenate words. FrameMaker uses four dictionaries—the
system dictionary, site dictionary, personal dictionary, and document
dictionary.

dictionary header
or footer

A running header or footer that shows the range of information on a page or
on two facing pages. For example, telephone books commonly use dictionary
headers to show the first and last names on the page. See also footer; header.
Compare running header or footer.
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didot

A unit of measure used in Europe. One didot is approximately 0.375
millimeters.

dingbat

An ornamental character such as a bullet, an asterisk, or scissors. You create
dingbats using the Zapf Dingbats or similar special font.

discretionary hyphen

A nonprinting symbol ( ) that marks where a word can be hyphenated. See
also automatic hyphen; hyphenation points; suppress hyphenation.

display equation

An equation that appears in a paragraph of its own. Compare in-line equation.

display units

The units—such as inches or points—that FrameMaker uses to display
measurements in dialog boxes and in the status bar at the bottom of the
document window.

distribute

To position objects an equal distance apart, horizontally or vertically.

double-click

To press and release the mouse button twice rapidly without moving the
mouse. Refers to the left mouse button, unless otherwise noted.

dpi

The setting (dots per inch) that determines the size (scaling) of a bitmap. See
also bitmap.

drag

To hold down a mouse button while moving the pointer.

draw order

The order in which objects are drawn on a page. When FrameMaker displays a
page, the objects on the page are displayed in draw order.

em dash

A dash (—) that is the same width as the point size of the font in use.

em space

A space that is the same width as the point size of the font in use.

emulsion

The photosensitive coating on photographic film.

en dash

A dash (–) that is half as wide as an em dash in the point size of the font
in use.

en space

A space that is half as wide as an em space in the point size of the font in use.

Encapsulated PostScript
(EPS) format

A graphic file format supported by many graphics applications. An EPS file
contains PostScript code for printing and may also contain a preview image
for viewing on the screen. EPSI is a version of Encapsulated PostScript that
contains a generic preview image. EPSI files can be imported and displayed on
the screen on all platform versions of FrameMaker. See also PostScript.

endnote

A note placed at the end of a document. Endnotes provide additional
information on a particular part of the document. Compare footnote.
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end-of-flow symbol

The symbol ( ) that appears at the end of the text in a text flow when text
symbols are visible. You can’t put the insertion point after an end-of-flow
symbol.

EPSI

See Encapsulated PostScript (EPS) format.

expression

Part of an equation. For example, ( x – 2 ) 2 is an expression in 3 ( x – 2 ) 2 + 7 .

extension

See filename extension.

feather

To add space between paragraphs and lines so that text completely fills a text
frame vertically and so that the baseline of the last line of text aligns with the
bottom of the text frame.

filename

The name of a file as it is stored on a disk. See also pathname.

filename extension

The characters that appear at the end of a filename, after a period. For
example, FrameMaker names some documents with an extension of .doc.

filename suffix

The characters that FrameMaker adds to a generated file to identify the type
of information the file contains. For example, a generated table of contents has
a suffix of TOC.

fill pattern

The pattern inside an object’s border. Compare pen pattern.

fixed line spacing

When a paragraph’s line spacing is fixed, FrameMaker doesn’t open up space
to accommodate larger font sizes, characters that are positioned above or
below the baseline, or anchored frames positioned at the insertion point.

fixed-width font

Refers to fonts in which all characters of the same font size are the same
width. For example, in the Courier font, the letter I takes up the same
horizontal space as the letter W. Compare proportionally spaced font.

flip

To change an object by rotating it around its horizontal axis (up/down) or its
vertical axis (left/right).

flow

See text flow.

flow tag

The name of a text flow. On a master page, text frames with a flow tag are
used as template text frames; text frames with no flow tag are used for
background text. Flow tags also determine how column layout changes are
applied to existing pages. When the insertion point is in a text frame, the flow
tag appears in the status bar at the bottom of the document window. See also
background text and graphics; template text frame; text flow.
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font

A complete set of characters (letters, numbers, punctuation, and symbols)
in one family at a single size and weight—for example, 10-point
Avant Garde Bold.

font family

A series of characters with the same design characteristics—for example,
Times.

footer

Text that appears at the bottom of each page—for example, the page number,
date, or chapter title. See also dictionary header or footer; running header or
footer.

footnote

A note placed at the bottom of a page or at the end of a table. Footnotes
provide additional information on a particular part of the document. Compare
endnote.

footnote reference

The number or symbol in the main text of a document that indicates a
footnote.

format overrides

Differences between the format of text or tables in a document and the
corresponding format in the Paragraph, Character, or Table Catalog.

frame

See anchored frame; reference frame; text frame; unanchored graphic frame.

FrameImage

A bitmap graphic file format that FrameMaker can import, display, and print
on each platform it supports.

FrameMaker Clipboard

A temporary storage area in FrameMaker for elements, text, objects, graphic
frames, and paragraph and character formats that you cut or copy within and
between FrameMaker documents. The information remains on the Clipboard
until you cut or copy something else. Compare X Window System Clipboard.

FrameReader

A program that permits only viewing, searching, and printing of hypertextnavigable FrameMaker documents. FrameReader is included in the CD-ROM
edition of FrameMaker and may be freely distributed for noncommercial use.
You can use FrameViewer to provide readers with online information. See also
FrameViewer.

FrameVector

A vector graphic file format that FrameMaker can import, display, and print
on each platform it supports.

FrameViewer

A program that, like FrameReader, permits only viewing, searching, and
printing of hypertext-navigable FrameMaker documents. In addition,
FrameViewer can read documents in Interchange format (MIF) and is
customizable with the Frame Developer’s Kit (FDK). See also FrameReader.
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generated file

A file—such as a table of contents, a list of figures, or an index—created by
extracting paragraphs or marker text from one document or from several
documents in a book. See also book file.

graphic frame

An object that contains text or graphics. See also anchored frame; unanchored
graphic frame.

graphic inset

An image created with a graphic inset editor and imported into a document.

graphic inset editor

A separate application that can create and edit images in a format
FrameMaker can import. You can start a graphic inset editor from within
FrameMaker.

Gravity

A drawing feature used to make the points of one object touch another object.
When Gravity is on, an object attracts the pointer when you draw, resize, or
reshape an object.

gray-scale image

A bitmapped graphic that contains more than 1 bit of information per pixel to
convey shades of gray. For example, an image with 256 shades of gray requires
8 bits per pixel. See also bitmap; color image.

greeking

The representation of text in a small font size as a gray bar on the screen.
Greeked text appears correctly when the document is printed.

group

To combine several objects into one so you can manipulate them as a single
object. After grouping objects, you can move, resize, flip, and rotate the group.
Compare join.

handles

Eight small boxes that appear around a selected object. Use the handles to
stretch or shrink an object. Compare reshape handles.

header

Text that appears at the top of each page—for example, the chapter or section
title. See also dictionary header or footer; running header or footer.

HLS

A model for representing color. HLS is based on three values—hue, lightness
(or luminance), and saturation. Hue specifies the actual color. Lightness refers
to the lightness or darkness of the color. Saturation is the amount of gray in
the color.

hypertext

Refers to the linking and display of related information on different pages or
in different documents. You can use FrameMaker hypertext commands to
create online documents. You can also generate files that include hypertext
links to the source documents.
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hyphenation points

The locations in a word where FrameMaker places a hyphen if necessary. See
also automatic hyphen; discretionary hyphen; suppress hyphenation.

import

To bring text or graphics from other files into a document. Also, to bring
formats from another FrameMaker document into a document.

in-line equation

An equation that appears in line with paragraph text. Compare display
equation.

insertion point

The point ( ) at which text and graphics are inserted or pasted.

inset

See graphic inset, text inset.

join

To combine lines, polylines, arcs, and smoothed polylines into a single complex
outline. Compare group.

justified text

Text that is adjusted to be even on the left and right. See also alignment.

kern

See pair kern.

keyboard shortcut

A keystroke or series of keystrokes you use to perform a task rather than use
the mouse. See also macro.

landscape

The orientation of a page that is wider than it is tall. Compare portrait.

layout

See page design.

layout overrides

Differences between the layout of a body page and the layout of its
corresponding master pages—for example, a different number of columns or
gap between columns, or different margins or side-head settings.

leader dots

Characters (usually periods) used to lead the reader’s eye across the page to
text aligned at a tab stop. Leader dots are frequently used in tables of
contents—for example, Introduction.............................. iii.

leading

The white space between lines in a paragraph, usually measured in points. A
type specification such as 12 on 14 means a 12-point font with 2 points of
leading (pronounced ledding). See also line spacing.

ligature

A combined letter pair such as fi or fl.

line cap

The style of a line end. A line cap can be butt, projecting, or round.

Butt

line spacing
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lock file

A temporary file (with the extension .lck) that FrameMaker creates when
you open a document. FrameMaker uses a lock file to determine whether a
document is already in use.

locked document

See view-only document.

macro

A user-defined keyboard shortcut that types text or plays back a sequence of
commands.

main FrameMaker
window

The small window that appears when you start FrameMaker. The main
FrameMaker window contains five buttons—New, Open, Help, Info, and Exit.

Maker menu

A menu that contains frequently used FrameMaker commands. To display the
Maker menu, point in a document window (except on the menu bar or title
bar), and hold down the right mouse button.

margin

See page margin.

marker

A nonprinting character ( ) you insert to indicate the text of a running header
or footer, an index entry, or a hypertext command. Markers are also used to
indicate conditional text and the source of a cross-reference.

master page

A nonprinting page that contains the page design for body pages. A master
page can include background text and graphics and template text frames.

math element

Item in an equation. For example, variables, operators, and delimiters are all
math elements. See also built-in math element; custom math element.

MIF

An acronym for Maker Interchange Format, a group of statements describing
a FrameMaker document in a text file. MIF is used to exchange information
between FrameMaker and other applications.

MML

An abbreviation for Maker Markup Language. An MML file is a text file that
contains statements that define a document’s contents and format. You can
create an MML file using a word processor. When you open the MML file,
FrameMaker interprets the markup statements and applies the correct
formats.

Normal format

The format in which you usually save FrameMaker documents. Compare Text
Only format; view-only document.

numeric space

A space that is as wide as the font’s zero (0) character.

object

Anything that appears with handles when selected—for example, rectangles,
circles, text frames, and text lines.

Object Selection tool

A tool on the Tools palette that allows you to select only objects. Compare
Smart Selection tool.
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offset

The distance of an object from some point. For example, the offsets for a circle
in a graphic frame are the distance from the left edge of the frame to the left
edge of the circle and from the top of the frame to the top of the circle.

orphan

A line of text at the top or bottom of a column of text that is isolated from the
rest of its paragraph.

overline

A font style in which a horizontal line appears above characters.

Overline
overrides

See format overrides; layout overrides.

overprinting

Printing one color on top of another when two objects in different colors
overlap. Used commonly when a color is overlapped by black. Compare cutout;
trapping.

page design

The column layout (the number, size, and placement of text columns), headers
and footers, and graphic elements on a page. See also background text and
graphics; template text frame.

page margin

The distance between the edge of the page and the edge of the nearest column.

pair kern

To move pairs of characters closer together to improve their appearance.

PANTONE MATCHING
SYSTEM®

A system for specifying ink colors.

paragraph

A block of text ended by a paragraph return.

Paragraph Catalog

Part of a document; contains formats that have been created and stored to
ensure consistent formatting of paragraphs. Compare Character Catalog.

paragraph default font

The font in which text appears unless you override it with a different
character format. The default font is part of a paragraph’s format.

Paragraph Designer

A window you can use to create and change paragraph formats and store them
in the Paragraph Catalog. Compare Character Designer.

paragraph format

The formatting information for a paragraph, including its typography (such as
fonts, spacing, and hyphenation), overall shape (including indents and
alignment), tab settings, and automatic numbering. This information can be
stored in the Paragraph Catalog.

paragraph symbol

The symbol ( ) that appears at the end of a paragraph when text symbols are
visible. If you delete a paragraph symbol between two paragraphs,
FrameMaker merges the two paragraphs into one.
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paragraph tag

The tag assigned to paragraphs; the name of a format stored in the Paragraph
Catalog.

path

The line segments at the center of an object’s border to which objects align
and snap.

Path
Border

pathname

The location of a file or directory on a disk. See also absolute pathname;
filename; relative pathname.

pen pattern

The pattern of an object’s border. Compare fill pattern.

pica

A unit of measure used in printing. There are 6 picas to the inch. Each pica
contains 12 points. See also point.

pixel

The smallest unit of a digitized picture. (The word pixel is derived from picture
element). See also bitmap.

point

A unit of measure used in printing. There are 12 points to the pica and 72
points to the inch. See also pica.

portrait

The orientation of a page that is taller than it is wide. Compare landscape.

PostScript

A page description language published by Adobe Systems Incorporated.
PostScript describes the appearance of text and graphics on printed pages. See
also Encapsulated PostScript (EPS) format.

process color

A color that is printed by combining cyan, magenta, yellow, and black. See also
CMYK; color separation. Compare spot color.

proportionally spaced
font

Refers to fonts in which characters of the same font size vary in width. For
example, in the Times font, the letter I takes up less horizontal space than the
letter W. Compare fixed-width font.

rasterfile

A file that contains a bitmap image (black and white, gray scale, or color).

read-only document

See view-only document.
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reference frame

An unanchored graphic frame that appears on a reference page. Reference
frames can be used above or below a paragraph (as specified in the
paragraph’s format). They can also separate footnotes from other text on a
page. And they can contain the definition for a custom math element.

reference page

A nonprinting page that contains reference frames that can be used above and
below paragraphs or above footnote text. A reference page can also contain
special flows that determine the structure and format of generated files such
as indexes and tables of contents.

registration

The alignment of color separations so that each color is printed in exactly the
right position in relation to the other colors.

registration marks

Marks (
) printed outside the page image area. A commercial printer uses
registration marks to align color separations. See also color separation; crop
marks.

relative pathname

A pathname that includes only the path from a document to another file—for
example, rfiles/Screen1). See also pathname. Compare absolute
pathname.

reshape

To change the shape of a line, polygon, polyline, or freehand curve by moving,
adding, or deleting reshape handles.

reshape handles

Small boxes used to change the shape of an object. Compare handles.

revert

To go back to the last-saved version of a document.

RGB

A model for representing colors on a color monitor by mixing red, green, and
blue light.

rule

A line drawn on a page.

runaround text

Text flowing around a graphic. Compare wordwrap.

running header or footer

A header or footer the text of which depends on the body page’s contents. For
example, a header might contain the text of the current section heading. See
also footer; header. Compare dictionary header or footer.

scale

To adjust the size of an object proportionally.

select

To highlight text and display handles on graphics.

selection border

A border you draw to select several objects at once. Compare border.
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separation

See color separation.

shrinkwrap

To fit a graphic frame tightly around an equation of any size and place the
frame in line with paragraph text.

Small Caps

A character format property that displays lowercase letters in uppercase,
using a smaller font size.

Smart Quotes

A document feature you can turn on to automatically insert the appropriate
left or right single quotation marks (‘’) or double quotation marks (“”) as you
type.

Smart Selection tool

A tool on the Tools palette that allows you to select both text and objects.
When this tool is active, the pointer changes shape as you move it, indicating
whether you select text or an object when you click. Compare Object Selection
tool.

Smart Spaces

A document feature you can turn on to prevent extra spaces when typing,
deleting, or replacing text.

smooth

To round the corners of a polygon, polyline, or freehand line. Compare
unsmooth.

Smoothed

Unsmoothed

Snap

A drawing feature used to draw, move, resize, and rotate objects so they line
up with the snap grid.

snap grid

An invisible grid to which an object snaps when you draw, move, resize, or
rotate it. Compare visible grid.

special text flow

A text flow on a reference page that determines the structure and format of
generated files.

spot color

A color that is printed with a single color ink rather than as a process color.
Spot color is usually used to highlight or emphasize information. For example,
headings in a book can be in a different color from the body text. See also color
separation. Compare process color.

spread

The amount of space added to or subtracted from the normal space between
characters. Spread is expressed as a percentage of an em space.
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status bar

The bar at the bottom of a document window, containing information such as
the tag, object size, page number, and zoom setting.

straddle

In a table, to combine a range of cells so text and graphics can flow across cell
borders as if the combined cells were a single cell. In a text frame, refers to a
paragraph, table, anchored frame, or footnote that spans columns of text.

strikethrough

A font style in which a horizontal line appears through characters.

Strikethrough
subscript character

A character, usually in a smaller font size than the surrounding text, set below
the baseline. Subscripts are used often in science and mathematics—for
example, H2O.

suffix

See filename suffix.

superscript character

A character, usually in a smaller font size than the surrounding text, set above
the baseline. Superscripts are used often for footnote references and in science
and mathematics—for example, b2.

suppress hyphenation

To prevent a word from being hyphenated by inserting a suppress
hyphenation symbol ( ) in the word. See also automatic hyphen; discretionary
hyphen; hyphenation points.

symmetrical page
layout

A double-sided page layout in which the left and right page layouts are mirror
images. They have the same inside, outside, top, and bottom margins. They
also have the same number of columns, the same gap between columns, and
the same side-head settings. Compare asymmetrical page layout.

synchronize

To align the baselines of body paragraphs along a page grid.

system administrator

The person who installs and maintains your FrameMaker installation.

system variable

A built-in variable, used mainly in headers and footers—for example, the
current date, document name, and current page number. See also variable.
Compare user variable.

tab alignment

A tab property that determines the alignment of text at the tab stop. Tab
alignment can be left, right, center, or decimal. See also alignment.

tab stop

The location to which the insertion point moves when you press the Tab key.

Table Catalog

Part of a document; contains formats that have been created and stored to
ensure consistent formatting of tables.
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Table Designer

A window you can use to create and change table formats and store them in
the Table Catalog.

table format

The formatting information for a table, including its indents, alignment, and
placement on the page; the placement of a table title; and the ruling and
shading used for its rows and columns. This information can be stored in the
Table Catalog.

table tag

The tag assigned to tables; the name of a format stored in the Table Catalog.

tag

See character tag, condition tag, flow tag, paragraph tag, table tag.

Tag area

The area on the left side of the status bar at the bottom of the document
window. The Tag area contains the current flow, paragraph, and character
tags. It also contains the current condition tag settings.

template

A document used to create new documents. A template can include all the
formats and other information you need to create a document. It can include
formats in the Paragraph Catalog, Character Catalog, and Table Catalog as
well as page design information such as margins, page numbering, and
headers and footers. It can also include cross-reference formats, variable
definitions, conditional text settings, math and color definitions, and
information on reference pages.

template text frame

A text frame on a master page that has a flow tag. Template text frames are
used to determine the column layout on corresponding body pages. See also
background text and graphics; flow tag; text frame.

text flow

The text in a series of connected text frames. A text flow can also be contained
in a single text frame, not connected to any other. See also flow tag.

text frame

A rectangular object that contains paragraphs of text. Compare text line.

text inset

Text that is imported by reference from another document, from a file created
by another application, or from a text file. A text inset is linked to the text in
the source document. When the source text changes, FrameMaker can
automatically update the inset.

text item

A range of text, usually a few characters, a word, or a phrase within a
paragraph.

text line

An object, created with the Text Line tool on the Tools palette, that contains a
single line of text. Compare text frame.
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Text Only format

A format in which you can save FrameMaker documents. Only the document
text is saved, unformatted. You can edit the resulting file with any standard
text editor. Compare Normal format.

text symbols

Special nonprinting characters that are displayed when Text Symbols is
turned on in the View menu.

Thesaurus

A list of words, with synonyms, antonyms, and related words. Use the
FrameMaker Thesaurus to look up words and to replace words in a document.

thumbnail

A small image of a page. Print thumbnails to see the general layout of several
pages at a glance.

trapping

A technique used to prevent gaps from appearing between objects of different
colors when printing. Compare cutout; overprinting.

trigger

The key sequence that activates a macro.

triple-click

To press and release the left mouse button three times rapidly without moving
the mouse.

unanchored graphic
frame

A graphic frame used to crop graphics. Also used on reference pages for
reference art, which appears above or below a paragraph as part of the
paragraph’s format, separates footnotes from the body text above them, and
defines math elements. An unanchored graphic frame isn’t anchored to text.
See also graphic frame. Compare anchored frame.

ungroup

To separate grouped objects into their constituent objects or groups.

unresolved crossreference

A cross-reference that has a source FrameMaker cannot find.

unsmooth

To remove smoothing from an object that has corners that were rounded with
the Smooth command. Compare smooth.

user variable

A variable you can define to use in the place of text that appears repeatedly—
for example, a product name. See also variable. Compare system variable.

variable

Text that is defined once but that can be used several times. Variables are
updated automatically when the values of the variables change. See also
system variable; user variable.

vector

A graphic composed of mathematically defined lines and curves. Compare
bitmap.

view-only document

A document saved in View Only format; a read-only document.

visible grid

A grid of horizontal and vertical lines used as an aid when drawing, placing,
and resizing objects. Compare snap grid.
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widow

A line of text at the top or bottom of a column of text that is isolated from the
rest of its paragraph.

wildcard

A special character used to broaden or narrow a search.

wordwrap

The automatic continuation of text from the end of one line to the beginning of
the next. Compare runaround text.

X Window System
Clipboard

A temporary storage area in the X Window System for text (not graphics) that
you copy from one application to another. The information remains on the
Clipboard until you copy something else. FrameMaker supports the X11R3,
-R4, and -R5 Clipboard (primary selection). FrameMaker does not support the
X11R2 Clipboard. Compare FrameMaker Clipboard.
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A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
Symbols
See anchor symbols
<> See angle brackets
/ See backslash
• See bullet symbols
^ See caret
: See colon
† See dagger characters
See discretionary hyphens
$ See dollar sign
§ See end-of-flow symbol
See forced line return symbol
! See keyboard shortcuts
See marker symbol
See nonbreaking space
¶ See paragraph symbol
+ See plus sign.
? See question mark
; See semicolon in index entries
[] See square brackets
See suppress hyphenation symbol
See tab symbol
\t See tabs
| See vertical bar

A
abandoning changes 2-31
abbreviations for preset display units 2-22
absolute pathnames
for graphics imported by reference 16-12
for text insets 3-20
absolute tab stops 3-6
accent marks
index sort order for 23-25

typing. See Quick Reference
See also diacritical marks in equations;
languages
Acrobat, converting hypertext documents for 27-36
to 27-39
active areas (hypertext)
character formats of 27-6
cross-references as 27-13
cross-references as, in unlocked
documents 27-30
graphics as 27-7 to 27-8
graphics matrices as 27-17
multiple, in one text area 27-6
nonprinting 27-8
overriding, on body pages 27-7
preparing 27-5 to 27-8
See also hypertext commands; hypertext
documents; hypertext links
Active paragraph tag in generated files 27-30
active window 2-21
Add Fractions command 30-5
adding
background text on master pages 19-6
blank pages to book files 24-23
blank pages at end of documents 18-15
body pages automatically 3-6
body pages, disconnected 20-10
change bars automatically 25-4
change bars in composite documents 25-13
change bars to selected text 25-5
change bars by using character or paragraph
format 25-6
character formats to Character Catalog 5-17
to 5-20
corners to polygons and polylines 14-22
documents to book files 24-7 to 24-8
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fonts. See Managing Frame Products
footers to pages 18-10 to 18-13
generated lists to book files 24-8 to 24-11
handles to objects 14-22
headers to pages 18-10 to 18-13
indexes to book files 24-8 to 24-11
items to lists of expressions in equations 28-12
operands in equations 28-19
pages automatically 3-6
pages, blank, at end of documents 18-15
pages, blank, to book files 24-23
pages, disconnected 20-10
paragraph formats to Paragraph Catalog 5-7,
5-10 to 5-11
points on freehand curves 14-22
rows and columns to matrices in
equations 28-27
sides to polygons and polylines 14-22
square brackets ([]) around matrices in
equations 28-27
table formats to Table Catalog 7-8 to 7-11
table rows and columns 6-16
table titles 7-16 to 7-17
text columns 19-13 to 19-17
text to entries in generated list 22-18
text frames 13-26, 19-14 to 19-17
vertices to polygons and polylines 14-22
words to personal or document dictionary 9-10,
9-15, 9-16
words by using Thesaurus 9-20
See also creating; inserting
addition operators, inserting in equations 28-13
Addition pop-up menu 30-5 to 30-6
adjacent text columns
balancing text across 18-16
feathering text in 18-17
synchronizing text baselines in 18-19
See also columns, text; text frames
Adobe Acrobat, converting hypertext documents
for 27-36 to 27-39
alert boxes, hypertext 27-22
algebra, matrix 30-4
aligning
I-2

Using FrameMaker

anchored frames. See anchored frames,
positioning
cells in equation matrices 29-13
colors (registration) 17-13 to 17-16
display equations 29-9
equations 29-7 to 29-14
equations with text baselines 28-21
graphics 14-10 to 14-11
graphics in table cells 6-13
horizontal list items in equations 29-12
indents with ruler markings 4-14
in-line graphics 15-5
justified text 4-14
lines in multiline equations 29-9
numbers on decimal 4-15
objects 14-10 to 14-11
objects by distributing 14-11
objects to grid 13-6
page numbers in generated lists 22-18
page numbers in indexes 23-23
paragraphs within indents 4-14
tab stops with ruler markings 4-16
table column borders to grid 6-20
tables 7-29
text in adjacent columns 18-16 to 18-21
text with bottom of column 18-17
text at left, right, center 4-14
text line objects 14-10
text at tab stops 4-15 to 4-17
text vertically in table cells 7-34
vertical list items in equations 29-9
See also positioning; snap grid
alphabetic groups in indexes 23-26
alphabetic numbering style
autonumbering with 4-40 to 4-43
page numbering with 18-14
alphabetical order. See sort order, index
alphanumeric characters in equations 28-8
to 28-11
alternate text. See conditional text
alternate versions of documents. See comparing
books; comparing documents; composite
documents; conditional documents
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alternating layouts. See double-sided documents
AM or PM in system variables 12-17
anchor symbol 2-27
moving 15-18
table position and 7-30
anchored frames
changing settings of 15-18
conditional 26-10, 26-12
copying, cutting, and pasting 15-18
copying, from reference pages to body
pages 19-26
creating 15-4 to 15-15
creating, automatically 15-15
cropping 15-6
cropping in (clipping contents of) 15-17
deleting 15-18
drawing properties of 15-20
editing 15-17 to 15-20
editing contents of, in rotated text frames 14-16
equation line breaks in 29-7 to 29-9
equations in 28-4 to 28-8
finding 8-4 to 8-6
floating 15-6
floating, revision pages and 25-8
full-width 15-9
graphics not moving with 15-16
macros for C-8, C-10
moving 15-18 to 15-19
moving, into text column 15-11
in multicolumn layouts 15-9
nonprinting comments in 26-13
obscuring text in 15-6
paragraph formats for 21-8
placing graphics in 15-15
positioning 15-5 to 15-15
positioning, between/outside columns 15-9
positioning, at insertion point 15-5
positioning, in margin 15-12
positioning, in text column 15-6
positioning, at top corner of paragraph 15-13
on reference pages 19-25
resizing 15-20

resizing, by shrinkwrapping and
unwrapping 15-6, 28-21
rotating tables in 6-9
in run-in heads 15-8
running text around 15-13
searching for 8-4 to 8-6
selecting 15-15
straddling columns with 15-9
symbols for 2-27
in table cells 6-13
text in 15-16
and unanchored graphic frames,
compared 14-19
See also graphic frames; reference frames;
unanchored graphic frames
anchoring
graphics. See anchored frames
tables in lines of text 6-4
tables within table cells 6-14
angle brackets (<>)
in autonumber formats 4-40 to 4-44
in cross-reference formats 10-11
in index entries 23-6
in special text flows for generated lists 22-14
to 22-19
in special text flows for indexes 23-21 to 23-22,
23-24 to 23-26
in system variable definitions 12-15
in user variable definitions 12-8
angles
arc start and end 14-22
halftone 17-21
regular polygon start 13-12
rotation 14-14 to 14-16
antonyms, looking up, in Thesaurus 9-18
API (Application Program Interface) A-6
apostrophe (’) 3-8
See also quotation marks
appendixes. See book files; chapter numbers
Application Program Interface (API) A-6
application programs
hypertext commands to execute 27-24
links to graphics in 16-15 to 16-17
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See also file formats; graphic file formats;
graphic insets; imported graphics; text
insets
Apply Rule command 30-17
applying
Character Designer properties 4-8, 5-8
character formats from Character Catalog 5-6
character formats to characters with certain
tags 5-7
colors 17-4 to 17-6
condition tags 26-9 to 26-14
flow tags 20-7, 20-9
formats to text 5-5 to 5-10
master pages to body pages 19-7 to 19-9
no master page to body pages 19-21
paragraph default font to text 5-7
Paragraph Designer properties 4-7, 5-8
paragraph formats from Paragraph Catalog 5-5
paragraph formats to paragraphs with certain
tags 5-7
Table Designer properties 7-5
table formats from Table Catalog 7-6
table formats to tables with certain tags 7-7
Arabic numerals
autonumbering with 4-40 to 4-44
page numbering with 18-14
archiving a conditional document version 26-9
arcs
drawing 13-12
joining 14-9
reshaping 14-22
arrow pointer 13-15
arrowhead line ends 13-18 to 13-21
changing shape of 13-23
current 13-8
art, clip 19-22 to 19-26
available from online services A-4 to A-5
See also imported graphics; objects, graphic
art, drawing. See drawing objects; objects, graphic
As Is property settings
character format changes and 5-18
character formats with 5-18 to 5-21
in hypertext active area 27-6
I-4
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paragraph format changes and 5-18
table format changes and 5-18, 7-14
ascenders, font G-2
ASCII files. See file formats; text files
aspect ratio. See scaling
assembling books. See book files
asterisk (*)
finding a literal 8-8
numbering footnotes with 11-11
as symbol for formats with overrides 5-13
as wildcard for finding 8-8
as wildcard for opening documents 2-15
asymmetrical page layouts 18-8
atom, math element type 28-31
attaching graphics to text. See anchored frames
attraction, object (gravity) 14-12
attributes. See change bars; colors; drawing
properties; footnotes; object properties;
paragraphs; tables; text
author indexes 23-11
See also indexes
autoconnecting
disconnecting text frames and 20-12
turning off 20-9
when to use 20-7, 20-9
See also flow tags; text flows
autoflow. See autoconnecting
automatic backup on save 2-35
automatic hyphenation 4-23
finding 8-4 to 8-6, 9-12
automatic letter spacing 4-22
automatic line-spacing changes 4-18
automatic save 2-35
automatic spell-check correction 9-11
automatic text wrapping. See line breaks, text;
running text around objects
autonumbering
based on section numbers 4-44
in book files 24-12 to 24-14
building blocks in 4-37
bullet symbols in 4-38 to 4-40
chapters in templates 21-6

.....

INDEX

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
character formats in 4-38, 4-39
counter placeholders for 4-37, 4-40 to 4-44
in cross-references 10-13
examples of 4-42 to 4-44
figures 4-44
formats for, summary of 4-37
in generated lists 22-16, 24-10
in indexes 23-21
in lists 4-36 to 4-44
in outlines 4-42
removing 4-38
resetting 4-41, 4-43 to 4-44
in running headers and footers 12-20 to 12-21
suppressing display of 4-44
in tables 7-35
in templates 21-7
<$autorange> building block in special text flows
for indexes 23-22
autoreferences. See cross-references
autosave files 2-35
axis, flipping objects around 14-13

B
back, sending objects to 14-7
background graphics (master pages) 19-5
background pages. See master pages
background text frames (untagged)
adding, on master pages 19-6
creating headers and footers with 18-10 to 18-13
system variables in 12-9 to 12-12, 19-7
See also columns, text; template text frames
(tagged); text frames
background, white text on dark (reverse text) 13-27
backslashes (\)
in cross-reference format definitions 10-12
finding literal 8-9
including in replacement text 8-16
in index entries 23-6
as prefixes for special characters 4-26, 4-35
in system variable definitions 12-15
in user variable definitions 12-8
backup files 2-35

backward, finding, in document 8-6
balancing text across columns 18-16 to 18-17
See also adjacent text columns
bar (|) character
finding a literal 8-8
as manual alignment symbol 2-27, 29-10
as wildcard for finding 8-8
bar, formatting. See formatting bar
bar, menu 2-17
bars, change. See change bars
base colors 17-10
base pages. See master pages
baselines, text
aligning, in adjacent columns 18-19
aligning equations with 28-21
anchoring frames on 15-5
offsets from, for superscripts and
subscripts 4-13
side heads and 4-33
See also text
batch operations, fmbatch utility and B-3
BBS (bulletin board service) for Frame
products A-4
beginning of line, finding 8-8
beginning position. See first page; start positions
Berkeley UNIX, printer queue commands for 2-41
Bezier curves. See freehand curves
binding margin
anchored frames in 15-9
changing 18-7
changing, on individual pages 19-12
in new documents 2-11
bitmaps 16-3
capturing 16-17 to 16-18
inverting B-12
See also imported graphics; importing graphics
black
converting to white in bitmap B-12, B-13
printing colors as 2-40, 17-17
black and white
images, inverting B-12
images, tinting with color 17-6
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reverse text 13-27
blank lines between paragraphs 4-21
blank pages
adding, at end of documents 18-15
in books 24-23
color separations and 17-20
containing no background text or graphics 19-21
deleting 3-11
deleting, at end of documents 18-15
preventing from printing 17-20
blank paper documents 2-10
blank spaces. See spaces, text
blocking out. See cropping
blocks, building. See building blocks
blocks of text. See text
body pages
adding new, automatically 3-6
adding new, unconnected 20-10
applying master pages to 19-7 to 19-9
applying no master page to 19-21
copying anchored frames from reference pages
to 19-26
deleting disconnected 20-16
displaying 2-28 to 2-30, 18-10
importing text flows from. See importing text
flows
layout overrides on 19-20
margins of. See indenting; margins, page
preventing from creating 20-9
rotating 19-18
text flows on 19-9, 20-7
updating, with master page changes 19-10
updating master pages with changes to 19-10
See also master pages
body paragraphs. See paragraphs
body rows, table. See rows, table
body text. See body pages; text
body-text areas, side heads and 4-29 to 4-33
boilerplate graphics 19-22 to 19-26
available from online services A-4 to A-5
See also imported graphics; objects, graphic
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boilerplate text. See importing text files; importing
text flows; user variables
bold typestyle 4-7
book files
adding documents to 24-7 to 24-8
adding empty pages in 24-23
adding generated files to 24-8 to 24-11
autonumbering in 24-12 to 24-14
closing 24-27
closing all files in 24-27
comparing 24-27
conditional documents in 24-20
creating 24-6
cross-references to chapter numbers in 24-16
deleting empty pages in 24-23
dividing long files in 24-4
fmbatch and B-1 to B-11
generating files in 24-18 to 24-23
naming 24-6
numbering pages and paragraphs in 24-12
to 24-18
opening files in 24-24
organizing files for 24-4
page count, showing total in 24-17
paginating 24-12 to 24-17
planning templates for files in 21-5
printing 24-24
rearranging files in 24-12
removing files from 24-12
renaming 24-6
saving 24-6
saving all files in 24-27
setting up 24-4 to 24-12
updating 24-18 to 24-23
updating formats in 24-26
view-only format for 27-33
See also chapter numbers; files; generated files in
books; generated lists; indexes
book window, plus sign (+) in 24-11
bookmarks, Adobe Acrobat 27-36 to 27-39
books. See book files; documents
borders
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around graphics 13-11
capture 16-18
object path and 13-9
selection 13-16, 13-17
showing and hiding 2-26
as window guides 2-26
See also line widths, graphic; lines, graphic; pen
patterns; ruling lines in tables
bottom-aligning. See aligning
boxes
gray (as graphic image placeholder) 16-8, 16-15
hypertext alert 27-22
See also checkboxes; handles
boxing paragraphs 4-18
braces ({}) in equations
inserting 28-15
removing 28-26
toggling format of 28-26
brackets. See angle brackets; square brackets
breaking a link. See canceling; converting
breaks, line. See line breaks, text
breaks, page. See page breaks
bringing objects to front 14-7
BSD UNIX, printer queue commands for 2-41
building blocks
in autonumber formats 4-37
in cross-reference formats 10-11 to 10-15
in index entries 23-5 to 23-11
in special text flows for generated lists 22-14
to 22-19
in special text flows for indexes 23-20 to 23-27
in system variables 12-13 to 12-24
built-in math elements. See math elements
bullet symbols (•) 4-9
autonumber formats and 4-38 to 4-40
in bulleted lists 4-38 to 4-40
removing, from bulleted lists 4-39
typing 3-7, 3-8
bulletin board service (BBS) for frame products A-4
butt cap (line style) 13-22
buttons
hypertext 27-7 to 27-8

QuickAccess bar. See Quick Reference
bypassing text frames in text flow 20-12

C
calculus symbols in equations
adding operands to 28-19
inserting 28-14, 28-17
callouts (text)
formats for 21-8
multiline 13-26
single-line 13-24 to 13-26
See also side heads
camera-ready copy. See printing
canceling
changes in dialog boxes 2-21
changes in documents 2-31
commands 2-19
find operations 8-6
macros C-4
pop-up menus 2-20
spell-checking 9-5
Undo command for 2-19
update of text insets 3-23
cap style, line 13-22
capitalization
finding/changing and 8-7, 8-16
font styles 4-11
of format tags 5-12, 7-9
ignoring when finding 8-7
spell-checking of 9-6, 9-10
of Thesaurus words 9-19
See also case-sensitivity
caps and small caps text 4-11
captions. See figures, titles for; heads, text
capturing screen images 16-17 to 16-18
caret (^)
finding a literal 8-8
as wildcard for finding 8-8
carriage returns. See forced returns; paragraph
symbol
case-sensitivity
of cross-reference format names 10-12
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finding and 8-7
of fmbatch commands B-2
of format tags 5-12, 7-9
of hypertext commands 27-9
of keyboard shortcuts 2-19
replacing found text and 8-16
See also capitalization
catalog formats. See character formats; paragraph
formats; table formats
catalogs
of character formats. See Character Catalog
of paragraph formats. See Paragraph Catalog
of table formats. See Table Catalog
cells in equation matrices, aligning 29-13
cells (matrix), hypertext command for 27-17
cells, table
aligning graphics in 6-13
aligning text in 7-34
anchoring tables in 6-14
centering text vertically in 7-32
changing height of 6-22
color in 17-5
combining (straddling) 6-22
copying and pasting 6-15
deleting contents of 6-15
indenting paragraphs in 6-11
inserting tables into 6-14
margins in 7-31 to 7-34
margins in, customizing 7-32
moving between 6-11
placing graphics in 6-13
removing ruling or shading from 7-27 to 7-28
resizing 6-19 to 6-23
rotating 6-23
ruling lines around. See ruling lines in tables
saving, as paragraphs 2-33
selecting 6-7, 6-11
shading of. See shading in tables
straddling 6-22
tab stops, setting in 6-11
unstraddling 6-23
See also columns, table; rows, table; tables
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center tab stops 4-15
centering
paragraphs 4-14
text vertically in table cells 7-32
See also aligning
centimeters (measurement units) 2-22
change bars
adding, automatically 25-4
adding, in a composite document 25-13
adding, to selected text 25-5
adding, by using character or paragraph
format 25-6
clearing 25-6
color of 17-5
finding 25-7
marking entire paragraphs with 25-6
marking revisions with 25-4 to 25-7
positioning 25-5
removing 25-6
changing
capitalization of found text 8-16
character format of found text 8-16
found items 8-14 to 8-18
found items automatically 8-18
by pasting Clipboard contents 8-17
See also converting; customizing; editing;
finding; replacing; updating
Changing Setup Files xv
chapter numbers 24-15 to 24-16
autonumbering, in templates 21-6
in cross-references to books 24-16
in headers and footers of books 24-15
in multifile chapters 24-16
See also book files
Character Catalog
adding formats to 5-17 to 5-20
applying formats from 5-6
closing 2-21
deleting formats from 5-22
displaying 5-6
importing formats to 21-12 to 21-13
importing formats to, with fmbatch B-10
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renaming formats in 5-22
updating formats in 5-20 to 5-21
See also Character Designer; character formats
Character Designer
As Is property settings in 5-18
displaying 4-7
displaying catalog format properties in 5-20
functions of 4-6
resetting properties in 4-7
updating all characters from 5-21
updating formats in 5-20 to 5-21
See also Character Catalog; character formats
Character Format window. See Character Designer
character formats
adding change bars by using 25-6
applying 5-6
applying, to characters with certain tags 5-7
As Is property settings, using in 5-18 to 5-21
in autonumbering 4-38, 4-39
for callouts (text) 21-8
changing with Find/Change command 8-16
copying and pasting 5-7
creating 5-17 to 5-20
creating, guidelines for 5-12
creating, and using As Is settings 5-18
in cross-reference format definitions 10-15
defined 5-3
defining hypertext active area with 27-6
deleting 5-22
designing, for templates 21-7
in equations 29-14 to 29-17
finding 8-10
format overrides and 5-6
in generated lists 22-15, 22-19
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
in index entries 23-9, 23-21, 23-27
removing, from text by restoring paragraph’s
default font 5-7
renaming 5-22
in system variable definitions 12-15
for text line objects 13-25

updating 5-20 to 5-21
updating, in conditional text 26-18
in user variable definitions 12-7
See also Character Catalog; Character Designer;
character tags; text
character height. See point size, text
character sets 3-6
for equations 29-16
Symbol 3-6
Zapf Dingbats 4-9
See also characters; Quick Reference; special
characters
character spacing
between math elements in equations 29-5, 29-16
pair kerning 4-10
spread between characters in text 4-10
character tags
finding 8-4 to 8-6
guidelines for 5-12
imported, with same name 21-12 to 21-13
removing, after deleting change bars 25-7
See also character formats
characters
alphanumeric, in equations 28-8 to 28-11
double, finding, when spell-checking 9-6
in equations. See math elements
nonalphanumeric 4-9
pair kerning of 4-10
spread between 4-10
as tab leaders 4-17
unavailable font alert 2-14
updating all 5-21
See also character sets; Quick Reference; special
characters; text
checkboxes, dim 5-18
checking spelling. See spell-checking
choice functions in equations
evaluating 30-14
inserting 28-15
ciceros (measurement units) 2-22
circles, drawing 13-10
circumflex (^). See caret
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classes, training, on Frame products A-3
classified information, indicating, in running
headers and footers 12-23
clearing
automatic corrections for spell-checking 9-11
change bars 25-6
current macros C-6
See also cutting and pasting; deleting; removing
click-to-type 2-21
clip art 19-22 to 19-26
available from online services A-4 to A-5
See also imported graphics; objects, graphic
Clipboard
changing found items by pasting from 8-17
copying objects without changing contents
of 14-6
copying text without changing contents of 3-11
finding contents of 8-4 to 8-6
finding text with format matching contents
of 8-11
See also copying and pasting; cutting and pasting
clipping graphic frame contents, avoiding 15-17
clockwise rotation. See rotating
cloning case of changed text 8-16
closing
all files in book file 24-27
book files 24-27
Character Catalog 2-21
dialog boxes 2-21
documents 2-42
documents, hypertext commands for 27-23
files with fmbatch B-8
palette, Equations 28-5
palettes 2-21
Paragraph Catalog 2-21
QuickAccess bar 2-22
Tools palette 2-21
windows 2-21
See also hiding
CMYK color model 17-6, 17-22
printing 17-13 to 17-21
collated copies, printing 2-39
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colons (:) in index entries 23-6, 23-7
color definitions, importing and updating 21-12
to 21-13
with fmbatch B-10
color images. See imported graphics
color map, switching 16-18
color models 17-4, 17-6
choosing 17-6
color monitors, colors on 17-6, 17-7
color separations
adjusting registration for 17-13, 17-15 to 17-16
cutouts in 17-12
DCS graphic files 16-9
emulsion 17-19
graphic formats and 17-20
halftone screen settings for 17-21
knockouts 17-12
printing 17-13 to 17-21
printing extra plates for 17-19
printing registration marks with 2-40
skipping blank pages in 17-20
See also spot colors
colors
altering 17-10
applying 17-4 to 17-6
base 17-10
of change bars 17-5
for conditional text 26-7
creating 17-6 to 17-10
deleting 17-11
displaying views of 17-11 to 17-13
in Encapsulated PostScript files 17-4
in equations 17-5, 29-2, 29-14
invisible 17-13
mixing 17-6 to 17-10
naming custom 17-8
of objects 13-18 to 13-21, 17-5
of objects, current 13-8
PANTONE, using 17-8
planning the use of 17-4
printing 17-13 to 17-21
printing, as black 2-40, 17-17
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printing extra plates for 17-19
removing gap between, when printing 17-15
to 17-16
for table ruling 7-22
for table shading 7-23, 7-25
for text 4-9, 17-5
values for 17-7, 17-22, 17-23
See also color models; color separations; spot
colors
column gap. See gap
column layout
changing 18-7 to 18-9
in new documents 2-11
See also page layout
column margins. See margins, table cell; margins,
page
column-by-column conversion of tables to
paragraphs 6-28
columns, equation matrix 28-27
transposing, with rows 30-4
columns, table
adding 6-16
copying and pasting 6-17
copying and pasting widths of 6-21
cutting and pasting 6-17
default paragraph formats for 6-11
deleting 6-18
equal widths of 6-20
moving 6-17
numbering down 7-35
removing ruling or shading from 7-27 to 7-28
replacing 6-18
resizing 6-19 to 6-22
ruling lines in 7-18 to 7-23
scaling 6-19 to 6-22
selecting 6-7
selecting in 6-11
shading in 7-18, 7-23 to 7-26
straddling cells in 6-22
See also cells, table; tables
columns, text
adding 19-13 to 19-17
aligning text in adjacent 18-16 to 18-21

aligning text with bottom of 18-17
and anchored frame positions 15-5 to 15-12
balancing text in 18-16 to 18-17
breaking. See page breaks
changing page size, effect on 18-6
cross-referencing (newsletter style) 20-14
feathering text to bottom of 18-17
footnotes in 11-4 to 11-12
gap between, changing 18-9, 19-13
gap between, in new documents 2-11
newsletter style 20-6
number of, changing 18-9, 19-13 to 19-17
number of, in new documents 2-11
resizing 18-7, 19-12
space between, changing 18-9
space between, in new documents 2-11
synchronizing text baselines in 18-19
See also background text frames (untagged);
template text frames (tagged); text frames;
text line objects
columns, untagged. See background text columns
(untagged)
combination keys. See key combinations
combined documents. See composite documents;
conditional documents
combining
files into a book. See book files
fractions in equations 30-5
graphics. See grouping objects; joining objects
lines of text into paragraphs, when saving in
Text Only format 2-34
personal dictionaries (merging) 9-14
table cells (straddling) 6-22
tables 6-19
text flows 19-14, 20-10
See also connecting
commands
canceling 2-19
choosing 2-17 to 2-19
conventions for xiii
prefix for xiii, 2-17
on QuickAccess bar 2-21
See also hypertext commands; UNIX commands
Using FrameMaker
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comments, nonprinting 26-13
comparing books 24-27
See also composite documents; summary
documents
comparing documents 25-9 to 25-16
conditional 25-11
creating a composite document when 25-10
creating a hypertext summary document
when 25-13
items compared when 25-15
multiflow 25-11
setting options for 25-10 to 25-14
See also composite documents; conditional
documents; summary documents
complete menus 2-19
composite documents
book comparison and 24-28
condition tags used in 25-11
creating 25-10
filenames of 24-28, 25-11
marking changes in 25-11
reading 25-14 to 25-16
using change bars in 25-13
See also comparing documents; conditional
documents; summary documents
composite plates, printing 17-16
compound words, hyphenating 9-16
CompuServe, technical support on A-4
computing in equations. See evaluating equations
condition indicators
changing style or color of 26-8
displaying 26-16
turning off before printing 26-20
See also change bars; condition tags; conditional
documents; conditional text
condition tags
applying 26-9 to 26-14
classified information, indicating with 12-23
in composite documents 25-11
copying and pasting 26-13
creating 26-6 to 26-9
deleting 26-8
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displaying, in running headers and
footers 12-23
editing definitions of 26-8
finding 26-13
generating lists of 22-9, 26-9
importing and updating 21-12 to 21-13, 26-7
importing and updating, with fmbatch B-10
keyboard shortcuts for applying 26-12
names of 26-6 to 26-9
removing, from text 26-14 to 26-15
in text insets 26-17
See also condition indicators; conditional
documents; conditional text
conditional documents
in book files 24-20
changing view of 26-15 to 26-17
comparing 25-11
cross-references to 26-12, 26-20
editing 26-17
graphics in 26-6
index markers in 26-6
planning 26-4 to 26-6
templates for 26-19
templates that change Show/Hide settings
for 21-10
variable definitions in 26-19
version in, printing one 26-20
versions in, displaying all 26-15 to 26-17
versions in, saving 26-9
See also comparing documents; composite
documents; condition indicators; condition
tags; conditional text
conditional table rows 26-10, 26-18
finding 26-18
conditional text
converting, to unconditional text 26-14 to 26-15
cross-references as 26-10
cross-references in 26-6
cross-references to 26-20
deleting 26-18
displaying 26-15 to 26-17
finding 8-12, 26-18
footnotes as 26-10
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hidden, finding in 26-18
hiding 26-15 to 26-17
importing and updating settings for 21-12
to 21-13
importing and updating settings for, with
fmbatch B-10
indexing 26-6
items allowed in 26-10
markers as 26-10
for nonprinting comments 26-13
showing or hiding 26-15 to 26-17
spell-checking 26-18
in text insets 26-17
updating cross-references to hidden 10-20
variables as 26-10
See also condition indicators; condition tags;
conditional documents
<$condtag> building block 12-23
connecting
graphic lines 13-10
graphic lines, cap style for 13-22
objects by using gravity 14-12
text frames 19-14, 20-10
See also autoconnecting; combining
consecutive spaces. See Smart Spaces
constraining object movement 14-4
contents, table of. See generated lists
context-sensitive help 2-23
continuation columns in newsletters 20-14
continuation text in table titles and headings 6-12
(Continued) system variable for tables 12-11
control points 14-20
Control-r command prefix xiii
conventions
command xiii
for conditional documents 26-4 to 26-6
for imported graphic filenames 16-13
keyboard xiii
for paragraph and character tag names 5-12
for table tag names 7-9
for text inset filenames 3-20
converting

between View Only and Normal formats 27-33
black to white in bitmaps B-12, B-13
conditional to unconditional text 26-14 to 26-15
cross-references to text 10-10
display units 2-22
imported graphic images to monochrome B-13
imported text to tables 6-26
system variables to text 12-16
tables to paragraphs of text 6-28
tabular text insets to editable paragraphs 6-28
text to tables 6-24 to 6-28
user variables to text 12-9
white to black in bitmaps B-12, B-13
See also changing; editing; replacing; updating
copies to print, number of 2-37
copying and pasting
anchored frames 15-18
anchored frames from reference pages to body
pages 19-26
character formats 5-7
condition tags 26-13
drawing properties 13-20
in equations 28-25
objects 14-6
objects into graphic frames 15-16
paragraph formats 5-7
system variables 12-13
table cells 6-15
table column widths 6-21
table rows and columns 6-17
tables 6-8
text 3-10
text frames 19-16
user variables 12-6
See also Clipboard; duplicating
copying, importing by. See importing graphics;
importing text files; importing text flows
corner radius of rounded rectangles 14-18 to 14-19
corners, object, adding or removing 14-22
correcting. See errors; spell-checking
count, page
in book files 24-17
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in documents 18-13
odd or even 18-15
counterclockwise rotation. See rotating
counters, autonumbering 4-37, 4-40 to 4-44
crashes, opening documents after 2-36
creating
anchored frames 15-4 to 15-15
book files 24-6
character formats 5-12, 5-17 to 5-20
colors 17-4, 17-6 to 17-10
composite documents when comparing
documents 25-10
condition tags 26-6 to 26-7
cross-reference formats 10-10 to 10-15
custom math element definitions 28-28 to 28-32
documents 2-7 to 2-11
documents, double-sided 2-11
documents, generated hypertext 27-27
documents, hypertext 27-4 to 27-32
equations 28-4 to 28-8
generated lists 22-4 to 22-10
graphic insets 16-16
macro files C-5
macros C-2
master pages 19-17 to 19-19
one-time-only page layouts 19-20 to 19-21
page headers and footers 18-10 to 18-13
paragraph formats 5-10 to 5-11
personal dictionaries 9-14
reference frames 19-23
reference pages 19-23
revision pages 25-7 to 25-8
rotated page layouts 19-18
run-in heads 4-34
running headers and footers 12-18 to 12-24
side heads 4-30 to 4-33
straddle paragraphs 4-34
summary documents when comparing
documents 25-10
tab stops 4-15 to 4-17
table formats 7-8 to 7-11
table ruling styles 7-22
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user variables 12-6
See also adding; inserting
creation date variables 12-11, 12-16
crimping curved objects 14-21
crop marks, printing 2-40, 17-18
cropping
anchored frames 15-6
in anchored frames (clipping contents) 15-17
parts of captured screen images 16-18
parts of graphics 14-19
crossed I-beam pointer 13-25
cross-hair pointer (drawing cross) 13-8
Cross-Ref markers 10-4, 10-8
cross-reference formats
for additional footnote references 11-6
building blocks for 10-11 to 10-15
case-sensitivity of names for 10-12
changing 10-16
changing, in text insets 10-17
character formats in 10-15
creating 10-10 to 10-17
deleting 10-17
for endnotes 11-7
examples of 10-15
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
square brackets ([]) in 10-14
cross-references
autonumbering in 10-13
between text columns (newsletter style) 20-14
changing source of 10-9
chapter numbers in, for books 24-16
conditional 26-10
to conditional documents 26-12, 26-20
in conditional text 26-6
converting, to text 10-10
cutting and pasting 10-9
deleting 10-10
displaying sources of 10-9
editing 10-9
to endnotes 11-7
filenames in 10-13
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finding 8-4 to 8-6
finding sources of 10-9
to footnotes 11-6
formats for. See cross-reference formats
formatting text in 10-15
generating lists of 10-22, 22-9
hidden (in conditional text) 26-12, 26-20
as hypertext areas 27-13
as hypertext areas, deactivating 27-13
as hypertext areas in unlocked documents 27-30
in index entries 23-9, 23-18
inserting 10-4 to 10-10
inserting, to paragraphs 10-4 to 10-7
inserting, to specific spots within
paragraphs 10-4, 10-8
maintaining 10-17 to 10-22
markers for 10-4, 10-8
moving 10-9
to other documents 10-5
paragraph tags in 10-13
to paragraphs in text insets 10-7
selecting 10-9
suppressing automatic updating of 10-19
unresolved. See unresolved cross-references
updating, with fmbatch B-10
updating, to hidden conditional text 10-20
updating, manually 10-19
updating, when printing 10-19
See also cross-reference formats
curly braces. See braces
<$curpagenum> building block 12-11
current date, system variables for 12-11
in headers and footers 18-13
current information. See system variables
current page number, system variable for 12-11
in headers and footers 18-13
current paragraph 3-4
curvature
of freehand curves 14-20
of rounded rectangles 14-18 to 14-19
curved objects
arcs 13-12

circles 13-10
crimping 14-21
freehand 13-13
ovals 13-10
reshaping 14-20 to 14-23
rounded rectangles 13-10
See also drawing objects
curved quotation marks (Smart Quotes) 3-8
custom characters. See character sets; Quick
Reference; special characters
custom documents, creating 2-11
See also master pages
custom line spacing, guidelines for 4-19
custom master pages. See master pages; pages
custom math elements. See math element
definitions
custom menus 2-19
custom templates. See templates
customizing
arrowheads 13-23
bullet symbols in bulleted lists 4-39
cell margins in tables 7-32
dashed line style 13-23
document windows 2-24 to 2-28
line properties 13-21 to 13-24
menus 2-19
page numbers 18-13
printing 2-39
table ruling 7-18, 7-21
table shading 7-25
tables 7-4, 7-18
zoom settings 2-25
See also default; preferences
cutout (reverse) text 13-27
cutouts, in color separations 17-12
cutting and pasting
anchored frames 15-18
cross-references 10-9
in equations 28-25
objects 14-6
objects into graphic frames 15-16
system variables 12-13
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table rows and columns 6-17
tables 6-8
text 3-10
user variables 12-6
See also clearing; Clipboard; deleting; moving;
removing

D
dagger characters (†), numbering footnotes
with 11-11
dashed line styles 13-18 to 13-21
changing 13-23
current 13-8
dashes, typing 3-7
dates, system variables for 12-11
in running headers and footers 18-13
<$dayname>, <$daynum>, <$daynum01> building
blocks 12-17
DCS graphic files 16-9
printing 17-20
debugging
generated lists 22-11 to 22-13
hypertext documents 27-25
indexes 23-13 to 23-19
decimal places in equations 30-12
decimal tab stops 4-16
default
command prefix (Esc) xiii
font properties in paragraphs 4-7 to 4-13
line spacing 4-18
paragraph formats in tables 6-11
properties not set in Table Designer window 7-4
See also customizing; preferences
<Default Para Font> building block
in cross-reference formats 10-15
in index entries 23-9
in special text flows for generated lists 22-16
in system variable definitions 12-15
in user variable definitions 12-7
defining. See adding; creating; inserting
degrees of rotation 14-14 to 14-16
deleting
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anchored frames 15-18
blank pages from book files 24-23
blank pages at end of documents 18-15
character formats 5-22
color definitions 17-11
condition tags 26-8
conditional text 26-18
cross-reference formats 10-17
cross-references 10-10
custom master pages 19-19
equations 28-25
files in book files 24-12
footnotes 11-5
found items 8-15
graphics 14-6
hypertext commands 27-10
index entries 23-14
jobs from printer queue 2-41
macros C-6
markers 23-14
master pages, custom 19-19
math element definitions 28-32
objects 14-6
pages from book files 24-23
pages, disconnected 20-16
pages from documents 3-11, 3-12, 18-15
paragraph formats 5-22
reference pages 19-26
rows or columns from a matrix (in
equations) 28-27
system variables 12-13
tab stops 4-16
table cell contents 6-15
table formats 7-16
table rows or columns 6-18
table ruling styles 7-23
tables 6-10
text 3-11
user variables 12-6
words from dictionaries 9-14
See also clearing; cutting and pasting; removing
delimiters in equations
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defining 28-31
inserting 28-15
math element type 28-31
removing 28-26
using larger 29-5
derivatives in equations
adding operands to 28-19
evaluating 30-15
inserting 28-17
descenders, font G-5
deselecting
objects 13-17
text 3-10
Designate Dummy command 30-17
designer window overrides. See overrides, format
designer windows. See Character Designer;
Paragraph Designer; Table Designer
Desktop Color Separation (DCS) files 16-9
printing 17-20
destination pages. See hypertext links
determinants in equation matrices 30-13
diacritical marks in equations
inserting 28-12
math element type 28-31
diagonal lines, drawing 13-10
diagramming. See drawing objects
dialog boxes
canceling changes in 2-21
changing directories in 2-13
closing 2-21
limiting filename lists in 2-15, 24-8
macros for using C-7 to C-11
pop-up menus in 2-20
using 2-20
and windows 2-17, 2-21
dictionaries
languages for 9-8, A-7
main 9-13
managing 9-13 to 9-17
ordering additional A-5
personal 9-13 to 9-15, 9-15 to 9-17
site 9-13

See also document dictionary; personal
dictionary; spell-checking
dictionary-style running headers and footers 12-24
didots (measurement units) 2-22
differentials. See derivatives in equations
digits. See numbers
dimensions. See display units; size
dingbats font 4-9
directories
copying with fmcopy B-12
in dialog boxes, changing 2-13
in hypertext command pathnames 27-12
for imported graphics 16-12, 16-13
saving documents to different 2-31 to 2-33
Templates 2-8, 21-12
for text insets 3-20
disconnected body pages
adding 20-10
deleting 20-16
disconnected pages, deleting
See also multiflow documents
disconnecting text frames 20-11
Autoconnect settings and 20-12
See also columns, text; text flows; text frames
discretionary hyphens 4-23
finding 8-9
symbol for 2-27
display equations 28-4
aligning 29-9
creating 28-6
See also equations
display resolution (imported graphic scaling) 16-9
display units 2-11
changing 2-22
dots-per-inch (dpi) 16-8, 16-9
displaying
body pages 2-28 to 2-30, 18-10
borders 2-26
catalog format properties in Character
Designer 5-20
catalog format properties in Paragraph
Designer 5-13
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catalog format properties in Table Designer 7-6
Character Catalog 5-6
Character Designer 4-7
color views 17-11 to 17-13
condition indicators 26-16
conditional documents 26-15 to 26-17
conditional text 26-15 to 26-17
cross-references, sources of 10-9
document window guides 2-26
Equations palette 28-5
filenames for imported graphics 16-15
filenames for text insets 3-21
flows in multiflow documents 20-15
formatting bar 4-6
grid lines 13-6
hypertext documents in separate
windows 27-26, 27-35
imported graphics on other platforms 16-7
list of current licensees 2-6
list of printer queue jobs 2-41
master pages 18-10
pages, body 2-28 to 2-30
Paragraph Catalog 5-6
Paragraph Designer 4-6
publisher boundaries 2-27
QuickAccess bar 2-21
reference pages 19-23
rulers 2-27
Table Designer 7-5
text insets, sources of 3-21
text symbols 2-26
Tools palette 13-5
view-only documents, guidelines for 27-33
See also zooming
distance between objects
distributing objects 14-11
measuring 14-24
setting 14-11
See also gap; offsets
Distribute command for equations 30-8
Distribute Over Equality command 30-9
distributing objects 14-11

I-18

Using FrameMaker

See also aligning
division operators, inserting in equations 28-13
Division pop-up menu 30-9 to 30-11
document catalogs. See Character Catalog;
Paragraph Catalog; Table Catalog
document dictionary 9-13 to 9-16
adding words to 9-10, 9-15
deleting words from 9-14
editing 9-15
managing 9-13 to 9-16
merging 9-14
See also dictionaries
document files. See book files; documents; files
document formats, predefined. See templates
document formatting. See page layout; paragraphs;
text
document management products A-7
document reports 22-10
document window 2-24 to 2-28
components of 2-24
customizing 2-24 to 2-28
displaying specific pages in 2-28
graphics display in, turning off 2-29
guides 2-26 to 2-28
resizing, automatically, hypertext command
for 27-15
scrolling methods for 2-29
speeding up display in 2-29
zooming, in and out 2-25 to 2-26
documents
adding, to a book 24-7 to 24-8
canceling changes in 2-31
closing 2-42
closing, hypertext command for 27-23
comparing two. See comparing documents
converting between View Only and Normal
formats 27-33
creating 2-7 to 2-11
creating hypertext 27-4 to 27-32
cross-references as hypertext areas in
unlocked 27-30
double-sided. See double-sided documents
generating reports about 22-9, 22-10
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hyphenating. See hyphenation
importing formats into 21-12 to 21-13
importing formats into, with fmbatch B-10
locking and unlocking 27-33
long. See book files
MIF. See MIF file format
MML 2-12
moving 2-31 to 2-33
naming 2-31 to 2-33
navigating in 2-28 to 2-30
online. See hypertext documents; view-only
documents
opening. See opening documents
page count of, in headers/footers 18-13
page numbering styles for 18-14
predefined formats for. See templates
printing 2-37 to 2-40
printing, with fmbatch B-7
printing, with fmprint B-12
renaming 2-31 to 2-33
reverting to last-saved 2-31
saving 2-30 to 2-36
saving, automatically 2-35
single-sided 2-11, 18-6
testing templates for 21-11
working in. See document window
See also book files; files; hypertext documents;
multiflow documents; view-only
documents
dollar sign ($)
in cross-reference format building blocks 10-13
finding a literal 8-8
as wildcard for finding 8-8
dots, inserting in equations 28-12
dots, leader line 4-17
in generated lists 22-18
in indexes 23-23
dots per inch (dpi) 16-8, 16-9
dotted line styles 13-18 to 13-21
changing 13-23
current 13-8
double characters, spell-checking and 9-6

double question marks (??) in index entries 23-16
double quotation marks (“ ”), Smart Quotes 3-8
double spacing of text 4-18
double words, spell checking and 9-6
double-sided documents
alternating master pages for 20-5
creating 2-11
facing pages, display of 2-29
layout of 18-6
dpi (dots per inch) 16-8, 16-9
drafts of documents. See composite documents;
conditional documents
draw order (object stacking, back to front) 14-7
drawing cross (cross-hair pointer) 13-8
drawing environment, setting up 13-4
drawing objects 13-7 to 13-14, 13-24 to 13-28
arcs 13-12
Bezier (freehand) curves 13-13
circles 13-10
diagonal lines 13-10
drop shadows 14-8
ellipses 13-10
freehand curves 13-13
in graphic frames 15-15
lines 13-10
ovals 13-10
polygons 13-11 to 13-12
polylines 13-11
rectangles 13-10
rounded rectangles 13-10
several, of same color 13-19
several, of same type 13-9
with snap grid on 13-4, 13-6
splines (freehand curves) 13-13
squares 13-10
text frames 13-26, 19-16
text frames on body pages 19-14
text frames on master pages 19-14
text frames on master pages, assigning flow tags
when 20-9
text lines 13-25
unanchored graphic frames 13-14
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unanchored graphic frames on reference
pages 19-23
See also objects, graphic; Tools palette
drawing properties 13-18 to 13-21
of anchored frames 15-20
changing available 13-21 to 13-24
copying 13-20
current 13-8
inspecting 13-20
See also object properties; objects, graphic
drawing tools for graphic annotations. See Tools
palette
drop cap. See anchored frames, running text
around; running text around objects
drop shadows 14-8
dumps, capturing screen 16-17 to 16-18
duplicate index entries 23-17
duplicating
boilerplate graphics 19-26
catalogs 21-12 to 21-13
directories with fmcopy B-12
files. See importing text files; importing text
flows; text insets
object properties 13-20
objects without using Clipboard 14-6
text frames on body pages 19-16
See also Clipboard; copying and pasting

E
edge gap between objects 14-11
edges. See borders
editing
anchored frame contents, when rotated 14-16
color definitions 17-10
condition tag definitions 26-8
conditional documents 26-17
cross-reference formats 10-16
cross-references 10-9
custom math element definitions 28-32
dictionaries 9-15
equations 28-20 to 28-28
equations, rotated 14-16
footnotes 11-5
I-20
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graphic insets 16-16
hypertext commands 27-10
imported tables 6-27
index entries 23-13 to 23-19
marker text 23-14
system variable definitions 12-13 to 12-24
table ruling styles 7-22
tables 6-10 to 6-24
text 3-10 to 3-11
text insets, tabular 6-27
user variable definitions 12-8
See also changing; converting; customizing;
replacing; updating
editors, graphic inset 16-15 to 16-17
elements of an equation. See math elements
ellipses, drawing 13-10
em dashes, typing 3-7
em spaces
finding 8-9
typing 3-7
embedded graphics from other applications 16-15
to 16-17
See also imported graphics
embedded text from other documents. See text
insets
Emphasis character format 5-12
empty brackets < >. See counters, autonumbering
empty pages. See blank pages
emulsion setting, plate imaging 17-19
See also color separations
en dashes, typing 3-7
en spaces
finding 8-9
typing 3-7
Encapsulated PostScript (EPS) files 16-5
color definitions in 17-4
printing color separations for 17-20
end-of-flow symbol (§) 2-27
finding 8-9
end of line, finding 8-8
end page to print 2-37
end pages, blank. See blank pages
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end-of-paragraph symbol (¶) 2-27
finding 8-9
end of word, finding 8-9
endnotes 11-7
See also footnotes
endpoints of arcs 14-22
<$endrange> index marker building block 23-8
ends of lines, graphic. See line endings, graphic
enlarging. See resizing; scaling; zooming
Enter Rule command 30-16
entering text 3-4 to 3-9
entry structure in generated lists. See generated
lists
environment variables in hypertext
commands 27-12, 27-25
EPSF, EPSI formats 16-5
See also Encapsulated PostScript (EPS) files
equal distance between objects 14-11
equal signs, inserting in equations 28-16
equations
aligning 29-7 to 29-14
aligning several 29-11 to 29-12
aligning, with text baseline 28-21
changing matrices in 28-27
color in 17-5, 29-2, 29-14
commands for evaluating 30-2 to 30-20
creating 28-4 to 28-8
cutting, copying, and pasting in 28-25
decimal places in 30-12
defining custom math elements for 28-28
to 28-32
deleting 28-25
deleting part of 28-25
display 28-4, 28-6
editing 28-20 to 28-28
editing rotated 14-16
evaluating 30-2 to 30-20
in existing graphic frames 28-7
expressions in. See expressions in equations
floating-point numbers in 30-12
fonts for 29-14 to 29-17
horizontal lists of. See horizontal lists of
expressions in equations

importing and updating properties of 21-12
to 21-13
importing and updating properties of, with
fmbatch B-10
in-line 28-4 to 28-5
inserting math elements in 28-8 to 28-20
line breaks in 29-7 to 29-9
lists of 28-11
mathematical syntax in 28-9
moving 28-8
multiline, aligning lines in 29-9
object properties of 29-8, 29-11
placing insertion point in 28-23
positioning 14-6, 28-8
removing parentheses from 28-26
replacing part of 28-24
rotating 14-16
scope of operation in 28-9
selecting 28-25
selecting in 28-23
shrinkwrapping and unwrapping 28-21
subexpressions in 28-23
text runaround and 13-30
toggling format in 28-26
vertical lists of. See vertical lists of expressions
in equations
See also Equations palette; expressions in
equations; math elements
Equations palette 28-2
closing 28-5
displaying 28-5
pages on 28-9
See also equations; math elements
errors
checking for spelling 9-4
checking for typing 9-6
correcting, in generated lists 22-11 to 22-13
correcting, in indexes 23-15 to 23-19
when generating files in book files 24-22
in hypertext documents, common 27-26
unavailable fonts 2-14
unresolved cross-references. See unresolved
cross-references
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unresolved text insets. See unresolved text
insets
See also spell-checking
Escape key shortcuts xiii
Evaluate command 30-13
Evaluate Derivatives 1 Level command 30-16
Evaluate Derivatives command 30-15
Evaluate Integrals command 30-15
Evaluate Substitution command 30-14
evaluating equations 30-2 to 30-20
Evaluation pop-up menu 30-11 to 30-16
even page count in documents 18-15
exclamation point (!) in menu commands 2-17
exiting 2-42
hypertext command for 27-24
Expand All Terms command 30-20
Expand First Term command 30-20
exponents in equations
evaluating 30-19
inserting 28-13
transforming 30-8, 30-13
exporting. See saving
expressions in equations 28-8, 28-23
character formats for 29-14 to 29-17
copying, cutting, and pasting 28-25
deleting 28-25
evaluating 30-2 to 30-20
micropositioning 29-4
replacing 28-24
rules that transform 30-16 to 30-17
See also equations; math elements
external graphics. See imported graphics
external text. See text insets

F
facets of graphic insets 16-15
facing pages, display of 2-29
Factor command 30-7
Factor Some command 30-7
factorials in equations
evaluating 30-13
inserting 28-13
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FDE (Frame Development Environment) A-6
FDK (Frame Developer’s Kit) A-6
feathering text in columns 18-17
straddles and 18-18
See also adjacent text columns
figure space. See numeric space
figures
lists of. See generated lists
numbering. See autonumbering
titles for 13-28, 15-16
file extensions. See filename extensions
file formats
ASCII (text only) 2-33
available, when saving 2-31 to 2-35
FrameMaker can open and import 2-12
ISO Latin-1 (text only) 2-33
Maker Interchange Format (MIF) xvi, 2-12, 2-31
Maker Markup Language (MML) xvi, 2-12
Normal 2-31
of print files 24-25
Text Only 2-33
View Only 2-31
See also graphic file formats
file locking
to create view-only documents 27-33
for files in use 2-14
See also view-only documents
file permissions
when saving 2-32
for templates 21-12
File Transfer Protocol (FTP), using for technical
support A-3
<$filename> building block
in cross-reference formats 10-13
in system variable definitions 12-11
filename extensions
.auto 2-35
.backup 2-35
.lck 2-14
.mif 2-31
.pdf 27-39
.recover 2-35
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.txt 2-31
See also filename suffixes; filenames
filename suffixes
for composite documents 24-28, 25-11
for generated lists 22-8
for indexes 23-11
for summary documents 24-28, 25-11
See also filename extensions; filenames
filename system variables 12-11
filenames
of composite documents 24-28, 25-11
in cross-references 10-13
in dialog box scroll lists, wildcards and 2-15,
24-8
generated, symbol for, in book window 24-11
in hypertext commands 27-12
for imported graphics 16-13
for imported graphics, displaying 16-15
of summary documents 24-28, 25-11
in system variables 12-11
for text insets 3-20
for text insets, displaying 3-21
See also filename extensions; filename suffixes;
files; pathnames, file location
files
autosave 2-35
backup 2-35
batch operations on, with fmbatch. See
fmbatch
importing. See importing graphics; importing
text files; importing text flows
locked (.lck) 2-14
names of. See filename extensions; filename
suffixes; filenames
printing to 2-40
recover 2-35
text only 2-31
transferring, to technical support A-3 to A-5
using existing, as generated files 24-11
See also book files; documents; file formats;
generated files in books; graphic file
formats; text files
fill patterns 13-18 to 13-21

current 13-8
transparent 13-19
fill percentage for table shading 7-23
filters
available from online services A-4 to A-5
for opening and importing files 2-12
See also importing text flows; importing
graphics; Using Frame Filters; Using
Frame Products on Multiple Platforms
finding
anchored frames 8-4 to 8-6
backward in document 8-6
beginning of line 8-8
beginning of paragraph 8-9
beginning of word 8-9
canceling a search 8-6
capitalization and 8-7
change bars 25-7
and changing 8-14 to 8-18
character formats 8-10
character tags 8-4 to 8-6
Clipboard contents 8-4 to 8-6
complete words 8-7
condition tags 26-13
conditional text 8-12, 26-18
cross-reference sources 10-9
cross-references 8-4 to 8-6
and deleting 8-15
end of flow 8-9
end of line 8-8
end of paragraph 8-9
end of word 8-9
footnotes 8-4 to 8-6
forced returns 8-9
forward in document 8-6
graphic files imported by reference 16-14
hyphens 8-9
hyphens, automatic 8-4 to 8-6, 9-12
index markers 23-13, 23-15
with macros C-10
marker text 8-12
markers 8-12
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missing source entries in generated lists 22-11
names of built-in math elements 28-32
nontext items 8-4 to 8-6
paragraph tags 8-4 to 8-6
repeated characters 9-6
repeated words 9-6
spaces 8-8, 8-9
special characters 8-9
suppress hyphenation symbols 8-9
symbols 8-9
table tags 8-4 to 8-6
tables 8-4 to 8-6
tabs 8-9
text 8-8
text insets, sources of 3-23
text marked as changed 25-7
text with a particular character format 8-11
variables 8-4 to 8-6
wildcards for 8-7 to 8-8
See also changing; navigating
first page
displaying 2-29
hypertext links to 27-14
page side in books 24-13
page side in new documents 2-11
first-line indent 4-14
first-line synchronization limit 18-21
fixed line spacing for text 4-19
fixed-width spaces, using 3-7
flagged changes. See change bars
flagging spelling errors. See spell-checking
flipping graphic objects 14-13
floating anchored frames 15-6
floating palettes. See Character Catalog; Equations
palette; Paragraph Catalog; Tools palette
floating table position 7-30
floating-point numbers in equations 30-12
flow tags
alternating master pages and 20-5
assigning 20-9
assigning, when drawing text frames 20-9
HypertextLinks 27-32
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pop-up hypertext commands and 27-19
using, on master pages 19-5, 19-9
See also autoconnecting; text flows
flowing text around graphics. See running text
around objects
flows of text. See special text flows on reference
pages; text flows
fmbatch utility B-1 to B-11
batch operation of B-3
case-sensitivity of commands for B-2
closing files B-8
commands list B-3
echoing commands B-4
executing UNIX commands B-9
exiting B-6, B-8
generating files B-10
importing and updating formats B-10
interactive use B-5
opening files B-6
printing files B-7
printing messages to standard error output B-6
saving files B-8
starting B-5
updating cross-references B-10
verifying Frame is running B-7
fmcopy utility B-12
fmdictionary file 9-14
$FMDOCDIR environment variable in hypertext
commands 27-25
$FMDOCNAME environment variable in hypertext
commands 27-25
fminvert utility B-12
fmMacros file C-5
fmMacrosLog file C-5
fmprint utility B-12
font substitution 2-14
fonts
adding. See Managing Frame Products
catalog of. See Character Catalog
in equations 29-14 to 29-17
generating lists of 22-9
special 3-6
in templates 21-7
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in text 4-7 to 4-13
unavailable 2-14
See also character sets; printing
footers, page
chapter numbers in, for books 24-15
creating 18-10 to 18-13
dates in 18-13
moving 18-12
page numbers or page count in 18-13 to 18-14
resizing 18-12
rotating 19-18
templates and 21-6
See also running headers and footers
footing rows, table
adding 6-16
deleting 6-18
in multipage tables 6-12
ruling lines in 7-18 to 7-23
shading for 7-23 to 7-26
See also rows, table
footnote references
numbering style for 11-9 to 11-11
placing two, together 11-5
several, for one footnote 11-6
footnote separators, changing 11-12
footnotes
in columns of text 11-4 to 11-12
conditional 26-10
creating 11-4
deleting 11-5
editing 11-5
finding 8-4 to 8-6
format of 11-9 to 11-11
full-width 11-5
keeping, together with footnote reference 11-6
lines as separators for 11-12
maximum height of 11-10
in multicolumn layouts 11-5
numbering styles for 11-9 to 11-11
paragraph formats for 11-10
several references to one 11-6
straddling columns 11-5

in tables 11-4 to 11-12
tables not allowed in 6-5
See also endnotes
forced returns
finding 8-9
symbol for 2-27
typing 4-25
See also line breaks, text
foreground pages. See body pages
foreign languages. See accent marks; languages
foreword page numbers. See page numbers
format catalogs. See Character Catalog; Paragraph
Catalog; Table Catalog
format overrides. See overrides, format
format tags. See character tags; paragraph tags;
table tags
formats
applying. See applying
of files. See file formats
importing and updating 21-12 to 21-13
importing and updating, in book files 24-26
importing and updating, with fmbatch B-10
merging or overwriting 21-12
overriding. See overrides, format
predefined page. See page layout; templates
toggling equation 28-26
See also character formats; paragraph formats;
table formats
formatting
cross-references. See cross-reference formats
equations. See equations
footnotes 11-9 to 11-11
generated lists 22-14 to 22-20
imported text flows, options for 3-16
indexes 23-19 to 23-28
indexes, individual entries in 23-9
pages. See page layout
paragraphs. See paragraphs; text
system variables 12-15
tables. See tables
text. See text
text, designer windows and 4-6
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text, formatting bar and 4-6
user variables 12-7
formatting bar 4-6
applying formats with 5-5
displaying and hiding 4-6
tab wells on 4-15
formulas. See equations
fractions, combining 30-5
Frame Application Program Interface (API) A-6
Frame Developer’s Kit (FDK) A-6
Frame Development Environment (FDE) A-6
Frame products
information on A-4, A-5, A-6
ordering A-5 to A-8
technical support for. See technical support
Frame third-party products and services A-8
FrameConnections Catalog A-8
FrameImage file format 16-7
FrameMaker
exiting 2-42
exiting, hypertext command for 27-24
file formats 2-12
icon 2-4
installing. See Installing Frame Products
licenses 2-5
main window 2-4
new features of. See What’s New in FrameMaker
online Help 2-23
starting 2-4
templates. See templates
training for A-3
using, on multiple platforms. See Using Frame
Products on Multiple Platforms
FrameMaker Clipboard. See Clipboard
FrameMaker International Dictionaries 9-8, A-7
FrameMaker International Edition A-7
FrameMaker+SGML A-7
FrameMath. See equations; math elements
FrameMath reference pages 28-28
FrameReader 27-3, A-7
frames, types of 13-33
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See also anchored frames; graphic frames;
reference frames; text frames; unanchored
graphic frames
FrameVector file format 16-7
FrameViewer 27-3, A-7
freehand curves
adding and removing points on 14-22
drawing 13-13
joining 14-9
reshaping 14-20
freezing pagination 25-7 to 25-9
front, bringing objects to 14-7
FTP (File Transfer Protocol), using for technical
support A-3
<$fullfilename> building block
in cross-reference formats 10-13
in hypertext documents 27-31
in variable definitions 12-11
full-width anchored frames 15-9
full-width footnotes 11-5
full-width paragraphs 4-34
full-width tables 6-5
function keys. See key combinations; macros
functions in equations
font for 29-17
inserting 28-18
math element type 28-31

G
gap
between columns, changing 18-9, 19-13
between columns, in new documents 2-11
between objects (edge gap) 14-11
between printed colors, removing 17-15 to 17-16
between side heads and body text 4-30
between tables and titles 7-17
See also distance between objects; offsets
generated filenames symbol (+) in book
window 24-11
generated files in books
adding 24-8 to 24-11
error messages 24-22
hypertext links in 27-27 to 27-32
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master table of contents or index for several
books 24-18
pagination and page numbering in 24-12
to 24-18
problems with 24-22
renaming 24-11
updating 24-18 to 24-23
using existing files as 24-11
See also book files; generated lists; indexes
generated hypertext documents 27-27 to 27-32
creating 27-27
display commands for 27-31
in online systems 27-32
See also hypertext documents; hypertext online
systems
generated lists
adding, to book files 24-8 to 24-11
adding text to entries in 22-18
aligning page numbers in 22-18
autonumbering in 22-16, 24-10
character formats in 22-15, 22-19
of condition tags 22-9, 26-9
creating 22-7 to 22-10
of cross-references 10-22, 22-9
debugging 22-11 to 22-13
entries in, tracing back to source 22-12
extra entries 22-12
filename suffixes for 22-8
finding missing entries in 22-11
of fonts 22-9
format of, storing information in source
document 22-20
format of, updating from template 22-20
formatting 22-14 to 22-20
formatting, retaining changes to 22-19
generating 22-7 to 22-10
hypertext links in 22-12, 27-27 to 27-32
of imported graphics 22-9
and indexes, compared 22-6
leader dots in 22-18
line breaks in 22-13, 22-17
locking, in View Only format 22-12
of markers. See marker lists

master, for several books 24-18
missing entries in 22-11
for multiflow documents 22-9
preparing source documents for 22-4 to 22-6
problem entries in 22-11 to 22-13
rearranging information in 22-15
of references 22-9
special text flows in 22-14 to 22-19
tabs in 22-18
templates for 21-9, 22-20
of text insets 22-9
titles for 22-19
updating 22-8
updating, with fmbatch B-10
See also book files; generated files in books;
indexes
generating
book files 24-18 to 24-23
document reports 22-9, 22-10
hypertext documents 27-27 to 27-32
indexes 23-11
lists 22-7 to 22-10
See also book files; generated files in books;
generated lists; hypertext documents;
indexes
geometric objects. See drawing objects
glossaries, running headers and footers for 12-24
go to page number 2-29
gradients in equations
adding operands to 28-19
inserting 28-17
graphic file formats
bitmap 16-3
DCS 16-9
Encapsulated PostScript 16-5
FrameImage 16-7
FrameVector 16-7
for Macintosh applications 16-5
Metafile preview image 16-5
PICT 16-5
PostScript code 16-10
TIFF preview image 16-5
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vector 16-3
for Windows applications 16-5
xwd 16-17
See also file formats; imported graphics; Using
Frame Filters; Using Frame Products on
Multiple Platforms
graphic frames
anchored and unanchored, compared 14-19
clipping problems in 15-17
drawing in 15-15
equations in 28-7
placing objects in 15-15
rotating 14-16
and text frames, compared 13-33
See also anchored frames; reference frames;
unanchored graphic frames
graphic insets 16-15 to 16-17
creating 16-16
editing 16-16
facets of 16-15
running text around 13-30
See also imported graphics
graphic matrices, creating active areas in
(hypertext) 27-17
graphic objects. See drawing objects; objects,
graphic
graphic properties. See drawing properties; object
properties
graphics
anchoring, to text. See anchored frames
available from online services A-4 to A-5
background (master pages) 19-5
boilerplate 19-22 to 19-26
conditional, in anchored frames 26-10, 26-12
in conditional documents 26-6
copying, cutting, and pasting, into graphic
frames 15-16
cropping 14-19, 16-18
deleting 14-6
display options for 2-29
drawing. See drawing objects
drawing borders around 13-11
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flowing text around. See running text around
objects
hiding 2-29
inline 15-5
printing 2-37, 2-39
printing low-resolution 2-39
on reference pages in templates 21-8
repeating, on pages 19-6
standardizing, for templates 21-8
text in 13-24 to 13-29
titles for 13-28, 15-16
See also graphic file formats; imported graphics;
importing graphics; objects, graphic
graphics tools. See drawing objects; Tools palette
gravity, connecting objects by using 14-12
gray bar in place of text 2-29
gray box in place of imported images 16-8, 16-15
gray-scale images. See imported graphics
greater-than symbol (>). See angle brackets
Greek letters in equations
font for 29-16
inserting 28-12
greeking text 2-29
grid lines, showing and hiding 13-6
grids
aligning tab stops to 4-16
aligning table column borders to 6-20
page layout, for multiflow newsletters 20-6
snap 13-4, 13-6
spacing of 13-6
synchronizing baselines to, in text
columns 18-19
visible 13-4, 13-6
grouping objects 14-8
See also joining objects
GroupTitles paragraph tag in indexes 23-26
guides, document window 2-26 to 2-28
gutter. See binding margin; gap

H
hairline rules. See lines, graphic
halftone screen settings 17-21
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handles
adding or removing 14-22
reshape 14-20
selection, object 13-15
selection, table cell 6-7
hanging indent. See indenting, paragraphs
hard hyphens. See nonbreaking hyphens
hard returns. See forced returns; line breaks, text
hard spaces. See nonbreaking spaces
Header/Footer $1 and Header/Footer $2 marker
types 12-22
headers, page
chapter numbers in, for books 24-15
creating 18-10 to 18-13
dates in 18-13
moving 18-12
page numbers or page count in 18-13 to 18-14
resizing 18-12
rotating 19-18
templates and 21-6
See also running headers and footers
heading rows, table
adding 6-16
continuation text in 6-12
converting text to 6-25
deleting 6-18
in multipage tables 6-12
ruling lines in 7-18 to 7-23
shading for 7-23 to 7-26
See also rows, table
heads, text
for alphabet groupings in indexes 23-26
autonumbering examples 4-42
keeping, with next paragraph 4-28
next paragraph’s format 5-9
See also run-in heads; side heads; straddles;
titles
height
first-line synchronization limit 18-21
of footnotes 11-10
line. See line spacing
of table rows 6-22

See also size; width
Help, online 2-23
as a hypertext document 27-11
See also technical support
hidden cross-reference markers (conditional
text) 26-12, 26-20
hidden text. See text frames, overflowing;
conditional text
hiding
borders 2-26
conditional text 26-15 to 26-17
formatting bar 4-6
graphics 2-29
grid lines 13-6
nonprinting comments 26-13
publisher boundaries 2-27
rulers 2-27
text symbols 2-26
See also closing
hierarchy of object grouping 14-8
highlight colors. See spot colors
HLS color model 17-6, 17-23
horizontal alignment. See aligning
horizontal distribution of objects 14-11
horizontal (landscape) page orientation in new
documents 2-10
horizontal lines
drawing 13-10
in tables. See ruling lines in tables
horizontal lists of expressions in equations
adding items to 28-12
aligning items in 29-12
inserting 28-11
math element type 28-31
horizontal movement, constraining objects to 14-4
horizontal scrolling 2-29
hot links. See cross-references; graphic insets;
hypertext links; imported graphics; text
insets
<$hour>, <$hour01>, <$hour24> building
blocks 12-17
hours in system variables 12-17
hues, color 17-6, 17-23
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hyperbolic functions, inserting in equations 28-18
hypertext active areas. See active areas (hypertext)
hypertext buttons 27-7 to 27-8
hypertext commands
activating, in Normal-format (unlocked)
documents 27-30
affecting the stack 27-16
case-sensitivity of 27-9
for closing view-only documents 27-23
for controlling generated hypertext
documents 27-31
converting, to Acrobat links 27-36 to 27-39
for creating alert boxes 27-22
for creating graphic matrices 27-17
for creating pop-up menus 27-19 to 27-21
debugging tips for 27-26
deleting 27-10
editing 27-10
environment variables in 27-12, 27-25
for executing UNIX commands 27-24
for exiting 27-24
filenames in 27-12
inserting 27-9 to 27-10
for linking to previous location in stack 27-16
for linking to specific pages 27-13 to 27-15
for linking to specific topics 27-11
markers for 27-9
in online systems 27-32
for opening a new, unnamed document 27-15
pathnames in 27-12
for resizing document window 27-15
for retracing steps 27-16, 27-34
for sending messages to another
application 27-24
summary of 27-40
testing 27-25
using specific 27-11 to 27-26
See also active areas (hypertext); hypertext
documents; hypertext links
hypertext documents
converting, to Acrobat documents 27-36 to 27-39
creating 27-4 to 27-32
creating summary 25-13
I-30
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deactivating cross-references in 27-13
debugging tips for 27-26
display commands for 27-31
displaying, in separate windows 27-26, 27-35
generating lists or indexes as 27-27 to 27-32
locking and unlocking 27-33
online Help as 27-11
planning 27-4
testing 27-25
See also active areas (hypertext); generated
hypertext documents; hypertext
commands; hypertext links; hypertext
online systems; view-only documents
hypertext icons 27-7 to 27-8
hypertext links
converting, to Acrobat links 27-36 to 27-39
cross-references as 27-13
in generated lists 22-8, 27-27 to 27-32
in indexes 23-12, 27-27 to 27-32
missing, in pop-up menus 27-26
to specific pages 27-13 to 27-15
in summary documents 25-13, 27-27 to 27-32
using, in Normal-format (unlocked)
documents 27-30
See also active areas (hypertext); hypertext
commands; hypertext documents
hypertext markers 27-9
See also markers
hypertext online systems
generated hypertext documents for 27-32
planning 27-4
view-only documents for 27-33 to 27-35
See also hypertext documents
hypertext stack
commands affecting 27-16
linking to previous location 27-16
retracing jumps in hypertext documents 27-34
HypertextLinks flow tag 27-32
hyphenated compound words, adding to personal
dictionary 9-16
hyphenation
automatic 4-23
controlling, in compound words 9-16
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controls 4-23, 9-11
language for 4-24
of last word in paragraph 4-24
manual 4-23
points 9-11
preventing 4-23, 9-12
rehyphenating a document 9-12
spell-checking of 9-6, 9-11
See also line breaks, text
hyphens 4-23
discretionary 4-23
finding automatic 8-4 to 8-6, 9-12
finding discretionary or nonbreaking 8-9
nonbreaking 4-23
number of letters before or after 4-23

I
I-beam pointer 3-4, 13-15
crossed 13-25
icons
FrameMaker 2-4
hypertext 27-7 to 27-8
QuickAccess bar 2-21
IgnoreChars paragraph tag, in indexes 23-24
illustrations. See drawing objects; imported
graphics; objects, graphic
illustrations, software, capturing 16-17 to 16-18
images, imported. See imported graphics
imaging settings for plates 17-19
imported graphics
allocating memory for 16-8
assigning color to 17-6
in conditional documents 26-6
converting, to monochrome B-13
cropping parts of 14-19
displaying filenames of 16-15
displaying, on other platforms 16-7
dots-per-inch (dpi) setting for 16-8, 16-9
generating lists of 22-9
graphic insets 16-15 to 16-17
gray box display in place of 16-8, 16-15
inverting black and white B-12

managing 16-12 to 16-15
masking parts of 14-19, 16-18
missing 16-14
naming conventions for 16-13
pathnames of 16-12
positioning 16-5
printing original colors of 17-16, 17-20
replacing 16-10
resizing 16-9
running text around 13-30
scaling 16-7 to 16-8, 16-9
types of 16-3, 16-4
updating 16-7
See also clip art; graphic file formats; importing
graphics; graphic insets; objects, graphic
imported tables, editing 6-27
imported text. See text insets
importing formats
into book files 24-26
into documents 21-12 to 21-13
with fmbatch B-10
importing graphics 16-5 to 16-11
by copying 16-7
into graphic frames 15-16
by reference 16-7
See also imported graphics
importing text files 3-17
by copying 3-15
by reference 3-15
into tables 3-18, 6-26
See also importing text flows; text insets
importing text flows 3-13 to 3-17
by copying 3-15
file types allowed 2-12
formatting options for 3-16
by reference 3-15
updating options for 3-15
See also importing text files; text insets
inches (measurement units) 2-22
typing abbreviation for 3-9
inconsistent Show/Hide settings 24-22
indenting
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paragraphs 4-13
table cell paragraphs 6-11
tables 7-29
text running around anchored frames and 15-14
See also margins, page
index entries
angle brackets (<>) in 23-6
autonumbers in 23-21
backslashes (\) in 23-6
brackets, square ([]), in 23-6, 23-10
building blocks in 23-5 to 23-11
character formats in 23-9, 23-21, 23-27
colons (:) in 23-6, 23-7
in conditional documents 26-6
cross-reference form of 23-9, 23-18
deleting 23-14
duplicate entries 23-17
editing 23-13 to 23-19
finding markers for 23-13, 23-15
formatting 23-19 to 23-28
formatting individual 23-9
inserting 23-5 to 23-11
leader dots in 23-23
line breaks in 23-18
missing 23-15, 26-20
page numbers in, aligning 23-23
page numbers in, character format of 23-21
page numbers in, compressing into range 23-22
page numbers in, removing 23-9, 23-18
page numbers in, separators for 23-22
page range in 23-8
page range in, problems with 23-16
principal 23-9
problems in 23-15 to 23-19
question marks (??) in 23-16
“See” and “See also” in 23-9, 23-18
semicolons (;) in 23-6, 23-10
several, in one marker 23-10
sort order of 23-10, 23-24 to 23-26
sort order of, problems with 23-17
square brackets ([]) in 23-10
subentries in 23-7
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syntax and punctuation of 23-5 to 23-11
tabs in 23-23
tracing back, to source 23-13
See also indexes
index markers. See index entries
indexes
adding, to book files 24-8 to 24-11
alphabet groupings in 23-26
author 23-11
autonumbering in 23-21
creating 23-5 to 23-12
debugging 23-13 to 23-19
editing 23-13 to 23-19
entries in. See index entries
filename suffixes for 23-11
format of, storing information in source
document 23-28
format of, updating from template 23-28
formatting 23-19 to 23-28
formatting, retaining changes to 23-27
and generated lists, compared 22-6
generating 23-11
group titles in 23-26
headers and footers for 12-24
hypertext links in 23-12, 27-27 to 27-32
letter-by-letter sort order in 23-24
locking, in View Only format 23-13
and marker lists, compared 22-6
master, for several books 24-18
planning 23-2
of references 22-10
sort order in 23-10, 23-24 to 23-26
sort order in, problems with 23-17
special text flows in 23-20 to 23-27
subject 23-11
templates for 21-9, 23-28
titles for 23-27
updating 23-14
updating, with fmbatch B-10
word-by-word sort order in 23-24
See also book files; generated files in books;
generated lists; index entries
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Infinity in equations 30-12
infix, math element type 28-31
ink colors
CMYK 17-6, 17-22
PANTONE 17-6, 17-8
in-line equations 28-4 to 28-5
See also equations
in-line graphics 15-5
See also anchored frames
inserting
cross-references to paragraphs 10-4 to 10-7
cross-references to specific spots within
paragraphs 10-4, 10-8
in equations. See math elements
footnotes 11-4 to 11-6
graphics in table cells 6-13
hypertext commands 27-9 to 27-10
index entries 23-5 to 23-11
markers for a list of markers 22-5
markers for hypertext commands 27-9
markers for index entries 23-5
markers for spot cross-references 10-8
system variables 12-9 to 12-13
tables 6-4 to 6-7
tables in table cells 6-14
user variables 12-4 to 12-5
See also adding; creating; defining
insertion point
for entering text 3-4
in equations 28-23
placing anchored frames at 15-5
in tables 6-10
in view-only documents 27-35
inset editors for graphic insets 16-15 to 16-17
insets. See graphic insets; text insets
inside/outside margins
changing 18-7
in new documents 2-11
See also page margins
installing. See Installing Frame Products
integrals in equations
adding operands to 28-19

evaluating 30-15
inserting 28-14, 28-17
interactive commands. See hypertext commands
Interchange format (MIF). See MIF file format
Interleaf
importing files from 3-12 to 3-17
opening files from 2-12
See also importing text flows
interline padding, feathering text and 18-18
interline spacing. See line spacing
Intermediate Printer Language (IPL) A-6
International Edition A-7
starting 2-4
using templates in 2-8
Internet
transferring files to technical support on A-3
World Wide Web, for Frame product
information A-5
interparagraph padding, feathering text and 18-18
intersecting lines 13-10
cap style for 13-22
intersections in equations
adding operands to 28-19
inserting 28-14
Introducing FrameMaker 5 xiv
inverse (reverse) text 13-27
inverted printing. See color separations
inverting bitmaps B-12
invisible colors 17-13
invisible snap grid 13-4, 13-6
aligning tab stops with 4-16
aligning table column border to 6-20
spacing of 13-6
IPL (Intermediate Printer Language) A-6
irregular graphic objects. See drawing objects
ISO Latin-1 files. See file formats; text files
Isolate Term command 30-20
italic text 4-7
Emphasis character format for 5-12

J
job number, printer queue 2-41
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joining objects 14-9
See also grouping objects
jumps. See hypertext commands; hypertext links
justification, paragraph 4-14
automatic letter spacing and 4-22

K
keeping
footnotes together with footnote references 11-6
paragraphs together 4-28
table rows together 7-37
kerning
pair 4-10
spell-checking text with vertical 9-6
See also spread
key combinations
conventions for xiii
for nonkeyboard characters 3-6
for quotation marks 3-9
keyboard shortcuts
for applying character and paragraph
formats 5-5
for applying condition tags 26-12
case-sensitivity of 2-19
for inserting system variables 12-12
for inserting user variables 12-5
macros and C-3
for moving insertion point 3-5
for removing condition tags 26-15
for selecting pop-up menu options 2-21
using 2-17
See also macros; Quick Reference
knockouts, color separation 17-12

L
landscape (horizontal) page orientation in new
documents 2-10
languages
for dictionaries 9-8
for dictionaries, ordering A-5
Greek math symbols in equations 28-12, 29-16
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for paragraph spell-checking and
hyphenation 4-24, 9-8, A-7
side by side, in parallel text flows 20-4
for text line spell-checking 13-26, A-7
for Thesaurus 9-19, A-7
user interface, starting 2-4
user interfaces, available A-7
See also accent marks
large math element type 28-31
last page
displaying 2-29
hypertext links to 27-14
<$lastpagenum> building block 12-11
last-saved version, reverting to 2-31
layout. See page layout; templates
layout overrides. See overrides, layout
leader dots, tab 4-17
in generated lists 22-18
in indexes 23-23
leading. See line spacing
Learning FrameMaker tutorial xv
learning words when spell-checking 9-10
left indent. See indenting
left margin. See margins, page; margins, table cell
Left master page 19-2
left quotation mark (‘) 3-8
See also quotation marks
left-aligning. See aligning
legends. See figures; heading rows, table; heads,
text
less-than symbol (See angle brackets
letter groups in indexes 23-26
See also indexes
letter-by-letter index sort order 23-24
letter spacing in justified text 4-22
library of clip art 19-22 to 19-26
available from online services A-4 to A-5
See also imported graphics; objects, graphic
licenses, Frame user 2-5
ligatures 4-10
limits in equations
inserting 28-17
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math element type 28-31
line art. See drawing objects
line breaks, equation 29-7 to 29-9
line breaks, text
after nonalphabetic characters 4-25
in equations 29-7 to 29-9
forcing 4-25
in generated lists 22-13, 22-17
hyphenation points and 4-23
in indexes 23-18
preventing 4-25
in rotated cells 6-24
saving in Text Only format with 2-33
text conversion to a table and 6-27
See also forced returns; hyphenation; running
text around objects
line cap style 13-22
line endings, graphic 13-19, 13-22 to 13-23
arrowheads 13-19
cap styles for 13-22
changing arrowhead shapes for 13-23
current 13-8
line numbers, going to 2-29
line properties, customizing 13-21 to 13-24
line screens (halftone) 17-21
line spacing 4-18 to 4-20
baseline synchronization and 18-19
custom 4-19
feathered text and 18-17
fixed 4-19
line styles, graphic 13-18 to 13-21
changing available 13-23
current 13-8
line widths, graphic 13-18 to 13-21
changing available 13-22
current 13-8
lines, graphic
above and below paragraphs 4-17
arrowhead shapes for, changing 13-23
cap styles for 13-22
connecting 13-10
drawing 13-10

as footnote separators 11-12
joining 14-9
properties of 13-18 to 13-21
properties of, changing available 13-21 to 13-24
in tables. See ruling lines in tables
lines, grid. See grids
lines in tables. See ruling lines in tables
lines of text
anchoring tables in 6-4
finding beginning or end of 8-8
keeping, together 4-28
merging, into paragraphs when saving in Text
Only format 2-34
spacing of 4-18 to 4-20
widow or orphan 4-28
See also text line objects
lining up. See aligning
links
to graphics. See graphic insets; imported
graphics; importing graphics
hypertext. See hypertext commands; hypertext
links
to other pages. See cross-references; hypertext
links
to text. See importing text files; importing text
flows; text insets
lists
autonumbered 4-36 to 4-44
bulleted 4-38 to 4-40
of current licensees, displaying 2-6
of printer queue jobs, displaying 2-41
See also generated lists; indexes
lists of expressions in equations
adding items to 28-12
aligning items in 29-9, 29-12
inserting 28-11
math element type 28-31
lists. See autonumbering; generated lists
locating. See finding
lock file (.lck) 2-14
locked documents. See view-only documents
locking
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documents (converting to View Only
format) 27-33
files in use 2-14
See also view-only documents
log file for macros C-5
logarithms in equations
adding operand to 28-19
inserting 28-18
transforming 30-12 to 30-14
logic symbols, inserting in equations 28-13
Long Division command 30-9
long documents. See book files
lowercase text 4-11
See also capitalization; case-sensitivity

M
Macintosh applications, graphic file formats
for 16-5
See also graphic file formats
macros
canceling C-4
clearing current C-6
comments explaining C-3
creating C-2
deleting stored C-6
in dialog boxes C-8 to C-11
file syntax C-7
finding with C-10
keyboard shortcuts and C-3
limitations of C-4
log file for C-5
macro files for, creating C-5
macro files for, managing C-5 to C-7
and mouse gestures C-4
playing back C-4
reading, from a file C-6
repeating C-11
sample. See macros, sample
saving, in a file C-5
triggers C-3
See also keyboard shortcuts; macros, sample
macros, sample
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changing anchored frames C-8
displaying a dialog box and stopping C-11
repeating in another macro C-11
searching for anchored frames C-10
starting in dialog boxes C-11
using in dialog boxes C-7 to C-11
using several windows C-8
See also macros
magnifying a view. See zooming
main dictionary 9-13
See also dictionaries
Maker Interchange Format. See MIF file format
Maker Markup Language (MML) file format xvi,
2-12
Maker menu, using 2-18
Managing Frame Products xv
manual equation alignment point symbol (|) 2-27,
29-10
manual feed, when printing 2-40
manual hyphenation 4-23
margins, page
anchored frames in 15-12
changing, on individual page 19-12
changing, throughout a document 18-7
in new documents 2-11
See also indenting
margins, table cell 7-31 to 7-34
customizing 7-32
marker lists
fixing problems in 22-11 to 22-13
generating 22-7
indexes compared to 22-6
preparing source documents for 22-5
See also generated lists
marker symbol 2-27
marker text
changing found 8-16
editing 23-14
finding 8-12
for hypertext commands. See hypertext
commands
for index entries. See index entries
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in running headers and footers 12-22
for spot cross-references 10-8
See also cross-references; markers
marker types, changing names of 22-6
<$marker1>, <$marker2> building blocks 12-22
markers
conditional 26-10
Cross-Ref 10-4, 10-8
cross-reference. See cross-references
deleting 23-14
editing text in 23-14
finding 8-12
hypertext 27-9
index 23-5 to 23-11
inserting, for hypertext commands 27-9
inserting, for index entries 23-5
inserting, for a list of markers 22-5
inserting, for spot cross-references 10-8
selecting 23-13
showing/hiding symbols for 2-26
types of, renaming 22-6
marks, crop and registration 2-40, 17-18
masking. See cropping
master indexes for several books 24-18
master pages
active areas on (hypertext) 27-7
adding background text to 19-6
alternating left and right 20-5
assigning, to body pages 19-7 to 19-9
as basic layout grid for multiflow
newsletters 20-6
creating 19-17 to 19-19
deleting custom 19-19
displaying 18-10
drawing template text frames (tagged) on 19-14
duplicating text frames on 19-16
flow tags, using on 19-5, 19-9
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
Left 19-2
margins of, changing on individual 19-12
none assigned to body page 19-21

overriding layout of, on body page 19-20
planning 21-5
renaming 19-19
Right 19-2
rotated, creating 19-18
system variables on 12-9 to 12-12, 19-7
updating, with body page changes 19-10
updating body pages with changes to 19-10
See also body pages; footers, page; headers, page;
page layout; running headers and footers;
text flows
master table of contents for several books 24-18
See also generated files in books; generated lists
math definitions, importing and updating 21-12
to 21-13
with fmbatch B-10
math element definitions
changing 28-32
changing spacing in 29-6
creating 28-29
creating, for delimiters 28-31
creating, for vertical lists 28-32
deleting 28-32
math elements
adding operands to 28-19
alphanumeric characters 28-10 to 28-11
braces 28-15
brackets, square ([]) 28-15
calculus symbols 28-14, 28-17
character formats for 29-14 to 29-17
choice functions 28-15
copying, cutting, and pasting 28-25
custom, creating. See math element definitions
custom, inserting 28-20
deleting, from equations 28-25
delimiters 28-15
derivatives 28-17
diacritical marks 28-12
differentials 28-17
dots 28-12
equal signs 28-16
exponents 28-13
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finding names of built-in 28-32
formatting. See equations
functions 28-18
gradients 28-17
Greek letters 28-12
horizontal lists of expressions. See horizontal
lists of expressions in equations
inserting 28-8 to 28-20
inserting, from the keyboard 28-10
integrals 28-14, 28-17
intersections 28-14
limits 28-17
lists of expressions. See horizontal lists of
expressions in equations; vertical lists of
expressions in equations
logic symbols 28-13
matrices 28-18
micropositioning 29-4
operators 28-13
parentheses 28-15
positioning 29-4 to 29-7
primes 28-12
products 28-14
radicals 28-13
relations 28-16
replacing 28-24
roots 28-13
spacing around 29-5, 29-16
square brackets ([]) 28-15
straight quotation marks in strings 28-11
strings 28-10
subscripts 28-13
summations 28-14
sums 28-19
superscripts 28-13
toggling formats for 28-26
types of 28-31
unions 28-14
vertical lists of expressions. See vertical of
expressions in equations
See also equations; Equations palette;
expressions in equations; individual math
elements; math fonts
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math fonts 29-14 to 29-17
installing 29-17
mathematical expressions. See equations;
expressions in equations; math elements
Mathematical Pi font, in equations 29-16
matrices in equations
adding and removing brackets on 28-27
adding rows and columns to 28-27
aligning cells in 29-13
changing row height and column width of 28-28
computing determinant of 30-13
deleting rows and columns from 28-27
inserting 28-18
math element type 28-31
transposing rows and columns in 30-4
matrices of graphics, creating active areas in
(hypertext) 27-17
Matrix Algebra command 30-4
Matrix Commands pop-up menu 30-4
Matrix Transpose command 30-4
measurement units
display units 2-11
display units, changing 2-22
dots-per-inch (dpi) 16-8, 16-9
measuring objects and distances 14-23 to 14-24
memory, allocating for images 16-8
menus
complete 2-19
custom 2-19
hypertext pop-up 27-19 to 27-21
Maker pop-up 2-18
menu bar 2-17
quick 2-19
in view-only documents 27-35
merging. See combining; composite documents;
conditional documents; connecting; importing
text files; importing text flows
messages, hypertext alert 27-22
Meta key xiii
Metafile preview image 16-5
micropositioning math elements 29-4
Microsoft Word
importing files from 3-12 to 3-17
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opening files from 2-12
See also importing text flows
middle-click mouse action xiii
MIF file format xvi
deactivating cross-references in hypertext
documents with 27-13
importing files in 3-12 to 3-17
opening files in 2-12
saving files in 2-31
See also importing text flows
MIF Reference xvi
millimeters (measurement units) 2-22
<$minute>, <$minute00> building blocks 12-17
minutes in system variables 12-17
mirror images
creating, by flipping objects 14-13
printing (emulsion down) 17-19
missing graphic images 16-14
missing index entries 23-16, 26-20
missing links in hypertext pop-up menus 27-26
missing text insets 3-19, 3-23
mixed-caps text 4-11
See also capitalization
mixed-text versions. See conditional documents
mixing colors 17-4, 17-6 to 17-10
See also colors
MML file format xvi, 2-12
MML Reference xvi
models, color 17-4, 17-6
choosing 17-6
modification date variables 12-11
modifying. See changing; converting; customizing;
editing; replacing; updating
monitors, color, color display on 17-6, 17-7
monochrome, converting images to B-13
<$monthname>, <$monthnum>, <$monthnum01>,
building blocks 12-17
months in system variables 12-17
mouse gestures xiii
macros and C-4
movement, constraining 14-4
moving

anchored frames 15-18 to 15-19
between table cells 6-11
cross-references 10-9
documents 2-31 to 2-33
in documents (navigating) 2-28 to 2-30
equations 28-8
graphics. See moving, objects
header/footer text frames 18-12
insertion point in equations 28-23
insertion point in tables 6-10
insertion point in text 3-4
objects 14-4 to 14-7, 14-11
objects to back or front 14-7
objects into graphic frames 15-15
objects with text 15-2
to specific pages 2-28
system variables 12-13
tab stops 4-16
table rows or columns 6-17
tables 6-8
text 3-10
user variables 12-6
in view-only documents (navigating) 27-34
See also aligning; cutting and pasting;
positioning; rotating
multicolumn documents
aligning text in 18-16 to 18-21
anchored frames in 15-9
footnotes in 11-5
margins of, changing, on one page 19-12
new 2-11
number of columns in, changing 18-9, 19-13
to 19-17
side heads in 4-33
straddle paragraphs in 4-34
tables in 6-5
multifile books. See book files
multifile chapters in books 24-16
multiflow documents
comparing 25-11
generated lists for 22-9
newsletter-style text flows for 20-6
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parallel text flows for 20-4
text flows in 20-2 to 20-16
tracking flows in 20-15
multilingual documents, parallel text flows for 20-4
multipage tables
page breaks in 7-36 to 7-38
setting up 6-12
multiple platforms, using Frame products on. See
Using Frame Products on Multiple Platforms
multiple versions of a document. See comparing
documents; conditional documents
multiplication operators, inserting in
equations 28-13
Multiplication pop-up menu 30-6 to 30-9
Multiply Out command 30-7
Multiply Out Once command 30-8

N
naming
backup files 2-35
book files 24-6
character tags, conventions for 5-12
colors 17-8
condition tags 26-6 to 26-9
documents 2-31 to 2-33
generated files in books 24-11
imported graphics, conventions for 16-13
master pages 19-19
paragraph tags, conventions for 5-12
reference frames 19-23 to 19-25
reference pages 19-26
table tags, conventions for 7-9
text insets, conventions for 3-20
text symbols 2-27
See also character formats; math elements;
paragraph formats; renaming; table
formats; flow tags; titles
NaN (Not a Number) in equations 30-12
navigating
in documents 2-28 to 2-30
in view-only documents 27-34
negative images, printing 17-19
negative powers, removing 30-11
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newsletters
continuation columns in 20-14
multiflow, text flows for 20-6
in a single flow 20-8
synchronizing text baselines in 18-20
next page
displaying 2-28
hypertext links to 27-14
next paragraph, specifying format for 5-9
nonalphanumeric characters 4-9
backslash (\) as prefix for 4-26
backslash (\) prefix for 4-35
line breaks after 4-25
See also character sets; characters; Quick
Reference; special characters
NoName documents 2-9
nonbreaking hyphens
finding 8-9
typing 4-23
nonbreaking spaces
finding 8-9
symbol for 2-27
typing 4-25
nonprinting items
comments in conditional text 26-13
hypertext buttons 27-7 to 27-8
pages. See master pages
text symbols 2-26
nonsequential exploration. See hypertext links
nonstandard words and punctuation. See spellchecking
nontext items, finding 8-4 to 8-6
<$nopage> index marker building block 23-9
Normal-format documents 2-31
activating hypertext commands in 27-30
converting view-only documents to 27-33
notes, document, using conditional text for 26-13
See also endnotes; footnotes
Number Crunch command 30-12
number, go to page 2-28
number series. See autonumbering
numbered lists 4-36 to 4-44
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See also autonumbering
numbering in tables 7-35
See also autonumbering
numbering styles
footnote 11-9 to 11-11
page 18-14
revision page 25-8
numbers
of chapters in book files 24-15 to 24-16
in equations, font for 29-17
floating-point, in equations 30-12
in lists. See autonumbering
of pages, even or odd 3-11
paragraph. See autonumbering
printer queue 2-41
for sheets of multipage tables 6-12
spell-checking words that contain 9-7
See also equations; measurement units; page
numbers; pagination, freezing and
unfreezing
numeric spaces
finding 8-9
typing 3-7
numeric underlining 4-7, 4-9

O
object path 13-9
object properties
of anchored frames 15-20
current 13-8
duplicating 13-20
of equations 29-8, 29-11
offsets (position) 14-5, 14-24
overprinting 17-15
rotation angle 14-14 to 14-16
of rounded rectangles 14-18
size 14-23
of text line objects 14-10
text runaround. See running text around objects
See also drawing properties; objects, graphic
Object Selection tool 13-15
object stacking, back to front (draw order) 14-7

object types. See drawing objects
<$ObjectId> hypertext building block 27-31
objects, equation. See equations
objects, graphic
as active hypertext areas 27-7 to 27-8
as active hypertext matrices 27-17
aligning 14-10 to 14-11
aligning, with snap grid 13-6
anchoring, to text. See anchored frames
autonumbering figures and 4-44
boilerplate 19-22 to 19-26
bringing, to front 14-7
capturing screen images 16-17 to 16-18
clip art 19-22 to 19-26
clip art, available from online services A-4
to A-5
color of 13-18 to 13-21, 17-5
color of, current 13-8
in conditional documents 26-6
connecting, by using gravity 14-12
constraining movement of 14-4
copying, cutting, and pasting 14-6
copying, cutting, and pasting, into graphic
frames 15-16
cropping 14-19
deleting 14-6
deselecting 13-17
distributing 14-11
draw order of (object stacking, back to
front) 14-7
drawing. See drawing objects
drawing environments for 13-4
drawing properties of 13-18 to 13-24
duplicating, without using Clipboard 14-6
flipping 14-13
grouping and ungrouping 14-8
handles 13-15
inspecting position of 14-24
joining 14-9
masking 14-19
measuring 14-23
moving 14-4 to 14-7, 14-11
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moving, to back or front 14-7
moving, into graphic frames 15-15
moving, with text 15-2
overlapping 14-7, 17-15
overprinting 17-15
in paragraph formats 4-17
placing, in graphic frames 15-15
placing, in table cells 6-13
printing 2-37
properties of. See drawing properties; object
properties
reference frames containing 19-23
reshaping 14-18 to 14-19, 14-20 to 14-23
resizing 14-17
rotating 14-14 to 14-16
rotating, by flipping 14-13
rotating, snap rotate interval 13-6
rounding corners of rectangles 14-18 to 14-19
running text around. See running text around
objects
scaling 14-17
selecting 13-15 to 13-17
sending, to back 14-7
smoothing and unsmoothing 14-18 to 14-19
symmetrical 14-13
trapping 17-16
See also graphics; imported graphics; importing
graphics; text line objects; Tools palette
<$Objectype> hypertext building block 27-31
odd page count in documents 18-15
offsets
of anchored frames 15-5 to 15-12
of equations 14-6, 28-8
of objects 14-5
of objects, inspecting 14-24
of superscripts and subscripts 4-12
of text line objects 14-6
See also distance between objects; gap
one-time-only page layout, creating 19-20 to 19-21
See also overrides, layout
online documents. See hypertext documents; viewonly documents
online Help 2-23
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as a hypertext document 27-11
online systems. See hypertext online systems
open documents, closing 2-42
opening documents 2-12 to 2-16
after crashes 2-36
in book files 24-24
file formats recognized when 2-12
with fmbatch utility B-6
lock files and 2-14
MIF and MML files 2-12
new unnamed, hypertext command for 27-15
recently opened 2-15
substituting fonts when 2-14
text files 2-16
view-only, in a new window 27-35
opening files
in book files 24-24
file types allowed 2-12
with fmbatch utility B-6
text files 2-16
operands, adding in equations 28-19
operators, inserting in equations 28-13
order of index entries 23-10, 23-24 to 23-26
problems with 23-17
order of text versions. See conditional text
Order Sum command 30-6
Order Sum Reverse command 30-6
ordering Frame products A-5 to A-8
orientation, page
for new documents 2-10
for printing thumbnails 2-40
rotated 19-18
orphan lines in paragraphs 4-28
orphan rows in tables 7-36
Other Rewrites pop-up menu 30-18 to 30-20
outlines, autonumbering of 4-42
See also autonumbering
outside/inside margins
changing 18-7
in new documents 2-11
See also margins, page
ovals, drawing 13-10
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overflows, text frame 13-27, 20-8, 20-10
overlapping objects 14-7
printing colored 17-15
overlapping text frames, causes of 19-9
overlays. See spot colors
overlined text 4-7
See also condition indicators
overlooking words. See spell-checking
overprinting objects 17-15
overrides, format
change bars and 25-4, 25-6
character formats and 5-6
paragraph formats and 5-13
of paragraph formats, removing 5-12 to 5-17
removing, when importing formats 21-12
to 21-13, 24-26
table formats and 7-6
overrides, layout
on body pages 19-20
removing 19-10 to 19-11
removing, when importing formats 21-12
to 21-13, 24-26
overriding
active areas on master pages (hypertext) 27-7
default punctuation of run-in heads 4-35
Smart Quotes 3-9

P
padding, interline, when feathering text 18-18
page breaks
controlling 4-26 to 4-29
in multipage tables 7-36 to 7-38
starting position for tables and 7-30
page count
in book files 24-17
in documents 18-13
odd or even 18-15
Page Count system variable 12-11
page headers and footers. See footers, page;
headers, page; running headers and footers
page layout
basic, in templates 21-6

column layout, changing 18-7 to 18-9
column layout, in new documents 2-11
custom 19-12 to 19-19
custom master pages and 19-17 to 19-19
double-sided 18-6
headers and footers for 18-10 to 18-13
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
margins, changing 18-7
margins, changing on individual page 19-12
margins, in new documents 2-11
multiflow. See multiflow documents
in new documents 2-10 to 2-11
one-time-only 19-20 to 19-21
orientation in new documents 2-10
overrides, removing 19-10 to 19-11
overrides, removing, when importing
formats 21-12 to 21-13, 24-26
overriding of master 19-20
page size 18-5
portrait or landscape 2-10
predefined. See templates
rotated 19-18
single-sided 18-6
symmetrical and asymmetrical 18-7
thumbnails of 2-40
See also background text columns (untagged);
columns, text; master pages; templates
page margins. See margins, page
page numbers
alphabetic 18-14
in books 24-12 to 24-17
in cross-references 10-13 to 10-15
customizing 18-13
in documents 18-13 to 18-14
in generated lists 22-15 to 22-18
go to page 2-28
in headers and footers 18-13
highest, in book 24-17
highest, in document 18-13
hypertext links to 27-13 to 27-15
in index entries. See index entries
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page n of n style, in books 24-17
on revision pages 25-8
Roman numerals as 18-14
styles of 18-14
system variables for 12-11
page side, first
in books 24-14
in new documents 2-11
page size
changing 18-5
and existing text frames 18-6
of new documents 2-11
See also paper size
page-anchored graphics. See unanchored graphic
frames
page-based reference lists. See generated lists
<$pagenum> building block
in cross-reference formats 10-13
in special text flows for generated lists 22-15
in special text flows for indexes 23-22
<$pagenumonly> hypertext building block 27-31
pages
adding, automatically 3-6
adding, manually 20-10
adding, manually to multiflow documents 20-7
Autoconnect and 20-7, 20-9
blank, adding or deleting at end of
document 18-15
blank, adding or deleting in book files 24-23
blank, preventing from printing 17-20
breaks between 4-26 to 4-29
columns of text in. See columns, text; page
layout
counting, in books 24-17
counting, in documents 18-13
custom layout for 19-12 to 19-19
deleting 3-12
deleting, from book files 24-23
deleting, disconnected 20-16
deleting, from end of documents 18-15
as destinations. See hypertext links
displaying 2-28 to 2-30
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double-sided, printing 2-39
hypertext links to specific 27-13 to 27-15
last, in document 3-11
layout of. See page layout
margin settings for, changing 18-7
margin settings for, in new documents 2-11
navigating in 2-28 to 2-30
numbering. See page numbers
orientation of, in new documents 2-10
pasting objects onto 14-7
preventing Frame from creating 20-9
printed, orientation of. See orientation, page
printing. See printing
revision 25-7 to 25-9
rotating 19-18
scrolling 2-28 to 2-30
thumbnails, printing 2-40
zooming, in/out 2-25 to 2-26
See also blank pages; body pages; columns, text;
master pages; plates; reference pages; text
frames
pagination, freezing and unfreezing 25-7 to 25-9
See also page numbers
pair kerning 4-10
See also spread
palettes. See Character Catalog; Equations palette;
Paragraph Catalog; Tools palette
PANTONE colors 17-6, 17-8
printing 17-10
paper sizes 2-38, 2-40
See also page size
paragraph autonumbering. See autonumbering
Paragraph Catalog
adding formats to 5-7, 5-10 to 5-11
applying formats from 5-5
closing 2-21
deleting formats from 5-22
displaying 5-6
importing formats to 21-12 to 21-13
importing formats to, with fmbatch B-10
renaming formats in 5-22
updating formats in 5-8, 5-12 to 5-17
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See also Paragraph Designer; paragraph formats
paragraph cross-references 10-4 to 10-7
Paragraph Designer
As Is property settings in 5-18
Default Font properties 4-7 to 4-13
displaying 4-6
displaying catalog format properties in 5-13
functions of 4-6
Numbering properties and tables 7-35
resetting properties in 4-7
Table Cell properties 7-32
updating formats in 5-8, 5-12 to 5-17
using 5-8
See also Paragraph Catalog; paragraph formats
Paragraph Format window. See Paragraph
Designer
paragraph formats
adding change bars by using 25-6
for anchored frames 21-8
applying 5-5
applying, to paragraphs with certain tags 5-7
As Is settings for 5-18
for callouts (text) 21-8
copying and pasting 5-7
creating 5-11
creating, guidelines for 5-12
defined 5-2
deleting 5-22
designing, for templates 21-7
for footnotes 11-10
graphics used in 4-17
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
overrides of 5-13
overrides of, removing 5-12
overrides of, removing, when importing
formats 21-12 to 21-13, 24-26
reference frames used in 19-22 to 19-25
renaming 5-22
specifying, for next paragraph 5-9
table cell margins and 7-16 to 7-18, 7-34
for table text 6-11

updating 5-8, 5-12 to 5-17
updating, in conditional text 26-18
See also autonumbering; Paragraph Catalog;
Paragraph Designer; paragraphs;
paragraph tags
paragraph lists. See generated lists
paragraph symbol (¶) 2-27
finding 8-9
paragraph tags
in cross-references 10-13
finding 8-4 to 8-6
guidelines for 5-12
imported, with same name 21-12 to 21-13
in running headers and footers 12-20 to 12-21
See also paragraph formats
paragraphs
aligning 4-14
autonumbering 4-36 to 4-44
boxing 4-18
bulleted lists and 4-38 to 4-40
capitalization style of 4-11
centering 4-14
change bars and 25-5 to 25-6
character spread in 4-10
color of text in 17-5
converting into table text 6-25
in cross-references 10-13
current 3-4
default font properties of 4-7 to 4-13
formatting 4-7 to 4-44
full-width 4-34
graphic lines above and below 4-17
hyphenation and 4-23 to 4-24
indenting 4-13
indenting, in table cells 6-11
justifying 4-14
justifying, automatic letter spacing and 4-22
keeping lines together in 4-29
keeping, together on a page 4-28
language for spell-checking and
hyphenation 9-8
line breaks in 4-25
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line spacing within 4-18 to 4-20
lines above and below 4-17
lists, autonumbered 4-43
next, paragraph format for 5-9
pair kerning in 4-10
revision pages and 25-8
rules above and below 4-17
run-in heads 4-34
in running headers and footers 12-20
selecting 3-10
side heads. See side heads
skipping, when spell-checking 9-8
space above and below 4-20
space between, when feathering 18-17
start position of 4-26 to 4-29
straddle 4-34
tab stops in 4-15 to 4-17
testing types of 21-11
word spacing in 4-21 to 4-22
See also autonumbering; paragraph formats;
text
parallel text flows, setting up 20-4
See also text flows
<$paranum> building block
in cross-reference formats 10-13
in running header/footer variables 12-21
in special text flows for generated lists 22-17
in special text flows for indexes 23-22
<$paranumonly> building block
in cross-reference formats 10-13
in running header/footer variables 12-21
in special text flows for generated lists 22-17
in special text flows for indexes 23-22
<$paratag> building block
in cross-reference formats 10-13
in running header/footer variables 12-21
<$paratext> building block
in cross-reference formats 10-13
in running header/footer variables 12-21
in special text flows for generated lists 22-15
parentheses () in equations
inserting 28-15
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removing 28-26
toggling format of 28-26
partial differentials. See derivatives in equations
pasting. See Clipboard; copying and pasting;
cutting and pasting
path, object 13-9
pathnames, file location
for graphics imported by reference 16-12
in hypertext commands 27-12
for text insets 3-20
See also filenames
patterns. See fill patterns; pen patterns
PDF (Portable Document Format) 27-36
pen patterns 13-18 to 13-21
current 13-8
transparent 13-19
percentage, scaling. See scaling
permissions
for saved files 2-32
for templates 21-12
personal dictionary 9-13 to 9-15, 9-15 to 9-17
adding hyphenated compound words to 9-16
adding words to 9-10, 9-15
changing 9-14
creating 9-14
deleting words from 9-14
editing 9-15
ignoring, while spell-checking 9-14
managing 9-13 to 9-15, 9-15 to 9-17
merging 9-14
using another 9-14
See also dictionaries
personal licenses 2-5
picas (measurement units) 2-22
PICT format 16-5
printing, in color 17-20
pictures. See graphics; objects, graphic
placeholders for text. See markers; system
variables; user variables
placement. See aligning; moving; page layout;
positioning
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placing graphics. See anchored frames; imported
graphics; importing graphics; running text
around objects
placing insertion point 3-4
in view-only documents 27-35
plates. See printing
platforms, compatibility across
for imported graphics 16-7
See also Using Frame Products on Multiple
Platforms
platforms, locking files across 2-14
plus sign (+) in book window 24-11
PM or AM in system variables 12-17
point pages. See revision pages
point size, text 4-8
small caps 4-11
superscript and subscript 4-12
pointed brackets. See angle brackets
pointers
arrow 13-15
crossed I-beam 13-25
drawing cross (cross-hair) 13-8
I-beam 3-4, 13-15
Object Selection tool and 13-15
question mark Help 2-23
Smart Selection tool and 13-15
points
control 14-20
defining, for freehand curves 14-22
hyphenation 9-11
as measurement units 2-22
See also point size, text
polygons
adding or removing corners and sides on 14-22
drawing 13-11 to 13-12
drawing, regular 13-12
reshaping 14-20
polylines
adding or removing corners and sides on 14-22
drawing 13-11
joining 14-9
reshaping 14-20

polynomials, arranging 30-6
pop-up menus 2-20
pop-up menus, hypertext 27-19 to 27-21
debugging 27-26
Portable Document Format (PDF) 27-36
portrait (vertical) page orientation in new
documents 2-10
positioning
anchored frames. See positioning anchored
frames
change bars 25-5
equations 14-6, 28-8
graphics in text. See anchored frames; importing
graphics; imported graphics; running text
around objects
imported graphics 16-5
math elements in equations 29-4 to 29-7
objects. See positioning objects
tables in text frames 7-28 to 7-31
text in table cells 7-31 to 7-35
See also aligning; moving; rotating
positioning anchored frames 15-5 to 15-15
changing position 15-18
between/outside columns 15-9
at insertion point 15-5
in margin 15-12
in text column 15-6
at top corner of paragraph 15-13
positioning objects 14-4 to 14-7
in back 14-7
in front 14-7
inspecting position of objects 14-24
object path and 13-9
postfix math element type 28-31
PostScript code in text columns 16-10
PostScript files 2-40
books printed as 24-25
color definitions in 17-4
documents printed as 2-40
Encapsulated (EPS) 16-5
See also graphic file formats
power failures, opening documents after 2-36
powers in equations, evaluating 30-19
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preferences
autosave 2-35
backup 2-35
See also customizing; default
prefix math element type 28-31
prefixes for page numbers in book files 24-13
preset display units, changing 2-22
preventing
bad page breaks 4-26 to 4-29
creation of new body pages 20-9
graphic frame from clipping contents 15-17
hyphenation 4-23, 9-12
line breaks, text 4-25
printing of blank pages 17-20
unresolved cross-references to conditional
text 26-12
widow/orphan lines 4-28
preview images, EPS 16-5
previous location in hypertext stack 27-16
previous page
displaying 2-28
hypertext links to 27-14
primes, inserting in equations 28-12
printer queue, managing 2-41
printing
book files 24-24
changing settings for, without printing 2-39
collated copies 2-39
colors 17-13 to 17-21
colors as black 2-40, 17-17
colors in imported graphics 17-20, 17-16
composite color plates 17-16
conditional documents 26-20
crop marks 2-40, 17-18
cross-references updated when 10-19
customizing 2-39
DCS graphic files 17-20
deleting jobs from queue 2-41
documents 2-37 to 2-40
enlarging or reducing page image when 2-40
to files 2-40
with fmbatch B-7
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fmbatch messages B-6
fmprint utility and B-12
graphics 2-37, 2-39
halftones 17-21
last page first 2-39
manual feed 2-40
negative images 17-19
pages 2-37
pages, in books 24-25
PANTONE colors 17-10
paper size 2-38, 2-40
PostScript code columns 16-10
reducing or enlarging page image when 2-40
registration marks 2-40, 17-18
resolution 2-39
skipping blank pages when 17-20
thumbnails 2-40
two-sided pages 2-39
process color, printing 17-13 to 17-21
See also CMYK color model; color separations
products in equations
adding operands to 28-19
evaluating 30-20
inserting 28-14
projecting cap (line style) 13-22
properties. See change bars; colors; drawing
properties; footnotes; object properties;
paragraphs; tables; text
proportional size changes. See scaling
proportional spaces 3-7
ps_prolog file 2-40, 17-21
published pages, revision pages and 25-7 to 25-9
publisher boundaries, showing and hiding 2-27
punctuation
in autonumber formats 4-37
in conditional text 26-5
in index entries 23-5 to 23-11
line breaks after 4-25
after run-in heads 4-35
spell-checking 9-6
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Q
question mark (?)
finding a literal 8-8
Help pointer 2-23
prompt, in equations 28-5
as wildcard for finding 8-8
question marks, double (??), in index entries 23-16
queue, printer, managing 2-41
quick menus 2-19
Quick Reference xiv
QuickAccess bar 2-21
See also Quick Reference
quick-copying
objects 14-6
text 3-11
quitting (exiting) 2-42
hypertext command for 27-24
quotation marks
straight, in equations 28-11
straight, spell-checking for 9-6
typing 3-8

R
radicals in equations
adding operands to 28-19
evaluating 30-19
inserting 28-13
transforming 30-8
radius of rounded rectangle corners 14-18 to 14-19
range kerning. See spread
rasterfiles. See bitmaps
read-only documents. See view-only documents
recording macros C-2
recover files 2-35
rectangles
drawing 13-10
rounding the corners of 14-18 to 14-19
reducing
printed page images 2-40
zoom displays 2-25 to 2-26
See also cropping; resizing; scaling
reference frames

above and below paragraphs 4-17
creating 19-23
as footnote separators 11-12
graphics in 19-23
naming 19-23
renaming 19-24
using 19-22 to 19-25
See also graphic frames; unanchored graphic
frames
reference, importing by. See importing graphics;
importing text files; importing text flows
reference lists, page-based. See generated lists
reference pages
boilerplate graphics on 19-22 to 19-26
copying anchored frames to body pages
from 19-26
creating 19-23
deleting 19-26
displaying 19-23
graphics on, in templates 21-8
hypertext commands for matrix cells on 27-17
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
importing text flows from. See importing text
flows
math element definitions 28-28 to 28-32
renaming 19-26
special text flows on, for generated lists 22-14
special text flows on, for indexes 23-20
unanchored graphic frames on 19-23
referenced graphics. See imported graphics;
importing graphics
referenced text. See cross-references; endnotes;
footnotes; importing text files; importing text
flows; indexes; text insets
registration marks, printing 2-40, 17-18
See also color separations; spot colors
regular polygons 13-12
regular ruling. See ruling lines in tables
rehyphenating a document 9-12
related words, Thesaurus lookup of 9-17
relations, inserting in equations 28-16
relative pathnames
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for graphics imported by reference 16-12
for text insets 3-20
relative tab stops 3-6
Release Notes xv
<$relfilename> hypertext building block 27-31
Remove Division 1 Level command 30-10
Remove Division command 30-10
Remove Negative Powers 1 Level command 30-11
Remove Negative Powers command 30-11
removing
autonumbers 4-38
braces ({}) from equations 28-26
bullet symbols from bulleted lists 4-39
character formats from text by restoring
paragraph’s default font 5-7
condition tags from text 26-14 to 26-15
corners from polygons and polylines 14-22
delimiters from equations 28-26
documents from book files 24-12
format overrides 5-12, 7-11
format overrides when importing formats 21-12
to 21-13, 24-26
gaps between printed colors 17-15 to 17-16
handles from objects 14-22
layout overrides 19-10 to 19-11
layout overrides when importing formats 21-12
to 21-13, 24-26
negative exponents from equations 30-11
page numbers from index entries 23-9, 23-18
parentheses () from equations 28-26
points from freehand curves 14-22
sides from polygons and polylines 14-22
square brackets ([]) from equations 28-26
square brackets ([]) from matrices in
equations 28-27
table ruling and shading 7-27 to 7-28
table titles 7-17
text frames from text flows 20-12
vertices from polygons and polylines 14-22
See also clearing; cutting and pasting; deleting
renaming
book files 24-6
Character Catalog formats 5-22
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documents 2-31 to 2-33
generated files in books 24-11
marker types 22-6
master pages 19-19
Paragraph Catalog formats 5-22
reference frames 19-24
reference pages 19-26
Table Catalog formats 7-15
See also naming
repeated characters and words, spell-checking
and 9-6
repeating graphics 19-5
See also boilerplate graphics
repeating macros C-11
repeating tab stops 4-16
repeating text. See footers, page; headers, page;
user variables
replacing
in equations 28-24
imported graphics 16-10
system variables 12-13
table rows and columns 6-18
text 3-12
text insets 3-19
user variables 12-6
words by using Thesaurus 9-20
See also changing; cutting and pasting; editing;
updating
reports, document, generating 22-9, 22-10
repositioning. See moving; positioning
reproduction quality printing (printing
resolution) 2-39
reshape handles 14-20
reshaping objects 14-18 to 14-19, 14-20 to 14-23
adding or removing corners 14-22
arcs 14-22
curved 14-20 to 14-23
freehand curves 14-20, 14-22
polylines/polygons 14-20
rounded rectangles 14-18 to 14-19
smoothing and unsmoothing 14-18 to 14-19
resizing
anchored frames 15-20
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anchored frames, by shrinkwrapping 15-6,
28-21
bitmaps 16-9
document window automatically, hypertext
command for 27-15
header/footer text frames 18-12
imported graphics 16-9
objects 14-17
table cells 6-19 to 6-23
table columns 6-19 to 6-22
table rows 6-22
text frames 18-7, 19-12
text line objects 14-17
See also scaling; zooming
resolution
halftone 17-21
printing 2-39
See also scaling
restoring last-saved version 2-31
retaining formats. See overrides, format
retracing jumps in hypertext documents 27-34
returns, line. See forced returns; line breaks, text
reverse text 13-27
reversing search direction 8-6
reverting to last-saved version 2-31
revision pages
creating 25-7 to 25-8
numbering style of 25-8
restoring consecutive page numbers 25-9
revisions, indicating with change bars 25-4 to 25-7
RGB color model 17-6, 17-22
right indent. See indenting
right margin. See margins, page; margins, table
cell
Right master page 19-2
right quotation mark (’) 3-8
See also quotation marks
right-aligning. See aligning
Roman numerals
autonumbering with 4-40 to 4-43
page numbering with 18-14
spell-checking 9-7

roots in equations
evaluating 30-19
inserting 28-13
math element type 28-31
transforming 30-8
rotating
equations 14-16
graphic frames 14-16
master pages and body pages 19-18
objects 14-14 to 14-16
objects, by flipping 14-13
objects, snap rotate interval for 13-6
pages 19-18
table cells 6-23
tables 6-9
See also moving; positioning
rotation angle for objects 14-14 to 14-16
round cap (line style) 13-22
rounded rectangles
changing corner radius of 14-18 to 14-19
drawing 13-10
row-by-row conversion of tables to paragraphs 6-28
rows, equation matrix 28-27
transposing with columns 30-4
rows, table
adding 6-16
conditional 26-10
conditional, finding 26-18
copying and pasting 6-17
cutting and pasting 6-17
deleting 6-18
height of 6-22
keeping, together on page 7-37
minimum number of, on page 7-36
moving 6-17
numbering across 7-35
removing ruling or shading from 7-27 to 7-28
replacing 6-18
resizing 6-22
ruling lines in 7-18 to 7-23
selecting 6-7
selecting in 6-11
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shading in 7-23 to 7-26
straddling cells in 6-22
See also cells, table; footing rows, table; heading
rows, table; tables
ruler markings
aligning objects with 13-6
aligning paragraph indents with 4-14
aligning tab stops with 4-16
rulers, document window 2-26 to 2-28
Rules pop-up menu 30-16 to 30-17
ruling lines above and below paragraphs 4-17
ruling lines in tables 7-18 to 7-23
creating or editing styles 7-22
custom 7-18, 7-21
deleting styles 7-23
displaying settings for 7-26
regular 7-18
removing 7-27 to 7-28
runaround text. See running text around objects
run-in heads 4-34
anchored frames in 15-8
running headers and footers
autonumbers in 12-20 to 12-21
in books 24-15
condition tags in 12-23
creating 12-18 to 12-24
dictionary style 12-24
glossary style 12-24
marker text in 12-22
paragraph tags in 12-20 to 12-21
paragraph text in 12-20
system variables in 12-18 to 12-24
See also footers, page; headers, page
Running H/F system variables 12-11
running text around objects
anchored frames 15-13
equations 13-30
tables 6-6
text line objects 13-30
unanchored graphics 13-30
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S
saturation, color 17-6, 17-23
saving
all files in book 24-27
automatically 2-35
book files 24-6
conditional document versions 26-9
documents 2-30 to 2-36
files with fmbatch B-8
macros in a file C-5
table cells as paragraphs 2-33
text-only documents 2-33
view-only files 2-31
without a license 2-6
scaling
imported graphics 16-7 to 16-8, 16-9
objects 14-17
printed page images 2-40
table columns 6-19 to 6-22
See also resizing; zooming
scope of operation in equations 28-9
screen angles, halftone 17-21
screen images
capturing 16-17 to 16-18
cropping 16-18
screen resolution (imported graphic scaling) 16-9
script math element type 28-31
scroll lists in dialog boxes, limiting contents
of 2-15, 24-8
scrolling 2-28 to 2-30
searching. See finding
<$second>, <$second00> building blocks 12-17
seconds in system variables 12-17
“See” and “See also” index entries 23-9, 23-18
selecting
anchored frames 15-15
cross-references 10-9
in dialog boxes, with keyboard 2-21
equations 28-25
in equations 28-23
hypertext markers 27-10
markers 23-13
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Object Selection tool and 13-15
objects 13-15 to 13-17
Smart Selection tool and 13-15
in tables 6-7, 6-11
tables 6-7
text 3-10
in view-only documents 27-35
selection borders 13-16, 13-17
selection handles
object 13-15
table cell 6-7
selection tools 13-15
semicolons (;) in index entries 23-6, 23-10
sending files to technical support A-3 to A-5
sending objects to back 14-7
separate text flows. See multiflow documents
separated colors. See color separations; spot colors
separator frames, footnote 11-12
Separators paragraph tag, in indexes 23-22
to 23-23
sequential page numbering. See page numbers
SGML (FrameMaker+SGML) A-7
shading in tables 7-18, 7-23 to 7-26
custom 7-25
displaying settings for 7-26
regular 7-23
removing 7-27 to 7-28
shading, object. See fill patterns
shadows, drop 14-8
shape, changing object. See reshaping objects
shared licenses 2-5
sheet numbering in tables 6-12, 12-11
shell environment variables in hypertext
commands 27-12, 27-25
<$shortdayname>, <$shortmonthname>,
<$shortyear> building blocks 12-17
Show All Digits command 30-12
Show/Hide settings (conditional text),
inconsistent 24-22
showing. See displaying; zooming
shrinkwrapping
anchored frames 15-6
equations in anchored frames 28-21

side heads 4-29 to 4-33
creating 4-32
gap between body text and 4-30
in multicolumn text frames 4-33
reformatting, as body text 4-32
setting up areas for 4-30
space above 4-33
turning off 4-32
See also callouts (text); multicolumn documents
side-by-side page display 2-29
side-by-side text versions. See change bars;
composite documents; conditional documents
sidebars, text. See side heads
sides of objects, adding or removing 14-22
sign function, inserting in equations 28-18
signs, mathematical. See equations; math elements
Simplify command 30-18
Simplify Some command 30-19
single quotation marks (‘ ’), Smart Quotes 3-8
single spacing of text 4-18
<$singlepage> index marker building block 23-11
single-sided documents
creating 2-11
layout of 18-6
site dictionary 9-13
See also dictionaries
site-specific menus 2-19
size
of files in books 24-4
font (text) 4-8
of objects, changing 14-17
of objects, inspecting 14-23
of page display 2-25
of pages, changing 18-5
of pages in new documents 2-11
of printer paper 2-38, 2-40
of small caps 4-11
of superscripts and subscripts 4-12
zoom display 2-25
See also cropping; height; resizing; scaling; width
small-caps text 4-11
See also capitalization
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Smart Quotes 3-8
Smart Selection tool 13-15
Smart Spaces 3-8
smoothing and unsmoothing objects 14-18 to 14-19
See also curvature; reshaping objects
snap grid 13-4, 13-6
aligning tab stops with 4-16
aligning table column border to 6-20
spacing of 13-6
See also grids
snap rotate interval 13-6
software illustrations, capturing 16-17 to 16-18
sort order, index 23-10, 23-24 to 23-26
problems with 23-17
SortOrder paragraph tag, in indexes 23-24
sources of formats. See Character Catalog;
Paragraph Catalog; Table Catalog
sources of information. See cross-references;
imported graphics; indexes; markers; text
insets
spaces, text 3-7
in autonumber counters 4-44
in autonumber formats 4-41, 4-43, 4-44
in conditional text 26-5
extra, spell-checking and 9-6
finding 8-8, 8-9
spread between characters 4-10
in text files 2-35
typing 3-7
See also nonbreaking space
spacing
above and below paragraphs 4-20
above and below tables 7-30
above side heads 4-33
around mathematical expressions 29-5, 29-16
between characters 4-10 to 4-11
between lines of text 4-18 to 4-20
between objects, measuring 14-24
between objects, setting 14-11
between paragraphs 4-21
between table and title 7-17
between words 4-21 to 4-22
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double 4-18
feathering text and 18-17
grid 13-6
grid, and ruler intervals 2-27
in math element definitions 29-6
pair kerning 4-10
ruler 2-27
single 4-18
synchronizing text baselines and 18-19
See also gap; distance between objects; offsets;
spaces, text; white space
spanning. See straddles
SpecEffects sample document 16-11
special characters
changing found items to 8-16
finding 8-9
typing 3-6
typing, in cross-reference definitions 10-12
typing, in system variable definitions 12-15
typing, in user variable definitions 12-8
See also character sets; characters; Quick
Reference
special text flows on reference pages
for generated hypertext documents 27-30
for generated lists 22-14 to 22-19
for indexes 23-20 to 23-27
spell-checking 9-4
adding words to dictionaries when 9-10
canceling 9-5
capitalization of text when 9-6, 9-10
clearing automatic corrections when 9-11
conditional text 26-18
correcting words automatically when 9-11
correcting words when 9-9 to 9-11
current page 9-4
hyphenated compound words 9-16
hyphenation and 9-6, 9-11
languages for 4-24, 9-8, 13-26
learning words when 9-10
overlooking words when 9-7
punctuation 9-6
rechecking after changing options 9-7
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repeated characters 9-6
repeated words 9-6
Roman numerals 9-7
skipping items when 9-7
skipping paragraphs when 9-8
spaces, extra 9-6
specific text 9-4
subscript and superscript text 9-6
text insets 9-6
typing errors 9-6
unlearning words when 9-14
uppercase words 9-7
vertically kerned text 9-6
words with numbers 9-7
See also dictionaries; document dictionary;
personal dictionary
splines. See freehand curves
splitting
tables 6-19
text frames to start new flows 20-13
“unsplitting” text frames 20-14
spot colors
assigning, to text 4-9
PANTONE 17-6, 17-8
printing 17-13 to 17-21
See also color separations; colors
spot cross-references 10-4, 10-8
spread
between characters in text 4-10
between math elements in equations 29-5, 29-15
See also pair kerning
square brackets ([])
around matrices 28-27
in cross-reference formats 10-14
finding a literal 8-8
in index entries 23-6, 23-10
inserting, in equations 28-15
publisher boundaries 2-27
removing, from equations 28-26
in system variable definitions 12-20
toggling format of, in equations 28-26
as wildcards for finding 8-8

squares, drawing 13-10
stack, hypertext. See hypertext stack
stacking objects 14-7
standoff amount. See margins, page; running text
around objects
start angles
for arcs 14-22
for regular polygons 13-12
start-of-paragraph, finding 8-9
start positions
for paragraphs 4-27
for tables 7-30
start-of-word, finding 8-9
starting FrameMaker 2-4
starting jumps. See hypertext commands;
hypertext links
starting page to print 2-38
starting page side in new documents 2-11
<$startrange> index marker building block 23-8
status bar 2-24
current position in 14-5
steps
autonumbered 4-43
retracing, in hypertext documents 27-16, 27-34
See also autonumbering
stops, tab. See tab stops
storing. See saving
straddles
anchored frames 15-9
feathering text in columns and 18-18
footnotes 11-5
paragraphs 4-34
tables 6-5
straddling table cells 6-22
straight quotation marks (' and ")
in equations 28-11
spell-checking and 9-6
typing 3-8
streams (autonumber counters) 4-40 to 4-44
strikethrough text 4-7
See also condition indicators
strings in equations
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font for 29-17
inserting 28-10
style sheets. See Character Catalog; master pages;
page layout; Paragraph Catalog; reference
pages; Table Catalog; templates
styles for text. See character formats; paragraph
formats; templates
subentries in index entries 23-7
subexpressions in equations 28-23
See also equations; expressions in equations;
math elements
subject indexes 23-11
See also indexes
submenus, hypertext pop-up 27-20
subscribers, text, on non-Macintosh
platforms 3-21, 3-24
subscript text
font style 4-7
inserting, in equations 28-13
size and placement of 4-12
spell-checking 9-6
substituting fonts when opening documents 2-14
substitution in equations
evaluating 30-13, 30-14
math element type 28-31
rules for 30-16 to 30-17
subtraction operators, inserting in equations 28-13
suffixes
filename, for generated lists 22-8
filename, for indexes 23-11
for page numbers in book files 24-13
for revision page numbers 25-7 to 25-9
See also filename extensions
summary documents
book comparison and 24-28
creating 25-10
filenames of 24-28, 25-11
with hypertext links 25-13, 27-27 to 27-32
reading 25-14 to 25-16
See also comparing books; comparing
documents; composite documents
summations in equations
adding operands to 28-19
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evaluating 30-20
inserting 28-14
superscript text
font style 4-7
inserting, in equations 28-13
size and placement of 4-12
spell-checking 9-6
supplementary pages. See revision pages
support. See technical support
suppress hyphenation symbol 2-27
finding 8-9
suppressing
automatic update of cross-references 10-19
automatic update of text insets 3-22
autonumber display 4-44
hyphenation 4-23, 9-12
Symbol font 3-6
symbols
in autonumber formats 4-39
boilerplate graphics and 19-22, 19-25
in equations. See math elements
finding 8-9
footnote numbering with 11-11
text 2-26
See also icons; pointers; Quick Reference; specific
symbols
symmetrical objects 14-13
symmetrical page layouts 18-7
synchronizing text baselines along a grid 18-19
See also adjacent text columns
synonyms
in index entries 23-9
looking up, in Thesaurus 9-18
syntax
for cross-reference formats 10-11 to 10-15
for hypertext commands 27-11 to 27-26
for index markers 23-5 to 23-11
for index markers, problems with 23-15 to 23-19
for macro files C-7
mathematical, in equations 28-9
for system variable definitions 12-13 to 12-24
See also special text flows on reference pages
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system administrator 2-4
system crash, file recovery after 2-36
System V UNIX, printer queue commands for 2-41
system variables 12-2
changing definitions of 12-13 to 12-24
conditional 26-10
converting, to text 12-16
copying, cutting, and pasting 12-13
for dates 12-11
default definitions of 12-11
deleting 12-13
for filenames 12-11
finding 8-4 to 8-6
formatting text in 12-15
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
inserting 12-9 to 12-13, 19-7
on master pages 12-9 to 12-13
moving 12-13
for page numbers 12-11
replacing 12-13
for running headers and footers 12-18 to 12-24
special characters in 12-15
for tables 6-12, 12-11
in text insets 12-16
for time 12-11
updating, on body and reference pages 12-13
updating, on master pages 12-10
See also user variables; variables, text
systems, color 17-4, 17-6
choosing 17-6

T
tab. See tab stops; tabs
tab leader dots 4-17
in generated lists 22-18
in indexes 23-23
specifying 4-17
tab stops
absolute 3-6
aligning, with ruler markings 4-16
in autonumber formats 4-37, 4-39

decimal 4-16
defining 4-15 to 4-17
deleting 4-16
in generated lists 22-18
in headers and footers 18-10
in indexes 23-23
moving 4-16
at regular intervals 4-16
relative 3-6
in table cells 6-11
See also tabs
tab symbol 2-27, 3-5
finding 8-9
tab wells on formatting bar 4-6
tabbed text, converting to a table 6-25
table anchor symbol 2-27
table positioning and 7-30
Table Catalog
adding formats to 7-8 to 7-11
applying formats from 7-6
deleting formats from 7-16
displaying catalog format properties in 7-6
importing formats to 21-12 to 21-13
importing formats to, with fmbatch B-10
renaming formats in 7-15
updating formats in 7-11 to 7-15
See also Table Designer; table formats
table cell properties. See cells, table
Table Continuation system variable 6-12, 12-11
Table Designer
applying properties from 7-5
As Is property settings in 5-18, 7-14
displaying 7-5
displaying catalog format properties in 7-6
properties of tables not set in 7-4
resetting properties in 7-6
Ruling properties 7-18
Shading properties 7-23
updating formats in 7-11 to 7-15
See also Table Catalog; table formats
table formats
adding, to catalog 7-8 to 7-11
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applying 7-6
applying, to tables with certain tags 7-7
As Is property settings for 5-18, 7-14
choosing, for new tables 6-4
creating 7-8 to 7-11
defined 6-3
deleting 7-16
displaying properties of, in the Table
Designer 7-6
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
naming tips for 7-9
overrides of 7-6
overrides of, removing 7-11 to 7-15
overrides of, removing, when importing
formats 21-12 to 21-13, 24-26
overview of 7-4
renaming 7-15
types of properties in 7-4
updating 7-11 to 7-15
See also Table Catalog; Table Designer; table
tags; tables
table ruling styles. See ruling lines in tables
Table Sheet system variable 6-12, 12-11
table tags
finding 8-4 to 8-6
guidelines for 7-9
imported, with same name 21-12 to 21-13
table titles
adding 7-16 to 7-17
autonumbering, based on section numbers 4-44
removing 7-17
tables
aligning, within indents 7-29
anchor symbols and positioning of 7-30
anchor symbols for 2-27
autonumbering in 7-35
boxing paragraphs within 4-18
captions for. See table titles
cell margins in 7-31 to 7-34
centering text in cells of 7-32
color of ruling lines in 7-22
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color of shading in 7-23, 7-26
color of text in 17-5
combining 6-19
conditional 26-10
continuation text in, for titles and headings 6-12
converting text to 6-24 to 6-28
converting, to text 6-28
copying and pasting 6-8
customizing 7-4, 7-18
cutting and pasting 6-8
default paragraph formats for 6-11
deleting 6-10
displaying ruling and shading settings of 7-26
filling in 6-10 to 6-15
finding 8-4 to 8-6
floating 7-30
footnotes in 11-4 to 11-12
full-width 6-5
gap between titles and 7-17
imported, editing 6-27
importing text files into 3-18, 6-26
indenting 7-29
inserting new empty 6-4 to 6-7
inserting, in table cells 6-14
insertion point in 6-10
lists of. See generated lists
merging text files into 6-26
moving 6-8
in multicolumn layouts 6-5
multipage, continuation text 12-11
multipage, revision pages and 25-8
multipage, setting up 6-12
orphan rows in 7-36
page breaks in 7-36 to 7-38
placing graphics in cells of 6-13
properties affecting 7-4
rotating 6-9
ruling lines in 7-18 to 7-23
ruling lines in, styles for 7-22
running text around 6-6
searching for 8-4 to 8-6
selecting 6-7
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selecting in 6-7, 6-11
shading 7-18, 7-23 to 7-26
sheet numbering in 6-12
space above and below 7-30
splitting 6-19
start position for 7-30
straddling columns in 6-5
tabs in 6-11
in text insets 7-11
text insets as, converting to editable
paragraphs 6-28
titles of. See table titles
updating properties of 7-5
using, for figures or graphics 13-28
vertical alignment of text in 7-34
See also cells, table; columns, table; footing rows,
table; heading rows, table; rows, table;
table formats
tables of contents. See generated lists
tabs
finding 8-9
in generated lists 22-18
in indexes 23-23
typing 3-5
typing, in tables 6-11
See also tab stops
tags list. See Character Catalog; Paragraph
Catalog; Table Catalog
tags. See character tags; condition tags; flow tags;
paragraph tags; table tags
tall pages (portrait) in new documents 2-10
See also orientation, page
<$tblsheetcount>, <$tblsheetnum> building
blocks 12-11
technical support A-1 to A-5
bulletin board service for A-4
on CompuServe A-4
by e-mail A-2 to A-5
by fax A-2 to A-3
on the internet A-3
by letter A-5
preparing to contact A-2
subscribing to A-1

by telephone A-2
transferring files to A-3 to A-5
See also Help, online; filters
template text frames (tagged)
assigning, to body pages 19-7 to 19-9
background text frames and 19-5
changing column layout of 19-9 to 19-17
drawing, on master pages 19-14
See also background text frames (untagged); text
frames
templates xv
autonumbering in 21-7
available, from online services A-4 to A-5
to change conditional text settings 21-10
for conditional documents 26-19
contents of 2-8
defined 2-7
designing 21-4 to 21-5
directories for 2-8, 21-12
documenting your 21-4
for generated lists 21-9, 22-20
importance of 2-8
for indexes 21-9, 23-28
new documents from 2-7 to 2-11
organizing 21-12
overview of 2-8
page layout of 21-6
planning 21-4 to 21-5
setting up 21-5 to 21-9
standard 2-7
standard, exploring 2-10
testing 21-11
Templates directory 21-12, 2-8
text
aligning 4-14
aligning, in multicolumn documents 18-16
to 18-21
in anchored frames 15-16
anchored frames obscuring 15-6
applying formats to 5-5 to 5-10
applying paragraph default font to 5-7
autonumbering with 4-36, 4-43
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background 19-6
balancing, across columns 18-16
boilerplate. See importing text files; importing
text flows; user variables
capitalization of 4-11
Character Catalog formats for 5-6
color of 4-9, 17-5
continuation, in table titles and headings 6-12,
12-11
converting cross-references to 10-10
converting, to a table 6-24 to 6-28
converting variables to 12-9, 12-16
copying, cutting, and pasting 3-10
deleting 3-11
deselecting 3-10
drawing tools for 13-24 to 13-27
duplicating, without using Clipboard 3-11
editing 3-10 to 3-12
entering 3-4 to 3-9
entering, in tables 6-10
feathering 18-17
finding 8-8
finding and changing 8-15
finding, with a particular character format 8-11
flowing around graphics 13-30, 15-13
flowing around tables 6-6
font family 4-7
font properties of 4-7 to 4-13
format overrides and tagged 5-6
formatting 4-7 to 4-44
formatting, in cross-references 10-15
formatting, in system variables 12-15
formatting, in user variables 12-7
in graphics 13-24 to 13-29
gray bar in place of 2-29
hypertext active areas in 27-6
hyphenating 4-23 to 4-24
importing. See importing text files; importing
text flows
indenting. See indenting
insets. See text insets
justifying 4-14
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leading of. See line spacing
letter spacing within 4-21 to 4-22
line breaks. See line breaks, text
moving 3-10
numeric underlining of 4-9
orphan lines of 4-28
pair kerning 4-10
Paragraph Catalog formats for 5-5
pasting 3-10
pasting objects into 14-6
point size of 4-8
quick-copying 3-11
repeating, on pages. See background text frames
(untagged); footers, page; headers, page;
user variables
replacing 3-12
reverse (white on dark background) 13-27
running around graphics 13-30, 15-13
running, around tables 6-6
searching for 8-8, 8-11
selecting 3-10
size of 4-8
special characters. See character sets; Quick
Reference; special characters
spread between characters 4-10
style of 4-7
subscript 4-12
superscript 4-12
synchronizing baselines of 18-19
in table cells, positioning 7-31 to 7-35
typing, in rotated text frames 19-19
vertical alignment of, in table cells 7-34
weight of 4-9
widow lines 4-28
wildcard searches for 8-7 to 8-8
wrapping. See line breaks, text; running text
around objects
See also baselines, text; columns, text;
paragraphs; text frames; text line objects
text boxes, blank 5-18
text columns. See columns, text
text file formats. See file formats
text files
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importing. See importing text files; importing
text flows
opening 2-16
saving 2-33
.txt filename extension for 2-31
See also file formats; files; text insets
text flows
balancing text in, across columns 18-16
on body pages 19-9, 20-7
bypassing text frames in 20-12
combining 19-14, 20-10
controlling 20-7 to 20-16
feathering 18-17
importing. See importing text flows
on master pages 19-9
in multiflow documents 20-2 to 20-16
multiple nonparallel 20-6
overflowing 13-27, 20-8, 20-10
parallel 20-4
removing text frames from 20-12
side-head areas 4-30
splitting text frames into 20-13
synchronizing baselines in 18-19
tracking 20-15
See also autoconnecting; flow tags; special text
flows on reference pages
text formats
design guidelines for 21-7
designer windows and 4-6
from the formatting bar 4-6
See also Character Designer; character formats;
Paragraph Designer; paragraph formats;
paragraphs; text
text frames
adding 13-26
adding, on master pages 19-13 to 19-17
adding, on master pages, and assigning flow
tags 20-9
aligning text with bottom of 18-17
and anchored frame positions 15-5 to 15-12
assigning color to 13-20, 17-5
balancing text across columns in 18-16
changing page size, effect on 18-6

color of 17-5
connecting 19-14, 20-10
copying and pasting 19-16
disconnecting 20-11
disconnecting, and Autoconnect settings 20-12
drawing or duplicating, on body pages 19-14
drawing, on master pages 19-14
drawing properties 13-20
duplicating 19-15
feathering text in 18-17
gutters for, changing 18-7
gutters for, in new documents 2-11
header and footer 18-10
margins for, changing 18-7 to 18-8, 19-12
margins for, in new documents 2-11
number of columns in, changing 18-9
number of columns in, in new documents 2-11
and other frame types, compared 13-33
overflowing 13-27, 20-8, 20-10
overlapping, causes of 19-9
PostScript code 16-10
removing, from middle of flow 20-12
resizing 14-17, 18-7, 19-12
reverse text in 13-28
rotating 14-14
rotating tables in 6-9
side heads in 4-29 to 4-33
splitting 20-13
synchronizing text baselines in 18-19
and text line objects, compared 13-24
unrotating 14-16
“unsplitting” 20-14
See also adjacent text columns; background text
frames (untagged); columns, text; template
text frames (tagged); text line objects
text insets 3-13
conditional text in 26-17
converting, to editable text 3-23
cross-reference formats in 10-17
cross-references to 10-7
directories for 3-20
displaying filenames of 3-21
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displaying properties of 3-21
displaying sources of 3-21
file-naming conventions for 3-20
generated lists of 22-9
missing 3-19
missing, locating sources of 3-23
pathnames for 3-20
spell-checking 9-6
suppressing automatic updating of 3-22
system variables in 12-16
tables in 7-11
tabular, converting to editable paragraphs 6-28
tabular, editing 6-27
unresolved, locating sources of 3-23
updating, interrupting 3-23
updating, manually 3-22
updating, options for 3-15, 3-22
variables in 12-9
See also importing text files; importing text
flows; text files
text line objects
aligning 14-10
changing character format of 13-25
color of 13-20, 17-5
creating 13-25
drawing properties of 13-20
limitations 13-25
for math elements 28-28 to 28-32
moving 14-4 to 14-7
object properties of 14-10
resizing 14-17
skipping, when spell-checking 9-8
spell-checking and hyphenation language of 9-8
and text frames, compared 13-24
text runaround and 13-30
See also columns, text; lines of text
Text Only file format 2-33
text properties
format overrides of 5-6
resetting to current 4-7
text styles. See character formats; fonts
text symbols 2-26
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finding 8-9
See also Quick Reference; special characters
text wrap. See line breaks, text; running text
around objects
text-anchored graphics. See anchored frames;
tables
text-only documents, saving 2-33
Thesaurus
adding a word by using 9-20
dictionaries for, ordering A-5
languages for 9-19, A-7
looking up a word in 9-17 to 9-19
replacing a word with 9-20
thin spaces
finding 8-9
typing 3-7
thumbnail images, printing 2-40
TIFF files, printing color separations for 17-20
TIFF preview image for Encapsulated PostScript
files 16-5
time
autosave interval 2-36
idle system 2-6
license duration 2-6
system variables for 12-11
tints 17-5 to 17-6
See also fill patterns
titles
of generated lists 22-19
for graphics 13-28, 15-16
of indexes 23-27
for tables 7-16 to 7-18
See also heading rows, table; heads, text
TOC. See generated lists
today’s date 12-11, 12-16
toggling format of math elements 28-26
Tools palette 13-3
closing 2-21
displaying 13-5
drawing properties on 13-18 to 13-21
See also drawing objects; objects, graphic
top of column or page
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paragraph position 4-27
table position 7-30
table row position 7-38
top-aligning. See aligning
tracking. See spread
training on Frame products A-3
transferring files to technical support A-3 to A-5
transforming equations 30-2 to 30-20
transparent objects 13-19
transposing rows and columns in matrices 30-4
trapping objects 17-16
triggers, macro C-3
trigonometric functions, inserting in
equations 28-18
trimming an image. See cropping; unanchored
graphic frames
troff
importing files from 3-12 to 3-17
opening files from 2-12
See also importing text flows
tutorial for learning FrameMaker xv
two-column documents. See multicolumn
documents; multiflow documents
two-sided pages, printing 2-39
type, reverse 13-27
type size 4-8
type style 4-7
typefaces. See fonts
typing
abbreviation for inches 3-9
bullets 3-7, 3-8
dashes 3-7
forced returns 4-25
hyphens 4-23
quotation marks 3-8
spaces 3-7
special characters 3-6
special characters in dialog boxes 3-8
tabbed text 3-5
text 3-6
typing errors, correcting with Spelling Checker 9-6
typography. See paragraphs; text

U
unanchored graphic frames
and anchored frames, compared 14-19
drawing 13-14
drawing, on reference pages 19-23
placing graphics in 15-15
See also anchored frames; graphic frames;
reference frames
unanchored graphics
in page background 19-5
running text around 13-30
unconditional text, restoring, by removing condition
tags 26-14 to 26-15
unconnected body pages
adding 20-10
deleting 20-16
unconnected columns. See autoconnecting;
background text columns (untagged)
underlined text 4-7
See also condition indicators
underlying page layout. See master pages
Undo command 2-19
See also canceling
unfreezing pagination 25-9
ungrouping objects 14-8
unions in equations
adding operands to 28-19
inserting 28-14
units of measure. See display units; size
UNIX commands
executing with fmbatch B-9
hypertext execution of 27-24
lpr 2-41
printer queue 2-41
Unknown File Type dialog box
for importing graphics 16-6
for importing text files 3-18
for importing text flows 3-14
for opening files 2-15
for opening text files 2-16
unlinked text frames. See autoconnecting;
background text frames (untagged)
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unlocked documents, activating hypertext links
in 27-30
unlocking view-only documents (converting to
Normal format) 27-33
unresolved cross-references
avoiding, when using conditional text 26-12
to conditional text, resolving 26-20
finding 10-21
generating lists of 10-22, 22-9
resolving, after automatic updating 10-18
resolving, when marker is deleted 10-21
resolving, when marker is moved 10-20
See also cross-references
unresolved text insets
generating lists of 22-9
locating sources of 3-23
unrotating objects (graphic) 14-16
unsmoothing and smoothing objects 14-18 to 14-19
See also curvature; reshaping objects
unstraddling table cells 6-23
unsymmetrical page layouts 18-8
untagged font properties. See fonts, in text
untagged text frames. See background text frames
(untagged)
unwrapping equations in anchored frames 28-21
updating
body pages with master page changes 19-10
book files 24-18 to 24-23
book files with fmbatch B-10
character format of all characters 5-21
character formats 5-20 to 5-21
character formats in hidden conditional
text 26-18
cross-references when printing 10-19
cross-references with fmbatch B-10
cross-references manually 10-19
cross-references, suppressing automatic 10-19
documents from a template 21-12 to 21-13
formats from another document 21-12 to 21-13
formats from another document with
fmbatch B-10
formats in book files 24-26
generated files in book files 24-18 to 24-23
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generated files with fmbatch B-10
generated lists 22-8
generated lists from a template 22-20
generated lists with fmbatch B-10
graphics imported by reference 16-7
imported template formats and 21-12 to 21-13
indexes 23-14
indexes with fmbatch B-10
indexes from a template 23-28
master pages with body page changes 19-10
paragraph formats 5-8, 5-12 to 5-17
paragraph formats in hidden conditional
text 26-18
system variables 12-10, 12-13
table formats 7-11 to 7-15
table properties 7-5
templates for 21-9
text insets 3-22
text insets, options for 3-15, 3-22
user variables 12-8
See also converting; customizing; editing;
replacing
uppercase text 4-11
See also capitalization; case-sensitivity
user variables 12-2
changing definitions of 12-8
conditional 26-10
in conditional documents 26-19
converting, to text 12-9
copying, cutting, and pasting 12-6
creating 12-6
deleting 12-6
finding 8-4 to 8-6
formatting text in 12-7
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
inserting 12-4 to 12-5
moving 12-6
replacing 12-6
special characters in 12-8
updating 12-8
See also system variables; variables, text
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Using Frame Filters xv
Using Frame Products on Multiple Platforms xvi
utilities B-1 to B-13

V
values, color 17-7, 17-22, 17-23
variable definitions
in conditional documents 26-19
importing and updating 21-12 to 21-13
importing and updating, with fmbatch B-10
variables, text
in conditional documents 26-10
in equations, changing font of 29-17
on master pages 19-7
shell environment, in hypertext
commands 27-12, 27-25
in text insets 12-9
using conditional text or 26-4
See also system variables; user variables
vector graphics 16-3
versions. See comparing books; comparing
documents; conditional documents
vertical alignment of text in table cells 7-34
See also aligning
vertical bar (|)
finding a literal 8-8
manual alignment symbol 2-27, 29-10
as wildcard for finding 8-8
vertical distribution of objects 14-11
vertical division bar, math element type 28-31
vertical kerning, spell-checking text with 9-6
vertical lines
drawing 13-10
in tables. See ruling lines in tables
vertical lists of expressions in equations
adding items to 28-12
aligning items in 29-9
defining custom math element for 28-32
inserting 28-11
math element type 28-31
vertical movement, constraining objects to 14-4

vertical (portrait) page orientation in new
documents 2-10
vertical scrolling 2-28 to 2-30
vertices
adding or removing 14-22
number of, in regular polygon 13-12
view settings
for colors 17-11 to 17-13
for conditional documents 26-15 to 26-17
for conditional documents, template for
changing 21-10
for graphics 2-29
for scrolling 2-28 to 2-30
viewing. See displaying; zooming
view-only documents
book files and 27-33
converting Normal-format documents to 27-33
displaying, in separate windows 27-35
for online systems. See hypertext online systems
guidelines for displaying 27-33
highlighting markers in 27-33
hypertext commands to close 27-23
menus in 27-35
navigating within 27-34
opening. See opening documents
placing insertion point in 27-35
selecting in 27-35
See also hypertext documents
visible grid 13-4, 13-6
spacing of 13-6
See also grids

W
weight, font 4-9
What’s New in FrameMaker xiv
wheels, color 17-6
white, converting to black in bitmap B-12, B-13
white cutout (reverse text) 13-27, 17-13
white space
above and below paragraphs 4-20
around mathematical expressions 29-5, 29-16
table row height and 6-22
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wide pages (landscape) in new documents 2-10
See also orientation, page
widow lines in paragraphs 4-28
width
equation line-break 29-7 to 29-9
line, graphic 13-18 to 13-21
line, graphic, customizing 13-22
table column, resizing 6-19 to 6-22
table ruling line 7-22
See also height; size
wildcards
for finding 8-7 to 8-8
for limiting filenames in scroll lists 2-15, 24-8
window guides, displaying 2-26 to 2-28
window settings. See document window
windows
closing 2-21
dialog boxes and 2-17, 2-21
main FrameMaker 2-4
opening new, with hypertext command 27-35
resizing 2-25
using 2-17
See also document window
Windows applications, graphic file formats for 16-5
Windows Metafile (WMF) files, printing in
color 17-20
Windows Metafile (WMF) preview image for
Encapsulated PostScript files 16-5
Word files. See Microsoft Word files
word processing files
importing 3-12 to 3-17
See also importing text flows
word spacing 4-21 to 4-22
word-by-word index sort order 23-24
WordPerfect
importing files from 3-12 to 3-17
opening files from 2-12
See also importing text flows
words
choosing. See Thesaurus
double, finding when spell-checking 9-6
hyphenating. See hyphenation
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selecting 3-10
whole, finding 8-7
See also paragraphs; text
wordwrap. See line breaks, text; running text
around objects
working notes, nonprinting. See nonprinting items
World Wide Web, for Frame product
information A-5
wrapping text. See line breaks, text; running text
around objects

X
X resources. See Changing Setup Files
X-Ref markers. See Cross-Ref markers; crossreferences
xwd format 16-17
xwd8to1 utility B-13

Y
<$year> building block 12-17
year, in system variables 12-17

Z
Zapf Dingbats font 4-9
zooming in document windows 2-25 to 2-26
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DOCUMENTATION DEVELOPMENT

Andy Andersen, Paul Battaglia, Gary Beichler, Judy Bligh, Lisa Caras,
Geta Carlson, Mary Lou Carlson, Chris Despopoulos, Daniel Franks,
Maureen Franotovich, Victoria Gilbert, Heather Hermstad, Kurt Heycke,
Ann Hillesland, Lily Ko, Rebecca Kutlin, Tom Lam, Nina Machotka, Barb
Mackraz, Ed Malick, John Patterson, Elaine Pendergrast, Dayna
Porterfield, Michael Salinero, Marc Savage, Anitra Saxton, Monica Smith,
Kevin Susco, John Taylor, Dave Valiulis, Russell Wyllie, Douglas Yoshinaga
QUALITY ASSURANCE

Marcia Bell, Scott Bitton, Jim Burrill, Thuan Connolly, Tom Costales,
Rosalind de Vera, Leslie DeGroff, David DiFiori, Jim Drew, Mark Drury,
Blake Elder, Marc Jameson, Steve Ketchum, Peter Lockrem, Rachel
Magnus, Devin McKinney, Donna Moore, Kate Murtha, Anna Newman,
Thach Nguyen, Lynne Rossi, Aric Rubin, Jannine Sabath, Carla Schroer,
Jim Steck, Bao Tran, Stanley Vealé, Karen Woodmansee, Gordon
Yamamoto
SOFTWARE DEVELOPMENT

Chip Brown, Chris Butler, Mark Carmichael, David Clark, Charles
Corfield, Steve Cox, Lyndley Crumly, Dee Doyle, Gus Fernandez, David
Fuchs, Andrew Hamel, Andy Hartman, Ron Hughes, Tracy Lakin, Tod
Landis, Peter Lee, Tammy Liu, Tom McRae, Joel Nava, Susan Osofsky,
Mark Paine, Bill Rose, Stephanie Sandberg, Steven Sargent, Linda Soloff,
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This manual was written, illustrated, and produced with FrameMaker
document publishing software on a variety of platforms. Some illustrations
were done in Adobe Illustrator and Photoshop. The manual uses standard
LaserWriter Plus fonts to facilitate electronic distribution.

